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ВведениеВведениеВведениеВведениеВведение

Данная анная книга представляет собой вводный курс по использованию
системы автоматизированного проектирования (САПР) AutoCAD в
двухмерной компьютерной графике. Материал книги построен на од�
ноименном курсе, апробированном автором на практике, и рассчитан

на освоение в течение полутора недель. Как показывает опыт автора, при жела�
нии любой пользователь, имеющий минимальный уровень подготовки в ис�
пользовании современных программных систем, может освоить материал дан�
ной книги в течение одной недели. Наличие твердых навыков владения ПК, а
также базового инженерного образования в подавляющем большинстве случа�
ев позволяет еще в большей степени сократить срок освоения AutoCAD с помо�
щью данной книги.

Структура книгиСтруктура книгиСтруктура книгиСтруктура книгиСтруктура книги
Материал книги можно условно разделить на три основные части.
����� Базовые сведения о работе в AutoCAD — главы с 1 по 3, в которых приве�

дено описание пользовательского интерфейса AutoCAD, методов его на�
стройки и основных принципов двухмерного черчения в AutoCAD.
����� Основные инструменты и методы создания чертежей в AutoCAD — главы

с 4 по 8, посвященные описанию инструментов, команд и приемов созда�
ния основных объектов чертежей.
����� Оформление, компоновка и печать чертежей — главы с 9 по 14, раскрыва�

ющие принципы создания элементов оформления чертежей, их компо�
новки, подготовки к печати и выводу на печать.

 Основная часть этой книги построена на примере создания чертежа рабо�
чей зоны детской комнаты. В книге рассматривается весь процесс получения
чертежей — от нанесения габаритов рабочей зоны до создания видов в ортого�
нальных проекциях, расстановки размеров и вывода чертежа на печать с офор�
млением в соответствии с требованиями отечественных стандартов. Конечно,
в связи с учебным характером проекта, в нем будут допущены некоторые упро�
щения и условности. Однако в целом, как надеется автор, проделав все упраж�
нения и самостоятельно создав все примеры, вы получите достаточно твердые
навыки владения AutoCAD, которые позволят вам приступить к работе над соб�
ственными проектами, в том числе и на реальном производстве.

Дополнительные материалы к книгеДополнительные материалы к книгеДополнительные материалы к книгеДополнительные материалы к книгеДополнительные материалы к книге
На веб�сайте автора по адресу http:\\www.KLIMACHEVA.com вы сможете

найти все примеры, рассмотренные в книге, а также дополнительные материа�
лы. Если по каким�то причинам вам не удастся воспользоваться веб�сайтом, мо�
жете прислать запрос на получение материалов по электронной почте по адре�
су tn@klimacheva.com или ktn-ktn@mail.ru.

Версии AutoCADВерсии AutoCADВерсии AutoCADВерсии AutoCADВерсии AutoCAD
Данная книга посвящена официальной русской версии AutoCAD 2007. Однако
пользователи англоязычной версии также смогут применять ее для обучения,
поскольку все команды, названия инструментов и элементов интерфейса в
книге продублировано в соответствии с англоязычной версией AutoCAD 2007.
С целью упрощения задачи пользователя в книге применяется классический
пользовательский интерфейс AutoCAD.

Пользователям AutoCAD 2008Пользователям AutoCAD 2008Пользователям AutoCAD 2008Пользователям AutoCAD 2008Пользователям AutoCAD 2008
В приложении А представлены сведения, которые позволят настроить как
официальную русскую версию AutoCAD 2008, так и английскую версию
AutoCAD 2008 для работы с этой книгой. Если в вашем распоряжении есть
лишь AutoCAD 2008, начните освоение материала книги с приложения А, а за�
тем перейдите к главе 2.

Пользователям AutoCAD 2009Пользователям AutoCAD 2009Пользователям AutoCAD 2009Пользователям AutoCAD 2009Пользователям AutoCAD 2009
В приложении Б представлены сведения, которые позволят настроить как
официальную русскую версию AutoCAD 2009, так и английскую версию
AutoCAD 2009 для работы с этой книгой. Если в вашем распоряжении есть
лишь AutoCAD 2009, начните освоение материала книги с приложения Б, а за�
тем перейдите к главе 2.

Пользователям AutoCAD 2010Пользователям AutoCAD 2010Пользователям AutoCAD 2010Пользователям AutoCAD 2010Пользователям AutoCAD 2010
В приложении В представлены сведения, которые позволят настроить как
официальную русскую версию AutoCAD 2010, так и английскую версию
AutoCAD 2010 для работы с этой книгой. Если в вашем распоряжении есть
лишь AutoCAD 2010, начните освоение материала книги с приложения В, а за�
тем перейдите к главе 2.

Соответствие команд русских версий AutoCADСоответствие команд русских версий AutoCADСоответствие команд русских версий AutoCADСоответствие команд русских версий AutoCADСоответствие команд русских версий AutoCAD
К сожалению, компания Autodesk в русских версиях AutoCAD не придержива�
ется последовательного и неизменного подхода к переводу англоязычных тер�
минов и обозначений на русский язык. Именно поэтому автор посоветует чита�
телям, имеющим некоторый опыт работы с англоязычной САПР AutoCAD
предыдущих версий, хорошенько подумать, прежде чем устанавливать офици�
альную русскую версию AutoCAD. То же самое относится и к пользователям,
которые могут предположить, что им придется иметь дело одновременно как с
официальной русской версией AutoCAD, так и с ее англоязычным вариантом
либо с англоязычными вариантами AutoCAD предыдущих версий. Дело в том,
что самым мощным средством работы в AutoCAD является командное окно и
многие профессиональные конструкторы предпочитают вводить команды
именно в командном окне. Однако соответствие команд русскоязычного и анг�
лоязычного варианта AutoCAD, как вы убедитесь сами, не всегда прозрачно,
особенно для начинающего пользователя.

Тем не менее, автор надеется, что эти небольшие трудности вы преодолеете
и уже через несколько дней с помощью этой книги будете работать в AutoCAD
так же свободно, как если бы вы знали эту САПР уже много лет.
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Прежде, чем переходить к освоению методов черчения, мы уделим не�
которое внимание интерфейсу AutoCAD 2007. Этот интерфейс может
показаться достаточно сложным даже для опытного пользователя

Windows, однако многие из элементов интерфейса AutoCAD 2007 при первона�
чальном обучении не очень нужны и их можно безболезненно отключить.
В этой главе мы изучим основные приемы управления элементами окна AutoCAD,
а также принципы использования основы основ AutoCAD – команд. Но снача�
ла, естественно, нужно запустить AutoCAD, что мы и сделаем.

1.1. Первый запуск AutoCAD 20071.1. Первый запуск AutoCAD 20071.1. Первый запуск AutoCAD 20071.1. Первый запуск AutoCAD 20071.1. Первый запуск AutoCAD 2007
При установке AutoCAD в стандартной конфигурации для его запуска доста�
точно выбрать команду Пуск ⇒ Все программы ⇒ Autodesk ⇒ AutoCAD 2007 –
Русский ⇒ AutoCAD 2007 (рис. 1.1). Если же при установке на вашем ПК
стандартная конфигурация AutoCAD 2007 была изменена, найдите значок
AutoCAD 2007 самостоятельно, а затем запустите программу, как любое другое
приложение Windows XP.

При первом запуске AutoCAD 2007 появляется окно выбора рабочего про�
странства (workspace), которое называется – Рабочие (Workspaces) (рис. 1.2).
Рабочее пространство – это удобный инструмент, который часто используют
опытные пользователи AutoCAD для настройки всех параметров своего экзем�
пляра AutoCAD, включая файлы чертежей.

По умолчанию в AutoCAD 2007 имеется два стандартных рабочих простран�
ства: 3D моделирование (3D Modeling) и Классический AutoCAD (AutoCAD
Classic). Поскольку мы в этой книге будем работать с классическими средства�
ми AutoCAD 2007, выберите рабочее пространство Классический AutoCAD
(AutoCAD Classic), установите флажок Больше не выводить это окно (Don’t
Show me this again) и щелкните на кнопке OK.

Рис. 1.1  Запуск AutoCAD 2007

Рис. 1.2  Выбор рабочего пространства в окне Рабочие (Workspaces)

Первый запуск AutoCAD 2007Первый запуск AutoCAD 2007Первый запуск AutoCAD 2007Первый запуск AutoCAD 2007Первый запуск AutoCAD 2007
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Вслед за окном Рабочие (Workspaces) на экране появится окно Семенар по
новым возможностям (New Features Workshop), с помощью которого можно
ознакомиться с новыми возможностями AutoCAD 2007 по сравнению с преды�
дущими версиями. Выберите в этом окне переключатель Больше не предла�
гать (No, don’t show me this again), чтобы это окно больше не появлялось (если
у вас возникнет такая необходимость, вы всегда сможете ознакомиться с но�
винками, выбрав из меню AutoCAD команду Справка ⇒ Новые возможности
(Help ⇒ New Features Workshop) и щелкните на кнопке OK.

AutoCAD выполнит настройку рабочего пространства, после чего на экране
появится окно AutoCAD 2007 (рис. 1.3), которые специалисты называют также
графическим пользовательским интерфейсом (GUI – graphical user interface).

имя активного приложения (AutoCAD 2007) и имя текущего файла чертежа
(Чертеж1.dwg (Drawing1.dwg)). Структура меню также должна быть знакома
любому пользователю Windows. В частности, несколько меню (Файл (File),
Правка (Edit), Вид (View), Express, Окно (Windows), и Справка (Help) присут�
ствуют практически во всех меню приложений для Windows, хотя указанные
меню в AutoCAD содержат ряд дополнительных команд. Кроме того, в строку
меню AutoCAD входят меню, специфичные только для AutoCAD (Слияние
(Insert), Формат (Format), Сервис (Tools), Черчение (Draw), Размеры (Dimen�
sion), Изменить (Modify)). Подробнее о меню AutoCAD 2007 мы поговорим
далее в этой главе. Под строкой меню расположены панели инструментов
(Standard, Стили (Styles), Рабочие пространства (Workspaces), Слои (Layers),
Свойства (Properties)). Практически все кнопки этих панелей, кроме несколь�
ких кнопок панели Standard, начинающему пользователю AutoCAD будут не�
знакомы. Именно изучению инструментов и команд AutoCAD, представленных
кнопками этих и других панелей инструментов, строго говоря, и посвящена
данная книга. Поэтому сейчас мы не будем на них останавливаться, поскольку
с каждым из основных инструментов черчения AutoCAD вы будете знакомить�
ся по мере изучения материала книги.

У левой и правой границ экрана AutoCAD отображаются еще три панели
инструментов: слева – Черчение (Draw), а справа Изменить (Modify) и Поря�
док прорисовки (Draw Order) (небольшая панель с четырьмя кнопками, нахо�
дящаяся ниже панели Изменить (Modify)). Это обычные панели инструмен�
тов, которые по умолчанию располагаются не по горизонтали, а по вертикали.
А вот два крупных объекта, закрывающие черную область в центре экрана, – это
не панели инструментов. Слева находится палитра ДИСПЕТЧЕР ПОДШИ�
ВОК (SHEET SET MANAGER), а справа – падитра TOOL PALETTES�ВСЕ ПА�
ЛИТРЫ (TOOL PALETTES). И диспетчер подшивок, и палитры инструмен�
тов – это очень удобные средства, но предназначены они, прежде всего, для
опытных пользователей AutoCAD. В нашем же случае эти панели представля�
ют собой избыточные средства, которые лишь загромождают экран. Поэтому
поочередно подведите указатель мыши к кнопкам закрытия палитр ДИСПЕТ�
ЧЕР ПОДШИВОК (SHEET SET MANAGER) и TOOL PALETTES�ВСЕ ПАЛИТ�
РЫ (TOOL PALETTES) и щелкните на этих кнопках для отключения этих палитр.

Теперь посреди экрана вы видите черную пустую область. Эта область
в AutoCAD называется областью черчения (drawing area). Указатель мыши, попадая
в эту область при перемещении по экрану, принимает форму указателя�перекрес�
тия (crosshair cursor), как показано на рис. 1.3. При использовании некоторых
команд AutoCAD указатель может принимать и другие формы, в зависимости
от назначения команды и этапа ее выполнения.

Кроме того, в окне AutoCAD 2007, как и в любом другом окне приложения
Windows, могут отображаться полосы прокрутки. В общем случае использовать
полосы прокрутки в AutoCAD не рекомендуется, поскольку они не только ме�
нее удобны, чем инструменты масштабирования и панорамирования AutoCAD,
но еще и занимают место в области черчения. Поэтому сейчас мы отключим

Рис. 1.3  Пользовательский интерфейс AutoCAD 2007 после первого запуска

1.2. Основные элементы интерфейса AutoCAD1.2. Основные элементы интерфейса AutoCAD1.2. Основные элементы интерфейса AutoCAD1.2. Основные элементы интерфейса AutoCAD1.2. Основные элементы интерфейса AutoCAD
и его настройкаи его настройкаи его настройкаи его настройкаи его настройка
Основные элементы окна AutoCAD 2007 (строка заголовка, система меню и панели
инструментов) полностью аналогичны соответствующим элементам любого со�
временного приложения для Windows. Так, в строке заголовка отображаются

Основные элементы интерфейса AutoCAD и его настройкаОсновные элементы интерфейса AutoCAD и его настройкаОсновные элементы интерфейса AutoCAD и его настройкаОсновные элементы интерфейса AutoCAD и его настройкаОсновные элементы интерфейса AutoCAD и его настройка
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отображение полос прокрутки, а также заодно изменим цвет области черче�
ния. Эти и другие операции настройки интерфейса AutoCAD выполняются
с помощью диалогового окна Настройка (Options), которое вы будете очень
часто использовать в работе.

1. Выберите из меню команду Инструменты ⇒ Настройка (Tools ⇒ Opti�
ons). Откроется диалоговое окно Настройка (Options), показанное на
рис. 1.4, которое содержит десять вкладок.

гие опытные пользователи AutoCAD (в том числе и автор) считают, что
так с указателем�перекрестием работать удобнее, чем при размере, уста�
новленным по умолчанию.

5. Теперь щелкните на кнопке Цвета (Colors), расположенной в нижней
части группы Элементы окна (Window Elements). В открывшемся диало�
говом окне Цветовая гамма окна чертежа (Drawing Window Colors) вы�
берите в списке Контекст (Context) элемент Пространство 2D модели
(2D model space), а в списке Элемент интерфейса (Interface Element) –
элемент Однородный фон (Uniform background). Затем раскройте спи�
сок Цвет (Color) и выберите из него цвет Белый (White). Область про�
смотра Образец (Preview) окна Цветовая гамма окна чертежа (Drawing
Window Colors) примет вид, показанный на рис. 1.6.

6. Щелкните на кнопке Принять (Apply & Close) для закрытия окна Цвето�
вая гамма окна чертежа (Drawing Window Colors), а затем на кнопке OK
диалогового окна Настройка (Options).

Теперь цвет области черчения окна AutoCAD изменился на белый, а цвет
указателя�перекрестия – на черный (AutoCAD автоматически подбирает цвет
указателя так, чтобы он был хорошо виден на фоне цвета, выбранного поль�
зователем для области черчения). Кроме того, если вы установили макси�
мальный размер для указателя�перекрестия, эти изменения вы также легко за�
метите.

Рис. 1.4  Вкладка Файлы (Files)
диалогового окна Настройка (Options)

2. Перейдите в окне Настройка (Options) на вкладку Экран (Display), на
которой представлены параметры, управляющие отображением элемен�
тов графического интерфейса AutoCAD (рис. 1.5).

3. Если в группе Элементы окна (Window Elements) (находится в левом вер�
хнем углу вкладки) установлен флажок Полосы прокрутки (Display scroll
bars in drawing window), как показано на рис. 1.5, щелкните на нем для его
сброса и отключения соответствующего режима. Не спешите щелкать на
кнопке OK – настройку интерфейса мы еще не закончили.

4. Найдите в левом нижнем углу вкладки строку ввода Размер перекрестья
(Crosshair size). Если вы хотите, чтобы экран вашего ПК при изучении
этой книги выглядел точно так же, как и экран автора, введите в этой
строке значение 100 (или просто переместите бегунок право до конца).
В этом случае линии перекрестия будут уходить за границы экрана. Мно�

Рис. 1.5  Вкладка Экран (Display)
диалогового окна Настройка (Options)
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Теперь давайте рассмотрим другие элементы окна AutoCAD. Во�первых,
в нижнем левом углу окна области черчения отображается пиктограмма с дву�
мя стрелками. Эта пиктограмма называется ПСК (пользовательская система ко�
ординат) и используется для обозначения положительных направлений осей ко�
ординат X и Y. Для работы с этой книгой пиктограмма ПСК практически не
понадобиться, поэтому в последующих главах вы узнаете, как ее отключить.

Во�вторых, под пиктограммой ПСК находятся ярлычки листов модели (Мо�
дель (Model)) и листов компоновок (Лист1 (Layout1) и Лист2 (Layout2)). Эти
ярлычки используются для быстрого переключения между режимами работы
в пространстве модели (model space) и в пространстве листа (paper space). Под�
робнее о том, что такое компоновки и чем они отличаются от модели, мы так�
же поговорим в последующих главах.

Третий по порядку (но не по важности) элемент окна AutoCAD 2007, – это
командное окно.

Командное окно (command window) – это, без преувеличения, «сердце»
AutoCAD. В этом окне пользователь может вводить команды, а также задавать

их параметры. Кроме того, в командном окне выводится информация о выпол�
няемых AutoCAD операциях. Значимость командного окна очень высока, по�
скольку все команды меню и кнопки панелей инструментов представляют со�
бой, по сути, лишь «надстройку» над командами AutoCAD, которые изначально
предназначались для ввода в командном окне. Кроме того, существуют некото�
рые команды, которые можно ввести только в командном окне. Поэтому сове�
тую вам уделить самое пристальное внимание изучению методов работы с этим
элементом интерфейса AutoCAD. Подробнее о настройке командного окна мы
поговорим далее в этой главе.

Под командным окном расположена строка состояния (status bar). В отличие
от других приложений, в которых строка состояния используется от случая
к случаю, в AutoCAD этот элемент интерфейса применяется очень активно.
Во�первых, в строке состояния отображаются текущие координаты указателя�
перекрестия. Во�вторых, с помощью находящихся на ней кнопок�индикаторов
можно быстро включать и отключать соответствующие режимы работы AutoCAD.
Для начинающего пользователя AutoCAD очень важны такие индикаторы, как
ШАГ (SNAP), СЕТКА (GRID), ОРТО (ORTHO) и ПРИВЯЗКА (OSNAP), по�
скольку с помощью соответствующих режимов можно быстро научиться созда�
вать точные чертежи. Кроме того, вам могут пригодиться такие кнопки�инди�
каторы, как ОТС�ПОЛЯР (POLAR), ОТС�ОБЪЕКТ (OTRACK), ВЕС (LWT) и
МОДЕЛЬ (MODEL), поэтому мы также рассмотрим их в этой книге. Что каса�
ется кнопок�индикаторов ДПСК (DUCS) и ДИН (DYN), то они нам не понадо�
бятся. Индикатор ДПСК (DUCS) предназначен для использования режима ди�
намической ПСК (DUCS – dynamic user coordinate system), он используется
только при трехмерном моделировании, а индикатор ДИН (DYN) – для вклю�
чения режима динамических подсказок, которые многим начинающим пользовате�
лям создают дополнительные трудности в освоении базовых приемов черчения.

Поэтому давайте их отключим, чтобы вы не испытывали затруднений при
дальнейшей работе.

1. Если кнопки�индикаторы ДПСК (DUCS) и (или) ДИН (DYN) находятся
в нажатом положении, щелкните на них, чтобы выключить соответст�
вующие режимы.

2. Щелкните на кнопке раскрытия меню строки состояния, которая нахо�
дится в этой строке правее области уведомлений
(рис. 1.8).

3. Выберите из меню элемент Динамическая ПСК
(F6) (Dynamic UCS (F6)). AutoCAD закроет меню
и, отключив отображение кнопки ДПСК (DUCS),
перерисует строку состояния.

4. Снова откройте меню строки состояния и проде�
лайте аналогичную операцию с элементом Дина�
мический ввод (F12) (Dynamic Input (F12)).
Обратите внимание на значки, представленные
в области уведомлений. Первый из них (с изобра�

Рис. 1.8  Меню строки
состояния

Рис. 1.6  Диалоговое окно Цветовая гамма окна чертежа
(Drawing Window Colors)

Рис. 1.7  Командное окно и строка состояния AutoCAD 2007
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тия окна, которая находится в его правом верхнем углу, или просто на�
жмите Esc.

9. Убедитесь в том, что инструмент Коммуникационный центр (Commu�
nication Center) отключился (значок в области уведомлений стал блек�
лым).

В завершение обсуждения основных элементов окна AutoCAD можно упомя�

нуть о кнопке  Очистить экран (Clear Screen), которая находится в строке
состояния (см. рис. 1.7) у правой границы окна AutoCAD. Щелкнув на этой
кнопке, вы перейдете в полноэкранный режим работы AutoCAD с автомати�
ческим сокрытием всех панелей инструментов и строки заголовка. Это позво�
ляет обеспечить максимальное использование экрана дисплея, что бывает дос�
таточно удобным при работе со сложными чертежами. Повторный щелчок на
кнопке Очистить экран (Clear Screen) приводит к возврату в исходный режим
отображения окна AutoCAD.

1.3. Командное окно1.3. Командное окно1.3. Командное окно1.3. Командное окно1.3. Командное окно
Командное окно не зависит от других элементов области черчения, поэтому
его можно перемещать в любое место экрана, а также изменять размер. В част�
ности, для того чтобы увеличить высоту командного окна, следует подвести
указатель мыши к горизонтальной границе, отделяющей область черчения от
командного окна. Когда указатель приобретет форму двух параллельных отрезков,
сверху и снизу над которыми находятся направленные вверх и вниз вертикальные
стрелки, нажмите левую кнопку мыши и переместите указатель в нужном направ�
лении на высоту нескольких строк текста. Добившись необходимого вам поло�
жения границы, отпустите кнопку мыши. После завершения работы AutoCAD
состояние командного окна будет сохранено и при следующем запуске AutoCAD
размер командного окна окажется таким, каким он был установлен во время
предыдущего сеанса работы.

Как уже говорилось выше, командное окно – это исключительно важный
элемент интерфейса AutoCAD. Именно в нем пользователь отдает команды
AutoCAD и получает от AutoCAD нужную ему информацию. Например, от�
крыть упоминавшееся выше диалоговое окно Настройка (Options) можно, не
только выбрав из меню команду Cервис ⇒ Настройка (Tools ⇒ Options), но и
введя в командном окне команду Íàñòðîéêà (OPTIONS). Для этого достаточно
набрать команду с клавиатуры (соблюдать регистр необязательно) и нажать
Enter. AutoCAD автоматически распознает ввод с клавиатуры и отобразит вве�
денную вами команду в командном окне, а затем откроет диалоговое окно На�
стройка (Options). Закрыв окно Настройка (Options) щелчком на кнопке
Отмена (Cancel) или простым нажатием Esc, попробуйте открыть его снова
с помощью команды Cервис ⇒ Настройка (Tools ⇒ Options) и понаблюдайте
при этом за командным окном. Если размер окна равен как минимум трем стро�
кам, вы увидите, что в нем промелькнет команда _options. Это означает, что

жением локатора) представляет инструмент Коммуникационный центр
(Communication Center), а второй (с изображением замка) – инструмент
Положения панелей инструментов и окон разблокированы (Toolbar/
Window Position). Инструмент Положения панелей инструментов и
окон разблокированы (Toolbar/Window Position), предназначенный для
закрепления расположения элементов интерфейса, вам хлопот не доста�
вит (да и использовать его мы не будем). А вот инструмент Коммуника�
ционный центр (Communication Center), который нам также не понадо�
биться, постоянно будет уведомлять вас о невозможности установки
связи с Интернетом (или, что еще хуже, устанавливать такую связь и про�
верять наличие обновлений и выполнять прочие операции без вашего
ведома). Поэтому лучше его также отключить.

5. Щелкните дважды на значке  Коммуникационный центр (Communi�
cation Center) в области уведомлений строки состояния.

6. В открывшемся окне Коммуникационный центр (Communication Cen�
ter) щелкните на кнопке Настройка (Settings).

7. На единственной вкладке Параметры (Settings) появившегося диалого�
вого окна Настройка (Configurations Settings) выберите в списке Страна
или территория (Country/Region) регион вашего проживания, в списке
Проверка обновлений (Check for New Content) – элемент По запросу
(On Demand) и сбросьте единственный флажок в группе Всплывающие
уведомления (Balloon Notification) (рис. 1.9), а затем щелкните на кноп�
ке OK.

8. Диалоговое окно Настройка (Con�
figurations Settings) примет вид, по�
казанный на рис 1.10. Ничего не
меняя, щелкните на кнопке закры�

Рис. 1.9  Диалоговое окно Настройка
(Configurations Settings)

Рис. 1.10  Диалоговое окно
Коммуникационный центр (Communication

Center) после настройки параметров

Командное окноКомандное окноКомандное окноКомандное окноКомандное окно
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при использовании команд меню и панелей инструментов AutoCAD все равно
автоматически вводит за вас в командном окне соответствующие команды.

Поэтому автор настоятельно рекомендует всем начинающим пользовате�
лям выработать привычку, которая заключается в постоянном наблюдении за
тем, что происходит в командном окне. Это позволит вам избежать множества
недоразумений и досадных ошибок.

Кроме того, из вышесказанного следует сделать вывод о том, что одну и ту
же операцию в AutoCAD можно выполнить разными способами. Действитель�
но, для выполнения большинства команд можно воспользоваться не только
клавиатурой, но и системой меню либо панелями инструментов. В одних случа�
ях удобнее вводить команды по�старинке, с клавиатуры, а в других – пользо�
ваться мышью для выбора команд из меню или запуска их с помощью кнопок
панелей инструментов.

О командах, вводимых с клавиатуры, мы будем говорить на протяжении
всей книги, а пока что давайте бегло просмотрим все меню AutoCAD и панели
инструментов, а также кратко поговорим об особенностях их использования
в AutoCAD.

1.4. Система меню1.4. Система меню1.4. Система меню1.4. Система меню1.4. Система меню
Система меню AutoCAD состоит из двенадцати или одиннадцати меню. (При ус�
тановке с параметрами по умолчанию меню Express и, соответственно, инстру�
ментов пакета Express Tools, в системе меню AutoCAD может и не быть). Кроме
того, к этой системе можно отнести и значок меню окна текущего документа
AutoCAD, который находится слева от меню Файл (File). Щелчок на любом из
этих элементов приводит к открытию соответствующего меню. Значок меню
окна документа, а также меню Файл (File), Правка (Edit), Вид (View), Окно (Win�
dow) и Справка (Help) относятся к стандартным меню Microsoft Windows XP,
хотя и со специфическими командами AutoCAD. Меню окна документа содержит
команды управления расположением окна активного чертежа AutoCAD. Коман�
ды меню Файл (File) предназначены для открытия и сохранения новых и суще�
ствующих чертежей, печати, экспорта файлов в другие форматы, выполнения
некоторых других общих файловых операций, а также выхода из AutoCAD.
Меню Правка (Edit) содержит команды Отменить (Undo) и Повторить (Redo),
предназначенные для отмены или повтора операций; Вырезать (Cut), Копиро�
вать (Copy) и Вставить (Paste), используемые для работы с буфером обмена
Windows; а также команды организации внешних связей файлов AutoCAD и дру�
гих файлов. Меню Вид (View), помимо команд, предназначенных для управле�
ния отображения чертежа в области черчения, содержит команду Панели (Tool�
bars), которая, как и в других программах Windows, позволяет настраивать панели
инструментов. Меню Окно (Window) и Справка (Help), в основном, функциони�
руют так же, как и аналогичные меню программ для Windows.

Остальные меню содержат чаще всего используемые команды AutoCAD. Да�
вайте вкратце рассмотрим назначения команд каждого из меню AutoCAD.

Меню Слияние (Insert) содержит команды вставки чертежей и рисунков
(в том числе созданных в других программах) или их фрагментов в теку�
щий чертеж.
Меню Формат (Format) содержит команды настройки общих парамет�
ров чертежа.
Меню Сервис (Tools) содержит специальные команды, которые не отно�
сятся ни к одной из других категорий, например, для программирования
работы AutoCAD с помощью макросов.
Меню Черчение (Draw) содержит все основные команды, обеспечиваю�
щие создание новых объектов чертежа (линий, окружностей, много�
угольников и т. д.).
Меню Размеры (Dimension) содержит команды для нанесения размеров
на текущем чертеже.
Меню Изменить (Modify) содержит команды, которые, как и команды
меню Черчение (Draw), используются чаще других команд AutoCAD, по�
скольку они предназначены для внесения изменений в объекты текущего
чертежа.
Меню Express содержит команды вызова пакета Express Tools. (Этот
пакет является устаревшим и включается в поставку AutoCAD только для
тех пользователей, которые к нему привыкли.)

1.5. Панели инструментов1.5. Панели инструментов1.5. Панели инструментов1.5. Панели инструментов1.5. Панели инструментов
Как уже отмечалось выше, по умолчанию в окне AutoCAD отображается не�
сколько панелей инструментов (toolbar). Однако это только вершина айсберга –
всего в AutoCAD имеется 35 панелей инструментов, на многих из которых на�
считывается не один десяток кнопок. Для того чтобы увидеть список всех пане�
лей инструментов, достаточно щелкнуть на любой панели инструментов пра�
вой кнопкой мыши. На экране появится контекстное меню, представляющее
собой полный список панелей инструментов AutoCAD (рис. 1.11).

Те панели инструментов, которые на момент открытия списка отображают�
ся в окне AutoCAD, помечены в списке «галочкой». Если щелкнуть на помечен�
ном элементе списка, контекстное меню закроется, а соответствующая панель
инструментов перестанет отображаться в окне AutoCAD. Для включения ото�
бражения панели нужно снова открыть это контекстное меню, щелкнув правой
кнопкой мыши на любой из оставшихся панелей инструментов, и выбрать из
списка панель, рядом с названием которой нет «галочки».

Кроме того, любая панель инструментов AutoCAD может быть как пристыко�
ванной (docked toolbar), так и плавающей (floating toolbar). Пристыкованными
называются панели инструментов, которые прикреплены к одной из границ
окна документа AutoCAD, то есть панели инструментов в их традиционном
смысле, как, например, на рис. 1.11. Плавающие панели инструментов пред�
ставляют собой небольшие окна, которые можно свободно перемещать по эк�
рану. Любая плавающая панель, помещенная рядом с границей окна, автомати�
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чески становится пристыкованной и наоборот – любую пристыкованную па�
нель можно отстыковать и сделать плавающей. Поскольку освоение работы
с панелями инструментов – это достаточно важный аспект, мы уделим ему боль�
ше внимания далее в этой главе. А пока что откройте список панелей инстру�
ментов и отключите все панели, кроме Standard, Черчение (Draw) и Изме�
нить (Modify).

Следует отметить, что на многих панелях имеются скрытые кнопки, кото�
рые не всегда отображаются на экране. Такие кнопки нужно выбирать из свое�
образного графического меню, называемого плавающей панелью (flyout). В част�
ности, на панели Standard имеется такая плавающая панель – если вы
внимательно присмотритесь к кнопкам панели Standard, то увидите в правом
нижнем углу одной из кнопок маленький треугольник (по умолчанию эта кноп�
ка называется Окно зумирования (Zoom Window) и на ней изображена лупа).
О том, как работать с плавающими панелями, мы поговорим подробнее в следу�
ющем подразделе.

Остальные кнопки панели Standard – это обычные кнопки приложения
Windows (многие из них вам, наверняка покажутся знакомыми). Кнопки пане�
ли Черчение (Draw), которые по умолчанию располагаются у левой границы
окна AutoCAD, предназначены для создания объектов чертежа. Среди них име�
ется одна плавающая панель, которая по умолчанию представлена кнопкой
Вставить блок (Insert Block). Кнопки панели Изменить (Modify), расположен�

ной у правой границы окна AutoCAD, предназначены для внесения изменений
в объекты чертежа, созданные с помощью инструментов панели Черчение
(Draw). Плавающих панелей на этой панели инструментов нет. Подробнее
с инструментами панелей Standard, Черчение (Draw) и Изменить (Modify) вы
познакомитесь уже в следующей главе этой книги.

1.5.1. Плавающие панели1.5.1. Плавающие панели1.5.1. Плавающие панели1.5.1. Плавающие панели1.5.1. Плавающие панели
Итак, если с использованием обычных кнопок панелей инструментов даже
у начинающих пользователей проблем, как правило, не возникает, то для
освоения методов работы с плавающими панелями требуется некоторая прак�
тика. Самое большое затруднение, которое испытывают начинающие пользо�
ватели при работе с такими панелями, заключается в том, что они не могут най�
ти на панели инструментов скрытую кнопку плавающей панели. Поэтому для
освоения навыков работы с плавающими панелями выполните следующие опе�
рации.

1. Поместите указатель на кнопку  Окно зумирования (Zoom Window)
панели инструментов Standard. (На пиктограмме кнопки, как уже указы�
валось выше, изображена лупа, под стеклом которой видна прямоуголь�
ная рамка.)

2. Подержите указатель на этой кнопке в течение 1–2 с, не щелкая мышью.
Рядом с указателем мыши появится название команды, которой соответ�
ствует эта кнопка (в данном случае – Окно зумирования (Zoom Win�
dow)). Это так называемая контекстная подсказка (tooltip), которой снаб�
жены все инструменты AutoCAD. Именно с помощью контекстной
подсказки можно узнать название нужного вам инструмента. Для этого
достаточно подвести указатель мыши к панели инструментов, а затем
поочередно останавливать его на 1–2 с на каждом инструменте, до тех
пор, пока не увидите контекстную подсказку с нужным вам названием.

3. Теперь поместите указатель на кнопку (вы, наверное, обратили внима�
ние на черный треугольник в правом нижнем углу ее пиктограммы) и,
нажав левую кнопку мыши, удерживайте ее нажатой. Под кнопкой Окно
зумирования (Zoom Window) появится графическое меню, состоящее
из девяти кнопок (верхняя кнопка в этом меню аналогична нажатой
кнопке панели инструментов Standard). Это графическое меню из кно�
пок и называется плавающей панелью.

4. Продолжая удерживать левую кнопку мыши, медленно ведите указатель
вниз поочередно останавливая его на 1–2 с на каждой кнопке. Кнопки
при этом будут вам «представляться», показывая свои названия во всплы�
вающих подсказках (как нетрудно заметить, все названия кнопок этой
плавающей панели начинаются словом Зумирование (Zoom)). «Позна�
комившись» со всеми кнопками, подведите указатель мыши к кнопке Зу�
мировать все (Zoom All). Увидев контекстную подсказку с названием
этой кнопки, как показано на рис. 1.12, отпустите левую кнопку мыши.

Рис. 1.11  Список панелей инструментов AutoCAD 2007
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Плавающая панель закроется, а AutoCAD выполнит
команду Зумировать все (Zoom All).

5. Посмотрите на командное окно в нижней части экрана.
Если вы увеличите высоту командного окна примерно
в два раза, то увидите в нем, что при выполнении коман�
ды Çóìèðîâàòü âñå (Zoom All) в командном окне авто�
матически была введена команда âñå (_all) (Символы
подчеркивания, указанные перед командой Çóìèðîâàòü
(Zoom) и режимом ее выполнения âñå (_all), говорят
о том, что команда вводится автоматически, а не пользователем.)

6. Теперь снова посмотрите на панель Standard, туда, где раньше находилась
кнопка Окно зумирования (Zoom Window). Теперь на этом месте находит�
ся кнопка Зумировать все (Zoom All). Основная особенность плавающих
панелей состоит в том, что кнопка, выбранная последней, занимает место
предыдущей кнопки на основной панели. Теперь, если вам понадобиться

в следующий раз воспользоваться инструментом Зуми�
ровать все (Zoom All), вы будете освобождены от необ�
ходимости снова открывать плавающую панель – вам
достаточно будет просто щелкнуть на кнопке Зумиро�
вать все (Zoom All) панели инструментов Standard,
как если бы она была обычной кнопкой этой панели
(рис. 1.13). Порядок следования кнопок на плавающей
панели остается неизменным, поэтому при повторном
открытии этой панели кнопка Окно зумирования
(Zoom Window) снова окажется на самом ее верху.

Остальные плавающие панели работают точно так же, как только что рас�
смотренная плавающая панель Зумирование (Zoom). Строго говоря, можно не
использовать плавающие панели, поскольку все представленные в них инстру�
менты находятся на обычных панелях инструментов с соответствующими на�
званиями. Так, открыв список панелей инструментов AutoCAD, как показано
на рис. 1.11, вы увидите в конце этого списка панель инструментов Зумирова�
ние (Zoom). Включив отображение этой панели, легко убедиться, что она со�
держит все инструменты, представленные в виде плавающей панели Зумиро�
вание (Zoom) панели инструментов Standard, показанной на рис. 1.12. Однако
работать с плавающими панелями все же удобнее, поскольку они позволяют
рациональнее использовать область черчения, поэтому мы будем интенсивно
применять их при изучении дальнейшего материала этой книги.

1.5.2. Размещение панелей в окне AutoCAD1.5.2. Размещение панелей в окне AutoCAD1.5.2. Размещение панелей в окне AutoCAD1.5.2. Размещение панелей в окне AutoCAD1.5.2. Размещение панелей в окне AutoCAD
Для того чтобы увидеть, как в AutoCAD можно манипулировать панелями инстру�
ментов, мы воспользуемся панелью Изменить (Modify). Как отмечалось выше, по

Рис. 1.12  Выбор кнопки Зумировать все (Zoom All)
из плавающей панели инструментов

Рис. 1.13  Кнопка
Зумировать все (Zoom All)

заняла место кнопки
Окно зумирования

(Zoom Window)

умолчанию эта панель пристыкована к правой границе окна AutoCAD. Для того
чтобы преобразовать ее в плавающую панель, выполните следующие операции.

1. Подведите указатель мыши к двойной линии, выглядящей, как рифленая
поверхность (у вертикальных пристыкованных панелей эта двойная ли�
ния находится сверху, а у горизонтальных – слева).

2. Нажав левую кнопку мыши, вы увидите, что
вокруг панели появилась тонкая рамка, ох�
ватывающая контур панели. Не отпуская
кнопку мыши, переместите указатель вле�
во. Вместе с указателем будет перемещать�
ся и рамка, как показано на рис. 1.14.

3. Продолжайте перемещать указатель мыши
влево. Как только панель Изменить (Modify)
отстыкуется, рамка станет, во�первых, широкой, а во�вторых, горизонталь�
ной, а не вертикальной. Если вы отпустите левую кнопку мыши, на месте
широкой горизонтальной рамки появится плавающая панель Изменить
(Modify) с заголовком и кнопкой закрытия, как у обычного окна Windows.

4. Поместив указатель на строку заголовка, нажмите и не отпускайте левую
кнопку мыши, а затем попробуйте переместить плавающую панель Изме�
нить (Modify) в другое место экрана. Обратите внимание, что при пере�
мещении панель остается на месте, а двигается всего прямоугольная рам�
ка тех же размеров, что и панель (рис. 1.15).

5. Подведите указатель мыши к левой границе окна AutoCAD (туда, где на�
ходится пристыкованная панель Черчение (Draw)). Как только указа�
тель мыши (не прямоугольная рамка, а именно указатель) достигнет ле�
вой границы окна, рамка станет снова узкой и вертикальной. Это
означает, что панель готова к пристыковке. Пристыкуйте панель Изме�
нить (Modify) справа от панели Черчение (Draw).

Плавающие панели не оказывают никакого влияния на размеры области
черчения, но они при этом скрывают ее фрагменты, тогда как каждая присты�
кованная панель занимает место, которое могла бы дополнительно занимать
область черчения. В AutoCAD 2007, в отличие от более ранних версий, в кото�
рых отсутствовала уже упоминавшаяся выше кнопка Очистить экран (Clear
Screen), экономия пространства на экране не является принципиальным фак�
тором. Действительно, если, щелкнув на кнопке Очистить экран (Clear
Screen), в любой момент можно переключиться в режим чистого экрана, то
снижение производительности из�за загромождения области черчения плава�
ющими панелями инструментов, практически нивелируется.

Однако при обучении основам работы в AutoCAD все же лучше начинать
с минимального набора инструментов, подключая дополнительные панели по
мере необходимости. Поэтому здесь и далее автор будет считать, что вы оста�
вили на экране лишь панель Standard, пристыкованную к верхней границе
окна, а также панели Черчение (Draw) и Изменить (Modify), пристыкованные
к левой границе окна, как показано на рис. 1.16.

Рис. 1.14  Отстыковка панели
Изменить (Modify)
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Рис. 1.15  Перемещение плавающей панели Изменить (Modify)

Если вам удалось расположить панели Черчение (Draw) и Изменить (Modi�
fy), как показано на рис. 1.16, а также добиться соответствия расположения и
настройки других элементов окна AutoCAD на вашем ПК расположению и на�
стройке аналогичных элементов на рис. 1.16, можете переходить к изучению
заключительных разделов этой главы. В противном случае вернитесь к началу
главы и попробуйте разобраться в том, как решить соответствующую пробле�
му, поскольку в последующих главах не будет уделяться такого внимания вопро�
сам настройки интерфейса, исходя из того, что вы научились выполнять все
операции, описанные в данной главе.

1.5.3. Настройка панелей инструментов1.5.3. Настройка панелей инструментов1.5.3. Настройка панелей инструментов1.5.3. Настройка панелей инструментов1.5.3. Настройка панелей инструментов
Опытный пользователь AutoCAD может настроить конфигурацию любойпане�
ли инструментов по своему усмотрению – добавить или удалить кнопки, создать
новую панель и даже создать новые инструменты, отсутствующие в AutoCAD.
Эти операции выполняются с помощью диалогового окна Настройка интер�
фейса пользователя (Customize User Interface) (рис. 1.17), открыть которое
можно с помощью команды Вид ⇒ Панели инструментов (View ⇒ Toolbars)
либо с помощью команды Сервис ⇒ Адаптация ⇒ Интерфейс (Tools ⇒ Custo�
mize ⇒ Interface).

Однако одно лишь подробное описание диалогового окна Настройка интер�
фейса пользователя (Customize User Interface) потребует объема, соответ�
ствующего объему данной книги. Поэтому, упомянув о наличии в AutoCAD 2007
инструментов, позволяющих настроить пользовательский интерфейс, все же
рекомендуется читателям этой книги отложить изучение методов настройки
на будущее, пока вы не приобретете опыт выполнения обычных операций.

1.6. Использование клавиатуры и мыши1.6. Использование клавиатуры и мыши1.6. Использование клавиатуры и мыши1.6. Использование клавиатуры и мыши1.6. Использование клавиатуры и мыши
Нетрудно догадаться, что поскольку командное окно является одним из важ�
нейших элементов пользовательского интерфейса AutoCAD, при черчении вы
будете очень часто использовать клавиатуру для ввода команд и необходимых
им данных. Более того – опытные пользователи часто предпочитают вводить
команды именно в командном окне, а не выбирать их из меню или запускать
с помощью панелей инструментов. Это объясняется тем, что в AutoCAD под�
держиваются так называемые псевдонимы команд (alias) – сокращения из одного�
двух символов, позволяющие быстро вводить команды и названия их режимов
в командном окне. Например, упоминавшуюся команду Íàñòðîéêà (OPTIONS)
можно запустить, просто введя в командном окне псевдоним íà, команду Îêíî

Рис. 1.16  Окно AutoCAD 2007 настроено для работы с данной книгой

Использование клавиатуры и мышиИспользование клавиатуры и мышиИспользование клавиатуры и мышиИспользование клавиатуры и мышиИспользование клавиатуры и мыши
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Рис. 1.17  Диалоговое окно Настройка интерфейса пользователя
(Customize User Interface)

çóìèðîâàíèÿ (ZOOM WINDOW) – псевдоним ïî (Z W) (то есть последователь�
но нажав Z, Enter, W, Enter), а команду Ïîêàçàòü âñå (ZOOM ALL) – псевдо�
ним ïî (Z), а затем псевдоним âñå (A). В последующих главах мы еще вернемся
к этому вопросу и, возможно, вы также со временем начнете запускать коман�
ды, вводя их псевдонимы.

Кроме псевдонимов команд, AutoCAD поддерживает клавиатурные эквива�
ленты (shortcut key), которые представляют собой комбинации клавиш, нажа�
тие которых приводит к запуску той или иной команды либо к включению или
отключению того или иного режима. В качестве клавиатурных эквивалентов
могут использоваться комбинации буквенно�цифровых клавиш с Ctrl и Shift
(например, Ctrl+O – команда Файл ⇒ Открыть (File ⇒ Open), Ctrl+Shift+C –
команда Правка ⇒ Копировать с базовой точкой (Edit ⇒ Copy with Base Point)
и т. п.), а также функциональные клавиши (например, F9 – включение или вык�

лючение режима объектной привязки, F7 – включение или выключение режи�
ма привязки к сетке и т. п.). Знание клавиатурных эквивалентов, как и знание
псевдонимов команд, позволяет опытным пользователям существенно повы�
сить производительность работы в AutoCAD.

Наконец, как уже упоминалось ранее в разделе «Система меню», клавиату�
рой можно пользоваться вместо мыши для выбора из меню содержащихся
в них команд. Как вы знаете, в Windows в названии команды меню любого прило�
жения обычно имеется подчеркнутый символ. Это позволяет нажать клавишу
с соответствующим символом вместе с Alt для быстрого открытия этого меню,
а затем клавишу с подчеркнутым символом нужной вам команды. Соответст�
вующие клавиши называются клавишами ускоренного запуска команд (hot key). На�
пример, для быстрого открытия окна Настройка (Options) (команда Сервис ⇒
Настройка (Tools ⇒ Options)) можно нажать Alt+T, N. Поскольку в AutoCAD,
в отличие от многих других приложений Windows, клавиатурных эквивалентов
не так уж и много, запомнив последовательности клавиш ускоренного запуска
команд, можно также повысить производительность работы в AutoCAD.

Конечно же, клавиатура, в AutoCAD является далеко не единственным, хотя
и очень важным устройством черчения. Не умаляя важность клавиатуры, сле�
дует признать, что основным инструментом современного конструктора, ра�
ботающего в AutoCAD, является устройство указания (pointing device). Таким
устройством может быть специальный планшет, графическое перо или другое
профессиональное устройство. Однако подавляющее большинство как начина�
ющих, так и опытных пользователей применяют для работы шарово�кнопоч�
ный манипулятор (ШКМ), известный как «компьютерная мышь», или просто
мышь (mouse). Автор в последующих главах будет, во�первых, использовать
обиходное название, а во�вторых, исходить из того, что вы применяете для
управления AutoCAD и создания чертежей именно мышь, а не какое�то другое
устройство. Мыши современных ПК могут иметь две или три кнопки. Для от�
крытия меню, выбора команд из меню, а также для перемещения меню, пане�
лей или окон используется основная кнопка мыши, функции которой, как вы,
наверное, догадались, в этой главе выполняла левая кнопка. Поскольку боль�
шинство пользователей ПК являются правшами, автор, говоря о левой кнопке,
в дальнейшем будет понимать именно основную кнопку мыши, то есть кнопку,
которую пользователь нажимает указательным пальцем.

Правая (то есть вспомогательная) кнопка мыши используется для выполне�
ния следующих операций.

Открытие контекстного меню (context menu) – меню, содержимое которо�
го зависит от объекта, на котором вы щелкнули правой кнопкой мыши, и
(или) его состоянии (то есть от контекста). Пример контекстного меню
представлен на рис. 1.11.
Открытие специального меню с использованием нажатия Shift (с этим
меню вы будет работать в последующих главах).

В трехкнопочной мыши средняя кнопка обычно по умолчанию запрограм�
мирована на открытие уже упоминавшегося специального меню, тем самым за�
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меняя использование правой кнопки вместе с нажатием Shift. Если мышь обо�
рудована колесиком прокрутки, то при щелчке кнопкой, расположенной под
колесиком, запускается команда Панорамирование (Pan), а при вращении ко�
лесика – команда Зумирование в реальном времени (Zoom Realtime). О том,
что собой представляют эти очень популярные команды AutoCAD, вы узнаете
в последующих главах книги.

На этом вводная глава по интерфейсу AutoCAD закончена. Надеюсь, что вы
настроили окно AutoCAD в соответствии с рис. 1.16, а также разобрались как
в методах использования панелей инструментов, меню и командного окна, так
и в методах использования для этого клавиатуры и мыши. Если вы собираетесь
на этом завершить сеанс работы в AutoCAD, выберите команду Файл ⇒ За�
крыть (File ⇒ Exit) или нажмите Alt+F4 и выйдите из AutoCAD, не сохраняя
текущего документа. В следующей главе вы изучите несколько команд черче�
ния, с помощью которых можно создать простейший чертеж.

Т еперь, когда вы ознакомились с пользовательским интерфейсом
AutoCAD и поняли, что в нем нет ничего сверхсложного, мы можем пе�
рейти к созданию чертежей. В этой главе речь пойдет об основных ин�

струментах, которые используются при создании в AutoCAD практически
любого чертежа. Для того чтобы вам было легче понять смысл выполняемых
операций, мы будем практиковаться на примере простой офисной тумбы, по�
казанной на рис. 2.1. Естественно, вид этой тумбы сверху не представляет со�
бой ничего интересного – обычный четырехугольник. Поэтому мы взглянем на
нее в немного необычном ракурсе и попробуем создать чертеж, соответствую�
щий виду снизу (рис. 2.2).

Как нетрудно заметить, вид снизу интересен тем, что на нем имеется техно�
логический паз, выполненный на нижней грани крышки тумбы и который на
рис. 2.1, естественно, незаметен. Подроб�
нее о видах и проекциях мы поговорим
в главе 8, а о нанесении размеров – в главе 11.
Сейчас же сосредоточимся лишь на созда�
нии самого чертежа, показанного на рис. 2.2.
Возможно, вы будете удивлены, но для ре�
шений этой задачи вам потребуется освоить
лишь несколько инструментов AutoCAD.
Мы начнем с инструмента С линиями (Line),
который позволяет создавать отрезки за�
данной длины, а затем перейдем к изуче�
нию других инструментов, которые позво�
ляют превращать нагромождения отрезков
в нужные вам чертежи.

2ГГГГГлавалавалавалавалава
СозданиеСозданиеСозданиеСозданиеСоздание
первого чертежапервого чертежапервого чертежапервого чертежапервого чертежа

Рис. 2.1  Простая офисная тумба
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2.1. Создание отрезков с помощью инструмента2.1. Создание отрезков с помощью инструмента2.1. Создание отрезков с помощью инструмента2.1. Создание отрезков с помощью инструмента2.1. Создание отрезков с помощью инструмента
«С линиями» (Line)«С линиями» (Line)«С линиями» (Line)«С линиями» (Line)«С линиями» (Line)
Для создания прямых отрезков, соединяющих выбранные точки существую�
щих линий, фигур или других объектов чертежа, а также любых произвольных
точек, выбранных в области черчения, применяется инструмент С линиями
(Line). Задать начальную и (или) конечную точку отрезка можно, щелкнув в со�
ответствующих точках чертежа, введя координаты X и Y в командном окне или
введя расстояние и угол. При создании ломаных линий можно, построив пер�
вый отрезок, тут же продолжить создание линии, используя вторую точку
предыдущего отрезка в качестве первой точки последующего. Это позволят
с помощью инструмента С линиями (Line) быстро создать ломаную линию
произвольной формы, в том числе и правильный замкнутый четырехугольник.
Как вы понимаете, мы вплотную подошли к началу создания нашего чертежа.

1. Выберите из меню команду Файл ⇒ Закрыть (File ⇒ Close) для закрытия
текущего чертежа. Вместе с документом закроются также панели инстру�
ментов и командное окно, а в меню останется лишь несколько команд.

2. Выберите из меню команду Файл ⇒ Создать (File ⇒ New). На экране сно�
ва появятся панели инструментов и командное окно, но, прежде чем со�
здать новый документ, AutoCAD предложит вам выбрать шаблон (templa�
te) для этого документа с помощью диалогового окна Выбор шаблона
(Select Template) (рис. 2.3). Шаблон – это обычный документ AutoCAD,
но с расширением не DWG, а DWT.

3. Шаблоны AutoCAD подобны шаблонам Microsoft Office Word – в них так�
же хранятся все настройки, необходимые пользователю. В частности,
в шаблоне можно задать тип используемой системы единиц (метриче�
ская или английская), создать стандартные рамки и основные надписи,
определить стандартные слои, стили размеров и текста, а также другие
элементы. О многих из них мы будем говорить в последующих главах дан�
ной книги. Разобравшись с соответствующими настройками, вы можете
сохранить собственный вариант в виде шаблона (например, назвав его
Eskd.dwt, ГОСТ.dwt и т. п.), а затем использовать этот шаблон при созда�
нии новых документов.

Примечание. Все входящие в комплект поставки шаблоны AutoCAD хранятся
в папке Системный_диск:\Documents and Settings\имя_пользователя\Local Settings\
Application Data\Autodesk\AutoCAD 2007\R17.0\rus\Template. Для английской вер�
сии папка ru заменяется на enu.

4. Мы будем использовать стандартный шаблон AutoCAD для метрической
системы, который называется acadiso.dwt. Выберите этот шаблон, как
показано на рис. 2.3, и щелкните на кнопке Открыть (Open) диалогово�
го окна Выбор шаблона (Select Template) для создания нового документа
на основе этого шаблона.

5. Убедитесь в том, что в левой части окна AutoCAD находятся панели инст�
рументов Черчение (Draw) и Изменить (Modify), а в верхней – панель
Standard, как было показано на рис. 1.16. При изложении дальнейшего
материала будем считать, что окно AutoCAD имеет именно такой вид,

Рис. 2.2  Чертеж тумбы (вид снизу)
Рис. 2.3  Выбор шаблона acadiso.dwt

в диалоговом окне Выбор шаблона (Select Template)
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поэтому, если вы еще не разобрались как открыть эти панели и размес�
тить их на экране, а также как настроить другие элементы интерфейса,
обратитесь к материалу главы 1.

6. Щелкните на кнопке  С линиями (Line), которая находится в верхней
части панели Черчение (Draw).

Примечание. Для запуска инструмента С линиями (Line) можно также вы�
брать из системы меню команду Черчение ⇒ Отрезок (Draw ⇒ Line) или ввести
в командном окне команду  Îòðåçîê (LINE) либо ее псевдоним îò (L).

7. Теперь обратите внимание на командное окно. В нем вы увидите, во�пер�
вых, что была автоматически запущена команда Îòðåçîê (LINE) (ÎÒÐÅ-
ÇÎÊ (Command: _line)), а во�вторых, что AutoCAD ожидает, что вы зада�
дите координаты начальной точки отрезка (Ïåðâàÿ òî÷êà: (Specify first
point:)).

8. Переместите указатель в область черчения и щелкните в произвольной
точке этой области, тем самым задав ее в качестве первой точки отрезка.

9. Переместите указатель от выбранной точки, и вы увидите так называе�
мую «резиновую» линию (rubber line), с помощью которой эта точка будет
связана с указателем. При перемещении указателя «резиновая» линия
автоматически меняет направление и длину.

10. Снова обратите внимание на командное окно. Текст в нем изменился
(Ñëåäóþùàÿ òî÷êà èëè [Îòìåíèòü]: (Specify next point or [Undo]:)),
поскольку AutoCAD ожидает, что вы зададите координаты второй точки
отрезка.

11. Продолжайте перемещать указатель по экрану и выбирать точки в облас�
ти черчения. Тем самым вы будете добавлять новые отрезки к ломаной
линии (рис. 2.4). Обратите внимание, что в командном окне после выбо�
ра очередной точки снова и снова повторяется запрос: Ñëåäóþùàÿ òî÷-
êà èëè [Çàìêíóòü/Îòìåíèòü]: (Specify next point or [Close/Undo]).

12. Для завершения работы с инструментом С линиями (Line) после созда�
ния нескольких отрезков ломаной щелкните правой кнопкой мыши и вы�
берите из появившегося контекстного меню команду Enter или просто
нажмите Enter. Это приведет к тому, что отрезок ломаной, созданный
последним, «оторвется» от указателя�перекрестия и создание ломаной
на этом будет закончено.

13. Снова взглянув на командное окно, вы увидите, что в нем, как и до запус�
ка инструмента С линиями (Line), появилось приглашение Êîìàíäà:
(Command:). Это означает, что в данный момент не выполняется ника�
кая команда, а AutoCAD находится в состоянии ожидания.

В заключение хочу обратить ваше внимание на то, что в проделанном уп�
ражнении для щелчка на кнопке С линиями (Line) панели Черчение (Draw) и
для выбора опорных точек отрезков ломаной использовалась левая (то есть ос�
новная) кнопка мыши, а для завершения работы с инструментом С линиями
(Line) – правая кнопка (можно также воспользоваться нажатием Enter).

Примечание. Здесь и далее в тех случаях, когда вам будет предложено ввести что�
либо в командном или диалоговом окне, это означает, что вы должны набрать
указанный текст, а затем нажать Enter. Для облегчения вашей задачи текст,
который вы должны вводить в ответ на запросы AutoCAD, в этой книге будет
выделяться полужирным шрифтом.

2.1.1. Координаты и системы координат2.1.1. Координаты и системы координат2.1.1. Координаты и системы координат2.1.1. Координаты и системы координат2.1.1. Координаты и системы координат
Выбор точек на экране с помощью мыши при построении отрезков – это наибо�
лее интуитивно понятный и простой метод. Однако у него есть один недоста�
ток, заключающийся в низкой точности этого метода. В AutoCAD имеется мно�
жество методов, призванных компенсировать этот недостаток. Один из таких
методов заключается в полном отказе от использования мыши с заданием всех
координат с помощью клавиатуры. Отложите мышь в сторону, поскольку сей�
час вы будете работать в AutoCAD без нее.

1. Для удаления всех объектов текущего чертежа введите в командном окне
Ñòåðåòü (ERASE).

2. AutoCAD предложит выбрать объекты, подлежащие удалению. Введите
в ответ на запрос Âûáåðèòå îáúåêòû: (Select objects:) режим Âñå (ALL).

3. Все отрезки ломаной линии станут пунктирными, а в командном окне
появится сообщение с указанием количества найденных объектов. На�

Рис. 2.4  Построение четвертого отрезка ломаной линии
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жмите Enter для завершения выделения и применения команды Ñòå-
ðåòü (ERASE).

Теперь, когда область черчения вернулась в исходное состояние, мы нач�
нем вычерчивать отрезки заново, не прикасаясь к мыши.

1. Запустите инструмент С линиями (Line), введя в командном окне Îòðå-
çîê (LINE) или просто îò (L).

2. Введите 150,70.
3. Введите 300,100.
4. Введите 350,250.
5. Введите 50,200.
6. Введите 360,160.
7. Введите 50,70.
8. Введите 170,250.
9. Введите 240,60.

10. Нажмите Enter для завершения работы команды Îòðåçîê (LINE).
Основное отличие полученного об�

разца абстрактного искусства от того,
который вы создали самостоятельно
с помощью мыши, заключается в том,
что в этот раз вы точно знаете, где распо�
лагаются опорные точки каждого отрез�
ка по отношению к началу координат
(то есть точки с координатами 0,0). Для
всякого нового чертежа, как, например,
тот, с которым мы работаем, точка (0,0)
является левым нижним углом области
черчения, и поэтому координаты всех
точек положительны (рис. 2.5).

Для того чтобы определить, как со�
относится область черчения с коорди�
натами точек, попробуйте попереме�

щать указатель�перекрестие по экрану, наблюдая за индикатором координат
(как вы помните, он находится в левом нижнем углу окна AutoCAD).

Например, если вы подведете указатель�перекрестие к левому нижнему углу
области черчения, на индикаторе должно отобразиться значения координат,
близкое к 0.0000, 0.0000, 0.0000.

Примечание. Перемещая указатель по области черчения, вы поймете, что первое
значение индикатора координат изменяется при перемещении указателя по го�
ризонтали и, таким образом, соответствует координате X. Второе значение из�
меняется при перемещении указателя по вертикали и, естественно, соответству�
ет координате Y. А что же с третьим значением? Почему оно все время равно
0.0000? Как вы, должно быть, догадались, это значение представляет собой ко�
ординату Z. При черчении на плоскости координата Z не используется, поэтому
мы о ней говорить в дальнейшем не будем.

Поместив указатель�перекрестие в левый верхний угол области черчения,
вы увидите на индикаторе координат значения координат X и Y, близкие
к 0.0000, 300.0000. Таким образом, высота области черчения по умолчанию со�
ставляет триста единиц. Наконец, переместив указатель�перекрестие в правый
верхний угол области черчения, можно придти к заключению о том, что по
умолчанию ее размер составляет около 300 единиц по высоте и до 600 единиц
по ширине (строго говоря, этот размер зависит от установленного разрешения
экрана).

Примечание. О том, какой смысл имеют единицы измерения длины, мы будем
подробно говорить в главе 3. Кроме того, в следующей главе мы также изменим
точность представления единиц измерения, чтобы не загромождать индикатор
координат лишними нулями.

2.1.2. Относительные координаты2.1.2. Относительные координаты2.1.2. Относительные координаты2.1.2. Относительные координаты2.1.2. Относительные координаты
Итак, используя координаты, в AutoCAD можно начертить линию любой дли�
ны и с любым направлением. Проще говоря, когда перед нами стоит задача со�
здания чертежа, например, такого, как показано на рис. 2.2, мы можем, произ�
ведя определенные вычисления, рассчитать абсолютные координаты всех
вершин, а затем с помощью команды Îòðåçîê (LINE) создать чертеж, вводя
эти координаты с клавиатуры. Конечно, назвать такой метод создания черте�
жей удобным нельзя, в связи с чем в AutoCAD поддерживаются две системы не
абсолютных, а относительных координат.

Относительными эти системы называются потому, что при создании оче�
редного объекта (например, тех же линий), в качестве точки отсчета использу�
ется не начало координат (0,0), а предыдущая точка. Если, например, первая
точка линии имеет координаты (100,150), а линия длиной 200 единиц должна
располагаться справа от этой точки строго по горизонтали, относительные
координаты второй точки линии будут равны (200,0) – 200 единиц в положи�
тельном направлении оси X и 0 единиц в направлении оси Y. Абсолютные коор�
динаты этой же точки при этом будут равны (300,150).

Этот принцип справедлив для системы относительных декартовых координат,
в которой положение точки описывается координатами X и Y. В системе относи�
тельных полярных координат ее положение описывается расстоянием от точки
отсчета и углом, отсчитываемым от горизонтального направления. Большин�
ство пользователей чаще применяют систему относительных декартовых ко�
ординат, однако это не означает, что систему относительных полярных коор�
динат можно игнорировать. Работая в AutoCAD вы рано или поздно можете
столкнуться с ситуацией, когда создание объекта без использования системы
полярных координат будет значительно затруднено. Мы рассмотрим примеры
подобных ситуаций в главе 4.

При вводе относительных координат перед ними необходимо ставить сим�
вол «@». Так, в приведенном выше примере с вычерчиванием линии в относи�
тельных координатах для создания второй точки следовало бы ввести @200,0.

Рис. 2.5  Расположение области
черчения в координатах X и Y

Создание отрезков с помощью инструмента «С линиями» (Line)Создание отрезков с помощью инструмента «С линиями» (Line)Создание отрезков с помощью инструмента «С линиями» (Line)Создание отрезков с помощью инструмента «С линиями» (Line)Создание отрезков с помощью инструмента «С линиями» (Line)
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Наличие символа «@» говорит AutoCAD о том, что следующие за ним числа –
это значения координат, которые должны отсчитываться от предыдущей точки.

Относительные декартовы координатыОтносительные декартовы координатыОтносительные декартовы координатыОтносительные декартовы координатыОтносительные декартовы координаты
Известная нам еще со школьной скамьи система декартовых координат была
предложена в XVII веке французским математиком Рене Декартом. В этой сис�
теме описания положения точки используется горизонтальная (X) и верти�
кальная (Y) координаты, отсчитываемые от точки (0,0). Относительные декар�
товы координаты ничем не отличаются от абсолютных, за исключением того,
что отсчет ведется не от начала координат, а от предыдущей точки. Проще го�
воря, относительные координаты показывают, как далеко от выбранной точки
следует провести линию или сдвинуть объект (рис. 2.6). Если смещение направ�
лено влево, координата X будет отрицательной. Точно так же, если смещение
направлено вниз, то отрицательной будет координата Y. Эту систему целесооб�
разно использовать, если известны горизонтальное и вертикальное расстоя�
ния от одной точки до другой. Вводить относительные координаты следует
в таком формате: @X,Y. правлению влево («на девять часов») – угол 180°, вниз («на шесть часов») – 270°,

а полному обороту – угол 360°.
При вводе полярного угла его следует обозначать символом «меньше» (<),

чтобы было понятно, что мы имеем дело не со значением относительной коор�
динаты Y, а со значением полярного угла. Таким образом, в приведенном выше
примере для указания координат точки, расположенной на 200 единиц вправо
от предыдущей, следовало бы ввести @200<0.

2.2. Создание чертежа с помощью инструментов2.2. Создание чертежа с помощью инструментов2.2. Создание чертежа с помощью инструментов2.2. Создание чертежа с помощью инструментов2.2. Создание чертежа с помощью инструментов
«Подобие» (Offset) и «Сопряжение» (Fillet)«Подобие» (Offset) и «Сопряжение» (Fillet)«Подобие» (Offset) и «Сопряжение» (Fillet)«Подобие» (Offset) и «Сопряжение» (Fillet)«Подобие» (Offset) и «Сопряжение» (Fillet)
Вооружившись знаниями, мы приступаем к собственно созданию чертежа, пока�
занному на рис. 2.2. При этом мы будем использовать обе системы относительных
координат, уже известные вам инструменты С линиями (Line) и Стереть (Erase),
а также два новых инструмента – Подобие (Offset) и Сопряжение (Fillet).

2.2.1. Черчение в относительных декартовых2.2.1. Черчение в относительных декартовых2.2.1. Черчение в относительных декартовых2.2.1. Черчение в относительных декартовых2.2.1. Черчение в относительных декартовых
координатахкоординатахкоординатахкоординатахкоординатах
Для черчения в относительных декартовых координатах выполните следую�
щие действия.

1. Выберите из системы меню команду Файл ⇒ Закрыть (File ⇒ Close).
В появившемся окно с приглашением сохранить старый чертеж щелкни�
те на кнопке Нет.

2. Выберите из системы меню команду Файл ⇒ Создать (File ⇒ New).
3. В диалоговом окне Выбор шаблона (Select Template) выберите шаблон

acadiso.dwt, а затем щелкните на кнопке Открыть (Open).

Рис. 2.6  Система относительных декартовых координат

Относительные полярные координатыОтносительные полярные координатыОтносительные полярные координатыОтносительные полярные координатыОтносительные полярные координаты
В системе относительных полярных координат для задания положения после�
дующей точки относительно предыдущей используется расстояние между эти�
ми точками (полярный радиус) и угол, задающий направление (полярный угол).
При этом полярный радиус всегда рассматривается как положительная вели�
чина. Что касается отсчета полярного угла, то AutoCAD в качестве нулевой оси
отсчета выбрано направление вправо (или, как еще говорят, «на три часа»),
а полярный угол отсчитывается против часовой стрелки (рис. 2.7). Таким обра�
зом, направлению вверх («на двенадцать часов») соответствует угол 90°, на�

Рис. 2.7  Система относительных полярных координат
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4. Запустите инструмент С линиями (Line) (например, щелкните на кнопке
С линиями (Line), находящейся в верхней части панели инструментов
Черчение (Draw), или введите в командном окне îò (L)).

5. В ответ на запрос в командном окне Ïåðâàÿ òî÷êà: (Specify first point:)
введите 50,150. Это абсолютные декартовы координаты первой точки.

6. Введите @470,0.
7. Введите @0,400.
8. Введите @-470,0.
9. Введите Çàìêíóòü (CLOSE) или просто Ç. Режим Çàìêíóòü – это один

из режимов выполнения команды Îòðåçîê (LINE), который становится
доступным после создания двух и более отрезков ломаной линии. Если
в ответ на приглашение Ñëåäóþùàÿ òî÷êà èëè [Îòìåíèòü]: (Specify
next point or [Undo]:) ввести название этого режима или его псевдоним,
AutoCAD автоматически соединит последнюю точку с первой и завер�
шит выполнение команды Îòðåçîê (LINE).

10. Введите Ïîêàçàòü (ZOOM) или просто ïî (Z), а затем введите команду
âñå (ALL) или просто â. Тем самым вы запустите инструмент Зумиро�
вать все (Zoom All), который выполняет масштабирование чертежа по
его границам (подробнее о настройке границ и масштабировании мы по�
говорим в следующей главе). Вид чертежа должен быть таким, как пока�
зано на рис. 2.8.

2.2.2. У2.2.2. У2.2.2. У2.2.2. У2.2.2. Удаление отдельных объектов чертежадаление отдельных объектов чертежадаление отдельных объектов чертежадаление отдельных объектов чертежадаление отдельных объектов чертежа
с помощью инструмента «Стереть» (Erase)с помощью инструмента «Стереть» (Erase)с помощью инструмента «Стереть» (Erase)с помощью инструмента «Стереть» (Erase)с помощью инструмента «Стереть» (Erase)
Теперь мы рассмотрим пример создания этого же чертежа, но уже в относи�
тельных полярных координатах. Однако сначала нужно удалить ранее создан�
ные объекты чертежа. Для этого можно использовать уже знакомую вам коман�
ду Ñòåðåòü (ERASE) в режиме âñå (ALL), однако в этот раз мы рассмотрим
методы использования инструмента Стереть (Erase) для удаления отдельных
объектов чертежа.

1. Выберите из системы меню команду Изменить ⇒ Стереть (Modify ⇒
Erase). Указатель изменит форму с перекрестия на маленький квадратик,
который называется отмечающим указателем (pickbox cursor). Когда он
появляется на экране, это означает, что указатель можно использовать
для выбора объектов чертежа. Обратите также внимание на командное
окно: в нем появился запрос на выбор объектов.

2. Поместите отмечающий указатель на одну из линий и щелкните мышью –
линия превратится из сплошной в пунктирную. Этот процесс называется
выделением объектов чертежа.

Примечание. Для того чтобы вам было проще понять, на какой линии находит�
ся отмечающий указатель, AutoCAD временно выделяет ее утолщенным конту�
ром. В нашем случае это не существенно, однако на сложных чертежах это значи�
тельно упрощает задачу выбора нужных объектов.

3. Проделайте то же самое с остальными линиями.
4. Нажмите Enter для завершения выделения и применения к выделенным

объектам команды Ñòåðåòü (ERASE). Созданный вами четырехугольник бу�
дет удален с чертежа, а выполнение команды Ñòåðåòü (ERASE) завершится.

2.2.3. Черчение в относительных полярных координатах2.2.3. Черчение в относительных полярных координатах2.2.3. Черчение в относительных полярных координатах2.2.3. Черчение в относительных полярных координатах2.2.3. Черчение в относительных полярных координатах
Теперь давайте воссоздадим чертеж, но уже в относительных полярных коор�
динатах.

1. Запустите инструмент С линиями (Line).
2. Введите 50,150 в качестве координат первой точки.
3. Введите @470<0.
4. Введите @400<90.
5. Введите @470<180.
6. Введите Çàìêíóòü (CLOSE) или Ç для замыкания контура и завершения

команды Îòðåçîê (LINE). Полученный чертеж должен быть точно та�
ким же, как и предыдущий (см. рис. рис. 2.8).

Таким образом, мы на практике убедились в том, что обе системы относи�
тельных координат могут применяться для получения абсолютно одинаковых
результатов. Те не менее, как уже отмечалось выше, при создании сложных
чертежей нередко возникают ситуации, в которых одна система относитель�
ных координат может оказаться более удобной, чем другая. В последующих гла�Рис. 2.8  Наружный контур тумбы создан
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вах мы еще вернемся к вопросу использования различных систем координат,
когда будем чертить план рабочей зоны детской комнаты.

2.2.4. Смещение объектов с помощью инструмента2.2.4. Смещение объектов с помощью инструмента2.2.4. Смещение объектов с помощью инструмента2.2.4. Смещение объектов с помощью инструмента2.2.4. Смещение объектов с помощью инструмента
«Подобие» (Offset)«Подобие» (Offset)«Подобие» (Offset)«Подобие» (Offset)«Подобие» (Offset)
Следующая задача, которую нам нужно решить, – это построение внутренних
линий боковых стенок тумбы. Поскольку все они отстоят от линий внешнего
контура на одинаковое расстояние, это можно проделать с помощью нового
для вас инструмента Подобие (Offset). С его помощью существующие линии
будут смещены на 20 единиц внутрь внешнего контура тумбы.

Применение инструмента Подобие (Offset) происходит в три этапа:
выбора величины смещения;
выбора смещаемого объекта;
выбора направления смещения.

Для выполнения смещения проделайте следующие действия.
1. Запустите инструмент Подобие (Offset). Для этого выберите из меню

команду Изменить ⇒ Подобие (Modify ⇒ Offset) или же щелкните на
кнопке  Подобие (Offset) панели Изменить (Modify) либо введите в
командном окне Ïîäîáèå (Offset) или просто ïîä. В командном окне по�
явится запрос Óêàæèòå ðàññòîÿíèå ñìåùåíèÿ èëè [×åðåç/Óäàëèòü/
Ñëîé] <×åðåç>: (Specify offset distance or [Through/Erase/Layer]
<Through>:).

Примечание. Поначалу сообщения командного окна будут для вас не очень понят�
ны. Это нормально – со временем, после приобретения некоторого опыта, вы нач�
нете не столько понимать логику AutoCAD, сколько ощущать ее.

2. Смысл данного запроса сводится к выполнению одного из следующих
действий:
ввод расстояние смещения с клавиатуры;
выбор двух точек на экране, расстояние между которыми равно величи�
ной смещения (режим ×åðåç (THROUGH));
нажатие Enter для принятия предложенной по умолчанию величины
смещения (выведена в угловых скобках; если команда Ïîäîáèå (OFFSET)
еще не запускалась, в угловых скобках отображается текущий режим ко�
манды, по умолчанию – ×åðåç (THROUGH)).

3. Режимы Ñòåðåòü (ERASE) и Ñëîé (LAYER) команды Ïîäîáèå (OFFSET)
не имеют прямого отношения к выбору смещения, поэтому мы их рас�
сматривать не будем.

4. Введите 20 в качестве величины смещения, чтобы перейти ко второму
этапу выполнения команды Ïîäîáèå (OFFSET). Указатель�перекрестие
примет форму отмечающего указателя, а в командном окне появится зап�
рос Âûáåðèòå îáúåêò äëÿ ñìåùåíèÿ èëè [Âûõîä/Îòìåíèòü] <Âû-
õîä>: (Select object to offset or [Exit/Undo] <Exit>).

5. Поместите указатель на правую вертикальную линию и щелкните мы�
шью. Выбранная линия превратится в пунктирную (рис. 2.9), указатель
снова примет форму перекрестия, а в командном окне появится запрос
Óêàæèòå òî÷êó, îïðåäåëÿþùóþ ñòîðîíó ñìåùåíèÿ, èëè [Âûõîä/Íå-
ñêîëüêî/Îòìåíèòü] <Âûõîä>: (Specify points on side to offset or [Exit/
Multiply/Undo] <Exit>:). Этот запрос означает, что вы должны указать
направление смещения. Выбор направления осуществляется щелчком
в области черчения с соответствующей стороны от линии.

Рис. 2.9  Правая вертикальная линия выбрана в качестве исходной

6. Поместите указатель�перекрестие в прямоугольник, обозначающий на�
ружный контур тумбы, и щелкните мышью. Поскольку тем самым вы за�
дали направление смещения (влево от смещаемой линии), AutoCAD тут
же выполнит смещение. В результате внутри прямоугольного контура
тумбы появится новая линия, которая будет расположена на 20 единиц
влево от исходной (рис. 2.10). Вместо перекрестия на экране снова по�
явится отмечающий указатель. Это означает, что инструмент Подобие
(Offset) по�прежнему активен, и вы можете продолжать смещение линий
на заданное расстояние.

Примечание. Если нужно завершить выполнение команды (например, для изме�
нения расстояния смещения в случае команды  Ïîäîáèå (OFFSET)), достаточно
нажать Esc.

7. Щелкните на верхней горизонтальной линии, а затем снова внутри пря�
моугольного контура. AutoCAD выполнит смещение второй линии.

8. Щелкните на третьей линии, затем внутри прямоугольного контура,
а затем – на четвертой линии и снова внутри контура (рис. 2.11).
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и инструмент С линиями (Line), в том смысле, что он остается активным
до тех пор, пока пользователь не завершит принудительно его работу.

Итак, внутренние линии стенок тумбы построены. Однако, сравнив рис. 2.11
с рис. 2.2, вы увидите, что часть линий на полученном чертеже лишние, а неко�
торых не хватает. Вскоре мы решим эту проблему, однако пока что познако�
мимся с еще одним инструментом AutoCAD, предназначенным для выполне�
ния сопряжения объектов.

2.2.5. Сопряжение объектов с помощью инструмента2.2.5. Сопряжение объектов с помощью инструмента2.2.5. Сопряжение объектов с помощью инструмента2.2.5. Сопряжение объектов с помощью инструмента2.2.5. Сопряжение объектов с помощью инструмента
«Сопряжение» (Fillet)«Сопряжение» (Fillet)«Сопряжение» (Fillet)«Сопряжение» (Fillet)«Сопряжение» (Fillet)
Инструмент Сопряжение (Fillet) выполняет сопряжение углов, образованных
двумя линиями. Радиус сопряжения может быть произвольным. Но в нашем
случае нас интересует сопряжение с радиусом 0 единиц, то есть соединение
линий под углом без округления. Это позволит нам убрать лишние линии, обра�
зованные пересечением внутренних контуров боковых стенок тумбы.

1. Запустите инструмент Сопряжение (Fillet) , щелкнув на кнопке  Со�
пряжение (Fillet) панели Изменить (Modify) или выбрав из меню коман�
ду Изменить ⇒ Сопряжение (Modify ⇒ Fillet) либо введя в командном
окне команду Ñîïðÿæåíèå (FILLET) или просто ñîï (F).

2. В командном окне появится сообщение о текущих параметрах команды
Ñîïðÿæåíèå (FILLET): режим отсечения лишних линий (Ðåæèì =
Ñ îáðåçêîé (Mode = TRIM)) и сопряжение линий с радиусом 0 единиц
(Ðàäèóñ ñîïðÿæåíèÿ = 0.0000 (Radius = 0.0000)). Эти параметры нас
вполне устраивают, поэтому просто подведите отмечающий указатель
к местам, обозначенным на рис. 2.12 и щелкните сначала на правой внут�
ренней вертикальной линии, а затем на верхней внутренней горизон�
тальной линии.

Рис. 2.10  Первая линия сдвинута влево на 20 единиц от исходной

Рис. 2.11  Все четыре линии смещены внутрь контура тумбы

Примечание. Величина смещения остается той же, какой она была задана при
последнем запуске команды  Ïîäîáèå (OFFSET) (в данном случае 20 единиц),
пока она не будет изменена явно в одном из последующих запусков команды.

9. Нажмите Enter для завершения работы инструмента Подобие (Offset).
Как вы уже, наверное, догадались, этот инструмент ведет себя так же, как Рис. 2.12  Точки выбора внутренних линий для их сопряжения
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3. Как только вы щелкните на второй линии, они будут сопряжены с нуле�
вым радиусом, в результате чего эти линии образуют прямой угол
(рис. 2.13), а работа инструмента Сопряжение (Fillet) автоматически за�
вершится. Нажмите Enter для повторного запуска команды Ñîïðÿæåíèå
(FILLET).

Esc для завершения команды, а затем введите в командном окне Îòìåíèòü
(UNDO) или просто î (U). Эта команда отменяет (undo) последнюю операцию,
возвращая чертеж к исходному состоянию.

Конечно, результат, представленный на рис. 2.14, по�прежнему лишь отда�
ленно напоминает чертеж, показанный на рис. 2.2. Однако теперь вы освоили
не только инструмент Подобие (Offset), но и инструмент Сопряжение (Fillet),
 что, как вы вскоре убедитесь, вам еще не раз пригодится. Команды Ïîäîáèå
(OFFSET) и Ñîïðÿæåíèå (FILLET) являются едва ли не наиболее часто исполь�
зуемыми инструментами AutoCAD. В следующих главах мы подробнее ознако�
мимся с методами их применения.

2.3. Завершение чертежа с помощью инструментов2.3. Завершение чертежа с помощью инструментов2.3. Завершение чертежа с помощью инструментов2.3. Завершение чертежа с помощью инструментов2.3. Завершение чертежа с помощью инструментов
«У«У«У«У«Удлинить» (Extend) и «Обрезать» (Tдлинить» (Extend) и «Обрезать» (Tдлинить» (Extend) и «Обрезать» (Tдлинить» (Extend) и «Обрезать» (Tдлинить» (Extend) и «Обрезать» (Trim)rim)rim)rim)rim)
Для завершения чертежа, показанного на рис. 2.2, нам осталось создать прямо�
угольник в нижней части, обозначающий технологический паз на нижней гра�
ни крышки тумбы, а также уточнить изображения боковых стенок тумбы. Из
чертежа видно, что технологический паз должен быть шириной 160 единиц и
высотой 30 единиц. Он расположен на расстоянии 20 единиц от нижней линии
внешнего контура тумбы и 135 единиц от левой и правой вертикальной линий,
обозначающих внутренние контуры боковых стенок. Конечно, можно просто
нарисовать прямоугольник с помощью инструмента С линиями (Line), однако,
как вы, наверное, догадываетесь, эту же задачу гораздо проще решить с помо�
щью инструментов Подобие (Offset) и Сопряжение (Fillet). Кроме того, для

Рис. 2.13  Линии первого внутреннего угла сопряжены

Примечание. Любую команду сразу после ее завершения можно снова запустить,
нажав Enter. Кстати, вы, должно быть, обратили внимание на то, что автор
использует термины «инструмент» и «команда» в качестве синонимов. Это
объясняется тем, что один и тот же инструмент AutoCAD можно запустить
несколькими способами: выбрав команду из меню, щелкнув на кнопке панели ин�
струментов или введя в командном окне название команды или ее псевдоним. Но
поскольку, независимо от метода запуска того или иного инструмента, все сво�
дится к автоматическому или ручному запуску команды в командном окне, ав�
тор использует выражения вида «инструмент Сопряжение (Fillet)» и «команда
Ñîïðÿæåíèå (FILLET)» как синонимы, чтобы лишний раз подчеркнуть значе�
ние командного окна AutoCAD и суть операций, выполняющихся при запуске ин�
струментов AutoCAD.

4. Выполнив сопряжение двух следующих линий, снова запустите инстру�
мент Сопряжение (Fillet) и продолжайте его применять до тех пор, пока
не закончите сопряжение всех углов (рис. 2.14).

Совет. Если по ошибке вы щелкнете не на той линии чертежа, которая вам нуж�
на или не в том месте, в котором нужно, результат сопряжения будет соответ�
ствующим (то есть совсем не таким, как вы ожидаете). В этом случае нажмите

Рис. 2.14  Все внутренние линии чертежа сопряжены
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придания чертежу окончательного вида нам понадобятся еще два инструмен�
та – Удлинить (Extend) и Обрезать (Trim).

2.3.1. Подготовительные операции2.3.1. Подготовительные операции2.3.1. Подготовительные операции2.3.1. Подготовительные операции2.3.1. Подготовительные операции
Для точного задания расположения контура технологического паза выполните
следующие действия.

1. Активизируйте инструмент Подобие (Offset). Обратите внимание на ко�
мандную строку – величина смещения теперь по умолчанию равна 20 еди�
ниц, то есть значению, выбранному во время предыдущей операции сме�
щения.

2. Введите значение смещения 135.
3. Выберите внутреннюю вертикальную линию правой стенки тумбы, а за�

тем произвольную точку, находящуюся левее этой линии. Линия смес�
тится влево на 135 единиц, образуя правую границу контура технологи�
ческого паза (рис. 2.15).

7. Щелкните на нижней горизонтальной линии наружного контура тумбы,
а затем выберите произвольную точку над ней. Нажмите Enter для завер�
шения работы команды Ïîäîáèå (OFFSET) (рис. 2.16).

Рис. 2.15  Построение первой линии контура технологического паза

4. Выберите внутреннюю вертикальную линию левой стенки тумбы, а за�
тем произвольную точку, находящуюся правее этой линии. Линия смес�
тится вправо на 135 единиц, образуя правую границу контура технологи�
ческого паза.

5. Нажмите Enter для завершения команды Ïîäîáèå (OFFSET), затем сно�
ва нажмите Enter для ее повторного запуска, чтобы изменить значение
смещения.

6. В ответ на запрос AutoCAD задать смещение введите в командном окне
значение 50.

Рис. 2.16  Вторая горизонтальная линия прямоугольника,
обозначающего контур технологического паза, создана

8. Запустите инструмент Сопряжение (Fillet) и выполните сопряжение ли�
нии, созданной в п. 7, с внутренней линией левой боковой стенки тумбы.

9. Повторите пп. 5�8, но в этот раз не вводите смещение (просто нажмите
Enter для принятия предложенного по умолчанию значения 50 единиц),
а сопряжение новой линии выполните с внутренней линией правой бо�
ковой стенки тумбы. Результат обоих сопряжений должен быть таким,
как показано на рис. 2.17.

Теперь наш чертеж готов к применению инструментов Удлинить (Extend)
и Обрезать (Trim), с помощью которых мы завершим формирование осталь�
ных элементов чертежа.

2.3.2. Растяжение объектов с помощью инструмента2.3.2. Растяжение объектов с помощью инструмента2.3.2. Растяжение объектов с помощью инструмента2.3.2. Растяжение объектов с помощью инструмента2.3.2. Растяжение объектов с помощью инструмента
«У«У«У«У«Удлинить» (Extend)длинить» (Extend)длинить» (Extend)длинить» (Extend)длинить» (Extend)
Инструмент Удлинить (Extend) предназначен для продления линий до пересе�
чения с другими линиями или объектами чертежа, которые называются ограни�
чивающими ребрами (boundary edge). У этого инструмента несколько необычная
логика, однако с практикой его применение становится почти автоматическим
и не будет вызывать у вас затруднений. Инструмент Удлинить (Extend) приме�
няется в два этапа: вначале выбирается ограничивающее ребро, а затем выби�
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раются линии, которые должны быть растянуты до пересечения с ним (в этом
и заключается необычность логики этого инструмента – большинство других
инструментов AutoCAD предлагают сначала выбрать объект, над которым бу�
дет выполняться операция). Завершение выбора ограничивающего ребра за�
вершается нажатием Enter.

1. Запустите инструмент Удлинить (Extend), щелкнув на кнопке  Удли�
нить (Extend) панели Изменить (Modify) или выбрав из меню команду
Изменить ⇒ Удлинить (Modify ⇒ Extend) либо введя в командном окне
команду Óäëèíèòü (EXTEND) или просто ó (EX). В командном окне
AutoCAD предложит вам выбрать ограничивающие ребра.

2. Выберите самую верхнюю горизонтальную линию (рис. 2.18) и нажмите
Enter.

Совет. В подавляющем большинстве случаев выбор объектов в AutoCAD заверша�
ется нажатием Enter, независимо от того, сколько объектов вы выбираете – один
или сотню. Поэтому вам придется запомнить, что для продолжения работы
с командой, предлагающей выбрать объекты, нужно завершить выбор, нажав
Enter.

3. Выберите две вертикальные линии, обозначающие внутренние контуры
боковых стенок тумбы. Имейте в виду, что если вы будете щелкать в ниж�
ней части линий, AutoCAD проигнорирует выбор. Поэтому щелкайте
в верхней части линий, неподалеку от ограничивающего ребра. Сразу
же после щелчка линии будут удлиняться до пересечения с ограничиваю�
щим ребром. Нажмите Enter для завершения команды Óäëèíèòü
(EXTEND) (рис. 2.19).

2.3.3. Обрезка объектов с помощью инструмента2.3.3. Обрезка объектов с помощью инструмента2.3.3. Обрезка объектов с помощью инструмента2.3.3. Обрезка объектов с помощью инструмента2.3.3. Обрезка объектов с помощью инструмента
«Обрезать» (T«Обрезать» (T«Обрезать» (T«Обрезать» (T«Обрезать» (Trim)rim)rim)rim)rim)
Последним этапом построения чертежа является окончательное оформление
контура технологического паза. Конечно, эту задачу можно было бы решить,
применив четыре раза инструмент Сопряжение (Fillet) (с применением инст�

Рис. 2.17  Боковые стенки тумбы после сопряжения Рис. 2.18  Выбор верхней линии в качестве ограничивающего ребра

Рис. 2.19  Внутренние вертикальные линии боковых стенок
продлены до пересечения с ограничивающим ребром

Завершение чертежа с помощью инструментов «УЗавершение чертежа с помощью инструментов «УЗавершение чертежа с помощью инструментов «УЗавершение чертежа с помощью инструментов «УЗавершение чертежа с помощью инструментов «Удлинить» и «Обрезать»длинить» и «Обрезать»длинить» и «Обрезать»длинить» и «Обрезать»длинить» и «Обрезать»



Создание первого чертежаСоздание первого чертежаСоздание первого чертежаСоздание первого чертежаСоздание первого чертежа56 57

румента Подобие (Offset) для создания верхней горизонтальной линии конту�
ра паза). Однако мы рассмотрим еще один инструмент, который позволит нам
решить эту задачу немного быстрее. Этот инструмент называется Обрезать
(Trim) и предназначен он для обрезки линий, выступающих за пределы других
линий или объектов чертежа. Как и в случае инструмента Удлинить (Extend),
обрезка выполняется в два этапа. На первом этапе выбираются вспомогатель�
ные линии – в данном случае они называются секущими ребрами (cutting edge),
поскольку обрезка линий выполняется до пересечения с ними.

1. Запустите инструмент Обрезать (Trim), щелкнув на кнопке  Обрезать
(Trim) панели Изменить (Modify) или выбрав из меню команду Изме�
нить ⇒ Обрезать (Modify ⇒ Trim) либо введя в командном окне команду
Îáðåçàòü (TRIM) или просто îáð (TR). Как и при использовании коман�
ды Óäëèíèòü (EXTEND), AutoCAD в командном окне предложит вам вы�
брать объекты, которые в данном случае будут использоваться как секу�
щие ребра.

2. Выберите две вертикальные линии, созданные с помощью инструмента
Подобие (Offset), которые обозначают правую и левую вертикальную
границы контура технологического паза (рис. 2.20) и нажмите Enter для
завершения выбора. 5. Нажмите Enter для завершения работы команды Îáðåçàòü (TRIM).

Нам осталось лишь создать верхнюю линию контура технологического
паза, а затем обрезать верхние части линий, которые мы только что ис�
пользовали в качестве секущих ребер.

Примечание. Отменить неудачно выполненную команду  Îáðåçàòü (TRIM)
можно, введя в командном окне  Îòìåíèòü (UNDO) или просто î (U) либо щелк�
нув на кнопке Отменить (Undo) панели инструментов Standard.

6. С помощью инструмента Подобие (Offset) сместите нижнюю линию кон�
тура паза вверх на 30 единиц.

7. Снова запустите инструмент Обрезать (Trim) и выберите в качестве се�
кущего ребра только что созданную верхнюю горизонтальную линию
контура паза (рис. 2.22).

8. Нажав Enter для завершения выбора секущих ребер, в ответ на пригла�
шение AutoCAD выбрать линии, подлежащие обрезке, сначала левую,
а затем правую вертикальные линии, как показано на рис. 2.23. AutoCAD
будет тут же обрезать выбранные линии.

9. Нажмите Enter для завершения команды Îáðåçàòü (TRIM).
Сравнив полученный результат (рис. 2.24) с исходным чертежом (см. рис. 2.2),

мы видим, что поставленная цель достигнута. Несколько простых инструмен�
тов, изученных в этой главе, вам еще не раз пригодятся не только при изучении
остальных глав этой книги, но и в повседневной работе с AutoCAD.

Если вы чувствуете, что не совсем уверенно овладели инструментами С ли�
ниями (Line), Подобие (Offset), Стереть (Erase), Сопряжение (Fillet), Обре�
зать (Trim) и Удлинить (Extend), можете попробовать повторить создание
рассмотренного чертежа еще несколько раз. В AutoCAD нет правильных и не�

Рис. 2.20  Линии, выбранные в качестве секущих ребер

3. Выберите горизонтальную линию, обозначающую нижнюю лини конту�
ра паза, поместив указатель не между выбранными секущими ребрами,
а слева или справа от них (рис. 2.21).

4. Повторите операцию, описанную в п. 3, но в этот раз выберите остав�
шийся сегмент нижней линии, выступающий за другое секущее ребро.

Рис. 2.21  Выбор правого сегмента нижней линии паза для обрезки
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Потренировавшись, можете закрыть AutoCAD, не сохраняя построенного
чертежа. Для этого выберите из меню команду Файл ⇒ Выход (File ⇒ Exit) или
просто нажмите Alt+F4. (Если не хотите выходить из AutoCAD, просто закрой�
те текущий чертеж, выбрав из меню команду Файл ⇒ Закрыть (File ⇒ Close)
или нажав Ctrl+F4.) В ответ на предложение AutoCAD сохранить чертеж щелк�
ните на кнопке Нет.

Теперь вы готовы к изучению материала следующей главы, в которой мы
поговорим о следующей проблеме. Объект, который изображен на только что
созданном нами чертеже, имеет размеры 470 на 400 единиц. В данном случае
можно предположить, что речь идет о миллиметрах. Однако такое предполо�
жение можно сделать далеко не всегда Например, если перед нами чертеж вала
электрогенератора длиной 10 единиц, то какую длину эта деталь имеет в дей�
ствительности: 10 мм, 10 см или 10 м? К тому же, чертеж офисной тумбы соот�
ветствует установленным по умолчанию размерам окна AutoCAD, поэтому у нас
и в этом смысле никаких проблем не возникло. Но представьте, что вам дей�
ствительно нужно создать чертеж 15�метрового вала электрогенератора диа�
метром несколько метров! Наконец, если вы создаете чертеж для иностранных
партнеров, оперирующих не метрической, а британской системой единиц, вам
волей�неволей придется создавать чертеж не в метрах и сантиметрах, а в футах
и дюймах. Поэтому в следующей главе мы поговорим о том, как настроить па�
раметры чертежа в соответствии со стоящей перед пользователем AutoCAD
задачей.

Рис. 2.22  Верхняя горизонтальная линия контура паза
выбрана в качестве секущего ребра

Рис. 2.23  Левая вертикальная линия обрезана, теперь настал черед правой

Рис. 2.24  Окончательный вид чертежа

правильных методов получения результата – вы можете применить другую пос�
ледовательность создания чертежа или другую последовательность примене�
ния инструментов, отличную от предложенной автором. Кроме того, можете
попробовать выполнить чертеж, запуская все инструменты с помощью ввода
их псевдонимов в командном окне.
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Когда мы создавали в главе 2 чертеж вида снизу офисной тумбы, область
черчения использовалась нами в том стандартном виде, какой она име�
ет при создании нового файла. При разрешении 1024 × 768 пикселей

эти размеры обычно составляют 300 единиц в высоту и 580–600 единиц в дли�
ну, в зависимости от настройки панелей инструментов.

Практически вся оставшаяся часть книги будет посвящена построению чер�
тежей рабочей зоны детской комнаты с габаритными размерами 1,5 × 3,0 м.
Но, прежде чем приступать к созданию первого чертежа, мы рассмотрим
в этой главе методы настройки основных параметров чертежа, которые позво�
лят нам разместить в пространстве модели объект заданных размеров. Для это�
го нам понадобиться увеличить установленный по умолчанию размер области
черчения, чтобы в ней целиком поместился чертеж рабочей зоны детской ком�
наты в натуральную величину. Кроме того, в этой главе мы рассмотрим еще
несколько инструментов, с помощью которых можно изменить внешний вид
окна AutoCAD, а также создавать объекты на чертеже длиной, кратной фикси�
рованному шагу. В конце главы мы поговорим о том, как сохранять файл черте�
жа на диске.

3.1. Настройка линейных и угловых единиц измерения3.1. Настройка линейных и угловых единиц измерения3.1. Настройка линейных и угловых единиц измерения3.1. Настройка линейных и угловых единиц измерения3.1. Настройка линейных и угловых единиц измерения
В AutoCAD при вычерчивании линий, а также объектов, состоящих из сегмен�
тов линий, используется одна из пяти систем линейных единиц. Угловые вели�
чины также могут измеряться в одной из пяти систем. Пользователь может
выбрать самостоятельно как тип линейных, так и тип угловых единиц измере�
ний либо воспользоваться соответствующим шаблоном. Например, в предыду�
щей главе мы использовали шаблон acadiso.dwt, который предназначен для со�
здания чертежей на основе десятичной метрической системы единиц.

Как вы уже знаете, при создании нового чертежа на экране появляется пус�
той документ AutoCAD с названием вида ЧертежN.dwg (DrawingN.dwg). Если
этот чертеж создан на основе шаблона acadiso.dwt, для него по умолчанию при�
нята метрическая (metric) система единиц измерения. Если создать новый доку�
мент на основе шаблона acad.dwt, в нем по умолчанию будет использоваться
британская (imperial) система единиц измерения (дюймы, футы, ярды и т. п.).
Как уже отмечалось в предыдущей главе, вы можете создать собственный шаб�
лон и создавать на его основе все последующие чертежи. Однако сначала нуж�
но разобраться с принципами настройки основных параметров чертежа.

3.1.1. Настройка линейных единиц3.1.1. Настройка линейных единиц3.1.1. Настройка линейных единиц3.1.1. Настройка линейных единиц3.1.1. Настройка линейных единиц
Для настройки линейных единиц выполните следующие действия.

1. Запустите AutoCAD, выберите из меню команду Файл ⇒ Закрыть (File ⇒
Close) или нажмите Ctrl+F4 для закрытия созданного по умолчанию чер�
тежа, а затем воспользуйтесь командой Файл ⇒ Создать (File ⇒ New)
или нажатием Ctrl+N для создания нового чертежа на основе шаблона
acadiso.dwt.

2. Выберите из меню команду Формат ⇒ Единицы (Format ⇒ Units) либо
введите в командном окне команду Åäèíèöû (UNITS) или просто åä (UN).
В открывшемся диалоговом окне Единицы чертежа (Drawing Units)
(рис. 3.1) убедитесь в том, что в списке Формат (Type) группы Линейные
(Length) выбран пункт Десятичные (Decimal), а в списке Формат (Type)
группе Угловые (Angle) – пункт Десятичные градусы (Decimal Degrees).

3ГГГГГлавалавалавалавалава
Основные параметрыОсновные параметрыОсновные параметрыОсновные параметрыОсновные параметры
чертежачертежачертежачертежачертежа

Рис. 3.1  Диалоговое окно Единицы чертежа
(Drawing Units)

3. Так как при проектировании рабочей зоны детской комнаты мы будем
пользоваться метрической системой единиц, оставьте в списке Формат
(Type) группы Линейные (Length) выбранным значение Десятичные
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(Decimal), поскольку все остальные (Архитектурные (Architectural),
Инженерные (Engineering) и Дробные (Fractional)) используют немет�
рические единицы (футы, дюймы и их доли). Выбор значения Научные
(Scientific) приводит к тому, что все размеры будут указываться в так на�
зываемом научном формате (например, значение 2.0039 в этом формате
выглядит как 2.0039E+00), что в нашем случае не очень удобно. Для того
чтобы понять, чем отличаются различные типы систем единиц, попро�
буйте выбрать какое�либо другое значение из списка Формат (Type) и
обратите внимание на примеры, представленные в области Пример
(Sample Output). Для возврата к метрической системе единиц снова вы�
берите пункт Десятичные (Decimal).

4. Теперь обратите внимание на два раскрывающихся списка Точность
(Precision), которые в группах Линейные (Length) и Угловые (Angle) на�
ходятся под списками Формат (Type). Щелкните на кнопке раскрытия
списка Точность (Precision) в группе Линейные (Length). Список откро�
ется, и в нем будут перечислены допустимые значения точности для сис�
темы единиц Десятичные (Decimal) (рис. 3.2).

Примечание. Раскрывающиеся списки представляют собой элементы управле�
ния, в которых в свернутом состоянии отображается текущий элемент. После
щелчка на кнопке раскрытия списка (на ней изображен направленный вниз тре�
угольник), на экране отображается весь список, что позволяет выбрать из него
другой элемент. После выбора список закрывается и в нем отображается только
выбранный элемент. Как и в случае переключателей, из раскрывающегося списка
можно выбрать только один элемент.

5. Заданная с помощью этого списка точность влияет лишь на точность
представления линейных размеров на чертеже AutoCAD. Если точность

равна 0.1, то любая линия, длина которой задана с большей точностью
(например, 2.0039), будет отображаться с округлением до 0.1 (в нашем
примере до 2.0). Тем не менее, линия на самом деле будет иметь заданную
длину 2.0039. Если изменить значение точности на 0.0001, а затем вос�
пользоваться командой Длина (Distance) (рассматривается в материале
главы 7) для определения длины линии, то измерение покажет длину
2.0039.

6. Выберите из списка Точность (Precision) пункт 0.0 для представления
линейных размеров с точностью до 0.1 мм.

3.1.2. Настройка угловых единиц3.1.2. Настройка угловых единиц3.1.2. Настройка угловых единиц3.1.2. Настройка угловых единиц3.1.2. Настройка угловых единиц
В списке Формат (Type) группы Угловые (Angle), выбранное значение кото�
рого определяет тип угловых единиц измерения, , как уже говорилось выше,
должен быть выбран тип Десятичные градусы (Decimal Degrees). Тип Град/
Мин/Сек (Deg/Min/Sec), соответствующий представлению угловых ве�
личин в системе «градусы�минуты�секунды», а также другие типы (Градусы
(Grads), Радианы (Radians) и Топографические единицы (Surveyor’s Units))
менее удобны на практике. Однако установленная по умолчанию точность
представления угловых величин для типа Десятичные градусы (Decimal
Degrees), слишком низка, поэтому ее следует изменить на более приемлемое
значение.

1. Щелкните на кнопке раскрытия списка Точность (Precision) группы Уг�
ловые (Angle).

2. Выберите из раскрывшегося списка элемент 0.00. Теперь параметры
диалогового окна Единицы чертежа (Drawing Units) показывают, что
в чертеже будет использоваться система десятичного представления
линейных единиц (Десятичные (Decimal)) с точностью 0.1 мм и сис�
тема десятичного представления угловых единиц, выраженная в гра�
дусах и десятичных долях градуса (Десятичные градусы (Decimal Deg�
rees)), с точностью 0.01 градуса
(рис. 3.3).

3. Щелкнув на кнопке Направле�
ние (Direction), расположенной
в нижней части окна Единицы
чертежа (Drawing Units), мож�
но открыть диалоговое окно
Выбор направления (Direction
Control). В этом окне, в случае
необходимости, можно изменить
направление, соответствующе�

Рис. 3.2  Раскрывающийся список Точность (Precision)
для системы единиц Десятичные (Decimal)

Рис. 3.3  Диалоговое окно
Единицы чертежа (Drawing Units) после

настройки параметров единиц измерений
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го углу 0°. Эти параметры незачем изменять, поэтому просто откройте
окно Выбор направления (Direction Control), посмотрите на значения
параметров (они соответствуют значениям, которые были показаны в
главе 2 на рис. 2.7) и закройте его щелчком на кнопке OK. В остальных
главах книги эти параметры не будут изменяться.

4. Закройте окно Единицы чертежа (Drawing Units), щелкнув на кнопке
OK, а затем посмотрите на индикатор координат в левой части строки
состояния. Значения координат на нем не изменились, но, как и было
обещано в предыдущей главе, точность их представления изменилась
в соответствии с только что выбранными вами параметрами в окне Еди�
ницы чертежа (Drawing Units).

Ознакомившись с параметрами диалогового окна Единицы чертежа (Dra�
wing Units), вы получили представлении о системах линейных и угловых еди�
ниц, поддерживаемых в AutoCAD, а также о методах выбора точности пред�
ставления линейных и угловых величин. Теперь вам предстоит разобраться
с методами настройки размеров чертежа в соответствии с размерами реально�
го объекта, который должен быть изображен на этом чертеже.

3.2. Настройка размеров чертежа3.2. Настройка размеров чертежа3.2. Настройка размеров чертежа3.2. Настройка размеров чертежа3.2. Настройка размеров чертежа
Как вы уже знаете, область черчения – это та часть экрана, в которой вы созда�
ете собственно чертеж объекта. В случае необходимости можно изменять мас�
штаб просмотра так, чтобы в области черчения отображался не весь чертеж,
а лишь его фрагмент. Соответствующие операции называются масштабировани�
ем (zooming).В первых главах книги мы уже упоминали инструменты масштаби�
рования, а также применяли некоторые из них для изменения масштаба чертежа
офисной тумбы в главе 2. Теперь мы рассмотрим эти инструменты подробнее,
но не на примере чертежа, а с помощью специального средства AutoCAD, назы�
ваемого сеткой (grid). Основное назначение сетки заключается в облегчении
создания чертежей, однако в нашем примере мы воспользуемся ею для нагляд�
ного представления размеров чертежа.

3.2.1. Использование сетки3.2.1. Использование сетки3.2.1. Использование сетки3.2.1. Использование сетки3.2.1. Использование сетки
Итак, сетка – это упорядоченный набор равномерно распределенных по плос�
кости чертежа точек, предназначенных для упрощения черчения. По умолча�
нию сетка невидима, но в случае необходимости пользователь может включить
ее отображение. Размеры области, покрываемой сеткой, определяются так на�
зываемыми границами чертежа (drawing limits). Для настройки размера сетки и
ее шага (то есть расстояния между точками) лучше сделать сетку видимой,
а затем изменить масштаб изображения с помощью инструментов Уменьшить
(Zoom In) и Увеличить (Zoom Out). После масштабирования можно изменить
границы чертежа, обозначенные сеткой. Однако сначала мы отключим изобра�
жение пиктограммы ПСК, как было обещано в главе 1.

1. Выберите из меню команду ид ⇒⇒⇒⇒⇒ Отображение ⇒⇒⇒⇒⇒ Знак ПСК ⇒⇒⇒⇒⇒ Вкл.
(View ⇒ Display ⇒ UCS Icon ⇒ On) или введите в командном окне команду
ÇíàêÏÑÊ, а затем îòêë (UCSICON OFF). Пиктограмма ПСК исчезнет.

2. Выберите из меню команду Вид ⇒⇒⇒⇒⇒ Зумирование ⇒⇒⇒⇒⇒ Границы (View ⇒
Zoom ⇒ Extents) либо введите в командном окне команду Ïîêàçàòü
(ZOOM), а затем ãðàíèöû (ZOOM EXTENTS) или просто ïî (Z), а затем –
ã (E). Масштаб изменится так, чтобы сетка занимала всю область черче�
ния (пока она невидима, но масштабирование все равно произойдет).

3. Переместите указатель�перекрестие в строку состояния и щелкните на
кнопке�индикаторе Сетка (GRID). Кнопка Сетка (GRID) станет нажа�
той, а в области черчения появятся точки (рис. 3.4). Эти точки и есть сет�
ка. По умолчанию она нанесена с шагом 10 единиц вправо и вверх от точ�
ки (0.0,0.0) до точки с координатами (420.0,290.0).

Рис. 3.4  Область черчения AutoCAD,
масштабированная по границам созданной по умолчанию сетки

4. Для лучшего обзора всей сетки в целом воспользуемся инструментом
Увеличить (Zoom Out), предназначенным для увеличения масштаба (то
есть для уменьшения изображения и увеличения области обзора). Выбе�
рите из меню команду Вид ⇒⇒⇒⇒⇒ Зумирование ⇒⇒⇒⇒⇒ Где искать (View ⇒ Zoom ⇒
Out). Теперь мы словно поднялись над областью черчения, вследствие
чего сетка станет меньше, а ее шаг – реже.

5. Для того чтобы точки сетки были расположены гуще (то есть отобража�
лись всегда через каждые 10 единиц, а не через 50, как сейчас), введите
в командном окне GRIDDISPLAY, а затем 4. Точки сетки примут вид, по�
казанный на рис. 3.5. Размеры сетки останутся теми же – поместите ука�
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затель�перекрестие сначала в левый нижний угол сетки, а затем в правый
верхний. Эти точки по�прежнему будут иметь координаты (0.0,0.0) и
(420.0,290.0), соответственно.

6. Щелкните на кнопке�индикаторе ШАГ (SNAP) (она находится в строке
состояния рядом с кнопкой�индикатором Сетка (GRID)). Поместите ука�
затель�перекрестие на сетку и попробуйте перемещать его по горизон�
тали или вертикали. Вы заметите, что указатель начал двигаться скач�
кообразно, останавливаясь на точках сетки с шагом 10 единиц. Как вы
догадались, кнопка�индикатор ШАГ (SNAP) управляет режимом привяз�
ки указателя к точкам сетки, который сохраняется даже в том случае, ког�
да указатель�перекрестие находится за пределами сетки.

Сетка – это достаточно полезное средство AutoCAD. Например, введя ко�
манду GRIDDISPLAY 0, вы включите режим вычерчивания линий только в об�
ласти, покрытой сеткой (включать этот режим автор вам не рекомендует, по�
скольку выгоды от этого режима сомнительны). Однако в большинстве случаев
пользователи AutoCAD предпочитают создавать чертежи без привязки к раз�
мерам сетки, используя последнюю лишь в качестве средства визуализации гра�
ниц чертежа.

Кстати, раз речь зашла о границах чертежа, самое время заняться их на�
стройкой, используя отображаемую на экране сетку для визуального контроля
выполняемых операций. Поскольку детская комната, чертеж рабочей зоны
которой мы будем разрабатывать в оставшейся части книги, имеет размер
2,85 × 4,90 м, нам нужно установить для сетки размер 4900 × 2850 мм. Поскольку
сетка соответствует границам чертежа, для решения этой задачи нам нужно из�
менить эти границы.

3.2.2. Настройка границ чертежа3.2.2. Настройка границ чертежа3.2.2. Настройка границ чертежа3.2.2. Настройка границ чертежа3.2.2. Настройка границ чертежа
В AutoCAD под  границами чертежа (drawing limits) понимаются координаты ле�
вого нижнего и верхнего правого углов сетки. Координаты левого нижнего угла
по умолчанию равны (0.0,0.0) и их обычно не изменяют. Это позволяет для изме�
нения границ чертежа просто изменить координаты верхнего правого угла.

1. Выберите из меню команду Формат ⇒⇒⇒⇒⇒ Лимиты (Format ⇒ Drawing
Limits) или введите в командном окне команду ëèìèòû (LIMITS). В сооб�
щении, которое появится в командном окне, будет сказано, что выполне�
ние этой команды начинается с изменения координат левого нижнего
угла, которые в данный момент равны (0.0000,0.0000).

2. Поскольку мы решили, что изменять координаты левого нижнего угла не
будем, нажмите Enter для принятия значений координат, предложен�
ных по умолчанию. AutoCAD предложит в командном окне задать коор�
динаты верхнего правого угла.

3. Введите 4900,2850. Тем самым вы определите размер сетки равным
4,9 × 2,85 м, выраженный в миллиметрах. AutoCAD после выполненной
настройки единиц измерения отображает размеры с точностью до од�
ной десятой миллиметра, но нам соблюдать такую точность при вводе
значений не обязательно.

4. Как только вы введете координаты правого верхнего угла, сетка существен�
но увеличиться в размере, выйдя за пределы области черчения (рис. 3.6).
Как вы уже знаете, для того, чтобы увидеть всю сетку, нужно увеличить мас�
штаб изображения. Для этого можно воспользоваться инструментами
Уменьшить (Zoom In) или Зумировать в границах (Zoom Extents), но мы
в этот раз для применим инструмент Зумировать все (Zoom All).

Рис. 3.5  Сетка в увеличенном масштабе

Рис. 3.6  Сетка после увеличения границ чертежа
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5. Выберите из меню команду Вид ⇒⇒⇒⇒⇒ Зумирование ⇒⇒⇒⇒⇒ Все (View ⇒ Zoom ⇒
All) либо введите в командном окне команду Çóìèðîâàòü âñå (ZOOM
ALL) или просто ç (Z), а затем – â (A). Эффект будет обратным ожидаемо�
му – сетка вообще исчезнет с экрана.

Дело в том, что сетка сейчас, мягко говоря, густовата – вспомните о том, что
по умолчанию шаг сетки равен 10 единиц, что в нашем случае соответствует
10 мм. Понятно, что расположить такое количество точек в области черчения
AutoCAD не в состоянии, в результате чего режим Ñåòêà (Grid) автоматически
выключился, а в командном окне появилось сообщение, о том, что сетка слиш�
ком плотная для отображения.

Таким образом, нам нужно увеличить шаг сетки для того, чтобы, во�первых,
она отображалась на экране, а во�вторых, чтобы с ней было удобно работать,
учитывая габаритные размеры нашего объекта (1,5 × 3 м). Ясно, что шаг 10 мм
является слишком мелким. Как вы помните, щелкнув на кнопке�индикаторе
ШАГ (SNAP), вы включили одноименный режим привязки к точкам сетки.
Поскольку один из размеров детской комнаты кратен 50 мм (2850 мм), для вы�
черчивания плана рабочей зоны мы можем сделать шаг сетки равным 50 мм,
что позволит нам успешно применять привязку к сетке для создания на черте�
же основных мебельных элементов рабочей зоны. Кроме того, AutoCAD позво�
ляет привязать шаг сетки к шагу привязки. Давайте выполним соответствую�
щую настройку, проделав следующие операции.

1. Выберите из меню команду Сервис ⇒⇒⇒⇒⇒ Режимы рисования (Tools ⇒
Drafting Settings) либо введите в командном окне команду ðåæèìðèñ
(DSETTINGS). Перейдите, если в этом есть необходимость, в открыв�
шемся диалоговом окне Режимы рисования (Drafting Settings) на вклад�
ку Шаг и Сетка (Snap and Grid) (рис. 3.7). Параметры режимов Сетка
(Grid) и Шаг (Snap) находятся в этом окне в группах с соответствующи�
ми названиями. Обратите внимание, что для обоих режимов шаг имеет
значение 10.

2. В строке Шаг сетки по Х (Grid X spacing) группы Шаг сетки (Grid spacing)
вместо текущего значения введите значение 0. Это означает, что шаг сет�
ки будет автоматически настраиваться на шаг привязки в режиме Шаг
(Snap). Щелкните на строке Шаг сетки по Y (Grid Y spacing) или нажмите
Tab для перехода в эту строку из строки Шаг сетки по Х (Grid X spacing),
и соответствующее значение автоматически станет таким же.

3. В строке Шаг сетки по Х (Grid X spacing) группы Шаг (Snap) вместо те�
кущего значения введите значение 50. Затем щелкните в строке Шаг сет�
ки по Y (Grid Y spacing) или нажмите Tab для перехода в эту строку, и ее
значение автоматически станет равным значению строки Шаг сетки по
Х (Grid X spacing).

4. Щелкните на кнопке OK для закрытия окна Режимы рисования (Draf�
ting Settings).

После настройки шага сетки равным 50 мм она приобретет вид, показанный
на рис. рис. 3.8 (обратите внимание на индикатор координат в строке состоя�

Рис. 3.7  Диалоговое окно Режимы рисования (Drafting Settings)

Рис. 3.8  Сетка размером 4900 ґ 2850 мм с шагом 50 мм
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ния). Попробуйте перемещать указатель�перекрестие по сетке, чтобы убедить�
ся в том, что координаты в каждой точке кратны 5 см.

3.2.3. Использование режимов «Сетка» (Grid) и «Шаг»3.2.3. Использование режимов «Сетка» (Grid) и «Шаг»3.2.3. Использование режимов «Сетка» (Grid) и «Шаг»3.2.3. Использование режимов «Сетка» (Grid) и «Шаг»3.2.3. Использование режимов «Сетка» (Grid) и «Шаг»
(Snap) на практике(Snap) на практике(Snap) на практике(Snap) на практике(Snap) на практике
Ну что ж, работа по настройке параметров чертежа завершена и теперь можно
приступать с вычерчиванию плана рабочей зоны детской комнаты. Для начала
мы начертим четыре линии, обозначающие габариты рабочей зоны относи�
тельно самой детской комнаты.

1. Запустите инструмент С линиями (Line) (например, введя в командном
окне L) и выберите точку сетки с координатами (0.0, 1350.0), как показа�
но на рис. 3.9. (Как нетрудно догадаться, выбрать точку с конкретными
координатами без сетки было бы невозможно – пришлось бы вводить их
с клавиатуры.)

точкой, а угол должен иметь значение 0.00 (третья координата, как мы
договорились в предыдущей главе, нас не интересует).

4. Продолжайте перемещать указатель�перекрестие по горизонтали впра�
во до тех пор, пока значение координаты не станет равным 3000.0<0.00.
Щелкните в этой точке, и AutoCAD создаст линию, обозначающую длину
рабочей зоны детской комнаты (рис. 3.10).

Рис. 3.9. Первая габаритная точка рабочей зоны, выбранная с помощью сетки

2. Переместите указатель�перекрестие вправо от только что выбранной
точки и взгляните на индикатор координат. По умолчанию он отобража�
ет координаты в декартовой системе. Для переключения в полярную сис�
тему координат щелкните на индикаторе два раза (после первого щелчка
индикатор отключится, а в командном окне появится сообщение <По�
лярная откл> (<Coords off>)).

3. Переместите указатель�перекрестие вправо строго по горизонтали от
выбранной точки, наблюдая за показаниями индикатора координат. На
индикаторе должно отображаться расстояние между первой и текущей

Рис. 3.10  Первая габаритная линия рабочей зоны детской комнаты

5. Переместите указатель�перекрестие вертикально вверх в точку с коорди�
натами 1500.0<90.00 и выберите ее, щелкнув мышью.

6. Переместите указатель�перекрестие влево по горизонтали и выберите
точку с координатами 3000.0<180.00 (рис. 3.11).

Примечание. Сообщение Конточка (Endpoint), которое может появиться на эк�
ране, как показано на рис. 3.11, – это результат срабатывания режима объект�
ной привязки, о котором мы будем говорить в последующих главах. Если вы счи�
таете, что этот режим вам мешает, можете выключить его, а также режим
отслеживания объектной привязки, щелкнув на кнопках�индикаторах ПРИ�
ВЯЗКА (OSNAP) и ОТС�ОБЪЕКТ (OTRACK), соответственно, для перевода их
в ненажатое состояние.

7. Для завершения построения прямоугольника введите Çàìêíóòü (CLOSE)
или просто ç (C). AutoCAD замкнет контур (рис. 3.12) и автоматически
завершит выполнение команды Îòðåçîê (LINE).

Метод создания чертежей, основанный на использовании привязки к сетке
и индикатора координат, удобен в тех случаях, когда все или большинство раз�
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Рис. 3.11  Построение второй и третьей габаритных линий рабочей зоны

Рис. 3.12  Законченный контур габаритов рабочей зоны

меров объекта кратны определенной величине. Кстати, шаг сетки и шаг при�
вязки вовсе не обязательно должны быть одинаковыми – достаточно, чтобы
шаг сетки был кратным шагу привязки. В нашем случае, например, можно было
бы сделать шаг привязки равным 50 мм, а шаг сетки – 100 мм. При этом на экра�
не было бы меньше точек, а указатель�перекрестие все равно останавливался
бы в точках, кратных половине расстояния между точками сетки.

Однако основное преимущество черчения с использованием сетки по срав�
нению с методом, рассмотренным в главе 2, заключается, конечно же, в отсут�
ствии необходимости ввода значений с клавиатуры, а также выполнения вы�
числений. Тем не менее, следует отметить, что в некоторых случаях легче не
привязываться к сетке, а просто ввести относительные координаты с клавиату�
ры. Как уже отмечалось автором выше, в AutoCAD нет правильных и непра�
вильных методов черчения: в одних ситуациях лучше использовать одним ме�
тоды, а в других – другие. Кроме того, бывает и так, что пользователь, выбрав
какой�то один метод, применяет его во всех случаях, предпочитая использо�
вать хорошо изученный инструмент вместо незнакомого. Как поступать вам,
вы сможете решить по мере накопления опыта.

3.3. Сохранение чертежа в файле3.3. Сохранение чертежа в файле3.3. Сохранение чертежа в файле3.3. Сохранение чертежа в файле3.3. Сохранение чертежа в файле
Как и многие Windows�приложения, AutoCAD при первом сохранении нового
документа в файле предлагает переименовать его, а также позволяет выбрать
или создать папку, в которой этот файл будет храниться. В последующих главах
мы рассмотрим, как выбрать папку и файл и еще до открытия нового чертежа,
но поскольку документ, содержащий контур рабочей зоны детской комнаты,
уже открыт, вам осталось только его сохранить.

Лучше всего сохранять файлы, посвященные отдельному проекту, в своей
папке с соответствующим именем, например, «Детская» или Children Room.
Такую папку можно создать с помощью средств Windows или непосредственно
при сохранении файла, выполнив для этого следующие действия.

1. Щелкните на кнопке  Сохранить (Save) панели инструментов Stan�
dard или выберите из меню команду Файл ⇒⇒⇒⇒⇒ Сохранить (File ⇒ Save)
либо введите в командном окне команду Ñîõðàíèòü (QSAVE) или нажми�
те Ctrl+S. Откроется диалоговое окно Сохранение чертежа (Save Dra�
wing As) (рис. 3.13).

2. В раскрывающемся списке Папка (Save In) выберите папку, в которой вы
хотите создать новую папку для хранения учебных файлов (по умолча�
нию AutoCAD предлагает сохранить файл в папке «Мои документы»).

3. Щелкните на кнопке  Создать папку (Create New Folder), находящей�
ся в верхней части диалогового окна Сохранение чертежа (Save Drawing
As), или нажмите Alt+5.

4. Введите название новой папки, например Children Room.
5. Щелкните дважды на новой папке для ее открытия.
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Начиная с этой главы, мы будем создавать чертеж рабочей зоны детской
комнаты, которая представляет собой комбинированный стол для
подростка и ученика начальных классов. Общий вид рабочей зоны

представлен на рис. 4.1. В левой части находится рабочее место подростка,
обеспечивающее размещение компьютерной техники: под столом имеются от�
сек для системного блока и выдвижная доска для клавиатуры, на столе – дисп�
лей и две стойки для компакт�дисков, над столом на полке – лазерный принтер.
Кроме того, слева от пользователя должно быть достаточно пространства для
размещения сканера.

6. В строке Имя файла (File name) измените имя файла, набрав вместо
Чертеж1.dwg (Drawing1.dwg) название Work030 (расширение dwg можно
не набирать).

Примечание. Начиная с этой главы, учебные чертежи будут сохраняться в фай�
лах с именами Workxxy, где xx – номер главы. Так вам будет легче в случае необ�
ходимости разыскивать в книге ссылки на те или иные чертежи. Если главе сохра�
няется несколько чертежей, они будут называться соответственно Workxx0,
Workxx1 и т. д.

7. Щелкните на кнопке Сохранить (Save). Теперь, сохранив результаты рабо�
ты в файле, можете выйти из AutoCAD, выбрав из меню команду Файл ⇒
Выход (File ⇒ Exit) или нажав Alt+F4.

В заключение нужно отметить, что операции, рассмотренные в этой главе
(выбор единиц измерения, точности их представления, настройка границ чер�
тежа и шага сетки и шага привязки к ней), являются обязательными для созда�
ния любого нового чертежа и подготовки его к работе над проектом.

В следующей главе вы приступите к изучению новых команд черчения и мо�
дификации объектов чертежа, а также научитесь решать ряд типичных про�
блем, возникающих при создании чертежей средней сложности.

Рис. 3.13  Диалоговое окно Сохранение чертежа (Save Drawing As)

4ГГГГГлавалавалавалавалава
Простые инструментыПростые инструментыПростые инструментыПростые инструментыПростые инструменты
и приемы черченияи приемы черченияи приемы черченияи приемы черченияи приемы черчения

Рис. 4.1  Общий вид рабочей зоны детской комнаты
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но даже без использования инструмента С линиями (Line), применяя смеще�
ние габаритных линий рабочей зоны, созданных вами при изучении материала
предыдущей главы.

4.1.1. Использование инструментов «Подобие» (Offset),4.1.1. Использование инструментов «Подобие» (Offset),4.1.1. Использование инструментов «Подобие» (Offset),4.1.1. Использование инструментов «Подобие» (Offset),4.1.1. Использование инструментов «Подобие» (Offset),
«Сопряжение» (Fillet) и «У«Сопряжение» (Fillet) и «У«Сопряжение» (Fillet) и «У«Сопряжение» (Fillet) и «У«Сопряжение» (Fillet) и «Удлинить» (Extend)длинить» (Extend)длинить» (Extend)длинить» (Extend)длинить» (Extend)
Поскольку, как известно, повторение – мать учения, мы начнем работу с повто�
рения приемов черчения с использованием упомянутых выше инструментов.
Как видно из рис. 4.3, чтобы начертить внутренние линии конструктивных эле�
ментов, достаточно скопировать внутрь чертежа линии, обозначающие габа�
риты рабочей зоны. Расстояние смещения при этом мы будем считать равным
18 мм. На практике мебель могут изготавливать из плит ДСП или массива де�
рева толщиной 16–28 мм, а неответственные элементы могут иметь толщину
10–14 мм. Точно так же, столешницы могут иметь толщину 38 мм и больше, но
мы будем считать, что практически все конструктивные элементы рабочей
зоны изготовлены из плиты ДСП толщиной 18 мм. Исключение лишь составля�
ют стенки выдвижного ящика парты, которые имеют толщину 5 мм.

1. Выберите из меню команду Файл ⇒ Открыть (File ⇒ Open), найдите
созданную в конце главы 3 папку и откройте чертеж, который был сохра�

Крышка стола рабочего места младшего школьника выполнена, как у пар�
ты, – ее можно поднимать и опускать на угол до 15° (на рис. 4.1 показана в под�
нятом положении). Кроме того, правая часть рабочей зоны также выполнена
в виде небольшого стола, который может использоваться для чтения, непро�
должительных занятий и т. п. Над этим столом находятся две консольные пол�
ки, смонтированные на хромированной опоре с креплением консольных час�
тей к стене кронштейнами (на рис. 4.1 не показаны).

Конечно, создать чертеж столь сложного объекта, как говориться, в один
присест, достаточно нелегко даже опытному пользователю AutoCAD. Поэтому
мы разобьем работу по созданию чертежей рабочей зоны на несколько этапов.
В этой и последующей главах мы будем создавать чертеж нижней части объекта
(рис. 4.2), точнее чертеж вида сверху.

Рис. 4.2  Элементы нижней части рабочей зоны детской комнаты

В последующих главах мы добавим к чертежу изображения столешницы и
элементов, находящихся над столом. Завершив работу над видом сверху, мы
рассмотрим в главе 8 инструменты создания видов спереди и справа.

4.1. Создание прямолинейных элементов4.1. Создание прямолинейных элементов4.1. Создание прямолинейных элементов4.1. Создание прямолинейных элементов4.1. Создание прямолинейных элементов
Создание любого вида сверху лучше всего начинать с обозначения габаритных
размеров. Если вы хорошо усвоили материал предыдущих глав, то чертеж, по�
казанный на рис. 4.3 (без выдвижной подставки для клавиатуры – о ней мы по�
говорим позже), который вам предстоит создать в этой и следующей главах,
вам не покажется слишком сложным.

Да, ряд инструментов (например, обеспечивающих вычерчивание окруж�
ностей), мы еще не рассматривали, но остальные элементы чертежа вы сможе�
те создать с помощью уже известных вам инструментов С линиями (Line), Подо�
бие (Offset), Сопряжение (Fillet), Обрезать (Trim) и Удлинить (Extend). Более
того – создать большую часть элементов чертежа, показанного на рис. 4.3, мож�

Рис. 4.3  Чертеж нижней части рабочей зоны
с основными размерами конструктивных элементов

Создание прямолинейных элементовСоздание прямолинейных элементовСоздание прямолинейных элементовСоздание прямолинейных элементовСоздание прямолинейных элементов



Простые инструменты и приемы черченияПростые инструменты и приемы черченияПростые инструменты и приемы черченияПростые инструменты и приемы черченияПростые инструменты и приемы черчения78 79

с наружной вертикальной линией. (Можно, конечно, просто отсечь лиш�
нюю часть внутренней вертикальной линии с помощью инструмента
Обрезать (Trim), но мы пойдем более длинным путем, чтобы закрепить
навыки использования инструмента Сопряжение (Fillet).) Однако сна�
чала давайте изменим масштаб просмотра, чтобы было удобнее исполь�
зовать инструмент Сопряжение (Fillet). Запустите инструмент Умень�
шить (Zoom In), но не через меню или панель инструментов, а введя
в командном окне сначала Ïîêàçàòü (ZOOM) или просто ïî, а затем
1.5x. Изображение увеличиться в полтора раза.

Совет. При запуске инструмента Увеличить (Zoom Out) из меню или с помощью
панели инструментов AutoCAD автоматически запускает команду Ïîêàçàòü
(ZOOM) с коэффициентом масштабирования 2.0x, а при запуске инструмента
Уменьшить (Zoom In) – с коэффициентом 0.5x. В тех случаях, когда нужно ис�
пользовать другие значения коэффициентов масштабирования, их можно ввес�
ти, запустив соответствующий инструмент вручную в командном окне.

10. Запустите инструмент  Сопряжение (Fillet), например, введя в коман�
дном окне ñîï (F) или выбрав из меню команду Изменить ⇒ Сопряже�
ние (Modify ⇒ Fillet).

Совет. Прежде, чем переходить к сопряжению, убедитесь в том, что команда
Ñîïðÿæåíèå (FILLET) по умолчанию использует радиус сопряжения, равный
нулю (в сообщении командного окна должно быть указано Ðàäèóñ ñîïðÿæåíèÿ =
0.0000 (Radius = 0.0)). В противном случае запустите режим Ðàäèóñ
(RADIUS), введя в ответ на приглашении команды ä (R), а затем введите 0
в качестве нового значения радиуса сопряжения. Поскольку команда Ñîïðÿæå-
íèå (FILLET) после задания радиуса завершится, нажмите Enter для ее повтор�
ного запуска.

нен в файле Work030.dwg. Открытый чертеж должен состоять из четы�
рех линий, образующих прямоугольник (см. рис. 3.12).

2. Щелкните на кнопках�индикаторах Сетка (GRID) и Шаг (SNAP), чтобы
отключить соответствующие режимы, поскольку сетка и привязка к ней
нам пока не понадобятся.

3. Воспользуйтесь инструментом Зумировать в границах (Zoom Extents)
(или командой Вид ⇒ Зумирование ⇒ Границы (View ⇒ Zoom ⇒
Extents)), а затем – инструментом Увеличить (Zoom Out) (или командой
Вид ⇒ Зумирование ⇒ Где искать (View ⇒ Zoom ⇒ Out)), чтобы выб�
рать приемлемый масштаб для чертежа, а также поместить изображение
прямоугольника в центре области черчения.

4. Запустите инструмент  Подобие (Offset), например, введя в команд�
ном окне ïîä или выбрав из меню команду Изменить ⇒ Подобие (Modi�
fy ⇒ Offset).

5. В ответ на приглашение AutoCAD Óêàæèòå ðàññòîÿíèå ñìåùåíèÿ èëè
[×åðåç/Óäàëèòü/Ñëîé] <×åðåç>: (Specify offset distance or [Through/
Erase/Layer] <Through>) введите в командном окне 18.

6. AutoCAD в командном окне с помощью сообщения Âûáåðèòå îáúåêò
äëÿ ñìåùåíèÿ èëè [Âûõîä/Îòìåíèòü] <Âûõîä>: (Select object to offset
or [Exit/Undo]:) предложит выбрать объект, подлежащий смещению.
Щелкните на левой вертикальной линии.

7. Для задания направления смещения щелкните в пустой области внутри
прямоугольника. Первая линия будет смещена на 18 мм внутрь габаритов
рабочей зоны (рис. 4.4). Инструмент Подобие (Offset) останется рабо�
тать, поэтому AutoCAD снова предложит в командном окне выбрать сле�
дующий объект.

Рис. 4.4  Внутренняя линия создана путем смещения внешней

8. Выберите верхнюю горизонтальную линию контура габаритов рабочей
зоны и щелкните внутри прямоугольника, а затем нажмите Enter для за�
вершения команды Ïîäîáèå (OFFSET) (рис. 4.5).

9. Теперь необходимо сопрячь угол с помощью инструмента Сопряжение
(Fillet), а затем продлить внутреннюю горизонтальную линию, как на
рис. 4.3, с помощью инструмента Удлинить (Extend) до пересечения

Рис. 4.5  Созданы внутренние линии боковой и задней стенок
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3. Щелкните на внутренней линии левой боковой стенки (рис. 4.8).

11. Щелкните на линиях, образующих внутренний угол. (Если вы не очень
уверено применяете инструмент Сопряжение (Fillet), вернитесь к мате�
риалу главы 2.) Линии будут сопряжены так, как показано на рис. 4.6,
а команда Ñîïðÿæåíèå (FILLET) автоматически завершит работу.

Рис. 4.6  Линии внутреннего угла сопряжены

12. Запустите инструмент  Удлинить (Extend), например, введя в команд�
ном окне ó (EX) или выбрав из меню команду Изменить ⇒ Удлинить
(Modify ⇒ Extend).

13. Выберите в качестве ограничивающего ребра левую вертикальную ли�
нию, а затем, нажав Enter для завершения выбора, щелкните отмечаю�
щим указателем на нижней горизонтальной линии. AutoCAD продлит
эту линию до пересечения с ограничивающим ребром в соответствии
с рис. 4.3 и предложит выбрать следующую линию для продления. На�
жмите Enter для завершения команды Óäëèíèòü (EXTEND). Чертеж
примет вид, показанный на рис. 4.7.

4.1.2. Создание конструктивных элементов4.1.2. Создание конструктивных элементов4.1.2. Создание конструктивных элементов4.1.2. Создание конструктивных элементов4.1.2. Создание конструктивных элементов
угловой части рабочей зоныугловой части рабочей зоныугловой части рабочей зоныугловой части рабочей зоныугловой части рабочей зоны
Контуры внутренних элементов мы создадим путем копирования линий наруж�
ных стенок.

1. Запустите инструмент Подобие (Offset), щелкнув на кнопке Подобие
(Offset) панели инструментов Изменить (Modify) (можно также ввести в
командном окне команду Ñîïðÿæåíèå (OFFSET) или просто ïîä (O)).

2. В ответ на приглашение Óêàæèòå ðàññòîÿíèå ñìåùåíèÿ (Specify offset
distance) введите 200.

Рис. 4.7  Стык задней и левой боковой стенок оформлен должным образом

Рис. 4.8  Выбор первой линии для смещения на 200 мм

4. Щелкните в пустой области справа от выбранной линии. Линия сместит�
ся на 200 мм вправо. Нажмите Enter для завершения команды Ïîäîáèå
(OFFSET), а затем нажмите Enter еще раз для повторного ее запуска. Те�
перь нам нужно изменить значение смещения.

Совет. Инструмент Подобие (Offset) не позволяет изменять значение смещения в
процессе работы команды. Поэтому в тех случаях, когда нужно задать новое зна�
чение смещения, приходиться завершать работу команды Ïîäîáèå (OFFSET) и
тут же запускать ее снова. Быстрее всего сделать это, дважды нажав Enter.

5. Руководствуясь рис. 4.3, задайте значение смещения равным 400 мм (то
есть в ответ на приглашение AutoCAD введите в командном окне 400).

6. Снова щелкните на той же линии, которую вы выбирали в п. 3 (см. рис. 4.8),
а затем щелкните правее этой линии внутри рабочей зоны. AutoCAD сме�
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Можно, конечно, на этом не останавливаться, а продолжить смещение дру�
гих линий. Однако в этом случае вы получите на чертеже нагромождение мно�
жества линий, в котором не трудно и запутаться. Поэтому мы прервемся на не�
которое время и займемся обрезкой лишних линий.

Обрезка базовых линийОбрезка базовых линийОбрезка базовых линийОбрезка базовых линийОбрезка базовых линий
Для обрезки линий нам понадобится инструмент Обрезать (Trim). Для начала
мы обрежем линию, представляющую на чертеже контур нижней угловой пол�
ки шириной 200 мм (линия, которая была создана первой на предыдущем эта�
пе). В качестве секущего ребра мы будем использовать линию наружного конту�
ра боковой стенки малой тумбы (линия, которая была создана последней на
предыдущем этапе).

1. Запустите инструмент Обрезать (Trim), щелкнув на кнопке Обрезать
(Trim) панели инструментов Изменить (Modify) или введя в командном
окне команду Îáðåçàòü (Trim) или просто îáð (TR).

2. В ответ на предложение выбрать секущее ребро выберите линию, кото�
рая находится выше нижней горизонтальной линии габаритов рабочей
зоны на 696 мм (400 + 296 мм), а затем нажмите Enter для завершения
выбора (на рис. 4.12 эта линия показана пунктиром).

3. AutoCAD предложит выбрать линию, подлежащую обрезке. Щелкните на
вертикальной линии, которая была создана на предыдущем этапе пер�
вой, ниже секущего ребра, как показано на рис. 4.12, а затем нажмите
Enter для завершения работы команды Îáðåçàòü (Trim).

4. Снова запустите команду Îáðåçàòü (Trim), нажав Enter, и обрежьте ту
же вертикальную линию сверху, выбрав в качестве секущего ребра гори�
зонтальную линию, показанную на рис. 4.13 пунктиром.

стит выбранную линии вправо, расположив ее на 200 мм правее первой
смещенной линии.

7. В ответ на приглашение выбрать следующую линию для смещения выбери�
те нижнюю горизонтальную линию габаритов рабочей зоны (рис. 4.9),
а затем щелкните внутри рабочей зоны, чтобы поднять ее вверх на 400 мм.

Рис. 4.9  Смещение нижней линии габаритов рабочей зоны

8. Теперь выберите внутреннюю горизонтальную линию контура задней
стенки (рис. 4.10) и также сместите ее внутрь рабочей зоны на 400 мм.

Рис. 4.10  Смещение внутренней линии контура задней стенки

9. В завершение выберите линию, отстоящую от левой боковой стенки на
200 мм (она была создана первой в п. 4), и также сместите ее вправо. (Эта
линия впоследствии понадобиться нам, как вспомогательная.)

10. Нажмите Enter два раза для завершения работы команды Ïîäîáèå (OFF�
SET) и ее повторного запуска, задайте расстояние смещения 296 мм, сме�
стите вторую снизу горизонтальную линию вверх на это расстояние и
нажмите Enter для завершения команды Ïîäîáèå (OFFSET). Чертеж
должен выглядеть так, как показано на рис. 4.11.

Рис. 4.11  Базовые линии угловой части рабочей зоны созданы
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8. Нам осталось избавиться от двух вспомогательных линий. Их можно
было бы обрезать с помощью инструмента Обрезать (Trim), но в данном
случае удобнее воспользоваться инструментом Сопряжение (Fillet). По�
этому завершите работу команды Îáðåçàòü (Trim) нажатием Enter и
запустите команду Ñîïðÿæåíèå (FILLET), щелкнув на кнопке Сопряже�
ние (Fillet) панели инструментов Изменить (Modify) или введя в команд�
ном окне ñîï (F).

9. Убедившись в том, что радиус сопряжения остается нулевым, щелкните
на двух вспомогательных линиях так, как показано на рис. 4.16. AutoCAD
выполнит сопряжение и выполнение команды Ñîïðÿæåíèå (FILLET) ав�
томатически завершится.

Совет. При использовании инструментов Сопряжение (Fillet) и Обрезать (Trim)
следуйте такому правилу: инструмент Сопряжение (Fillet) применяется для со�
пряжения пересечения двух линий в самых простейших случаях. Во всех осталь�
ных случаях применяется инструмент Обрезать (Trim).

5. Нажмите два раза Enter, а затем выберите в качестве секущего ребра по�
лучившийся в п. 4 вертикальный отрезок, обозначающий контур полки,
а в качестве обрезаемой линии – горизонтальную линию, которая в п. 4
была секущим ребром.

6. Добившись результата, показанного на рис. 4.14, снова перезапустите
команду Îáðåçàòü (Trim) двойным нажатием Enter и выберите в ка�
честве секущих две горизонтальные линии, показанные на рис. 4.14
пунктиром. Нажав Enter для завершения выбора секущих, в ответ на при�
глашение AutoCAD выбрать отрезаемые части линий, щелкните на вер�
тикальной линии, образующей контур малой тумбы, сначала под нижним
секущим ребром, а затем, как показано на рис. 4.14, над верхним секущим
ребром.

7. Теперь можно избавиться от горизонтальных линий, выходящих за пре�
делы контуров малой тумбы, которые мы использовали в качестве секу�
щих ребер на предыдущем этапе. Перезапустите команду Îáðåçàòü (Trim),
выберите в качестве секущего ребра вертикальную линию контура малой
тумбы (показана пунктиром на рис. 4.15), а затем, нажав Enter для завер�

Рис. 4.12  Выбор линии, подлежащей обрезке
(секущее ребро показано пунктиром)

Рис. 4.13  Выбор линии, подлежащей обрезке
(секущее ребро показано пунктиром)

Рис. 4.14  Формирование контура малой тумбы

шения выбора, щелкните сначала на нижней горизонтальной линии,
а затем на верхней, как показано на рис. 4.15, для их обрезки.

Рис. 4.15  Завершение формирования контура малой тумбы
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изменяет масштаб просмотра так, чтобы изображение выделенного с ее
помощью фрагмента чертежа заняло всю область черчения.

Примечание. Рассмотренный инструмент называется Окно зумирования (Zoom
Window), а команда – Îêíî çóìèðîâàíèÿ (Zoom Window) (псевдоним – Ïîêà-
çàòü (Zoom)). Если ввести в командном окне просто ïî (Z), а затем выбрать
в области черчения точку, режим рамки масштабирования включается автома�
тически.

4. Запустите инструмент Обрезать (Trim), выберите в качестве секущей
внутреннюю вертикальную линию контура левой стенки (показана на
рис. 4.20 пунктиром), а затем, нажав Enter для завершения выбора, щелк�
ните сначала на верхней, а затем на нижней (рис. 4.20) выступающих ча�

Внимательно присмотревшись к чертежу, вы заметите, что горизонтальные
линии контура малой тумбы выходят за контур левой боковой стенки рабочей
зоны. Для их отсечения нужно использовать инструмент Обрезать (Trim), од�
нако при текущем масштабе просмотра это будет сделать, мягко говоря, непро�
сто. Поэтому давайте уменьшим масштаб так, чтобы изображение пересечения
линий увеличилось.

Применение инструмента «Окно зумирования» (Zoom Window)Применение инструмента «Окно зумирования» (Zoom Window)Применение инструмента «Окно зумирования» (Zoom Window)Применение инструмента «Окно зумирования» (Zoom Window)Применение инструмента «Окно зумирования» (Zoom Window)
Вы уже применяли инструменты Зумировать все (Zoom All), Зумировать
в границах (Zoom Extents), Уменьшить (Zoom In) и Увеличить (Zoom Out).
Однако наиболее популярным инструментом этого семейства в AutoCAD явля�
ется инструмент Окно зумирования (Zoom Window), а также его «партнер» –
инструмент Зумировать предыдущий (Zoom Previous). Первый позволяет за�
пустить команду Ïîêàçàòü (ZOOM) в режиме рамки масштабирования (zoom
window), с помощью которого пользователь может увеличить интересующий
его фрагмент до нужного размера, а второй – восстановить предыдущий масш�
таб, не задумываясь о том, каким именно этот масштаб был до изменения.

1. Введите в командном окне Ïîêàçàòü (ZOOM) или просто ïî (Z), переме�
стите указатель�перекрестие в точку, находящуюся выше и левее верхне�
го пересечения (рис. 4.17) и щелкните в пустой области за пределами га�
баритов рабочей зоны.

2. Переместите указатель вниз и вправо. Обратите внимание на прямоу�
гольник, растягивающийся при его перемещении. Продолжайте переме�
щать указатель вниз и вправо до тех пор, пока прямоугольник не охватит
нужную нам область пересечения линий так, как это показано на рис. 4.18,
а затем щелкните еще раз.

3. Как только вы щелкните мышью, работа команды Ïîêàçàòü(ZOOM) за�
вершится, а всю область черчения займет изображение пересечения
контуров малой тумбы и левой стенки (рис. 4.19). Прямоугольная рамка,
с помощью которой вы определили интересующую вас область и называ�
ется рамкой масштабирования. После задания размеров рамки AutoCAD

Рис. 4.16  Удаление вспомогательных линий путем их сопряжения

Рис. 4.17  Расположение указателя
при первом щелчке после запуска команды Ïîêàçàòü (ZOOM)

Рис. 4.18  Задание области,
масштаб просмотра которой нужно уменьшить
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нужно было бы при этом запустить в командном окне и ввести коэффи�
циент масштабирования вручную, как вы это делали раньше). Однако
в применении столь сложной последовательности операций нет необхо�
димости. Введите в командном окне Ïîêàçàòü ïðåäûäóùèé (ZOOM
PREVIOUS) или просто ïî ïð (Z P). Масштаб изображения тут же вернет�
ся к предыдущему (рис. 4.21). Команде Ïîêàçàòü ïðåäûäóùèé (ZOOM
PREVIOUS) соответствует инструмент Зумировать предыдущий (Zoom
Previous), который можно запустить как с помощью плавающей панели
инструментов Standard, так и с помощью команды меню Вид ⇒ Зумиро�
вание ⇒ Назад (View ⇒ Zoom ⇒ Previous).

стях горизонтальных линий. Нажмите Enter для завершения работы ко�
манды Îáðåçàòü (Trim).

Совет. При использовании инструмента Обрезать (Trim) следует щелкать на
тех сегментах линий, которые нужно удалить, а при использовании инструмен�
та Сопряжение (Fillet) – на тех, которые нужно оставить.

5. Для возврата к предыдущему масштабу просмотра можно было бы приме�
нить инструменты Зумирование в границах (Zoom Extents), Уменьшить
(Zoom In) и Увеличить (Zoom Out) (команду Óâåëè÷èòü (ZOOM OUT)

Рис. 4.19  Область пересечения линий контуров после изменения масштаба

Рис. 4.20  Верхняя линия уже обрезана, выбор второй линии

Рис. 4.21  Результат применения инструмента
Зумировать предыдущий (Zoom Previous)

Теперь нужно выполнить еще несколько операций смещений и обрезки,
чтобы обозначить на чертеже дно угловой части, а также тумбы системного
блока компьютера.

Завершение формирования угловой частиЗавершение формирования угловой частиЗавершение формирования угловой частиЗавершение формирования угловой частиЗавершение формирования угловой части
Поскольку к этому моменту вы уже должны достаточно хорошо овладеть инст�
рументами Подобие (Offset), Обрезать (Trim), Удлинить (Extend) и Сопря�
жение (Fillet), автор предлагает вам выполнить остальные операции самостоя�
тельно, руководствуясь следующими указаниями.

1. Сместите вертикальную вспомогательную линию вправо на 100 мм, полу�
чившуюся линию – вправо на 82 мм, а затем эту линию – еще вправо на
218 мм (см. рис. 4.3).

2. Сместите горизонтальную вспомогательную линию вверх на 300 мм, а за�
тем эту же линию вниз на 100 мм.
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Work041.dwg. Теперь, в случае необходимости, вы можете закрыть AutoCAD и
продолжить работу позже.

4.1.3. Создание конструктивных элементов4.1.3. Создание конструктивных элементов4.1.3. Создание конструктивных элементов4.1.3. Создание конструктивных элементов4.1.3. Создание конструктивных элементов
прямой части рабочей зоныпрямой части рабочей зоныпрямой части рабочей зоныпрямой части рабочей зоныпрямой части рабочей зоны
Операции черчения конструктивных элементов во многом аналогичны тем,
которые использовались при черчении угловой части. Пока что мы не будем
вычерчивать все элементы прямой части рабочей зоны (собственно, как мы
пропустили вычерчивание контуров стенок и фасада малой тумбы в угловой
зоне). Почему мы так поступаем, вы узнаете чуть позже, а пока что давайте зай�
мемся созданием контуров большой тумбы и парты. Здесь, как и на предыду�

3. Сопрягите вертикальную и горизонтальную линии для образования кон�
тура тыльной части тумбы системного блока, как показано на рис. 4.22.

Рис. 4.22  Сопряжение линий,
образующих контур тыльной части тумбы системного блока

4. Сместите левую вертикальную линию контура тумбы системного блока
вправо на 18 мм, а затем продлите полученную линию и правую верти�
кальную линию контура тумбы вниз до пересечения с горизонтальной
вспомогательной линей (запустив инструмент Удлинить (Extend), выбе�
рите эту линию в качестве ограничивающего ребра).

5. Используя правую продленную линию контура тумбы системного блока
в качестве секущего ребра, обрежьте три горизонтальных линии, выхо�
дящих вправо за секущее ребро.

6. Выполните сопряжение линий на лицевой стороне контура тумбы сис�
темного блока. После запуска команды Ñîïðÿæåíèå (FILLET) введите
радиус (ä (R)), затем значение радиуса сопряжения 50 мм (см. рис. 4.3),
после чего выберите линии, как показано на рис. 4.23.

7. Сместите верхнюю горизонтальную линию малой тумбы вверх на 86 мм,
затем продлите правую вертикальную линию этой тумбы до полученной
вспомогательной линии (она должна использоваться в качестве ограни�
чивающего ребра), после чего удалите горизонтальную вспомогатель�
ную линию (см. рис. 4.3). (Для удаления объекта в AutoCAD достаточно
щелкнуть на нем и нажать Delete.)

8. Для завершения выполните сопряжение (предварительно изменив ра�
диус сопряжения с 50 на 0 мм) второй вспомогательной линии, нахо�
дящейся левее тумбы системного блока, с горизонтальной линей так,
чтобы созданный в результате чертеж выглядел, как это показано на
рис. 4.24.

Если вы справились с этой задачей, можно сказать, что с командами Подо�
бие (Offset), Обрезать (Trim), Удлинить (Extend) и Сопряжение (Fillet) вы
освоились. Если вы захотите прерваться и немного отдохнуть, воспользуйтесь
командой Файл ⇒ Сохранить как (File ⇒ Save As) и сохраните чертеж в файле

Рис. 4.23  Сопряжение линий, образующих контур
лицевой части тумбы системного блока, с радиусом 50 мм

Рис. 4.24  Чертеж прямолинейных элементов
угловой части в первом приближении готов
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4. Теперь скопируйте правую вертикальную границу контура большой тум�
бы вправо на 800 мм (см. рис. 4.3), затем продлите полученную линию и
исходную линию (она одновременно представляет, как правую границу
контура большой тумбы, так и левую границу контура парты) до пересе�
чения с оставшейся вспомогательной горизонтальной линией. После
этого обрежьте горизонтальную линию по полученным вертикальным
линиям, обозначающим контур парты (рис. 4.27).

щем этапе, мы будем использовать уже знакомые вам инструменты Подобие
(Offset), Обрезать (Trim), Удлинить (Extend) и Сопряжение (Fillet), но в этот
раз мы больше уделим внимания инструментам Окно зумирования (Zoom
Window) и Зумировать предыдущий (Zoom Previous).

1. Используя рис. 4.3, выполните смещение правой стенки тумбы системно�
го блока вправо на 500 мм, а затем сместите внутреннюю горизонтальную
линию задней стенки рабочей зоны вниз на 600 мм, а затем полученную
линию вниз на 100 мм. (Как вы помните, для задания нового смещения,
каждый раз нужно завершать и снова запускать команду Ïîäîáèå (Offset)
или просто ïîä двойным нажатием Enter.) Результат должен выглядеть
так, как показано на рис. 4.25.

Рис. 4.25  Базовые линии для создания контуров большой тумбы и парты

2. Как легко заметить, для получения контура большой тумбы нужно удли�
нить линии ее боковых стенок до верхней горизонтальной линии, а за�
тем выполнить сопряжение с этой линией. Можно также, удлинив ли�
нии, обрезать горизонтальную линию по контурам боковых стенок.
В данной ситуации эту операцию можно выполнить быстрее, чем два
раза применять сопряжение, поэтому мы применим именно инструмент
Обрезать (Trim), а не Сопряжение (Fillet). (Как уже отмечалось выше,
в AutoCAD нет правильных и неправильных методов, поскольку каждую
операцию можно выполнить разными способами.) Поэтому запустите
инструмент Удлинить (Extend), выберите в качестве ограничивающего
ребра верхнюю вспомогательную линию и продлите до нее линии, кото�
рые будут представлять на чертеже контуры большой тумбы.

Совет. На продлеваемых линиях следует щелкать как можно ближе к ограничи�
вающим ребрам, поскольку в противном случае линии будут продолжены в проти�
воположном направлении.

3. Запустите инструмент Обрезать (Trim), выберите в качестве секущих
ребер только что продленные линии, а затем щелкните на верхней вспо�
могательной линии в местах, показанных на рис. 4.26. После удаления
лишних сегментов линии завершите команду Îáðåçàòü (Trim) нажатием
Enter.

Рис. 4.26  Точки выбора вспомогательной линии для ее отсечения

Рис. 4.27  Контур парты сформирован
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верхнюю линию контура ящика, отстоящую от наружной линии на 5 мм
(мы ее не создаем, поскольку она совпадает с внутренней горизонталь�
ной линией контура задней стенки рабочей зоны).

8. Охватите рамкой масштабирования контур парты так, чтобы все ее эле�
менты оказались внутри рамки масштабирования. После уменьшения
масштаба в рабочей области вы должны увидеть нечто подобное тому,
что показано на рис. 4.30.

Теперь нам нужно создать контур выдвижного ящика парты. На рис. 4.3
этот контур шириной 5 мм плохо виден из�за слишком крупного масштаба, но
это не самая большая проблема в нашей ситуации. В данном случае самое глав�
ное состоит в том, как лучше создать этот контур, выполняя минимум опера�
ций. Вы можете попробовать решить эту задачу самостоятельно, применяя
любой метод получения необходимого результата, а можете воспользоваться
приведенным ниже описанием.

1. Сместите левую и правую вертикальные границы, а также нижнюю гра�
ницу контура парты внутрь на 18 мм.

2. Используя инструмент Окно зумирования (Zoom Window) (введите
в командной строке ïî (Z)), охватите рамкой масштабирования левый
нижний угол контура парты, как показано на рис. 4.28. (Для перехода
в режим рамки масштабирования нужно щелкнуть примерно в том месте,
где находится левый верхний угол показанной на рис. 4.28 рамки.) Как
только вы, задав размер рамки, щелкните мышью, AutoCAD уменьшит мас�
штаб так, чтобы заданный фрагмент чертежа занял всю область черчения.

Рис. 4.28  Определение фрагмента чертежа
для увеличения с помощью рамки масштабирования

3. Запустите инструмент Обрезать (Trim) и отсеките часть горизонталь�
ной линии контура ящика, выступающую за вертикальную линию его
контура, используя последнюю в качестве секущей.

4. Получив результат, показанный на рис. 4.29, вернитесь к предыдущему
масштабу, воспользовавшись инструментом Зумировать предыдущий
(Zoom Previous) (введите в командном окне ïî ï (Z P)).

5. Повторите операции, описанные в пп. 1–4, для формирования контура
ящика в правом нижнем углу парты.

6. Руководствуясь рис. 4.3, сместите вверх полученную горизонтальную ли�
нию контура ящика на 332 мм вверх (350 – 18 = 332 мм). Эта линия будет
представлять на чертеже контур нижней полки парты (см. рис. 4.1 и 4.2),
поэтому она должна идти от одной боковой стенки парты до другой.

7. Теперь снова сместите только что созданную линию контура нижней
полки парты вверх на 345 мм (350 – 5 = 345 мм). Тем самым вы создадите

Рис. 4.29  Лишняя часть горизонтальной линии контура ящика
обрезана по вертикальной границе контура ящика

Рис. 4.30  Чертеж парты после изменения масштаба
с помощью инструмента Окно зумирования (Zoom Window)
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ле второго – к исходному. При этом последовательных «вложенных» применений
инструментов Окно зумирования (Zoom Window) и Зумировать предыдущий
(Zoom Previous) может быть сколького угодно (как и вложенных пар скобок в ма�
тематических выражениях) – это никак не помешает «закрыть скобки» для воз�
вращения к исходному масштабу просмотра.

Ну что ж, наш чертеж уже значительно больше напоминает чертеж, пред�
ставленный на рис. 4.3. Для того чтобы перейти к очередному этапу, нам оста�
лось лишь внести небольшие коррективы в имеющиеся объекты чертежа.
Смысл некоторых из них вам будет понятен без комментариев, а с назначением
остальных описанных ниже операций вы разберетесь немного позднее.

9. Сместите левую и правую внутренние вертикальные границы, а также
нижнюю внутреннюю вертикальную границу контура стенок парты (с эти�
ми линиями совпадают наружные границы контура ящика) внутрь на 5 мм.

10. Охватите рамкой масштабирования левый нижний угол контура парты,
как показано на рис. 4.31.

Рис. 4.31  Определение с помощью инструмента Окно зумирования (Zoom Window)
фрагмента, подлежащего увеличению

11. Выполните сопряжение вертикальной и горизонтальной линий внутрен�
него контура выдвижного ящика, щелкнув на них в местах, показанных
на рис. 4.32.

12. Верните с помощью инструмента Зумировать предыдущий (Zoom
Previous) предыдущий масштаб просмотра, а затем повторите пп. 10 и 11
для сопряжения линий, образующих правый нижний, левый верхний и
правый верхний углы внутреннего контура выдвижного ящика, каждый
раз возвращаясь к предыдущему масштабу с помощью команды Ïîêà-
çàòü ïðåäûäóùèé (ZOOM PREVIOUS).

13. После выполнения всех сопряжений и восстановления масштаба чертеж
парты должен иметь вид, показанный на рис. 4.33.

14. Снова запустите инструмент Зумировать предыдущий (Zoom Previous), и
AutoCAD вернет масштаб изображения к исходному состоянию (рис. 4.34).

Примечание. Инструмент Зумировать предыдущий (Zoom Previous) называем
«напарником» инструмента Окно зумирования (Zoom Window), поскольку они
действуют подобно открывающей (Окно зумирования (Zoom Window)) и закры�
вающей (Зумировать предыдущий (Zoom Previous)) скобкам в математических
выражения. Иными словами, если вы два раза применили инструмент Окно зу�
мирования (Zoom Window), то после первого применения Зумировать предыду�
щий (Zoom Previous) вы вернетесь к промежуточному масштабу просмотра, а пос�

Рис. 4.32  Запустив команду Сопряжение (FILLET),
щелкните в этих точках для сопряжения линий, образующих левый нижний угол

внутреннего контура выдвижного ящика
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Рис. 4.33  Все четыре угла внутреннего контура выдвижного ящика сопряжены
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штабирования правый верхний угол чертежа рабочей зоны, как показа�
но на рис. 4.37.

5. Как вы помните, рабочая зона имеет дину 3000 мм. Однако, взглянув на
рис. 4.1, нетрудно понять, что задняя стенка короче, чем 3000 мм. Из чер�
тежа на рис. 4.3 видно, что ее длина составляет 2718 мм. Таким образом,
нам нужно сместить правую вертикальную границу рабочей зоны влево
на 282 мм (3000 – 2718 = 282 мм), а затем обрезать горизонтальные линии
контура задней стенки по этой линии, а саму линию – по нижней гори�
зонтальной линии контура задней стенки. Причем эту операцию можно
выполнить, применяя команду Îáðåçàòü (TRIM) не два раза, как это вы
делали раньше, а один.

1. Охватите рамкой масштабирования область, показанную на рис. 4.35.

2. После уменьшения масштаба щелкните на правой вертикальной вспомо�
гательной линии для ее выделения, а затем нажмите Delete для удаления
этой линии (эту операцию можно было выполнить и раньше, но автор
решила отложить ее для того, чтобы не нагружать вас непонятными опе�
рациями, пока вы не освоитесь с основными инструментами черчения).

3. Обрежьте линию, обозначающую внутренний контур стенки тумбы систем�
ного блока, использовав в качестве секущей горизонтальную линию, обозна�
чающую контур нижней полки, как показано на рис. 4.36. Эта операция от�
носится как раз к разряду тех, смысл которых вы поймете чуть позже.

4. Восстановите предыдущий масштаб просмотра с помощью инструмента
Зумировать предыдущий (Zoom Previous), а затем охватите рамкой мас�

Рис. 4.36  Отсечение линии, обозначающей
внутренний контур стенки тумбы системного блока

Рис. 4.37  Использование инструмента
Окно зумирования (Zoom Window) для увеличения фрагмента чертежа

в районе правого верхнего угла рабочей зоны
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Рис. 4.34  Вид чертежа после восстановления исходного масштаба просмотра

Рис. 4.35  Использование инструмента Окно зумирования (Zoom Window)
для увеличения фрагмента чертежа в районе тумбы системного блока
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хорошая идея, поскольку для создания прямоугольника нам нужно задать точ�
ные координаты как минимум одного угла, что, мягко говоря, несколько слож�
нее, чем просто сместить линию на 18 мм. Но эта проблема только кажущаяся.
На самом деле ситуации, когда тот или иной элемент можно получить либо пу�
тем смещения, либо с помощью других инструментов, будут встречаться на
практике не так уж часто. Поэтому вам следует познакомиться со средствами
AutoCAD, позволяющие создавать на чертеже объекты, которые нельзя полу�
чить смещением имеющихся элементов чертежа, но которые при этом должны
быть привязаны к строго заданным точкам чертежа.

Соответствующие средства в AutoCAD называются режимами объектной
привязки. Давайте попробуем создать несколько прямоугольников и на практи�
ке уяснить, как работают эти режимы.

4.2.1. Инструмент «Прямоугольник» (Rectangle)4.2.1. Инструмент «Прямоугольник» (Rectangle)4.2.1. Инструмент «Прямоугольник» (Rectangle)4.2.1. Инструмент «Прямоугольник» (Rectangle)4.2.1. Инструмент «Прямоугольник» (Rectangle)
и инструмент объектной привязки «Конточка»и инструмент объектной привязки «Конточка»и инструмент объектной привязки «Конточка»и инструмент объектной привязки «Конточка»и инструмент объектной привязки «Конточка»
(Snap to Endpoint)(Snap to Endpoint)(Snap to Endpoint)(Snap to Endpoint)(Snap to Endpoint)
Если вы сравните наш чертеж с рис. 4.3, то увидите, что на текущем чертеже
пока что отсутствуют линии, обозначающие контуры стенок и фасада малой
тумбы, боковой стенки тумбы системного блока (соответствующая линия была
на чертеже, но мы ее умышленно обрезали), а также контуры боковой стенки и
фасада большой тумбы. Кроме того, нам еще предстоит создать линии, обозна�
чающие вырезы в фасадах под ручки. Строго говоря, все эти линии при виде
сверху на рабочую зону со снятой столешницей должны быть невидимы, по�
скольку они скрыты расположенными над ними элементами. Однако мы пока
что изобразим их, как видимые, а впоследствии приведем вид соответствую�

6. Сместите правую границу рабочей зоны влево на 282 мм
7. Запустите команду Îáðåçàòü (TRIM) или просто îáð (TR) и выберите

в качестве секущих ребер все три интересующих нас линии (выделены на
рис. 4.38 пунктиром).

8. Нажав Enter для завершения выбора, последовательно щелкните для от�
сечения лишних сегментов в точках, показанных на рис. 4.38 (сначала на
горизонтальных линиях, а затем на вертикальной линии).

9. Нажмите Enter для завершения работы инструмента Обрезать (Trim),
а затем воспользуйтесь инструментом Зумировать предыдущий (Zoom
Previous) для восстановления предыдущего масштаба.

Таким образом, во многих случаях при использовании инструмента Обре�
зать (Trim) (равно как и инструментов Удлинить (Extend) и Сопряжение
(Fillet)) ряд последовательных применений инструмента можно объединить
в одну операцию. В последующих главах мы еще воспользуемся этими особен�
ностями данных инструментов.

Между тем, наш чертеж (рис. 4.39) уже очень похож на чертеж, показанный
на рис. 4.3. Строго говоря, для его завершения нам осталось лишь начертить
две наклонные лини, две дуги, а также несколько сегментов прямых линий, ко�
торые мы создадим в виде прямоугольников.

Что ж, приступим к выполнению этих задач, и заодно изучим несколько но�
вых инструментов, предназначенных как для создания элементов чертежа со�
ответствующей формы, так и для облечения работы пользователя AutoCAD.

4.2. Создание дуг и прямоугольников4.2. Создание дуг и прямоугольников4.2. Создание дуг и прямоугольников4.2. Создание дуг и прямоугольников4.2. Создание дуг и прямоугольников
Для начала мы создадим два прямоугольника, обозначающих на чертеже стен�
ки малой тумбы. Конечно, внутренние контуры стенок тумбы можно было бы
получить, просто сместив внутрь контура тумбы наружные линии. Но в данном
случае мы воспользуемся новым для вас инструментом и добьемся такого же
визуального эффекта. На первый взгляд может показаться, что это не очень
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Рис. 4.38  Точки, в которых нужно щелкнуть
для отсечения лишних сегментов линий

Рис. 4.39  Вид чертежа после создания основных прямолинейных элементов
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щих элементов к требованиям стандартов. Выполнив эти элементы чертежа
в виде прямоугольников, а не отдельных линий, нам будет проще впоследствии
разобраться в том, что они обозначают на чертеже.

1. Для начала обратите внимание на строку состояния. Все находящиеся
в ней кнопки�индикаторы (за исключением кнопки Модель (MODEL))
должны быть отжатыми (то есть выключенными). Если это не так, щелк�
ните на нажатых кнопках, чтобы отключить все режимы, кроме режима
Модель (MODEL).

2. Выберите из меню команду Сервис ⇒ Режимы рисования (Tools ⇒ Draf�
ting Settings) либо введите в командном окне команду ðåæèìðèñ (DSET�
TINGS).

3. В появившемся окне Режимы рисования (Drafting Settings) перейдите
на вкладку Объектная привязка (Object Snap) и убедитесь в том, что все
находящиеся на ней флажки сброшены, как показано на рис. 4.40 (для
сброса флажка достаточно щелкнуть на нем), а затем щелкните на кнопке
OK, чтобы закрыть диалоговое окно.

6. Для создания прямоугольника, который будет представлять на чертеже
контур боковой стенки малой тумбы, запустите инструмент  Прямо�
угольник (Rectangle), кнопка которого находится на панели инструмен�
тов Черчение (Draw). Альтернативный метод запуска этого инструмента
заключается в использовании команды меню Черчение ⇒ Прямоуголь�
ник (Draw ⇒ Rectangle) либо в использовании команды командного окна
Ïðÿìîóãîëüíèê (RECTANG) или ее псевдонима ïðÿìîóã (REC). AutoCAD
предложит в командном окне задать координаты первого угла или вы�
брать дополнительные режимы использования инструмента Прямоуголь�
ник (Rectangle) (Ïåðâûé óãîë èëè [Ôàñêà/Óðîâåíü/Ñîïðÿæåíèå/Âû-
ñîòà/Øèðèíà]: (Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]:)). В данном случае нас вполне устраивает предложен�
ный по умолчанию режим. Размер прямоугольника в этом режиме задает�
ся точно так же, как и размер рамки масштабирования, – по двум точкам,
определяющим противоположные углы прямоугольника. Однако, в от�
личие от рамки масштабирования, мы не можем задать координаты этих
точек «на глаз». Для того чтобы расположить прямоугольный контур бо�
ковой стенки тумбы, можно либо вычислить и ввести координаты, либо
использовать различные режимы объектной привязки (object snap). Объек�
тная привязка – это специальный механизм AutoCAD, который обеспечи�
вает автоматическое распознавание характерных точек чертежа (око�
нечные и средние точки линий, центры окружностей и т. п.). Именно
эти режимы и были перечислены на вкладке Объектная привязка
(Object Snap) диалогового окна Режимы рисования (Drafting Settings)
(см. рис. 4.40). Вы их только что отключили, чтобы не путаться в пока что
неизвестных вам режимах, однако теперь настало время воспользовать�
ся одним из режимов объектной привязки.
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Рис. 4.40  Вкладка Объектная привязка (Object Snap)
диалогового окна Режимы рисования (Drafting Settings)

Рис. 4.41  Использование инструмента Окно зумирования (Zoom Window)
для увеличения фрагмента чертежа в районе малой тумбы

4. Щелкните на кнопке  Окно зумирования (Zoom Window) панели ин�
струментов Standard (если нужно, выберите эту кнопку на плавающей па�
нели, как рассказывалось в главе 1) или просто введите в командной
строке ïî (Z) для включения режима рамки масштабирования.

5. Охватите рамкой масштабирования контур малой тумбы, как показано
на рис. 4.41.
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в режиме объектной привязки на чертеже обозначается ближайшая к те�
кущему расположению указателя�перекрестия оконечная точка.

10. Теперь вам не нужно вводить координаты первой точки – как только она
распознана в режиме объектной привязки, пользователю достаточно щел�
кнуть левой кнопкой мыши (даже если указатель�перекрестие не совпада�
ет точно с положением распознанной опорной точки). Поэтому, добив�
шись появления маркера объектной привязки к показанной на рис. 4.43
оконечной точке, переместите указатель�перекрестие вправо и вверх.

11. Перемещая указатель, вы будете видеть, что одновременно с ним изменя�
ется контур прямоугольника, левый нижний угол которого привязан
к только что заданной вами точке, а правый верхний – к указателю�пере�
крестию. (Как только вы остановите указатель, контур прямоугольника
тут же исчезнет. Не волнуйтесь – все в порядке, просто две линии прямо�
угольника совпадают с имеющимися линиями чертежа, а две – с линиями
указателя�перекрестия.) Между тем в командном окне появится пригла�
шение ввести координаты второго угла создаваемого прямоугольника
(Âòîðîé óãîë èëè [Ïëîùàäü/Ðàçìåðû/Ïîâîðîò]: (Specify other
corner point or [Area/Dimensions/Rotation]:). В ответ на это приглаше�
ние, исходя из размеров, указанных на рис. 4.3, введите относительные
координаты: @400,18.

Прямоугольник займет свое место на чертеже (рис. 4.44), а выполнение ко�
манды Ïðÿìîóãîëüíèê (RECTANG) автоматически закончится.

Примечание. Конечно, с помощью инструмента Прямоугольник (Rectangle) мож�
но было бы создать и контур рабочей зоны, а также всех объектов прямоугольной
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Рис. 4.42  Панель инструментов Объектная привязка (Object Snap) в окне AutoCAD

Рис. 4.43  AutoCAD распознал оконечную точку нижней горизонтальной линии

7. Щелкните правой кнопкой мыши на любой панели инструментов, найди�
те в открывшемся списке панелей пункт Объектная привязка (Object
Snap) и щелкните на нем. На экране появится плавающая панель Объек�
тная привязка (Object Snap) с кнопками инструментов, которые пред�
назначены для включения режимов объектной привязки (рис. 4.42).
Панель после появления ее на экране будет плавающей. Можете переме�
стить ее в свободное место рабочей области (например, как показано на
рис. 4.42), или пристыковать ее рядом с другими панелями инструментов
(например, правее панели Standard).

8. Щелкните на кнопке  Конточка (Snap to Endpoint) панели Объектная
привязка (Object Snap). В командном окне появится сообщение _endp
of. Это означает, что включен режим объектной привязки к оконечной
точке (endpoint).

9. Переместите указатель�перекрестие к левой точке нижней горизонталь�
ной линии контура малой тумбы. Как только указатель достигнет конеч�
ной точки, AutoCAD распознает ее, обозначив цветным квадратиком
(рис. 4.43). Если задержать указатель на 1–2 с, рядом с ним появится
всплывающая подсказка Конточка (Endpoint). Именно таким образом
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формы, которые мы создавали в главах 3 и 4 до этого момента. С одной стороны,
это избавило бы нас от необходимости выполнения сопряжений, а также обрезки
и продления линий. Тем не менее, нередко удобнее воспользоваться описанными
выше методами, основанными на смещении, чем создавать прямоугольники, по�
скольку для удаления лишних линий во многих случаях может возникнуть необхо�
димость в использовании дополнительной операции, которая заключается в пре�
образование прямоугольников в набор отдельных линий с помощью инструмента
Расчленить (Explode).

Теперь давайте для закрепления навыка создадим прямоугольный контур
фасада малой тумбы, но пока что расположим его не так, как он должен нахо�
диться на чертеже (по вертикали, как показано на рис. 4.3), а по горизонтали,
то есть точно так же, как только что созданный прямоугольник.

1. Запустите инструмент Прямоугольник (Rectangle) (например, щелкнув
на кнопке Прямоугольник (Rectangle) панели инструментов Черчение
(Draw) или введя в командном окне ïðÿìîóã (REC)).

2. В ответ на приглашение задать координаты первого угла прямоугольни�
ка, щелкните на кнопке Конточка (Snap to Endpoint) для включения ре�
жима объектной привязки к оконечной точке (в командном окне появит�
ся сообщение _endp of).

3. Подведите указатель�перекрестие к точке, которая находится в правом
нижнем углу прямоугольника, созданного на предыдущем этапе, и, как
только AutoCAD распознает ее как оконечную, щелкните левой кнопкой
мыши для привязки первого угла нового прямоугольника к данной точке.

4. Переместите указатель�перекрестие вправо и вниз, а затем в ответ на
приглашение задать координаты второй точки, введите, руководствуясь
размерами на рис. 4.3, относительные координаты второго угла прямо�

В данном случае мы могли бы создать прямоугольник сразу с нужным распо�
ложением (для этого нужно было бы ввести в п. 4 предыдущего этапа относи�
тельные координаты в виде @18,296). «Дверца» в этом случае была бы «закры�
той», однако автор намерено решила немного усложнить задачу, чтобы
познакомить вас с одним достаточно важным приемом создания элементов
сложных чертежей. Суть этого приема состоит в том, что тот или иной объект
при создании располагается так и в том месте чертежа, как это удобно пользо�
вателю, а затем поворачивается и (или) копируется в другое положение и (или)
место. Именно так мы поступим в следующей главе, когда будем создавать
объекты, расположенные не по горизонтали или вертикали, а под углом.

Ну а пока давайте займемся разворотом контура фасада малой тумбы.

Использование инструмента «Повернуть» (Rotate)Использование инструмента «Повернуть» (Rotate)Использование инструмента «Повернуть» (Rotate)Использование инструмента «Повернуть» (Rotate)Использование инструмента «Повернуть» (Rotate)
для поворота объектовдля поворота объектовдля поворота объектовдля поворота объектовдля поворота объектов
В данном случае нам нужно развернуть прямоугольный объект, представляю�
щий на чертеже контур фасада малой тумбы, на 90° против часовой стрелки.
Для этого нам понадобиться воспользоваться новым для вас инструментом
Повернуть (Rotate).
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Рис. 4.44  Прямоугольник, представляющий контур левой боковой стенки малой тумбы,
занял свое место на чертеже после ввода относительных координат

Рис. 4.45  Второй прямоугольник создан

угольника: @296,–18. (Как вы помните из материала главы 2, при вводе
относительных координат положительные значения соответствуют на�
правлению вправо и вверх, а отрицательные – влево и вниз.)

5. Восстановите предыдущий масштаб, воспользовавшись инструментом
Зумировать предыдущий (Zoom Previous).

Теперь чертеж малой тумбы выглядит так, словно тумба на нем изображена
с открытой дверцей (рис. 4.45).
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Совет. В AutoCAD направление поворота против часовой стрелки считается по�
ложительным, а по часовой стрелке – отрицательным. Если вас не устраивает
принятое по умолчанию направление отсчета углов, его можно изменить с помо�
щью диалогового окна Выбор направления (Direction Control), которое открыва�
ется после щелчка на кнопке Направление (Direction) диалогового окна Единицы
чертежа (Drawing Units) (см. рис. 3.3).

1. Запустите инструмент  Повернуть (Rotate), щелкнув на кнопке По�
вернуть (Rotate) панели инструментов Изменить (Modify) или выбрав
из меню команду Изменить ⇒ Повернуть (Modify ⇒ Rotate) либо введя
в командном окне команду Ïîâåðíóòü (ROTATE) или просто ïîâ (RO).
AutoCAD предложит выбрать объекты, подлежащие повороту. Щелкни�
те на одной из линий фасада малой тумбы и нажмите Enter для заверше�
ния выбора.

Примечание. Щелкнув на одной из линий прямоугольника, вы сразу поймете, чем
он отличается от прямоугольников, созданных из отдельных линий, – в данном
случае будут выделены сразу все четыре линии объекта, независимо от того, на
какой из линий вы щелкните. Прямоугольники, созданные с помощью команды
Ïðÿìîóãîëüíèê (RECTANG), состоят из четырех сегментов так называемой
полилинии (polyline), которая объединяет все сегменты в один объект. Подробнее с
полилиниями вы познакомитесь в материале главы 10, посвященной нанесению
надписей на чертеж.

2. AutoCAD в командном окне предложит выбрать базовую точку, относи�
тельно которой нужно выполнить поворот. Щелкните на кнопке Кон�
точка (Snap to Endpoint) панели инструментов Объектная привязка
(Object Snap).

3. Переместите указатель к верхнему левому углу контура фасада (точка,
в которой он прикасается к контуру малой тумбы). Как только AutoCAD
распознает эту точку в качестве оконечной, щелкните левой кнопкой
мыши для захвата ее координат в качестве базовой точки поворота.
Прежде, чем перейти к выполнению следующей операции, убедитесь
в том, что кнопка�индикатор ОРТО (ORTHO) в строке состояния нахо�
дится в выключенном положении (если это не так, щелкните на нем, что�
бы отключить ортогональный режим черчения). Этот режим, который
обеспечивает черчение только по горизонтали и вертикали, бывает удо�
бен во многих случаях, но в данной ситуации он нам будет только мешать.
Более подробно ортогональный режим описан в материале главы 5.

4. Переместите указатель от базовой точки – с перемещением указателя
контур фасада будет поворачиваться (рис. 4.46). В командной строке по�
явится приглашение Óãîë ïîâîðîòà èëè [Êîïèÿ/Îïîðíûé óãîë] <0>:
(Specify rotation angle or [Copy/Reference] <0.00>), предлагающее задать
угол поворота.

5. Введите 90. Прямоугольник будет повернут на 90°, в результате чего
наша «дверца» малой тумбы перейдет в «закрытое» положение, как на

рис. 4.3, а выполнение команды Ïîâåðíóòü (ROTATE) автоматически за�
вершится.

Теперь мы на некоторое время отвлечемся от задачи создания прямоуголь�
ников и познакомимся с еще одним новым инструментом, предназначенным
для создания дуг.
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Как вы догадываетесь, глядя на рис. 4.3, дуги нам нужно создать для того, чтобы
получить контуры округленных полок. Таких объектов на нашем чертеже долж�
но быть два (полок больше, но контуры трех из них, которые находятся возле
малой тумбы, на виде сверху совпадают): один расположен возле контура малой
тумбы, а второй – возле контура парты. Мы начнем с создания контура полки,
находящейся возле малой тумбы. Для этого нам понадобиться воспользоваться
инструментом Дуга (Arc), а также режимом привязки Конточка (Endpoint).

У инструмента Дуга (Arc) есть одна особенность. В отличие от многих дру�
гих инструментов, которые можно запускать разными способами, инструмент
Дуга (Arc) лучше всего (во всяком случае, начинающим пользователям) запус�
кать из меню Черчение (Draw). Это объясняется тем, что в меню Черчение ⇒
Дуга (Draw ⇒ Arc) имеется специальное подменю (рис. 4.47), которое позволя�
ет быстро выбрать режим работы команды äóãà (ARC), наилучшим образом
соответствующий задаче, стоящей перед пользователем.

При запуске инструмента Дуга (Arc) с помощью кнопки панели инструмен�
тов Черчение (Draw) запускается режим работы этого инструмента, соответ�
ствующий команде Черчение ⇒ Дуга ⇒ 3 точки (Draw ⇒ Arc ⇒ 3 Points). При
запуске инструмента Дуга (Arc) из командного окна (путем ввода команды äóãà
(ARC)) пользователь может, отвечая на запросы команды, самостоятельно
выбрать ее режим работы, однако по умолчанию также используется режим по�
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Рис. 4.46  Второй прямоугольник вращается вокруг базовой точки
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строения дуги по трем точкам, как и при
запуске инструмента Дуга (Arc) с по�
мощью кнопки панели инструментов
Черчение (Draw).

1. Используя инструмент Окно зу�
мирования (Zoom Window), уве�
личьте изображение фрагмента
чертежа, который находится меж�
ду малой тумбой и нижней горизон�
тальной границей рабочей зоны.

2. Выберите из меню команду Черче�
ние ⇒ Дуга ⇒ Начало, центр, ко�
нец (Draw ⇒ Arc ⇒ Start, Center,
Angle). В нашем случае этот режим
создания дуги наиболее удобен, по�
скольку мы легко можем, используя
режим объектной привязки Кон�
точка (Endpoint), задать точки ее
начала и центра, а градусная мера
дуги нам заранее известна (90°).

3. AutoCAD автоматически запустит команду äóãà (ARC) в командном окне
(_arc), а затем отобразит приглашение Íà÷àëüíàÿ òî÷êà äóãè èëè
[Öåíòð]: (Specify start point of arc or [Center]:). Это означает, что по умол�
чанию нужно указать начальную точку дуги (Íà÷àëüíàÿ òî÷êà äóãè
(Specify start point of arc)).

Примечание. Дугу можно задать несколькими разными методами, основанными
на использовании комбинации следующих характеристик: координаты начальной
(Начало (Start)) и конечной (Конец (End)) точки; градусная мера (Угол (Angle)); ко�
ординаты центральной точки (Центр (Center)); радиус (Радиус (Radius)); на�
правление касательной к дуге, проведенной в начальной точке (Направление
(Direction)); длина хорды (Длина (Length)). Выбирать конкретную комбинацию
этих характеристик нужно, исходя из особенностей чертежа. Именно поэтому
начинающим пользователям рекомендуется осваивать инструмент Дуга (Arc),
используя меню (см. рис. 4.47), в котором представлены все возможные комбина�
ции характеристик дуги.

4. Щелкните на кнопке Конточка (Snap to Endpoint), чтобы включить ре�
жим привязки к оконечной точке Конточка (Endpoint), и выберите
в этом режиме нижнюю точку внутренней линии контура боковой стен�
ки, как показано на рис. 4.48.

5. В командной строке появится приглашение Âòîðàÿ òî÷êà äóãè èëè
[Öåíòð/Êîíåö] (Specify second point of arc or [Center/End]:) _c Öåíòð
äóãè (_c Specify center point of arc). Проще говоря, AutoCAD за вас выбе�
рет режим Öåíòð (Center), введя в командном окне псевдоним перехода
в этот режим (_c). Если бы вы запустили инструмент Дуга (Arc) с по�
мощью кнопки панели инструментов или непосредственно в командном
окне, этот режим вам пришлось бы выбирать вручную. Именно поэтому
автор советует для построения дуг использовать меню, а не другие мето�
ды запуска инструмента Дуга (Arc). Вновь включите режим привязки
Конточка (Endpoint) и выберите точку, которая находится выше началь�
ной точки дуги на 400 мм (точка пересечения внутренней вертикальной
линии контура боковой стенки и внешней горизонтальной линии конту�
ра малой тумбы – см. рис. 4.3).

6. AutoCAD отобразит приглашение Êîíå÷íàÿ òî÷êà äóãè èëè [Óãîë/
Äëèíà õîðäû]: (Specify end point of arc or [Angle/chord Length]) и тут же
автоматически введет _a для включения режима задания градусной меры
дуги óãîë (Angle), в связи с чем в командном окне появится приглашение
Ïðîòèâîïîëîæíûé óãîë: (Specify included angle:). Кроме того, вслед за
указателем�перекрестием будет перемещаться «резиновая линия», со�
единяющая его с центральной точкой, выбранной в п. 5 (рис. 4.49). От
начальной точки будет проведена дуга, градусная мера которой также бу�
дет изменяться в зависимости от перемещения указателя�перекрестия.

7. Введите в командном окне 90. AutoCAD создаст дугу нужной длины, пос�
ле чего выполнение команды äóãà (ARC) автоматически завершится.

Рис. 4.48  Выбор начальной точки дуги
с использованием режима привязки Конточка (Endpoint)
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Рис. 4.47  Подменю Черчение ⇒ Дуга
(Draw ⇒ Arc) содержит 11 команд,

соответствующих различным режимам
использования команды äóãà (ARC)
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8. Восстановите предыдущий масштаб, воспользовавшись инструментом
Зумировать предыдущий (Zoom Previous).

Теперь логично предположить, что автор предложит вам приступить к со�
зданию второй дуги. Однако мы поступим не так – мы не станем создавать вто�
рую дугу с помощью инструмента Дуга (Arc), а просто скопируем ее в нужное
место. Копирование объектов – это очень популярная операция, к которой вы
будете прибегать не раз, работая в AutoCAD. В отличие от смещения, она позво�
ляет перемещать копии объектов в произвольное место чертежа.

4.2.2. Копирование объектов с помощью инструмента4.2.2. Копирование объектов с помощью инструмента4.2.2. Копирование объектов с помощью инструмента4.2.2. Копирование объектов с помощью инструмента4.2.2. Копирование объектов с помощью инструмента
«Копировать» (Copy)«Копировать» (Copy)«Копировать» (Copy)«Копировать» (Copy)«Копировать» (Copy)
Для создания копий объектов чертежа в AutoCAD предназначен инструмент
Копировать (Copy). Расположение копии задается либо указателем�перекрес�
тием, либо путем ввода координат с клавиатуры. При копировании нужно
задать базовую точку (base point), то есть точку, «за которую» пользователь
«берет» объекты, и вторую точку (second point), расположение которой относи�
тельно базовой определяет направление и расстояние перемещении копии.
Если расстояние и направление перемещения копии известны точно (напри�
мер, копию нужно сместить вправо на 100 мм), базовую точку можно выбрать
произвольным образом, так как вторая точка в подобных случаях задается в от�
носительных полярных или декартовых координатах. Но в нашей ситуации
точное расстояние и угол перемещения копии контура округленной полки за�
ранее неизвестны, поэтому к выбору базовой точки нужно подойти тщательно.

Поскольку на правой боковой границе контура парты нет характерных то�
чек, к которым мы могли бы привязаться, в качестве базовой при перемещении
дуги мы можем взять либо центральную точку дуги, либо ее конечную точку (со�

впадает с правым нижним углом прямоугольника, представляющего боковую
стенку малой тумбы). Давайте выберем в качестве базовой точку конечную точ�
ку дуги – в таком случае мы сможем привязать копию к точке, которая находит�
ся в правом нижнем углу прямоугольника, представляющую заднюю стенку ра�
бочей зоны.

1. Щелкните на кнопке  Копировать (Copy) панели инструментов Изме�
нить (Modify), выберите из меню команду Изменить ⇒ Копирование
свойств (Modify ⇒ Copy) либо введите в командном окне команду Êîïè-
ðîâàòü (COPY) или просто êï (CP). AutoCAD в командном окне предло�
жит выбрать объекты, подлежащие копированию. Выберите созданную
на предыдущем этапе дугу и нажмите Enter.

2. В командной строке появится приглашение Áàçîâàÿ òî÷êà èëè [Ïåðå-
ìåùåíèå] <Ïåðåìåùåíèå>: (Specify base point or [Displacement] <Displa�
cement>:). Включите режим привязки Конточка (Endpoint) и выберите
точку, показанную на рис. 4.50. (Если вы затрудняетесь правильно выбрать
точку, увеличьте соответствующий фрагмент чертежа, щелкнув на кнопке
Окно зумирования (Zoom Window) панели инструментов Standard.)

3. Как только вы зададите базовую точку, копия дуги «приклеится» к указа�
телю�перекрестию конечной точкой, а в командном окне появится при�
глашение Âòîðàÿ òî÷êà èëè <c÷èòàòü ïåðåìåùåíèåì ïåðâóþ òî÷-
êó>: (Specify second point or <use first point of displacement>). Теперь
следует указать точку, в которой контур второй полки будет соприкасать�
ся с конечной точкой нижней линии контура задней стенки. (Если вы из�
менили масштаб просмотра, щелкните на кнопке Зумировать предыду�
щий (Zoom Previous) панели инструментов Standard.) Переместите

Рис. 4.50  Выбор конечной точки дуги в качестве базовой точки для копирования
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Рис. 4.49  AutoCAD ожидает ввода градусной меры дуги
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указатель�перекрестие с «приклеенной» к нему дугой в правый верхний
угол чертежа (см. рис. 4.3).

Совет. Обратите внимание на то, что на панели Standard имеется две кнопки
 Зумировать предыдущий (Zoom Previous) – одна находится среди кнопок пла�

вающей панели Зумирование (Zoom), а вторая – справа от этой панели. Поэто�
му удобнее всего использовать плавающую панель для запуска инструмента Окно
зумирования (Zoom Window), а инструмент Зумировать предыдущий (Zoom
Previous) запускать, щелкая на отдельной кнопке (без черного треугольника в пра�
вом нижнем углу). То же, самое, кстати, относится и к кнопке Зумирование
в реальном времени (Zoom Realtime), которая находится слева от плавающей па�
нели Зумирование (Zoom) (если мышь вашего компьютера оборудована колесиком,
функции кнопки Зумирование в реальном времени (Zoom Realtime) выполняет
вращение колесика).

4. Включите режим Конточка (Endpoint) и выберите оконечную точку
нижней горизонтальной линии контура задней стенки рабочей зоны.
Копия дуги тут же займет свое место (рис. 4.51), а выполнение команды
Êîïèðîâàòü (COPY) продолжится.

5. Нажмите Enter для завершения работы команды Êîïèðîâàòü (COPY).

команд Ïîêàçàòü (ZOOM), Ïàíîðàìèðîâàíèå или ïàí (Pan) и других
в AutoCAD называется методом прозрачного запуска.

Теперь вы, наверное, понимаете, почему мы не стали создавать второй прямо�
угольник, представляющий правую боковую стенку малой тумбы. Действительно,
его можно просто скопировать. Однако в данном случае можно поступить еще
проще – создать не копию объекта, а его зеркальное отображение. Подобные си�
туации при создании чертежей технических объектов, для которых характерна
симметрия, возникают довольно часто. Поэтому давайте воспользуемся тем, что
малая тумба симметрична относительно продольной оси, и применим зеркальное
отображение контура ее левой стенки для получения контура правой стенки. По�
путно вы познакомитесь с еще одним режимом объектной привязки.

4.2.3. Зеркальное отображение объектов с помощью4.2.3. Зеркальное отображение объектов с помощью4.2.3. Зеркальное отображение объектов с помощью4.2.3. Зеркальное отображение объектов с помощью4.2.3. Зеркальное отображение объектов с помощью
инструментов «Зеркальное отражение» (Mirror)инструментов «Зеркальное отражение» (Mirror)инструментов «Зеркальное отражение» (Mirror)инструментов «Зеркальное отражение» (Mirror)инструментов «Зеркальное отражение» (Mirror)
и «Середина» (Snap to Midpoint)и «Середина» (Snap to Midpoint)и «Середина» (Snap to Midpoint)и «Середина» (Snap to Midpoint)и «Середина» (Snap to Midpoint)
Итак, мы используем имеющийся объект, представляющий на чертеже контур
левой стенки малой тумбы, чтобы создать на его основе с помощью инструмен�
та Зеркальное отражение (Mirror) точно такой же объект, представляющий
собой зеркальное отображение первого.

Инструмент Зеркальное отражение (Mirror) позволяет создавать копии
симметрично расположенных элементов чертежа относительно оси зеркально�
го отображения, определяемой по двум точкам. Поскольку точность отображе�
ния зависит от корректности выбора оси, очень важно хорошо представлять,
какой именно результат нужно получить. В некоторых случаях, когда преимуще�
ство зеркального отображения очевидно, можно даже начертить вспомогатель�
ную линию, чтобы облегчить задачу выбора конечных точек оси зеркального
отображения. Но в нашем случае этого делать не придется, поскольку ось зер�
кального отображения уже имеется на чертеже. Правда, для ее визуализации нам
понадобиться использовать новый для вас режим объектной привязки.

1. Щелкните на кнопке  Зеркальное отражение (Mirror) панели инстру�
ментов Изменить (Modify) или выберите из меню команду Изменить ⇒
Зеркало (Modify ⇒ Mirror) либо введите в командном окне команду Çåð-
êàëî (MIRROR).

2. В ответ на приглашение выбрать объекты щелкните на контуре левой
боковой стенки малой тумбы и нажмите Enter для завершения выбора.
В командном окне появится приглашение Ïåðâàÿ òî÷êà îñè îòðàæå-
íèÿ: (Specify first point of mirror line:).

3. Щелкните на кнопке  Середина (Snap to Midpoint) панели инструмен�
тов Объектная привязка (Object Snap). Включится режим объектной
привязки к серединной точке (в командном окне AutoCAD автоматиче�
ски введет команду _mid). В этом режиме AutoCAD умеет распознавать
срединные точки объектов.

Примечание. Если вы изменяли масштаб просмотра, используя кнопки Окно зу�
мирования (Zoom Window) и Зумировать предыдущий (Zoom Previous) панели
инструментов Standard, то заметили, что они никак не повлияли на работу ко�
манды Êîïèðîâàòü (COPY). Точно так же работают и другие инструменты
масштабирования (zoom) и панорамирования (pan) – вы можете их применять,
не прерывая работы ранее запущенных команд. Такой метод использования

Создание дуг и прямоугольниковСоздание дуг и прямоугольниковСоздание дуг и прямоугольниковСоздание дуг и прямоугольниковСоздание дуг и прямоугольников

Рис. 4.51  Контур округленной полки скопирован



Простые инструменты и приемы черченияПростые инструменты и приемы черченияПростые инструменты и приемы черченияПростые инструменты и приемы черченияПростые инструменты и приемы черчения116 117

7. Отраженное изображение исчезнет, а в командном окне появится за�
прос Óäàëèòü èñõîäíûå îáúåêòû? [Äà/Íåò] <Í>: (Erase source objects?
[Yes/No] N:). Этот запрос означает, что перед завершением команда
Çåðêàëî (MIRROR) может удалить исходный объект, оставив на черте�
же только его зеркальную копию. В данном случае нам это не нужно, по�
этому нажмите Enter, чтобы отказаться от удаления.

8. На чертеже появится зеркальное отображение правой стенки малой тум�
бы, а команда Çåðêàëî (MIRROR) завершит свою работу.

Для завершения чертежа нам осталось выполнить совсем немного работы:
создать контуры боковых стенок тумбы системного блока и большой тумбы,

контур фасада большой тумбы и контуры трех вырезов в фасадах малой и боль�
шой тумб, а также выдвижного ящика стола (в этих вырезах будут располагать�
ся врезные ручки). Кроме того, нужно завершить работу над контурами полок,
расположенных в левом углу рабочей зоны (см. рис. 4.1–4.3). Сейчас вы вполне
готовы решить последнюю задачу, поэтому мы с нее и начнем.

4.3. Завершающие этапы4.3. Завершающие этапы4.3. Завершающие этапы4.3. Завершающие этапы4.3. Завершающие этапы
Для завершения данного этапа работы выполните следующие последователь�
ности действий.

4.3.1. Использование инструмента «С линиями» (Line)4.3.1. Использование инструмента «С линиями» (Line)4.3.1. Использование инструмента «С линиями» (Line)4.3.1. Использование инструмента «С линиями» (Line)4.3.1. Использование инструмента «С линиями» (Line)
и режима привязки «Конточка» (Endpoint)и режима привязки «Конточка» (Endpoint)и режима привязки «Конточка» (Endpoint)и режима привязки «Конточка» (Endpoint)и режима привязки «Конточка» (Endpoint)
Пока вы были незнакомы с режимами объектной привязки, задача создания
наклонных линий могла показаться вам достаточно сложной. Однако теперь,
используя уже хорошо известный вам инструмент С линиями (Line) и режим
объектной привязки Конточка (Endpoint), вы справитесь с ней за считанные
секунды.

1. Запустите инструмент С линиями (Line) и, включив режим объектной при�
вязки Конточка (Endpoint), выберите верхнюю точку вспомогательной ли�
нии, которая находится в углу рабочей зоны, как показано на рис. 4.53.

2. AutoCAD предложит выбрать вторую точку линии. Снова включите ре�
жим привязки Конточка (Endpoint) и, руководствуясь рис. 4.3, выберите

Рис. 4.53  Выбор первой точки верхней полки
с помощью режима привязки Конточка (Endpoint)

Завершающие этапыЗавершающие этапыЗавершающие этапыЗавершающие этапыЗавершающие этапы

4. Подведите указатель�перекрестие к середине одной из вертикальных ли�
ний, обозначающих контур фасада малой тумбы. Как только AutoCAD
распознает середину линии, на экране появится треугольный маркер.
Щелкните мышью для захвата координат этой точки.

5. В командном окне появится приглашение Âòîðàÿ òî÷êà îñè îòðàæå-
íèÿ: (Specify second point of mirror line:), а на чертеже появится отра�
женное изображение исходного объекта, которое будет перемещаться
в соответствии с перемещением оси зеркального отображения, положе�
ние которой определяется первой выбранной точкой и текущим положе�
нием указателя�перекрестия.

6. Вновь включите режим привязки Середина (Midpoint) и выберите се�
редину второго вертикального отрезка контура фасада малой тумбы
(рис. 4.52).

Рис. 4.52  Отображение боковой стенки относительно оси,
проходящей через середины вертикальных отрезков фасада
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6. Снова воспользовавшись режимом привязки Конточка (Endpoint), вы�
берите верхнюю оконечную точку вертикальной линии, которая обозна�
чает контур полки шириной 400 мм.

7. Нажмите Enter для завершения работы команды Îòðåçîê (LINE).
Согласитесь, режим объектной привязки значительно упрощает задачу кон�

структора, не правда ли?

4.3.2. Использование инструмента «Прямоугольник»4.3.2. Использование инструмента «Прямоугольник»4.3.2. Использование инструмента «Прямоугольник»4.3.2. Использование инструмента «Прямоугольник»4.3.2. Использование инструмента «Прямоугольник»
(Rectangle) и режима привязки «Конточка» (Endpoint)(Rectangle) и режима привязки «Конточка» (Endpoint)(Rectangle) и режима привязки «Конточка» (Endpoint)(Rectangle) и режима привязки «Конточка» (Endpoint)(Rectangle) и режима привязки «Конточка» (Endpoint)
Давайте создадим прямоугольники, представляющие контуры боковых стенок
большой тумбы и тумбы системного блока, а также фасад большой тумбы, ис�
пользуя режим привязки Конточка (Endpoint).

1. Запустите инструмент Прямоугольник (Rectangle) и включите режим
привязки Конточка (Endpoint).

4. AutoCAD создаст прямоугольник, который будет представлять на черте�
же контур боковой стенки тумбы системного блока, и завершит выполне�
ние команды Ïðÿìîóãîëüíèê (RECTANG).

Вам осталось лишь создать контуры фасада и боковой стенки большой тум�
бы. К сожалению, в этом случае для выбора второй точки вы не сможете ис�
пользовать режим объектной привязки, поэтому при создании соответствую�
щих прямоугольников, применяйте технику, которую мы использовали на
предыдущих этапах – вводите относительные координаты второго угла, ис�
пользуя рис. 4.3.

Завершающие этапыЗавершающие этапыЗавершающие этапыЗавершающие этапыЗавершающие этапы

верхнюю точку вертикальной линии, которая обозначает контур полки
шириной 200 мм.

3. Нажмите Enter для завершения работы команды Îòðåçîê (LINE).
4. Щелкните на вспомогательной вертикальной линии для ее выделения,

а затем нажмите Delete для удаления этой линии.
5. Снова активизируйте инструмент С линиями (Line), включите режим

объектной привязки Конточка (Endpoint) и выберите левую оконечную
точку горизонтальной линии, обозначающей прямолинейный сегмент
нижней полки, как показано на рис. 4.54.

Рис. 4.55  Выбор второй точки контура боковой стенки
с помощью режима привязки Конточка (Endpoint)

2. В ответ на приглашение AutoCAD задать координаты первого угла прямо�
угольника выберите, используя привязку Конточка (Endpoint), точку, ко�
торая находится в левом верхнем углу контура тумбы системного блока.

3. AutoCAD предложит задать координаты второго угла прямоугольника.
Обычно в ответ на этот запрос вы вводили относительные координаты
соответствующей точки, которые, по сути, представляли собой размеры
прямоугольного элемента. Однако в этот раз мы можем обойтись без вво�
да координат, воспользовавшись режимом объектной привязки. Вклю�
чите режим привязки Конточка (Endpoint) и выберите точку, показан�
ную на рис. 4.55 (изображение тумбы системного блока на рисунке
увеличено для наглядности, поскольку линии чертежа, совпадающие
с линиями указателя�перекрестия, как всегда при черчении прямоуголь�
ников, становятся невидимыми).

Рис. 4.54  Выбор первой точки нижней полки
с помощью режима привязки Конточка (Endpoint)
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4. Для задания координат второй точки введите в командном окне: @18,
-582 (600 – 18 = 582 мм). AutoCAD создаст контур боковой стенки, а выпол�
нение команды Ïðÿìîóãîëüíèê (RECTANG) автоматически завершится.

Примечание. В действительности невозможность использования режима объек�
тной привязки в данной ситуации только кажущаяся. В последующих главах вы
узнаете, как можно свести к минимуму задание размеров вручную, используя для
этого вместе с объектной привязкой специальные режимы отслеживания объект�
ной привязки.

4.3.3. Использование пересекающей рамки4.3.3. Использование пересекающей рамки4.3.3. Использование пересекающей рамки4.3.3. Использование пересекающей рамки4.3.3. Использование пересекающей рамки
и инструмента «Объектная привязка» (Object Snap)и инструмента «Объектная привязка» (Object Snap)и инструмента «Объектная привязка» (Object Snap)и инструмента «Объектная привязка» (Object Snap)и инструмента «Объектная привязка» (Object Snap)
Для завершения чертежа в том виде, в котором он приведен на рис. 4.3, нам
осталось создать контуры вырезов под ручки в фасадах малой и большой тумб,
а также в фасаде выдвижного ящика стола. Эти контуры представляют собой

3. Запустите инструмент Прямоугольник (Rectangle), включите режим
привязки Конточка (Endpoint), и выберите в качестве первой точки
нижнюю оконечную точку любой из двух вспомогательных линий.

4. В ответ на приглашение задать вторую точку щелкните на кнопке  Пе�
ресечение (Snap to Intersection) панели инструментов Объектная при�
вязка (Object Snap), а затем подведите указатель�перекрестие к точке,

Завершающие этапыЗавершающие этапыЗавершающие этапыЗавершающие этапыЗавершающие этапы

Сначала мы создадим контур фасада, а затем – контур боковой стенки.
1. Запустите инструмент Прямоугольник (Rectangle) и выберите с помо�

щью привязки Конточка (Endpoint) точку, которая находится в левом
нижнем углу контура большой тумбы.

2. Для задания координат второй точки введите в командном окне:
@500,18.

3. Нажмите Enter для повторного запуска команды Ïðÿìîóãîëüíèê (REC�
TANG) и выберите с помощью привязки Конточка (Endpoint) точку, кото�
рая находится в левом верхнем углу контура большой тумбы (рис. 4.56).

Рис. 4.56  Выбор первой точки контура боковой стенки большой тумбы
с помощью режима привязки Конточка (Endpoint)

прямоугольники шириной 80 мм и высотой 18 мм (на рис. 4.3 размер выреза
показан только для большой тумбы). Решить эту задачу можно разными спосо�
бами, но мы применим комбинированную технику, которая позволит вам по�
знакомиться с несколькими новыми инструментами.

1. Измените масштаб просмотра так, чтобы всю область черчения занима�
ла нижняя половина контура парты, включая линию, которая представ�
ляет контур нижней полки парты.

2. Сместите сначала левую вертикальную линию контура парты вправо на
360 мм (800/2 – 80/2 = 400 – 40 = 360 мм), а затем правую линию контура
парты влево на то же расстояние (рис. 4.57). Казалось бы, можно обре�
зать полученные линии по контуру фасада выдвижного ящика парты,
и результат достигнут. Однако в этом случае мы получим не прямоуголь�
ник, а две вертикальные линии. Второе решение, лежащее на поверхно�
сти, – обрезать эти линии по контуру фасада выдвижного ящика, а затем,
используя их в качестве вспомогательных, начертить по их оконечным точ�
кам прямоугольник, после чего эти линии удалить. Это уже лучше, но выбор
коротких отрезков вспомогательных линий, лежащих под прямоугольни�
ком, будет затруднителен. Поэтому мы применим третий подход, восполь�
зовавшись для этого режимом привязки Пересечение (Intersection).

Рис. 4.57  Вертикальные вспомогательные линии созданы
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5. AutoCAD создаст прямоугольник и завершит выполнение команды Ïðÿ-
ìîóãîëüíèê (RECTANG). На первый взгляд, на чертеже ничего не из�
менится, поскольку контуры полученного прямоугольника совпадают
с линиями других объектов чертежа. Давайте удалим две вертикальные
вспомогательные линии, но сделаем это, не щелкая на них, а выделим их
с помощью пересекающей рамки (crossing window). Щелкните правее пра�
вой вертикальной линии и переместите указатель мыши влево и вверх.
Указатель�перекрестие исчезнет, а вместо него на экране появится
штриховая рамка, внутренняя область которой будет иметь зеленый
цвет (рис. 4.59).

6. Все объекты чертежа, которые хотя бы в одной точке пересекаются
этой рамкой, после повторного щелчка левой кнопкой мыши будут выде�
лены. Пересеките обе вспомогательные линии рамкой, как показано на
рис. 4.59, а затем щелкните левой кнопкой мыши. Рамка исчезнет, на
экране снова появится указатель�перекрестие, а обе линии станут выде�
ленными.

7. Нажмите Delete для удаления выделенных вспомогательных линий.
Теперь видно, что прямоугольник, представляющий вырез для ручки в фаса�

де, создан. Нам осталось лишь скопировать его на два других фасада.

4.3.4. Использование инструментов «Копировать»4.3.4. Использование инструментов «Копировать»4.3.4. Использование инструментов «Копировать»4.3.4. Использование инструментов «Копировать»4.3.4. Использование инструментов «Копировать»
(Copy) и «Повернуть» (Rotate) и режима привязки(Copy) и «Повернуть» (Rotate) и режима привязки(Copy) и «Повернуть» (Rotate) и режима привязки(Copy) и «Повернуть» (Rotate) и режима привязки(Copy) и «Повернуть» (Rotate) и режима привязки
«Середина» (Midpoint)«Середина» (Midpoint)«Середина» (Midpoint)«Середина» (Midpoint)«Середина» (Midpoint)
Сначала мы скопируем прямоугольник, выбрав в качестве базовой среднюю
точку нижней горизонтальной линии контура фасада, а затем разместим две
его копии в соответствующих точках остальных фасадов.

1. Запустите инструмент Копировать (Copy) и щелкните на одной из его
вертикальных линий для выделения, а затем нажмите Enter для заверше�
ния выбора. Можете также использовать пересекающую рамку, как пока�
зано на рис. 4.60. Когда после повторного щелчка AutoCAD снова отобра�
зит указатель�перекрестие и выделит прямоугольник, также нажмите
Enter для завершения выбора.

Завершающие этапыЗавершающие этапыЗавершающие этапыЗавершающие этапыЗавершающие этапы

в которой неиспользовавшаяся в п. 3 вспомогательная линия пересекает�
ся с линией контура фасада. Как только AutoCAD распознает точку пере�
сечения этих линий (рис. 4.58), щелкните для захвата ее координат.

Рис. 4.58  Выбор второй точки выреза под ручку
с помощью режима привязки Пересечение (Intersection)

Рис. 4.59  Выделение объектов с помощью пересекающей рамки

Рис. 4.60  Выделение прямоугольника с помощью пересекающей рамки
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Рис. 4.61  Выбор базовой точки с помощью режима привязки Середина (Midpoint)

2. Включите режим привязки Середина (Midpoint) и подведите указатель�
перекрестие к середине нижней горизонтальной линии выделенного пря�
моугольника. Когда AutoCAD распознает эту точку (рис. 4.61), щелкните
для захвата ее координат в качестве базовой точки копируемого объекта.

9. AutoCAD предложит выбрать базовую точку. Снова щелкните на кнопке Се�
редина (Snap to Midpoint) и выберите точку, которая находится на середи�
не нижней линии контура выбранного в п. 8 прямоугольника (рис. 4.64).
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Рис. 4.62  Копирование прямоугольника на контур фасада большой тумбы
с помощью режима привязки Середина (Midpoint)

Рис. 4.63  Копирование прямоугольника на контур фасада малой тумбы
с помощью режима привязки Середина (Midpoint)

3. AutoCAD перейдет в режим копирования выбранного прямоугольника,
о чем можно будет судить по наличию контура этого прямоугольника,
«приклеенного» к указателю�перекрестию серединой нижней границы.
Восстановите предыдущий масштаб просмотра с помощью инструмента
Зумировать предыдущий (Zoom Previous).

4. Снова включите режим привязки Середина (Midpoint) и, подведя указа�
тель�перекрестие к середине нижней горизонтальной линии прямоу�
гольника, обозначающего контур фасада большой тумбы (рис. 4.62), щел�
кните для вставки копии исходного прямоугольника в эту точку.

5. Опять включите режим привязки Середина (Midpoint) и, подведя указа�
тель�перекрестие к середине правой вертикальной линии прямоугольни�
ка, обозначающего контур фасада малой тумбы (рис. 4.63), щелкните для
вставки копии исходного прямоугольника в эту точку.

6. Нажмите Enter для завершения копирования.
7. С помощью инструмента Окно зумирования (Zoom Window) увеличьте

изображение фасада малой тумбы и запустите инструмент Повернуть
(Rotate).

8. В ответ на приглашение выбрать объекты, подлежащие повороту, щелк�
ните на контуре только что вставленной копии прямоугольника, а затем
нажмите Enter для завершения выбора.
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Рис. 4.64  Выбор базовой точки для вращения
с помощью режима привязки Середина (Midpoint) Уровень владения пользователем навыками черчения в AutoCAD можно

определить по тому, насколько оптимально он выбирает инструменты
и насколько быстро запускает их. Как уже неоднократно отмечалось ав�

тором в предыдущих главах, AutoCAD позволяет использовать различные ме�
тоды запуска инструментов. Так, в частности, инструменты Подобие (Offset),
Сопряжение (Fillet), Обрезать (Trim) и Удлинить (Extend) могут быть запу�
щены как с помощью щелчка на соответствующей кнопке панели инструментов
Изменить (Modify), так и путем выбора соответствующей команды из меню
с аналогичным названием. Кроме того, все команды можно запустить из коман�
дного окна, введя ее название или псевдоним.

Совет. Для быстрого запуска инструментов Подобие (Offset) и Сопряжение
(Fillet) достаточно ввести в командном окне  ïîä (O) или ñîï (F), соответствен�
но. Другие псевдонимы не столь коротки: так, для запуска инструмента Обре�
зать (Trim) необходимо ввести îáð (TR), а для запуска инструмента Удлинить
(Extend) –  Óäëèíèòü (EXTEND). С другой стороны, в некоторых случаях удоб�
нее (именно удобнее, а не быстрее) использовать клавиши ускоренного запуска ко�
манд меню, чем ввод псевдонимов в командном окне. Например, для создания дуги
по начальной и центральной точкам с известной градусной мерой удобнее восполь�
зоваться нажатием Alt+D, A, T для запуска команды Черчение ⇒ Дуга ⇒ Нача�
ло, центр, угол (Draw ⇒ Arc ⇒ Start, Center, Angle), чем запускать команду Äóãà
(ARC) в командном окне, а затем вводить названия соответствующих режимов
работы. Поэтому для таких команд старайтесь запоминать комбинации
Alt+клавиша. (Для выбора команды из меню достаточно нажать только клави�
шу, соответствующую подчеркнутой букве в названии команды, не нажимая при
этом Alt.)

Поэтому, по мере освоения инструментов AutoCAD, пробуйте разные мето�
ды их запуска, выбирая тот, который вам кажется оптимальным. Профессио�
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10. AutoCAD предложит задать угол поворота. Введите в командном окне 90.
Прямоугольник будет повернут в нужное положение, а выполнение ко�
манды Ïîâåðíóòü (ROTATE) завершится.

11. Восстановите предыдущий масштаб с помощью инструмента Зумиро�
вать предыдущий (Zoom Previous).

На этом создание чертежа, показанного на рис. 4.3, закончено. Сохраните
чертеж в файле Work042.dwg.

В этой главе основное внимание уделялось основным инструментам и при�
емам черчения. В результате был создан относительно простой чертеж ниж�
ней части рабочей зоны, над которым мы продолжим работу в последующих
главах.

Освоив инструменты и приемы, описанные в материале этой главы, вы уже
не должны испытывать затруднений при черчении прямых линий, прямоу�
гольников и дуг, а также при необходимости изменить масштаб просмотра чер�
тежа или его фрагмента. В следующей главе вы закрепите эти навыки, а также
познакомитесь с несколькими новыми инструментами и режимами работы
в AutoCAD, которые позволят вам повысить производительность при создании
чертежей.
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нальные пользователи AutoCAD предпочитают в большинстве случаев приме�
нять ввод псевдонимов команд в командном окне. Однако это вовсе не означает,
что вам не стоит привыкать щелкать на кнопках панели инструментов или
пользоваться меню. Самое главное состоит в том, чтобы вы выработали устойчи�
вые навыки владения инструментами AutoCAD, которые позволят вам не терять
время на их запуск, а полностью сосредоточиться на стоящей перед вами задаче.

Кроме того, в AutoCAD, как вы также уже знаете, нет правильных и непра�
вильных методов черчения. Проще говоря, один и тот же чертеж можно со�
здать с использованием разных подходов и разных инструментов. Например,
в предыдущей главе вместо создания прямоугольников с помощью инструмен�
та Прямоугольник (Rectangle) мы могли бы везде использовать инструмент
С линиями (Line). Как правило, выбор одних инструментов и приемов имеет
свои недостатки и достоинства, а выбор других – свои. Поэтому, прежде чем
приступить к работе, старайтесь изучить стоящую перед вами задачу и опреде�
лить оптимальный набор инструментов и приемов, которые позволят в конк�
ретной ситуации достичь максимальной эффективности.

В этой главе вы изучите несколько новых инструментов, а также ознакоми�
тесь с альтернативными приемами черчения, которые позволяют по�другому
решать уже знакомые вам по предыдущей главе задачи. При проработке мате�
риала этой главы мы рассмотрим, как обозначить на чертеже те элементы ниж�
ней части рабочей зоны, создание которых мы в предыдущей главе на время
отложили: порожек на нижней угловой полке, подставку под клавиатуру, деко�
ративные цилиндрические опоры малой и большой тумб, а также основную
опору. Кроме того, в этой главе мы приступим к созданию на чертеже элемен�
тов, которые обозначают не только детали рабочей зоны, но и ее оборудование
(его габариты также нужно показать на чертеже): полочек левой и правой сто�
ек под компакт�диски, дисплея, планшетного сканера и настольной лампы. Для
того чтобы размещение двух последних приборов было вам понятнее, автор
еще раз приводит общий вид рабочей зоны (рис. 5.1). Сравнив его с рис. 4.1, вы
легко заметите, что теперь на нем появились изображения сканера и лампы.
Кроме того, на рис. 5.1, в отличие от рис. 4.1, крышка парты показана в опущен�
ном положении.

5.1. Черчение в режимах «ОРТО» (ORTHO)5.1. Черчение в режимах «ОРТО» (ORTHO)5.1. Черчение в режимах «ОРТО» (ORTHO)5.1. Черчение в режимах «ОРТО» (ORTHO)5.1. Черчение в режимах «ОРТО» (ORTHO)
и «ОТС=ПОЛЯР» (POLAR)и «ОТС=ПОЛЯР» (POLAR)и «ОТС=ПОЛЯР» (POLAR)и «ОТС=ПОЛЯР» (POLAR)и «ОТС=ПОЛЯР» (POLAR)
Мы начнем работу над перечисленными выше объектами, отталкиваясь не от
размещения соответствующих элементов рабочей зоны по высоте, а от формы
и расположения их на виде сверху. Такой подход позволит нам обсудить сход�
ные инструменты и приемы черчения, а также хорошо увидеть, в чем они отли�
чаются. В частности, на рис. 5.2 приведены размеры прямолинейных элемен�
тов, которые сосредоточены в угловой части рабочей зоны: полочки стоек под
компакт�диски, порожек нижней полки и системный блок.

Полочки имеют прямоугольную форму и одинаковые размеры (120 × 130 мм).
На рис. 5.2 показаны оба размера только одной полочки, поскольку для второй
достаточно указать лишь один размер и расстояние от других элементов черте�
жа. Порожек имеет длину 425 мм и ширину 30 мм. На рис. 5.2 это не показано,
чтобы не загромождать чертеж лишними размерами, но нижняя граница кон�

Рис. 5.1  Доработанный общий вид рабочей зоны детской комнаты

Рис. 5.2  Размеры прямоугольных конструктивных элементов и оборудования,
расположенных в угловой части рабочей зоны
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тура порожка не совпадает с линией нижней угловой полки, а выступает за пос�
леднюю на 2 мм, чтобы учесть толщину порожка, имеющего в сечении Г�образ�
ный профиль. Чертеж системного блока представляет собой прямоугольник
размером 175 × 408 мм, отстоящий от стенки большой тумбы на 10 мм и от зад�
ней стенки рабочей зоны на 45 мм. Линия, обозначающая ребро лицевой грани
системного блока, сопряжена с вертикальными линиями прямоугольника с ра�
диусом 10 мм.

Как видите, в объектах, которые нам предстоит создать, нет ничего особен�
но сложного. В принципе, вы могли бы создать их и самостоятельно, не испы�
тывая больших затруднений (кроме, разве что, создания контура порожка).
Но, как вы сейчас убедитесь, даже на столь простых объектах мы можем изу�
чить новые для вас инструменты и приемы черчения.

5.1.1. Использование режима «ОРТО» (ORTHO)5.1.1. Использование режима «ОРТО» (ORTHO)5.1.1. Использование режима «ОРТО» (ORTHO)5.1.1. Использование режима «ОРТО» (ORTHO)5.1.1. Использование режима «ОРТО» (ORTHO)
и инструмента «Нормаль» (Snap to Perpendicular)и инструмента «Нормаль» (Snap to Perpendicular)и инструмента «Нормаль» (Snap to Perpendicular)и инструмента «Нормаль» (Snap to Perpendicular)и инструмента «Нормаль» (Snap to Perpendicular)
Как видно из рис. 5.2, полочки стоек компакт�дисков расположены симметрич�
но и имеют одинаковые размеры. Логично предположить, что их можно со�
здать с помощью одинаковых приемов черчения или вообще получить второй
экземпляр соответствующего объекты путем копирования или зеркального
отображения. Однако мы создадим их, во�первых, с помощью несколько раз�
личных приемов черчения, а во�вторых, будем использовать для этого режи�
мы, с которыми вы пока не сталкивались.

1. Откройте чертеж рабочей зоны (в конце предыдущей главы он был со�
хранен в файле с именем Work042.dwg) и сохраните его в новом файле
с именем Work051.dwg.

Совет. Если вы создаете новый чертеж из имеющегося, выработайте привычку
сразу же сохранять открытый файл с новым именем, чтобы случайно не запи�
сать измененный чертеж в файле с исходным именем. AutoCAD по умолчанию со�
храняет предыдущую копию файла чертежа в файле с таким же именем и расши�
рением BAK вместо DWG (например, в нашем случае – Work042.bak). Однако если
вы, забыв сохранить измененный чертеж в новом файле, несколько раз сохраните
его с прежним именем, резервная копия будет содержать только ту информацию,
которая осталась в файле после предпоследнего сохранения. Проще говоря, если
вы, открыв имеющийся чертеж, удалили из него все объекты, затем сохранили,
после чего провели линию и снова сохранили, то исходный чертеж будет содер�
жать одну линию, а резервная копия – пустой документ AutoCAD.
Поэтому здесь и далее автор будет предлагать вам сохранить файл с новым именем
сразу после его открытия (команда Ñîõðàíèòü êàê (SAVEAS)), а по окончании
работы с файлом – сохранить последние изменения (команда Ñîõðàíèòü (QSAVE)).
Аналогичные команды меню называются Файл ⇒ Сохранить как (File ⇒ Save As)
(Ctrl+Shift+S) и Файл ⇒ Сохранить (File ⇒ Save) (Ctrl+S) соответственно.

2. C помощью инструмента Окно зумирования (Zoom Window) измените
масштаб просмотра так, как это показано на рис. 5.2 (окружности, обо�

значающие на чертеже декоративные опоры малой и большой тумб, на
вашем чертеже, естественно, пока что отсутствуют).

3. Запустите инструмент С линиями (Line) и включите режим привязки
Конточка (Endpoint). Выберите точку, которая находится на пересече�
нии прямой и угловой части полки шириной 200 мм.

Совет. Для выбора режима привязки можно воспользоваться не только соответ�
ствующей кнопкой панели инструментов Объектная привязка (Object Snap), но
и контекстным меню, которое открывается при нажатии Shift и щелчке правой
кнопкой мыши в свободном месте области черчения.

4. Щелкните на кнопке�индикаторе ОРТО (ORTHO) для включения режи�
ма черчения с таким же названием. После этого переместите указатель�
перекрестие влево от первой выбранной точки и понаблюдайте за тем,
как ведет себя вычерчиваемая линия.

Примечание. В режиме ОРТО (ORTHO) все линии чертятся строго по горизон�
тали либо строго по вертикали.

5. Щелкните на кнопке  Нормаль (Snap to Perpendicular) панели инстру�
ментов Объектная привязка (Object Snap) для включения режима объ�
ектной привязки к перпендикуляру. (Можете также включить режим
привязки Нормаль (Perpendicular), выбрав соответствующий пункт из
контекстного меню, которое открывается при щелчке правой кнопкой
мыши с одновременным нажатием Shift, как описано выше.)

6. Переместите указатель�перекрестие влево так, чтобы он оказался побли�
зости вертикальной линии контура левой боковой стенки рабочей зоны.
Как только AutoCAD распознает точку падения перпендикуляра (рис. 5.3),

Рис. 5.3  Привязка второй точки горизонтальной линии к точке падения перпендикуляра
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щелкните для захвата координат этой точки, а затем нажмите Enter для
завершения команды Îòðåçîê (LINE). (Обратите внимание на то, что
режим ОРТО (ORTHO) по�прежнему останется включенным.)

7. Полученную линию мы используем в качестве вспомогательной. Как вы
помните из главы 4, полка шириной 200 мм переходит в угловую полку на
расстоянии 400 мм от задней стенки рабочей зоны (см. рис. 4.3). Таким
образом, если сместить полученную линию вниз на 50 мм, мы сможем вос�
пользоваться полученной копией для привязки к ней первой линии конту�
ра прямоугольника, который будет представлять на чертеже полочку ле�
вой стойки. Выполните такое смещение с помощью инструмента Подобие
(Offset), а затем удалите исходную линию, щелкнув на ней и нажав Delete.

8. Запустите инструмент С линиями (Line) и включите режим привязки
Конточка (Endpoint). Выберите левую оконечную точку полученной ли�
нии. Переместите указатель�перекрестие вправо, не щелкая мышью.
Поскольку режим ОРТО (ORTHO) по�прежнему остается включенным,
рядом с указателем�перекрестием будет отображаться всплывающая под�
сказка соответствующего содержания, а новая линия, длина которой бу�
дет изменяться при перемещении указателя, скроет под собой вспомога�
тельную линию.

9. Введите в командном окне 130 (как видно из рис. 5.2, это длина прямоу�
гольника, который нам нужно начертить).

10. Как только вы введете указанное в п. 9 значение, направление вычерчива�
ния линии в режиме ОРТО (ORTHO) автоматически изменится (AutoCAD
небезосновательно предполагает, что сегменты, вычерчиваемые в этом
режиме, расположены один к другому под прямым углом). При желании
это направление можно изменить, но нас оно вполне устраивает. Убедив�
шись в том, что новый сегмент линии направлен вниз, введите в команд�
ном окне 120.

11. Для завершения контура полочки нужно начертить лишь третий сег�
мент. Снова включите режим привязки Нормаль (Perpendicular) и, как
показано на рис. 5.4, завершите черчение, щелкнув на распознанной
AutoCAD точке падения перпендикуляра, а затем нажав Enter для завер�
шения команды Îòðåçîê (LINE).

12. Для придания контуру полочки окончательного вида щелкните на вспо�
могательной горизонтальной линии для ее выделения и нажмите Delete.

Как вы поняли, режим ОРТО (ORTHO) весьма удобен для вычерчивания
объектов прямоугольной формы: начертив очередной сегмент, нужно лишь
ввести длину следующего сегмента, не задумываясь об относительных и абсо�
лютных координатах, что, естественно, очень близко к тому, как мы чертим
линии на бумаге. Единственная проблема заключается в том, что первую точку
первой линии нужно к чему�то привязать. Понятно, что в реальных чертежах
в подобных ситуациях, как и в рассмотренном только что примере, для этого
придется либо создавать вспомогательные линии, либо… использовать инстру�
мент объектной привязки Смещение (Snap From).

5.1.2. Инструменты «Смещение» (Snap From)5.1.2. Инструменты «Смещение» (Snap From)5.1.2. Инструменты «Смещение» (Snap From)5.1.2. Инструменты «Смещение» (Snap From)5.1.2. Инструменты «Смещение» (Snap From)
и «Конточка» (Snap to Endpoint) в режиме «ОРТО»и «Конточка» (Snap to Endpoint) в режиме «ОРТО»и «Конточка» (Snap to Endpoint) в режиме «ОРТО»и «Конточка» (Snap to Endpoint) в режиме «ОРТО»и «Конточка» (Snap to Endpoint) в режиме «ОРТО»
(ORTHO)(ORTHO)(ORTHO)(ORTHO)(ORTHO)
Сейчас мы создадим контур второй полочки, но не станем для этого прибегать
к созданию вспомогательной линии, а воспользуемся режимом привязки Сме�
щение (Snap From).

1. Запустите инструмент С линиями (Line), а затем щелкните на кнопке 
Смещение (Snap From) панели инструментов Объектная привязка
(Object Snap) (или воспользуйтесь аналогичной командой контекстного
меню, открываемого при щелчке правой кнопкой мыши с нажатием Shift).
В командном окне после обычного приглашения команды îòðåçîê (LINE)
(Ïåðâàÿ òî÷êà: (Specify first point:)) появится команда запуска соответ�
ствующего режима привязки, автоматически введенная AutoCAD (_from),
а затем первое приглашение этой команды (Áàçîâàÿ òî÷êà: (Base point:)).
Иными словами, после включения режима Смещение (Snap From) снача�
ла нужно задать точку, которая будет использоваться в качестве базовой.
В нашем случае мы знаем расстояние от левого угла рабочей зоны до ле�
вой вертикальной линии контура вычерчиваемой полочки, которое со�
ставляет 450 мм (см. рис. 5.2). Поэтому логично выбрать в качестве базо�
вой именно верхнюю точку внутренней вертикальной границы левой
боковой стенки рабочей зоны, от которой на рис. 5.2 отсчитывается рас�
стояние до контура полочки правой стойки.

Рис. 5.4  Привязка второй точки третьего сегмента ломаной линии,
вычерчиваемой в режиме ОРТО (ORTHO), к точке падения перпендикуляра
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2. Включите режим привязки Конточка (Endpoint) и выберите в качестве
базовой точку, показанную на рис. 5.5.

чительно упрощает задачу выбора первой точки сегмента ломаной линии.
Единственный недостаток этого режима состоит в необходимости ввода отно�
сительных координат, что не так удобно, как, например, простой ввод длины
очередного сегмента в режиме ОРТО (ORTHO). Как вы, наверное, догадывае�

Рис. 5.5  Выбор базовой точки, от которой будет отсчитываться смещение
в режиме Смещение (Snap From)

3. В командном окне после команды включения режиме Конточка (End�
point), автоматически введенной AutoCAD (_endp of), появится пригла�
шение задать смещения от базовой точки (<Ïîäîáèå>: (<Offset>:)), ко�
торое является вторым приглашением режима привязки Смещение
(Snap From). Введите @450,0.

4. AutoCAD тут же продолжит выполнение команды Îòðåçîê (LINE) в ре�
жиме ОРТО (ORTHO), предлагая вам задать вторую точку первого сег�
мента ломаной линии (рис. 5.6).

5. Сместите указатель�перекрестие вниз для задания направления вычерчи�
вания, как показано на рис. 5.6, и введите в командном окне 130.

6. Переместите указатель�перекрестие вправо от начерченной линии и вве�
дите в командном окне 120.

7. Переместите указатель�перекрестие вверх и либо воспользуйтесь режи�
мом привязки Нормаль (Perpendicular), либо просто введите в команд�
ном окне 130.

8. Нажмите Enter для завершения команды Îòðåçîê (LINE). Контуры по�
лочек обоих стоек для компакт�дисков созданы (рис. 5.7).

Итак, режим привязки Смещение (Snap From) является удобным дополне�
нием к существующему набору инструментов объектной привязки, поэтому он
довольно часто будет использоваться в этой книге. В частности, при его ис�
пользовании с режимом ОРТО (ORTHO) режим Смещение (Snap From) зна�

Рис. 5.6  С помощью режима Смещение (Snap From) первая линия начинается
на заданном смещении от базовой точки без использования вспомогательных линий

Рис. 5.7  С помощью режима Смещение (Snap From) первая линия начинается
на заданном смещении от базовой точки без использования вспомогательных линий
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тесь, в AutoCAD имеется специальный инструмент, который позволяет изба�
виться и от этого недостатка. Этот инструмент называется Точка отслежива�
ния (Temporary track point).

5.1.3. Инструмент «Т5.1.3. Инструмент «Т5.1.3. Инструмент «Т5.1.3. Инструмент «Т5.1.3. Инструмент «Точка отслеживания»очка отслеживания»очка отслеживания»очка отслеживания»очка отслеживания»
(T(T(T(T(Temporary track point)emporary track point)emporary track point)emporary track point)emporary track point)
Режим Точка отслеживания (Temporary track point), или режим временного от�
слеживания точки привязки, подобен режиму Смещение (Snap From), тем, что
в нем также выбирается базовая точка и направление, в котором нужно смес�
тить указатель�перекрестие от базовой точки для начала черчения. Однако
режим Точка отслеживания (Temporary track point) обладает тем преимуще�
ством, что при его использовании можно отказаться от необходимости исполь�
зования относительных координат, которые необходимо вводить в режиме
Смещение (Snap From).

Примечание. Такой метод ввода координат, когда с помощью перемещения указа�
теля�перекрестия сначала задается направление, а затем с клавиатуры вводит�
ся расстояние (как, например, при черчении в режиме ОРТО (ORTHO)), без явно�
го указания типа координат (как декартовых, так и полярных), в AutoCAD
называется непосредственным вводом расстояния (direct distance entry).

1. Запустите инструмент С линиями (Line), а затем щелкните на кнопке 
Точка отслеживания (Temporary track point) панели инструментов Сме�
щение (Snap From) или выберите команду Точка отслеживания (Tem�
porary track point) из контекстного меню, открывающегося с нажатием
Shift.

2. Включите режим привязки Конточка (Endpoint) и переместите указа�
тель�перекрестие к правой оконечной точке верхней горизонтальной
линии контура тумбы системного блока. Как только AutoCAD распозна�
ет эту точку, щелкните для захвата ее координат в качестве точки отсле�
живания привязки (tracking point). Выбранная точка будет помечена
небольшим крестиком, а на линии указателя�перекрестия появится
символ «×».

3. Переместите указатель влево по горизонтали так, задавая направление
смещения. Появится изображение пунктирной линии и всплывающая
подсказка (рис. 5.8).

4. Добившись появления пунктирной линии, введите в командном окне 10
(как видно из рис. 5.2, контур системного блока отстоит от контура боль�
шой тумбы на 10 мм).

5. Как вы помните из главы 2, расстояние между тумбой системного блока и
задней стенкой рабочей зоны составляет 100 мм (см. рис. 4.3), а между
системным блоком и задней стенкой – 45 мм (см. рис. 5.2). Поэтому пере�
местите указатель�перекрестие вверх от полученной точки (рис. 5.9)
и введите 55 (100 – 45 = 55 мм).

6. Дальнейшие операции создания контура системного блока, благодаря
режиму ОРТО (ORTHO), тривиальны: переместите указатель�перекрес�
тие влево и введите 175, затем переместите указатель�перекрестие вниз

Рис. 5.8  В режиме Точка отслеживания (Temporary track point)
AutoCAD отслеживает направление смещения и расстояние

от заданной точки отслеживания привязки

Рис. 5.9  Начало вычерчивания контура системного блока от точки,
полученной с помощью режима Точка отслеживания (Temporary track point)
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и введите 480, после чего переместите указатель�перекрестие вправо и
введите 175, и, наконец, введите Çàìêíóòü (CLOSE) или просто ç (C)
для получения замкнутого прямоугольного контура. Выполнение коман�
ды Îòðåçîê (LINE) на этом завершится.

7. Воспользуйтесь инструментом Сопряжение (Fillet) для сопряжения
нижней горизонтальной и вертикальных линий с радиусом 10 мм. Снача�
ла измените радиус, введя в ответ на приглашение AutoCAD Ðàäèóñ
(RADIUS) и соответствующее значение. Затем выполните сопряжение
нижней горизонтальной линии сначала с одной, а затем, после повтор�
ного запуска команды Ñîïðÿæåíèå (Fillet), – с другой вертикальной ли�
нией. Завершенный контур системного блока должен выглядеть так, как
показано на рис. 5.10.

5.1.4. Использование режима «ОТС=ПОЛЯР» (POLAR)5.1.4. Использование режима «ОТС=ПОЛЯР» (POLAR)5.1.4. Использование режима «ОТС=ПОЛЯР» (POLAR)5.1.4. Использование режима «ОТС=ПОЛЯР» (POLAR)5.1.4. Использование режима «ОТС=ПОЛЯР» (POLAR)
Режим ОТС�ПОЛЯР (POLAR), как и режим ОРТО (ORTHO) можно включить
или выключить с помощью кнопки�индикатора, находящейся в строке состояния.
Следует заметить, что режимы ОТС�ПОЛЯР (POLAR) и ОРТО (ORTHO) являют�
ся взаимоисключающими. Проще говоря, включив режим ОРТО (ORTHO), вы
тем самым автоматически выключаете режим ОТС�ПОЛЯР (POLAR) (если после�
дний, конечно был включен), и наоборот. Однако, прежде, чем приступить к ис�
пользованию режима ОТС�ПОЛЯР (POLAR) для создания контура порожка, нам
нужно будет выполнить некоторую настройку его параметров.

1. Щелкните на кнопке�индикаторе ОТС�ПОЛЯР (POLAR) для включения
режима ОТС�ПОЛЯР (POLAR). Кнопка ОТС�ПОЛЯР (POLAR) должна
принять вид, соответствующий нажатому состоянию, а кнопка ОРТО
(ORTHO) автоматически примет вид, соответствующий отжатому со�
стоянию.

2. Щелкните на кнопке�индикаторе ОТС�ПОЛЯР (POLAR) правой кнопкой
мыши и выберите из открывшегося небольшого контекстного меню ко�
манду Настройка (Settings). (Можно также ввести в командном окне ко�
манду Ðåæèìðèñ (DSETTINGS).)

3. В появившемся окне Режимы рисования (Drafting Settings) перейдите,
если нужно, на вкладку Отслеживание (Polar Tracking), раскройте
в группе Полярные углы (Polar Angle Settings) список Шаг углов (Incre�
ment angle) и выберите из него значение 45, как показано на рис. 5.11.

Рис. 5.10  Законченный контур системного блока после сопряжения линий,
образующих нижние углы

Итак, вы убедились в том, что режим Точка отслеживания (Temporary track
point)  – это очень мощное и гибкое средство, объединяющее в себе достоин�
ства режимов Смещение (Snap From) и ОРТО (ORTHO), причем использова�
ние режима Точка отслеживания (Temporary track point) не ограничивается
вычерчиванием одних лишь вертикальных и горизонтальных линий, в чем вы
убедитесь в последующих упражнениях этой главы.

Мы же пока займемся вычерчиванием контура порожка, представляющего
собой прямоугольник, развернутый на 45° и смещенный от линии угловой ниж�
ней полки на 2 мм (на рис. 5.2 это смещение не показано). Для этого вы позна�
комитесь с новым режимом, который напоминает режим ОРТО (ORTHO), но
применительно к объектам, расположенным под углом.

Рис. 5.11  Вкладка Отслеживание (Polar Tracking)
диалогового окна Режимы рисования (Drafting Settings)
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Щелкните на кнопке OK для закрытия окна Режимы рисования (Draf�
ting Settings).

4. Запустите инструмент С линиями (Line), включите режим привязки Кон�
точка (Endpoint) и выберите точку, которая находится на диагональном
отрезке контура нижней полки ближе к контуру тумбы системного блока.

5. Переместите указатель�перекрестие от первой точки влево и вверх при�
мерно под углом 45°. Если вы правильно зададите направление, AutoCAD
распознает его, о чем можно будет судить по появлению пунктирной ли�
нии и всплывающей подсказке режима ОТС�ПОЛЯР (POLAR), как пока�
зано на рис. 5.12.

10. Введите Çàìêíóòü (CLOSE) или ç (C) для автоматического завершения
контура порожка.

11. Убедитесь с помощью инструмента Окно зумирования (Zoom Window)
в том, что контур порожка создан правильно и выступает за контур ниж�
ней полки на 2 мм (рис. 5.14).

Рис. 5.12  AutoCAD в режиме ОТС?ПОЛЯР (POLAR)
распознал направление под углом 45°

6. Получив изображение, представленное на рис. 5.12, введите в команд�
ном окне значение 28 (30 – 2 = 28 мм).

7. AutoCAD создаст первый сегмент ломаной линии, расположенный под
углом 45° длиной 28 мм. Переместите указатель�перекрестие влево и
вниз от второй точки полученного сегмента также примерно под углом
45°. Добившись изображения, представленного на рис. 5.13, введите
в командном окне 425 (см. рис. 5.2).

8. AutoCAD создаст второй сегмент ломаной линии длиной 425 мм. Переме�
стите указатель�перекрестие право и вниз от второй точки полученного
сегмента примерно под углом 45°. Как только AutoCAD распознает нуж�
ное вам направление, введите в командном окне 30.

9. Создайте сегмент, параллельный второму сегменту также длиной 425 мм,
но направленный вправо и вверх углом 45°.

Рис. 5.13  AutoCAD в режиме ОТС?ПОЛЯР (POLAR)
распознал направление второго сегмента под углом 90° к первому

Рис. 5.14  Контур порожка смещен относительно контура полки на 2 мм
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12. Восстановите прежний масштаб просмотра с помощью инструмента Зу�
мировать предыдущий (Zoom Previous).

Итак, можно сказать, что режим ОТС�ПОЛЯР (POLAR) – это что�то вроде
режима ОРТО (ORTHO), но для черчения объектов, расположенных под уг�
лом. С технической точки зрения, скорее режим ОРТО (ORTHO) является ча�
стным случаем режима ОТС�ПОЛЯР (POLAR) (можете убедиться в этом сами,
попробовав начертить, например, контур системного блока с помощью режи�
ма ОТС�ПОЛЯР (POLAR), а не ОРТО (ORTHO)). Отличаются они тем, что
режим ОРТО (ORTHO) нельзя перенастроить, тогда как углы, автоматически
определяемые в режиме ОТС�ПОЛЯР (POLAR), в общем случае, могут не со�
впадать с вертикальным и горизонтальным направлением. Подробнее о режи�
ме ОТС�ПОЛЯР (POLAR) мы поговорим в последующих главах.

5.2. Создание окружностей и дуг5.2. Создание окружностей и дуг5.2. Создание окружностей и дуг5.2. Создание окружностей и дуг5.2. Создание окружностей и дуг
с помощью инструмента «Круг» (Circle)с помощью инструмента «Круг» (Circle)с помощью инструмента «Круг» (Circle)с помощью инструмента «Круг» (Circle)с помощью инструмента «Круг» (Circle)
Теперь вам предстоит создать на чертеже изображение дисплея. Как видно из
рис. 5.1 и 5.15 (некоторые элементы чертежа на рис. 5.15 не показаны), на виде
сверху чертеж дисплея представляет из себя две дуги и три прямоугольника,
развернутых относительно горизонтали на 45° (один из них, обозначающий
углубление до поверхности экрана в корпусе дисплея, слишком мал, чтобы обо�
значить его на рис. 5.15).

Если провести соответствующие вычисления, то две нужные дуги можно
построить, используя уже знакомый вам инструмент Дуга (Arc). Однако в дан�

ном случае гораздо проще воспользоваться инструментом создания окружнос�
тей Круг (Circle), а затем полученную окружность преобразовать в дуги. Вто�
рая проблема состоит в том, что вычерчивать контуры дисплея под углом в 45°
не очень удобно. Можно, конечно, воспользоваться режимом ОТС�ПОЛЯР
(POLAR), однако на практике бывает гораздо проще начертить объект в гори�
зонтальном или вертикальном положении, а затем развернуть его на нужный
угол. Именно такой метод мы и будем использовать, поскольку он является уни�
версальным (далеко не всегда объекты будут повернуты на угол 45°). Наконец,
третья задача, которую нам предстоит решить для создания чертежа дисплея,
заключается в том, что нам не к чему привязаться – на чертеже нет ни одной
опорной точки, которую мы могли бы использовать для привязки без предва�
рительных подготовительных операций. Поэтому мы начертим дисплей в про�
извольной точке чертежа, а затем переместим его на нужно место и повернем
на заданный угол. Именно так вы и будете часто поступать при черчении
в AutoCAD в подобных ситуациях.

1. После выполнения последнего упражнения остался включенным режим
ОТС�ПОЛЯР (POLAR). Щелкните на кнопке�индикаторе ОРТО (ORTHO)
в строке состояния, чтобы выключить режим ОТС�ПОЛЯР (POLAR)
и включить режим ОРТО (ORTHO).

2. Выберите из меню команду Чер�
чение ⇒ Круг (Draw ⇒ Circle).
В открывшемся меню (рис. 5.16)
представлены шесть команд, соот�
ветствующих различным режимам
применения инструмента Круг (Circ�
le) для построения окружностей.
Первые два режима позволяют пост�
роить окружность по заданному цен�
тру и радиусу или диаметру. Следую�
щие два – по двум или трем точкам.
И, наконец, последние два режима
основаны на использовании при по�
строении окружности касательных
и значения радиуса или только каса�
тельных.

Примечание. Подобно инструменту Дуга
(Arc), инструмент Круг (Circle) удобнее
всего запускать именно из меню Черчение
(Draw). Однако вы, конечно, можете ис�

Рис. 5.15  Основные размеры дисплея

Рис. 5.16  Подменю Черчение ⇒ Круг
(Draw ⇒ Circle) содержит 6 команд,

соответствующих различным режимам
использования команды êðóã (CIRCLE)

Создание окружностей и дуг с помощью инструмента «Круг»Создание окружностей и дуг с помощью инструмента «Круг»Создание окружностей и дуг с помощью инструмента «Круг»Создание окружностей и дуг с помощью инструмента «Круг»Создание окружностей и дуг с помощью инструмента «Круг»



УУУУУсложненные инструменты и приемы черчениясложненные инструменты и приемы черчениясложненные инструменты и приемы черчениясложненные инструменты и приемы черчениясложненные инструменты и приемы черчения144 145

пользовать для этого кнопку  Круг (Circle) панели инструментов Черчение
(Draw) или ввод команды êðóã (CIRCLE) либо ее псевдонима ê (C) в командном
окне.

3. Поскольку нам известен радиус окружности (126 мм, см. рис. 15.5), выбе�
рите из меню Черчение (Draw) команду Черчение ⇒ Круг ⇒ Центр,
радиус (Draw ⇒ Circle ⇒ Center, Radius). AutoCAD предложит в команд�
ном окне задать координаты центра окружности. Поскольку, как было
сказано выше, мы пока не можем привязаться к нужной нам точке, выбе�
рите произвольную точку на чертеже (например, включите режим при�
вязки Конточка (Endpoint) и выберите точку пересечения угловой и
прямолинейной частей полки шириной 200 мм).

4. После задания координат центра окружности AutoCAD будет переме�
щать вместе с указателем�перекрестием контур будущей окружности.
Введите в командном окне значение 126. AutoCAD создаст окружность
заданного радиуса, после чего команда êðóã (CIRCLE) автоматически за�
вершится.

5.2.1. Использование инструмента «Прямоугольник»5.2.1. Использование инструмента «Прямоугольник»5.2.1. Использование инструмента «Прямоугольник»5.2.1. Использование инструмента «Прямоугольник»5.2.1. Использование инструмента «Прямоугольник»
(Rectangle) с режимами привязки «Т(Rectangle) с режимами привязки «Т(Rectangle) с режимами привязки «Т(Rectangle) с режимами привязки «Т(Rectangle) с режимами привязки «Точка отслеживания»очка отслеживания»очка отслеживания»очка отслеживания»очка отслеживания»
(T(T(T(T(Temporary track point) и «Центр» (Center)emporary track point) и «Центр» (Center)emporary track point) и «Центр» (Center)emporary track point) и «Центр» (Center)emporary track point) и «Центр» (Center)
Теперь вам нужно начертить два прямоугольника, представляющих корпус дис�
плея и узел его крепления к основанию. Для этого мы воспользуемся инстру�
ментом Прямоугольник (Rectangle) и уже знакомым вам режимом привязки
Точка отслеживания (Temporary track point), а также новым режимом привяз�
ки Центр (Center).

1. Отключите режим ОРТО (ORTHO), щелкнув на соответствующей кноп�
ке�индикаторе в строке состояния.

2. Запустите инструмент Прямоугольник (Rectangle). В ответ на приглаше�
ние AutoCAD задать координаты первой точки щелкните на кнопке Точка
отслеживания (Temporary track point), а затем – на кнопке  Центр (Snap
to Center) панели инструментов Объектная привязка (Object Snap).

3. Переместите указатель�перекрестие в центр окружности и, когда AutoCAD
распознает его, о чем вы узнаете по появлению маркера объектной привяз�
ки в виде небольшой окружности с центром, совпадающим с центром выб�
ранной окружности, щелкните для захвата этой точки в качестве базовой.

4. Переместите указатель�перекрестие вверх. Как только AutoCAD распоз�
нает направление (рис. 5.17), введите в командном окне 20, поскольку
прямоугольник, представляющий корпус дисплея, находится над цент�
ром окружности выше на 20 мм (см. рис. 5.15).

5. AutoCAD предложит ввести координаты второй точки. Введите в команд�
ном окне @370,30 (см. рис. 5.15). На чертеже появится прямоугольник,
а команда Ïðÿìîóãîëüíèê (RECTANG) автоматически завершится.

6. Нажмите Enter для повторного запуска команды Ïðÿìîóãîëüíèê (REC�
TANG), но в этот раз запустите режим привязки Середина (Midpoint).

7. Переместите указатель�перекрестие к середине верхней линии только
что созданного прямоугольника и, как только AutoCAD распознает сред�
нюю точку отрезка (рис. 5.18), щелкните для захвата ее координат.

Рис. 5.17  Задание направления в режиме Точка отслеживания (Temporary track point)
с привязкой базовой точки к центру окружности

Рис. 5.18  Выбор первой точки с использованием режима привязки Середина (Midpoint)
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8. В ответ на приглашение задать координаты второй точки введите
@140,25 (см. рис. 5.15). Второй прямоугольник будет начерчен, а выпол�
нение команды Ïðÿìîóãîëüíèê (RECTANG) снова автоматически завер�
шится.

9. Повторите пп. 6�8, но в этот раз выберите в режиме привязки Середина
(Midpoint) середину нижней линии первого прямоугольника, а в ответ на
предложение задать координаты второй точки введите @350,2.5. Со�
зданный прямоугольник не показан на рис. 5.15 из�за своей малой толщи�
ны, но он нам понадобиться в последствии, поскольку он представляет
на чертеже экран дисплея.

5.2.2. Использование инструмента «Переместить»5.2.2. Использование инструмента «Переместить»5.2.2. Использование инструмента «Переместить»5.2.2. Использование инструмента «Переместить»5.2.2. Использование инструмента «Переместить»
(Move) и режима привязки «Середина» (Midpoint)(Move) и режима привязки «Середина» (Midpoint)(Move) и режима привязки «Середина» (Midpoint)(Move) и режима привязки «Середина» (Midpoint)(Move) и режима привязки «Середина» (Midpoint)
Понятно, что два последних полученных прямоугольника нужно выровнять
посредине первого прямоугольника, а затем все три объекта переместить по
горизонтали так, чтобы они выровнялись по центру окружности. Для этого
нам понадобиться новый инструмент Переместить (Move).

1. Охватите рамкой масштабирования все три прямоугольника так, как по�
казано на рис. 5.19.

2. После увеличения изображения щелкните на кнопке  Переместить
(Move) панели инструментов Изменить (Modify) или выберите из меню
команду Изменить ⇒ Перенести (Modify ⇒ Move) либо введите в коман�
дном окне команду Ïåðåíåñòè (MOVE) или просто ï (M).

3. В командном окне появится приглашение выбрать объекты, подлежащие
перемещению. Щелкните на прямоугольнике, созданном последним,
а затем нажмите Enter для завершения выбора.

4. AutoCAD предложит в командном окне выбрать базовую точку. Включите
режим привязки Середина (Midpoint) и выберите точку, которая нахо�
дится посредине нижней линии контура выделенного прямоугольника
(рис. 5.20).

Рис. 5.19  Использование инструмента Окно зумирования (Zoom Window)
для изменения масштаба просмотра

Рис. 5.20  Задание базовой точки
с использованием режима Середина (Midpoint)

5. Для задания расстояния смещения снова воспользуйтесь режимом Сере�
дина (Midpoint) и выберите середину нижней линии большого прямоу�
гольника. (Можно также использовать режим привязки Конточка (End�
point) и выбрать левую оконечную точку нижней линии выделенного
прямоугольника.)

6. Нажмите Enter для повторного запуска команды Ïåðåíåñòè (Move) и по�
вторите пп. 3–5, но уже для верхнего прямоугольника.

7. Восстановите предыдущий масштаб просмотра с помощью инструмента
Зумировать предыдущий (Zoom Previous).

5.2.3. Использование рамки выделения5.2.3. Использование рамки выделения5.2.3. Использование рамки выделения5.2.3. Использование рамки выделения5.2.3. Использование рамки выделения
Теперь все три прямоугольника выровнены по серединам и вам осталось лишь
выровнять их по горизонтали относительно центра окружности. Для этого мы
также будем использовать инструмент Переместить (Move), однако сначала
выделим объекты, подлежащие перемещению.
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Примечание. Некоторые инструменты AutoCAD игнорируют наличие выделен�
ных объектов в момент их запуска, предлагая снова выделить объекты, над кото�
рыми нужно выполнить соответствующие операции. Другие же инструменты,
наоборот, требуют, чтобы перед запуском пользователь сначала выделил объек�
ты и при отсутствии такого выделения не запускаются. Инструмент Перемес�
тить (Move) относится к разряду «всеядных» инструментов AutoCAD: при его
использовании вы можете выделять объекты как заранее, так и непосредственно
после запуска инструмента.

В предыдущей главе вы познакомились, как выделять объекты с помощью
пересекающей рамки. Как вы помните, эта рамка появляется, когда после щел�
чка в произвольной свободной точке чертежа перемещать мышь влево от точ�
ки первого щелчка. Рамка обозначается в AutoCAD штриховой линией, а охва�
ченное ею пространство окрашивается светло�зеленым цветом.

Теперь давайте познакомимся с еще одним видом рамки, которая называет�
ся просто рамкой выделения (selecting window). Щелкните правее и выше всех
трех прямоугольников, а затем переместите мышь вправо и вниз от точки пер�
вого щелчка. Вы увидите на экране картину, подобную показанной на рис. 5.21.

(Modify ⇒ Move) либо введите в командном окне команду Ïåðåíåñòè
(MOVE) или просто ï (M).

2. Поскольку объекты были выделены заранее, команда Ïåðåíåñòè (MOVE)
сообщит вам в командном окне, сколько объектов было распознано,
и сразу же предложит задать базовую точку. Включите режим привязки
Середина (Midpoint) и выберите в качестве базовой точку, которая нахо�
дится на середине верхней линии самого большого прямоугольника (если
попытаться выбрать середину нижней линии, легко ошибиться и выб�
рать середину верхней линии тонкого прямоугольника, в результате чего
все три объекта будут перемещены не только по горизонтали, но и по
вертикали).

3. AutoCAD в командном окне предложит задать расстояние перемещения.
Включите режим привязки Конточка (Endpoint) и выберите левую точ�
ку верхней линии самого большого прямоугольника, как показано на
рис. 5.22. Объекты будут перемещены на нужное место, а команда Ïåðå-
íåñòè (MOVE) завершит работу.

Совет. Щелкните в произвольном месте чертежа, незанятом объектами, и попе�
ремещайте мышь влево и вправо от точки щелчка. Вы увидите, что при переме�
щении мыши вправо AutoCAD отображает рамку выделения, а при перемещении
ее влево – пересекающую рамку. Основное отличие между этими двумя режимам
выделения заключается в том, что, при использовании рамки выделения после
второго щелчка будут выделены все объекты, которые были полностью охвачены
рамкой выделения. В случае же применения пересекающей рамки будут выделены
все объекты, которые попали под пересекающую рамку хотя бы в одной точке.

Рис. 5.21  Выбор объектов с помощью рамки выделения

Охватив все подлежащие объекты рамкой выделения, щелкните еще раз.
Рамка исчезнет, на экране снова появится указатель�перекрестие, а вокруг всех
выделенных объектов появятся маленькие квадратики, называемые маркера�
ми выделения (вы уже видели их не раз, когда щелкали на вспомогательных
объектах перед их удалением). Теперь можно запустить инструмент Перемес�
тить (Move).

1. Щелкните на кнопке Переместить (Move) панели инструментов Изме�
нить (Modify) или выберите из меню команду Изменить ⇒ Перенести

Рис. 5.22  Выбор точки для перемещения трех объектов
с использованием режима привязки Конточка (Endpoint)
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В только что рассмотренном выше примере вы могли использовать как рамку
выделения, так и пересекающую рамку. Однако на практике нередко возникают
ситуации, когда удобнее использовать какой�то один из этих двух режимов вы�
деления.

5.2.4. Использование инструмента «Переместить»5.2.4. Использование инструмента «Переместить»5.2.4. Использование инструмента «Переместить»5.2.4. Использование инструмента «Переместить»5.2.4. Использование инструмента «Переместить»
(Move) и режима привязки «Квадрант» (Quadrant)(Move) и режима привязки «Квадрант» (Quadrant)(Move) и режима привязки «Квадрант» (Quadrant)(Move) и режима привязки «Квадрант» (Quadrant)(Move) и режима привязки «Квадрант» (Quadrant)
Нам осталось лишь переместить чертеж дисплея в точку, соответствующую
рис. 5.15, развернуть его на нужный угол и преобразовать окружность в две
дуги. Труднее всего решить первую задачу, но мы пойдем по пути наименьшего
сопротивления, не прибегая к сложным расчетам.

1. Руководствуясь рис. 5.15, сместите левую вертикальную линию контура
левой боковой стенки рабочей зоны вправо на 400 мм, а нижнюю гори�
зонтальную линию контура задней стенки рабочей зоны – вниз на 256 мм.

2. Используя пересекающую рамку, например, как показано на рис. 5.23, вы�
делите все четыре объекта (будьте внимательны, чтобы не задеть пересе�
кающей рамкой других объектов и при этом не пропустить ни одного из
четырех нужных вам объекта). Применение рамки выделения в данной
ситуации менее удобно, поскольку из�за большого диметра окружности
в нее попадет верхний сегмент прямоугольника, представляющего на
чертеже полочку левой стойки для компакт�дисков.

Совет. Для исключения объекта, случайного попавшего в набор выделенных объек�
тов, достаточно нажать Shift и щелкнуть на нем мышь. Для включения в набор

выделенных объектов того объекта, который случайно не был выделен, достаточ�
но щелкнуть на нем мышью.

3. Запустите инструмент Переместить (Move) любым из способов (напри�
мер, введите ï (M) в командном окне).

4. Щелкните на кнопке Квадрант (Snap to Quadrant) панели инструментов
Объектная привязка (Object Snap) или, если вы предпочитаете исполь�
зовать контекстное меню, открываемое с нажатием Shift, выберите из
этого меню команду Квадрант (Quadrant). Режим привязки Квадрант
(Quadrant) позволяет использовать в качестве опорных четыре точки,
расположенных в верхней, нижней, левой и правой точках окружности.
В данном случае нас интересует точка, обозначающая верхний квадрант.

5. Переместите указатель�перекрестие к верхней точке окружности и, ког�
да AutoCAD распознает верхний квадрант (рис. 5.24), щелкните для за�
хвата координат этой точки в качестве координат базовой точки.

Рис. 5.23  Выбор объектов, подлежащих перемещению,
с помощью пересекающей рамки

Рис. 5.24  Выбор верхней точки окружности
с помощью режима привязки Квадрант (Quadrant)

6. Включите режим привязки Пересечение (Intersection) (с помощью кноп�
ки Пересечение (Snap to Intersection) панели инструментов Объектная
привязка (Object Snap) или контекстного меню) и переместите указа�
тель�перекрестие к точке пересечения двух вспомогательных линий, со�
зданных в п. 1.

7. Когда AutoCAD распознает эту точку пересечения (рис. 5.25), щелкните
для задания расстояния перемещения. Чертеж дисплея займет свое
место, а выполнение команды Перенести (Move) автоматически завер�
шится.
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Рис. 5.26  Первый фрагмент удален,
выбор второго фрагмента

8. Для удаления вспомогательных линий последовательно щелкните на
них, а затем нажмите клавишу Delete. (В данном случае этот метод выде�
ления объектов будет самым быстрым и удобным.)

5.2.5. Разворот выделенных объектов5.2.5. Разворот выделенных объектов5.2.5. Разворот выделенных объектов5.2.5. Разворот выделенных объектов5.2.5. Разворот выделенных объектов
и преобразование окружности в две дугии преобразование окружности в две дугии преобразование окружности в две дугии преобразование окружности в две дугии преобразование окружности в две дуги
Для завершения работы над чертежом дисплея выполните следующие операции.

1. Выделите все четыре объекта, образующих чертеж дисплея, с помощью
рамки выделения или пересекающей рамки.

2. Запустите инструмент Повернуть (Rotate) самым удобным для вас спосо�
бом (например, введите ïîâ (RO) в командном окне).

3. Поскольку все подлежащие повороту объекты были заранее выделены,
команда Ïîâåðíóòü (ROTATE) сразу же предложит вам выбрать базовую
точку. Включите режим привязки Центр (Center) и, добившись появле�
ния соответствующего маркера объектной привязки в центре окружнос�
ти, щелкните для захвата координат этой точки.

Совет. Если указатель�перекрестие слишком быстро переместить в центр ок�
ружности, AutoCAD может не успеть ее распознать. В таком случае верните ука�
затель�перекрестие к линии самой окружности и задержите его на ней на 1–2 с
и режим привязки Центр (Center) тут же включится. То же самое относится
и к выбору квадрантов в режиме привязки Квадрант (Quadrant).

4. В ответ на приглашение AutoCAD введите в командном окне 45. Объекты
будут развернуты на заданный угол, а выполнение команды Ïîâåðíóòü
(ROTATE) автоматически завершится.

5. Для окончательного формирования чертежа дисплея запустите инстру�
мент Обрезать (Trim) и в ответ на предложение выбрать секущие ребра
щелкните на контуре самого большого прямоугольника, а затем нажмите
Enter для завершения выбора.

6. Щелкните на контуре окружности в тех местах, которые приходятся
на внутреннюю область большого прямоугольника, как показано на
рис. 5.26.

Рис. 5.25  Выбор точки пересечения с помощью режима привязки Пересечение
(Intersection)

7. Удалив оба фрагмента окружности, находившихся внутри прямоугольни�
ка, нажмите Enter для завершения команды Îáðåçàòü (TRIM).

8. Восстановите исходный масштаб с помощью инструмента Зумировать
предыдущий (Zoom Previous).

На этом задачу черчения дисплея можно считать выполненной. Если вы
прислушались к совету автора и сразу же переименовали файл, открытый в на�
чале этой главы, в файл Work051.dwg, тогда, воспользовавшись командой Файл ⇒
Сохранить (File ⇒ Save) или нажатием Ctrl+S, сохраните текущее состояние
чертежа. В противном случае сохраните чертеж (если вы его не переименовали
в самом начале, файл должен называться Work042.dwg) в файле Work051.dwg,
воспользовавшись командой Файл ⇒ Сохранить как (File ⇒ Save As) или нажа�
тием Ctrl+Shift+S.

Примечание. Возможно, вас удивляет тот факт, что мы миримся с «прозрачны�
ми» стенками тумб, но почему�то избавляемся от «прозрачности» корпуса дисп�
лея. Наберитесь терпения – буквально в следующей главе мы наведем порядок
и в этом вопросе.
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5.3. Модификация свойств объектов5.3. Модификация свойств объектов5.3. Модификация свойств объектов5.3. Модификация свойств объектов5.3. Модификация свойств объектов
На следующем этапе разработки чертежа нижней части рабочей зоны мы зай�
мемся созданием чертежей декоративных цилиндрических опор, находящих�
ся на большой и малой тумбе, а также основной опоры (см. рис. 4.1, 4.2, 5.1 и
5.2). На рис. 5.27 приведены размеры опор, а также расстояния между их цент�
рами и характерными точками чертежа (ряд элементов, как и на рис. 5.15, не
показаны, чтобы не загромождать чертеж).

радиусами. Что ж, давайте так и поступим, чтобы получить чертежи опор ма�
лой тумбы.

1. С помощью инструмента Окно зумирования (Zoom Window) охватите
рамкой масштабирования фрагмент чертежа, показанный на рис. 5.28.

Рис. 5.27  Размеры опор большой и малой тумб
и размещение опор на чертеже

5.3.1. Использование инструмента «Круг» (Circle)5.3.1. Использование инструмента «Круг» (Circle)5.3.1. Использование инструмента «Круг» (Circle)5.3.1. Использование инструмента «Круг» (Circle)5.3.1. Использование инструмента «Круг» (Circle)
с режимами привязки «Тс режимами привязки «Тс режимами привязки «Тс режимами привязки «Тс режимами привязки «Точка отслеживания»очка отслеживания»очка отслеживания»очка отслеживания»очка отслеживания»
(T(T(T(T(Temporary track point), «Пересечение» (Intersection)emporary track point), «Пересечение» (Intersection)emporary track point), «Пересечение» (Intersection)emporary track point), «Пересечение» (Intersection)emporary track point), «Пересечение» (Intersection)
и «Круг» (Circle)и «Круг» (Circle)и «Круг» (Circle)и «Круг» (Circle)и «Круг» (Circle)
Как видно на рис. 5.27, чертеж каждой опоры представляет собой три концент�
рические окружности радиусом 25, 27 и 35 мм, соответственно. Их создание не
должно вызвать у вас затруднений, однако с позиционированием соответст�
вующих объектов на чертеже все не так просто. Первое, что приходит в голову, –
это применение инструмента Подобие (Offset) для получения вспомогатель�
ных линий на нужных расстояниях в соответствии с рис. 5.27 с последующим
созданием с помощью режимов привязки Пересечение (Intersection) и Центр
(Center) в точках пересечения этих линий окружностей с соответствующими

Рис. 5.28  Увеличение изображения фрагмента чертежа
в области малой тумбы

2. После изменения масштаба для выделенного фрагмента, воспользуйтесь
инструментом Подобие (Offset) для смещения внутрь контура тумбы на
60 мм вертикальной линии, которая обозначает прямолинейный участок
нижней угловой полки шириной 400 мм (рис. 5.29). Казалось бы, нам нуж�
но создать еще две вспомогательные линии (одну вертикальную и одну

Рис. 5.29  Для создания чертежей обоих опор
достаточно всего одной вспомогательной линии
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горизонтальную, в соответствии с рис. 5.27). Однако, если хорошо поду�
мать, можно придти к выводу, что одной линии в данном случае вполне
достаточно, в чем вы сейчас убедитесь.

3. Запустите инструмент Круг (Circle), выбрав из меню команду Черчение ⇒
Круг ⇒ Центр, радиус (Draw ⇒ Circle ⇒ Center, Radius).

Примечание. Поскольку при запуске с помощью панели инструментов или из ко�
мандного окна инструмент Круг (Circle) по умолчанию использует именно режим
создания окружности по центральной точке и радиусу (Центр, радиус (Center,
Radius)), можете также щелкнуть на кнопке Круг (Circle) панели инструментов
Черчение (Draw) либо ввести в командном окне Êðóã (CIRCLE) или просто ê (C).

4. В ответ на приглашение AutoCAD задать координаты центральной точки
включите режим привязки Точка отслеживания (Temporary track point),
а затем – режим привязки Пересечение (Intersection).

5. Переместите указатель мыши в точку пересечения вспомогательной
линии с верхней линией контура правой боковой стенки малой тумбы
(рис. 5.30) и, как только AutoCAD распознает эту точку, щелкните для ее
захвата в качестве базовой.

7. AutoCAD создаст в точке, которая находится ниже базовой точки пересе�
чения на 60 мм, динамически изменяемую окружность и предложит за�
дать ее радиус. Введите в командном окне 35 (см. рис. 5.27).

8. Выполнение команды Êðóã (CIRCLE) завершится. Щелкните на вспомо�
гательной линии для ее выделения, а затем нажмите Delete, чтобы уда�
лить ее, поскольку она нам больше не понадобится.

9. Снова запустите инструмент Круг (Circle) и, используя режим привязки
Центр (Center), создайте в центре имеющейся окружности еще одну окруж�
ность с радиусом 27 мм.

10. Нажмите Enter для повторного запуска команды Êðóã (CIRCLE) и, снова
используя режим привязки Центр (Center), создайте в центре первых
двух окружностей третью окружность с радиусом 25 мм.

Итак, чертеж первой опоры получен. Казалось бы, нужно повторить опера�
ции предыдущего этапа, создав еще одну вспомогательную линию. Однако если
внимательно посмотреть на чертеж, представленный на рис. 5.27, станет ясно,
что опоры расположены симметрично относительно прямоугольника, пред�
ставляющего контур правой боковой стенки малой тумбы. Давайте воспользу�
емся этим обстоятельством.

5.3.2. Создание копии объекта с помощью5.3.2. Создание копии объекта с помощью5.3.2. Создание копии объекта с помощью5.3.2. Создание копии объекта с помощью5.3.2. Создание копии объекта с помощью
инструмента «Зеркальное отражение» (Mirror)инструмента «Зеркальное отражение» (Mirror)инструмента «Зеркальное отражение» (Mirror)инструмента «Зеркальное отражение» (Mirror)инструмента «Зеркальное отражение» (Mirror)
и режима привязки «Середина» (Midpoint)и режима привязки «Середина» (Midpoint)и режима привязки «Середина» (Midpoint)и режима привязки «Середина» (Midpoint)и режима привязки «Середина» (Midpoint)
Да, конечно же – в данном случае проще всего получить нужный результат, при�
менив зеркальное отображение имеющегося объекта относительно вертикаль�
ной оси симметрии другого объекта.

1. С помощью рамки выделения или пересекающей рамки выделите все три
окружности, а затем запустите инструмент Зеркальное отражение (Mir�
ror) (например, щелкнув на кнопке Зеркальное отражение (Mirror) па�
нели инструментов Изменить (Modify)).

2. Поскольку объекты были выделены заранее, команда Çåðêàëî (MIRROR)
предложит выбрать первую точку оси зеркального отображения. Вклю�
чите режим привязки Середина (Midpoint) и выберите среднюю точку
верхней линии прямоугольника, который обозначает правую боковую
стенку малой тумбы, как показано на рис. 5.31.

3. AutoCAD предложит выбрать вторую точку, создав динамическое изобра�
жение зеркальной копии. Снова воспользуйтесь режимом привязки Се�
редина (Midpoint) и выберите среднюю точку нижней линии того же пря�
моугольника.

4. В ответ на предложение AutoCAD сохранить исходные объекты нажмите
Enter.

5. На чертеже появится зеркальное отображение трех исходных окружно�
стей, а команда Çåðêàëî (MIRROR) автоматически завершит работу.

Рис. 5.30  Точка пересечения будет использоваться
в качестве базовой для временного отслеживания объектной привязки

6. AutoCAD перейдет в режим отслеживания объектной привязки, обозна�
чив выбранную вами точку пересечения крестиком. Переместите указа�
тель�перекрестие вниз, чтобы задать направление смещения от базовой
точки, и, добившись появления на экране вертикальной пунктирной ли�
нии отслеживания и всплывающей подсказки Òî÷êà îòñëåæèâàíèÿ,
введите в командном окне 60.
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5.3.3. Создание копий объекта с помощью инструмента5.3.3. Создание копий объекта с помощью инструмента5.3.3. Создание копий объекта с помощью инструмента5.3.3. Создание копий объекта с помощью инструмента5.3.3. Создание копий объекта с помощью инструмента
«Копировать» (Copy) и режимов «Т«Копировать» (Copy) и режимов «Т«Копировать» (Copy) и режимов «Т«Копировать» (Copy) и режимов «Т«Копировать» (Copy) и режимов «Точка отслеживания»очка отслеживания»очка отслеживания»очка отслеживания»очка отслеживания»
(T(T(T(T(Temporary track point), «Середина» (Midpoint)emporary track point), «Середина» (Midpoint)emporary track point), «Середина» (Midpoint)emporary track point), «Середина» (Midpoint)emporary track point), «Середина» (Midpoint)
и «Центр» (Center)и «Центр» (Center)и «Центр» (Center)и «Центр» (Center)и «Центр» (Center)
Как видите, мы вполне успешно справились с поставленной задачей, применяя
только одну вспомогательную линию. Теперь нужно создать чертежи трех
опор большой тумбы, причем в данном случае мы обойдемся вообще без вспо�
могательных линий.

1. Восстановите предыдущий масштаб просмотра, а затем охватите рамкой
масштабирования область, показанную на рис. 5.32.

2. Используя рамку выделения или пересекающую рамку, выделите все три
окружности, образующие чертеж любой из опор малой тумбы.

3. Запустите инструмент Копировать (Copy) (например, щелкнув на кноп�
ке Копировать (Copy) панели инструментов Изменить (Modify) или
просто введя в командном окне êï (CP) – в отличие от других команд,
команда Êîïèðîâàòü (COPY) имеет не один, а несколько псевдонимов).

4. В ответ на предложение команды Êîïèðîâàòü (COPY) выбрать базовую
точку, включите режим привязки Центр (Center) и выберите централь�
ную точку выделенных окружностей.

5. Команда Êîïèðîâàòü (COPY) предложит задать смещение. Включите
режим привязки Точка отслеживания (Temporary track point), а затем –
режим Середина (Midpoint).

6. Переместите указатель�перекрестие и связанное с ним динамическое
изображение копируемых объектов к середине левой боковой стенки
большой тумбы. Когда AutoCAD распознает точку, которая находится на
левой вертикальной линии соответствующего прямоугольника (рис. 5.33),
щелкните для захвата ее координат в качестве базовых для отслеживания
объектной привязки.

Внимание. Будьте внимательны, поскольку немного ниже нужной вам точки на�
ходится другая средняя точка, принадлежащая левой границе контура тумбы.
Чтобы убедиться в том, что AutoCAD распознал нужную вам точку, перемести�
те указатель�перекрестие к середине правой вертикальной линии контура боко�

Рис. 5.31. Первая точка оси зеркального отображения выбранных объектов

Рис. 5.32  Увеличение изображения фрагмента чертежа
в области малой и большой тумб

Рис. 5.33  Середина левой границы контура боковой стенки тумбы будет использоваться
в качестве базовой для временного отслеживания объектной привязки
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вой стенки тумбы, а затем верните его в исходное положение. Точка, которую вы
должны выбрать, и середина правой вертикальной линии контура боковой стен�
ки должны, естественно, находиться на одном уровне по вертикали.

7. После включения режима временного отслеживания объектной привяз�
ки переместите указатель�перекрестие вправо, как показано на рис. 5.34,
и введите в командном окне значение смещения от базовой точки, рав�
ное 60 мм (см. рис. 5.27).

5.3.4. Одновременное использование режимов5.3.4. Одновременное использование режимов5.3.4. Одновременное использование режимов5.3.4. Одновременное использование режимов5.3.4. Одновременное использование режимов
«Т«Т«Т«Т«Точка отслеживания» (Tочка отслеживания» (Tочка отслеживания» (Tочка отслеживания» (Tочка отслеживания» (Temporary track point)emporary track point)emporary track point)emporary track point)emporary track point)
и «Смещение» (Snap From)и «Смещение» (Snap From)и «Смещение» (Snap From)и «Смещение» (Snap From)и «Смещение» (Snap From)
Нам осталось создать чертеж основной опоры (см. рис. 5.1), который на нашем
чертеже должен находиться в правом верхнем углу рабочей зоны. Как видно из
рис. 5.36, эта опора имеет диаметр трубы 60 мм и, соответственно, диаметр
монтажного кольца 64 мм. Наружный же диаметр монтажного кольца равен
наружному диаметру монтажного кольца декоративных опор большой и малой
тумб, созданных нами на предыдущем этапе. Воспользуемся этим обстоятель�
ством и просто скопируем три окружности в правый верхний угол чертежа ра�
бочей зоны, а затем модифицируем свойства двух внутренних окружностей.

1. Выделите с помощью рамки выделения или пересекающей рамки (по�
следний метод в данном случае более удобен), чертеж любой из опор,
а затем запустите инструмент Копиро�
вать (Copy).

2. Включите режим привязки Центр (Cen�
ter) и выберите в качестве базовой точ�
ки центр копируемых окружностей.

3. Щелкните на кнопке Окно зумирова�
ния (Zoom Window) панели инструмен�

Рис. 5.34  Задание направления смещения от базовой точки
в режиме временного отслеживания объектной привязки

8. AutoCAD создаст первую копию опоры и предложит задать смещение
для создания второй копии. Снова включите режим Точка отслежива�
ния (Temporary track point), а затем режим Центр (Center) и выбери�
те в качестве базовой центральную точку только что созданной копии
опоры.

9. Используя включившийся режим отслеживания объектной привязки,
переместите указатель�перекрестие вниз от базовой точки для задания
направления копирования, как показано на рис. 5.35, а затем введите
в командном окне значение 231, чтобы вставить копию на 231 мм ниже
базовой точки (см. рис. 5.27).

10. Повторите операции, описанные в пп. 8 и 9, но в этот раз после включе�
ния режима отслеживания объектной привязки перемещайте указатель�
перекрестие вверх от центральной точки первой копии объекта.

11. Нажмите Enter для завершения команды Êîïèðîâàòü (COPY).
12. Восстановите предыдущий масштаб просмотра.

Рис. 5.35  Задание направления смещения от базовой точки
для создания второй копии объекта

Рис. 5.36  Размеры боковой опоры
и расположение ее на чертеже

Модификация свойств объектовМодификация свойств объектовМодификация свойств объектовМодификация свойств объектовМодификация свойств объектов



УУУУУсложненные инструменты и приемы черчениясложненные инструменты и приемы черчениясложненные инструменты и приемы черчениясложненные инструменты и приемы черчениясложненные инструменты и приемы черчения162 163

4. После изменения масштаба и отображения в области черчения выделен�
ного фрагмента работа команды Êîïèðîâàòü (COPY) продолжится. Вклю�
чите режимы Точка отслеживания (Temporary track point) и Конточка
(Endpoint) и выберите в качестве базовой точки верхнюю оконечную
точку вертикальной границы рабочей зоны.

5. Переместите указатель�перекрестие вниз, чтобы включить режим вре�
менного отслеживания привязки от выбранной базовой точки, а затем
включите режим Смещение (Snap From), щелкнув на соответствующей
кнопке панели инструментов Объектная привязка (Object Snap).

6. В командном окне появится приглашение задать базовую точку. Это при�
глашение относится к режиму Смещение (Snap From). Однако поскольку
при этом остается активным режим Точка отслеживания (Temporary
track point), значение, которое вы введете, сначала будет использовано
последним режимом для определения точки, расположенной на соответ�
ствующем расстоянии ниже базовой точки режима Точка отслежива�
ния (Temporary track point). Добившись временного отслеживания объ�
ектной привязки, как показано на рис. 5.38, введите 60. Тем самым вы
с помощью режима Точка отслеживания (Temporary track point) укажи�
те, что точка, которая будет использоваться в качестве базовой для режи�
ма Смещение (Snap From), должна находиться на 60 мм ниже базовой
точки, выбранной для режима Точка отслеживания (Temporary track
point) (см. рис. 5.36).

7. AutoCAD поймет все правильно и после того, как вы введете первое зна�
чение, не завершит команду Êîïèðîâàòü (COPY) (хотя изображение ко�

пируемых объектов «приклеится» к заданной точке), а предложит ввести
в командном окне расстояние смещения. Это означает, что теперь рабо�
тает режим Смещение (Snap From), а точка, в которой пока что находит�
ся изображение копируемых объектов, является базовой для этого режи�
ма. Щелкните на кнопке�индикаторе ОРТО (ORTHO) для включения
соответствующего режима (изображение копируемых объектов тут же
«прыгнет» на указатель�перекрестие), переместите указатель�перекрес�
тие левее базовой точки режима Смещение (Snap From) (рис. 5.39) и вве�
дите в командном окне 70.

8. Нажмите Enter для завершения команды Êîïèðîâàòü (COPY), а затем
щелкните на кнопке�индикаторе ОРТО (ORTHO) для отключения этого
режима.

Если вы не поняли, каким образом нам удалось в одной операции задать сме�
щение и по вертикали, и по горизонтали, можете щелкнуть на кнопке  От�
менить (Undo) панели инструментов Standard. Только что созданная копия
чертежа опоры исчезнет, а масштаб автоматически вернется к тому, который
был до использования инструмента Копировать (Copy). Снова проделайте
операции только что выполненного этапа сначала, обращая внимание на все
детали.

В том случае, если вы передумали, можете вернуться к состоянию, которое
предшествовало отмене предыдущей операции. Для этого следует щелкнуть
на кнопке  Повторить (Redo) панели инструментов Standard, которая
становится активной в том случае, когда имеется хотя бы одна отмененная
команда.

тов Standard и охватите рамкой масштабирования область, показанную
на рис. 5.37. (Выполнение команды Êîïèðîâàòü (COPY) будет приоста�
новлено, но не прервано, о чем можно судить по отображению копируе�
мых объектов штриховыми линиями.)

Рис. 5.37  Выбор фрагмента чертежа для его увеличения
с помощью инструмента Окно зумирования (Zoom Window)

во время работы команды Êîïèðîâàòü (COPY)

Рис. 5.38  Верхняя точка вертикального отрезка используется
в качестве базовой для режима Точка отслеживания (Temporary track point)
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Внимание. В отличие от многих других инструментов AutoCAD, в том числе и
инструмента Повторить (Redo), инструменту Отменить (Undo) соответству�
ет не команда Îòìåíèòü (UNDO), а команда î (U). Более того – последняя не
является псевдонимом команды Îòìåíèòü (UNDO), а полноценной командой,
означающей отмену одной операции. Инструменту Повторить (Redo) соответ�
ствует команда Ïîâòîðèòü (REDO). Иными словами, инструментам Повто�
рить (Redo) и Отменить (Undo) соответствуют команды командного окна î
(U) и Ïîâòîðèòü (Redo), а команда Îòìåíèòü (UNDO) предназначена для уп�
равления режимами отмены и позволяет отменить не только одну последнюю
операцию (этот режим используется по умолчанию), а вообще все операции теку�
щего сеанса работы. Поэтому команду Îòìåíèòü (UNDO) нужно использовать с
осторожностью, а лучше вообще не использовать, поскольку для обычных опера�
ций вполне достаточно кнопок панели инструментов Standard.

5.3.5. Изменение свойств объектов5.3.5. Изменение свойств объектов5.3.5. Изменение свойств объектов5.3.5. Изменение свойств объектов5.3.5. Изменение свойств объектов
с помощью палитры «Свойства» (Properties)с помощью палитры «Свойства» (Properties)с помощью палитры «Свойства» (Properties)с помощью палитры «Свойства» (Properties)с помощью палитры «Свойства» (Properties)
Нам осталось модифицировать две внутренние окружности, чтобы привести
их диаметры в соответствии с рис. 5.36.

1. Щелкните на внутренней окружности для ее выделения. В центре и в точках
квадрантов появятся квадратики, называемые маркерами выделения (grip).

2. Щелкните на кнопке  Свойства (Properties) панели инструментов Stan�
dard (эта кнопка находится справа от кнопки Окно Зумировать преды�
дущий (Zoom Previous)). В левой части окна AutoCAD появится палитра

Свойства (Properties), которую можно перетащить за вертикальный за�
головок в любое место экрана, как показано на рис. 5.40.

3. Как видно из рис. 5.40, в верхней части палитры Свойства (Properties)
имеется раскрывающийся список, в котором отображается тип выделен�
ного объекта (в данном случае – Круг (Circle)). Найдите в разделе Геомет�
рия (Geometry) палитры Свойства (Properties) элемент Радиус (Radius) и
щелкните на его значении, а затем введите 30 (см. рис. 5.36) вместо теку�
щего значения 25.

Рис. 5.39  Точка, находящаяся на 60 мм ниже верхней точки вертикального отрезка
используется в качестве базовой для режима Смещение (Snap From)

Рис. 5.40  Палитра Свойства (Properties)
позволяет просмотреть и изменить свойства выделенного объекта

4. Как только вы нажмете Enter, радиус выделенной окружности на черте�
же тут же изменится, в результате чего она станет не самой маленькой,
а средней.

5. Нажмите Esc для отмены выделения (в раскрывающемся списке палитры
Свойства (Properties) появится сообщение Нет набора (No selection)), а за�
тем щелкните на окружности, которая теперь является самой маленькой.

6. Щелкните на значении элемента Радиус (Radius) палитры Свойства
(Properties) и введите 32 вместо текущего значения 27. Диаметр выде�
ленной окружности увеличится, в результате чего она снова станет сред�
ней, а не внутренней.
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7. Щелкните на кнопке закрытия палитры Свойства (Properties), чтобы
убрать ее с экрана.

8. Восстановите предыдущий масштаб с помощью инструмента Зумиро�
вать предыдущий (Zoom Previous).

Примечание. Палитра Свойства (Properties) – это удобное средство, которое,
как вы только что убедились, позволяет значительно облегчить работу с объекта�
ми чертежа. В последующих главах мы будем постоянно использовать эту палит�
ру, поэтому к более подробному ее обсуждению мы еще вернемся.

5.4. Завершающие этапы5.4. Завершающие этапы5.4. Завершающие этапы5.4. Завершающие этапы5.4. Завершающие этапы
Нам осталось создать чертежи планшетного сканера и настольной лампы.
Сами по себе эти объекты не очень сложны, но, создавая их, вы познакомитесь
с несколькими новыми инструментами, а также новыми режимами использова�
ния уже знакомых вам инструментов AutoCAD, позволяющих повысить произ�
водительность при работе в AutoCAD.

5.4.1. Использование инструментов5.4.1. Использование инструментов5.4.1. Использование инструментов5.4.1. Использование инструментов5.4.1. Использование инструментов
«Зумирование в реальном времени» (Zoom Realtime)«Зумирование в реальном времени» (Zoom Realtime)«Зумирование в реальном времени» (Zoom Realtime)«Зумирование в реальном времени» (Zoom Realtime)«Зумирование в реальном времени» (Zoom Realtime)
и «Панорамирование в реальном времени»и «Панорамирование в реальном времени»и «Панорамирование в реальном времени»и «Панорамирование в реальном времени»и «Панорамирование в реальном времени»
(Pan Realtime)(Pan Realtime)(Pan Realtime)(Pan Realtime)(Pan Realtime)
Как видно из рис. 5.41, чертеж сканера довольно прост. Основная сложность
заключается в том, что многие линии, которые представляют на чертеже реб�
ра, образуемые скошенными боковыми гранями сканера, проходят очень близ�
ко одна от другой. Учитывая достаточно большие габариты сканера в сравне�
нии с этими расстояниями, вам придется, создавая его чертеж, интенсивно
использовать инструменты Окно зумирования (Zoom Window) и Зумировать
предыдущий (Zoom Previous). Если хотите,
можете так и поступить, но в данном разделе
мы рассмотрим альтернативный подход, зак�
лючающийся в использовании инструментов
Зумирование в реальном времени (Zoom Real�
time) и Панорамирование в реальном вре�
мени (Pan Realtime), отметив достоинства и
недостатки его использования.

1. Щелкните на кнопке  Панорамиро�
вание в реальном времени (Pan Real�
time) панели инструментов Standard

или выберите из меню команду Вид ⇒ Панорамирование ⇒ В реальном
времени (View ⇒ Pan ⇒ Realtime) либо введите в командном окне ïàí
(PAN). Указатель�перекрестие исчезнет, а вместо него появится указа�
тель мыши в виде небольшой руки, с помощью которой можно переме�
щать чертеж в области черчения. Переместите этот указатель в левый
нижний угол рабочей зоны, расположив его примерно над малой тумбой.

2. Нажмите левую кнопку мыши и, не отпуская ее, переместите указатель
вправо и вверх. Чертеж будет перемещаться в области черчения вместе
с перемещением указателя (рис. 5.42). Когда малая тумба окажется при�
мерно посредине области черчения, отпустите кнопку мыши.

Рис. 5.41  Основные размеры сканера
и расположение его на чертеже рабочей зоны

Рис. 5.42  Перемещение чертежа в области черчения
с помощью инструмента Панорамирование в реальном времени (Pan Realtime)

3. Щелкните на кнопке  Зумирование в реальном времени (Zoom Real�
time) панели инструментов Standard или выберите из меню команду Вид ⇒
Зумирование ⇒ В реальном времени (View ⇒ Zoom ⇒ Realtime). Можно
также запустить инструмент Зумирование в реальном времени (Zoom
Realtime) в командном окне, однако в этом случае сначала нужно завер�
шить работу инструмент Панорамирование в реальном времени (Pan
Realtime), нажав Esc или Enter. После этого можно набрать в командном
окне ïîêàçàòü (ZOOM) или просто ïî (Z), а затем два раза нажать Enter.
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4. Указатель примет форму лупы, рядом с которой расположен символ
«±». Расположите указатель у нижней границы чертежа, затем нажмите
левую кнопку и, не отпуская ее, перемещайте указатель вверх. Изобра�
жение будет увеличиваться (рис. 5.43). При этом неизменным останет�
ся положение тех элементов чертежа, которые находятся в центре эк�
рана.

или ïàí (PAN)) либо снова воспользуйтесь контекстным меню и выбери�
те из него команду Выход (Exit).

Совет. Использование контекстного меню при работе с инструментами Пано�
рамирование в реальном времени (Pan Realtime) и Зумирование в реальном вре�
мени (Zoom Realtime) – это самый удобный метод переключения между ними.
Кроме того, если ваш ПК оборудован трехкнопочной мышью, при нажатии сред�
ней кнопки автоматически включается инструмент Панорамирование в реаль�
ном времени (Pan Realtime). Трехкнопочные мыши, в средней кнопке которых
имеется колесико прокрутки, позволяют, вращая колесико, автоматически ис�
пользовать инструмент Зумирование в реальном времени (Zoom Realtime). Мно�
гие профессиональные пользователи предпочитают применять панорамирова�
ние и масштабирование именно с помощью средней кнопки мыши, не прибегая
к обычным инструментам AutoCAD.

5.4.2. Использование инструмента «Сопряжение»5.4.2. Использование инструмента «Сопряжение»5.4.2. Использование инструмента «Сопряжение»5.4.2. Использование инструмента «Сопряжение»5.4.2. Использование инструмента «Сопряжение»
(Fillet) в режиме «Несколько» (Multiply)(Fillet) в режиме «Несколько» (Multiply)(Fillet) в режиме «Несколько» (Multiply)(Fillet) в режиме «Несколько» (Multiply)(Fillet) в режиме «Несколько» (Multiply)
Теперь можно приступать к созданию контуров сканера. Для этого мы восполь�
зуемся уже хорошо изученными инструментами Подобие (Offset), Сопряже�
ние (Fillet) и С линиями (Line), а также режимом объектной привязки Конточ�
ка (Endpoint). Выполните следующие операции, руководствуясь рис. 5.41.

1. Сместите горизонтальную линию, обозначающую нижнюю границу габа�
ритов рабочей зоны, вверх на 200 мм, а затем полученную линию – вверх
на 470 мм.

2. Сместите вертикальную линию, обозначающую левую наружную границу
контура левой боковой стенки рабочей зоны, вправо на 50 мм, а затем
полученную линию – вправо на 298 мм.

3. Для сопряжения полученных четырех линий (рис. 5.44) и образования
контура сканера запустите инструмент Сопряжение (Fillet).

4. Убедитесь в том, что радиус сопряжения, указанный в командном окне
среди параметров команды Ñîïðÿæåíèå (FILLET), равен 0 (то есть Ðà-
äèóñ = 0.0 (Radius = 0.0)). Если это не так, введите Ðàäèóñ (RADIUS) или
просто ä, а затем введите значение 0.

5. Проверив и, в случае необходимости, изменив значение радиуса, введите
в командном окне íåñêîëüêî (MULTIPLY) для включения режима множе�
ственного сопряжения. Команда Ñîïðÿæåíèå (FILLET) не выдаст никаких
сообщений, но логика ее изменится – после сопряжения двух линий она не
завершит выполнение, а продолжит предлагать выбирать следующие пары
сопрягаемых линий до тех пор, пока вы не нажмете Enter или Esc.

6. Выполните попарное сопряжение всех четырех линий для образования
контура прямоугольника, а затем нажмите Enter для завершения коман�
ды Ñîïðÿæåíèå (FILLET).

7. Измените с помощью инструментов Панорамирование в реальном вре�
мени (Pan Realtime) и Зумирование в реальном времени (Zoom Real�

Рис. 5.43  Изменение масштаба просмотра
с помощью инструмента Зумирование в реальном времени (Zoom Realtime)

5. Если при увеличении нужного нам фрагмента чертежа изображение «уй�
дет» влево или вправо, щелкните правой кнопкой мыши и выберите из
появившегося контекстного меню команду Панорамирование (Pan). Под�
корректировав расположение объектов в области черчения, снова щелк�
ните правой кнопкой мыши и выберите из появившегося контекстного
меню команду Зумирование (Zoom).

6. Расположите чертеж в области черчения так, чтобы вы видели верхнюю
линию контура малой тумбы и нижнюю горизонтальную линию габари�
тов рабочей зоны, и чтобы при этом указанный фрагмент чертежа зани�
мал по вертикали практически всю область черчения.

7. Добившись нужного расположения объектов на чертеже, нажмите Esc
или Enter для завершения текущей команды (то есть ïîêàçàòü (ZOOM)
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time) масштаб так, чтобы контур сканера занимал по вертикали почти
всю область черчения, как показано на рис. 5.45.

8. Исходя из рис. 5.41, нужно рассчитать смещение, которое необходимо
применить к линиям наружного контура для получения линий внутрен�

него контура. Оно составляет (470 – 464,75) / 2 = 2,625 мм. Это смещение
одинаково и по вертикали и по горизонтали. Запустите инструмент По�
добие (Offset) и, используя рассчитанное значение смещения, сместите
все четыре линии внутрь контура сканера.

9. Снова запустите инструмент Сопряжение (Fillet) и, используя режим
Несколько (Multiply), выполните сопряжение всех четырех линий внут�
реннего контура сканера.

10. Как видно из рис. 5.41, для образования линии, обозначающей край
крышки сканера, нужно сместить верхнюю линию внутреннего контура
вниз на 457,04 мм. Воспользуйтесь для решения этой задачи инструмен�
том Подобие (Offset), а затем снова запустите его для смещения получен�
ной линии вниз еще на 1,76 мм. Результат представлен на рис. 5.46.

Рис. 5.44  Линии, обозначающие контур сканера,
получены с помощью инструмента Подобие (Offset)

Рис. 5.45  Линии, обозначающие контур сканера, сопряжены
с помощью инструмента Сопряжение (Fillet) в режиме Несколько (Multiply)

Рис. 5.46  Прямолинейные участки контуров
конструктивных элементов сканера получены

11. Для завершения картины необходимо создать линии, обозначающие
ребра на скошенных вертикальных гранях сканера. Воспользуйтесь ин�
струментом Окно зумирования (Zoom Window) для увеличения масшта�
ба элементов чертежа сканера, находящихся в его правом нижнем углу.

12. После изменения масштаба запустите инструмент С линиями (Line) и,
используя режим привязки Конточка (Endpoint) для привязки к угловым
точкам внешнего и внутреннего контуров сканера, создайте наклонную
линию, как показано на рис. 5.47.

13. Завершив выполнение команды Îòðåçîê (LINE), вернитесь к предыду�
щему масштабу просмотра с помощью инструмента Зумировать преды�
дущий (Zoom Previous).
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15. Повторите пп. 10–12 для создания двух оставшихся линий в правом и ле�
вом верхних углах чертежа сканера, используя любой из двух методов из�
менения масштаба.

16. Вернитесь к исходному масштабу просмотра всего чертежа рабочей
зоны, последовательно используя инструмент Зумировать предыдущий
(Zoom Previous) необходимое количество раз.

Совет. Если вы не смогли восстановить исходный масштаб чертежа (например,
вы сохранили чертеж после изменения масштаба, в результате чего информация
об исходном масштабе была утеряна), воспользуйтесь инструментами Зумирова�
ние в границах (Zoom Extents) и Увеличить (Zoom Out), последовательно введя
в командном окне сначала ïî ã (Z E), а затем – ïî 0.75x (Z 0.75x).

5.4.3. Использование инструмента «Эллипс» (Ellipse)5.4.3. Использование инструмента «Эллипс» (Ellipse)5.4.3. Использование инструмента «Эллипс» (Ellipse)5.4.3. Использование инструмента «Эллипс» (Ellipse)5.4.3. Использование инструмента «Эллипс» (Ellipse)
с постоянно действующими режимами привязкис постоянно действующими режимами привязкис постоянно действующими режимами привязкис постоянно действующими режимами привязкис постоянно действующими режимами привязки
Вы уже, наверняка, обратили внимание, что у режимов привязки в том виде,
в котором мы их используем, есть один недостаток: их нужно постоянно вклю�
чать. Так, при черчении четырех диагональных линий в предыдущем упражне�
нии вам пришлось 8 раз щелкнуть на кнопке Конточка (Snap to Endpoint).
Поневоле напрашивается вопрос, нельзя ли как�то решить эту проблему? Ко�
нечно, можно. Режимы привязки, включаемые с помощью кнопок панели инст�
рументов Объектная привязка (Object Snap), а также контекстного меню,
открываемого при щелчке в свободном месте области черчения, являются ра�
зовыми. Однако, в случае необходимости, пользователь может как включить
эти режимы для постоянного использования, так и настроить общие парамет�
ры режимов привязки.

Давайте рассмотрим, как использовать постоянно действующие режимы
привязки, на примере создания чертежа лампы (рис. 5.48).

Чертеж лампы должен размещаться в левом верхнем углу контура парты. Как
видно из рис. 5.48, он состоит из нескольких прямых линий и дуг. Три меньше
дуги (одна – радиусом 10 мм и две – радиусом 40 мм), представляют собой полови�
ны окружностей, тогда как большая дуга – это
половина эллипса. Вы, наверняка, догадывае�
тесь, что при создании этого чертежа нам по�
надобятся такие режимы привязки, как Кон�
точка (Endpoint), Cередина (Midpoint), Центр
(Center) и Квадрант (Quadrant). Давайте по�
смотрим, как включить эти режимы привязки
для постоянного использования.

1. Выберите из меню команду Сервис ⇒
Настройка (Tools ⇒ Drafting Settings).

Рис. 5.47  Создание линии, обозначающей ребро
на скошенных боковых гранях сканера

14. Повторите пп. 10–12 для создания аналогичной линии в левом нижнем
углу чертежа сканера, но в этот раз для увеличения изображения попро�
буйте использовать инструменты Зумирование в реальном времени
(Zoom Realtime) и Панорамирование в реальном времени (Pan Real�
time). Вы убедитесь, что в данном случае использовать эти инструменты
не так удобно, как инструмент Окно зумирования (Zoom Window), по�
скольку расстояние между линиями слишком мало по сравнению с разме�
рами сканера, вследствие чего панорамирование и масштабирование
придется применять поочередно несколько раз. Кроме того, для возвра�
та к предыдущему масштабу вам придется столько же раз поочередно ис�
пользовать инструменты Зумирование в реальном времени (Zoom
Realtime) и Панорамирование в реальном времени (Pan Realtime) или
же несколько раз воспользоваться инструментом Зумировать предыду�
щий (Zoom Previous), поскольку AutoCAD сохраняет информацию о пре�
дыдущем масштабе чертежа при каждом использовании инструмента
Зумирование в реальном времени (Zoom Realtime) или Панорамирова�
ние в реальном времени (Pan Realtime).

Совет. Инструменты Зумирование в реальном времени (Zoom Realtime) и Пано�
рамирование в реальном времени (Pan Realtime) лучше использовать для про�
крутки больших чертежей и поиска нужной области, после которого вы плани�
руете в найденной области чертежа выполнять много операций, а инструмент
Окно зумирования (Zoom Window) – для кратковременного изменения масштаба
с последующим возвратом к предыдущему масштабу.

Рис. 5.48  Основные размеры настольной лампы
и расположение ее на чертеже рабочей зоны
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(Можно также ввести в командном окне команду Íàñòðîéêà (DSET�
TINGS) или просто íà (DS) либо щелкнуть на кнопке�индикаторе ПРИ�
ВЯЗКА (OSNAP) правой кнопкой мыши и выбрать из открывшегося не�
большого контекстного меню команду Настройка (Settings).)

2. В открывшемся окне Режимы рисования (Drafting Settings) перейдите
на вкладку Объектная привязка (Object Snap) и установите флажки
Конточка (Endpoint), Cередина (Midpoint), Центр (Center) и Квадрант
(Quadrant), а также флажок Объектная привязка Вкл (F3) (Object Snap
On (F3)), как показано на рис. 5.49.

4. Щелкните на кнопке OK диалогового окна Режимы рисования (Drafting
Settings) для его закрытия и включения постоянно действующих режи�
мов привязки, соответствующих флажкам, которые были установлены
вами на вкладке Объектная привязка (Object Snap) этого окна.

Теперь вы избавлены от необходимости каждый раз вручную включать ре�
жимы привязки Конточка (Endpoint), Cередина (Midpoint), Центр (Center) и
Квадрант (Quadrant), поскольку они будут действовать постоянно. (Конечно,
если вам понадобиться какой�то другой режим привязки, например, Нормаль
(Perpendicular), придется включить его вручную.)

Совет. Начинающие пользователи часто пытаются включить сразу все режи�
мы привязки. Делать этого не нужно, поскольку в таком случае AutoCAD будет
постоянно распознавать все характерные точки чертежа, что, скорее, услож�
нит вашу работу, чем облегчит ее. Кроме того, даже небольшой набор постоянно
действующих режимов привязки в некоторых случаях может усложнить задачу
выбора точки. В таком случае можно нажать F3 для отключения сразу всех по�
стоянно действующих режимов привязи, затем воспользоваться наиболее подхо�
дящим разовым режимом, после чего снова включить набор постоянно действую�
щих режимов с помощью повторного нажатия F3. Тот же эффект достигается
при щелчке на кнопке�индикаторе ПРИВЯЗКА (OSNAP).

Рис. 5.49  Вкладка Объектная привязка (Object Snap)
диалогового окна Режимы рисования (Drafting Settings)

с включенными режимами постоянно действующей привязки

3. Не щелкая на кнопке OK, щелкните на кнопке Настройка (Options), ко�
торая находится в левом нижнем углу окна Режимы рисования (Drafting
Settings). В открывшемся окне Настройка (Options) перейдите, если
нужно, на вкладку Построения (Drafting) (рис. 5.50). Если хотите, може�
те с помощью бегунка Размер маркера автопривязки (AutoSnap Marker
Size) изменить размер этого маркера (впрочем, в подавляющем большин�
стве случаев во внесении подобных изменений нет особой необходимос�
ти). Убедитесь в том, что флажки Маркер (Marker), Магнит (Magnet) и
Всплывающие подсказки автопривязки (Display AutoSnap tooltip) уста�
новлены, а флажок Прицел автопривязки (Display AutoSnap aperture box)
сброшен, а затем щелкните на кнопке OK для возврата в диалоговое окно
Режимы рисования (Drafting Settings).

Рис. 5.50  Вкладка Построения (Drafting)
диалогового окна Настройка (Options)
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Что ж, приступим к созданию чертежа лампы, чтобы на практике ощутить
преимущества использования постоянно действующих режимов объектной
привязки.

1. Охватите рамкой масштабирования фрагмент чертежа, показанный на
рис. 5.51. (Если хотите, можете воспользоваться инструментами Пано�
рамирование в реальном времени (Pan Realtime) и Зумирование в реаль�
ном времени (Zoom Realtime).)

наружную границу контура стенки выдвижного ящика в качестве секуще�
го ребра. Результат должен быть таким, как показано на рис. 5.53.

Рис. 5.51  Изменение масштаба фрагмента чертежа
с помощью инструмента Окно зумирования (Zoom Window)

2. После увеличения изображения выбранного фрагмента запустите инст�
румент Подобие (Offset) и сместите вниз внутреннюю горизонтальную
линию контура задней стенки рабочей зоны на 22 мм (см. рис. 5.48).

3. Снова запустите инструмент Подобие (Offset) и сместите вниз только
что созданную линию на 180 мм.

4. Сместите две созданные в п. 2 и 3 линии вверх и вниз внутрь будущего
контура основания лампы на 80 мм.

5. Повторите операцию, указанную в п. 4, но на этот раз сместите те же ли�
нии в том же направлении на расстояние 50 мм.

6. Теперь сместите левую вертикальную наружную границу контура стенки
выдвижного ящика (рис. 5.52) вправо на 35 мм, затем на 110 мм, затем ее
же – на 125 мм.

7. Сместите вертикальную линию, созданную последней, вправо на 40 мм,
а затем полученную линию – еще вправо на 120 мм.

8. Теперь начнем выполнять сопряжение линий для формирования конту�
ра лампы. Запустите инструмент Сопряжение (Fillet) и выполните со�
пряжение линий, созданных в пп. 2 и 3, со второй линией, созданной
в п. 6 (она отстоит от левой вертикальной наружной границы контура
стенки выдвижного ящика на 110 мм).

9. Запустите инструмент Обрезать (Trim) и обрежьте сегменты только что
сопряженных горизонтальных линий, используя левую вертикальную

Рис. 5.52  Линия, подлежащая смещению вправо сначала на 35,
затем на 110, а затем – на 125 мм

Рис. 5.53  Контур прямоугольной части основания лампы сформирован

10. Теперь, руководствуясь рис. 5.48, выполните сопряжение контура
плафонодержателя. (Не забывайте о возможности применения режима
Несколько (Multiply) при использовании инструмента Сопряжение
(Fillet).)
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12. Все предыдущие операции вы выполняли, не используя объектной при�
вязки (хотя, вероятно, обратили внимание на то, что когда вы переме�
щаете указатель над чертежом, AutoCAD распознает опорные точки).
Теперь настала пора задействовать режимы постоянно действующей
привязки для создания остальных элементов чертежа лампы. Запустите
инструмент Круг (Circle) и подведите указатель�перекрестие к середи�
не левой вертикальной линии прямоугольного контура плафонодер�
жателя.

13. Когда AutoCAD распознает среднюю часть отрезка (рис. 5.55), щелкните
для захвата координат этой точки в качестве координат центра будущей
окружности.

14. Переместите указатель вверх к левой оконечной точке верхнего гори�
зонтального отрезка контура плафонодержателя. AutoCAD тут же рас�
познает эту точку, используя режим привязки Конточка (Endpoint). Вам
остается лишь щелкнуть для задания радиуса, и окружность тут же по�
явится на чертеже.

15. Создайте подобным образом две окружности радиусом 40 мм на плафоне
лампы, затем обрежьте все три окружности по вертикальным линиям,
после чего удалите эти вертикальные линии, чтобы чертеж принял вид,
показанный на рис. 5.56.

16. Выберите из меню команду Черчение ⇒ Эллипс ⇒ Ось, конец (Draw ⇒
Ellipse ⇒ Axis, End). Альтернативный метод запуска инструмента Эллипс

(Ellipse) состоит в том, чтобы щелкнуть на кнопке Эллипс (Ellipse) пане�
ли инструментов Черчение (Draw) либо ввести в командном окне Ýë-
ëèïñ (ELLIPSE) или просто ý (EL).

11. Получив изображение, показанное на рис. 5.54, продолжите использо�
вать инструмент Сопряжение (Fillet) для сопряжения оставшихся четы�
рех линий, образующих прямоугольную часть плафона.

Рис. 5.54  Контур прямоугольной части плафонодержателя сформирован

Рис. 5.55  AutoCAD распознал среднюю точку без вмешательства пользователя,
поскольку режим привязки Середина (Midpoint) включен постоянно

Рис. 5.56  Чертеж лампы после отсечения лишних половин окружностей
и удаления вертикальных отрезков, игравших роль секущих ребер
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Примечание. В отличие от инструментов Дуга (Arc) и Круг (Circle), режиму ра�
боты по умолчанию инструмента Эллипс (Ellipse) соответствует не первая,
а вторая команда подменю Черчение ⇒ Эллипс (Draw ⇒ Ellipse).)

17. Переместите указатель�перекрестие к верхней оконечной точке верти�
кальной линии, которая обозначает правую границу контура основания
лампы, и, как только AutoCAD автоматически распознает ее в режиме
Конточка (Endpoint), щелкните для захвата координат этой точки в ка�
честве координат первой точки оси эллипса.

18. Повторите действия, выполненные в п. 17, но для нижней точки этого
же вертикального отрезка.

19. AutoCAD предложит в командном окне задать значение, которое должно
равняться половине длины второй оси эллипса. Эту величину можно было
бы задать с помощью динамически отображаемого эллипса (рис. 5.57), од�
нако поскольку у нас нет точки, чтобы привязаться к ней, просто введите
в командном окне 70 (см. рис. 5.48).

изогнутая. Так оно и есть – автор в этом месте также создала половину эллипса
с малой полуосью 2 мм (большая ось соответствует диаметру трубки плафонодер�
жателя), а затем обрезала левую половину эллипса, удалила вертикальную линию
большой оси эллипса и обрезала дугу радиусом 40 мм, используя полученную полови�
ну эллипса в качестве секущей.

5.4.4. Использование инструмента «Прямоугольник»5.4.4. Использование инструмента «Прямоугольник»5.4.4. Использование инструмента «Прямоугольник»5.4.4. Использование инструмента «Прямоугольник»5.4.4. Использование инструмента «Прямоугольник»
(Rectangle) с постоянно действующими режимами(Rectangle) с постоянно действующими режимами(Rectangle) с постоянно действующими режимами(Rectangle) с постоянно действующими режимами(Rectangle) с постоянно действующими режимами
привязкипривязкипривязкипривязкипривязки
Единственный объект, который нам нужно осталось создать в данной главе, – это
прямоугольник, обозначающий выдвижную подставку для клавиатуры (рис. 5.59).

Скорее всего, вы уже обладаете необхо�
димыми навыками для самостоятельного
создания этого объекта. Используйте ре�
жимы объектной привязки, инструменты
Прямоугольник (Rectangle) и Повернуть
(Rotate), а также режим ОТС�ПОЛЯР (PO�
LAR) для смещения прямоугольника по
диагонали. Можете, конечно, воспользо�
ваться и любым другим методом для дости�

Рис. 5.57  AutoCAD предлагает задать значение второй полуоси эллипса

20. Для завершения формирования чертежа лампы обрежьте левую полови�
ну эллипса по линии его большой оси, а затем удалите эту линию. Кроме
того, используя в качестве секущих горизонтальные линии плафона, об�
режьте оставшуюся часть эллипса, как показано на рис. 5.58.

21. Восстановите предыдущий масштаб просмотра с помощью инструмента
Зумировать предыдущий (Zoom Previous).

Примечание. Внимательно присмотревшись к рис. 5.58, вы заметите, что в мес�
те соединения контуров плафонодержателя и плафона линия не прямая, а слегка

Рис. 5.58  Чертеж лампы завершен

Рис. 5.59  Основные размеры выдвижной
подставки под клавиатуру и расположение ее

на чертеже рабочей зоны
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жения нужного результата. (Как уже неоднократно подчеркивалось, в AutoCAD
нет правильных и неправильных методов черчения.)

Прежде, чем сохранить чертеж в файле, с помощью инструментов Панора�
мирование в реальном времени (Pan Realtime) и Зумировать предыдущий
(Zoom Previous) измените масштаб так, чтобы чертеж занял всю область черче�
ния (рис. 5.60). Если вы прислушались к совету автора и сразу же переименова�
ли файл, открытый в середине этой главы, в файл Work052.dwg, тогда, восполь�
зовавшись командой Файл ⇒ Сохранить (File ⇒ Save) или нажатием Ctrl+S,
сохраните текущее состояние чертежа. В противном случае сохраните чертеж
(если вы его не переименовали, файл должен называться Work051.dwg) в фай�
ле Work052.dwg, воспользовавшись командой Файл ⇒ Сохранить как (File ⇒
Save As) или нажатием Ctrl+Shift+S.

Рис. 5.60  Окончательный вид нижней части
рабочей зоны с чертежами оборудования

Теперь вы уже должны почувствовать в себе силы справиться с чертежом
практически любой степени сложности. Действительно, инструменты и при�
емы черчения, изученные вами в главах 4 и 5, будут использоваться вами в 80%
случаев черчения на плоскости. При этом, как вы уже поняли, один и тот же
чертеж можно создать с помощью совершенно разных инструментов. Напри�
мер, можете попробовать создать чертеж, представленный на рис. 5.60, пре�
имущественно с использованием инструментов Прямоугольник (Rectangle) и
Круг (Circle), то есть прибегая к инструментам С линиями (Line), Подобие
(Offset), Сопряжение (Fillet), Удлинить (Extend) и Обрезать (Trim) только
в случае крайней необходимости. Можете также попробовать воссоздать этот
же чертеж, используя режим ïîëÿð (POLAR). Очень полезно будет попракти�

коваться в создании уже знакомых вам объектов с использованием постоянно
действующих режимов привязки и сравнить трудозатраты с теми, которые
имели место при использовании разовых режимов привязки. Короче говоря,
автор надеется, что главную идею вы поняли – практика, практика и еще раз
практика.

В следующей главе мы, наконец�то, займемся наведением порядка на черте�
же. Пока что созданный вами чертеж выглядит очень хорошо для новичка ра�
боты в AutoCAD, но совершенно непрофессионально с точки зрения опытного
пользователя. Из последующих глав вы узнаете, как научиться создавать
в AutoCAD не только точные, но и правильно оформленные чертежи, а также
как использовать возможности AutoCAD для повышения производительности
черчения.
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Кнастоящему моменту наш чертеж стал уже достаточно сложным, что
требует принятия каких�то мер для его упрощения. Кроме того, на чер�
теже пока еще отсутствует целый ряд объектов, расположенных в верх�

ней части рабочей зоны. Если мы их начнем наносить на чертеж в его текущем
состоянии, то в конце получим нагромождение линий, в котором будет трудно
разобраться даже автору такого чертежа.

С другой стороны, автор уже отмечала тот факт, что наш чертеж выглядит
не совсем корректно с точки зрения стандартов оформления чертежей. Как вы
помните, некоторые объекты (например, верхние крышки тумб, фасады и т. п.)
на чертеже выглядят «прозрачными», тогда как другие (сканер, дисплей, лам�
па) – «непрозрачными». Нужно навести порядок и в этом вопросе, чтобы даль�
нейшие построения выполнялись в соответствии с требованиями чертежных
стандартов.

Для решения этих проблем мы воспользуемся таким средством AutoCAD,
как слои. Слой (layer)  – это что�то вроде листа прозрачной кальки. Представьте,
например, что вы создаете чертеж автомобиля с нанесенными на него линия�
ми трасс всех систем (гидравлической, пневматической, топливной и т. п.).
В те времена, когда чертежи создавались на бумаге, при возникновении необ�
ходимости внесения существенных изменений в какую�то систему (например,
замену пневматической системы электрической), приходилось перечерчивать
весь чертеж.

Поэтому конструкторы придумали такой прием: основные конструктивные
элементы чертились на одном листе кальки, а каждая система – на последую�
щих листах. Наложив все листы кальки один на другой, можно было получить
изображение всего изделия. Например, если было видно, что бак гидросисте�
мы расположен неудачно, конструкторам нужно было изменить чертеж только
на том листе кальки, на котором находились объекты гидросистемы.

Слои AutoCAD в чем�то напоминают эти листы кальки. Однако при этом
использовать слои в AutoCAD можно гораздо гибче, чем листы кальки при тра�
диционном черчении. Во�первых, количество слоев в AutoCAD ничем не огра�
ниченно (использование листов кальки ограничивалось четырьмя�пятью лис�
тами из�за ее ограниченной прозрачности). Во�вторых, объекты, помещенные
на разные слои AutoCAD, вовсе не должны накладываться один на другой. Час�
то в AutoCAD слои используются для разграничения функциональности раз�
личных объектов чертежа (например, на одном слое – валы редуктора, на дру�
гом – подшипники, на третьем – зубчатые колеса и т. п.). В других случаях
удобно разносить объекты по слоям, основываясь на материале, из которых
они изготовлены, и (или) на отделке поверхности объектов.

В нашем случае мы воспользуемся слоями для того, чтобы разнести объекты
по высоте. На рис. 6.1 представлен чертеж рабочей зоны на виде спереди с ука�
занием основных высот (слева направо): 1276, 758, 622, 320, 18, 720, 1036, 1188
и 1358 мм.6ГГГГГлавалавалавалавалава

ОрганизацияОрганизацияОрганизацияОрганизацияОрганизация
объектов чертежаобъектов чертежаобъектов чертежаобъектов чертежаобъектов чертежа
с помощью слоевс помощью слоевс помощью слоевс помощью слоевс помощью слоев

Рис. 6.1  Основные высоты рабочей зоны на виде спереди

Как видно из рис. 6.1, полученный к настоящему времени чертеж примерно
соответствует высоте 720 мм. При этом на нем имеется часть объектов, кото�
рые расположены над столешницей и, соответственно, не должны быть види�
мы на этом чертежа. С другой стороны, на высоте 720 мм не должны быть види�
мы также объекты, которые расположены ниже этой высоты и закрыты
другими объектами (например, боковые стенки тумб, системный блок, полка
парты и др.).

Поэтому в нашем случае мы создадим слои по высотам, а затем займемся раз�
несением по этим слоям уже имеющихся объектов. Новые объекты мы будем
создавать сразу на соответствующих слоях. Таким образом, в итоге мы получим
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чертежи всех объектов рабочей зоны, но при этом не будем загромождать чер�
теж вида сверху рабочей зоны лишними объектами.

Примечание. В нашем случае слои соответствуют разрезам, выполненным на со�
ответствующей высоте. Пока что мы не будем акцентировать на этом внима�
ние, а вернемся к правилам оформления разрезов и сечений в главе 9.

6.1.6.1.6.1.6.1.6.1. СозданиеСозданиеСозданиеСозданиеСоздание слоевслоевслоевслоевслоев иииии настройканастройканастройканастройканастройка ихихихихих параметровпараметровпараметровпараметровпараметров
В любом документе AutoCAD всегда имеется как минимум один слой, который
называют нулевым, поскольку он имеет имя 0. Если вы не создали в чертеже ни
одного слоя, это означает, что все объекты чертежа находятся на нулевом слое.
(Как вы, наверно, догадались, именно таково положение дел с имеющимся у нас
чертежом.) Проводя аналогии, можно сказать, что нулевой слой – это что�то вро�
де того, что юристы называют «лицами без гражданства». Тогда любой создан�
ный пользователем слой – это «гражданство» какой�то конкретной «страны».
Все объекты AutoCAD являются либо «лицами без гражданства» (то есть принад�
лежат нулевому слою), либо «гражданами» того или иного слоя. В отличие от нас
с вами, объекты AutoCAD не могут иметь «двойного гражданства» (то есть не
могут принадлежать одновременно двум слоям) – при перемещении объекта на
другой слой он немедленно получает соответствующее «гражданство».

В дальнейшем мы будем оперировать не юридическими терминами вроде
«гражданства» объектов, а техническими – если объект принадлежит какому�то
слою, автор будет говорить, что он расположен на этом слое. Объект можно рас�
положить на слое двумя методами: либо сначала создать его на произвольном
слое (например, на нулевом), а затем переместить его на нужный слой, либо
сразу создать объект на нужном слое. Хотя второй метод, как правило, пред�
почтительнее, на практике приходиться пользоваться обоими методами.

6.1.1.6.1.1.6.1.1.6.1.1.6.1.1. ИнструментИнструментИнструментИнструментИнструмент «Диспетчер«Диспетчер«Диспетчер«Диспетчер«Диспетчер свойствсвойствсвойствсвойствсвойств слоев»слоев»слоев»слоев»слоев»
(Layer(Layer(Layer(Layer(Layer PropertiesPropertiesPropertiesPropertiesProperties Manager)Manager)Manager)Manager)Manager)
Поскольку в нашем случае объектов на чертеже более чем достаточно, мы при�
бегнем к первому методу – создадим несколько слоев и переместим на них
объекты чертежа.

1. Запустите, если в этом есть необходимость AutoCAD, откройте файл
Work052.dwg и, если вы прислушались к совету автора, сохраните его
в файле Work061.dwg.

2. Щелкните правой кнопкой мыши на любой панели инструментов и выбе�
рите в списке панелей инструментов пункты Cлои (Layers) и Слои II
(Layers II).

3. Если нужно, переместите появившиеся панели инструментов Cлои
(Layers) и Слои II (Layers II) (рис. 6.2) в верхнюю часть окна AutoCAD,
чтобы они пристыковались ниже панели инструментов Standard вдоль
верхней горизонтальной границы области черчения.

4. Щелкните на кнопке  Диспетчер свойств слоев (Layer Properties
Manager) панели инструментов Cлои (Layers) (первая кнопка слева).
(Альтернативный метод запуска этого инструмента заключается в выбо�
ре из меню команды Формат ⇒ Слой (Format ⇒ Layer) либо во вводе
в командном окне команды Ñëîé (LAYER) или просто ñë (LA).) На экране
появится диалоговое окно Диспетчер свойств слоев (Layer Properties
Manager). Как видно из рис. 6.3, в списке слоев этого окна представлен
лишь нулевой слой, что, как мы уже обсудили выше, понятно, поскольку
вы еще не создали в текущем чертеже ни одного слоя.

Рис. 6.2  Плавающие панели инструментов Cлои (Layers)
и Слои II (Layers II)

Рис. 6.3  Созданный по умолчанию нулевой слой
в диалоговом окне Диспетчер свойств слоев (Layer Properties Manager)

Примечание. Каждый слой характеризуется четырьмя свойствами: цветом
(color) линии, ее типом (linetype) и шириной (lineweight), а также стилем печати
(plot style). Обратите внимание на квадратик и слово белый (White) в столбце
Цвет (Color) строки, соответствующей нулевому слою. Квадрат закрашен в чер�
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ный цвет (или белый, если вы предпочитаете работать с черным фоном), но его
название не зависит от того, является ли он на самом деле белым или черным.
Слово Continuous, указанное в столбце Тип линий (Linetype), свидетельствует
о том, что нулевому слою по умолчанию соответствуют сплошные (continuous)
линии цвета белый (White).

Слева от столбца Цвет (Color) расположено три столбца: Вкл (On), Заморо�
зить (Freeze) и Блокировать (Lock). Пиктограммы, представленные в каче�
стве значений параметров конкретного слоя для соответствующего столбца,
позволяют судить о текущих свойствах слоя. О том, как использовать и изме�
нять эти параметры, мы поговорим далее в этой главе, а об остальных столбцах
(Вес линий (Lineweight), Стиль печати (Plot Style) и Печать (Plot)) – в главе 14,
посвященной выводу чертежей на печать. В столбце Пояснение (Description)
можно задавать описание слоя, объясняющее его назначение и (или) особенно�
сти использования.

Создадим девять новых слоев, назовем их и выберем для них цвет линий.
1. Щелкните на кнопке  Создать слой (New) или нажмите Alt+Д. В спис�

ке появится новый слой с именем Слой1 (Layer1). Имя нового слоя будет
выделено, что позволит сразу же переименовать его.

2. Введите Âûñîòà 1276. Название Слой1 (Layer1) изменится на Высота
1276 и по�прежнему будет выделено (рис. 6.4).

мер цвета (Index Color) этого диалогового окна (рис. 6.5) и введите
в строке Цвет (Color) значение 164, после чего текущим станет темно�
синий цвет.

Рис. 6.4  Новому слою присвоено имя Высота 1276

3. Щелкните на слове белый (White), находящемся на пересечении столб�
ца Цвет (Color) и строки Высота 1276. На экране появится диалоговое
окно Выбор цвета (Select Color). Перейдите, если нужно на вкладку Но�

Рис. 6.5  Вкладка Номер цвета (Index Color)
диалогового окна Выбор цвета (Select Color)

4. Щелкните на кнопке OK. Диалоговое окно Выбор цвета (Select Color)
закроется, а в списке слоев диалогового окна Диспетчер свойств слоев
(Layer Properties Manager) квадратик, обозначающий цвета слоя Высота
1276 также изменит свой цвет на темно�синий.

Примечание. Поскольку эта книга предназначена для черно�белой печати, автор
здесь и далее будет выбирать темные оттенки цветов (в противном случае рас�
смотреть на иллюстрациях объекты, слоям которых назначены светлые цвета,
будет либо затруднительно, либо вообще невозможно). Вы можете выбирать те
цвета, которые вам нравятся – цвет слоя не влияет ни на что, кроме его восприя�
тия. В последней главе этой книги вы узнаете, как можно отключить цвет, чтобы
получить качественное изображение при печати на черно�белых принтерах.

На вкладке Номер цвета (Index Color) диалогового окна Выбор цвета (Se�
lect Color), помимо девяти стандартных цветов, представленных в виде распо�
ложенной под основной палитрой полосы, можно выбрать одну из шести гра�
даций серого, задать два логических цвета (черный (Black) и белый (White)),
а также выбрать любой цвет из 256 цветов полной палитры либо ввести его
значение (индекс) в 256�цветной палитре. Цвета с индексами от 1 до 7 (первые
семь стандартных цветов) имеют собственные имена. Это означает, что их
можно выбирать, как вводя в строке Цвет (Color) индекс, так и имя (красный
(red), желтый (yellow) и т. д.). Остальные цвета (с 8 по 255) различаются по
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номерам. Цвет с индексом 7 называется White, но его цвет назначается в зави�
симости от того, какой цвет используется в качестве фонового.

Примечание. Если вам недостаточно 256�цветной палитры, можете перейти
на вкладку Вся палитра (TrueColor) и выбрать любой из цветов, определяемых
возможностями видеоконтроллера вашего ПК. Однако на практике выбирать
цвета с помощью вкладки Вся палитра (TrueColor) имеет смысл только в тех
случаях, когда вы создаете трехмерные модели с применением тонирования по
методу Гуро или Фонга. То же самое относится и к цветам, которые можно выб�
рать на вкладке Альбомы цветов (Color Books) – их также имеет смысл приме�
нять при трехмерном моделировании в тех случаях, когда объекты того или ино�
го слоя должны иметь цвет, точно заданный с помощью одного из стандартных
каталогов (PANTONE, RAL и т. п.).

При черчении на плоскости в подавляющем большинстве случаев достаточ�
но стандартной палитры, поэтому в дальнейшем мы будем использовать только
вкладку Номер цвета (Index Color).

Теперь вернемся к стоящей перед нами задаче создания слоев и назначения
им соответствующих цветов.

1. Щелкните на кнопке Создать слой (New) диалогового окна Диспетчер
свойств слоев (Layer Properties Manager), чтобы добавить новый слой.

2. Переименуйте новый слой на Высота 758.
3. Щелкните на квадратике цвета в строке, соответствующей слою Высота

758. В появившемся диалоговом окне Выбор цвета (Select Color) введите
в строке Цвет (Color) значение 144 (темно�зеленый цвет), после чего
щелкните на кнопке OK (рис 6.6).

4. Повторите пп. 1–3 для всех остальных слоев, назначив им цвета в соот�
ветствии с табл. 6.1.

Таблица 6.1. Параметры основных слоев вида сверху

Название слоя Цвет

Высота 622 126
Высота 320 56
Высота 18 24
Высота 720 155
Высота 1036 185
Высота 1188 234
Высота 1358 204

Рис. 6.6  Диалоговое окно Выбор цвета (Select Color)
Рис. 6.7  В списке диалогового окна Диспетчер свойств слоев

(Layer Properties Manager) перечислены девять новых слоев и нулевой слой

Примечание. Как отмечалось выше, автор выбирает цвета слоев с учетом черно�
белой печати иллюстраций этой книги. Вы можете выбирать другие цвета по
своему усмотрению.

После завершения этой операции в списке должны быть перечислены на�
звания десяти слоев и соответствующие им цвета (рис. 6.7). Всем слоям по
умолчанию назначен тип линии Continuous. В нашем случае так и должно
быть, поскольку мы не будем показывать на чертеже невидимые линии. Исклю�
чение сделаем лишь для системного блока – на слоях Высота 622 и Высота 720
мы покажем его контуры, скрытые крышкой тумбы системного блока, с помо�
щью штриховой линии.
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6.1.2.6.1.2.6.1.2.6.1.2.6.1.2. ИзменениеИзменениеИзменениеИзменениеИзменение типатипатипатипатипа линиилиниилиниилиниилинии
При выборе цвета слоя пользователь волен выбирать любой цвет, отображае�
мый в окне Выбор цвета (Select Color). Однако назначение типов линий – не�
много более сложный процесс. В любом новом чертеже пользователь по умол�
чанию может использовать два типа линий – непрерывные (Continuous) и
пунктирные (DOT). Все остальные типы линий нужно загружать из внешнего
файла.

1. Для начала создайте еще два слоя с именами СБлок Н и СБлок П и на�
значьте обоим слоям одинаковый цвет (автор использует цвет с индек�
сом 224).

2. Щелкните на слове Continuous в строке слоя СБлок П, что приведет
к открытию диалогового окна Выбор типа линий (Select Linetype)
(рис. 6.8). Как видите, в списке Загруженные типы линий (Loaded line�
types) отображается стандартный типа линий: Continuous.

6.1.3.6.1.3.6.1.3.6.1.3.6.1.3. НазначениеНазначениеНазначениеНазначениеНазначение слояслояслояслояслоя текущимтекущимтекущимтекущимтекущим ввввв окнеокнеокнеокнеокне
«Диспетчер«Диспетчер«Диспетчер«Диспетчер«Диспетчер свойствсвойствсвойствсвойствсвойств слоев»слоев»слоев»слоев»слоев» (Layer(Layer(Layer(Layer(Layer PropertiesPropertiesPropertiesPropertiesProperties Manager)Manager)Manager)Manager)Manager)
В верхней части диалогового окна Диспетчер свойств слоев (Layer Properties
Manager)  над списком слоев находится, кроме уже рассмотренной выше кноп�
ки Создать слой (New Layer) и кнопки Удалить слой (Delete Layer), с помощью

Рис. 6.8  Диалоговое окно Выбор типа линий (Select Linetype)
со стандартным типом линий

3. Щелкните на кнопке Загрузить (Load), которая находится в нижней час�
ти окна Выбор типа линий (Select Linetype). На экране появится диало�
говое окно  Загрузка/перезагрузка типовой линии (Load or Reload Line�
types), в списке Доступные типы линий (Available Linetypes) которого
перечислены все типы линий, определенные в файле acadiso.lin (рис. 6.9).

4. Щелкните в этом списке на элементе ACAD_ISO02W100, как показано на
рис. 6.9, а затем щелкните на кнопке OK.

5. Вернувшись в диалоговое окно Выбор типа линий (Select Linetype), вы
увидите, что теперь в списке Загруженные типы линий (Loaded line�
types) этого окна, кроме стандартных типов линий, появился только что
выбранный вами тип. Выберите его и щелкните на кнопке OK. В диало�
говом окне Диспетчер свойств слоев (Layer Properties Manager) слою
СБлок П будет присвоен тип линии ACAD_ISO02W100 (рис. 6.10).

Рис. 6.9  Выбор типа линии в окне
Загрузка/перезагрузка типовой линии (Load or Reload Linetypes)

Рис. 6.10  Слою СБлок Н назначен тип линии Continuous,
а слою СБлок П – ACAD_ISO02W100
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которой можно удалить ненужный слой, кнопка  Установить (Set Current).
С помощью этой кнопки любой слой, выделенный в списке слоев окна Диспет�
чер свойств слоев (Layer Properties Manager), можно назначить текущим. По
умолчанию текущим является нулевой слой, о чем можно судить по наличию
зеленой «галочки» рядом с названием слоя в списке слоев, а также по указанию
названия слоя в текстовой области Текущий слой (Current layer), расположен�
ной справа от кнопки Установить (Set Current) (см. рис. 6.10).

Текущим в чертеже может быть только один слой. Если вы назначите теку�
щим другой слой, предыдущий слой перестанет быть текущим и будет рассмат�
риваться AutoCAD наравне с остальными слоями. Смысл назначения слоя теку�
щим заключается в том, что все объекты, создаваемые в области черчения,
всегда размещаются на текущем слое и, соответственно, приобретают те свой�
ства (цвет и ширина линий, тип линий, видимость и т. п.), которые назначены
текущему слою.

1. Выберите в списке слой Высота 720 и щелкните на кнопке Установить
(Set Current) или нажмите Alt+C. Текущим станет слой Высота 720 (ря�
дом с его названием появится зеленая «галочка»), а в текстовой области
Текущий слой (Current layer) будет выведено его название.

2. Щелкните на кнопке OK для закрытия диалогового окна Диспетчер
свойств слоев (Layer Properties Manager).

3. В области черчения видимых изменений не произошло (рис. 6.11). Одна�
ко если вы посмотрите на раскрывающийся список слоев, расположен�
ный на панели инструментов Слои (Layers) (см. рис. 6.2 и рис. 6.11), то
заметите, что содержимое текущего элемента этого списка изменилось –
вместо свойств слоя 0, которые отображались в этом списке до открытия
окна Диспетчер свойств слоев (Layer Properties Manager), теперь в нем
отображаются свойства слоя Высота 720.

Однако на самом чертеже ничего не изменилось, поскольку все объекты по�
прежнему находятся на нулевом слое. Что ж, давайте займемся расположением
объектов по слоям. Кстати, используемый по умолчанию во всех чертежах ну�
левой слой как нельзя лучше подходит к нашей задаче – мы будем считать, что
он соответствует уровню пола, то есть высоте 0 мм. На этом слое мы оставим
только габаритные линии рабочей зоны, а все остальные объекты разнесем на
соответствующие слои.

6.2.6.2.6.2.6.2.6.2. РаспределениеРаспределениеРаспределениеРаспределениеРаспределение объектовобъектовобъектовобъектовобъектов чертежачертежачертежачертежачертежа попопопопо слоямслоямслоямслоямслоям
Для того чтобы распределить объекты по слоям, мы будем сначала выделять
их, используя все изученные в предыдущих главах методы выделения объектов
чертежа, а затем назначать их соответствующему слою. Выполнение послед�
ней операции мы проведем как с использованием списка слоев панели инстру�
ментов Слои (Layers), так и с помощью специализированных инструментов
панели Слои II (Layers II).

6.2.1.6.2.1.6.2.1.6.2.1.6.2.1. ИспользованиеИспользованиеИспользованиеИспользованиеИспользование спискаспискаспискаспискасписка слоевслоевслоевслоевслоев
панелипанелипанелипанелипанели инструментовинструментовинструментовинструментовинструментов «Слои»«Слои»«Слои»«Слои»«Слои» (Layers)(Layers)(Layers)(Layers)(Layers)
Для назначения объектов текущему слою с помощью списка слоев панели инст�
рументов Слои (Layers) следует, выделив их, выбрать текущий слой из списка
слоев. Давайте проделаем это на практике.

1. С помощью пересекающей рамки (рис. 6.12) выделите две горизонталь�
ные линии, контура задней боковой стенки рабочей зоны.

2. Проделайте аналогичную операцию с двумя вертикальными линиями
контура левой боковой стенки. Все четыре линии будут выделены, о чем
можно будет судить о наличии маркеров выделения (рис. 6.13).

3. Обратите внимание на список свойств слоев панели инструментов Слои
(Layers) – сейчас в нем должен отображаться не текущий слой Высота 720,
а слой 0. Это нормально – слой Высота 720 по�прежнему остается теку�
щим, однако в том случае, если на чертеже имеются выделенные объек�
ты, AutoCAD отображает в списке слоев свойства того слоя, к которому
принадлежат эти объекты. Поскольку в данном случае выделенные ли�
нии принадлежат слою 0, в списке слоев отображаются свойства именно
этого слоя. Если же выделенные объекты принадлежат разным слоям
(а это достаточно типичная ситуация), тогда список остается пустым.

Рис. 6.11  Свойства текущего слоя Высота 720
отображаются в списке слоев панели Слои (Layers)
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4. Раскройте список свойств слоев панели инструментов Слои (Layers) и
выберите из него строку, в которой отображаются свойства слоя Высота
720. Как только вы щелкните на этой строке, список автоматически за�
кроется. На экране ничего не изменится (линии по�прежнему останутся
выделенными), однако в списке вместо свойств слоя 0 появятся свойства
слоя Высота 720. Поскольку, как было сказано выше, в списке отобража�
ются свойства того слоя, на котором находятся выделенные объекты,
это означает, что теперь выделенные вами линии находятся на слое Вы�
сота 720, а не на слое 0. Таким образом, задача решена.

5. Нажмите Esc, чтобы снять выделение. Для завершения операции нужно
переместить на слой Высота 720 правую вертикальную линию контура

задней стенки. Охватите рамкой выделения область, в которой находит�
ся нужная нам линия, как показано на рис. 6.14, следя за тем, чтобы рамка
выделения полностью охватила только вертикальную линию.

Рис. 6.12  Для выделения обоих горизонтальных линий задней стенки
используется пересекающая рамка

Рис. 6.13  Выделены две горизонтальные и две вертикальные линии

Рис. 6.14  Использование рамки выделения
для выделения правой вертикальной границы контура задней стенки

6. Охватив нужную область рамкой выделения, как показано на рис. 6.14,
и щелкнув мышью, раскройте список свойств слоев панели инструмен�
тов Слои (Layers) и выберите из него слой Высота 720 для перемещения
выделенной вертикальной линии со слоя 0 на слой Высота 720.

7. Нажмите Esc для снятия выделения.
Как видите, операция перемещения объектов на нужный слой достаточно

проста. Мы продолжим выполнять ее по отношению к другим объектам, при�
меняя не только список свойств слоев, но и другие инструменты AutoCAD.

6.2.2.6.2.2.6.2.2.6.2.2.6.2.2. ИспользованиеИспользованиеИспользованиеИспользованиеИспользование инструментаинструментаинструментаинструментаинструмента
«Cменить«Cменить«Cменить«Cменить«Cменить нанананана текущийтекущийтекущийтекущийтекущий слой»слой»слой»слой»слой» (Change(Change(Change(Change(Change tototototo CurrentCurrentCurrentCurrentCurrent Layer)Layer)Layer)Layer)Layer)
Помимо списка слоев перемещать выделенные объекты на текущий слой мож�
но с помощью инструмента Cменить на текущий слой (Change to Current Layer)
панели инструментов Слои II (Layers II).

1. Охватите рамкой выделения контур порога, как показано на рис. 6.15.
При этом будьте внимательны, чтобы внутри рамки выделения не оказа�
лись целиком другие объекты! Если после второго щелчка мышью ока�
жутся выделенными элементы чертежа монитора, нажмите Esc для сня�
тия выделения и повторите все сначала.

2. Выделив контур порога, щелкните на контуре подставки под клавиатуру,
вертикальной и горизонтальной линии нижней угловой полки (с шири�
ной в прямолинейной части 400 мм), вертикальной и диагональной ли�
нии верхней угловой полки (с шириной в прямолинейной части 200 мм),
а также дугах радиусом 400 мм, обозначающих контуры округленных по�
лок. Объекты чертежа должны иметь вид, представленный на рис. 6.16.
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3. Щелкните на кнопке  Cменить на текущий слой (Change to Current
Layer) панели инструментов Слои II (Layers II) или выберите из меню
команду Формат ⇒ Инструменты слоя ⇒ Cменить на текущий слой
(Format ⇒ Layer tools ⇒ Change to Current Layer) либо введите в команд�
ном окне команду Ñëîé (LAYCUR). Все 13 выделенных объектов будут пе�
ремещены на текущий слой (то есть Высота 720), о чем AutoCAD сообщит
вам в командном окне, после чего выделение будет автоматически снято.

4. Выделите с помощью пересекающей рамки все шесть опор. При выделе�
нии выбирайте расположение пересекающей рамки так, чтобы гаранти�
ровано пересечь все три окружности, образующих чертеж каждой опо�

ры, но при этом не задеть никаких других объектов, например, как пока�
зано на рис. 6.17.

Рис. 6.15  Использование рамки выделения для выделения контура порога

Рис. 6.16  Набор выделенных объектов для перемещения на слой Высота 720

Рис. 6.17  Использование пересекающей рамки
для выделения шестой опоры

5. Снова воспользовавшись командой Ñëîé (LAYCUR), переместите все
контуры опор на текущий слой Высота 720.

Дальнейший выбор объектов, который должны находиться на слое Высота
720, затруднен, поскольку они закрыты другими объектами. Кроме того, рабо�
тать в таком режиме с чертежом не очень удобно (особенно если вы придержи�
ваетесь той же цветовой схемы, которой вынуждена придерживаться автор) –
объекты, перемещенные на другой слой, все равно остаются на чертеже. Нако�
нец, некоторые линии, присутствующие на слое Высота 720, нам придется об�
резать, чтобы избавиться от эффекта «прозрачности». Однако на других слоях
эти линии должны остаться в исходном виде.

Для решения всех этих проблем вам нужно научиться управлять видимос�
тью слоев, а также не только перемещать, но и копировать объекты с одного
слоя на другой.

6.3.6.3.6.3.6.3.6.3. СозданиеСозданиеСозданиеСозданиеСоздание новыхновыхновыхновыхновых объектовобъектовобъектовобъектовобъектов
ссссс использованиемиспользованиемиспользованиемиспользованиемиспользованием слоевслоевслоевслоевслоев
Рассмотрим подробнее создание новых объектов с использованием слоев.

6.3.1.6.3.1.6.3.1.6.3.1.6.3.1. УУУУУправлениеправлениеправлениеправлениеправление видимостьювидимостьювидимостьювидимостьювидимостью слоевслоевслоевслоевслоев
ссссс помощьюпомощьюпомощьюпомощьюпомощью замораживаниязамораживаниязамораживаниязамораживаниязамораживания
Для того чтобы слой (и, соответственно, находящиеся на нем объекты) стал
невидимым, в AutoCAD его нужно либо заморозить (freeze), либо отключить
(turn off). С точки зрения привычной терминологии было бы проще отключать
слои. Тем не менее, мы будем не отключать их, а замораживать. Дело в том, что
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объекты, находящиеся на отключенных слоях, оставаясь сами невидимы, мо�
гут скрывать под собой другие объекты. При черчении на плоскости это не
имеет существенного значения, однако, во�первых, отключение слоев не
уменьшает расходы на прорисовку изображения чертежа, что может быть су�
щественно при создании сложных чертежей, а во�вторых, вам нужно выраба�
тывать правильные навыки применения AutoCAD. Именно поэтому мы будем
в дальнейшем применять замораживание слоев.

Замораживать слои можно с помощью диалогового окна Диспетчер свойств
слоев (Layer Properties Manager), раскрывающегося списка слоев панели инст�
рументов Слои (Layers), а также инструмента Заморозить слой (Layer Freeze)
панели инструментов Слои II (Layers II).

1. Щелкните на кнопке Диспетчер свойств слоев (Layer Properties Mana�
ger) панели инструментов Слои (Layers) или выберите из меню команду
Формат ⇒ Слой (Format ⇒ Layer) либо введите в командном окне Ñëîé
(LAYER) или просто ñë (LA). В открывшемся окне Диспетчер свойств
слоев (Layer Properties Manager) вы увидите перечень всех слоев, при�
чем отсортированный не в порядке их создания, а по алфавиту.

2. Щелкните на слое СБлок Н, а затем, нажав и удерживая Shift, щелкните
на слое СБлок П. (В данном случае, поскольку нам нужно выделить всего
два слоя, можно было также перед щелчком на втором слое нажать и
удерживать Ctrl.)

3. Переместите указатель на столбец Заморозить (Freeze), в котором нахо�
дятся пиктограммы в виде «солнышек».

4. Щелкните на «солнышке» в любой из двух выделенных строк. «Солныш�
ки» исчезнут, а вместо них появятся «снежинки» (рис. 6.18).

5. Щелкните на кнопке OK для закрытия окна Диспетчер свойств слоев
(Layer Properties Manager).

6. Охватите окном масштабирования контур системного блока и измените
масштаб изображения так, чтобы хорошо видеть системный блок.

7. Последовательно щелкните на всех элементах чертежа, обозначающих
контур системного блока (пять линий и две дуги), чтобы получить резуль�
тат, представленный на рис. 6.19.

8. Раскройте список слоев панели Слои (Layers) и выберите из него слой
СБлок Н (обратите внимание на пиктограммы «снежинок», которые
отображаются в этом списке для слоев СБлок Н и СБлок П), как показа�
но на рис. 6.19.

9. AutoCAD отобразит сообщение о том, что вы переместили 7 объектов на
замороженный или отключенный слой, вследствие чего эти объекты бу�
дут удалены из текущего набора выделенных объектов. Щелкните в этом
окне на кнопке OK.

10. Контур системного блока исчезнет с чертежа. Восстановите предыду�
щий масштаб черчения.

11. Раскройте список слоев панели инструментов Слои (Layers) и щелкните
на пиктограмме «снежинки» в строке СБлок Н. Вместо «снежинки» по�

Рис. 6.18  Пиктограмма «снежинки» в свойствах слоя
говорит о том, что слой заморожен

Рис. 6.19  Перемещение на слой СБлок Н семи выделенных объектов, образующих контур
системного блока
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явится «солнышко» – это означает, что слои можно замораживать и раз�
мораживать и с помощью списка слоев панели Слои (Layers). Правда, так
можно заморозить или разморозить только один слой – использовать
нажатие Shift и Ctrl для выбора нескольких слоев в списке нельзя.

12. Щелкните в любом месте области черчения для закрытия списка, и на
чертеже тут же появится контур системного блока, цвет линий которого
будет соответствовать цвету линий слоя СБлок Н.

13. Щелкните на кнопке  Заморозить слой (Layer Freeze) панели инстру�
ментов Слои II (Layers II) или выберите из меню команду Формат ⇒
Инструменты слоя ⇒ Заморозить слой (Format ⇒ Layer tools ⇒ Layer
Freeze) либо введите в командном окне команду Ñëîèçàì (LAYFRZ).

14. AutoCAD предложит в командном окне щелкнуть на объекте, который
находится на слое, подлежащем замораживанию. Щелкните на любой
линии контура системного блока. Поскольку все линии контура систем�
ного блока находятся на слое СБлок Н, этот слой будет тут же заморо�
жен, а контур системного блока перестанет отображаться на чертеже.

15. Нажмите Enter для завершения команды Ñëîèçàì (LAYFRZ).
Таким образом, с помощью инструмента Заморозить слой (Layer Freeze) па�

нели инструментов Слои II (Layers II) можно заморозить слой, представлен�
ный как минимум одним объектом на чертеже. С помощью списка слоев панели
инструментов Слои (Layers) можно как заморозить, так и разморозить любой
слой чертежа, а с помощью диалогового окна Диспетчер свойств слоев (Layer
Properties Manager) можно заморозить или разморозить не только любой слой,
но и произвольное количество слоев.

Внимание. Заморозить текущий слой нельзя – при попытке выполнения такой
операции AutoCAD открывает окно с соответствующим сообщением и не выпол�
няет операцию замораживания текущего слоя.

Продолжим «очистку» чертежа от «лишних» объектов.
1. Раскройте список слоев панели инструментов Слои (Layers) и заморозь�

те слой Высота 1188.
2. Последовательно выделите контуры оборудования (сканера, дисплея и

лампы), а также полочек стоек для компакт�дисков (рис. 6.20).
3. Снова раскройте список слоев панели инструментов Слои (Layers) и щел�

кните на названии слоя Высота 1188. На экране появится диалоговое
окно с сообщением о том, что 38 выделенных объекта будут перемещены
на замороженный слой. Щелкните на кнопке OK для закрытия этого
окна. Все выделенные объекты перестанут отображаться на чертеже.

Примечание. Если в вашем случае количество объектов, перемещаемых на заморо�
женный слой, в сообщении AutoCAD будет меньше, чем 38, найдите оставшиеся
объекты (скорее всего – это 4 коротких диагональных отрезка, которые находят�
ся в углах чертежа сканера), выделите их, а затем повторите операцию переме�
щения выделенных объектов на замороженный слой Высота 1188.

4. Заморозьте слой Высота 320 и переместите на него объекты, показан�
ные на рис. 6.21 (две боковые стенки малой тумбы, боковые стенки тум�
бы системного блока и большой тумбы, фасад большой тумбы и горизон�
тальная линия контура полки парты).

5. Щелкните на каком�нибудь объекте, который все еще находится на нуле�
вом слое (например, на одной из габаритных линий), а затем щелкните
на кнопке Сделать слой объекта текущим (Make Object’s Layer Current)

Рис. 6.20  Объекты, подлежащие перемещению на слой Высота 1188

Рис. 6.21  Объекты, подлежащие перемещению на слой Высота 320
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панели инструментов Слои (Layers) или выберите из меню команду Фор�
мат ⇒ Инструменты слоя ⇒ Сделать слой объекта текущим (Format ⇒
Layer tools ⇒ Make Object’s Layer Current) либо введите в командном окне
Слойтек (LAYMCUR).

6. Текущим станет снова нулевой слой, о чем можно будет судить по изме�
нившемуся состоянию списка слоев панели инструментов Слои (Layers),
а также по сообщению, выведенном AutoCAD в командном окне. Замо�
розьте слой Высота 720.

7. Нажмите Ctrl+A или выберите из меню команду Правка ⇒ Выбрать все
(Edit ⇒ Select All) для выделения всех объектов чертежа.

8. Нажмите Shift и, удерживая ее нажатой, охватите рамкой выделения
контуры вырезов под ручки, которые находятся посредине контуров фа�
садов тумб и выдвижного ящика парты. Поскольку при выделении вы
удерживаете Shift, выделенные объекты будут не добавляться в набор,
а удаляться из него.

9. Продолжая удерживать Shift, щелкните на двух габаритных линиях рабо�
чей зоны для удаления их из набора выделенных объектов.

10. Получив набор выделенных объектов, представленный на рис. 6.22, отпус�
тите Shift и переместите все выделенные объекты на слой Высота 720.

Итак, основная задача решена – мы получили чертеж, в первом приближе�
нии соответствующий виду сверху на рабочую зону на высоте 720 мм. Теперь
нам предстоит заняться деталями, а затем мы перейдем к «наполнению» ос�
тальных слоев.

6.3.2.6.3.2.6.3.2.6.3.2.6.3.2. ИнструментИнструментИнструментИнструментИнструмент «Копировать«Копировать«Копировать«Копировать«Копировать объектыобъектыобъектыобъектыобъекты ввввв новыйновыйновыйновыйновый слой»слой»слой»слой»слой»
(Copy(Copy(Copy(Copy(Copy ObjectsObjectsObjectsObjectsObjects tototototo NewNewNewNewNew Layer)Layer)Layer)Layer)Layer)
Проанализировав рис. 6.23, можно придти к выводу о том, что на нашем черте�
же имеются три проблемные зоны:

«прозрачная» подставка под клавиатуру;
«прозрачный» порожек;
отсутствующая нижняя горизонтальная линия контура боковой стенки
рабочей зоны.

Последняя проблемная зона, конечно же, по�настоящему проблемной не
является, поэтому мы на ней даже не будем останавливаться. Однако прежде
чем устранять остальные проблемы, разморозьте слой СБлок Н. Как только
контур системного блока появится на чертеже, вы поймете, что у нас стало на
одну проблемную зону больше. Вот с нее мы и начнем.

1. Измените с помощью инструмента Окно зумирования (Zoom Window)
масштаб изображения так, чтобы контур системного блока занимал по�
чти всю область черчения. Как вы помните, мы создали еще один слой
СБлок П, на котором должны находиться те части контура системного
блока, которые скрыты другими объектами чертежа (подставка под кла�
виатуру и крышка системного блока). Это означает, что нам нужно ско�
пировать объекты слоя СБлок Н на слой СБлок П.

Рис. 6.22  Объекты, подлежащие перемещению на слой Высота 720

11. На экране должны остаться только три прямоугольных контура вырезов
под ручки и две габаритные линии рабочей зоны.

12. Разморозьте слой Высота 720 и назначьте его текущим, а затем заморозь�
те слой 0. Чертеж должен приобрести вид, показанный на рис. 6.23.

13. Сохраните текущее состояние чертежа в файле Work061.dwg.

Рис. 6.23  Объекты, оставшиеся на слое Высота 720,
после разнесения объектов по слоям
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2. Выделите все элементы, образующие контур системного блока (5 отрез�
ков и 2 дуги) любым удобным для вас способом (например, последова�
тельно щелкните на каждом из элементов).

3. Щелкните на кнопке  Копировать объекты в новый слой (Copy Ob�
jects to New Layer) панели инструментов Слои II (Layers II) или выберите
из меню команду Формат ⇒ Инструменты слоя ⇒ Копировать объекты
в новый слой (Format ⇒ Layer tools ⇒ Copy Objects to New Layer) либо вве�
дите в командном окне команду Êîïèÿâñëîè (COPYTOLAYER).

4. AutoCAD предложит выбрать любой объект на том слое, на который мы
хотим скопировать выделенные объекты. Поскольку, во�первых, слой
СБлок П заморожен, а во�вторых, на нем пока еще нет ни одного объек�
та, воспользоваться этим предложением вы не сможете. Поэтому вклю�
чите режим выбора слоя по имени, нажав Enter либо введя в командном
окне èìÿ (NAME).

5. В списке слоев появившегося диалогового окна Копировать в слой (Copy
To Layer) выберите слой СБлок П (рис. 6.24) и щелкните на кнопке OK.

8. Обрежьте все линии контура системного блока, оставив на чертеже лишь
те фрагменты, которые представляют границы контура, находящиеся
под крышкой тумбы системного блока и клавиатурой (рис. 6.26). Часть
объектов можно просто удалить, а часть нужно обрезать, используя две
горизонтальные линии контура крышки системного блока в качестве се�
кущих.

Рис. 6.24  Диалоговое окно
Копировать в слой (Copy To Layer)

6. AutoCAD сообщит в командном окне о том, что 7 выделенных объектов
были скопированы на слой СБлок П и предложит выбрать базовую точку
либо завершить работу команды Êîïèÿâñëîè (COPYTOLAYER). По�
скольку нас в данном случае не интересует копирование объектов со сме�
щением от исходного положения, просто нажмите Enter для завершения
команды Êîïèÿâñëîè (COPYTOLAYER).

7. Заморозьте слой СБлок Н и разморозьте слой СБлок П. Вы не только
убедитесь в том, что на этом слое появился контур системного блока, но
и в том, что образующим его объектам был автоматически назначен выб�
ранный при создании этого слоя тип прерывистой (штриховой) линии
(рис. 6.25).

Рис. 6.25  Объекты слоя СБлок П автоматически отображаются штриховыми линиями

Рис. 6.26  На слое СБлок П должны остаться две вертикальные линии и левая дуга
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9. Заморозьте слой СБлок П и разморозьте слой СБлок Н, а затем удалите
левую дугу и обрежьте те части вертикальных линий, которые находятся
внутри контура крышки системного блока.

10. Разморозьте слой СБлок П. Теперь объекты обоих слоев дополняют друг
друга, образуя контур системного блока, часть элементов которого ото�
бражается штриховыми линиями, как это и должно быть при изображе�
нии на чертеже объектов, скрытых другими объектами (рис. 6.27).

штрихи и пробелы между ними слишком короткие, поэтому отдельные штрихи
при большом масштабе сливаются в сплошную линию.

6.3.3.6.3.3.6.3.3.6.3.3.6.3.3. НастройкаНастройкаНастройкаНастройкаНастройка масштабамасштабамасштабамасштабамасштаба линиилиниилиниилиниилинии
Штриховые линии отображаются с использованием так называемого коэффици�
ента масштабирования (scale factor), который по умолчанию равен 1. В AutoCAD
поддерживается как глобальный коэффициент масштабирования, влияющий
на отображение всех штриховых линий чертежа, так и локальный коэффици�
ент масштабирования для каждого отдельного объекта. Последний по умолча�
нию также равен 1, но в том случае, когда для какого�то объекта он изменяется,
эффективный коэффициент масштабирования для такого объекта определяет�
ся путем умножения глобального коэффициента на установленное пользовате�
лем значение локального коэффициента. Такой подход позволяет гибко на�
страивать все штриховые линии чертежа.

Поскольку в нашем случае нет необходимости менять локальный коэффи�
циент масштабирования, мы просто изменим глобальный коэффициент сразу
для всех штриховых линий чертежа, увеличив длину штрихов и промежутков
между ними в 5 раз.

1. Введите в командном окне команду ëìàñøòàá (LTSCALE) или просто ëìø
(LTS).

2. AutoCAD предложит ввести новое значение или, нажав Enter, оставить
текущее значение без изменений. Введите 5.

3. Вид контура системного блока изменится, поскольку штрихи станут раз�
личимыми (рис. 6.28). Если вас не устраивает выбранный масштабный
коэффициент, можете попробовать задать другое значение (например,
4, 4.5 или 5.5).

Рис. 6.27  На слое СБлок П должны остаться две вертикальные линии и левая дуга

11. Теперь нужно убрать округленную часть полки тумбы системного блока,
которая «видна» сквозь контур «прозрачного» системного блока. Скорее
всего, вы уже понимаете, что нужно сделать, поэтому мы не будем деталь�
но останавливаться на этой задаче: скопируйте горизонтальный отрезок
и дугу полки, пересекающие контур системного блока, на слой Высота
320 (они нам пригодятся в дальнейшем), а затем обрежьте исходные
объекты слоя Высота 720, используя вертикальные линии контура сис�
темного блока в качестве секущих.

12. Закончив с контуром системного блока, давайте попутно решим еще
одну небольшую проблему. Не изменяя масштаба просмотра, щелкните
на линии контура нижней угловой полки, которая «видна» сквозь контур
«прозрачного порожка» и переместите ее на нулевой слой.

13. Щелкнув на кнопке OK в появившемся окне сообщения о перемещении
одного объекта на замороженный слой, восстановите предыдущий масш�
таб просмотра с помощью инструмента Зумировать предыдущий (Zoom
Previous).

После восстановления масштаба вы увидите, что штриховые линии контура
системного блока снова стали пунктирными. Этот эффект вызван тем, что Рис. 6.28  Штрихи после настройки глобального масштабного коэффициента
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6.3.4.6.3.4.6.3.4.6.3.4.6.3.4. СозданиеСозданиеСозданиеСозданиеСоздание объектовобъектовобъектовобъектовобъектов нанананана слояхслояхслояхслояхслоях путемпутемпутемпутемпутем копированиякопированиякопированиякопированиякопирования
Теперь мы займемся устранением эффекта «прозрачности» подставки для кла�
виатуры в зоне наложения ее контура на контур малой тумбы.

1. Измените масштаб просмотра так, чтобы проблемная зона занимала всю
область черчения.

2. С помощью пересекающей рамки выделите все три объекта, которые по�
падают внутрь контура подставки для клавиатуры (прямоугольник фаса�
да малой тумбы, вертикальная линия прямолинейного участка нижней
угловой полки и верхняя горизонтальная линия контура малой тумбы).

3. С помощью инструмента Копировать объекты в новый слой (Copy Ob�
jects to New Layer) скопируйте выделенные объекты на слой Высота 320.
(Поскольку этот слой заморожен, нажмите Enter в ответ на приглаше�
ние AutoCAD и выберите нужный слой в списке диалогового окна Копи�
ровать в слой (Copy To Layer).)

4. Обрежьте линии, попадающие внутрь контура подставки для клавиату�
ры, используя в качестве секущей прямоугольник контура.

5. Восстановите предыдущий масштаб просмотра.
Для завершения работы над объектами слоя Высота 720 осталось выпол�

нить небольшую операцию – создать нижнюю горизонтальную линию контура
боковой стенки рабочей зоны. Решите эту задачу самостоятельно любым удоб�
ным для вас способом. (Например, можно разморозить нулевой слой, скопи�
ровать горизонтальную габаритную линию на слой Высота 720, затем снова
заморозить нулевой слой и обрезать полученную горизонтальную линию по
вертикальной линии контура боковой стенки рабочей зоны.) Полученный ре�
зультат должен быть таким, как показано на рис. 6.29.

Теперь, применяя уже изученные вами инструменты, самостоятельно со�
здайте остальные объекты, которые должны находиться на слоях Высота 320
(рис. 6.30) и Высота 18 (рис. 6.31).

6.3.5.6.3.5.6.3.5.6.3.5.6.3.5. КопированиеКопированиеКопированиеКопированиеКопирование объектовобъектовобъектовобъектовобъектов сососососо слояслояслояслояслоя нанананана слойслойслойслойслой
сососососо смещениемсмещениемсмещениемсмещениемсмещением
Как вы убедились, использование копирования объектов со слоя на слой – это
очень удобный и эффективный метод работы со слоями. Давайте продолжим
овладение этим методом, в том числе и применяя копирование со смещением.

Рис. 6.29  Окончательный вид объектов слоя Высота 720

Рис. 6.30  Окончательный вид объектов слоя Высота 320

Рис. 6.31  Окончательный вид объектов слоя Высота 18
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На рис. 6.32 представлены геометрические размеры объектов рабочей
зоны, находящиеся над столешницей на уровне 1090 мм от пола (оборудование
не показано).

пользоваться для повторного запуска
любых команд AutoCAD. Кроме того,
можно использовать список ранее запус�
кавшихся команд Последний ввод (Re�
cent Input), расположенный непосредст�
венно под командой Повторить (Repeat)
(см. рис. 3.33).

Получив базовые линии, можно пе�
рейти к вычерчиванию столешницы. По�
лучить нужный результат, как это часто
бывает в AutoCAD, можно разными спосо�
бами, поэтому вы можете как применить
следующий алгоритм, так и использовать
собственный.

1. Сместите верхнюю горизонтальную линию габаритов рабочей зоны
вниз на 718 мм.

2. Сместите левую вертикальную линию габаритов рабочей зоны вправо на
400 мм.

3. Запустите инструмент С линиями (Line) и выберите с использованием
постоянно действующей объектной привязки в качестве начальной точ�
ки нижнюю точку линии, созданной в п. 2 (рис. 6.34).

Рис. 6.32  Геометрические размеры столешницы
и объектов верхней части рабочей зоны на уровне 1090 мм

Мы начнем с вычерчивания столешницы на слое Высота 758, а затем перей�
дем к созданию расположенных над ней элементов.

1. Назначьте текущим слой Высота 758 и заморозьте все остальные слои,
содержащие объекты, кроме нулевого слоя.

2. Скопируйте на слой Высота 758 вертикальную и горизонтальную габа�
ритные линии рабочей зоны, а затем заморозьте нулевой слой.

3. С помощью команды Ïîäîáèå (OFFSET) сместите вертикальную линию
влево на 3000 мм.

4. Нажмите Enter для завершения команды Ïîäîáèå (OFFSET), а затем
щелкните правой кнопкой мыши в любом свободном месте области чер�
чения.

5. Выберите из появившегося контекстного меню (рис. 6.33) команду По�
вторить ПОДОБИЕ (Repeat OFFSET).

6. AutoCAD автоматически снова запустит команду Ïîäîáèå (OFFSET),
предлагая вам использовать смещение 3000 мм. Задайте смещение 1500 мм
и примените его для смещения нижней горизонтальной линии вверх.

7. Нажмите Enter для завершения команды Ïîäîáèå (OFFSET).

Примечание. Рассмотренный метод запуска команд, основанный на использова�
нии команды Повторить (Repeat) <команда> контекстного меню, может ис�

Рис. 6.33  Использование контекстного меню
для повторного запуска команды

Рис. 6.34  Выбор первой точки линии с использованием
постоянно действующего режима объектной привязки Конточка (Endpoint)
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4. Включите, если нужно, режим ОТС�ПОЛЯР (POLAR), щелкнув на кноп�
ке�индикаторе ОТС�ПОЛЯР (POLAR) в строке состояния.

5. Щелкните на кнопке�индикаторе ОТС�ПОЛЯР (POLAR) правой кнопкой
мыши и выберите из контекстного меню команду Настройка (Settings).
Как вы помните, в предыдущей главы мы выбрали режим отслеживания
полярных углов, кратных 45°. В данном случае нас это не устраивает, по�
этому это значение нужно изменить.

6. На вкладке Отслеживание (Polar Tracking) диалогового окна Режимы
рисования (Drafting Settings) убедитесь в том, что установлен флажок
Полярное отслеживание Вкл (F10) (Polar Tracking On (F10)), а затем
выберите из раскрывающегося списка Шаг углов (Increment angle) груп�
пы Полярные углы (Polar Angle Settings) значение 10. Теперь в режиме
ОТС�ПОЛЯР (POLAR) AutoCAD будет отслеживать значения полярных
углов, кратных 10°.

7. Щелкните на кнопке OK для закрытия диалогового окна Режимы рисо�
вания (Drafting Settings).

8. Поперемещав указатель�перекрестие по экрану, убедитесь в том, что
AutoCAD отслеживает углы, кратные 10°. Добившись такого положения
указателя�перекрестия, которое соответствует величине 70°, перемести�
те указатель в произвольную точку, которая находится выше средней го�
ризонтальной линии (рис. 6.35) и щелкните для создания отрезка, а за�
тем нажмите Enter для завершения команды Îòðåçîê (LINE).

Примечание. Как вы помните, AutoCAD отслеживает углы от направления «на
три часа», поэтому для получения угла, отсчитываемого по часовой стрелке от

направления «на двенадцать часов» (+90°), нужно для получения нужного нам
значения из угла 90° вычесть (по умолчанию направление по часовой стрелке в
AutoCAD считается отрицательным) значение 20°.

9. Запустите команду Ñîïðÿæåíèå (FILLET), измените установленный по
умолчанию радиус сопряжения на 200 мм, а затем выполните сопряже�
ние только что созданной наклонной линии со средней горизонтальной
линией (см. рис. 6.32).

10. Руководствуясь рис. 6.32, повторите два раза команду Ñîïðÿæåíèå (FIL�
LET), выполнив первый раз сопряжение с радиусом 700 мм средней го�
ризонтальной и правой вертикальной линий, а второй раз – с радиусом
400 мм наклонной и нижней горизонтальной линий.

11. Удалите вспомогательную вертикальную линию. Чертеж должен иметь
вид, представленный на рис. 6.36.

Рис. 6.35  Выбор второй точки линии
с использованием режима ОТС?ПОЛЯР (POLAR)

Рис. 6.36  Контур столешницы создан

Теперь нужно вернуться к рис. 6.32 и прокомментировать его. В столешни�
це (в той части, которая находится за дисплеем) выполнено отверстие для вы�
вода кабелей от оборудования к системному блоку компьютера. Это отверстие
закрыто декоративной пластмассовой заглушкой – такие заглушки часто при�
меняются в подобных целях в офисной мебели. Однако с точки зрения черче�
ния, элементы, образующие контуры заглушки, ничем принципиально не отли�
чаются от элементов, образующих контуры нижних опор. Поэтому на рис. 6.32
расположение верхних опор, а также заглушки столешницы (вторая заглушка
находиться на полке принтера) показано относительно расположения средней
опоры большой тумбы (обозначена на рис. 6.32 штриховой линией). Давайте
создадим нужный нам объект и изучим метод копирования объектов со слоя на
слой со смещением.
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1. Разморозьте слой Высота 720 и выделите все три окружности средней
опоры большой тумбы (например, с помощью пересекающей рамки).

2. Запустите инструмент Копировать объекты в новый слой (Copy Ob�
jects to New Layer) или введите в командном окне команду Êîïèÿâñëîè
(COPYTOLAYER).

3. В ответ на приглашении AutoCAD выбрать слой, на который нужно ско�
пировать объекты, щелкните на контуре столешницы.

4. AutoCAD предложит выбрать базовую точку для смещения. Подведите
указатель�перекрестие к центру опоры и, добившись включения посто�
янно действующего режима объектной привязки Центр (Center), щелк�
ните для захвата координат этой точки (рис. 6.37).

из окружностей, а для двух других с помощью установите радиусы равны�
ми 28 и 35 мм соответственно.

Совет. Проще всего изменить радиус окружности, воспользовавшись палитрой
Свойства (Properties), которая, как вы помните, открывается с помощью кнопки
Свойства (Properties) панели инструментов Standard или команды Изменить ⇒
Свойства (Modify ⇒ Properties). Кроме того, открыть палитру Свойства (Pro�
perties) можно, введя в командном окне команду Ñâîéñòâà (PROPERTIES) или
один из ее многочисленных псевдонимов: îêíîñâ (PROPS), èç (MO), äèàëñâîé
(DDCHPROP), äèàëèçì (DDMODIFY) и т. д. Кстати, закрыть палитру Свой�
ства (Properties) можно с помощью команды командного окна îêíîñâçàê
(PROPERTIESCLOSE) или ее псевдонима ñâç (PRC).

1. Разделите внутреннюю окружность на две половины с помощью линии,
используя постоянно действующий режим объектной привязки Квад�
рант (Quadrant) (рис. 6.38). Верхняя половина представляет на чертеже
декоративную крышку заглушки, а нижняя – собственно отверстие для
вывода кабелей.

Рис. 6.37  Выбор базовой точки с использованием постоянно действующего режима
объектной привязки Центр (Center)

5. AutoCAD предложит задать смещение. Введите в командном окне @–
244,99 (см. рис. 6.32). Контур верхней опоры создан.

6. Повторите операции, описанные в пп. 2–5 применительно к только что
созданному контуру верхней опоры, задав при копировании смещение
@–436,60. Контур заглушки столешницы создан.

Совет. Инструмент Копировать объекты в новый слой (Copy Objects to New Layer)
можно использовать в качестве альтернативы инструмента Копировать (Copy),
выбирая в качестве назначения текущий слой.

7. Заморозьте слой Высота 720, а затем переместите контур верхней опо�
ры на слой Высота 1036 (если последний не заморожен, заморозьте его).

8. Измените масштаб просмотра так, чтобы контур заглушки занимал всю
область черчения, и внесите изменения в чертеж объекта: удалите одну

Рис. 6.38  Выбор второй точки отрезка с использованием
постоянно действующего режима объектной привязки Квадрант (Quadrant)

2. Восстановите предыдущий масштаб просмотра.
3. Для завершения чертежа столешницы сместите левую вертикальную ли�

нию ее контура вправо на 1536 мм, а затем полученную линию – вправо на
764 мм (см. рис. 6.32). Сместите верхнюю горизонтальную линию вниз на
250 мм (232 + 18 = 252 мм, см. рис. 6.32), а затем полученную линию – вниз
на 5 мм.

4. Измените масштаб так, чтобы хорошо видеть область парты.
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5. Обрежьте линии для образования контуров подвижной (внизу) и непод�
вижной (вверху) частей крышки парты (рис. 6.39).

6. Создайте под серединой верхней горизонтальной линии контура под�
вижной части крышки парты прямоугольник, представляющий на черте�
же вырез под ручку, как показано на рис. 6.39 (ширина – 80 мм, высота –
30 мм), а затем разделите его по горизонтали на две равные части лини�
ей, представляющей контур ручки (используйте режим привязки Сере�
дина (Midpoint)).

2. Выделите все объекты, отображаемые на экране, и скопируйте их на за�
мороженный слой Высота 1036.

Совет. Для быстрого выделения всех видимых объектов проще всего нажать
Ctrl+A или воспользоваться командой Правка ⇒ Выбрать все (Edit Select All).

3. Разморозьте и назначьте текущим слой Высота 1036, а слои Высота 758
и Высота 1188 заморозьте.

4. Используя объектную привязку, начертите прямоугольник, ширина ко�
торого равна ширине полочки левой стойки для компакт�дисков, а высо�
та – 18 мм. Этот прямоугольник будет представлять на чертеже заднюю
стенку левой стойки для компакт�дисков.

5. Начертите второй прямоугольник шириной 18 мм и высотой 150 мм
(см. рис. 6.32), который будет представлять на чертеже боковую стенку
левой стойки (рис. 6.41).

6. Используя в качестве оси симметрии точки, находящиеся в левом верх�
нем углу контура столешницы и посредине меньшей дуги контура под�
ставки дисплея (рис. 6.42), создайте зеркальные копии задней и боковой
стенок левой стойки. Тем самым будут получены задняя и боковая стенки
правой стойки.

7. Руководствуясь рис. 6.32, создайте три прямоугольника, обозначающих
левую боковую (18 × 600 мм), заднюю (1518 × 18 мм) и правую боковую
(18 × 232 мм) стенки рабочего места старшеклассника. (Задавая относи�
тельные координаты, учитывайте, в какую сторону в AutoCAD откладыва�
ются положительные значения координат X и Y.)

8. Скопируйте только что созданный прямоугольник, обозначающий пра�
вую боковую стенку рабочего место старшеклассника, вправо сначала на

Рис. 6.39  Смещение контура выреза под ручку
с использованием постоянно действующих режимов объектной привязки

Середина (Midpoint) и Конточка (Endpoint).

Совет. Используйте методику, которая применялась для решения аналогичной
задачи в предыдущих главах. Сначала нужно создать прямоугольник, используя
режим привязки Середина (Midpoint) к середине верхней линии контура подвиж�
ной крышки и относительные координаты (в данном случае – @80,–30). Затем
остается сместить этот прямоугольник с помощью инструмента Переместить
(Move) и режима привязки к середине верхней линии (базовая точка) и к оконеч�
ной точке (смещение) верхнего левого угла исходного прямоугольника.

7. Восстановите предыдущий масштаб просмотра. На этом работа над
объектами слоя Высота 758 завершена (рис. 6.40).

6.3.6.6.3.6.6.3.6.6.3.6.6.3.6. ПереименованиеПереименованиеПереименованиеПереименованиеПереименование иииии удалениеудалениеудалениеудалениеудаление слоевслоевслоевслоевслоев
Руководствуясь рис. 6.1 и 6.32, мы можем продолжить создание чертежей
объектов, находящихся на последующих слоях.

1. Разморозьте слой Высота 1188.

Рис. 6.40  Окончательный вид объектов слоя Высота 758
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Рис. 6.41  Создание боковой стенки с использованием привязки первой точки
к правому верхнему углу задней стенки

Рис. 6.42  Создание боковой и задней стенок правой стойки
с помощью инструмента Зеркальное отражение (Mirror)

438 мм, а затем – на 782 мм. Используя объектную привязку, создайте пря�
моугольник, который будет представлять на чертеже заднюю стенку по�
лок парты. Результат, который должен быть получен после выполнения
пп. 7 и 8, представлен на рис. 6.43.

9. Устраните эффект «прозрачности» задней стенки полок парты, обрезав
ту часть правой вертикальной линию крышки парты, которая попадает
внутрь прямоугольника задней стенки.

Рис. 6.43  Боковые и задние стенки созданы

10. Для того чтобы создать контур нижней полки рабочего места старшек�
лассника у нас, как может показаться на первый взгляд, нет информации
о ее длине (см. рис. 6.32). Однако эта информация нам и не нужна – учи�
тывая, что радиус сопряжения вертикальной и горизонтальной линий
контура полки нам известен (40 мм), можно придти к заключению о том,
что вертикальная линия проходит левее центра опоры на 40 мм. Поэтому
мы получим нужную нам линию путем смещения имеющейся линии. За�
пустите команду Ïîäîáèå (OFFSET).

11. В ответ на приглашение задать расстояние смещения выберите центр
опоры с помощью режима привязки Центр (Center). Затем щелкните на
кнопке Нормаль (Snap to Perpendicular) панели инструментов Объект�
ная привязка (Object Snap) и выберите точку, которая находится на пе�
ресечении левой границы контура крышки парты и перпендикуляра,
проведенного к этой границе из центра опоры (рис. 6.44).

12. В ответ на приглашение AutoCAD выбрать объект, подлежащий сме�
щению, щелкните на только что использовавшейся для выбора точки па�
дения перпендикуляра левой границе контура крышки парты, а затем
сместите ее влево. Если вы правильно задали расстояние смещения, то
смещенная линия пройдет точно через центр опоры.

13. Завершите команду Ïîäîáèå (OFFSET), а затем снова сместите только
что созданную вертикальную линию влево на 40 мм, после чего удалите
промежуточную линию, созданную в п. 12.

14. Сместите вниз на 250 мм (232 + 18 = 252 мм) верхнюю горизонтальную
линию контура столешницы (проще всего выбрать ее правой части рабо�
чей зоны, где она не перекрыта контурами задних стенок).
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15. Обрежьте полученную в п. 14 линию, используя в качестве ограничиваю�
щего ребра левую границу контура крышки парты, а затем выполните со�
пряжение с радиусом 40 мм оставшейся части горизонтальной линии и
вертикальной линии, созданной в п. 13 (рис. 6.45).

лампы. Кроме того, слой Высота 1188 в этом случае нам тоже не нужен, по�
скольку он будет отличаться от слоя Высота 1090 только отсутствием лампы и
вертикальной средней стенки полки парты (она, как и лампа, будет скрыта вер�
хней горизонтальной полкой). Таким образом, этот слой мы можем удалить.

Далее, слой Высота 1358 также выбран неудачно, поскольку для создания
этого слоя нам придется «рассекать» принтер. Кроме того, он отличается от
слоя Высота 1276 только тем, что на последнем отсутствует контур «рассечен�
ного» принтера. Таким образом, слои Высота 1358 и Высота 1276 можно объе�
динить в один слой, причем содержащиеся на нем объекты должны соответ�
ствовать виду сверху на рабочую зону, созданному на такой высоте, на которой
принтер будет виден полностью, например, на высоте 1495 мм от уровня пола.

Давайте внесем все перечисленные выше изменения в номенклатуру слоев
чертежа.

1. Щелкните на кнопке Диспетчер свойств слоев (Layer Properties Mana�
ger) панели инструментов Слои (Layers) или выберите из меню команду
Формат ⇒ Слой (Format ⇒ Layer) либо введите в командном окне коман�
ду Ñëîè (LAYERS) или просто ñë (LA).

2. В открывшемся диалоговом окне Диспетчер свойств слоев (Layer Pro�
perties Manager) должен быть выделен текущий слой Высота 1036. Щелк�
ните на названии слоя или нажмите F2. Вместо названия появится стро�
ка ввода, позволяя вам переименовать слой (рис. 6.46).

3. Переименуйте слой Высота 1036 в Высота 1090 и нажмите Enter.
4. Проделайте те же операции для слоя Высота 1358, переименовав его

в Высота 1495.

Рис. 6.44  Задание расстояние смещения
с помощью режимов привязки Центр (Center) и Нормаль (Perpendicular)

Рис. 6.45  Горизонтальная линия выбрана для сопряжения –
выбор вертикальной линии

На этом все объекты, находящиеся на уровне 1036 мм (см. рис. 6.1) созданы
и нам осталось лишь «рассечь» дисплей и лампу. Однако давайте поразмыс�
лим – а стоит ли это делать? Действительно, вернувшись к рис. 6.1, можно
прийти к выводу о том, что номенклатура слоев верхней части рабочей зоны
выбрана не очень удачно. В частности, если слой Высота 1036 заменить слоем
Высота 1090, можно избавиться от необходимости «рассечения» дисплея и

Рис. 6.46  Переименование слоя в окне Диспетчер свойств слоев
(Layer Properties Manager)
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5. Щелкните на кнопке OK для закрытия диалогового окна Диспетчер
свойств слоев (Layer Properties Manager). Обратите внимание на содер�
жимое списка свойств слоев на панели Слои (Layers) – теперь в нем пока�
зано, что текущим слоем является слой Высота 1090.

Примечание. Проще говоря, при переименовании слоя объекты не «остаются без
гражданства», а автоматически попадают на слой с новым именем. В нормаль�
ных государствах так и бывает, как например, при переименовании «слоя» ГДР
в «слой» ФРГ или «слоя» УССР в «слой» Украина. Правда, есть и такие государства,
которым, как говориться «закон не писан», как это было, например, когда прибал�
тийские республики бывшего СССР стали «независимыми» и «суверенными». К счас�
тью для нас, архитекторы AutoCAD умнее архитекторов «перестройки».

6. Снова откройте диалоговое окно Диспетчер свойств слоев (Layer Pro�
perties Manager) и выделите в списке слоев слой Высота 1276, а затем
щелкните на кнопке  Удалить слой (Delete Layer), находящейся над
списком слоев, или нажмите Alt+D.

7. На пиктограмме слоя появится изображение красного крестика. Это оз�
начает, что слой помечен для удаления, но пока еще не удален. Кроме
того, пиктограммы слоев Высота 622 и Высота 1495 станут блеклыми.
Это означает, что на данных слоях нет ни одного объекта. Если со слоем
Высота 1495 все ясно – мы еще до него не дошли, то слой Высота 622 мы
пропустили, поскольку его содержимое не представляет ничего интерес�
ного (все находящиеся на нем объекты имеются на других слоях).

8. Выделите слой Высота 1188 и щелкните на кнопке Удалить слой (Delete
Layer) или нажмите Alt+D. В этот раз на пиктограмме слоя изображение
красного крестика не появится – вместо этого AutoCAD откроет окно со�
общения (рис. 6.47). Смысл этого сообщения сводится к тому, что AutoCAD
не позволяет удалять нулевой слой и специальный слой Defpoints; слой,
являющийся текущим; слои, определенные во внешних ссылках (подроб�
нее о внешних ссылках мы поговорим в главе 12); слои, на которых име�
ется хотя бы один объект. Последнее как раз и относится к слою Высота
1188, поскольку на нем имеются созданные нами ранее объекты.

9. Щелкните на кнопке OK для закрытия окна сообщения, а затем выделите
слой Высота 622 и пометьте его для удаления, щелкнув на кнопке Уда�
лить слой (Delete Layer) или нажав Alt+D.

10. Щелкните на кнопке Применить (Apply) диалогового окна Диспетчер
свойств слоев (Layer Properties Manager). Помеченные к удалению слои
Высота 1276 и Высота 622 будут удалены из списка слоев.

11. Разморозьте слой Высота 1188, назначьте его текущим, а затем заморозь�
те слой Высота 1090 и щелкните на кнопке OK для закрытия диалогово�
го окна Диспетчер свойств слоев (Layer Properties Manager).

12. Выделите все объекты слоя Высота 1188 и удалите их.
13. Снова откройте диалоговое окно Диспетчер свойств слоев (Layer Proper�

ties Manager), назначьте текущим слой Высота 1495, а слой Высота 1188
переименуйте в слой Вид сверху (вскоре нам этот слой понадобится).

Рис. 6.47  Сообщение о невозможности удаления слоя

14. Щелкните на кнопке OK для закрытия диалогового окна Диспетчер
свойств слоев (Layer Properties Manager).

6.3.7.6.3.7.6.3.7.6.3.7.6.3.7. ЗавершениеЗавершениеЗавершениеЗавершениеЗавершение созданиясозданиясозданиясозданиясоздания слоевслоевслоевслоевслоев
Теперь, когда мы навели порядок в номенклатуре слоев, вы можете приступить
к завершению работы над двумя оставшимися слоями: Высота 1495 (рис. 6.48)
и Вид сверху (рис. 6.49).

Как видно из рис. 6.48 и 6.49, задача создания соответствующих объектов не
представляет из себя особой сложности, поэтому автор предлагает вам решить
ее самостоятельно, руководствуясь следующими общими указаниями.

1. Сначала скопируйте все объекты слоя Высота 1090 на слой Высота 1495.
2. Заморозив слой Высота 1090, удалите лишние объекты (элементы черте�

жа лампы, контур средней вертикальной стенки полки парты, контуры
задних стенок и полочек стоек для компакт дисков).

3. Создайте линию контура полки под принтер, используя привязку к око�
нечным точкам боковой стенки рабочего места старшеклассника и боко�
вых стенок стоек для компакт�дисков, а также к точке падения перпенди�
куляра (рис. 6.50), после чего удалите контуры боковых стенок стоек для
компакт�дисков.

4. Удалите те элементы чертежа дисплея, которые должны быть скрыты
полкой под принтер (для отсечения прямоугольника, представляющего
корпус экрана, используйте инструмент Обрезать (Trim)).

5. Включите режим ОТС�ПОЛЯР (POLAR), предварительно изменив зна�
чение угла отслеживания полярных углов на 45°, а затем переместите
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а затем, снова запустив команду Ïåðåíåñòè (MOVE) – в заданную точку
(добившись нужного направления смещения, как показано на рис. 6.51,
введите в командном окне 90).

6. Создайте с помощью инструмента Прямоугольник (Rectangle) и относи�
тельных координат @358,299 (см. рис. 6.48) наружный контур принте�
ра, расположив его левый нижний угол в средней точке диагональной
части полки для принтера (рис. 6.52).

Рис. 6.50  Создание контура полки под принтер

Рис. 6.48  Размеры объектов слоя Высота 1495 (дисплей и сканер не показаны)
и их расположение на чертеже

Рис. 6.49  Размеры объектов слоя Вид сверху и их расположение на чертеже

с помощью команды Ïåðåíåñòè (MOVE) чертеж заглушки, скопирован�
ный со слоя Высота 1090, в точку, которая находится на расстоянии
90 мм ниже и правее левого внутреннего угла рабочей зоны (см. рис. 6.48 –
точка обозначена перекрестием). Сначала переместите чертеж в исход�
ную точку, которая находится в левом внутреннем углу рабочей зоны,

Рис. 6.51  Перемещение контура заглушки из левого внутреннего угла рабочей зоны
в заданную точку с использованием режима ОТС?ПОЛЯР (POLAR)
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7. Создайте внутри контура принтера контур выемки для бумаги в виде пря�
моугольника размером 220 × 160 мм. Затем с помощью команды Ïåðåíå-
ñòè (MOVE) переместите его так, чтобы он находился по вертикали на
80 мм ниже верхней линии контура принтера, а по горизонтали – посре�
дине контура принтера (см. рис. 6.48).

8. Разверните с помощью инструмента Повернуть (Rotate) оба объекта
вокруг точки, которая находится в левом нижнем углу контура принтера,
на 45° (рис. 6.53), а затем сместите с помощью инструмента Перемес�

тить (Move) эти объекты влево и вниз вдоль диагональной части полки
для принтера на половину длины контура принтера.

9. Снова запустите команду Ïåðåíåñòè (MOVE) и сместите влево и вверх
оба прямоугольника, используя в качестве базовой произвольную точку
одного из объектов. Как только AutoCAD в режиме ОТС�ПОЛЯР (POLAR)
распознает угол 135° (рис. 6.54), введите в командном окне расстояние
смещения 25 (см. рис. 6.48).

Рис. 6.52  Наружный контур принтера создан

Рис. 6.53  Вращение чертежа принтера вокруг левого нижнего угла наружного контура

Рис. 6.54  Смещение чертежа принтера по диагонали

10. Выполните сопряжение левого и правого верхних углов наружного кон�
тура принтера с радиусом 25 мм, как показано на рис. 6.48. Прямоуголь�
ник представляет собой полилинию, но пусть вас это обстоятельство не
смущает – выбирайте оба сопрягаемых сегмента так, словно они являют�
ся обычными линиями. Как только вы щелкните на обоих сегментах, ко�
манда Ñîïðÿæåíèå (FILLET) выполнит их сопряжение с заданным ра�
диусом.

11. Разморозьте слой Высота 720 и скопируйте чертеж основной опоры на
слой Высота 1495, после чего снова заморозьте слой Высота 720. На
этом создание объектов слоя Высота 1495 завершено (рис. 6.55).

Для получения чертежа, показанного на рис. 6.56, нужно скопировать все
объекты со слоя Высота 1495 на слой Вид сверху, удалить лишние объекты,
а затем, руководствуясь рис. 6.49, применить смещение линий на заданные рас�
стояния, растяжение горизонтальных линий, их сопряжение с вертикальными
с радиусом 40 мм, а также отсечение ненужных элементов, которые должны
быть скрыты верхними полками.

Ну, вот мы и закончили создание всех слоев. Как вы убедились, слои
AutoCAD – это очень удобный инструмент, без использования которого со�
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Рис. 6.55  Окончательный вид объектов слоя Высота 1495

Рис. 6.56  Окончательный вид объектов слоя Вид сверху

здать сложный чертеж было бы очень сложно. Можете, например, разморо�
зить все слои и посмотреть, какое нагромождение линий мы получили бы, если
бы попытались обозначить все начерченные объекты на одном и том же черте�
же без использования слоев.

Заморозив все слои, кроме слоя Вид сверху, сохраните текущее состояние
чертежа в файле Work062.dwg. В следующей главе мы покажем расположение
рабочей зоны на чертеже детской, а также рассмотрим некоторые новые для
вас концепции работы в AutoCAD.

Как вы уже могли неоднократно убедиться, в AutoCAD многие операции
можно (и нужно) выполнять сразу с несколькими объектами. Такой под�
ход позволяет снизить количество операций и повысить производи�

тельность работы в AutoCAD, однако нередко сопряжен с определенными зат�
руднениями. В предыдущих главах вы часто сталкивались с тем, как непросто
порой бывает выбрать все элементы сложного объекта, особенно если рядом
с ними расположены элементы других объектов.

Эту проблему в AutoCAD можно решить с помощью разных механизмов.
В этой главе вы ознакомитесь с двумя из них – группами (group) и блоками (block).
В главе 12 мы снова вернемся к этой теме и обсудим еще один механизм более
высокого уровня, основанный на использовании внешних ссылок (X�ref).

Группы и блоки имеют следующие общие свойства.
Элементы чертежа, объединенные в группу или блок, можно выделять
щелчком на любом из элементов.
Группам и блокам могут присваиваться имена, поясняющие их назначе�
ние, а также создавать развернутые описания.
Группы и блоки можно вставлять в чертеж произвольное количество раз.
Над элементами, входящими в блок или группу, можно выполнять опера�
ции, как будто эти элементы являются одним объектом.

Вместе с тем, группы имеют следующие отличия от блоков.
Элементы чертежа, объединенные в группу, можно редактировать по
отдельности. Для редактирования элементов, входящих в блок, после�
дний нужно сначала расчленить (explode).
Один и тот же элемент может входить сразу в несколько групп. Два раз�
ных блока не могут содержать один и тот же элемент – в каждом блоке
храниться собственная копия.
Группы хранятся непосредственно в чертеже, блоки могут храниться как
в чертеже, так и в отдельных файлах на диске.

7ГГГГГлавалавалавалавалава
Использование группИспользование группИспользование группИспользование группИспользование групп
и блоков объектови блоков объектови блоков объектови блоков объектови блоков объектов
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Кроме того, если в блок объединяются элементы чертежа, расположенные
на нулевом слое, цвет, ширина и тип линии будут зависеть от свойств слоя, ко�
торый является текущим на момент вставки блока. Если же элементы, объеди�
ненные в блок, принадлежали слоям, отличным от нулевого, они сохраняют
исходные свойства вне зависимости от цвета и типа линии текущего слоя. (Еще
одно отличие нулевого слоя от всех остальных.) Элементы, объединенные
в группу, всегда принадлежат тому слою, на котором они были созданы, пока
пользователь явно не переместит группу на новый слой.

Поскольку группы и блоки очень похожи, но при этом блоки более удобны
в работе, мы основное внимание в этой главе уделим созданию и использова�
нию блоков. Однако, прежде чем перейти к основному материалу, давайте
вкратце ознакомимся с командой создания и изменения групп.

7.1. Создание и использование групп7.1. Создание и использование групп7.1. Создание и использование групп7.1. Создание и использование групп7.1. Создание и использование групп
Рассмотрим создание и использование групп.

7.1.1. Создание группы с помощью команды «Г7.1.1. Создание группы с помощью команды «Г7.1.1. Создание группы с помощью команды «Г7.1.1. Создание группы с помощью команды «Г7.1.1. Создание группы с помощью команды «Группа»руппа»руппа»руппа»руппа»
(GROUP)(GROUP)(GROUP)(GROUP)(GROUP)
В AutoCAD существует немного инструментов, которые можно запустить лишь
из командного окна. К этим немногочисленным инструментам относится и ко�
манда Ãðóïïà (GROUP) – для нее нет ни команды в меню AutoCAD, ни кнопки
панели инструментов.

1. Откройте чертеж Work062.dwg, если вы закрыли его после прочтения
предыдущей главы, а затем сохраните его в файле с именем Work071.dwg.

2. В данный момент должен быть текущим единственный размороженный
слой Вид сверху. Если это не так, назначьте его текущим и заморозьте
остальные слои.

3. Введите в командном окне команду Ãðóïïà (GROUP) или ее псевдоним
ã (G). На экране появится диалоговое окно Группы объектов (Object
Grouping).

4. Введите в строке Имя группы (Group Name) в качестве имени группы
Ñêàíåð, а затем щелкните на кнопке Новая (New) окна Группы объек�
тов (Object Grouping).

5. Окно Группы объектов (Object Grouping) на время закроется, указа�
тель�перекрестие примет форму отмечающего указателя, а AutoCAD в ко�
мандном окне предложит выбрать объекты, подлежащие объединению
в группу. Охватите рамкой выделения все линии, представляющие на
чертеже сканер, а затем нажмите Enter для завершения выбора. На экра�
не снова появится диалоговое окно Группы объектов (Object Grouping)
с именем одной группы СКАНЕР (рис. 7.1).

6. Установите флажок Включая неименованные (Include Unnamed). Со�
держимое окна от этого не изменится, поскольку на чертеже имеется
лишь одна именованная группа СКАНЕР.

Примечание. Группы могут быть именованными и неименованными (unnamed),
а также выбираемыми (selectable) и невыбираемыми. По умолчанию в окне Груп�
пы объектов (Object Grouping) предлагается создать выбираемую именованную
группу. Невыбираемые группы – это, скорее, теоретическая, чем практическая
возможность, поскольку трудно представить себе ситуацию, в которой пользова�
телю понадобилось бы создать такую группу. Что касается неименованных
групп, то такие группы создаются гораздо чаще. В действительности неимено�
ванными в AutoCAD считаются группы с именами вида *AN, где N – порядковый
номер группы. Эти имена создаются AutoCAD автоматически либо в случае, если
пользователь установил при создании группы флажок Без имени (Unnamed),
либо при копировании группы в чертеже.

7. Щелкните на кнопке OK для закрытия окна Группы объектов (Object
Grouping).

8. Щелкните на любом элемента чертежа сканера – тут же будут выделены
все остальные элементы, объединенные в группу.

7.1.2. Использование и удаление групп7.1.2. Использование и удаление групп7.1.2. Использование и удаление групп7.1.2. Использование и удаление групп7.1.2. Использование и удаление групп
Давайте попробуем скопировать группу СКАНЕР и посмотрим, какой будет
получен результат.

1. Запустите инструмент Копировать (Copy) и скопируйте два раза с его
помощью чертеж сканера в произвольные точки чертежа, а затем нажми�
те Enter для завершения копирования.

2. Снова запустите команду Ãðóïïà (GROUP).
3. После открытия окна Группы объектов (Object Grouping) установите

флажок Включая неименованные (Include Unnamed). В этот раз, как

Рис. 7.1  Если щелкнуть на названии группы в списке Имя группы (Group Name),
становятся доступными кнопки изменения ее свойств
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видно из рис. 7.2, в списке Имя группы (Group Name), кроме группы
СКАНЕР, появятся еще две группы с именами, автоматически созданны�
ми AutoCAD.

7.2. Создание и использование блоков7.2. Создание и использование блоков7.2. Создание и использование блоков7.2. Создание и использование блоков7.2. Создание и использование блоков
Рассмотрим создание и использование блоков.

7.2.1. Инструмент «Расчленить» (Explode)7.2.1. Инструмент «Расчленить» (Explode)7.2.1. Инструмент «Расчленить» (Explode)7.2.1. Инструмент «Расчленить» (Explode)7.2.1. Инструмент «Расчленить» (Explode)
Прежде, чем перейти к собственно созданию и применению блоков, нам нуж�
но доработать текущий чертеж.

1. Создайте четыре новых слоя: Детская (индекс цвета линий – 214), Бал�
кон (индекс цвета – 174), Двери (индекс цвета – 116) и Окна (индекс цве�
та – 66) и назначьте слой Детская текущим.

Примечание. Как видите, в данном случае мы создаем слои, отталкиваясь от
функциональности находящихся на них объектов.

2. Запустите инструмент Прямоугольник (Rectangle) и начните создание
прямоугольника, выбрав в качестве первой вершины точку, которая на�
ходится в левом верхнем углу рабочей зоны.

3. В ответ на приглашение AutoCAD задать другую точку введите относи�
тельные координаты @4920,–2850 для создания внутреннего контура
стен детской.

4. Воспользуйтесь инструментом Зумировать в границах (Zoom Extents)
для масштабирования чертежа по границам только что созданного пря�
моугольника.

5. Запустите инструмент Подобие (Offset), задайте смещение 350, выбери�
те любую из сторон контура стен детской, а затем задайте направление
смещение наружу от этого контура.

6. Снова воспользуйтесь инструментом Зумировать в границах (Zoom
Extents) для масштабирования чертежа по границам второго прямоу�
гольника, который будет представлять на чертеже контур наружных
стен (рис. 7.3).

7. Щелкните на обоих прямоугольниках для их выделения, а затем запусти�
те инструмент  Расчленить (Explode) панели инструментов Изме�
нить (Modify). Альтернативный метод запуска заключается в использова�
нии команды меню Изменить ⇒ Расчленить (Modify ⇒ Explode) либо
во вводе в командном окне команды Ðàñ÷ëåíèòü (EXPLODE) или ее
псевдонима ðàñ÷ (X).

8. Команда Ðàñ÷ëåíèòü (EXPLODE) сообщит в командном окне о том, что
она обнаружила два выделенных объекта и тут же завершит работу. На
первый взгляд, ничего не изменилось. Однако, если вы снова попробуете
щелкнуть на двух только что созданных прямоугольниках, то увидите,
что они теперь представляют из себя отдельные линии, а не единый
объект.

9. Сместите на 150 мм внутрь детской верхнюю и нижнюю линии наружных
стен, а затем удалите исходные линии.

Рис. 7.2  При копировании группы СКАНЕР
AutoCAD автоматически создал группы *A1 и *A2

4. Щелкните на названии группы *A1 в списке Имя группы (Group Name),
а затем на ставшей доступной кнопке Расчленить (Explode). Группа *A1
тут же будет удалена из списка Имя группы (Group Name). Это означает,
что она была расчленена на отдельные элементы и прекратила свое суще�
ствование.

5. Проделайте ту же операцию с оставшимися двумя группами и закройте
диалоговое окно Группы объектов (Object Grouping), щелкнув на кноп�
ке OK.

6. Удалите две копии чертежа сканера или просто закройте чертеж
Work071.dwg, не сохраняя его, и снова его откройте.

Совет. Группы – достаточно удобный механизм объединения нескольких элемен�
тов чертежа в единый объект, однако его можно использовать только для созда�
ния чертежей «на скорую руку», которые заведомо не будут использоваться по�
вторно. В остальных случаях лучше применять блоки, а не группы, поскольку
блоки позволяют, помимо объединения элементов чертежа в объекты, создавать
библиотеки стандартных объектов для дальнейшего повторного использования.
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10. Обрежьте образовавшиеся после смещения выступающие сегменты ле�
вой и правой вертикальных линий наружных стен по смещенным внутрь
горизонтальным линиям.

11. Сместите влево на 850 мм правую вертикальную линию контура наруж�
ных стен. Затем полученную линию сместите влево на 800 мм. Примени�
те команду Ïîäîáèå (OFFSET) еще два раза, сместив последнюю линию
влево на 810 мм, а затем полученную линию – влево на 700 мм.

12. Снова воспользуйтесь командой Ïîäîáèå (OFFSET) для смещения ниж�
ней горизонтальной линии контура наружных стен вверх на 800 мм, а за�
тем полученную линию сместите еще раз вверх на 600 мм. Результат дол�
жен быть таким, как показано на рис. 7.4.

13. Примените инструмент Обрезать (Trim) для обрезки линий стен по
вспомогательным линиям с тем, чтобы получить дверные проемы, как
показано на рис. 7.5.

14. Назначьте текущим слой Балкон, запустите инструмент Rectangle и нач�
ните создание прямоугольника, выбрав в качестве начальной точки ле�
вый верхний угол наружного контура стен (рис. 7.5).

15. Для задания второй точки введите относительные координаты @–1250,
–3250, а затем воспользуйтесь инструментом Зумировать в границах
(Zoom Extents) для настройки масштаба по габаритам чертежа.

16. Сместите контур балкона внутрь на 100 мм, затем примените инструмент
Расчленить (Explode) для расчленения обоих прямоугольников на от�
дельные линии, удалите правые вертикальные линии обоих контуров и
продлите горизонтальные линии внутреннего контура стенки балкона
до наружного контура стены детской (рис. 7.6).

Теперь, подготовив «площадку», мы можем приступать к созданию блоков,
в качестве которых будут использованы чертежи окон и дверей.

Рис. 7.3  Внутренние и наружные контуры стен детской комнаты Рис. 7.4  Вспомогательные линии для создания дверных проемов созданы

Рис. 7.5  Создание наружного контура балкона

7.2.2. Инструмент «Создать блок» (Make Block)7.2.2. Инструмент «Создать блок» (Make Block)7.2.2. Инструмент «Создать блок» (Make Block)7.2.2. Инструмент «Создать блок» (Make Block)7.2.2. Инструмент «Создать блок» (Make Block)
Блок представляет собой именованную совокупность элементов чертежа, кото�
рая вставляется в чертеж, как единый объект в заданной точке вставки (inser�
tion point). Эти три компонента (набор элементов чертежа, имя и точка встав�
ки) называются в AutoCAD определением блока (block definition), описанием блока
(Block description), ссылкой на блок (block reference) или просто блоком.
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Примечание. Некая «пестрота» терминологии AutoCAD – это одно из его «фир�
менных» отличий, поэтому автор будет применять все четыре приведенных
выше термина в качестве синонимов, чтобы вы также постепенно привыкали к
их использованию.

Для создания блоков используется инструмент Создать блок (Make Block)
панели инструментов Черчение (Draw). По умолчанию определение блока со�
храняется в файле чертежа, в котором он был создан. При этом входящие
в элементы чертежа можно удалить – определение блока от этого не исчезнет.
В случае необходимости вы в любой момент можете снова вставить в чертеж
входящие в него элементы с помощью инструмента Вставить блок (Insert
Block). Кроме того, блоки можно сохранять в отдельных файлах, но об этом мы
поговорим далее в этой главе.

Как уже отмечалось выше, нулевой слой при создании блоков является наи�
более предпочтительным, поскольку он позволяет создавать «нейтральные»
блоки. Поэтому перед созданием блока следует решить, должны ли какие�то его
объекты быть предварительно перемещены на нулевой слой. Как правило, луч�
ше всего создавать блоки именно на нулевом слое – тем самым вы избавите себя
от путаницы со слоями при вставке блоков, созданных на слоях, отличных от
нулевого, на другие слои. С другой стороны, если вы уверены в том, что какой�
то блок будет вставляться в чертеж только на одном и том же слое, тогда можно
создать его сразу на нужном слое.

1. Назначьте текущим слой Двери.
2. Создайте прямоугольник, используя в качестве первой точки верхнюю

оконечную точку левой вертикальной линии дверного проема шириной
700 мм (рис. 7.7).

3. Для задания координат второй точки введите в командном окне @40,700.
AutoCAD отобразит в дверном проеме, ведущем из детской в кабинет,

контур открытой двери с шириной полотна 700 мм и толщиной 40 мм
(так называемая «сороковка»).

4. Теперь нужно обозначить на чертеже траекторию распаха двери. Этот
объект представляет собой дугу с градусной мерой 90°, которая показыва�
ет на чертеже, какую часть пространства помещения охватывает дверь
при ее открытии. Как вы помните, дуги создаются с помощью инструмен�
та Дуга (Arc). Однако, как уже отмечалось в предыдущих главах, этот ин�
струмент часто удобнее всего запускать не из командной строки и не
с помощью кнопки Дуга (Arc) панели инструментов Черчение (Draw),
а из меню AutoCAD. Поэтому выберите из меню команду Черчение ⇒
Дуга ⇒ Начало, конец, угол (Draw ⇒ Arc ⇒ Start, End, Angle).

5. AutoCAD предложит выбрать начальную точку дуги. Выберите точку, ко�
торая находится на противоположной стороне дверного проема от точ�
ки крепления двери.

6. В следующем приглашении AutoCAD предложит задать конечную точку
дуги. Выберите точку, которая находится в левом верхнем углу прямо�
угольника, обозначающего контур открытой двери (рис. 7.8).

7. В ответ на приглашение задать угол введите в командном окне 90, после
чего AutoCAD изобразит траекторию распаха двери, а команда Äóãà
(ARC) автоматически завершится.

8. Элементы чертежа, которые нам предстоит преобразовать в блок, гото�
вы. Теперь нам осталось создать определение блока – присвоить этим
элементам имя и определить точку вставки. Для этого запустите инстру�
мент  Создать блок (Make Block) панели инструментов Черчение
(Draw) или выберите из меню команду Черчение ⇒ Блок ⇒ Создать
(Draw ⇒ Block ⇒ Make) либо введите в командном окне команду Áëîê
(BLOCK) или просто á (B).

Рис. 7.6  Контуры балкона и стен с дверными проемами созданы Рис. 7.7  Создание контура двери кабинета
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9. Введите в строке Имя (Name) открывшегося диалогового окна Описа�
ние блока (Block Definition) (рис. 7.9) имя нового блока – Дверь 700.

10. Раскройте список Единицы блока (Block unit) группы Настройки (Set�
tings) и выберите из него значение Безразмерный (Unitless). Это позво�
лит вам не привязывать блок к текущим единицам измерения чертежа.

11. Для задания точки вставки (она же – базовая точка блока) щелкните на
кнопке  Указать (Pick Point) группы Базовая точка (Base Point). Диало�
говое окно Описание блока (Block
Definition) временно закроется.

12. Выберите точку, в которой контур
двери соприкасается с контуром
дверного проема, как показано на
рис. 7.10. Как только вы щелкните
для захвата координат выбранной
точки, ее расположение относи�
тельно объектов будущего блока бу�
дет сохранено для будущего исполь�
зования в качестве точки вставки
блока, а на экране вновь появится
диалоговое окно Описание блока
(Block Definition).

13. Теперь вам осталось выбрать эле�
менты чертежа, из которых будет

состоять будущий блок. Щелкните для этого на кнопке Выбрать объек�
ты (Select Objects). Диалоговое окно Описание блока (Block Definition)
снова временно закроется, указатель примет форму отмечающего указа�
теля, а в командном окне появится приглашение выбрать объекты.

14. Щелкните на двери, затем – на траектории ее распаха и нажмите Enter
для завершения выбора и возврата в окно Описание блока (Block
Definition).

15. Обратите внимание – в нижней части группы Объекты (Objects) содер�
жится сообщение о том, что вы выбрали 2 объекта, а справа от списка
Имя (Name) – небольшая область предварительного просмотра будуще�
го блока. Щелкните на переключателе Delete этой же группы, а затем
щелкните на кнопке OK для закрытия диалогового окна Описание блока
(Block Definition).

Примечание. Переключатели группы Объекты (Objects) диалогового окна Описа�
ние блока (Block Definition) определяют режим преобразования выбранных эле�
ментов чертежа в блок. Если выбран режим Оставить (Retain), блок создается в
виде нового объекта, а исходные элементы остаются на чертеже. Режим Преоб�
разовать в блок (Convert to Block) отличается от режима Оставить (Retain)
тем, что исходные элементы чертежа автоматически преобразовываются во
вновь созданный блок. Если выбран режим Delete, то сразу же после создания бло�
ка исходные элементы чертежа автоматически удаляются.

Поскольку мы выбрали режим удаления исходных объектов, чертеж двери
после закрытия окна Описание блока (Block Definition) исчез. Только что вы
создали определение блока Дверь 700. Теперь же нужно создать в нужном мес�
те чертежа ссылку на блок (block reference). Хотя, как отмечалось выше, эти два
термина очень близки и могут использоваться в качестве синонимов, все же

Рис. 7.8  Выбор конечной точки дуги

Рис. 7.9  Диалоговое окно Описание блока
(Block Definition)

Рис. 7.10  Выбор базовой точки блока
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между ними есть небольшое различие. Определение, или описание, блока – это
набор компонентов, составляющих блок (элементы чертежа, имя и точка
вставки), тогда как ссылка на блок – это конкретная реализация этих компонен�
тов в виде конкретных объектов на чертеже. Если вы знакомы с основами
объектно�ориентированного программирования, тогда можете считать, что
определение блока – это класс, а ссылка на блок – это конкретный экземпляр
класса. Определение блока с заданным именем в чертеже всегда существует
в одном экземпляре, тогда как ссылок на этот блок в чертеже может быть как
угодно много.

С другой стороны, на практике вполне допустимы выражения вида: «создай�
те блок A и вставьте его в точке X,Y», то есть, как уже отмечала автор, часто
термины, связанные с блоками, заменяются одним лишь термином блок.

7.2.3. Инструмент «Вставить блок» (Insert Block)7.2.3. Инструмент «Вставить блок» (Insert Block)7.2.3. Инструмент «Вставить блок» (Insert Block)7.2.3. Инструмент «Вставить блок» (Insert Block)7.2.3. Инструмент «Вставить блок» (Insert Block)
Давайте вставим блок Дверь 700 в чертеж вместо удаленных AutoCAD объек�
тов (как вы понимаете, речь идет о вставке ссылки на блок, созданный в виде
определения блока Дверь 700).

1. Запустите инструмент  Вставить блок (Insert Block) панели инстру�
ментов Черчение (Draw). (Альтернативный метод запуска заключается
в выборе команды меню Вставить блок (Insert Block) либо во вводе в ко�
мандном окне команды Âñòàâèòü (INSERT) или просто â (I).)

2. В списке Имя (Name) появившегося диалогового окна Вставка блока
(Insert) отображается название пока что единственного определения
блока чертежа Work071.dwg с именем Дверь 700 (рис. 7.11).

(то есть ссылки на блок) в чертеж. (Далее в этой главе мы еще поговорим
об этих режимах подробнее.)

4. Щелкните на кнопке OK для закрытия окна Вставка блока (Insert) и пе�
рехода к собственно операции вставки блока.

5. Рядом с указателем�перекрестием появится изображение двери с конту�
ром ее распаха, причем блок будет «приклеен» к указателю�перекрестию
именно той точкой, которую мы выбрали в качестве базовой (рис. 7.12).
Обратите внимание на командное окно – AutoCAD предлагает в нем выб�
рать точку вставки. Подведите указатель�перекрестие к точке подвеса
двери (верхняя точка левой вертикальной линии дверного проема шири�
ной 700 мм) и щелкните для захвата координат этой точки, используя
режим привязки Конточка (Endpoint).

Рис. 7.11  Диалоговое окно Вставка блока (Insert)

3. Установите все три флажка Указать на экране (Specify On�screen) – это
означает, что все три режима (выбора точки вставки, задание масштаба
и угла поворота) мы будем задавать непосредственно при вставке блока

Рис. 7.12  Вставка ссылки на блок Дверь 700 в чертеж

6. В следующем приглашении AutoCAD предложит задать коэффициент
масштабирования блока по оси X. В данном случае мы изменять коэффи�
циент масштабирования не будем, поэтому просто нажмите Enter для
принятия установленного по умолчанию коэффициента 1.

7. AutoCAD предложит задать коэффициент масштабирования блока по
оси Y или нажать Enter для принятия коэффициента, равного коэффи�
циенту масштабирования по оси Х. Поскольку нас вполне устраивает
предложенный по умолчанию режим, снова нажмите Enter.

8. В заданной точке вставки появится изображение блока, которое будет
вращаться вокруг точки вставки (она же – базовая точка блока) в соответ�
ствии с перемещениями указателя�перекрестия. AutoCAD в командном
окне предложит задать угол поворота блока. Нажмите Enter, чтобы при�
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нять предложенное по умолчанию значение 0°. Ссылка на блок Дверь
700 будет вставлена в чертеж в виде нового объекта (рис. 7.13).

чает, что она расположена симметрично по отношению к двери кабинета отно�
сительно оси X. Наконец, в�третьих, дверь открывается по направлению к пра�
вой стене детской, а не к балкону, то есть она расположена симметрично и от�
носительно оси Y. Таким образом, в данном случае нам нужно будет при вставке
блока использовать масштабные коэффициенты вдоль осей X и Y, причем не
положительные, а отрицательные.

На первый взгляд, значения этих коэффициентов должны составлять –
(800/700)= –1.142857. Однако здесь кроется еще одна проблема – если мы вста�
вим блок с таким масштабным коэффициентом, увеличиться не только длина
дверного полотна, но и его толщина, что нас не устраивает. Решение заключа�
ется в том, чтобы вставить не одну, а две ссылки на блок Дверь 700: первую мы
вставим с рассчитанными значением масштабного коэффициента для осей X и
Y, а вторую – с этим же значением, но только для оси X, а для оси Y мы использу�
ем коэффициент –1. Затем мы с помощью инструмента Расчленить (Explode)
расчленим оба блока, удалим два лишних объекта и преобразуем полученный
чертеж двери в блок Дверь 800.

1. Запустите инструмент Вставить блок (Insert Block) панели инструмен�
тов Черчение (Draw) любым удобным для вас способом (например, вве�
дите в командном окне I). Убедитесь в открывшемся окне Вставка блока
(Insert) в том, что установлены все три флажка Указать на экране
(Specify On�Screen), щелкните на кнопке OK для закрытия диалогового
окна Вставка блока (Insert) и начала вставки блока.

2. В качестве точки вставки выберите нижнюю точку правой вертикальной
линии дверного проема, ведущего из детской в коридор (рис. 7.14).

3. В ответ на приглашение AutoCAD задать масштабный коэффициент по
оси X введите в командном окне -1.142857, а затем нажмите Enter для

Рис. 7.13  Ссылка на блок Дверь 700 вставлена в чертеж
с коэффициентами масштабирования, равными 1, и углом поворота 0°

Итак, операции по вставке блока выполняются в следующей последователь�
ности.

Выбор блока в окне Вставка блока (Insert) из списка созданных ранее
блоков.
Выбор на чертеже точки вставки блока, в которой будет расположена
базовая точка блока.
Задание коэффициента масштабирования по осям X и Y.
Задание угла поворота блока.

Примечание. Коэффициенты масштабирования могут быть как положитель�
ными, так и отрицательными. Если коэффициент масштабирования отрица�
телен, блок вставляется в зеркальном отображении относительно соответст�
вующей оси (как после применения команды  Çåðêàëî (MIRROR)).

Давайте на практике посмотрим, как вставить блок в чертеж с использова�
нием коэффициентов масштабирования.

7.2.4. Вставка блока с масштабированием7.2.4. Вставка блока с масштабированием7.2.4. Вставка блока с масштабированием7.2.4. Вставка блока с масштабированием7.2.4. Вставка блока с масштабированием
и отображениеми отображениеми отображениеми отображениеми отображением
Нам предстоит создать чертеж двери, которая ведет из детской в коридор.
Здесь мы сталкиваемся с несколькими проблемами. Во�первых, этот дверной
проем шире (800 мм), чем дверной проем, ведущий в кабинет (700 мм). Во вто�
рых, дверь, ведущая в коридор, должна открываться внутрь детской, что озна� Рис. 7.14  Выбор точки вставки первого экземпляра блока Дверь 700
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того, чтобы использовать это же значение масштабного коэффициента
по оси Y.

4. Еще раз нажмите Enter для принятия предложенного по умолчанию
значения угла поворота 0°. Блок появится на чертеже, заняв нужное по�
ложение.

5. Повторите пп. 1�4, введя в качестве масштабного коэффициента по оси X
значение -1, а в качестве масштабного коэффициента по оси Y – уже ис�
пользовавшееся выше значение -1.142857. После задания нулевого
угла поворота второй блок также появится на чертеже в нужном положе�
нии, но с недостаточной шириной.

6. Увеличьте масштаб изображения так, чтобы хорошо видеть все элемен�
ты обоих блоков (рис. 7.15).

чтобы не только создать определение блока, но сразу преобразовать име�
ющиеся элементы чертежа в ссылку на этот блок.)

10. Убедитесь в том, что чертеж двери шириной 800 мм представляет собой
блок, щелкнув на любом из его элементов (рис. 7.16).

Рис. 7.15  Оба экземпляра блока Дверь 700
вставлены в чертеж с различными масштабными коэффициентами по оси X

7. Выделите оба блока, щелкнув на них мышью или воспользовавшись пере�
секающей рамкой, а затем запустите инструмент Расчленить (Explode)
(например, щелкните на соответствующей кнопке панели инструментов
Изменить (Modify) или введите X в командном окне).

8. AutoCAD сообщит в командном окне о том, что 2 объекта были расчлене�
ны. Удалите дугу, которая «не дотягивает» до дверного проема, а также
более широкий прямоугольник, а затем восстановите предыдущий масш�
таб просмотра.

9. Воспользуйтесь инструментом Создать блок (Make Block) для создания
определения блока Дверь 800 из двух оставшихся элементов чертежа
двери шириной 800 мм. (В этот раз выберите в окне Описание блока
(Block Definition) переключатель Преобразовать в блок (Convert to Block),

Рис. 7.16  При щелчке на блоке появляется только один маркер выделения
в точке вставки этого блока в чертеж

Используя подобную методику, самостоятельно вставьте ссылку на блок
Дверь 800 в проем, ведущий на балкон. В качестве точки вставки используйте
середину нижней горизонтальной линии проема. Поскольку дверь должна от�
крываться внутрь детской, а ее ширина составляет 600 мм, при первой вставке
используйте масштабный коэффициент по оси X, равный 0.75 (600/800 =
0.75), по оси Y – коэффициент, равный –0.75, и угол поворота, равный -90.

При вставке второго экземпляра оставьте параметры такими же, за исклю�
чением коэффициента масштабирования по оси X, который должен быть рав�
ным 1.

Затем, увеличив масштаб просмотра, расчлените блоки, удалите большую
дугу и прямоугольник меньшей толщины, а затем восстановите предыдущий
масштаб и создайте определение блока Дверь 600, применив при создании ре�
жим Преобразовать в блок (Convert to Block). Полученный результат должен
быть таким, как показано на рис. 7.17.

7.2.5. Использование инструментов «Список» (List)7.2.5. Использование инструментов «Список» (List)7.2.5. Использование инструментов «Список» (List)7.2.5. Использование инструментов «Список» (List)7.2.5. Использование инструментов «Список» (List)
и «Свойства» (Properties)и «Свойства» (Properties)и «Свойства» (Properties)и «Свойства» (Properties)и «Свойства» (Properties)
Как уже отмечалось, объект, представляющий собой блок, визуально никак не
отличается от обычных элементов чертежа. Один из способов выяснить, явля�
ется ли тот или иной объектов или нет, мы только что рассмотрели – если пос�
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ле выделения объекта (щелчком мыши, обычной или пересекающей рамкой и
т. п.) вместо множества маркеров выделения (grip) появляется только один мар�
кер, значит, соответствующий набор элементов чертежа является блоком.
В этом случае маркер выделения обозначает базовую точку блока (она же – точ�
ка вставки).

Подробнее о том, что такое маркеры выделения и для чего они нужны, мы
поговорим в последующих главах.

Однако довольно часто нужно не просто определить, является ли объект
блоком, но и узнать его свойства. В этом случае можно воспользоваться инстру�
ментом Список (List) панели инструментов Сведения (Inquiry).

1. Щелкните правой кнопкой мыши на любой панели инструментов и выбе�
рите из появившегося списка панелей инструментов AutoCAD панель
Сведения (Inquiry).

2. Если хотите, пристыкуйте плавающую панель Сведения (Inquiry) к верх�
ней или левой границе экрана (эта панель небольшая, поэтому проблем
с ее размещением не возникает), а затем щелкните на кнопке инструмен�
та Список (List). Альтернативный метод запуска этого инструмента зак�
лючается в выборе из меню команды Сервис ⇒ Сведения ⇒ Список
(Tools ⇒ Inquiry ⇒ List) либо во вводе в командном окне команды Ñïèñîê
(LIST) или одного из ее псевдонимов – ñï (LI или LS).

3. После запуска инструмента Список (List) AutoCAD в командном окне
предложит выбрать интересующие вас объекты. Щелкните на блоке
Дверь 600 и нажмите Enter для завершения выбора.

4. На экране появится диалоговое окно Текстовое окно AutoCAD (AutoCAD
Text Window) с несколькими строками текста. Среди этого текста будет
описание блока, начинающееся заголовком Âëîæåíèå áëîêà Ñëîé:

(BLOCK REFERENCE Layer:) «Äâåðè». В описании объекта, выводимого
в текстовом окне AutoCAD с помощью инструмента Список (List), указы�
ваются, помимо прочих, следующие сведения: тип объекта (в данном слу�
чае – Âëîæåíèå áëîêà (BLOCK REFERENCE), то есть ссылка на блок);
слой, на котором находится объект (Ñëîé: (Layer:) «Äâåðè»); название оп�
ределения блока (Èìÿ áëîêà: (Block Name:) «Äâåðü 600»); координаты
точки вставки блока (â òî÷êàõ (at point), X=-175.0 Y=600.0 Z=0.0);
коэффициенты масштабирования по осям X и Y (Ìàñøòàá ïî îñè Õ
(X scale factor): 1.0; Ìàñøòàá ïî îñè Y (Y scale factor): 1.0) и угол пово�
рота (óãîë ïîâîðîòà (rotation angle): 0.00). Изучив свойства блока, на�
жмите F2 для возврата к чертежу.

Примечание. Текстовое окно AutoCAD содержит ту же информацию, которая
выводится в командном окне AutoCAD. В некоторых случаях бывает удобнее не
увеличивать размер командного окна, а открыть текстовое окно AutoCAD, изу�
чить выведенную в нем информацию, после чего закрыть это окно (или оставить
открытым) и продолжить работу. Для включения и выключения отображения
текстового окна можно, помимо команды Ñïèñîê (LIST), использовать нажа�
тие F2.

5. Еще раз запустите инструмент Список (List) (например, введите в коман�
дном окне ñï (LI)).

6. В этот раз в ответ на приглашение выбрать объекты щелкните на одной
из линий контуров балкона и стен детской, а затем нажмите Enter. На
экране снова появится текстовое окно AutoCAD с информацией о вы�
бранных объектах (рис. 7.18).

7. Несколько раз нажмите F2, чтобы убедиться в том, что в командном окне
видны последние строки текста, отображаемого в текстовом окне.

8. Если текстовое окно осталось на экране, нажмите F2 для его закрытия.
Наконец, третий метод получения информации о ссылках на блоки, встав�

ленные в чертеж, заключается в использовании палитры Свойства (Proper�
ties). С этим инструментом вы уже знакомы – с его помощью мы меняли свой�
ства концентрических окружностей, представляющих на чертеже контуры
опор. Теперь воспользуемся им для просмотра свойств блока.

1. Откройте палитру Свойства (Properties), щелкнув на соответствующей
кнопке панели инструментов Standard или нажав Ctrl+1. (Можно также
выбрать из меню команду Изменить ⇒ Свойства (Modify ⇒ Properties)
либо ввести в командном окне команду Ñâîéñòâà (PROPERTIES) или
один из ее многочисленных псевдонимов, например, îêíîñâ.)

2. На экране появится палитра Свойства (Properties). Щелкните на одном
из вставленных в чертеж блоков. В палитре Свойства (Properties) по�
явятся сведения о выделенном блоке (рис. 7.19), подобные тем, которые
отображались в текстовом окне AutoCAD при использовании инструмен�
та Список (List). Обратите внимание на то, что в верхней части панели
отображается тип выбранного объекта (в данном случае – Вхождение
блока (Block Reference)).

Рис. 7.17  Чертежи всех трех дверей представляют собой блоки
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7.3. Дополнительные методы вставки блоков7.3. Дополнительные методы вставки блоков7.3. Дополнительные методы вставки блоков7.3. Дополнительные методы вставки блоков7.3. Дополнительные методы вставки блоков
Рассмотрим подробнее дополнительные методы вставки блоков.

7.3.1. Создание блока с использованием инструмента7.3.1. Создание блока с использованием инструмента7.3.1. Создание блока с использованием инструмента7.3.1. Создание блока с использованием инструмента7.3.1. Создание блока с использованием инструмента
«Ближайшая» (Snap to Nearest)«Ближайшая» (Snap to Nearest)«Ближайшая» (Snap to Nearest)«Ближайшая» (Snap to Nearest)«Ближайшая» (Snap to Nearest)
В оставшейся части главы вы попрактикуетесь в применении различных мето�
дов вставки блоков, в том числе с использованием режимов объектной привяз�
ки, а также других средств AutoCAD. В этот раз мы создадим на нулевом слое
определение блока окна, а затем будет вставлять ссылки на него на новый слой
чертежа.

1. Разморозьте нулевой слой и назначьте его текущим.
2. Измените масштаб просмотра так, чтобы хорошо видеть нижнюю часть

контура балкона. Здесь мы создадим определение блока окна шириной
500 мм, а затем будем вставлять ссылки на него, коэффициент масштаби�
рования по оси X для получения экземпляров блока соответствующей
ширины. Для начала начертим внутри стены балкона оконный проем
шириной 500 мм.

3. Запустите инструмент С линиями (Line), а затем щелкните на кнопке 
Ближайшая (Snap to Nearest) панели инструментов Объектная привяз�
ка (Object Snap). В данном случае использование режима привязки к бли�
жайшей точке Ближайшая (Nearest) оправдано тем, что нам нужно вы�
брать любую точку на линии стены балкона, – главное, чтобы она
находилась точно на той линии, возле которой вы щелкните мышью.

4. Переместите указатель к верхней линии стены балкона. Как только указа�
тель�перекрестие окажется возле линии, AutoCAD распознает точку, ко�
торая находится на этой линии как можно ближе к указателю, отметив ее
значком, напоминающим песочные часы. Сместите указатель левее сере�
дины стены и, убедившись в наличии «песочных часов» (рис. 7.20), щелк�
ните мышью. AutoCAD захватит координаты выбранной точки в каче�
стве координат первой точки линии.

5. Щелкните на кнопке Нормаль (Snap to Perpendicular) панели инструмен�
тов Объектная привязка (Object Snap) , после чего переместите указа�
тель к нижней линии стены балкона. Как только AutoCAD распознает точ�
ку падения перпендикуляра, щелкните для захвата ее координат. Между
горизонтальными линиями контура стены будет начерчена вертикальная
линия. Нажмите Enter для завершения команды Îòðåçîê (LINE).

6. Сместите начерченную линию вправо на 500 мм с помощью команды Ïî-
äîáèå (OFFSET) и нажмите Enter для завершения этой команды.

7. Снова запустите команду Îòðåçîê (LINE). Используя постоянно действу�
ющий режим привязки Середина (Midpoint), выберите сначала сред�
нюю точку линии, созданной в пп. 4–5, а затем среднюю точку смещен�
ной линии.

Рис. 7.18  В текстовом окне отображается та же информация, что и в командном окне

Рис. 7.19  Палитра Свойства
(Properties), используемая для

просмотра свойств ссылки на блок

3. Закройте палитру Свой�
ства (Properties), щелкнув
на кнопке закрытия пане�
ли в ее левом верхнем углу
или введя Îêíîñâçàêð
(PRCLOSE) и нажмите Esc,
чтобы отменить выделе�
ние блока.

Совет. Описанные в данном
подразделе инструменты про�
смотра свойств объектов чер�
тежа могут оказаться очень
полезными в тех случаях, ког�
да нужно разбираться в чер�
тежах, созданных другими
пользователями.
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8. Нажмите Enter, чтобы завершить команду Îòðåçîê (LINE). Чертеж дол�
жен выглядеть примерно так, как показано на рис. 7.21.

го блока, то, используя масштабные коэффициенты по осям X и Y, вы без труда
получите необходимые объекты, адаптированные как к нужной ширине окон�
ного проема, так и к нужной толщине стены.

Однако трех созданных линий нам еще не достаточно. Дело в том, что при
создании блока нужно тщательно продумать расположение базовой точки бло�
ка, которая при вставке ссылки на блок используется в качестве точки вставки.
Когда мы создавали дверные блоки, эта точка была выбрана, так сказать, есте�
ственным образом – в ее качестве использовалась точка подвески двери на пет�
лях. С оконным блоком все не так просто – при вставке блока в чертеж на лини�
ях стен, как правило, отсутствуют какие�либо характерные точки, которые
можно было бы использовать в качестве точки вставки.

Рассуждая логически, можно придти к заключению о том, что лучше всего
вставлять блоки, представляющие на чертеже окна, используя в качестве точки
вставки пересечение перпендикуляра к линии стены, проходящего через сере�
дину оконного блока. Действительно, независимо от ширины оконного блока,
положение этой точки достаточно легко рассчитать, а саму точку достаточно
легко выбрать, используя различные режимы объектной привязки.

Конечно же, на созданном вами чертеже оконного блока отсутствует эле�
мент, точку которого можно выбрать в качестве базовой, однако ничто не ме�
шает нам создать такой элемент исключительно для задания базовой точки, не
включая его в блок.

Примечание. Базовая точка, которая используются для позиционирования ссыл�
ки на блок при ее вставке в чертеж и которая после размещения блока на чертеже
совпадает с точкой вставки, не обязательно должна принадлежать одному из
элементов блока. В общем случае в качестве базовой точки можно использовать
любую точку – AutoCAD сохраняет в определении блока относительные координа�
ты точки, выбранной в качестве базовой.

1. Снова запустите инструмент С линиями (Line) и, используя режим при�
вязки Середина (Midpoint), выберите середину линии, представляющей
в блоке стеклопакет.

2. С помощью режима привязки Нормаль (Perpendicular) выберите ниж�
нюю линию стены и нажмите Enter для завершения команды Îòðåçîê
(LINE). Нижний конец полученного перпендикуляра (рис. 7.22) мы и бу�
дем использовать в качестве базовой точки определения блока.

3. Теперь все готово для создания определения блока. Запустите инструмент
Создать блок (Make Block) (например, введите á (B) в командном окне).

4. В строке списка Имя (Name) введите название нового блока Окно 500,
а в списке Единицы блока (Block unit) выберите значение Безразмер�
ный (Unitless) для создания определения «безразмерного» блока.

5. Щелкните на кнопке Указать (Pick Point) группы Базовая точка (Base
Point) и, переключившись в режим выбора объектов, выберите с помо�
щью режима привязки Конточка (Endpoint) нижний конец только что
начерченного вспомогательного перпендикуляра.

Рис. 7.20  Выбор первой точки линии
с использованием режима привязки Ближайшая (Nearest)

Рис. 7.21  Элементы чертежа, из которых будет создан объект оконного блока

Таким образом, определение блока получено. Оно состоит из трех линий,
которые будут обозначать на чертеже оконный проем и полотно одинарного
стеклопакета. Когда вы будете вставлять в чертеж ссылки на определение это�
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6. Вернувшись в окно Описание блока (Block Definition), щелкните на кноп�
ке Выбрать объекты (Select Objects) группы Объекты (Objects).

7. Снова переключившись в режим выбора элементов чертежа, щелкните на
двух вертикальных линиях, обозначающих оконный проем, и на горизон�
тальной линии, обозначающей стеклопакет, а затем нажмите Enter для за�
вершения выбора. (Вспомогательный перпендикуляр, конечно же, выби�
рать не нужно!). В окне Описание блока (Block Definition) в группе Объекты
(Objects) появится сообщение о том, что было выбрано 3 объекта.

8. Выберите в группе Объекты (Objects) переключатель Delete и щелкните
на кнопке OK. Диалоговое окно Описание блока (Block Definition) авто�
матически закроется, причем все элементы созданного определения
блока будут удалены из чертежа.

9. Удалите оставшийся вспомогательный перпендикуляр.
10. Восстановите предыдущий масштаб просмотра.

Итак, базовое определение блока создано и теперь вы можете приступить
к вставке ссылок на этот блок в соответствующих местах чертежа.

7.3.2. Вставка блока с помощью вспомогательных линий7.3.2. Вставка блока с помощью вспомогательных линий7.3.2. Вставка блока с помощью вспомогательных линий7.3.2. Вставка блока с помощью вспомогательных линий7.3.2. Вставка блока с помощью вспомогательных линий
Окна балкона имеют следующие размеры: в левой и правой стенках ширина
окон составляет по 1000 мм, а посредине – 4 секции шириной 650 мм каждая.
Это означает, что в первых двух случаях нужно использовать значение масш�
табного коэффициента по оси X, равное 2, а в остальных – значение, равное
1.3. Однако сначала нужно создать вспомогательные линии.

1. Измените масштаб просмотра (инструмент Зумирование в реальном
времени (Zoom Realtime)) и расположение чертежа (инструмент Пано�

рамирование в реальном времени (Pan Realtime)) так, чтобы хорошо
видеть чертеж всего балкона и чтобы этот чертеж находился примерно
посреди области черчения.

2. Назначьте текущим созданный ранее слой Окна, а нулевой слой замо�
розьте.

3. Сместите левые вертикальные отрезки контуров наружной стены детс�
кой, прилегающей к балкону, влево на расстояние, равное половине го�
ризонтального отрезка внутреннего контура стены балкона (рис. 7.23).
(Если вы создали чертеж балкона по приведенным в начале главы разме�
рам, то расстояние смещения должно быть равным 575 мм.)

Рис. 7.22  Элементы оконного блока со вспомогательным перпендикуляром

Рис. 7.23  Вспомогательные линии
для вставки оконных блоков шириной 1000 мм созданы

4. Запустите инструмент  Длина (Distance), щелкнув для этого на соот�
ветствующей кнопке панели инструментов Сведения (Inquiry) или выб�
рав из меню команду Сервис ⇒ Сведения ⇒ Расстояние (Tools ⇒ In�
quiry ⇒ Distance) либо введя в командном окне команду äèñò (DIST) или
просто äè (DI).

5. Убедитесь в том, что расстояние от вертикальной внутренней линии
контура балкона до вспомогательных вертикальных линий составляет
575 мм. Для этого подведите указатель�перекрестие к точке, которая на�
ходится в левом нижнем углу внутреннего контура балкона и, используя
режим привязки Конточка (Endpoint), выберите эту точку. Затем подве�
дите указатель�перекрестие к точке, которая находится на пересечении
нижней горизонтальной линии внутреннего контура балкона и нижней
вертикальной линии, и, используя режим привязки Середина (Mid�
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point), выберите эту точку. В последней строке командного появится со�
общение о расстоянии между двумя выбранными точкам по всем трем
осям. Расстояние по оси X должно составлять 575 мм (Äåëüòà X (Delta X) =
575.0).

6. Если хотите подробнее рассмотреть сообщение, выводимое командой
äèñò (DIST), нажмите F2 (рис. 7.24).

задавали в качестве базовой при создании блока (ее будет легко определить по
расположению блока, «приклеенного» к указателю�перекрестию именно базо�
вой точкой). Не забудьте ввести коэффициент масштабирования по оси X, рав�
ный 2, а по оси Y – равный 1 (если просто нажмете Enter, AutoCAD будет ис�
пользовать тот же коэффициент, что и для оси X, то есть 2). Угол поворота
блока оставьте предложенным по умолчанию, то есть равным 0.

При вставке второй ссылки на блок, которая также должна представлять на
чертеже окно шириной 1000 мм, выберите в качестве точки вставки точку, ко�
торая расположена симметрично относительно точки вставки первого блока
(рис. 7.25).

Рис. 7.24  Команда äèñò (DIST) позволяет измерять расстояния и углы
между двумя выбранными точками

7. Нажмите F2 для сокрытия текстового окна AutoCAD, а затем примените
инструмент Длина (Distance) для измерения расстояния между точками,
которые находятся в левом нижнем и левом верхнем углу внутреннего кон�
тура балкона. Оно должно составлять 3050 мм. Итак, если половина ши�
рины оконного блока боковой стенки балкона составляет 500 мм, тогда
ширина рамы равна 75 мм (575 – 500 = 575 мм). Кроме того, можно опреде�
лить, что первая горизонтальная вспомогательная линия отстоит от левого
нижнего угла внутреннего контура балкона на 400 мм (650/2 + 75 = 400 мм).
Приняв же ширину рам между оконными блоками шириной 650 мм рав�
ной 100 мм, мы можем определить, что расстояние между вспомогатель�
ными горизонтальными линиями должно составлять 750 мм.

Совет. Инструмент Длина (Distance) – это очень удобное и полезное средство
AutoCAD, использование которого значительно облегчает как проведение слож�
ных построений и вычислений, так и контроль корректности начерченных
объектов.

8. Сместите нижнюю горизонтальную линию внутреннего контура балкона
вверх сначала один раз на 400 мм, а затем повторите команду Ïîäîáèå
(OFFSET), задав значение смещения 750 мм и каждый раз выбирая для
смещения линию, созданную последней. Получив четыре вспомогатель�
ных линии, нажмите Enter для завершения команды Ïîäîáèå (OFFSET).

Поскольку вспомогательные линии готовы, можно приступать к собственно
вставке блоков. Эта задача, скорее всего, не вызовет у вас особых сложностей,
поэтому автор предлагает вам решить ее самостоятельно. При вставке нижне�
го бокового блока шириной 1000 мм выберите на чертеже ту же точку, которую

Рис. 7.25  Выбор точки вставки второго блока шириной 1000 мм

Единственным отличием от параметров, использовавшихся при вставке
первого блока, является использование в качестве коэффициента масштабиро�
вания по оси Y не значения 1, а значения -1.

При вставке ссылок на блок Окно 500 для создания оконных блоков шири�
ной 650 мм следует выбирать левые оконечные точки созданных вспомогатель�
ных линий (рис. 7.26).

В качестве коэффициента масштабирования по оси X следует ввести значе�
ние 1.3, а в качестве коэффициента масштабирования по оси Y – значение 1.
Для разворота блока относительно точки вставки введите значение угла, рав�
ное 90.

Остальные три блока вставляются аналогично. Завершив вставку всех бло�
ков, удалите вспомогательные линии и с помощью инструмента Зумировать
в границах (Zoom Extents) восстановите предыдущий масштаб просмотра. Ре�
зультат должен быть таким, как показано на рис. 7.27.
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Совет. Если при вставке блоков сбросить флажки Указать на экране (Specify On�
screen) и Угол поворота (Rotation) группы Масштаб (Scale), можно задать масш�
табные коэффициенты и угол поворота в соответствующих строках окна
Вставка блока (Insert). В таком случае изображение блока при вставке сразу бу�
дет иметь нужный размер и ориентацию на чертеже – вам останется лишь за�
дать точку вставки.

7.3.3. Вставка блока с помощью координатного фильтра7.3.3. Вставка блока с помощью координатного фильтра7.3.3. Вставка блока с помощью координатного фильтра7.3.3. Вставка блока с помощью координатного фильтра7.3.3. Вставка блока с помощью координатного фильтра
Для вставки оконного блока шириной 1000 мм, которое будет представлять на
чертеже окно детской, нужно определить длину участка стены от дверного про�
ема окна до начала угловой полки рабочей зоны. Воспользовавшись для этого
инструментом Длина (Distance), режимами объектной привязки, а также от�
слеживанием объектной привязки (рис. 7.28), определяем, что этот участок
стены имеет длину 1050 мм. Это означает, что ширину рамы между дверью бал�
кона и окном детской комнаты мы примем равной 50 мм.

Рис. 7.26  Выбор точки вставки блока шириной 650 мм

Рис. 7.27  Оконные блоки балкона вставлены

Рис. 7.28  Использование режимов объектной привязки
и отслеживания объектной привязки для определения расстояния

Кроме того, в данном случае нам нужно учесть тот факт, что ширина стены
детской в данном месте составляет 350 мм, а ширина оконного блока – 100 мм.
Иными словами, при вставке ссылки на блок Окно 500, мы будем использо�
вать коэффициент масштабирования по оси X, равный 2, а по оси Y – равный
3.5.

Однако самая сложная задача, которую нам предстоит решить в данной си�
туации, – это выбор точки вставки. Можно, конечно, создать дополнительные
линии, как в предыдущем случае. Однако есть и другой, более гибкий метод, не
связанный с дополнительными построениями. Этот метод заключается в при�
менении координатных фильтров (coordinate filter). Координатные фильтры
позволяют использовать только одну координату выбранной точки или пару
таких координат (при черчении в трехмерном пространстве). Например, при
черчении на плоскости, мы, применяя координатные фильтры, сообщаем
AutoCAD, что он должен взять координату X одной точки и координату Y – дру�
гой. AutoCAD самостоятельно «проведет» условные линии от выбранных точек
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до точки их пересечения без использования отслеживания объектной привяз�
ки и других построений.

Давайте рассмотрим, как координатные фильтры применяются на практике.
1. Измените масштаб просмотра так, чтобы хорошо видеть участок стены

от дверного проема до начала угловой полки принтера.
2. Разморозьте слой Высота 720 (чуть позже вы поймете, зачем).
3. Запустите инструмент Вставить блок (Insert), убедитесь в том что в стро�

ке Имя (Name) открывшегося окна Вставка блока (Insert) указано имя
блока Окно 500 и что установлены все три флажка Указать на экране
(Specify On�screen), после чего щелкните на кнопке ОК.

4. В ответ на приглашение задать координаты точки вставки введите в ко�
мандном окне .X (символ точки, за которым без пробела следует символ
X). AutoCAD тут же отобразит приглашение of, которое означает, что вы
должны задать точку, у которой следует использовать координату X.

5. Выберите точку, которая находится в правом нижнем углу контура сте�
ны, как показано на рис. 7.29. (Можно выбрать и любую другую точку на
этой вертикальной линии стены детской, но в данном случае выбор обус�
ловлен тем, что мы точно знаем расстояние от выбранной точки до нуж�
ной нам точки по вертикали.)

поскольку она у нас в этой книге всегда равна 0). Подведите указатель�
перекрестие к середине нижней линии контура малой тумбы (рис. 7.30) и
щелкните для ее захвата (можно выбрать и любую другую точку на этой
линии, но середину выбрать проще всего).

Рис. 7.29  Выбор точки, координату X которой
мы отфильтровываем с помощью координатного фильтра

6. Как только вы щелкните для захвата точки, AutoCAD не вставит блок, как
это было в предыдущих случаях, а отобразит следующее приглашение
(òðåáóåòñÿ YZ: (need YZ:)), которое означает, что теперь нужно задать
координату Y точки вставки блока (координату Z мы вводить не будем,

Рис. 7.30  Выбор точки, координату Y которой
мы будем использовать вместо координаты Y первой точки

7. Введите 2 в качестве масштабного коэффициента по оси X.
8. Введите 3.5 в качестве масштабного коэффициента по оси Y.
9. Введите 90 в качестве значения угла поворота. Оконный блок займет

свое место на чертеже.
10. Восстановите предыдущий масштаб просмотра и заморозьте слой Высо�

та 720 (рис. 7.31).
Сохраните текущее состояние чертежа в файле Work071.dwg, а затем сохра�

ните его же в файле с именем Work072.dwg.

7.4. Модификация определения блока7.4. Модификация определения блока7.4. Модификация определения блока7.4. Модификация определения блока7.4. Модификация определения блока
Часто при работе с блоками возникает необходимость внести модификации в
описание блока. Например, в нашем случае может возникнуть необходимость
изменить заменить все одинарные стеклопакеты двойными. В подобных ситуа�
циях достаточно изменить свойства любой ссылки на блок, вставленной в чер�
теж с одинаковыми масштабными коэффициентами по осям X и Y.

Однако поскольку мы вставляли все блоки с разными масштабными коэф�
фициентами, нам остается лишь вставить еще одну ссылку на определение бло�
ка Окно 500, не изменяя принятых по умолчанию масштабных коэффициен�
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тов, и отредактировать его. Сохранив модифицированный блок, мы тем самым
автоматически изменим все ссылки на соответствующее определение блока,
вставленные в чертеж.

Примечание. Блоки можно перемещать, поворачивать, копировать, удалять,
масштабировать и разгруппировывать, но нельзя обрезать, продлять, смещать
или сопрягать. Кроме того, нельзя удалять или смещать часть блока. Все объек�
ты блока сгруппированы вместе и рассматриваются AutoCAD как один объект.

1. Запустите инструмент Вставить блок (Insert), выберите для вставки
блок Окно 500 и щелкните на кнопке OK.

2. Выберите произвольную точку посредине детской, а затем три раза на�
жмите Enter для вставки блока с параметрами, установленными по умол�
чанию.

3. Измените масштаб просмотра так, чтобы вставленная ссылка на блок за�
нимала всю область черчения, и выберите из меню команду Сервис ⇒
Внешняя ссылка или блок для местного редактирования ⇒ Редакти�
рование вхождений (Tools ⇒ Xref and Block In�place Editing ⇒ Edit
Reference In�place) либо введите в командном окне Ññûëðåä).

4. В ответ на приглашение AutoCAD выбрать блок щелкните на только что
вставленном блоке.

5. В появившемся окне Редактирование вхождений (Reference Edit) выбе�
рите переключатель Подтверждать выбор вложенных объектов (Prompt
to select nested objects) и щелкните на кнопке OK.

6. Окно Редактирование вхождений (Reference Edit) закроется, а в коман�
дном окне появится приглашение выбрать вложенные объекты.

Рис. 7.31  Все оконные блоки вставлены

7. Выберите горизонтальную линию, представляющую одинарный стекло�
пакет, и нажмите Enter для завершения выбора.

8. Линия исчезнет с экрана, а на экране появится плавающая панель инст�
рументов РедСсыл (Refedit).

9. Разморозьте нулевой слой – только что исчезнувшая линия снова появит�
ся на экране, причем по ее цвету можно будет понять, что она находится
на нулевом слое (рис. 7.32).

Рис. 7.32  После выбора линии редактируемого блока
она автоматически переместилась на нулевой слой,

на котором было создано определение блока

10. Сместите линию, представляющую одинарный стеклопакет, вверх и
вниз на 10 мм, после чего удалите исходную линию. Таким образом, опре�
деление оконного блока теперь представлять окно с двойным стеклопа�
кетом.

11. Щелкните на кнопке  Сохранить изменения вхождения (Save Refe�
rence Edit) панели инструментов РедСсыл (Refedit) или выберите из
меню команду Сервис ⇒ Внешняя ссылка или блок для местного ре�
дактирования ⇒ Закрыть вхождение (Tools ⇒ Xref and Block In�place
Editing ⇒ Close Reference) либо введите в командном окне Ññûëçàêð
(REFCLOSE).
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12. В появившемся окне предупреждения щелкните на кнопке OK.
13. Цвет двух новый линий изменится – это означает, что определение бло�

ка было модифицировано. Удалите блок, поскольку он нам уже не нужен.
14. Заморозьте нулевой слой, а затем восстановите предыдущий масштаб

просмотра и убедитесь в том, что все оконные блоки теперь приобрели
двойные стеклопакеты (рис. 7.33).

справа на рабочую зону, вы сможете вставить этот блок из файла, а не вычерчи�
вать его заново.

1. Разморозьте и назначьте текущим нулевой слой, а затем заморозьте все
остальные слои и разморозьте слой Высота 758.

2. Измените масштаб просмотра так, чтобы хорошо видеть изображение
ручки на верхней крышке парты.

3. Скопируйте прямоугольник и прямую линию, образующую чертеж руч�
ки, на нулевой слой, после чего заморозьте слой Высота 758.

4. Создайте определение блока Ручка, включив в него два объекта: прямо�
угольник, представляющий контур выреза под ручку, и линию, обознача�
ющую контур верхней части ручки. Блок сделайте безразмерным, выбе�
рите переключатель Delete для удаления исходных объектов после
создания определения блока, а в качестве точки вставки выберите точку,
показанную на рис. 7.34.

Рис. 7.33  Все ссылки на определение блока Окно 500 модифицированы

7.5. Сохранение блоков в отдельных файлах7.5. Сохранение блоков в отдельных файлах7.5. Сохранение блоков в отдельных файлах7.5. Сохранение блоков в отдельных файлах7.5. Сохранение блоков в отдельных файлах
Все определения блоков, которые мы создавали до настоящего момента, хра�
нились в текущем файле чертежа. Однако, как говорилось в начале главы, бло�
ки можно сохранять в отдельных файлах на диске и вставляться в чертежи из
таких файлов. Именно это обстоятельство и является одной из основных пре�
имуществ использования блоков перед группами. Применяя такой подход, на
диске можно создать целую библиотеку типичных объектов, которые впослед�
ствии будут использованы в самых различных чертежах.

Следует отметить, что при сохранении блока на диске все образующие его
элементы разгруппировываются, поэтому соответствующий файл с расшире�
нием dwg можно открыть и отредактировать точно так же, как и любой файл
AutoCAD. При вставке блока из файла в другой чертеж все элементы снова ав�
томатически группируются в блок.

Изучение принципов работы с блоками, сохраняемыми на диске, мы прове�
дем на примере блока Ручка, который будет создан из чертежа врезной ручки
крышки парты. В следующей главе, когда мы будем создавать виды спереди и

Рис. 7.34  Создание определения блока Ручка

5. Восстановите предыдущий масштаб просмотра, разморозьте и назначь�
те текущим слой Вид сверху, а нулевой слой заморозьте.

6. Примените инструмент Зумирование в границах (Zoom Extents) для из�
менения масштаба по границам чертежа. Теперь все готово для записи
блока на диск и последующей вставки его с диска.

7. Введите в командном окне команду ïáëîê (WBLOCK) или просто ïá (W)
(команда ïáëîê (WBLOCK) относится к тем редким командам AutoCAD,
которые не представлены ни на панели инструментов, ни в системе
меню AutoCAD).

8. В открывшемся диалоговом окне Запись блока на диск (Write Block)
щелкните в группе Источник данных (Source) на переключателе Блок
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(Block) и выберите из ставшего доступным списка определение блока
Ручка (рис. 7.35). В группе Размещение (Destination), если необходимо,
введите новое имя блока.

Рис. 7.35  Диалоговое окно
Запись блока на диск (Write Block)

9. Убедитесь в том, что в списке Запись блока на диск (Write Block) выбра�
но значение Безразмерный (Unitless), а затем щелкните на кнопке OK
для закрытия окна Запись блока на диск (Write Block).

10. Если хотите, можете удостовериться в том, что в выбранной вами папке
появился новый файл (по умолчанию – Ручка.dwg).

11. Сохраните текущее состояние чертежа в файле Work072.dwg, а затем зак�
ройте файл.

12. Откройте файл Work062.dwg. Как вы помните, в этом файле отсутствова�
ли определения блоков, которые были созданы вами в ходе изучения ма�
териала этой главы и сохранены в файлах Work071.dwg и Work072.dwg.
Сохраните чертеж в файле с именем Work081.dwg (мы начнем работу
в следующей главе именно с этого чертежа).

13. Увеличьте изображение крышки парты так, чтобы хорошо видеть учас�
ток с чертежом ручки, а затем удалите этот чертеж (прямоугольник и ли�
нию, которая делите его пополам).

14. Запустите инструмент Вставить блок (Insert Block), но в этот раз в окне
Вставка блока (Insert) не пытайтесь выбрать блок из раскрывающегося
списка Имя (Name) (этот список все равно будет пустым), а щелкните на
кнопке Обзор (Browse).

15. В открывшемся окне выберите файл Ручка.dwg и щелкните на кнопке
Открыть (Open). Название блока Ручка появится в списке Имя (Name).

16. Убедитесь в том, установлен флажок Указать на экране (Specify On�
screen) группы Точка вставки (Insertion point), и сбросьте два остальных
флажка Указать на экране (Specify On�screen) групп Масштаб (Scale)
и Угол поворота (Rotation), а затем щелкните на кнопке OK.

17. Вставьте появившийся возле указателя�перекрестия блок на место пре�
дыдущего чертежа ручки (рис. 7.36).

18. Восстановите предыдущий масштаб просмотра и сохраните текущее со�
стояние чертежа в файле Work081.dwg.

Если хотите, можете снова открыть чертеж Work072.dwg и создать другие
блоки (например, для оборудования рабочей зоны) и сохранить их в файлах на
диске.

В следующей главе мы продолжим работу с только что созданным файлом
чертежа Work081.dwg и займемся созданием видов рабочей зоны в проекциях
спереди и справа. Что касается файлов, созданных в этой главе (Work071.dwg
и Work072.dwg), то мы к ним еще вернемся в главе 12, посвященной вопросам
создания многофайловых чертежей с использованием так называемых вне�
шних ссылок.

Рис. 7.36  Чертеж ручки вставлен из файла в виде ссылки на блок Ручка
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В предыдущих главах книги мы неоднократно говорили о видах сверху
и спереди, однако при этом подразумевали, скорее, обыденное толко�
вание соответствующих понятий, чем строгие технические термины.

В частности, созданные вами чертежи, находящиеся на слоях с именами Высо�
та NNNN, представляют собой не виды сверху, а разрезы (именно поэтому мы
дали название Вид сверху только одному слою, который действительно содер�
жит те объекты, которые должны быть изображены на виде сверху). В этой гла�
ве мы займемся созданием чертежей видов рабочей зоны в полном смысле тех�
нического термина «вид».

Автор напомнит, что в черчении видом называется изображение трехмер�
ного объекта на плоскости. В соответствии с общепринятыми стандартами,
при создании двухмерных представлений реальных трехмерных объектов со�
здаются изображения на трех плоскостях, расположенных под прямым углом
одна к другой. Полученные изображения и называются видами в ортогональ�
ных проекциях. Плоскости проекций выбираются так, чтобы максимальную
информацию о форме и размерах изображенного объекта можно было полу�
чить из вида на фронтальной проекции. Этот вид считается главным и называ�
ется видом спереди. Если вида спереди недостаточно, создают еще два вида: вид
сверху (проекция объекта на горизонтальную плоскость) и вид слева (проекция
объекта на вертикальную плоскость). Виды спереди, сверху и слева, а также
виды справа, снизу и сзади называются основными видами. В случае необходимо�
сти, на чертеже можно использовать все основные виды, однако, как правило,
такая необходимость возникает лишь при черчении очень сложных объектов
или при неправильном выборе вида спереди. В подавляющем большинстве слу�
чаев можно обойтись двумя�тремя видами с применением дополнительных видов
(проекций на плоскости, не параллельные ни одной из основных плоскостей
проекций) или местных видов (изображений отдельных фрагментов объекта),
а также разрезов и сечений.

Поскольку наш проект является учебным, мы начали его создание с вида
сверху, который в нашем случае создать проще, чем другие виды. Теперь, ис�
пользуя этот вид, мы займемся созданием главного вида (то есть вида спереди),
а также вида справа. Вы убедитесь, насколько проще создавать виды в AutoCAD,
чем при традиционном черчении – значительную часть работы мы выполним,
используя за основу уже имеющиеся объекты чертежа.

Примечание. В AutoCAD также имеется термин вид (view), однако при черчении
на плоскости в его использовании нет никакого смысла – все двумерные чертежи
выполняются в AutoCAD в горизонтальной плоскости, соответствующей виду
сверху (top view). Поэтому в дальнейшем, когда мы будем говорить о видах, помни�
те, что речь идет об общепринятой в двухмерном черчении терминологии, а не
о терминах AutoCAD.

8.1. Создание главного вида8.1. Создание главного вида8.1. Создание главного вида8.1. Создание главного вида8.1. Создание главного вида
В соответствии с требованиями стандартов, вид спереди (он же – главный
вид), чертится под видом сверху. Такое расположение продиктовано не только
и не столько соображениями эстетики, сколько здравым смыслом: чертеж, на
котором вид спереди находится строго под видом сверху не только легче вос�
принимать, но и легче создавать. Последнее объясняется тем, что для получе�
ния элементов чертежа главного вида можно использовать вертикальные ли�
нии, проходящие из характерных точек чертежа вида сверху до пересечения
с горизонтальными линиями основных высот (рис. 8.1).

Первая высота, которую нам нужно создать – это нулевая высота, соответ�
ствующая уровню пола. Для получения горизонтальной линии, которая будет
обозначать нулевую высоту, выполните следующие операции.

8ГГГГГлавалавалавалавалава
Создание видовСоздание видовСоздание видовСоздание видовСоздание видов
в ортогональныхв ортогональныхв ортогональныхв ортогональныхв ортогональных
проекцияхпроекцияхпроекцияхпроекцияхпроекциях

Рис. 8.1  Основные высоты чертежа рабочей зоны на виде спереди
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1. Откройте файл Work081.dwg, если вы закрыли его после изучения пре�
дыдущей главы.

2. Воспользовавшись командой Ñëîè (LAYERS), создайте новый слой Вид
спереди (индекс цвета – 96) и назначьте его текущим.

3. Разморозьте нулевой слой, выделите нижнюю горизонтальную линию
границы рабочей зоны и сместите ее вниз с помощью команды Ïîäîáèå
(OFFSET) на 3000 мм.

4. Поскольку смещенная линия располагается вне видимой части чертежа,
нужно изменить масштаб просмотра. Воспользуйтесь командой Çóìèðî-
âàòü ãðàíèöû (ZOOM EXTENTS) (ïî ã) для изменения масштаба по гра�
ницам чертежа.

5. С помощью команды Ñëîè (LAYCUR) переместите ставшую видимой ли�
нию на текущий слой, а затем заморозьте нулевой слой.

6. Запустите инструмент Зумирование в реальном времени (Zoom Real�
time) и отрегулируйте масштаб просмотра таким образом, чтобы линия
нулевой высоты на виде сверху находилась на некотором расстоянии от
нижней границы области черчения, как показано на рис. 8.2.

няя поверхность больших консольных полок), а вторая – верхней поверх�
ности задней стенки рабочей зоны. Результат должен быть таким, как
показано на рис. 8.3.

Рис. 8.2  Пространство, подготовленное для размещения на чертеже главного вида

7. Руководствуясь рис. 8.1, сместите базовую линию несколько раз вверх (на
18, 320, 622, 720, 758, 1036, 1188, 1276 и 1358 мм), перед каждым запуском
команды Ïîäîáèå (OFFSET) устанавливая соответствующую величину
смещения.

8. Снова воспользовавшись инструментом Подобие (Offset), сместите ба�
зовую линию вверх на 1620, а затем – на 1740 мм. Первая полученная ли�
ния обозначает высоту, которая соответствует слою Вид сверху (верх�

Рис. 8.3  Базовые горизонтальные линии для создания главного вида рабочей зоны

Остальные горизонтальные линии мы получим несколько позже, смещая
только что созданные линии, а сейчас займемся созданием вертикальных ли�
ний, выходящих из характерных точек вида сверху (включая не только соб�
ственно слой Вид сверху, но и другие слои).

8.1.1. Использование маркеров выделения8.1.1. Использование маркеров выделения8.1.1. Использование маркеров выделения8.1.1. Использование маркеров выделения8.1.1. Использование маркеров выделения
для запуска режима «Копировать» (Copy)для запуска режима «Копировать» (Copy)для запуска режима «Копировать» (Copy)для запуска режима «Копировать» (Copy)для запуска режима «Копировать» (Copy)
инструмента «Переместить» (Move)инструмента «Переместить» (Move)инструмента «Переместить» (Move)инструмента «Переместить» (Move)инструмента «Переместить» (Move)
Нужные нам вертикальные линии можно было бы просто вычертить, исполь�
зуя инструмент С линиями (Line) и соответствующие режимы привязки. Одна�
ко мы в данной ситуации применим несколько иной подход, заключающийся
в использовании уже упоминавшихся в предыдущих главах маркеров выделения
(grip). Дело в том, что эти маркеры применяются не только для визуализации
выделенных объектов, но и для их модификации. Во многих случаях измене�
ние формы объекта с помощью маркера выделения оказывается предпочти�
тельнее, чем применение обычных инструментов AutoCAD.

1. Убедившись в том, что включен режим привязки Конточка (Endpoint),
начертите вертикальную линию от нижнего левого угла столешницы до
линии нулевой высоты.

2. Щелкните на только что начерченной линии, чтобы на ней появились
уже знакомые вам маркеры выделения.
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3. Щелкните на маркере выделения, расположенном на верхнем конце ли�
нии. Цвет маркера изменится с синего на красный, а в командной строке
появится приглашение следующего вида.
** Ðàñòÿãèâàíèå ** (** STRETCH **)
Òî÷êà ðàñòÿãèâàíèÿ èëè [Áàçîâàÿ òî÷êà/Êîïèðîâàòü/Îòìåíèòü/
Âûõîä] (Specify stretch point or [Base point/Copy/Undo/eXit]).

4. Это означает, что, выбрав маркер, вы тем самым запустили инструмент
Растянуть (Stretch). Данный инструмент всегда запускается первым при
выборе любого маркера выделения. Поскольку в данном случае инстру�
мент Растянуть (Stretch) нам не нужен, нажмите Пробел для перехода
к следующему инструменту.

5. Теперь в сообщении командного окна говорится о том, что запущен ин�
струмент Переместить (Move). Нажмите Пробел несколько раз, чтобы
убедиться в том, что после выбора маркера выделения AutoCAD каждое
нажатие этой клавиши приводит к циклическому выбору одного из пяти
инструментов (Растянуть (Stretch), Переместить (Move), Повернуть
(Rotate), Масштаб (Scale), Зеркальное отражение (Mirror)).

6. Нажав Пробел несколько раз, вернитесь к инструменту Переместить
(Move), а затем введите в командном окне Êîïèðîâàòü (COPY) или про�
сто ê (C) для запуска режима Копировать (Copy) этого инструмента.

Примечание. Каждый из пяти инструментов, которые можно запустить с по�
мощью маркеров выделения, поддерживает режим Копировать (Copy), обеспечи�
вающий внесение всех изменений не в исходный объект, а в его копию. Кроме того,
копирование с помощью маркеров выделения позволяет использовать несколько
дополнительных функциональных возможностей, недоступных при обычном ис�
пользовании инструмента Копировать (Copy).

7. Используя режимы объектной привязки и отслеживание объектной при�
вязки, выберите точку, которая находится на пересечении перпендику�
ляров, образующих правый нижний угол габаритов рабочей зоны для ко�
пирования в эту точку выделенной линии (рис. 8.4).

8. Режим копирования останется по�прежнему включенным. Выберите
нижние точки вертикальных линий, обозначающих левую и правую гра�
ницу крышки парты. В результате копия исходной линии появится возле
каждой из этих двух точек. Введите Âûõîä (EXIT) или просто X для завер�
шения работы инструмента Переместить (Move), а затем нажмите
Esc для отмены отображения маркеров выделения. Как легко заметить
(рис. 8.5), две последние линии не достигают линии нулевой высоты.
Это не удивительно: поскольку мы выполняли копирование исходной
линии, все ее копии имеют одинаковую длину, независимо от того, где
находятся их начальные точки. Однако это не имеет особого значения,
поскольку мы всегда сможем их продлить для получения нужной длины
(в том числе, с использованием инструмента Растянуть (Stretch), запус�
каемого с помощью маркера выделения).

Итак, вы только что познакомились с методом копирования объектов, осно�
ванным на использовании маркеров выделения. Это довольно необычный ме�
тод применения маркеров выделения, который многим начинающим пользо�
вателям AutoCAD кажется слишком сложным. Действительно, использование
маркеров выделения, например, для определения принадлежности объекта
к блоку, рассматривавшееся в главе 7, является интуитивно понятным. Тем не

Рис. 8.4  Копирование линии с помощью маркера выделения
и режимов объектной привязки

Рис. 8.5  Вертикальные линии, скопированные с помощью маркеров выделения
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менее, возможности маркеров выделения гораздо шире, чем простая визуали�
зация выбранных объектов.

Без преувеличения можно сказать, что маркеры выделения представляют
собой интерфейс для оперативного редактирования объектов с помощью ин�
струментов Растянуть (Stretch), Переместить (Move), Повернуть (Rotate),
Масштаб (Scale) или Зеркальное отражение (Mirror). Да, конечно же, следует
признать, что запуск этих инструментов с помощью маркеров выделения не�
сколько отличается от традиционного способа их использования. Однако, с
другой стороны, эти отличия связаны с тем, что в случае запуска упомянутых
инструментов с помощью маркеров выделения пользователю предоставляются
некоторые дополнительные функциональные возможности. В частности, как
уже отмечалось выше, все пять инструментов поддерживают режим Копиро�
вать (Copy), позволяющий оставлять исходный объект без изменений. Поэто�
му, если вы, например, вращаете объект с маркерами выделения, вы можете, не
изменяя исходного объекта, создать несколько его копий, расположенных под
разными углами. В обычном режиме инструменты Повернуть (Rotate) и Копи�
ровать (Copy) не поддерживают такую функциональную возможность.

Поэтому, освоив методы работы с маркерами выделения, вы не только обо�
гатите свой арсенал, но и сможете выполнять целый ряд операций с меньшими
затратами времени. Для того чтобы запустить один из пяти инструментов, ак�
тивизирующихся с помощью маркеров выделения, выполните следующие дей�
ствия.

1. Не запуская никаких инструментов AutoCAD, щелкните на объекте, кото�
рый необходимо изменить.

2. Щелкните на маркере выделения, который при выполнении последую�
щих операций будет использоваться в качестве базового.

3. Нажимая Пробел, выберите нужный вам инструмент из перечисленного
выше набора. (Можно также щелкнуть правой кнопкой мыши и выбрать
нужную команду из появившегося меню, пока�
занного на рис. 8.6.)

4. Выберите нужный режим из режимов, предло�
женных инструментом.

5. Для завершения работы инструмента введите X.
6. Для удаления маркеров выделения нажмите Esc.

Совет. При запуске того или иного инструмента
с помощью маркеров выделения очень важно правиль�
но выбрать маркер, который будет использоваться
в качестве базового. Именно недопонимание роли базо�
вого маркера приводит к путанице в использовании
соответствующих инструментов начинающими

пользователями. Поэтому, запуская эти инструменты традиционным мето�
дом, не упускайте возможности попрактиковаться в выполнении аналогичных
операций с использованием маркеров выделения, чтобы разобраться в нюансах их
работы.

Поскольку использование маркеров выделения нельзя отнести к основным
методам работы в AutoCAD, мы не будем останавливаться на их изучении де�
тально. Тем не менее, сведений, приведенных по данному вопросу в этой и пос�
ледующих главах, вполне достаточно, чтобы усвоить основные принципы ра�
боты с маркерами выделения.

8.1.2. Формирование нижней части рабочей зоны8.1.2. Формирование нижней части рабочей зоны8.1.2. Формирование нижней части рабочей зоны8.1.2. Формирование нижней части рабочей зоны8.1.2. Формирование нижней части рабочей зоны
с использованием инструментов «Ус использованием инструментов «Ус использованием инструментов «Ус использованием инструментов «Ус использованием инструментов «Удлинить» (Extend)длинить» (Extend)длинить» (Extend)длинить» (Extend)длинить» (Extend)
и «Обрезать» (Tи «Обрезать» (Tи «Обрезать» (Tи «Обрезать» (Tи «Обрезать» (Trim)rim)rim)rim)rim)
Как нетрудно догадаться, для получения вида спереди вам предстоит обрезать
пересекающиеся горизонтальные линии высот и вертикальные линии, прове�
денные из характерных точек вида сверху, продлевая эти линии в случае необхо�
димости. Для удобства мы сначала сформируем те элементы чертежа, которые
относятся к нижней части рабочей зоны, а затем займемся верхней частью.

1. Заморозьте слой Вид сверху и разморозьте слой Высота 320, как наибо�
лее информативный для решения текущей задачи.

2. Продлите с помощью инструмента Удлинить (Extend) до нулевой высо�
ты две вертикальные линии, обозначающие границы крышки парты.

3. С помощью маркера выделения только что продленной вами левой вер�
тикальной линии скопируйте ее в точку, обозначающую правую границу
малой тумбы.

4. Выполните аналогичную операцию над правой вертикальной линией,
обозначающей контур парты, скопировав ее в точку, которая представ�
ляет на чертеже правую границу задней стенки рабочей зоны, а затем
продлите эту линию до нулевой высоты (рис. 8.7).

5. Запустите инструмент Обрезать (Trim) и выберите в качестве секущих
линию нулевой высоты, линии высот 18 и 622, а также вертикальную ли�
нию, обозначающую границу малой тумбы (рис. 8.8).

6. Нажмите Enter для завершения выбора, а затем щелкните на сегментах
вертикальной линии, выступающих ниже высоты 0 и выше высоты 622.

7. Щелкните на горизонтальной линии, обозначающей высоту 18, правее
только что полученного отрезка вертикальной линии.

8. Нажмите Enter для завершения команды Îáðåçàòü (TRIM). Результат
должен быть таким, как показано на рис. 8.9.

9. Измените масштаб просмотра так, чтобы вид спереди занимал почти всю
область черчения.

10. С помощью инструмента Подобие (Offset) сместите на 18 мм вниз гори�
зонтальные линии высот 320, 622 и 758, а также на 18 мм вправо верти�
кальные линии границ контуров малой тумбы и правой границы парты.

Рис. 8.6  Контекстное меню маркера выделения,
выбранного в качестве базового
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Затем сместите на 18 мм влево вертикальную линию левой границы
парты (рис. 8.10).

11. Обрежьте линии так, как показано на рис. 8.11, для формирования контуров
малой тумбы, парты и угловой полки дополнительного рабочего места.

Совет. Помните, что команда Îáðåçàòü (TRIM) позволяет отменить резуль�
тат неправильно выполненной обрезки линии. Для этого необходимо ввести Îò-
ìåíèòü (UNDO) или просто î (U), в результате чего последняя операция будет
отменена. После этого можно продолжить работу.

12. Восстановите масштаб просмотра и создайте вертикальные линии, обо�
значающие на виде спереди вертикальные контуры большой тумбы, тум�

Рис. 8.7  Две линии продлены,
левая линия скопирована для обозначения правой границы малой тумбы,

а правая – для обозначения правой границы задней стенки

Рис. 8.8  В качестве секущих ребер
выбраны три горизонтальных и одна вертикальная линии

Рис. 8.9  Контур малой тумбы сформирован

Рис. 8.10  Вид спереди после копирования линий стенок на 18 мм
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бы системного блока, нижней и верхней угловых полок, порожка и фаса�
да малой тумбы, как показано на рис. 8.12.

13. Скопируйте линию нулевой высоты вверх на 100 мм, а затем полученную
линию – еще на 18 мм вверх.

14. Обрежьте две полученные горизонтальные линии по правой вертикаль�
ной границе контура малой тумбы и левой вертикальной границе конту�
ра парты.

15. Продлите созданные в п. 12 вертикальные линии до линии нулевой высо�
ты, а затем обрежьте полученные вертикальные и горизонтальные ли�
нии для формирования оставшихся объектов нижней части рабочей
зоны, как показано на рис. 8.13. (Для создания контура порожка необхо�
димо верхнюю линию контура нижней полки скопировать вверх на 2 мм –
для этого лучше всего изменить масштаб просмотра.)

Рис. 8.11  Контуры основных объектов нижней части сформированы

Рис. 8.12  Вертикальные границы оставшихся объектов нижней части рабочей зоны

Рис. 8.13  Контуры объектов нижней части рабочей зоны сформированы

Таким образом, процедура черчения главного вида сводится к опусканию
линий из точек вида сверху с применением инструмента Удлинить (Extend) и
последующей их обрезке с использованием линий высот. Самый главный на�
вык, который вы должны выработать для овладения этой процедурой, заклю�
чается в умении четко выделять из хаоса взаимно пересекающихся линий необ�
ходимые сегменты и надлежащим образом применять инструмент Обрезать
(Trim).

8.1.3. Формирование верхней части рабочей зоны8.1.3. Формирование верхней части рабочей зоны8.1.3. Формирование верхней части рабочей зоны8.1.3. Формирование верхней части рабочей зоны8.1.3. Формирование верхней части рабочей зоны
Продолжим создание главного вида рабочей зоны и приступим к созданию чер�
тежей объектов, которые находятся над столешницей.

1. Заморозьте слой Высота 320 и разморозьте слой Высота 1090.
2. Используя инструменты С линиями (Line) и Нормаль (Snap to Perpen�

dicular), проведите вертикальную линию от правого нижнего угла конту�
ра боковой стенки правой стойки для компакт�дисков до пересечения
с верхней горизонтальной линией, соответствующей высоте 758 мм
(верхняя поверхность столешницы), как показано на рис. 8.14.
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3. Используя копирование с помощью маркера выделения, скопируйте по�
лученную линию в левый нижний угол прямоугольника, обозначающего
контур боковой стенки правой стойки для компакт�дисков.

4. Не выходя из режима копирования инструмента Переместить (Move),
скопируйте линию к нижним точкам контура боковой стенки левой стой�
ки для компакт�дисков, к середине вертикальной линии контура полки,
а также к нижним точкам контура средней стенки парты.

5. Сместите вниз на 18 мм три горизонтальные линии, соответствующие
высотам 1036, 1188 и 1276 мм. Результат должен быть таким, как показа�
но на рис. 8.15.

6. Используя инструмент Обрезать (Trim), сформируйте контуры стоек
для компакт�дисков, полки принтера и полок парты (рис. 8.16). Если не�
обходимо, измените масштаб просмотра с помощью инструмента Окно
зумирования (Zoom Window), а для возврата к предыдущему масштабу
применяйте инструмент Зумировать предыдущий (Zoom Previous).

7. Сместите вниз на 18 мм горизонтальную линию, соответствующую высо�
те 1358 мм, а затем обрежьте обе полученные линии для формирования
контура средней полки рабочего места старшеклассника (рис. 8.17).

8. Используя инструмент Удлинить (Extend), продлите вертикальную ли�
нию, обозначающую левую границу только что созданного контура полки,
до линии, которая обозначает верхнюю границу контура столешницы.
Обрежьте полученную линию сверху, используя в качестве секущей ниж�
нюю горизонтальную линию контура этой же полки (левая вертикальная
граница контура полки исчезнет, но этот дефект мы вскоре исправим).

9. Используя режим постоянно действующей привязки Середина (Mid�
point), разовой привязки Нормаль (Snap to Perpendicular) и инструмент

С линиями (Line), создайте вспомогательную линию, разделяющую по�
полам пространство между средней полкой и столешницей (рис. 8.18).

10. Сместите полученную вспомогательную горизонтальную линию вниз и
вверх на 9 мм, а затем удалите вспомогательную линию (если нужно, из�
мените для выбора линии масштаб просмотра).

Рис. 8.14  Перпендикуляр, проведенный до уровня верхней грани столешницы Рис. 8.15  Горизонтальные и вертикальные линии, необходимые
для создания контуров стоек компакт>дисков, полки принтера и полок парты

Рис. 8.16  Контуры стоек компакт>дисков,
полки принтера и полок парты сформированы
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11. Продлите вертикальную линию, обозначающую левые границы нижней
и средней полок, до высоты 1358 мм (то есть до верхней линии контура
средней полки), а затем обрежьте эту линию по горизонтальным грани�
цам средней и нижней полок.

12. Сместите вверх на 100 мм верхнюю границу полки парты, соответствую�
щую высоте 1188 мм, продлите ее вправо на 18 мм (до пересечения с пра�

вой вертикальной границей контура боковой стенки), а затем обрежьте
две вертикальные линии правой боковой стенки полок парты по уровню
полученной линии. Чертеж на данном этапе должен иметь вид, представ�
ленный на рис. 8.19.

Рис. 8.17  Создание контура средней полки рабочего места старшеклассника

Рис. 8.18  Создание контура средней полки рабочего места старшеклассника

Рис. 8.19  Основные объекты до высоты 1358 мм сформированы

13. Восстановите, если нужно, предыдущий масштаб просмотра, заморозьте
слой Высота 1090 и разморозьте слой Вид сверху.

14. Используя копирование с помощью маркеров выделения, скопируйте
вертикальную линию, обозначающую контур боковой стенки парты, к се�
рединам левой и правой вертикальных линий, обозначающих на виде
сверху контуры верхних полок (рис. 8.20).

15. Сместите на 18 мм вниз линию, соответствующую высоте 1620 мм, а за�
тем обрежьте вертикальные и горизонтальные линии чертежа главного
вида так, чтобы сформировать объекты, находящиеся в верхней части
рабочей зоны (рис. 8.21).

8.1.4. Завершение формирования главного вида8.1.4. Завершение формирования главного вида8.1.4. Завершение формирования главного вида8.1.4. Завершение формирования главного вида8.1.4. Завершение формирования главного вида
Для получения полноценного вида спереди осталось сделать не так уж много
(если, конечно, не брать во внимание чертежи оборудования): создать изоб�
ражение подставки под клавиатуру, ручек на большой тумбе и выдвижном
ящике парты, цилиндрических опор тумб и полок, а также полочек для ком�
пакт�дисков, которые должны быть видны на чертеже левой стойки компакт�
дисков.
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Вставка блока из файлаВставка блока из файлаВставка блока из файлаВставка блока из файлаВставка блока из файла
Для начала мы займемся вставкой изображений ручек, которые, как вы помни�
те из прошлой главы, были сохранены на диске в виде блоков Ручка.dwg.

1. Используя режим привязки Середина (Midpoint) и инструмент Нор�
маль (Snap to Perpendicular), начертите горизонтальную линию, разде�
ляющую контур большой тумбы пополам.

2. Скопируйте полученную линию с помощью маркеров выделения вверх
так, чтобы она точно совпала с горизонтальной линией, образующей
верхнюю границу контура большой тумбы (рис. 8.22). Эта линия будет
использоваться в качестве вспомогательной для вставки изображения
ручки.

Рис. 8.20  Копирование вертикальных линий к серединам контуров верхних полок

Рис. 8.21  Формирование основных объектов главного вида завершено

Рис. 8.22  Создание вспомогательной горизонтальной линии
с использованием маркеров выделения

3. Запустите инструмент Вставить блок (Insert Block) (например, введите в
командном окне в (I)), а затем выберите в открывшемся окне блок Ручка
(если нужно, воспользуйтесь кнопкой Обзор (Browse), чтобы найти соот�
ветствующий файл на диске).

4. Убедитесь в том, что установлен флажок Указать на экране (Specify On�
Screen) группы Точка вставки (Insertion point) и сбросьте два остальных
флажка Указать на экране (Specify On�Screen) групп Масштаб (Scale) и
Угол поворота (Rotation), а затем щелкните на кнопке OK.

5. Используя режим привязки Середина (Midpoint), а также режим отсле�
живания объектной привязки, вставьте изображение ручки на 34 мм
ниже середины линии, созданной в п. 1.

6. Повторите операции, описанные в пп. 3–5 для вставки блока Ручка на
чертеж фасада верхнего ящика большой тумбы (рис. 8.23) и фасада выд�
вижного ящика парты. При вставке задавайте то же смещение на 34 мм
вниз от середины верхней линии контура фасада.

7. Щелкните на вспомогательной линии, созданной в п. 2, и удалите ее.
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Использование блоков для создания чертежейИспользование блоков для создания чертежейИспользование блоков для создания чертежейИспользование блоков для создания чертежейИспользование блоков для создания чертежей
цилиндрических опорцилиндрических опорцилиндрических опорцилиндрических опорцилиндрических опор
Вертикальные цилиндрические поверхности представляют собой на главном
виде прямоугольники. Их можно создать с помощью смещения и обрезки ли�
ний. Однако мы пойдем немного другим путем и создадим таким способом чер�
теж только одной опоры, а остальные получим путем вставки блоков, создан�
ных из чертежа первой опоры. Кроме того, попутно мы создадим чертеж
подставки под клавиатуру.

1. Восстановите, если нужно, исходный масштаб просмотра, заморозьте
слой Вид сверху и разморозьте слой Высота 720.

2. С помощью инструментов С линиями (Line) и Нормаль (Snap to Perpen�
dicular) опустите перпендикуляр от самой нижней точки чертежа под�
ставки под клавиатуру на виде сверху к горизонтальной линии, представ�
ляющий на виде спереди верхнюю линию контура угловой полки.

3. Скопируйте с помощью маркеров выделения полученный перпендику�
ляр в два других угла чертежа подставки под клавиатуру (рис. 8.24).

4. Измените масштаб просмотра так, чтобы увеличить область на виде
сверху, в которой находятся обе опоры малой тумбы и нижняя опора
большой тумбы.

5. Скопируйте с помощью маркеров выделения одну из вертикальных ли�
ний, созданных в пп. 2–3, в точки, обозначающие габариты всех трех ок�
ружностей левой опоры малой тумбы (всего шесть линий), а также в цен�
тральные точки каждой из опор, видимых в рабочей области (рис. 8.25).

6. Восстановите предыдущий масштаб просмотра, а затем измените его
так, чтобы хорошо видеть область, в которой будет находиться чертеж
левой опоры малой тумбы на чертеже вида спереди.

7. Сместите верхнюю линию контура малой тумбы вверх и нижнюю линию
контура столешницы вниз на 4 мм. Затем повторите операцию смеще�

Рис. 8.23  Вставка чертежа ручки из блока с использованием режима привязки Середина
(Midpoint) и режима отслеживания объектной привязки

Рис. 8.24  Копирование вертикальных линий
в характерные точки чертежа клавиатуры

Рис. 8.25  Вертикальные линии, обозначающие габариты одной из опор,
и центры всех трех опор

Создание главного видаСоздание главного видаСоздание главного видаСоздание главного видаСоздание главного вида



Создание видов в ортогональных проекцияхСоздание видов в ортогональных проекцияхСоздание видов в ортогональных проекцияхСоздание видов в ортогональных проекцияхСоздание видов в ортогональных проекциях288 289

ния, на этот раз задав расстояние смещения 6 мм и применив его к только
что смещенным линиям. Направление смещения остается тем же – к се�
редине контура будущей опоры (рис. 8.26).

9. Запустите инструмент Создать блок (Make Block) (например, введя в ко�
мандной строке B) и создайте определение блока Опора 50. В качестве
точки вставки выберите точку, которая находится на пересечении цент�
ральной оси и нижней линии контура столешницы. Выбирая объекты
блока, не забудьте о том, что центральную ось выбирать не нужно (всего
в блок должно входить 14 объектов).

10. Завершив создание определения блока, выберите переключатель Пре�
образовать в блок (Convert to Block) и щелкните на кнопке OK для созда�
ния блока.

11. Щелкните на центральной линии опоры и удалите ее, а затем восстано�
вите предыдущий масштаб просмотра. Измените масштаб просмотра
так, чтобы видеть вертикальные линии, обозначающие центральные оси
двух остальных опор.

12. Запустите инструмент Вставить блок (Insert Block) и выберите в окне
Вставка блока (Insert) только что созданный блок Опора 50, а затем щел�
кните на кнопке OK для вставки блока.

13. Щелкните на кнопке Пересечение (Snap to Intersection) панели инстру�
ментов Объектная привязка (Object Snap) и вставьте чертеж опоры, ис�
пользуя в качестве точки вставки точку, которая находится на пересече�
нии центральной оси правой опоры малой тумбы и нижней границы
контура столешницы.

14. Щелкните на центральной линии полученной опоры и удалите ее.
15. Повторите пп. 12–14 для создания чертежа опоры большой тумбы

(рис. 8.28).

Рис. 8.26  Вертикальные и горизонтальные линии
для формирования контура опоры созданы

8. Сформируйте контур опоры, удаляя все лишние сегменты, кроме отрез�
ка, обозначающего ось симметрии опоры (рис. 8.27).

Рис. 8.27  Контур опоры сформирован
Рис. 8.28  Вставка чертежа опоры в точку пересечения

вертикальной и горизонтальной линий

Создание главного видаСоздание главного видаСоздание главного видаСоздание главного видаСоздание главного вида



Создание видов в ортогональных проекцияхСоздание видов в ортогональных проекцияхСоздание видов в ортогональных проекцияхСоздание видов в ортогональных проекцияхСоздание видов в ортогональных проекциях290 291

16. Сместите нижнюю линию контура столешницы вниз на 70 мм, а затем
снова сместите полученную линию вниз на 18 мм.

17. Продлите правую вертикальную линию, обозначающую правую границу
контура подставки под клавиатуру, до горизонтальной линии, созданной
последней в п. 16, а затем сформируйте контур подставки, как показано
на рис. 8.29.

жа, образующих верхнее монтажное кольцо (всего 6 объектов). Точку
вставки выберите такой же, как и для блока Опора 50 (центральную ли�
нию и вертикальные линии самой опоры в блок включать не нужно).

25. Вставьте полученный блок, не забыв в окне Вставка блока (Insert) в каче�
стве масштабного коэффициента по оси Y указать -1 для зеркального
отображения вставляемого блока (рис. 8.30).

Рис. 8.29  Контур подставки под клавиатуру сформирован

18. Восстановите предыдущий масштаб просмотра.
19. Не замораживая слоя Высота 720, разморозьте слой Высота 1090.
20. Опустите перпендикуляры из центров опоры полок и основной опоры.

В первом случае достаточно опустить перпендикуляр к контуру столеш�
ницы, а во втором проще всего опустить его до уровня нулевой высоты.

21. Измените масштаб просмотра так, чтобы видеть полки рабочего места
старшеклассника в области только что созданной центральной линии
опоры, а затем запустите инструмент Вставить блок (Insert Block).

22. Вставьте экземпляр блока, используя привязку к пересечению централь�
ной линии опоры и нижней линии контура нижней полки. Вставленная
опора будет гораздо короче, чем нужно. В данном случае изменение мас�
штаба нам не поможет, поскольку при растяжении вдоль оси Y увеличит�
ся высота монтажных колец.

23. Запустите инструмент Расчленить (Explode) (например, введите в ко�
мандном окне X) и выберите только что вставленный экземпляр блока
для его разделения на отдельные объекты.

24. Удалите элементы опоры, образующие чертеж нижнего монтажного
кольца, а затем создайте блок Монтажное кольцо 50 из элементов черте�

Рис. 8.30  Вставка зеркального отображения блока Монтажное кольцо 50

26. Вставьте остальные четыре экземпляра блока Монтажное кольцо 50, не
забывая указывать для нижних экземпляров каждой пары масштабный
коэффициент по оси Y, равный –1.

27. Продлите вертикальные линии, обозначающие трубу опоры, вверх и
вниз, а затем обрежьте их лишние сегменты так, чтобы получился закон�
ченный чертеж опоры (рис. 8.31).

28. Восстановите предыдущий масштаб просмотра, а затем измените его
так, чтобы хорошо видеть область, которая находится в нижней точке
крепления основной опоры.

29. Вставьте в точку пересечения центральной оси основной опоры и лини�
ей нулевой высоты зеркальное отображение экземпляра блока Монтаж�
ное кольцо 50.

30. С помощью инструмента Расчленить (Explode) разъедините блок на
составные элементы и сместите на 5 мм левую и правую границы верх�
ней части монтажного кольца в направлении от центральной оси. Уда�
лите исходные линии и продлите верхнюю границу контура монтажно�
го кольца до пересечения с новыми вертикальными границами верхней
части.
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31. Создайте блок Монтажное кольцо 60, а затем вставьте его в точках пере�
сечения контуров центральной оси основной опоры и полок, не забывая
корректировать масштабный коэффициент по оси Y.

32. Сместите центральную ось основной опоры влево и вправо на 30 мм,
а затем удалите ее, а полученные вертикальные линии контура оси об�
режьте по контурам монтажных колец так, чтобы удалить лишние сег�
менты. Для обрезки сверху части основной опоры, выступающей над
верхним монтажным кольцом, сместите вверх на 20 мм верхнюю гори�
зонтальную линию контура верхней полки (рис. 8.32).
Восстановите исходный масштаб просмотра, заморозьте слои Высота
1090 и Высота 720 и разморозьте слой Вид сверху.

Создание однотипных элементовСоздание однотипных элементовСоздание однотипных элементовСоздание однотипных элементовСоздание однотипных элементов
с помощью инструмента «Массив» (Array)с помощью инструмента «Массив» (Array)с помощью инструмента «Массив» (Array)с помощью инструмента «Массив» (Array)с помощью инструмента «Массив» (Array)
Для завершения чертежа главного вида осталось создать лишь контуры полочек
левой стойки компакт�дисков. Поскольку эти элементы совершенно одинаковы,
мы воспользуемся для их создания инструментом Array, который позволяет со�
здавать так называемые массивы (array) – упорядоченные последовательности
однотипных элементов, расположенных через одинаковые промежутки один
от другого. Массивы могут быть прямоугольными (rectangular), когда элементы
массива расположены рядами и столбцами, и радиальными (polar), когда эле�
менты массива расположены на одинаковом расстоянии от общего центра.
В данном случае мы создадим прямоугольный массив, а о радиальных массивах
поговорим в следующей главе.

1. Измените масштаб просмотра так, чтобы хорошо видеть всю левую стой�
ку компакт�дисков.

2. Создайте прямоугольник длиной 130 мм и высотой 2 мм, расположив его
левый верхний угол на 15 мм ниже контура проема для полочек компакт�
дисков (рис. 8.33).

Рис. 8.31  Чертеж опоры на главном виде сформирован Рис. 8.32  Чертеж основной опоры на главном виде сформирован

Рис. 8.33  Контур первой полочки создан в проеме левой стойки компакт>диска
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3. Запустите инструмент Массив (Array), щелкнув на кнопке  Массив
(Array) панели инструментов Изменить (Modify), выбрав из меню коман�
ду Изменить ⇒ Массив (Modify ⇒ Array) либо введя в командном окне
команду Ìàññèâ (ARRAY) или просто ìñ (AR).

4. В появившемся диалоговом окне Массив (Array) выберите переключатель
Прямоугольный массив (Rectangular Array). Теперь нужно ввести в стро�
ке Между рядами (Rows) количество строк в создаваемом массиве (то есть
количество элементов, расположенных один под другим). Поскольку точ�
ное количество нужно рассчитывать, введите пока 20 (это значение мож�
но будет уточнить до завершения команды Ìàññèâ (ARRAY)).

5. В строке Столбцов (Columns) введите значение 1, так как нам не нужно
создавать массив из нескольких столбцов. В строке Между рядами (Row
offset) введите значение -17 (массив будет «расти вниз» от исходного
объекта, причем между полочками расстояние будет 15 мм, а еще 2 мм
нужны для учета толщины полочки), а в строке Между столбцами (Co�
lumn offset) – значение 0.

6. Щелкните на кнопке Выбор объектов (Select objects) и выберите прямо�
угольник, представляющий на чертеже полочку левой стойки компакт�
дисков. После этого в диалоговом окне Массив (Array) станет доступной
кнопка Просмотр (Preview) (рис. 8.34).

7. Щелкните на кнопке Просмотр (Preview). Диалоговое окно Массив
(Array) закроется, а на экране появится созданный массив и диалоговое
окно Массив (Array) с тремя кнопками: Принять (Accept), Изменить
(Modify) и Отмена (Cancel) (рис. 8.35).

Рис. 8.34  Диалоговое окно Массив (Array) с настроенными параметрами массива

Рис. 8.35  Предварительный просмотр массива

8. Поскольку указанного в п. 4 значения 20 для количества строк массива
явно недостаточно, щелкните на кнопке Изменить (Modify) и задайте
большее значение параметра Рядов (Rows), а затем снова проверьте, как
будет выглядеть массив, щелкнув на кнопке Просмотр (Preview).

9. Подобрав нужное значение параметра Рядов (Rows) (это значение долж�
но быть равным 29), щелкните на кнопке Принять (Accept). Массив бу�
дет создан с заданными вами параметрами.

На этом создание главного вида закончено. Восстановите исходный масш�
таб просмотра и сохраните текущее состояние чертежа в файле Work081.dwg,
а затем, если вы придерживаетесь предложенной автором схемы, сохраните
этот же чертеж с именем Work082.dwg.
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8.2. Создание вида справа8.2. Создание вида справа8.2. Создание вида справа8.2. Создание вида справа8.2. Создание вида справа
Как уже отмечалось в начале этой главы, помимо главного вида и вида сверху,
в большинстве случаев используется вид слева. Как правило, этого достаточно
для получения информации об изделии. В нашем случае на виде слева почти
все объекты окажутся скрытыми от наблюдателя стенками рабочей зоны. По�
этому мы создадим вид справа, поскольку использование других основных ви�
дов (снизу, слева и сзади) этой проблемы не решит – нужно применять разрезы
и сечения, что, собственно, мы и сделали, когда работали над чертежом вида
сверху. Поэтому, создав вид справа и используя уже имеющиеся виды и разре�
зы, представленные слоями с именами Высота NNNN, вы практически полно�
стью сможете определить геометрические параметры любого элемента рабо�
чей зоны.

Создать вид справа не намного сложнее, чем главный вид. На первый взгляд,
это не совсем очевидно. Однако, как вы вскоре убедитесь, при создании вида
справа можно использовать тот же прием формирования элементов чертежа,
получаемых путем обрезки пересекающихся вертикальных и горизонтальных
линий. Существенным отличием от аналогичной задачи, которую вы решали
при создании главного вида, является то, что при создании вида справа можно
использовать не только вертикальные линии, проведенные из характерных
точек вида сверху, но и горизонтальные линии, проведенные из характерных
точек главного вида. Проще говоря, каждый последующий вид создавать легче,
чем предыдущий. Второе отличие заключается в том, что для упрощения реше�
ния поставленной задачи нам понадобиться выполнить некоторые манипуля�
ции с пользовательской системой координат (ПСК).

8.2.1. Отображение линий высот под прямым углом8.2.1. Отображение линий высот под прямым углом8.2.1. Отображение линий высот под прямым углом8.2.1. Отображение линий высот под прямым углом8.2.1. Отображение линий высот под прямым углом
с использованием пересекающей линиис использованием пересекающей линиис использованием пересекающей линиис использованием пересекающей линиис использованием пересекающей линии
Чтобы использовать пересекающую линию для отображения линий высот под
прямым углом, выполните следующие действия.

1. С помощью инструмента Панорамирование в реальном времени (Pan
Realtime) сместите чертеж влево так, чтобы справа от вида сверху и глав�
ного вида было достаточно места для размещения вида справа. Для созда�
ния вертикальных и горизонтальных линий, проведенных из характер�
ных точек имеющихся видов, мы используем линию, проведенную под
углом 45° из правого нижнего угла габаритов рабочей зоны вида сверху.
Это позволит обеспечить, чтобы вид слева находился на таком же рассто�
янии от вида сверху, как и главный вид.

2. Создайте новый слой с названием Вид справа и индексом цвета 146. На�
значьте новый слой текущим, а также разморозьте нулевой слой для визу�
ализации габаритов рабочей зоны.

3. Щелкните на кнопке�индикаторе ОТС�ПОЛЯР (POLAR) правой кнопкой
мыши и выберите из контекстного меню команду Настройка (Settings).

На вкладке Отслеживание (Polar Tracking) открывшегося окна Режимы
рисования (Drafting Settings) установите флажок Полярное отслежива�
ние Вкл (F10) (Polar Tracking On (F10)) и выберите из списка Шаг углов
(Increment angle) значение 45. Закройте окно щелчком на кнопке OK.

4. Убедитесь в том, что кнопка�индикатор ОТС�ОБЪЕКТ (OTRACK) нахо�
дится в нажатом состоянии, а кнопка�индикатор ОРТО (ORTHO) –
в выключенном.

5. Щелкнув правой кнопкой мыши на кнопке�индикаторе ПРИВЯЗКА
(OSNAP) и выбрав из контекстного меню команду Настройка (Settings),
убедитесь в том, что включены режимы постоянно действующей привяз�
ки Конточка (Endpoint), Квадрант (Quadrant), Середина (Midpoint) и
Центр (Center).

6. Запустите инструмент С линиями (Line) и начните черчение линии от
правого нижнего угла габаритов рабочей зоны на виде сверху.

7. Переместите указатель�перекрестие вправо и вниз под углом 45° (в систе�
ме координат AutoCAD – под углом 315°). Когда включится режим отсле�
живания опорных углов, введите 4400, а затем еще раз нажмите Enter.
Вспомогательная диагональная линия начерчена (рис. 8.36).

Рис. 8.36  Создание вспомогательной линии с углом наклона 315°

8. Щелкните на кнопке�индикаторе ОРТО (ORTHO) для включения соот�
ветствующего режима и начертите с помощью инструмента С линиями
(Line) линию, начинающуюся в левом верхнем углу главного вида, а за�
канчивающуюся у правой границы области черчения.

9. Используя маркеры выделения, скопируйте эту линию к другим харак�
терным точкам, обозначающим различные высоты элементов главного
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вида. В случае необходимости применяйте изменение и восстановление
масштаба чертежа.

10. Запустите инструмент Обрезать (Trim) и выберите в качестве секущей
вспомогательную диагональную линию. Теперь нужно выступающие сег�
менты горизонтальных линий обрезать по заданной секущей. Эту опера�
цию мы выполним с помощью так называемой пересекающей линии.

Примечание. Пересекающая линия (fence) – это линия, состоящая из одного или
более сегментов, которая пересекает один или несколько объектов и тем самым
выбирает их. Пересекающую линию можно считать частным случаем пересекаю�
щей рамки (crossing window), выбирающей все попадающие внутрь объекты.

11. Проверьте, отключен ли режим ОРТО (ORTHO), а затем введите в ко�
мандном окне Ïåðåñå÷åíèå (FENCE) или просто ïåð (F). Щелкните на
кнопке  Ничего (Snap to None) панели инструментов Объектная при�
вязка (Object Snap) и выберите точку, которая находится ниже и правее
линии нулевой высоты справа от вспомогательной диагональной линии.
Щелкните на кнопке Ничего (Snap to None) еще раз, после чего переме�
стите указатель вверх и влево так, чтобы появившаяся штриховая линия
(это и есть пересекающая линия), была расположена правее и приблизи�
тельно параллельно вспомогательной диагональной линии. Кроме того,
нужно, чтобы пересекающая линия прошла через все горизонтальные
линии высот (рис. 8.37). Как только все эти условия будут соблюдены,
щелкните левой кнопкой.

Совет. Если включенный режим автоматической привязки мешает выбрать
нужную точку, можно перед выбором этой точки воспользоваться кнопкой Ниче�

го (Snap to None) панели инструментов Объектная привязка (Object Snap). Щел�
чок на этой кнопке приводит к отключению на время выполнения одной опера�
ции выбора всех режимов автоматической привязки.

12. Нажмите Enter для завершения создания пересекающей линии. Все го�
ризонтальные линии высот, через которые прошла пересекающая ли�
ния, тут же будут обрезаны.

13. Для завершения команды Îáðåçàòü (TRIM) нажмите Enter.
14. Воспользуйтесь инструментом Зеркальное отражение (Mirror) и пере�

секающей линией для отображения обрезанных линий относительно
вспомогательной диагональной линией.

15. Включите режим ОРТО (ORTHO) и начертите горизонтальную линию
от правого верхнего угла рабочей зоны на виде сверху до правой грани�
цы области черчения. После этого продлите все линии высот до получен�
ной горизонтальной линии (рис. 8.38).

Рис. 8.37  Выбор линий, подлежащий обрезке, с помощью пересекающей линии

Рис. 8.38  Линии высот повернуты под прямым углом относительно диагональной линии
и продлены до линии задней стенки рабочей зоны

Теперь, «забежав за поворот», вы можете воспользоваться полученными
линиями высот для создания вида справа.

8.2.2. Изменение ПСК для создания вида справа8.2.2. Изменение ПСК для создания вида справа8.2.2. Изменение ПСК для создания вида справа8.2.2. Изменение ПСК для создания вида справа8.2.2. Изменение ПСК для создания вида справа
Для того чтобы черчение вида справа было естественным (ось X была направ�
лена вправо, а ось Y – вверх), нужно повернуть пользовательскую систему коор�
динат под углом 90°.

1. Выберите из меню команду Вид ⇒ Отображение ⇒ Знак ПСК ⇒ Вкл.
(View ⇒ Display ⇒ UCS Icon ⇒ On), чтобы отобразить пиктограмму ПСК,
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которая была отключена в начале третьей главы. Две стрелки пиктограм�
мы показывают положительные направления координатных осей X и Y,
которые мы сейчас поменяем, а буква на пиктограмме W означает, что
в данный момент включена мировая система координат (МСК), исполь�
зуемая в AutoCAD по умолчанию.

2. Введите в командном окне ÏÑÊ (UCS), затем Z, затем 90. В результате
ПСК развернется вокруг оси Z (ось, направленная в МСК из плоскости
экрана в сторону наблюдателя) на 90°, о чем можно будет судить по изме�
нившемуся расположению пиктограммы ПСК. Кроме того, W на пикто�
грамме ПСК исчезнет, что говорит об использовании координатной сис�
темы, отличной от МСК.

3. Пиктограмму ПСК мы развернули, однако хотя оси X и Y теперь направ�
лены так, как нужно, чертить в таком режиме все равно сложно. Поэтому
сейчас мы развернем весь чертеж, приведя его к текущей ПСК.

4. Выберите из меню команду Вид ⇒ 3D виды ⇒ Вид в плане ⇒ Текущая
ПСК (View ⇒ 3D Views ⇒ Plan view ⇒ Current UCS). Вид чертежа тут же
изменится – он развернется так, чтобы соответствовать текущему поло�
жению ПСК. Обратите внимание на то, что хотя оси ПСК теперь ориен�
тированы так, как обычно, буква W на пиктограмме ПСК не появилась,
поскольку текущая ПСК не соответствует МСК.

Примечание. Рассмотренной выше команде меню соответствует команда Ïëàí
(PLAN) командного окна, после ввода которой нужно ввести режим Ïðåäûäó-
ùàÿ (CURRENT) или просто ä (C).

5. Заморозьте нулевой слой.
6. С помощью инструмента Окно зумирования (Zoom Windows) измените

масштаб просмотра таким образом, чтобы вид сверху, главный вид и линии
высот вида справа были полностью видны в области черчения (рис. 8.39).

7. Текущую ПСК можно сохранить под произвольным именем, что впослед�
ствии избавит вас от необходимости повторно настраивать чертеж для
внесения возможных изменений в объекты вида справа. Для этого введи�
те в командном окне команду ÏÑÊ (UCS), а затем название режима Ñî-
õðàíèòü (SAVE). В ответ на приглашение AutoCAD введите название со�
храняемой ПСК, например Вид справа. Теперь, в случае необходимости,
вы всегда сможете быстро перейти к сохраненной именованной ПСК.

Примечание. Описанным выше способом можно сохранить любую текущую сис�
тему координат, включая МСК. Тем не менее, в сохранении МСК нет смысла,
поскольку она всегда остается неизменной.

8. Помимо текущей ПСК, можно также сохранить текущий вид, в том числе
с информацией о текущей ПСК. Для этого следует выбрать из меню ко�
манду Вид ⇒ Именованные виды (View ⇒ Named Views) либо ввести
в командном окне команду Âèä (VIEW). Альтернативный метод запуск ин�
струмента Именованные виды (Named Views) заключается в использо�
вании  одноименной кнопки панели инструментов Вид (View).

9. В открывшемся диалоговом окне Диспетчер видов (View Manager) щелк�
ните на кнопке Создать (New).

10. В строке Имя вида (View Name) открывшегося окна Создать вид (New
View) наберите название нового вида (Вид справа). Убедитесь в том, что
в группе Грани (Boundary) выбран переключатель Текущий экран
(Current display). В группе Параметры (Settings) сбросьте флажок Сохра�
нить с видом снимок слоев (Save layer snapshot with view), чтобы не со�
хранять в данных о именованном виде информации о размороженных
слоях (в некоторых случаях это удобно, однако в нашей ситуации в сохра�
нении такой информации нет необходимости). В списке ПСК (UCS) дол�
жна быть выбрана текущая ПСК, сохраненная в п. 7 под именем Вид
справа. Оставив остальные параметры без изменений, щелкните на
кнопке OK.

11. В группе Виды (Model Views) диалогового окна Диспетчер видов (View
Manager) теперь появился именованный вид Вид справа. Значит, в лю�
бой момент, открыв диалоговое окно Диспетчер видов (View Manager),
выбрав в группе Виды (Model Views) именованный вид Вид справа и
щелкнув на кнопке Установить (Set Current), можно тут же перейти
к этому виду, причем с одновременным изменением ПСК.

12. Введите в командном окне ÏÑÊ (UCS) и нажмите Enter для возврата
к МСК. Пиктограмма ПСК развернется в соответствии с МСК (на пикто�
грамме снова появится буква W), но чертеж останется развернутым на 90°.

13. Введите в командном окне Ïëàí (PLAN) и нажмите Enter для приведения
чертежа в соответствие с текущей ПСК, которая в данный момент совпа�
дает с МСК. Чертеж займет исходное положение.

Рис. 8.39  Чертеж развернут в соответствии с текущей ПСК
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Таким образом, в качестве инструмента поворота чертежа мы использовали
новую ПСК, не изменяя расположения чертежа в МСК (примерно то же самое
происходит в реальной жизни, когда чертежник просто разворачивает лист
бумаги к себе короткой стороной, а по окончании вычерчивания объекта снова
возвращает лист в исходное положение).

8.2.3. Формирование вида справа8.2.3. Формирование вида справа8.2.3. Формирование вида справа8.2.3. Формирование вида справа8.2.3. Формирование вида справа
Если вы проделали все операции, описанные в этой главе, то вполне справи�
тесь самостоятельно с формированием вида справа, поэтому автор остановит�
ся лишь на основных моментах этой работы.

1. Запустите инструмент Именованные виды (Named Views) (например,
введя в командном окне Âèä (VIEW)), выберите в окне Диспетчер видов
(View Manager) именованный вид Вид справа и щелкните на кнопке Ус�
тановить (Set Current), а затем щелкните на кнопке OK.

2. Замораживая и размораживая слои вида сверху, опустите вертикальные
(в текущей ПСК) линии от характерных точек этих слоев для их пересе�
чения с горизонтальными линиями, проведенными от характерных то�
чек главного вида.

3. Руководствуясь рис. 8.40, а также рис. 5.1 и 8.1, выполните обрезку пере�
секающихся линий, сформировав вид справа (рис. 8.41).

4. Выполните сопряжение закругленных верхних частей с радиусом 232 мм
(на рис. 8.40 кажется, что радиусы разные, однако это лишь обман зре�
ния) и завершите формирование верхних частей полок (вам понадобить�
ся начертить две дополнительные линии, а также обрезать сопряжен�
ный контур верхней части боковой стенки, который должен быть скрыт
за полкой).

5. Вставьте блок Ручка на чертеж фасада малой тумбы, разместив его на
34 мм ниже середины верхней линии фасада (для определения середины
этой линии вам понадобиться начертить вспомогательную линию).

6. Вставьте блок Опора 50, используя в качестве точки вставки верхнюю
точку оси опоры (см. рис. 8.41). Для устранения эффекта «прозрачнос�
ти» подставки под клавиатуру вам понадобиться расформировать встав�
ленный экземпляр блока, а затем вырезать сегменты вертикальных ли�
ний опоры, которые находятся внутри контура подставки. Завершив
обрезку, удалите центральную линию опоры.

7. Основную опору создайте по той же методике, которую вы применяли
при черчении основной опоры на главном виде: сначала вставьте блоки
Монтажное кольцо 60, представляющие монтажные кольца основной
опоры, затем сместите центральную линию влево и вправо на 30 мм. Уда�
лите центральную линию и обрежьте лишние сегменты для получения
законченного чертежа (рис. 8.42).

8. Восстановите исходный масштаб просмотра, удалите все вспомогатель�
ные линии и приведите ПСК к МСК, а затем вид – к текущей ПСК.

9. Заморозьте все слои, кроме слоев Вид сверху, Вид спереди и Вид спра�
ва, а затем примените инструмент Зумировать в границах (Zoom Extents)
для оптимального размещения чертежа в области черчения.Рис. 8.40  Эталонный вид справа рабочей зоны

Рис. 8.41  Основные объекты вида справа сформированы
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Как нетрудно заметить, на видах спереди и справа отсутствует оборудова�
ние. Это было сделано умышленно, чтобы не усложнять и без того достаточно
сложные построения. Кроме того, виды на нашем чертеже располагаются не
совсем так, как того требуют стандарты. В частности, вид сверху должен распо�

лагаться под главным видом, а вид справа – слева от главного вида. В чертеже,
показанном на рис. 8.44, оба эти недостатка устранены. Попробуйте воссоздать
этот чертеж самостоятельно и, если это вам удастся, сохраните его в файле
Work083.dwg.

Рис. 8.42  Создание вида справа закончено

10. Сохраните текущее состояние чертежа (рис. 8.43) в файле Work082.dwg.

Рис. 8.43  Чертеж с тремя видами

Рис. 8.44  Чертеж с тремя видами,
оформленный с учетом всех требований стандартов

В следующей главе мы займемся изучением методов нанесения на чертежах
различных штриховок, а также их использования для оформления сечений и
разрезов.
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9ГГГГГлавалавалавалавалава
Штриховка разрезовШтриховка разрезовШтриховка разрезовШтриховка разрезовШтриховка разрезов
и сеченийи сеченийи сеченийи сеченийи сечений

В AutoCAD для обозначения материалов, из которых изготовленные
изображенные на чертеже объекты, применяют три различные мето�
дики, основанные на использовании штриховок (hatch), заливок (gra�

dient) и текстур (texture). Текстуры – это фотографии реальных поверхностей
различных материалов или сгенерированные компьютером имитации подоб�
ных изображений, которые применяются в трехмерном моделировании для
генерации фотореалистичных представлений объемных моделей. Процесс по�
лучения таких представлений называется рендерингом (rendering). Поскольку
данная книга посвящена исключительно вопросам черчения на плоскости,
рендеринг и использование текстур в ней рассматриваться не будет.

Заливки – это однотонные заполнения объектов выбранным цветом. Залив�
ки могут использоваться как в трехмерном моделировании под названием то�
нирование (shading), так и при создании чертежей на плоскости. Строго говоря,
тонирование и применение заливок – это не совсем одно и то же, однако ви�
зуальный эффект от применения тонирования и заливки может быть одинако�
вым (если не учитывать того, что тонирование применяется, как правило, для
трехмерных моделей). Заливки в двухмерном черчении могут использоваться
для создания схем различных узлов и агрегатов, когда для наглядности те или
иные объекты выделяются, например, красным цветом, а остальные – синим.
С точки зрения практического применения, заливки можно рассматривать как
частный случай штриховки, поэтому мы в этой главе поговорим лишь о мето�
дах использования различных штриховок, а также о некоторых особенностях
соответствующих инструментов AutoCAD.

В классическом техническом черчении штриховки применяются для графи�
ческого обозначения материалов в сечениях и на разрезах. Кроме того, при
черчении в AutoCAD различные штриховки нередко применяются для обозна�
чения материалов и покрытий для создания визуального эффекта, в чем�то на�

поминающего визуальный эффект от применения рендеринга в трехмерных
моделях.

Для применения штриховок и заливок используется инструмент Штрихов�
ка (Hatch). Это достаточно сложный инструмент, имеющий много параметров
и режимов. Основное внимание при использовании этого инструмента следует
уделять вопросу выбора границы заштриховываемой области. Поскольку
AutoCAD автоматически определяет границы сложных объектов, поэтому от
пользователя требуется лишь уметь правильно применять соответствующие
параметры инструмента Штриховка (Hatch).

9.1. Основные методы нанесения штриховки9.1. Основные методы нанесения штриховки9.1. Основные методы нанесения штриховки9.1. Основные методы нанесения штриховки9.1. Основные методы нанесения штриховки
С точки зрения AutoCAD, штриховки и заливки представляют собой объекты
чертежа, поэтому логично их расположить на отдельных слоях. Поэтому изуче�
ние методов нанесения штриховки мы начнем с создания соответствующих
слоев.

1. Откройте чертеж Work081.dwg и сохраните его в файле Work091.dwg.
Отключите, если нужно, все режимы автоматической привязки, щелкнув
на кнопке�индикаторе ПРИВЯЗКА (OSNAP) или нажав F3, а также ре�
жим отображения пиктограммы ПСК.

2. Создайте пять новых слоев со следующими параметрами (табл. 9.1)

Таблица 9.1. Параметры слоев штриховки

Название слоя Индекс цвета

Штриховка 18 26
Штриховка 320 16
Штриховка 720 24
Штриховка 1090 22
Штриховка 1495 12

3. Назначьте текущим слой Штриховка 320 и разморозьте слой Высота
320, а все остальные слои заморозьте.

4. Измените масштаб просмотра так, чтобы объекты слоя Высота 320 зани�
мали всю область черчения.

5. Запустите инструмент Штриховка (Hatch), щелкнув на кнопке  Штри�
ховка (Hatch) панели инструментов Черчение (Draw) или выбрав из
меню команду Черчение ⇒ Штриховка (Draw ⇒ Hatch). Если вы пред�
почитаете использовать командное окно, тогда введите Øòðèõ (HATCH)
или просто ø (H) (также можете воспользоваться командой Êøòðèõ
(BHATCH), или псевдонимом êø (BH) – суть от этого не изменится).

6. В открывшемся окне Штриховка и градиент (Hatch and Gradient) (рис. 9.1)
можно выбрать узор штриховки или тип заливки, задать параметры
штриховки или заливки, а также метод применения и метод определе�
ния границ соответствующей области чертежа. По умолчанию окно от�
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крывается на вкладке Штриховка (Hatch). Если выбрана вкладка Гради�
ент (Gradient), перейдите на вкладку Штриховка (Hatch) и выберите из
раскрывающихся списков Тип (Type) и Образец (Pattern) значения
Пользовательский (Predefined) и ANSI37, соответственно.

7. Щелкните на кнопке  Обзор (Browse), расположенной справа от рас�
крывающегося списка Образец (Pattern). В открывшемся окне Палитра
образцов штриховки (Hatch Pattern Palette) должна быть открыта вклад�
ка ANSI с выбранным на ней узором ANSI37 (рис. 9.2). Подробнее о рабо�
те с этим окном мы поговорим немного позднее, а пока что закройте его,
щелкнув на кнопке OK.

8. Текущий выбранный узор штриховки отображается в области Структу�
ра (Swatch) на вкладке Штриховка (Hatch) окна Штриховка и градиент
(Hatch and Gradient). Обратите также внимание на параметры группы
Угол и масштаб (Angle and scale), называющиеся Угол (Angle) и Масштаб
(Scale). Первый из них отвечает за угол наклона линий штриховки, а вто�
рой – за его масштаб. Угол наклона в данном случае изменять не нужно,
а вот масштаб – не помешает. Введите в строке Масштаб (Scale) вместо
текущего значения 1 значение 4.0.

Примечание. В списке Масштаб (Scale) имеется несколько стандартных значе�
ний масштабного коэффициента в диапазоне от 0.1 до 2. Все введенные пользова�
телем нестандартные значения также сохраняются в этом списке и могут ис�
пользоваться при дальнейшей работе.

9. Щелкните на кнопке Добавить: точки выбора (Add: Pick points), кото�
рая находится в правом верхнем углу диалогового окна. Окно временно
закроется, а AutoCAD предложит вам выбрать точку на чертеже, которая
находится внутри области, подлежащей штриховке.

10. Щелкните внутри контура задней стенки рабочей зоны. Если вы не забы�
ли отключить автоматическую привязку и выбрали нужный масштаб, эта
задача не вызовет у вас затруднений. О том, что область для штриховки
выбрана правильно, вы узнаете из того, что все отрезки, образующие кон�
тур задней стенки, будут отображаться штриховыми линиями (рис. 9.3).

11. Нажмите Enter для возврата в окно Штриховка и градиент (Hatch and
Gradient) и щелкните на кнопке Образец (Preview), которая находится
в левом нижнем углу этого окна.

12. Убедившись, что штриховка выглядит нормально (если бы вы оставили
масштабный коэффициент равным 1, она была бы слишком плотной),
щелкните на кнопке Добавить: выбрать объекты (Add: Select objects),
которая находится под кнопкой Добавить: точки выбора (Add: Pick
points). AutoCAD снова скроет окно Штриховка и градиент (Hatch and
Gradient), но в этот раз предложит вам выбрать не точку внутри области,
ограниченной контуром, а объект. Щелкните на левой боковой стенке

Рис. 9.1  Диалоговое окно
Штриховка и градиент (Hatch and Gradient)

Рис. 9.2  Диалоговое окно
Палитра образцов штриховки (Hatch Pattern Palette)
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большой тумбы. Поскольку контур этой стенки представляет собой еди�
ный объект, а не набор отдельных линий, нужно щелкнуть не внутри кон�
тура, а на одной из его линий. Вернувшись в AutoCAD, снова щелкните на
кнопке Образец (Preview) (рис. 9.4).

13. Примените штриховку к остальным стенкам, попавшим в плоскость сече�
ния, используя один из двух описанных выше методов определения гра�
ниц заштриховываемой области, а затем щелкните на кнопке OK для за�

крытия окна Штриховка и градиент (Hatch and Gradient). Чертеж дол�
жен выглядеть так, как показано на рис. 9.5.

Рис. 9.3  AutoCAD определил, что выбранная точка
находится внутри контура задней стенки

Рис. 9.4  Предварительный просмотр штриховки

Рис. 9.5  Стенки рабочей зоны, попавшие в плоскость сечения, заштрихованы

9.1.1. Выбор и настройка узора штриховки9.1.1. Выбор и настройка узора штриховки9.1.1. Выбор и настройка узора штриховки9.1.1. Выбор и настройка узора штриховки9.1.1. Выбор и настройка узора штриховки
Теперь давайте немного поговорим о штриховке вообще и о достигнутом ре�
зультате в частности. Как видно из рис. 9.2, входящие в комплект поставки
AutoCAD узоры штриховки лишь очень приблизительно соответствуют тре�
бованиям отечественных стандартов. В частности, узор ANSI31 можно при�
менять для обозначения металлов и твердых сплавов, узор ANSI32 – для обо�
значения керамики и силикатных материалов для кладки, а узор ANSI37 – для
обозначения неметаллических материалов, в том числе волокнистых монолит�
ных и плитных (прессованных), например ДСП, как в нашем случае. Также
с некоторым приближением можно использовать узор ANSI35, который напо�
минает стандартный узор, используемый для обозначения бетона.

Узоры, которые в соответствии с требованиями стандартов должны приме�
няться для обозначения дерева, естественного камня, стекла и других светоп�
розрачных материалов, жидкостей и естественного грунта, среди узоров
AutoCAD отсутствуют. Поскольку читатели этой книги вряд ли на первых по�
рах будут разрабатывать сложные чертежи промышленного назначения, автор
не станет рассматривать вопросы разработки собственных узоров, ограничив�
шись лишь замечанием о том, что это возможно.

Совет. Если вам действительно необходимо применить узор, отсутствующий
среди узоров AutoCAD, воспользуйтесь оговоркой, имеющейся в отечественных
стандартах: «Допускается применять дополнительные обозначения материа�
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лов … с пояснениями на чертеже». Таким образом, для обозначения, деталей, изго�
товленных не из ДСП, а, например, из массива дуба, вы можете использовать узор
ANSI38, сопроводив чертеж соответствующими пояснениями. (О том, как созда�
вать надписи на чертеже, вы узнаете из следующей главы.)

Все вышесказанное относится и к узорам, находящимся на вкладках ISO и
Другие стандартные (Other Predefined), – для практического применения
в качестве штриховок на сечениях они не подходят. Штриховки, которые на�
ходятся на вкладке Другие стандартные (Other Predefined), можно применять
лишь для создания эффекта, отдаленного напоминающего наложение текстур
в трехмерном моделировании.

Гораздо важнее то, что вид штриховки зависит от выбранного масштабного
коэффициента. Мы выбрали масштабный коэффициент, равный 4, потому,
что по умолчанию масштабный коэффициент равен 1, то есть в нашем случае
соответствует объектам, помещающимся на лист формата A4 (210 × 297 мм).
Поскольку размеры такого объекта, как большая тумба, гораздо больше форма�
та A4 и, скорее, соответствуют формату A0 (841 × 1189 мм), который по длине и
высота в 4 раза больше, чем A4, то выбор масштабного коэффициента 4 позво�
ляет получить приемлемый результат.

Если же ориентироваться на размер всего чертежа рабочей зоны, для разме�
щения которого в длину нужно не менее трех листов формата A0, тогда масштаб�
ный коэффициент следует установить, равным 12. Однако поскольку в плоскости
сечения разрезов у нас, в основном, находятся малоразмерные (по сравнению
с размерами всей рабочей зоны) объекты, все же лучше ориентироваться на их
габариты и принять масштабный коэффициент, равный 4.

Применяя описанные выше методы создания штриховки, а также (в тех слу�
чаях, когда это уместно) копирование объектов одного слоя на другой, нанеси�
те штриховку на соответствующие слои. Например, штриховка, нанесенная на
слой Штриховка 1090, вместе с объектами слоя Высота 1090 будет выглядеть,
как показано на рис. 9.6.

Совет. Если при создании штриховки вы примените ее в одном сеансе работы
с окном Штриховка и градиент (Hatch and Gradient), полученный в результате
набор штриховок будет представлять собой единый объект, который затем при�
дется модифицировать с помощью диалогового окна Редактирование штрихов�
ки (Edit Hatch) (рассмотрено далее в этой главе). Это сведет на нет все преимуще�
ства от применения копирования объектов со слоя на слой. Поэтому при
создании штриховки лучше применять ее по отдельности для каждой заштрихо�
вываемой области, каждый раз щелкая на кнопке OK для закрытия окна Штри�
ховка и градиент (Hatch and Gradient), а затем нажимая Enter для повторного
запуска инструмента Штриховка (Hatch).

Таким образом, разрезы, которые представлены на наших чертежах слоями
Высота NNNN, теперь оформлены почти с учетом всех требований стандар�
тов. Для их завершения осталось лишь нанести соответствующие надписи и
стрелки, чем мы займемся в последующих главах.

Сохраните текущее состояние чертежа в файле Work091.dwg, а затем размо�
розьте слой Вид спереди и назначьте его текущим. Заморозьте все остальные
слои, кроме слоя Высота 1090, и сохраните текущее состояние чертежа в фай�
ле Work092.dwg.

9.1.2. Обозначение цилиндрических поверхностей9.1.2. Обозначение цилиндрических поверхностей9.1.2. Обозначение цилиндрических поверхностей9.1.2. Обозначение цилиндрических поверхностей9.1.2. Обозначение цилиндрических поверхностей
На виде спереди рабочей зоны изображено много цилиндрических поверхнос�
тей, однако для того, чтобы показать это, нам придется воспользоваться не
штриховкой, а специальным приемом, построенном на применении радиаль�
ных массивов.

1. Измените масштаб просмотра так, чтобы область чертежа, на которой
на слое Высота 1090 изображена верхняя опора (три концентрические
окружности), занимала всю область черчения.

2. Используя инструмент С линиями (Line), режим ОРТО (ORTHO) и ре�
жим привязки Квадрант (Quadrant), проведите вниз вертикальную ли�
нию, начинающуюся от крайней правой точки внутренней окружности,
а также еще одну вертикальную линию от центра окружности до ее ниж�
него квадранта (рис. 9.7).

3. Запустите инструмент Массив (Array) (например, введя в командном
окне ìc (AR)).

4. В открывшемся окне Массив (Array) щелкните на переключателе Круго�
вой массив (Polar Array). В качестве центральной точки массива выбери�
те центр трех окружностей, щелкнув для этого на кнопке Указать центр
массива (Pick Center Point).

5. Из раскрывающегося списка Способ построения (Method) выберите
строку Число элементов и Угол между элементами (Total number of
items & Angle between items).

Рис. 9.6  Штриховка, совмещенная с объектами слоя Высота 1090
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6. В строке Число элементов (Total number of items) введите 40, а в строке
Угол между элементами (Angle between items) – значение 9. Затем щелк�
ните на кнопке Выбор объектов (Select objects) и выберите вертикаль�
ный отрезок, соединяющий центр внутренней окружности с ее нижним
квадрантом.

7. Закрыв окно щелчком на кнопке OK, вы должны получить чертеж, пред�
ставленный на рис. 9.8.

8. Измените масштаб просмотра так, чтобы видеть чертеж опоры и на виде
сверху, и на главном виде, а затем продлите вертикальную линию, начи�
нающуюся на правом квадранте вниз до пересечения с контуром столеш�
ницы на главном виде (рис. 9.9).

Рис. 9.7  Две вертикальные линии начерчены

Рис. 9.8  Радиальный массив создан

Рис. 9.9  Вертикальная линия продлена до нужной длины

9. Вернитесь к масштабу просмотра, при котором чертеж опоры на виде
сверху занимал бы почти всю область черчения, а затем скопируйте толь�
ко что продленную линию, используя верхний маркер выделения, к кон�
цу каждой линии радиального массива (к точкам линий, которые нахо�
дятся в верхнем полукруге, копировать линию не нужно).

10. Удалите исходную линию, поскольку она на главном виде совпадает
с контуром опоры, а также линию, которая находится симметрично от
нее относительно вертикальной оси окружности. Чертеж должен иметь
вид, показанный на рис. 9.10.

11. Удалите все радиальные линии на виде сверху, а затем измените масштаб
просмотра так, чтобы хорошо видеть опору на главном виде, и обрежьте
все лишние сегменты вертикальных линий, как показано на рис. 9.11.

 Примените описанную выше технику для обозначения остальных криволи�
нейных поверхностей (опоры и их монтажные кольца, изгибы столешницы,
округленные части полок), а затем сохраните полученный чертеж в файле
Work092.dwg (рис. 9.12).
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9.2. Применение штриховки для обозначения9.2. Применение штриховки для обозначения9.2. Применение штриховки для обозначения9.2. Применение штриховки для обозначения9.2. Применение штриховки для обозначения
материалов поверхностейматериалов поверхностейматериалов поверхностейматериалов поверхностейматериалов поверхностей
Теперь давайте рассмотрим методы, которые можно использовать для приме�
нения штриховки с целью обозначения различных материалов поверхностей.
Строго говоря, эти методы ничем не отличаются от аналогичных методов, ис�
пользуемых для обозначения материалов в разрезах и сечениях. Однако, как
уже отмечалось выше, в стандартном комплекте поставки AutoCAD отсутст�
вуют многие узоры штриховки, определяемые отечественными стандартами.
Такие узоры можно создать самостоятельно, после чего они появятся на вклад�
ке Пользовательские (Custom) диалогового окна Палитра образцов штри�
ховки (Hatch Pattern Palette) (см. рис. 9.2). Однако их создание (особенно в тех
случаях, когда нужно обеспечить полное соответствие требованиям стандар�
тов) – задача не из легких.

Поэтому в данной книге, ориентированной на начинающих пользователей
AutoCAD, мы поговорим не о дополнительных (custom) узорах штриховки, а о спе�
циальных (user�defined), то есть об узорах, определяемых пользователем на ос�
нове уже готовых узоров штриховки.

Кроме того, поскольку в стандартном комплекте AutoCAD отсутствуют узо�
ры, представляющие текстуру древесины, мы будем применять узоры, которые
часто используются в архитектуре для обозначения материалов отделки инте�
рьеров помещений и экстерьеров зданий. Эти узоры штриховки находятся на
вкладке Другие стандартные (Other Predefined) диалогового окна Палитра
образцов штриховки (Hatch Pattern Palette). В этой связи мы нанесем специ�

Рис. 9.10  Вертикальная линия скопирована к нижним конечным точкам
линий радиального массива

Рис. 9.11  Вертикальные линии штриховки,
обозначающие криволинейную поверхность на виде спереди, после обрезки

Рис. 9.12  Главный вид с обозначенными криволинейными поверхностями
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альную и архитектурную штриховку не на объекты рабочей зоны, а на план
всей детской комнаты.

9.2.1. Нанесение специальной штриховки9.2.1. Нанесение специальной штриховки9.2.1. Нанесение специальной штриховки9.2.1. Нанесение специальной штриховки9.2.1. Нанесение специальной штриховки
Для нанесения специальной штриховки выполните следующие действия.

1. Откройте файл Work071.dwg, который был сохранен в ходе изучения гла�
вы 7, и сохраните его под именем Work093.dwg.

2. Создайте новый слой Плитка (индекс цвета – 26) и назначьте его текущим.
3. Создайте на чертеже вспомогательную вертикальную линию, отделяю�

щую на чертеже площадь балкона от пола комнаты в области проема две�
ри балкона.

4. Запустите инструмент Штриховка (Hatch), например, введя ø (H) в ко�
мандном окне, и выберите из списка Тип (Type) на вкладке Штриховка
(Hatch) открывшегося окна Штриховка и градиент (Hatch and Gradient)
элемент Из линий (User defined). Обратите внимание на то, что после
закрытия списка Тип (Type) параметры Масштаб (Scale) и Образец
(Pattern) станут недоступными, а параметр Интервал (Spacing) – наобо�
рот, станет доступным.

5. В настоящий момент специальный узор штриховки представляет собой
горизонтальные параллельные линии. Установите флажок Крест�на�
крест (Double) и к узору добавятся также вертикальные параллельные
линии, что позволяет получить штриховку, напоминающую уложенную
плитку.

6. Введите в строке Интервал (Spacing) значение 250. Этот параметр опре�
деляет расстояние между линиями в созданном специальном узоре штри�
ховки. В данном случае мы создадим штриховку, имитирующую укладку
квадратной плиткой размером 250 × 250 мм.

7. Щелкните на кнопке Добавить: точки выбора (Add: Pick points). Перей�
дя к чертежу, удостоверьтесь в том, что отключены все режимы автома�
тической привязки и выберите точку, которая находится в центре конту�
ра балкона.

8. Нажав Enter для возврата в окно Штриховка и градиент (Hatch and Gra�
dient), щелкните в этом окне на кнопке Образец (Preview). Как видно из
полученного результата (рис. 9.13), режим автоматической привязки
штриховки к началу координат не позволяет добиться нужного эстети�
ческого эффекта. Действительно, на практике плитку, как правило, на�
чинают укладывать от середины комнаты. Поэтому давайте изменим ре�
жим привязки начала штриховки.

9. Нажмите Esc для выхода из режима предварительного просмотра, а за�
тем щелкните на кнопке Отмена (Cancel) для закрытия окна Штриховка
и градиент (Hatch and Gradient) без создания штриховки.

10. Создайте диагональную линию, проведенную из одного угла контура бал�
кона в противоположный, применяя для этого инструмент С линиями
(Line) и режим автоматической привязки Конточка (Endpoint).

11. Введите в командном окне команду SNAPBASE, а затем с помощью режи�
ма привязки Середина (Midpoint) выберите середину только что создан�
ной диагональной линии. Теперь все создаваемые узоры штриховки бу�
дут начинаться от этой точки.

12. Удалите диагональную линию и повторите пп. 1–8. Перейдя в режим
предварительного просмотра, убедитесь в том, что штриховка в этот раз
выполнена симметрично относительно центра балкона

13. Не выходя из режима предварительного просмотра, щелкните правой
кнопкой мыши для применения полученного специального узора. Полу�
ченная штриховка должна выглядеть так, как показано на рис. 9.14.

Примечание. SNAPBASE – это, строго говоря, не команда, а системная перемен�
ная AutoCAD. Для просмотра и изменения значений системных переменных дос�
таточно ввести их название в командном окне. По умолчанию переменная
SNAPBASE имеет значение (0,0). Это означает, что точка отсчета при нанесе�
нии узора штриховки совпадает с началом координат. Изменяя значение этой
переменной, вы тем самым изменяете координаты точки привязки для всех по�
следующих применяемых узоров штриховки. Как правило, это не имеет особого
значения, но в тех случаях, когда измененная точка привязки не позволяет полу�
чить нужный эстетический эффект, вы всегда можете ее изменить, задав новое
значение переменной SNAPBASE.

9.2.2. Нанесение архитектурной штриховки9.2.2. Нанесение архитектурной штриховки9.2.2. Нанесение архитектурной штриховки9.2.2. Нанесение архитектурной штриховки9.2.2. Нанесение архитектурной штриховки
Теперь давайте применим штриховку, которая будет представлять на чертеже
паркетное покрытие на полу детской комнаты.

1. Создайте новый слой Паркет (индекс цвета – 16) и назначьте его текущим.

Рис. 9.13  Предварительный просмотр специального узора штриховки

Применение штриховки для обозначения материалов поверхностейПрименение штриховки для обозначения материалов поверхностейПрименение штриховки для обозначения материалов поверхностейПрименение штриховки для обозначения материалов поверхностейПрименение штриховки для обозначения материалов поверхностей
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2. Начертите две горизонтальные вспомогательные линии в дверных про�
емах детской комнаты, замыкающие наружный контур комнаты в этих
проемах.

3. Запустите инструмент Штриховка (Hatch), но в этот раз выберите в спис�
ке Тип (Type) открывшегося окна элемент Стандартный (Predefined).

4. Щелкните на кнопке Образец (Pattern) и выберите узор AR�HBONE. Ус�
тановите значение параметра Масштаб (Scale) равным 0.5, а параметра
Угол (Angle) – 90.

Примечание. Масштаб архитектурных узоров штриховки отличается от масш�
таба остальных узоров, поскольку единицей измерения у архитектурных узоров
является 1 фут (около 33 см). Поэтому коэффициент масштабирования для ар�
хитектурных узоров штриховки, как правило, не очень сильно отличается от 1.

5. Щелкните где�нибудь посреди детской комнаты. AutoCAD автоматичес�
ки определит границы заштриховываемой области. Обратите внимание
на то, что в нее не попали те участки, которые находятся внутри конту�
ров распаха двух дверей детской. Щелкните на этих участках вне конту�
ров самих дверей.

6.  Удостоверившись в том, что AutoCAD корректно распознал границы
заштриховываемых областей, нажмите Enter для возврата к окну Штри�
ховка и градиент (Hatch and Gradient).

7. С помощью кнопки Образец (Preview) удостоверьтесь в том, что узор
применен корректно, а затем нажмите Enter и щелкните на кнопке OK.
Пол детской будет заштрихован узором, имитирующим уложенный
«елочкой» паркет (рис. 9.15).

9.2.3. Нанесение штриховки на разрезе9.2.3. Нанесение штриховки на разрезе9.2.3. Нанесение штриховки на разрезе9.2.3. Нанесение штриховки на разрезе9.2.3. Нанесение штриховки на разрезе
Для завершения чертежа попробуйте самостоятельно нанести штриховку в тех
местах, где изображены разрезы стен балкона и комнаты. Для штриховки про�
стенков балконного остекления используйте узор ANSI38, а для штриховки
простенков комнаты – узор ANSI35. Создавая штриховки, можете расположить
их на новых слоях, или же оставить их на слоях Балкон и Детская, соответствен�
но. Для штриховки простенков балкона установите масштабный коэффициент
10, а для штриховки простенков детской – масштабный коэффициент 4.

Полученный результат должен быть таким, как показано на рис. 9.16.
Сохраните текущее состояние чертежа в файле Work093.dwg.

9.3. Редактирование узора штриховки9.3. Редактирование узора штриховки9.3. Редактирование узора штриховки9.3. Редактирование узора штриховки9.3. Редактирование узора штриховки
с помощью инструмента «Редактированиес помощью инструмента «Редактированиес помощью инструмента «Редактированиес помощью инструмента «Редактированиес помощью инструмента «Редактирование
штриховки» (Edit Hatch)штриховки» (Edit Hatch)штриховки» (Edit Hatch)штриховки» (Edit Hatch)штриховки» (Edit Hatch)
Для внесения модификаций в узор штриховки следует щелкнуть на объекте
штриховки. О том, что объект выделен, вы узнаете по появлению одного мар�
кера выделения, который находится примерно в центре области, охваченной
штриховкой.

Затем выберите из меню команду Изменить ⇒ Объект ⇒ Штриховка
(Modify ⇒ Object ⇒ Hatch) либо введите в командном окне команду Ðåäøòðèõ
(HATCHEDIT) или просто ðø (HE). Можно также щелкнуть правой кнопкой
мыши и выбрать из контекстного меню команду Редактировать штриховку

Рис. 9.14  Специальный узор штриховки,
примененный к чертежу с новой точкой привязки

Рис. 9.15  Вид чертежа после нанесения архитектурной штриховки

Редактирование уРедактирование уРедактирование уРедактирование уРедактирование узора штриховки инструментом «Редактирование штриховки»зора штриховки инструментом «Редактирование штриховки»зора штриховки инструментом «Редактирование штриховки»зора штриховки инструментом «Редактирование штриховки»зора штриховки инструментом «Редактирование штриховки»



Штриховка разрезов и сеченийШтриховка разрезов и сеченийШтриховка разрезов и сеченийШтриховка разрезов и сеченийШтриховка разрезов и сечений322 323

(Edit Hatch) или щелкнуть на кнопке  Edit Hatch панели инструментов Из�
менить II (Modify II).

В любом случае на экране появится диалоговое окно Редактирование
штриховки (Edit Hatch). Как видно из рис. 9.17, это окно практически иден�
тично диалоговому окну Штриховка и градиент (Hatch and Gradient), за ис�
ключением некоторых небольших отличий. В частности, в диалоговом окне
Редактирование штриховки (Edit Hatch) становится доступной кнопка Re�
create boundary, с помощью которой можно заново определить границы для
уже имеющегося объекта штриховки. В остальном работа с окном Редактиро�
вание штриховки (Edit Hatch) ни в чем не отличается от работы с окном
Штриховка и градиент (Hatch and Gradient).

9.4. Создание штриховки с помощью инструмента9.4. Создание штриховки с помощью инструмента9.4. Создание штриховки с помощью инструмента9.4. Создание штриховки с помощью инструмента9.4. Создание штриховки с помощью инструмента
Super HatchSuper HatchSuper HatchSuper HatchSuper Hatch
Если вы при установке AutoCAD установили пакет Express Tools, тогда можете
попробовать использовать инструмент Super Hatch, который входит в этот
пакет.

Для запуска этого инструмента выберите из меню команду Express ⇒ Draw ⇒
Super Hatch или введите в командном окне команду SUPERHATCH. С помощью
появившегося диалогового окна SuperHatch (рис. 9.18) можно создать узор
штриховки из имеющегося растрового изображения (кнопка Image), блока
(кнопка Block), внешней ссылки (кнопка Xref Attach) или так называемой
плашки (wipeout) – области, которая исключается из штриховки и закрашивает�
ся текущим цветом фона (кнопка Wipeout).

С одной стороны, инструмент Super Hatch достаточно гибкий и мощный,
однако, к сожалению, он не всегда справляется с задачей корректного опре�
деления границ заштриховываемой области. Так, на
рис. 9.19 показан пример заливки рабочей области
с помощью инструмента Super Hatch изображением
поверхности ламинированной ДСП, которое было
взято из растрового файла. Как видно из рисунка, ин�
струмент Super Hatch в нескольких местах создал до�
полнительные вертикальные линии, отсутствовавшие
в чертеже. Тем не менее, эстетический эффект от при�
менения этого инструмента, возможно, покажется вам
гораздо более важным, чем отдельные недостатки, и
вы будете его использовать для получения реалистич�
ных изображений.

Рис. 9.16  Заштрихованные стены балкона и детской

Рис. 9.17  Диалоговое окно
Редактирование штриховки (Edit Hatch)

Рис. 9.18  Диалоговое окно SuperHatch

Создание штриховки с помощью инструмента Super HatchСоздание штриховки с помощью инструмента Super HatchСоздание штриховки с помощью инструмента Super HatchСоздание штриховки с помощью инструмента Super HatchСоздание штриховки с помощью инструмента Super Hatch
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 В следующей главе мы займемся созданием на чертеже объектов с тексто�
вой информацией, а также оформлением чертежа в соответствии с требовани�
ями стандартов (рамка, основная надпись и т. п.).

В чертежах, используемых в реальном производстве, всегда присутству�
ют не только графические представления объектов, но и надписи. Текс�
товые надписи могут применяться для обозначений видов и разрезов,

создания примечаний, а также как элемент размеров. При этом надписи на чер�
тежах могут различаться по высоте, расположению и стилю оформления.
В целом создание текстовых элементов на чертежах AutoCAD происходит
в следующей последовательности:

определение стилей текста;
выбор места расположения текста и нанесение его на чертеж;
модификация текста по мере необходимости.

 В AutoCAD надпись может создаваться в виде однострочного или много�
строчного текстового объекта. При этом многострочный объект, конечно, мо�
жет содержать только одну строку текста – суть не в том, сколько строк в надпи�
си, а в том, что многострочные и однострочные объекты создаются разными
командами. Однострочные надписи, представленные однострочными текстовы�
ми объектами (single line text) могут содержать от одного символа до нескольких
слов. Такие надписи используются для обозначения видов, коротких подписей
под чертежами и небольших примечаний. Конечно, ничто не мешает создать
многострочную надпись из нескольких однострочных текстовых объектов.
Однако в подобных случаях удобнее использовать многострочные текстовые объ�
екты (multiline text), поскольку они форматируются и обрабатываются AutoCAD
как единый объект.

Несмотря на то, что, как уже было сказано выше, однострочные и много�
строчные текстовые объекты создаются разными командами, и те, и другие
используют одни и те же текстовые стили (text style). Кроме того, для модифика�
ции текстовых объектов обоих типов используются одинаковые команды, хотя
действие этих команд на объекты разных типов проявляется по�разному. Нако�
нец, текст размерных линий также обрабатывается AutoCAD с некоторыми
нюансами, о чем вы узнаете из главы 11.

Рис. 9.19  Пример использования инструмента Super Hatch
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Учитывая все вышесказанное, изучение методов создания и использования
надписей в AutoCAD мы начнем с изучения методов создания текстовых сти�
лей. Затем вы узнаете, как создать и разместить на чертеже однострочные над�
писи, после чего мы рассмотрим методы работы с многострочными текстами.

10.1. Определение текстовых стилей10.1. Определение текстовых стилей10.1. Определение текстовых стилей10.1. Определение текстовых стилей10.1. Определение текстовых стилей
В определение текстового стиля AutoCAD входят: имя стиля, гарнитура шрифта,
высота шрифта, коэффициент ширины, угол наклона и ряд второстепенных па�
раметров. Все эти параметры определяются в специальном диалоговом окне.
Однако, прежде чем приступить к непосредственному определению стиля, необ�
ходимо выбрать высоту букв в создаваемой надписи. Принятие этого решения,
в свою очередь, зависит от того, в каком масштабе будет напечатан чертеж.

В традиционном черчении все объекты чертежа выполняются, как прави�
ло, не в натуральную величину, а в масштабе. Таким образом, деталь, скажем,
длиной 5 м, на чертеже при масштабе 1:100 будет иметь длину 5 см. Это позво�
ляет чертежнику не задумываться о том, что надпись с высотой букв 4 мм соот�
ветствует объектам чертежа, натуральная величина которых соответствует
размеру 40 см. Однако при черчении в AutoCAD в подавляющем большинстве
случаев все элементы чертежа, в том числе и надписи, выполняются в натураль�
ную величину. Иными словами, надпись с высотой текста 4 мм при выводе на
печать чертежа в масштабе 1:100 должна иметь на чертеже высоту букв 400 мм.
При этом надпись с такой же высотой букв 4 мм при выводе на печать чертежа
в масштабе 1:10 должна иметь на чертеже высоту букв 40 мм.

Для того чтобы не выполнять пересчет высоты букв, можно применить аль�
тернативный подход, описанный на использовании компоновок. Соответству�
ющие методы и инструменты мы рассмотрим в главе 13. Допустим, что при
выводе нашего чертежа на печать мы будем использовать масштаб 1:10. Таким
образом, для надписи с высотой букв 7 мм необходимо определить текстовый
стиль с высотой букв 70 мм. Все стили создаются на основе встроенного тексто�
вого стиля AutoCAD с именем Standard.

1. Откройте чертеж, сохраненный в файле Work092.dwg.
2. Разморозьте слой Вид сверху, измените масштаб чертежа по грани�

цам объектов, а затем сохраните текущее состояние чертежа в файле
Work101.dwg.

3. Создайте новый слой с именем Текст и индексом цвета 76 и назначьте
его текущим.

4. Выберите из меню команду Формат ⇒ Текстовый стиль (Format ⇒ Text
Style) либо введите в командном окне команду Ñòèëü (STYLE) или просто
ñò (ST). Можно также отобразить панель инструментов Текст (Text) и
щелкнуть на кнопке  Текстовые стили (Text Style) этой панели. В лю�
бом случае на экране появится диалоговое окно Текстовые стили (Text
Style) с параметрами используемого по умолчанию встроенного тексто�
вого стиля Standard (рис. 10.1).

5. Щелкните на кнопке Новый (New). В появившемся диалоговом окне
Новый текстовый стиль (New Text Style) вместо созданного по умолча�
нию имени стиль1 (style1) введите имя Òåêñò 10 ìì и щелкните на кноп�
ке OK для закрытия окна Новый текстовый стиль (New Text Style).

6. Вернувшись в окно Текстовые стили (Text Style), вы увидите, что создан
новый текстовый стиль Текст 10 мм. Поскольку его параметры пока что
совпадают с параметрами стандартного текстового стиля, мы сейчас их
изменим. Перейдите в группу Шрифт (Font) и раскройте список Имя
шрифта (Font Name). В этом списке перечислены все доступные для ис�
пользования шрифты – как шрифты, входящие в комплект поставки
AutoCAD, так и обычные шрифты Windows.

7. Найдите в списке шрифт romand.shx и щелкните на нем. Список закро�
ется, а в строке Имя шрифта (Font Name) вместо шрифта txt.shx появит�
ся выбранный вами шрифт.

8. Перейдите в строку ввода Высота (Height) группы Шрифт (Font) и вве�
дите в ней вместо текущего значения 0.0 значение 100.0 (как отмеча�
лось выше, при выводе чертежа на печать в масштабе 1:10 это значение
высоты букв позволит получить высоту текста, равную 10 мм).

9. Перейдите в строку ввода Угол наклона (Oblique Angle) группы парамет�
ров Эффекты (Effects) и введите в ней вместо текущего значения 0.0 зна�
чение 15.0 (угол наклона букв шрифта в соответствии с отечественны�
ми стандартами).

10. Щелкните на кнопке Применить (Apply), которая находится в правом
верхнем углу окна Текстовые стили (Text Style). Теперь текстовый стиль
Текст 10 мм сохранен в файле чертежа и назначен его текущим тексто�
вым стилем, то есть все создаваемые впоследствии надписи будут осно�
вываться именно на этом стиле до тех пор, пока вы не назначите теку�
щим другой текстовый стиль.

Рис. 10.1  Диалоговое окно Текстовые стили (Text Style)
с параметрами стандартного стиля AutoCAD
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11. Не щелкая на кнопке Закрыть (Close), снова щелкните на кнопке Новый
(New) для создания еще одного текстового стиля.

12. В диалоговом окне Новый текстовый стиль (New Text Style) введите
Òåêñò 7 ìì и щелкните на кнопке OK. Будет создан новый стиль с име�
нем Текст 7 мм, который после возврата в окно Текстовые стили (Text
Style) станет текущим стилем.

13. Как и в предыдущем случае, нам нужно изменить параметры нового сти�
ля. Выберите из списка шрифтов шрифт romans.shx, а затем измените
его высоту, введя в строке Высота (Height) значение 70.0.

14. Щелкните на кнопке Применить (Apply). Теперь стиль Текст 7 мм стал
текущим. Однако нам в ближайшее время понадобится определенный
ранее стиль Текст 10 мм. Поэтому сначала выберите его из раскрываю�
щегося списка Имя стиля (Style Name) и лишь после этого щелкните на
кнопке Закрыть (Close).

Итак, вы создали два текстовых стиля: Текст 10 мм, который мы будем ис�
пользовать для однострочных надписей, и Текст 7 мм, который удобнее при�
менять для многострочных текстов. Текущим в настоящее время является
стиль Текст 10 мм. Это означает, что все создаваемые текстовые объекты будут
основываться именно на этом стиле. Когда нам понадобиться переключиться
на стиль Текст 7 мм, нужно будет повторно воспользоваться окном Текстовые
стили (Text Style) и назначить соответствующий стиль текущим.

Примечание. Если в определении стиля шрифта параметр Высота (Height) име�
ет значение 0.0 (как, например, для шрифта Standard на рис. 10.1), это означа�
ет, что высота текста может быть произвольной и что ее нужно будет зада�
вать вручную при создании каждого текстового объекта, основанного на таком
стиле.

Теперь мы можем приступить к собственно созданию текстовых объектов.
Как отмечалось выше, мы начнем знакомство с соответствующими методами и
инструментами AutoCAD с создания однострочных надписей.

10.2. Создание однострочных надписей10.2. Создание однострочных надписей10.2. Создание однострочных надписей10.2. Создание однострочных надписей10.2. Создание однострочных надписей
Поскольку в текущем чертеже вид сверху находится не под главным видом, как
того требуют стандарты оформления чертежей, а над ним, мы должны создать
надпись, поясняющую, что приведенное над главным видом изображение
представляет на чертеже вид сверху, а не вид снизу.

10.2.1. Использование инструмента «Однострочный»10.2.1. Использование инструмента «Однострочный»10.2.1. Использование инструмента «Однострочный»10.2.1. Использование инструмента «Однострочный»10.2.1. Использование инструмента «Однострочный»
(Single Line T(Single Line T(Single Line T(Single Line T(Single Line Text)ext)ext)ext)ext)
Надпись, обозначающую вид, нужно выровнять по горизонтали по центру со�
ответствующего фрагмента чертежа. Для этого мы создадим вертикальную
направляющую, которую затем используем для привязки к ней создаваемой
надписи.

1. Начертите вертикальную линию, начинающуюся от средней точки верх�
ней горизонтальной линии контура задней стенки и заканчивающуюся
примерно возле верхней границы главного вида (рис. 10.2).

2. Сместите вниз на 1000 мм нижнюю горизонтальную линию контура пря�
молинейного участка столешницы.

3. Выберите из меню команду Черчение ⇒ Текст ⇒ Однострочный (Draw ⇒
Text ⇒ Single Line Text) или щелкните на кнопке  Однострочный
(Single Line Text) панели инструментов Текст (Text) (можно также ввес�
ти в командном окне команду Òåêñò (TEXT) или Äòåêñò (DTEXT), или
äò (DT)). Запустится инструмент Однострочный (Single Line Text), пред�
назначенный для создания однострочных надписей.

4. В командном окне появится приглашение задать начальную точку распо�
ложения текста или выбрать режим выравнивания либо стиль, отлич�
ный от текущего. Над этим приглашением в командном окне будет выве�
дено название текущего стиля и высота шрифта. По умолчанию текст
выравнивается по левому краю, поэтому нам нужно изменить режим вы�
равнивания, чтобы расположить текст по центру от точки вставки. Вве�
дите Âûðàâíèâàíèå (JUSTIFY) или просто âð (J) для того, чтобы пере�
ключить команду Äòåêñò (DTEXT) в режим выравнивания.

5. В командном окне отобразиться приглашение режима выравнивания
с перечнем всех возможных параметров. Введите Öåíòð (CENTER) или
просто ö (C) для выбора выравнивания по центру.

6. AutoCAD предложить в командном окне выбрать центральную точку текста.
Нажмите Shift и, удерживая эту клавишу нажатой, щелкните правой кнопкой

Рис. 10.2  Создание вспомогательной вертикальной линии
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мыши. На экране в месте расположения мыши
появится контекстное меню (рис. 10.3).

7. Выберите из контекстного меню команду Пе�
ресечение (Intersection) и щелкните на пересе�
чении вертикальной и горизонтальной линий,
созданных в пп. 1 и 2.

8. В ответ на появившееся предложение выбрать
угол поворота просто нажмите Enter, чтобы
принять используемое по умолчанию значение
0є. В точке пересечения, выбранной в качестве
точки вставки текста, появится текстовый I�об�
разный курсор.

Примечание. Как видно из рис. 10.3, специальное
контекстное меню, для открытия которого нужно
во время щелчка правой кнопкой мыши удерживать
нажатой Shift, содержит перечень всех режимов при�
вязки, команду Режимы привязки (Osnap Settings),
позволяющую включать и выключать режимы по�
стоянно действующей привязки с помощью диалогового окна Режимы рисования
(Drafting Settings). Кроме того, в этом меню имеется вложенное подменю Коорди�
натные фильтры (Point Filters), с помощью которого можно при выборе точек
чертежа выбирать различные типы координатных фильтров.

9. Наберите текст ÂÈÄ ÑÂÅÐÕÓ (рис. 10.4) и нажмите Enter. Введенный
текст разместится в области пересечения вспомогательных линий, сразу
выровнявшись по горизонтали по центру.

10. Снова нажмите Enter для завершения работы инструмента Одностроч�
ный (Single Line Text), а затем удалите направляющие.

Итак, вы создали однострочную надпись, применив при этом режим вырав�
нивания ее по горизонтали по центру вспомогательной линии. Подробнее
о том, как применить выравнивание текста как по горизонтали, так и по верти�
кали, мы поговорим далее в этой главе.

Теперь давайте создадим надписи, обозначающие разрезы на соответствую�
щих слоях.

10.2.2. Использование текста для обозначения разрезов10.2.2. Использование текста для обозначения разрезов10.2.2. Использование текста для обозначения разрезов10.2.2. Использование текста для обозначения разрезов10.2.2. Использование текста для обозначения разрезов
В чертежах разрезы изображаются на основных видах с помощью линий сече�
ния – разомкнутых линий с начальными и конечными штрихами, на которых
наносятся стрелки, указывающие направление взгляда на предмет. На концах
линии сечения ставится одна и та же прописная буква. Собственно разрезы
обозначаются надписью из двух соответствующих букв (А–А, Б–Б и т. д.).
О том, как создать стрелки, мы поговорим в следующей главе, а сейчас созда�

дим линии сечения на основном виде, а также обозначим разрезы на соответ�
ствующих слоях.

1. Разморозьте слои Высота 1495 и Штриховка 1495, назначив последний
текущим, а слои Вид сверху и Текст заморозьте.

2. Измените масштаб просмотра так, чтобы над чертежом разреза на высо�
те 1495 мм образовалось свободное пространство, достаточное для раз�
мещения надписи.

3. Создайте две вспомогательные линии: вертикальную, проведенную из
середины верхней горизонтальной линии контура задней стенки, и гори�
зонтальную, полученную путем смещения этой же горизонтальной ли�
нии контура задней стенки вверх на 300 мм (рис. 10.5).

4. Скопируйте обе вспомогательные линии на слой 0, поскольку они пона�
добятся вам в дальнейшем для обозначения других разрезов.

5. Сместите на главном виде левую линию контура боковой стенки влево на
100 мм, а затем еще раз сместите полученную линию еще на 100 мм левее
первой.

6. Создайте зеркальное отображение двух полученных вертикальных ли�
ний относительно середины столешницы (рис. 10.6).

7. Также скопируйте полученные четыре вертикальные линии на нулевой
слой.

8. Сместите линию нулевой высоты на главном виде вверх на 1495 мм, а за�
тем продлите ее так, чтобы она доходила до крайней левой и крайней
правой вертикальных линий (рис. 10.7).

9. Обрежьте лишние сегменты вспомогательных линий, чтобы получить из
линии высоты 1495 мм два штриха, которые будут на чертеже обозначать

Рис. 10.3  Специальное контекстное меню

Рис. 10.4  Создание однострочной надписи
с использованием вспомогательных линий
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вая по правому краю, для чего, переключившись в режим Âûðàâíèâàíèå
(JUSTIFY) команды Äòåêñò (DTEXT), введите Âïðàâî (RIGHT) или про�
сто ð (R). В качестве точки вставки выберите левую оконечную точку
штриха. При создании буквы А возле правого штриха выбирать режим
выравнивания не нужно, поскольку по умолчанию текст выравнивается
по левому краю, – просто задайте в качестве точки вставки правую око�
нечную точку штриха.

Рис. 10.5  Вспомогательные линии, предназначенные для обозначения разреза

Рис. 10.6  Создание вспомогательных вертикальных линий на главном виде

Рис. 10.7  Обозначена высота 1495 мм,
из которой можно создать линию сечения для разреза А–А

Рис. 10.8  Штрихи линии сечения для разреза А–А созданы

линию сечения разреза А–А (рис. 10.8). Переместите полученные штри�
хи на слой Штриховка 1495.

10. Создайте на виде сверху надпись A–A, а на главном виде – две буквы А
возле каждого штриха, как показано на рис. 10.9. Для надписи A–A выбе�
рите выравнивание по центру и привязку к точке пересечения, как вы
это проделывали при создании надписи ВИД СВЕРХУ. При создании
буквы А возле левого штриха на главном виде выберите режим выравни�
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11.  Сместите вертикальную вспомогательную линию на виде сверху влево и
вправо на 160 мм, а затем удалите исходную вертикальную линию и об�
режьте горизонтальную линию по двум полученным линиям так, чтобы
образовалась линия подчеркивания надписи A–A.

12. Удалите вертикальные линии, по которым была обрезана линия подчер�
кивания, и переместите последнюю на слой Штриховка 1495 (рис. 10.10).

13. Как нетрудно заметить, созданные надписи имеют один недостаток – бук�
вы расположены слишком низко относительно линий. Для исправления

этого недостатка выделите все три текстовых объекта, щелкнув на них,
а затем щелкните правой кнопкой мыши на любом из выделенных объек�
тов и выберите из контекстного меню команду Свойства (Properties).

14. В списке Выравнивание (Justify) появившейся палитры Свойства (Pro�
perties) выберите пункт Вниз по центру (Bottom center). Все три тексто�
вых объекта поднимутся над линиями, как показано на рис. 10.11.

Рис. 10.9  Линия сечения и разрез А–А обозначены

Рис. 10.10  Создана линия подчеркивания в обозначении разреза А–А

Рис. 10.11  Настройка расположения текста
с помощью палитры Свойства (Properties)

15. Закройте палитру Свойства (Properties) и снимите выделение с тексто�
вых объектов. Буквы, обозначающие разрез А–А на штрихах линии сече�
ния, сместятся внутрь главного вида (рис. 10.12), однако мы на это обра�
щать внимание пока что не будем, поскольку окончательную доработку
обозначения линии сечения мы выполним в следующей главе.

10.2.3. Режимы выравнивания текста10.2.3. Режимы выравнивания текста10.2.3. Режимы выравнивания текста10.2.3. Режимы выравнивания текста10.2.3. Режимы выравнивания текста
Прежде, чем двигаться дальше, необходимо сделать отступление и прокоммен�
тировать, каким образом был достигнут требуемый эффект при позициониро�
вании надписей относительно линий. Дело в том, что однострочные надписи,
независимо от того, из какого количества символов они состоят, представляют
собой единые объекты, методы позиционирования которых во многом подоб�
ны методам позиционирования блоков. Правда, в отличие от блоков, тексто�
вые объекты имеют не точку вставки, а точку выравнивания (justification point).
С помощью этой точки текстовый объект можно привязать к объекту чертежа,
применяя инструмент Пересечение (Snap to Intersection).

При использовании команды Äòåêñò (DTEXT) или Òåêñò (TEXT), как уже
отмечалось выше, по умолчанию используется режим выравнивания по левому
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краю. Однако, учитывая, что AutoCAD позволяет выравнивать текст не только
по горизонтали, но и по вертикали, следует отметить, что текст по умолчанию
выравнивается не просто по левому краю, а по левой нижней точке базовой
линии – воображаемой линии, вдоль которой располагаются символы текста.
Как вы уже знаете, если после запуска команды Äòåêñò (DTEXT) или Òåêñò
(TEXT) в ответ на приглашение ввести Âûðàâíèâàíèå (JUSTIFY), AutoCAD
предложит выбрать один из следующих режимов выравнивания.

Задайте опцию [âïÈñàííûé/Ïîøèðèíå/Öåíòð/ñÅðåäèíà/âïÐàâî/ÂË/
ÂÖ/ÂÏ/ÑË/ÑÖ/ÑÏ/ÍË/ÍÖ/ÍÏ]:

(Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/
MR/BL/BC/BR]:)

Большинство перечисленных в этом приглашении режимов выравнивания
представлены на рис. 10.13.

Режимы Âïèñàííûé (ALIGN) и Ïîøèðèíå (FIT) отличаются от остальных
режимов выравнивания тем, что определяют не только местоположение одно�
строчного текстового объекта, но и угол его поворота.

Примечание. В режиме Âïèñàííûé (ALIGN) AutoCAD предлагает задать две
точки, а затем выровнять текст между ними. Угол наклона линии, образуемой
этими двумя точками, определяет угол поворота текстового объекта. Поскольку
горизонтальный размер введенного текста точно подгоняется под расстояние
между заданными точками, AutoCAD не предлагает в этом режиме задать высо�
ту шрифта, поскольку она определяется автоматически. В режиме Ïîøèðèíå
(FIT) AutoCAD также предлагает задать две точки, которые определяют угол по�
ворота текстового объекта. Однако, в отличие от режима Âïèñàííûé (ALIGN),
AutoCAD в режиме Ïîøèðèíå (FIT) предлагает ввести высоту текста. Затем

текст преобразуется, разрежаясь или уплотняясь так, чтобы весь текстовый
объект точно поместился между двумя заданными точками.

На практике режимы Âïèñàííûé (ALIGN) и Ïîøèðèíå (FIT) вы будете ис�
пользовать гораздо реже, чем остальные режимы выравнивания, поэтому да�
вайте рассмотрим их подробнее, поскольку в их использовании имеются неко�
торые достаточно важные нюансы.

В уже знакомом вам режиме Öåíòð (CENTER) AutoCAD предлагает задать
точку, относительно которой текст будет выровнен по центру по горизонтали.
Иными словами, в этом режиме текстовый объект выравнивается так, чтобы
в заданной точке находилась средняя точка базовой линии. Режим Ñåðåäèíà
(MIDDLE) подобен режиму Öåíòð (CENTER) с тем лишь отличием, что тексто�
вый объект выравнивается не только по горизонтали, но и по вертикали. При
этом учитываются как надстрочные, так и подстрочные элементы букв – проще
говоря, в режиме Ñåðåäèíà (MIDDLE) выравнивание по вертикали осуществ�
ляется по высоте текстового объекта в целом. Часто выравнивание в режимах
Ñåðåäèíà (MIDDLE) и ÑÖ (MC) (рассмотрен ниже) дает одинаковый резуль�
тат, однако в общем случае соответствующие точки могут не совпадать, что и
показано на рис. 10.13. Режим Âïðàâî (RIGHT) подобен используемому по
умолчанию режиму выравнивания влево, но, в отличие от последнего, выбран�
ная точка определяет не левую, а правую границу текста. После завершения ко�
манды текстовый объект в режиме Âïðàâî (RIGHT) располагается во всю дли�
ну слева от заданной точки.

Режимы ÂË (TL), ÂÖ (TC) и ÂÏ (TR) представляют собой режимы выравнива�
ния верхних элементов текста (Âåðõ (Top)) по левой границе, по центру и по
правой границе, соответственно. При выборе одного из этих режимов AutoCAD
выравнивает текст так, чтобы верхние элементы текста находились на одном
уровне с заданной точкой с соответствующим режимом выравнивания по гори�
зонтали. Режимы ÑË (ML), ÑÖ (MC) и ÑÏ (MR) предназначены для выравнива�
ния текста по вертикали по середине высоты букв (Ñåðåäèíà (MIDDLE)). Под�
строчные элементы при этом не учитываются, поэтому, как уже отмечалось
выше, в общем случае выравнивание в режимах ÑÖ (MC) и Ñåðåäèíà (MIDDLE)
может приводить к несколько различающимся результатам. В режимах ÍË
(BL), ÍÖ (BC) и ÍÏ (BR) текст по вертикали выравнивается по нижним точкам

Рис. 10.12  Разрез А–А обозначен, за исключением стрелок на главном виде

Рис. 10.13  Точки, по которым
выравниваются однострочные текстовые объекты

Сверху слева

Посередине

слева

Слева

Снизу слева

Центр

Снизу по центру

Сверху по центру

Посередине

по центр

Справа

Снизу справа

Сверху справа

Посередине

справа

Посередине

Базовая линия

Создание однострочных надписейСоздание однострочных надписейСоздание однострочных надписейСоздание однострочных надписейСоздание однострочных надписей



Нанесение надписейНанесение надписейНанесение надписейНанесение надписейНанесение надписей338 339

подстрочных элементов. Режим ÍÖ (BC), который в списке Выравнивание
(Justify) палитры Свойства (Properties) называется Вниз по центру (Bottom
center), был применен нами для того, чтобы «приподнять» текст над штрихами
линии сечения.

Теперь вам, должно быть, понятно, почему буквы на главном виде сместились
внутрь после применения режима выравнивания Вниз по центру (Bottom
center). Действительно, к правой букве нужно применить режим выравнивания
Вниз влево (Bottom left), а к левой букве – режим выравнивания Вниз вправо
(Bottom right). Руководствуясь рис. 10.13, попробуйте решить эту задачу само�
стоятельно, еще раз воспользовавшись палитрой Свойства (Properties).

10.2.4. Перемещение и редактирование текста10.2.4. Перемещение и редактирование текста10.2.4. Перемещение и редактирование текста10.2.4. Перемещение и редактирование текста10.2.4. Перемещение и редактирование текста
Для завершения создания надписей, обозначающих разрезы, нужно проделать
те же операции, что и для обозначения разреза А–А. Однако мы применим не�
сколько иной подход, основанный на копировании и последующем редактиро�
вании текстовых объектов.

1. Заморозьте слой Высота 1495, разморозьте слой Штриховка 1090 и на�
значьте его текущим.

2. Скопируйте на слой Штриховка 1090 надписи и линии, относящиеся к обо�
значению разреза А–А, после чего заморозьте слой Штриховка 1495.

3. Разморозьте слой Высота 1090 и нулевой слой и скопируйте две пары
вертикальных вспомогательных линий, которые были раньше помеще�
ны на слой 0, на слой Штриховка 1495, после чего снова заморозьте ну�
левой слой.

4. Сместите нижнюю линию нулевой высоты на главном виде вверх на 1090 мм
и продлите ее до наружных вертикальных линий (рис. 10.14).

5. Измените масштаб просмотра так, чтобы на главном виде были видны
правая буква А и та часть линии, расположенной на высоте 1090 мм от
линии нулевой высоты, которая находится между двумя вертикальными
линиями.

6. Щелкните на букве А. Ее контур станет штриховым, а возле нее появится
два маркера, обозначающих точку вставки (правая оконечная точка
штриха линии сечения), и точку, соответствующую выбранному режиму
выравнивания. В том случае, если вы исправили режим выравнивания и
вместо режима Вниз по центру (Bottom center) применили режим Вниз
влево (Bottom left), маркеры будут расположены так, как показано на
рис. 10.15.

Рис. 10.14  Объекты, скопированные на слой Штриховка 1090,
и вспомогательные линии на главном виде

Рис. 10.15  Маркеры выделения текстового объекта
обозначают точку вставки и точку выравнивания

7. Щелкните на нижнем маркере, а затем нажмите Пробел для перехода от
режима Ðàñòÿãèâàíèå (STRETCH) в режим Ïåðåìåùåíèå (MOVE).
Сместите текстовый объект за выделенный маркер вниз и расположите
его так, чтобы AutoCAD распознал правую оконечную точку линии, обо�
значающей высоту 1090 мм (рис. 10.16), после чего щелкните для захвата
этой точки в качестве новой точки вставки текстового объекта.

8. Текстовый объект после смещения по�прежнему остается выделенным.
Выберите из меню команду Изменить ⇒ Объект ⇒ Текст ⇒ Редактиро�
вать (Modify ⇒ Object ⇒ Text ⇒ Edit) или щелкните на кнопке  Редак�
тировать (Edit) панели инструментов Текст (Text) либо введите в коман�
дном окне команду Äèàëðåä (DDEDIT) или просто ðåä (ED).
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9. После запуска команды Äèàëðåä (DDEDIT) выделение текстового объек�
та изменится – вместо выделения контура весь объект будет выделен цве�
том. Щелкните на букве A, и рядом с ней появится текстовый курсор вво�
да. Нажмите Backspace для удаления буквы А и введите вместо нее букву
Б, завершив ввод нажатием Enter, а затем нажмите еще раз Enter для за�
вершения команды Äèàëðåä (DDEDIT).

10. Восстановите предыдущий масштаб просмотра, а затем проделайте опе�
рации, описанные в пп. 5–9, для левой буквы А.

11. Снова вернувшись к исходному масштабу, отредактируйте надпись A–A,
заменив текст на Б–Б.

12. Завершите создание обозначения разреза Б–Б, оформив штрихи линии
сечения, как вы это делали для штрихов линии сечения разреза А–А. Пос�
ле завершения всех операций чертеж должен выглядеть так, как показа�
но на рис. 10.17.

Совет. Отредактировать текст можно также с помощью палитры Свойства
(Properties), изменив для этого значение параметра Содержимое (Contents) разде�
ла Текст (Text) этой палитры.

Продолжите обозначение остальных разрезов (для надписей, обозначаю�
щих разрез В–В, который соответствует высоте 758 мм, придется создать но�
вый слой, поскольку штриховка для слоя Высота 758 не создавалась) а затем
сохраните текущее состояние чертежа в файле Work101.dwg.

Завершив создание надписей, обозначающих разрезы, заморозьте все слои,
кроме слоев Вид спереди, Вид сверху и Текст, и сохраните чертеж в новом
файле Work102.dwg. Теперь можно расположить на чертеж комментарии, ко�

торыми часто сопровождаются чертежи. При этом лучше всего создать соот�
ветствующую надпись в виде многострочного объекта. Однако прежде следует,
в соответствии с требованиями стандартов, создать на чертеже рамку и основ�
ную надпись, что позволит правильно принять решение о позиционировании
многострочной надписи с комментариями. Тексты основной надписи мы вы�
полним в виде однострочных текстовых объектов, для чего нам понадобится
определить несколько дополнительных текстовых стилей.

10.3. Создание основной надписи в виде10.3. Создание основной надписи в виде10.3. Создание основной надписи в виде10.3. Создание основной надписи в виде10.3. Создание основной надписи в виде
полилинииполилинииполилинииполилинииполилинии
Как отмечалось выше, мы приняли решение о том, что чертеж рабочей зоны бу�
дет выводиться на печать в масштабе 1:10. Учитывая габариты чертежа, на кото�
ром отображается два вида (примерно 3000 × 4500 мм), можно сделать вывод
о том, что для его размещения в таком масштабе понадобится лист формата A2
(420 × 594 мм) с расположением основной надписи вдоль короткой стороны листа.

10.3.1. Использование инструмента «Прямоугольник»10.3.1. Использование инструмента «Прямоугольник»10.3.1. Использование инструмента «Прямоугольник»10.3.1. Использование инструмента «Прямоугольник»10.3.1. Использование инструмента «Прямоугольник»
(Rectangle) для создания рамки(Rectangle) для создания рамки(Rectangle) для создания рамки(Rectangle) для создания рамки(Rectangle) для создания рамки
Сначала мы создадим прямоугольник, представляющий границы листа форма�
та A2, а затем начертим на полученном листе прямоугольную рамку с размера�
ми, определяемыми требованиями стандартов.

1. Создайте новый слой Основная надпись с индексом цвета 7 и назначьте
его текущим.

Рис. 10.16  Выбор новой точки вставки
с помощью режима Ïåðåìåùåíèå (MOVE) маркера выделения

Рис. 10.17  Разрез Б–Б обозначен, за исключением стрелок на главном виде
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2. Запустите инструмент Прямоугольник (Rectangle) (например, введя
в командном окне ïðÿ (REC)). В ответ на запрос AutoCAD ввести коорди�
наты первой точки введите 0,0.

3. AutoCAD предложит ввести координаты второй точки. Введите в команд�
ном окне 4200,5940 (размеры листа формата A2, увеличенные в 10 раз).
Выполнение команды Ïðÿìîóãîëüíèê (RECTANG) автоматически за�
вершится, а в области черчения появится большой прямоугольник, ухо�
дящий вверх за ее пределы.

4. Воспользуйтесь инструментами Панорамирование в реальном време�
ни (Pan Realtime) и Зумирование в реальном времени (Zoom Realtime)
с целью обеспечения отображения в области черчения всех видимых
объектов текущего чертежа (рис. 10.18).

8. Измените масштаб чертежа по границам объектов с помощью инстру�
мента Зумировать в границах (Zoom Extents).

9. Теперь нужно создать собственно рамку, которая в соответствии с требо�
ваниями стандартов должна отстоять от левой границы листа на 20 мм,
а от всех остальных – на 5 мм. В масштабе 1:10 соответствующие размеры
объектов чертежа составят 200 и 50 мм. Для начала сместите внутрь гра�
ницу формата на 50 мм с помощью команды Ïîäîáèå (OFFSET).

10. Воспользуйтесь инструментом Расчленить (Explode), чтобы разделить
внутренний прямоугольник на отдельные сегменты, а затем сместите ле�
вый вертикальный сегмент вправо на 150 мм.

11. Удалите ставший ненужным исходный вертикальный сегмент, а затем
с помощью инструмента Сопряжение (Fillet) выполните сопряжение
с нулевым радиусом смещенного вертикального сегмента рамки с двумя
горизонтальными сегментами, чтобы убрать выступающие концы гори�
зонтальных сегментов.

12. Для объединения линий рамки в единый объект необходимо преобразо�
вать четыре образующих рамку сегмента в так называемую полилинию
(polyline). Детальнее об использовании полилиний мы поговорим не�
сколько позднее, когда будем создавать основную надпись. Пока же про�
сто выберите из меню команду Изменить ⇒ Объект ⇒ Полилиния (Mo�
dify ⇒ Object ⇒ Polyline).

13. AutoCAD предложит в командном окне выбрать полилинию. Щелкните
на левой вертикальной линии рамки. AutoCAD распознает выбранный
объект, как обычную линию, и предложит выбрать дополнительные сег�
менты, чтобы преобразовать их в полилинию. Введите Ä (YES) или про�
сто нажмите Enter для подтверждения.

Рис. 10.18  Масштаб чертежа изменен так, чтобы были видны все текущие объекты,
включая только что созданную границу формата

5. Для того чтобы чертеж рабочей зоны оказался внутри границы формата,
можно сместить либо сам чертеж (что нежелательно), либо границу фор�
мата (что вполне осуществимо без каких�либо побочных эффектов). По�
этому щелкните на прямоугольнике, представляющем границу формата,
для отображения маркеров выделения.

6. Щелкните на нижнем левом маркере для перехода в режим редактирова�
ния объекта с помощью маркеров, затем нажмите Пробел для перехода
от режима Ðàñòÿãèâàíèå (STRETCH) к режиму Ïåðåìåùåíèå (MOVE).

7. Переместите прямоугольник влево и вниз так, чтобы он занял положе�
ние, показанное на рис. 10.19. Добившись нужного расположения, щелк�
ните левой кнопкой мыши и нажмите Esc для отмены отображения мар�
керов выделения.

Рис. 10.19  Перемещение границы формата с использованием маркеров выделения
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14. AutoCAD отобразит перечень режимов редактирования полилинии. Вве�
дите в командном окне Çàìêíóòü (JOIN) или просто ç (J) для включения
режима объединения отрезков в полилинию. Выберите три остальных
прямолинейных сегмента, как показано на рис. 10.20, а затем дважды на�
жмите Enter для завершения объединения обычных линий в полилинию.

содержимое которой определяются стандартами. В частности, в основной над�
писи указываются: наименование изделия и наименование документа; обозна�
чение документа; обозначение материала детали (на чертежах деталей); лите�
ра, присвоенная документу; расчетная масса изделия; масштаб изображения;
порядковый номер листа и общее количество листов; наименование предприя�
тия, а также фамилии разработчиков документа и контролирующих лиц. На пер�
вом листе чертежей, в соответствии с требованиями стандартов, располагают
основную надпись формы 1, имеющей вид таблицы с размерами 55 × 185 мм.
Поэтому мы создадим основную надпись именно такого вида, используя для
этого уже упоминавшийся и применявшийся выше инструмент Полилиния
(Polyline).

Если вы помните, в главе 4, когда вы впервые применили инструмент Пря�
моугольник (Rectangle), автор отмечала, что создаваемые с помощью этого
инструмента прямоугольники представляют собой замкнутую полилинию (poly�
line). Основное отличие полилинии от обычной линии заключается в том, что
полилиния может быть произвольной ширины, тогда как обычная линия в об�
ласти черчения ширины не имеет. Иными словами, обычная линия при любом
масштабе всегда выглядит тонкой, тогда как ширина полилинии изменяется
в соответствии с изменениями масштаба. Более того – отдельные сегменты од�
ной и той же полилинии могут иметь разную ширину.

Как вы уже знаете, в общем случае полилинию произвольной формы (в том
числе путем преобразования обычных линий в полилинию) можно создать
с помощью инструмента Полилиния (Polyline). Применив инструмент Расчле�
нить (Explode), можно выполнить обратную операцию – разбить единый объект,
представленный полилинией, на совокупность независимых прямолинейных сег�
ментов, каждый из которых представляет собой экземпляр обычной линии.

Рис. 10.20  Выбор прямолинейных сегментов
для объединения их в полилинию

15. Щелкните на любой из линий рамки. Если вы все сделали правильно, бу�
дут выделены сразу все четыре отрезка, то есть рамка теперь представля�
ет собой единый объект�прямоугольник.

16. Не отменяя выделения, откройте палитру Свойства (Properties), вос�
пользовавшись для этого контекстным меню или кнопкой панели инст�
рументов Standard. Найдите в разделе Геометрия (Geometry) палитры
Свойства (Properties) параметр Глобальная ширина (Global width) и из�
мените его значение с 0 на 15. Это приведет к тому, что ширина полили�
нии станет равной 15 мм, что при выводе чертежа на печать в масштабе
1:10 позволит получить линию толщиной 1.5 мм.

17. Закройте палитру Свойства (Properties) и нажмите Esc, чтобы снять вы�
деление с прямоугольника, представляющего рамку. Чертеж будет иметь
вид, представленный на рис. 10.21.

10.3.2. Использование инструмента «Полилиния»10.3.2. Использование инструмента «Полилиния»10.3.2. Использование инструмента «Полилиния»10.3.2. Использование инструмента «Полилиния»10.3.2. Использование инструмента «Полилиния»
(Polyline) для создания граф основной надписи(Polyline) для создания граф основной надписи(Polyline) для создания граф основной надписи(Polyline) для создания граф основной надписи(Polyline) для создания граф основной надписи
Все конструкторские документы должны иметь так называемую основную над�
пись – специальную таблицу в правом нижнем углу чертежа, форма, размеры и

Рис. 10.21  Граница листа формата A2 и рамка созданы
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Итак, давайте рассмотрим последовательность операций, которые позво�
лят нам создать основную надпись с помощью полилиний.

1. Измените масштаб просмотра так, чтобы правый нижний угол чертежа
занимал всю область черчения. Убедитесь в том, что включен режим ав�
томатической привязки Расчленить (Explode), и включите режим авто�
матической привязки Нормаль (Perpendicular).

2. Запустите инструмент Полилиния (Polyline), воспользовавшись коман�
дой Черчение ⇒ Полилиния (Draw ⇒ Polyline) или щелкнув на кнопке

 Полилиния (Polyline) панели инструментов Черчение (Draw). Для
запуска инструмента Полилиния (Polyline) из командного окна введите
команду Ïëèíèÿ (PLINE) или просто ïë (PL).

3. AutoCAD предложит в командном окне задать координаты первой точки.
Убедитесь в том, что включен режим ОРТО (ORTHO), а затем, включив
режим разовой привязки Смещение (Snap From), в ответ на приглаше�
ние задать базовую точку щелкните в правом нижнем углу рамки.

4. AutoCAD предложит задать величину смещения. Переместите указатель
мыши влево и, когда AutoCAD распознает направление 180°, введите
1850 (185 мм в масштабе 1:10). Таким образом, создаваемая полилиния
будет начинаться левее 1850 мм правого нижнего угла рамки (рис. 10.22).

из режимов создания полилинии. Введите Øèðèíà (WIDTH) или просто
ø (W) для изменения ширины полилинии.

6. AutoCAD предложит задать начальную ширину полилинии. Введите 15,
чтобы при печати чертежа в масштабе 1:10 получить линию основной
надписи толщиной 1.5 мм. В ответ на приглашение задать конечную ши�
рину полилинии просто нажмите Enter, чтобы принять предложенное
по умолчанию значение 15 мм.

7. AutoCAD отобразит изменившуюся ширину полилинии и снова предло�
жит вам задать вторую точку. Введите в командном окне 550 (55 мм при
печати чертежа в масштабе 1:10). Создав первый сегмент полилинии,
AutoCAD предложит начертить следующий сегмент.

8. Переместите указатель�перекрестие вправо, до пересечения горизон�
тального сегмента с правой вертикальной границей рамки. Как только
AutoCAD распознает точку падения перпендикуляра, щелкните для за�
хвата координат этой точки, а затем нажмите Enter для завершения чер�
чения полилинии. Рамка основной надписи определена (рис. 10.23).
Ширина 15 мм теперь будет использоваться по умолчанию до тех пор,
пока вы ее не измените.

Рис. 10.22  Создание первого вертикального сегмента
полилинии основной надписи

5. Обратите внимание на две нижние строки, отображаемые в командном
окне. В первой строке приведена информация о текущей ширине поли�
линии, которая для вновь создаваемых линий равна 0. Во второй строке
AutoCAD отображает приглашение задать новую точку или выбрать один

Рис. 10.23  Рамка основной надписи создана в виде полилинии

9. Снова запустите инструмент Полилиния (Polyline), включите режим ра�
зовой привязки Точка отслеживания (Temporary track point) и щелкни�
те в левом верхнем углу полученной рамки основной надписи. Перемес�
тите указатель�перекрестие вправо вдоль верхней линии рамки основной
надписи. Как только AutoCAD распознает направление 0є, введите 650 и
щелкните для захвата координаты полученной точки в качестве коорди�
нат начальной точки сегмента полилинии.
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10. Используя режим постоянно действующей привязки Нормаль (Perpen�
dicular), завершите рисование вертикального сегмента полилинии на
нижней горизонтальной линии рамки, а затем нажмите Enter для завер�
шения команды Ïëèíèÿ (PLINE).

11. Используя те же методы и инструменты AutoCAD, начертите горизон�
тальную полилинию, состоящую из одного сегмента, используя режим
привязки Точка отслеживания (Temporary track point) от левого нижне�
го угла рамки с отступом по вертикали 50 мм (рис. 10.24).

12. С помощью команды Ïîäîáèå (OFFSET) сместите полученную в п. 11 го�
ризонтальную линию вверх 9 раз, задав расстояние смещения 50 мм и
каждый раз выбирая в качестве исходной линию, полученную после оче�
редного смещения. Затем последовательно сместите влево линию, разде�
ляющую по вертикали основную надпись на две части. Расстояние смеще�
ния при каждой операции смещения установите равным 100, 150, 230 и
100 мм, а в качестве исходной выбирайте линию, полученную в результа�
те предыдущего смещения.

13. Обрежьте вертикальную линию, созданную последней, выбрав в качест�
ве секущей шестую сверху горизонтальную линию. Щелкните на всех го�
ризонтальных линиях, созданных в п. 12, кроме пятой и шестой сверху,
для их выделения, а затем с помощью палитры Свойства (Properties) ус�
тановите для них значение параметра Глобальная ширина (Global
width) в разделе Геометрия (Geometry) равным 7.5 мм (рис. 10.24).

14. Закрыв палитрe Свойства (Properties) и отменив выделение, снова запус�
тите команду Ïëèíèÿ (PLINE) и, используя режим привязки Точка от�
слеживания (Temporary track point), начертите односегментную гори�

зонтальную полилинию. В качестве начальной точки полилинии задайте
точку, находящуюся на правой вертикальной линии рамки выше на 150 мм
от ее правого нижнего угла. Конечная точка – это точка падения перпен�
дикуляра, которая находится слева от начальной точки на вертикальной
линии, разделяющей основную надпись пополам. Начертив сегмент, на�
жмите Enter для завершения команды Ïëèíèÿ (PLINE).

15. Сместите полученную полилинию вверх на 250 мм, а затем снова запусти�
те команду Ïëèíèÿ (PLINE) и, используя режим привязки Точка отсле�
живания (Temporary track point), начертите вертикальную полилинию.
Начальная точка должна находиться на нижней горизонтальной линии
рамки на 500 мм левее от ее правого нижнего угла. Конечная точка – это
точка падения перпендикуляра, которая находится над начальной точ�
кой на горизонтальной линии, полученной в п. 14 с помощью команды
Ïîäîáèå (OFFSET). Начертив вертикальный сегмент, нажмите Enter
для завершения команды Ïëèíèÿ (PLINE). Основная надпись должна
иметь вид, показанный на рис. 10.25.

Рис. 10.24  Изменение ширины выбранных полилиний
с помощью палитры Свойства (Properties)

Рис. 10.25  Основная надпись после добавления
двух длинных горизонтальных и одной длинной вертикальной линий

16. Создайте короткую горизонтальную односегментную полилинию, выб�
рав в качестве начальной точку, которая находится ниже на 50 мм от точ�
ки падения перпендикуляра вертикальной линии, созданной в п. 15.
В качестве конечной точки выберите точку падения перпендикуляра со�
здаваемой горизонтальной линии, которая находится правее начальной
точки на вертикальной линии рамки. Сместите полученную линию вниз
на 150 мм.
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17. Начертите короткую вертикальную односегментную полилинию, выб�
рав в качестве начальной точку, которая находится левее на 180 мм от
точки падения перпендикуляра верхней длинной горизонтальной ли�
нии, созданной в п. 15, на вертикальной линии рамки. В качестве конеч�
ной точки выберите точку падения перпендикуляра создаваемой верти�
кальной линии, которая находится ниже начальной точки на второй
короткой горизонтальной линии, полученной в п. 16 путем смещения
первой линии.

18. Сместите влево вертикальную линию, полученную в п. 17, каждый раз
выбирая в качестве исходной предыдущую смещенную линию. Расстоя�
ние смещения должно быть равным 170, 50 и 50 мм. Щелкните на двух
коротких вертикальных линиях, созданными последними, и установите
для них с помощью палитры Свойства (Properties) ширину 7.5 мм, после
чего закройте палитру Свойства (Properties) и отмените выделение. Ос�
новная надпись должна выглядеть так, как показано на рис. 10.26.

На этом создание граф основной надписи завершено (рис. 10.27).

Рис. 10.26  Основная надпись после добавления двух коротких горизонтальных
и четырех коротких вертикальных линий

19. Обрежьте две вертикальные линии, созданными последними, указав
в качестве секущей верхнюю короткую горизонтальную линию.

20. Начертите короткую вертикальную односегментную полилинию, вы�
брав в качестве начальной точку, которая находится левее на 300 мм от
точки падения перпендикуляра нижней длинной горизонтальной линии,
созданной в п. 14, на вертикальной линии рамки. В качестве конечной точ�
ки выберите точку падения перпендикуляра создаваемой вертикальной
линии, которая находится выше начальной точки на ближайшей гори�
зонтальной линии.

10.3.3. Заполнение граф основной надписи10.3.3. Заполнение граф основной надписи10.3.3. Заполнение граф основной надписи10.3.3. Заполнение граф основной надписи10.3.3. Заполнение граф основной надписи
с помощью однострочных текстовых объектовс помощью однострочных текстовых объектовс помощью однострочных текстовых объектовс помощью однострочных текстовых объектовс помощью однострочных текстовых объектов
Для того чтобы заполнить графы основной надписи в соответствии с требова�
ниями стандартов, нужно определить несколько дополнительных стилей, по�
скольку высота шрифта определенных ранее стилей (Текст 10 мм и Текст 7
мм) не позволяет использовать эти стили для создания всех текстовых объек�
тов, которые должны присутствовать в основной надписи.

1. Запустите инструмент Текстовые стили (Text Style) (например, введите
в командном окне ST).

2. Щелкните в открывшемся окне Текстовые стили (Text Style) на кнопке
Новый (New) и создайте стиль с именем Òåêñò 2.5 ìì.

3. Вернувшись в окно Текстовые стили (Text Style) после закрытия окна
Новый текстовый стиль (New Text Style), установите высоту для шриф�
та romans.shx, равной 25 мм. Оставив без изменения значение 15 для па�
раметра Угол наклона (Oblique Angle), введите в строке Степень растя�
жения (Width Factor) значение 0.5, чтобы получить стиль с
уплотненным шрифтом.

4. Щелкните на кнопке Применить (Apply), а затем – на кнопке Закрыть
(Close). Стиль Текст 2.5 мм теперь является текущим текстовым стилем.

5. Измените масштаб просмотра так, чтобы основная надпись занимала
всю область черчения, и запустите инструмент Однострочный (Single
Line Text) (например, введите в командном окне äò). Щелкните на кноп�

Рис. 10.27  Все графы основной надписи созданы
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ке Ничего (Snap to None), чтобы временно отключить автоматическую
привязку, а затем щелкните в пятой сверху графе основной надписи
(в самом левом столбце этой графы).

6. В ответ на приглашение ввести угол поворота нажмите Enter, а затем вве�
дите текст Èçì., который в соответствии с требованиями стандартов
должен присутствовать в этой графе. Нажмите Enter для завершения ко�
манды Äòåêñò (DTEXT).

Примечание. Если расположение текста было выбрано неудачно, откорректи�
руйте его, перетащив объект мышью в нужное место. Для упрощения задачи изме�
ните масштаб просмотра и (или) отключите на время выполнения этой опера�
ции режимы автоматической привязки.

7. Используя команду Êîïèðîâàòü (COPY), скопируйте текстовый объект
в другие графы основной надписи, руководствуясь рис. 10.28. В качестве
базовой точки при копировании удобнее всего использовать точку пере�
сечения вертикальной и горизонтальной линий графы с исходным объ�
ектом. Затем при копировании достаточно выбрать с помощью того же
режима привязки Пересечение (Intersection) аналогичную точку другой
графы, как показано на рис. 10.28, чтобы точно позиционировать копию
текстового объекта. Создайте еще несколько текстовых стилей и заполните остальные графы

основной надписи, как, например, показано на рис. 10.30, а затем масштаби�
руйте изображение по границам чертежа и сохраните текущее состояние чер�
тежа в файле Work102.dwg.

В завершение этой главы мы изучим методы и инструменты создания много�
строчных текстовых объектов, создав на чертеже текстовую часть в виде тех�
нических требований.

Рис. 10.28  Копирование текстового объекта
с использованием режима привязки Пересечение (Intersection)

8. Завершив копирование нажатием Enter, запустите инструмент Редакти�
ровать (Edit) (например, введя в командном окне ðåä (ED)) и отредакти�
руйте содержимое граф основной надписи, а также в тех случаях, где это
необходимо, измените расположение текстовых объектов, руководству�
ясь рис. 10.29.

Рис. 10.29  Графы основной надписи после редактирования текста
и уточнения расположения некоторых текстовых объектов

Рис. 10.30  Пример заполнения граф основной надписи
с использованием различных текстовых стилей
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10.4. Создание многострочной текстовой части10.4. Создание многострочной текстовой части10.4. Создание многострочной текстовой части10.4. Создание многострочной текстовой части10.4. Создание многострочной текстовой части
чертежачертежачертежачертежачертежа
 В технических требования должны содержаться требования к изделию, кото�
рые нужно проконтролировать по данному чертежу или выполнить в процессе
сборки, транспортировки или эксплуатации изделия. В частности, на сбороч�
ных чертежах и чертежах общего вида в технические требования могут вклю�
чаться следующие сведения: размеры, их предельные отклонения, формы рас�
положения поверхностей, массы и т. п.; качество поверхностей, указания об их
отделке, покрытии; зазоры, расположение отдельных элементов конструкции;
особенности настройки и регулировки изделия; особые требования к качеству
изделия; условия и методы испытания; указания о маркировании и клеймении;
правила транспортировки и хранения; особые условия эксплуатации; ссылки
на другие документы технических требований.

Текст технических требований должен состоять из пунктов, имеющих
сквозную нумерацию, причем каждый пункт записывают с абзаца. Технические
требования располагают над основной надписью колонкой, ширина которой
не должна превышать 185 мм (то есть не должна быть шире основной надписи).

Как нетрудно понять, для создания подобных объектов однострочные над�
писи не очень хорошо подходят, поскольку при необходимости внесения изме�
нений в расположение или текст отдельной строки, может понадобиться вруч�
ную изменять расположение остальных строк технических требований.

Действительно, для решения подобной задачи в AutoCAD гораздо удобнее
использовать многострочные текстовые объекты. Содержимое такого объекта
редактировать так же просто, как и текст в любом текстовом редакторе. Кроме
того, изменять расположение технической части чертежа, выполненной
в виде многострочного текстового объекта, очень легко, поскольку при изме�
нении границ такого объекта расположение образующих его строк изменяется
автоматически.

Примечание. С многострочными текстовыми объектами мы еще встретимся
в главе 11, когда будем изучать методы и инструменты создания размеров, по�
скольку тексты размерных надписей также представлены в AutoCAD в виде мно�
гострочных текстовых объектов.

1. Измените масштаб просмотра так, чтобы видеть ту часть чертежа, кото�
рая находится между основной надписью и нижней линией главного
вида, и назначьте текущим слой Текст, а также отключите все режимы
автоматической привязки.

2. Запустите инструмент Многострочный текст (Multiline Text), щелкнув
для этого на кнопке  Многострочный текст (Multiline Text) панели
инструментов Черчение (Draw), выбрав из меню команду Черчение ⇒
Текст ⇒ Многострочный (Draw ⇒ Text ⇒ Multiline Text) либо введя
в командном окне команду Ìòåêñò (MTEXT) или просто ìò (MT).

3. В командном окне отобразится название текущего стиля и соответствую�
щая ему высота шрифта, после чего AutoCAD предложит задать коорди�
наты точки верхнего левого угла многострочного текстового объекта.
Щелкните немного ниже чертежа главного вида в точке, которая распо�
ложена над левым верхним углом основной надписи.

4. Переместите указатель вправо и вниз, задав тем самым размер текстово�
го объекта, соответствующий ширине основной надписи (рис. 10.31).

Рис. 10.31  Определение размеров многострочного текстового объекта

5. AutoCAD создаст многострочный текстовый объект и автоматически пе�
реключится в режим редактирования текста. Если вы имеете хотя бы ми�
нимальный опыт работы с текстовыми редакторами, вы легко разбере�
тесь во всех элементах управления этого режима. Выберите из списка
стилей текстовый стиль Текст 7 мм (рис. 10.32) и наберите следующий
текст, нажимая Enter в конце каждой строки.
1. Ìàòåðèàë èçäåëèÿ – ËÄÑÏ s=18 ìì. Öâåò – áóê D381 SE

(KRONOSTAR).
2. Êðîìêà – ÏÂÕ, áóê 7200M (ROMA).
3. Ðó÷êè âðåçíûå 339-Pc, õðîì (REI). Ðó÷êè óñòàíàâëèâàòü,

ñîãëàñîâàâ ñ çàêàç÷èêîì.
4. Óñòàíîâêó îáîðóäîâàíèÿ çàêàç÷èêà, ïîêàçàííîãî íà âèäå

ñâåðõó, âûïîëíÿòü âî âðåìÿ ñáîðêè èçäåëèÿ.
6. Поскольку был выбран стиль с крупным шрифтом, введенный вами текст

не поместится в области, которая находится между чертежом и основ�
ной надписью. Давайте исправим ситуацию. Раскройте список размеров
шрифтов и выберите из него размер 35 мм. Вид чертежа улучшится, но
все же останется далеким от идеального (рис. 10.33).
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7. Откройте список стилей и выберите из него стиль Тест 3.5 мм. Высота
шрифта у этого стиля также составляет 35 мм, однако шрифт является
более плотным, поэтому весь текст поместится в отведенное для него
пространство.

8. Откройте список шрифтов, который находится справа от списка стилей,
и выберите из него шрифт Arial, а затем измените коэффициент уплот�
нения в правом нижнем углу окна Формат текста (Text Formatting), уста�
новив значение 0.8 (рис. 10.34).

Рис. 10.32  Выбор стиля в режиме редактирования многострочного текста

Рис. 10.33  При редактировании многострочного текста
можно изменить размер шрифта, не меняя стиль

Рис. 10.34  При редактировании многострочного текста
можно изменить размер гарнитуру шрифта и другие параметры, не меняя стиль

9. Щелкните на кнопке OK окна Формат текста (Text Formatting) (находит�
ся ближе к правой границе окна) или нажмите Ctrl+Enter.

10. Щелкните на многострочном текстовом объекте. Весь объект будет вы�
делен, а в углах прямоугольной текстовой области появятся маркеры вы�
деления. С помощью этих маркеров можно, в случае необходимости, из�
менять размеры текстовой области, а также перемещать ее по чертежу.

11. Отмените выделение, а затем щелкните дважды на текстовом объекте.
При двойном щелчке AutoCAD автоматически переходит в режим редак�
тирования многострочного текста, открывая уже знакомое вам окно Фор�
мат текста (Text Formatting). Аналогичного эффекта можно добиться,
выделив текстовый объект одинарным щелком, а затем выбрав из меню
команду Изменить ⇒ Объект ⇒ Текст ⇒ Редактировать (Modify ⇒
Object ⇒ Text ⇒ Edit) или щелкнув на кнопке Редактировать (Edit) пане�
ли инструментов Текст (Text). AutoCAD автоматически определит, что
был выделен многострочный объект и запустит вместо команды Äèàë-
ðåä (DDEDIT) команду Ìòåêñò (MTEDIT).

Примечание. Команду Ìòåêñò (MTEDIT) можно ввести и запустить из коман�
дного окна, но смысла в выполнении подобной операции нет, поскольку собствен�
ного псевдонима у команды Ìòåêñò (MTEDIT) нет, а ввести псевдоним ðåä
(ED) команды Äèàëðåä (DDEDIT) гораздо проще. AutoCAD корректно распозна�
ет тип текстового объекта и автоматически запустит нужную команду редак�
тирования.
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Поэкспериментируйте с редактированием многострочного текста (напри�
мер, выделите полужирным шрифтом и красным цветом ключевые данные тек�
стовой части), а затем измените масштаб по границам чертежа и сохраните
текущее состояние чертежа (рис. 10.35) в файле Work103.dwg.

Р азмеры – это очень важный элемент чертежа, без которого он, по сути
дела, превращается лишь в аккуратно выполненный рисунок. С другой
стороны, поскольку размер состоит из размерных и выносных линий,

размерной надписи, а также в некоторых случаях из дополнительных элемен�
тов, не удивительно, что создание размеров – это процесс достаточно сложный
и нетривиальный. Действительно, если учесть, что вся предыдущая глава была
посвящена описанию методов и инструментов работы с одними лишь текста�
ми, которые представляют в размерах размерные надписи, становится понят�
но, почему настройка и расстановка размеров нередко представляет для начи�
нающего пользователя AutoCAD достаточно серьезную проблему.

Тем не менее, суть этой проблемы в подавляющем большинстве случаев кро�
ется в том, что начинающие пользователи, пытаясь наносить размеры, часто
не подозревают о том, что эту операцию лучше всего выполнять после настрой�
ки размерных стилей. Назначение размерного стиля точно такое же, как и назна�
чение текстового стиля, – определить все параметры объектов, которые созда�
ются на основе этого стиля. Учитывая, что параметров у размерных объектов
гораздо больше, чем у текстовых, понятно, что использование размерных сти�
лей – это единственный способ сделать расстановку размеров достаточно про�
стой операцией.

11.1. Определение размерного стиля11.1. Определение размерного стиля11.1. Определение размерного стиля11.1. Определение размерного стиля11.1. Определение размерного стиля
По умолчанию в чертежах, созданных на основе шаблона acadiso.dwt, исполь�
зуется размерный стиль ISO�25. Параметры настройки этого стиля, мягко го�
воря, не очень хорошо подходят для отечественного пользователя AutoCAD,
поэтому мы не будем пытаться приспособить его для наших нужд, а сразу созда�
дим новый стиль.

Рис. 10.35  Чертеж с рамкой, текстовой частью и основной надписью

В следующей главе вы изучите методы и инструменты нанесения размеров в
AutoCAD, а также ознакомитесь с некоторыми особенностями работы с тексто�
выми объектами, поскольку такие объекты в AutoCAD являются элементами
обозначений размеров.
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1. Откройте чертеж Work103.dwg и сохраните его в новом файле с именем
Work111.dwg.

2. Измените масштаб просмотра таким образом, чтобы всю область черче�
ния занимало изображение вида сверху, включая свободное простран�
ство между видом сверху и рамкой формата.

3. Создайте новый слой Размеры (индекс цвета – 126) и назначьте его теку�
щим, а затем убедитесь в том, что включен режим автоматической при�
вязки Конточка (Endpoint).

4. Включите отображение панели инструментов Размер (Dimension) и рас�
положите ее в правом нижнем углу области черчения, не делая панель
стационарной, как показано на рис. 11.1.

Совет. Если вы забыли, как включить отображение панели инструментов и
(или) сделать ее плавающей, обратитесь к материалу главы 1.

6. В появившемся окне Диспетчер размерных линий (Dimension Style Ma�
nager) будет отображаться пример размеров, нанесенных в соответ�
ствии с единственным присутствующим в чертеже размерным стилем
ISO�25. Изображение, приведенное в этом окне, не стоит принимать за
истину в последней инстанции – оно дает лишь приблизительное пред�
ставление о стиле и не более того. Щелкните на кнопке Новый (New),
которая находится в правой части окна Диспетчер размерных линий
(Dimension Style Manager).

7. В строке Имя нового стиля (New Style Name) открывшегося окна Созда�
ние нового размерного стиля (Create New Dimension Style) (рис. 11.2)
введите вместо предложенного по умолчанию название нового стиля,
например ÅÑÊÄ. В списке На основе (Start With) содержится стиль, на
основе которого будет создан новый стиль. Поскольку по умолчанию
в этом списке присутствует лишь стиль ISO�25, особого выбора у вас не
будет. В списке Размеры (Use for) можно выбрать тип размеров, для ко�
торых будет определен новый стиль. Оставьте выбранное в этом списке
значение Все размеры (All dimensions).

Рис. 11.1  Окно AutoCAD с чертежом Work111.dwg
после изменения масштаба и включения отображения панели Размер (Dimension)

5. Выберите из меню команду Размеры ⇒ Размерные стили (Dimension ⇒
Dimension Style) или щелкните на кнопке  Размерные стили (Dimen�
sion Style) панели инструментов Размер (Dimension) либо введите в ко�
мандном окне команду Ðçìñòèëü (DIMSTYLE) или просто ðñò.

Рис. 11.2  Окно Создание нового размерного стиля
(Create New Dimension Style)

8. Щелкните на кнопке Далее (Continue) для закрытия окна Создание но�
вого размерного стиля (Create New Dimension Style) и переходу к окну
определения параметров нового стиля Новый размерный стиль: ЕСКД
(New Dimension Style: ЕСКД). Это окно будет открыто на вкладке Линии
(Lines), предназначенной для настройки параметров размерных и вы�
носных линий.

9. Установите параметры линий в соответствии с рис. 11.3: параметру Шаг
в базовых размерах (Baseline spacing) (определяет расстояние по умол�
чанию, которое используется между параллельными размерными линия�
ми, построенными от общей базы) присвойте значение 60; параметру
Удлинения за размерные (Extend beyond dim lines) (определяет рассто�
яние, на которое выносная линия должна выходить за концы стрелок) –
значение 10, а параметру Отступ от объекта (Offset from origin) (опреде�
ляет расстояние между точкой привязки выносной линии и ее нача�
лом) – значение 0.
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Примечание. Пусть вас не смущает изображение, которое появится в области
предварительного просмотра, – помните, что наш чертеж будет выводиться на
печать в масштабе 1:10. Поэтому все введенные вами значения для получения их
размера при печати нужно разделить на 10. Когда остальные параметры стиля
будут настроены, изображение в области предварительного просмотра также
примет вполне нормальный вид.

10. Перейдите на вкладку Символы и стрелки (Symbols and Arrows) и устано�
вите параметры стрелок в соответствии с рис. 11.4: параметру Размер
стрелки (Arrow size) присвойте значение 35; в группе Метки центра
(Center marks) выберите переключатель Линия (Line) и присвойте пара�
метру Размер (Size) значение 35.

11. Перейдите на вкладку Текст (Text) и установите параметры размерного
текста в соответствии с рис. 11.5: из списка Текстовый стиль (Text style)
выберите стиль Текст 3.5 мм; параметру Высота текста (Text height)
присвойте значение 35; параметру Отступ от размерной линии (Offset
from dim line) присвойте значение 10; в группе Ориентация текста (Text
alignment) выберите переключатель Согласно ISO (ISO standard).

Примечание. Как видно из рис. 11.5, после настройки основных параметров но�
вого стиля изображение в области предварительного просмотра приобрело вполне
корректный вид.

12. Перейдите на вкладку Размещение (Fit) и установите параметры распо�
ложения размерного текста и стрелок в соответствии с рис. 11.6: в группе

Рис. 11.3  Параметры линий для нового стиля ЕСКД Рис. 11.4  Параметры стрелок для нового стиля ЕСКД

Рис. 11.5  Параметры размерного текста для нового стиля ЕСКД
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Опции размещения (Fit options) выберите переключатель Текст (Text)
и установите флажок Подавить стрелки, если они не помещаются меж�
ду выносными (Suppress arrows if they don’t fit inside extension lines);
в группе Выравнивание текста (Text placement) выберите переключа�
тель Строить выноску (Over dimension line, with leader); в группе Под�
гонка элементов (Fine tuning) сбросьте флажок Размерная линия меж�
ду выносными (Draw dim line between ext lines).

щелкайте на обоих стилях, чтобы увидеть различия между ними в облас�
ти предварительного просмотра. Сравнив оба стиля, выберите стиль
ЕСКД и щелкните сначала на кнопке Установить (Set Current), а затем
на кнопке Закрыть (Close).

16. Запустите инструмент Текстовые стили (Text style) (например, введите
в командном окне команду ñò (ST)) и назначьте текущим текстовый стиль
Текст 3.5 мм, выбрав его из списка стилей и щелкнув на кнопке Закрыть
(Close).

Теперь созданный вами стиль ЕСКД является текущим, о чем можно судить по
значению, отображающемуся в списке стилей на панели инструментов Размер
(Dimension), и мы можем перейти к непосредственному нанесению размеров.

11.2. Создание линейных горизонтальных11.2. Создание линейных горизонтальных11.2. Создание линейных горизонтальных11.2. Создание линейных горизонтальных11.2. Создание линейных горизонтальных
и вертикальных размерови вертикальных размерови вертикальных размерови вертикальных размерови вертикальных размеров
Как известно, размеры могут быть линейными (linear dimension) и угловыми (an�
gular dimension). В свою очередь, линейные размеры в AutoCAD подразделяют�
ся на горизонтальные и вертикальные. По виду горизонтальные и вертикаль�
ные размеры ничем не отличаются, кроме расположения размерной надписи,
поэтому для создания и тех, и других используются одни и те же инструменты
AutoCAD.

Рис. 11.6  Параметры расположения размерного текста
и стрелок для нового стиля ЕСКД

13. Перейдите на вкладку Основные единицы (Primary Units) и установите
параметры точности представления размеров в соответствии с рис. 11.7:
в группах Линейные размеры (Linear dimensions) и Угловые размеры
(Angular dimensions), выберите из списка Точность (Precision) значение 0.

14. Поскольку параметры, представленные на вкладках Альт. единицы (Al�
ternate Units) и Допуски (Tolerance), нам не понадобятся (первые нужны
в тех случаях, когда на чертеже применяются размеры в двух системах
измерения, а вторые – в машиностроительных чертежах, на которых ука�
зываются предельные отклонения размеров), щелкните на кнопке OK
для закрытия окна Новый размерный стиль: ЕСКД (New Dimension
Style: ЕСКД).

15. Вы снова вернетесь к окну Диспетчер размерных линий (Dimension Style
Manager), в котором теперь появится новый стиль ЕСКД (рис. 11.8). По�

Рис. 11.7  Параметры точности представления размеров
для нового стиля ЕСКД
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Гораздо важнее то, что размеры (как линейные, так и угловые) могут нано�
ситься в виде размерной цепи или же от общей базы. Во многих случаях приме�
нение соответствующих инструментов AutoCAD позволяет существенно повы�
сить производительность, а также упростить чтение чертежа.

Давайте сначала нанесем горизонтальный и вертикальный размеры, пока�
зывающие габариты рабочей зоны, а затем рассмотрим инструменты, предназ�
наченные для создания размерных цепей и нанесения размеров от общей базы.

1. Запустите инструмент Линейный (Linear Dimension), щелкнув на кноп�
ке  Линейный (Linear) панели инструментов Размер (Dimension) или
выбрав из меню команду Размеры ⇒ Линейный (Dimension ⇒ Linear)
либо введя в командном окне Ðçìëèíåéíûé (DIMLINEAR) или просто
ðëè (DLI).

2. AutoCAD предложит в командном окне выбрать точку, в которой должна
начинаться выносная линия, или нажать Enter, чтобы выбрать объект,
для которого нужно создать линейный размер. В этот раз мы создадим
линейный размер по точкам, а при создании вертикального размера по�
смотрим, как можно выбрать сразу весь объект. Используя режим при�
вязки Конточка (Endpoint), выберите точку, которая находится в левом
верхнем углу чертежа рабочей зоны.

3. AutoCAD предложит выбрать вторую точку. Выберите точку, которая на�
ходится в правом верхнем углу чертежа.

4. AutoCAD создаст размер и предложит задать его расположение (рис. 11.9).
Проще всего в нашем случае задать расположение размера, просто вы�
брав соответствующую точку на чертеже. Как только вы щелкните в под�
ходящей точке, размер будет создан, а в командном окне будет продубли�

ровано содержимое размерной надписи, которое в данном случае долж�
но быть представлено числом 3000.

5. Снова запустите инструмент Линейный (Linear Dimension), но в этот
раз в ответ на приглашение AutoCAD выбрать первую точку или объект
нажмите Enter.

6. AutoCAD предложит выбрать объект, для которого нужно создать линей�
ный размер. Щелкните на вертикальной линии, которая представляет на
чертеже левую границу рабочей зоны (рис. 11.10).

Рис. 11.8  Окно Диспетчер размерных линий
(Dimension Style Manager) с новым стилем ЕСКД Рис. 11.9  Задание расположения горизонтального размера с помощью мыши

Рис. 11.10  Выбор объекта для создания его линейного размера
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7. AutoCAD создаст вертикальный размер и предложит задать его располо�
жение. Как и в предыдущем случае, выберите произвольную точку на чер�
теже и щелкните для фиксации размера в выбранном месте (рис. 11.11).

кнопке  Базовый (Baseline) панели инструментов Размер (Dimension)
или выберите из меню команду Размеры ⇒ Базовый (Dimension ⇒ Base�
line) либо введите в командном окне Ðçìáàçîâûé (DIMBASELINE) или
просто ðáà (DBA).

Рис. 11.11  Вертикальный и горизонтальный размеры

8. Теперь давайте создадим размерную цепь. Однако сначала нужно создать
первый размер, который затем будет продолжен в виде размерной цепи.
Для этого лучше всего подходит угловой стол, находящийся на чертеже
рабочей зоны справа. Создайте линейный размер, показывающий длину
этого стола в соответствии с рис. 11.12.

9. Запустите инструмент Продолжить (Continue Dimension), щелкнув для
этого на кнопке  Продолжить (Continue) панели инструментов Раз�
мер (Dimension) или выбрав из меню команду Размеры ⇒ Продолжить
(Dimension ⇒ Continue) либо введя в командном окне команду Ðçìïðî-
äîëæ или Ðçìöåïü (DIMCONTINUE) или просто ðöï (DCO).

10. AutoCAD тут же автоматически создаст следующий горизонтальный раз�
мер, используя в качестве первой выносной линии вторую выносную ли�
нию предыдущего размера, и предложит выбрать точку начала второй
выносной линии создаваемого размера. Выберите начальную точку вто�
рой вертикальной линии контура парты (рис. 11.13).

11. AutoCAD создаст размер 764 мм и тут же предложит задать расположение
второй выносной линии следующего размера текущей размерной цепи.
Выберите точку, в которой линейный участок столешницы переходит
в угловую часть (рис. 11.14), а затем нажмите два раза Enter для заверше�
ния команды Ðçìïðîäîëæ (DIMCONTINUE).

12. Для создания размеров, откладываемых от общей базы, используется ин�
струмент Базовый (Baseline Dimension). Для его запуска щелкните на

Рис. 11.12  Задание расположения горизонтального размера,
показывающего длину углового стола

Рис. 11.13  Задание расположения второго горизонтального размера,
образующего размерную цепь
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13. Поскольку последний размер был построен от размера 764 мм, AutoCAD
предложит создать новый размер, используя в качестве базовой вторую
выносную линию размера 764 мм. Нас в данном случае это не устраивает,
поэтому нажмите Enter, чтобы перейти в режим выбора базовой линии.

14. AutoCAD предложит выбрать выносную линию любого имеющегося на
чертеже размера, которая будет использоваться в качестве базовой.
Щелкните на правой выносной линии размера 3000 мм (рис. 11.15).

15. AutoCAD создаст горизонтальный размер от выбранной вами выносной
линии и предложит задать начальную точку второй выносной линии. Вы�
берите точку, которая находится в левом верхнем углу консольной полки
(рис. 11.16).

16. AutoCAD создаст размер 1112 мм и предложит задать точку для создания
следующего размера от текущей базы. Нажмите Enter для переключения
в режим изменения базы и выберите левую выносную линию размера
3000 мм. Затем создайте размер для верхней полки рабочего места стар�
шеклассника, после чего нажмите Enter два раза, чтобы завершить рабо�
ту команды Ðçìáàçîâûé (DIMBASELINE). Чертеж должен иметь вид,
представленный на рис. 11.17.

Примечание. Изменение базовой линии по ходу работы команды используется не
только при построении размеров от общей базы, но и при создании размерных
цепей – нажав Enter после запуска команды Ðçìïðîäîëæ (DIMCONTINUE) или
после создания очередного размера цепи, вы всегда можете выбрать другую вынос�
ную линию, чтобы создать размерную цепь, отличную от текущей.

17. Вы, наверное, обратили внимание на то, что взаимное расположение
размерных линий при построении размеров от общей базы изменить во

время создания размеров нельзя – оно определяется значением парамет�
ра Шаг в базовых размерах (Baseline spacing) на вкладке Линии (Lines)
окна Новый размерный стиль (New Dimension Style) (см. рис. 11.3).
Однако поскольку полученные размеры выглядят некорректно (их вы�
носные линии пересекают размерную линию размера 3000 мм), нужно
изменить их расположение, созданное AutoCAD с использованием пара�
метров стиля, принятых по умолчанию. Щелкните на размерах 1184 и
1112 мм для их выделения.

Рис. 11.14  Задание расположения третьего горизонтального размера,
образующего размерную цепь

Рис. 11.15  Выбор базовой линии для построения размеров от общей базы

Рис. 11.16  Выбор точки для построения горизонтального размера от общей базы
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18. Щелкните на любом расположенном возле стрелки маркере выделения
одного из двух выделенных размеров. AutoCAD переключится в режим
редактирования объекта с помощью маркера. Перетащите размер вниз
с помощью выделенного маркера. Затем щелкните на аналогичном мар�
кере второго размера и также перетащите его вниз, используя режим от�
слеживания объектной привязки для выравнивания высоты расположе�
ния второго размера по первому размеру (рис. 11.18). Нажмите Esc для
выхода отмены выделения.

Совет. Перетаскивая маркеры, которые находятся в начальных точках вынос�
ных линий, можно изменить не только расположение размера, но и текст размер�
ного числа, который после операции изменения расположения размерной линии
будет отображать размер соответствующего объекта.

В некоторых случаях AutoCAD не может самостоятельно определить, какой
размер (вертикальный или горизонтальный) нужно создать. Давайте, напри�
мер, попробуем создать на чертеже размер, который показывал бы ширину
прямолинейного участка столешницы.

1. Запустите инструмент Линейный (Linear Dimension) (например, введи�
те в командном окне ðëè (DLI)) и в ответ на предложение AutoCAD за�
дать начальную точку первой выносной линии выберите точку, которая
находится в правом верхнем углу чертежа.

2. Когда AutoCAD предложит выбрать начальную точку второй выносной
линии, выберите точку, которая находится в том месте, где столешница
переходит в закругленный угловой стол (рис. 11.19).

3. AutoCAD создаст размер, но его расположение (вертикальное или гори�
зонтальное) будет зависеть от текущего расположения указателя�пере�

крестия. Поперемещайте указатель вокруг выбранной вами второй точ�
ки и убедитесь в том, что это действительно так. В данном случае нетруд�
но найти такое расположение указателя�перекрестия, при котором
AutoCAD переключится в режим создания именно вертикального разме�
ра. Однако в других ситуациях, когда на чертеже в области расположе�
ния создаваемого размера находится много различных объектов, выбор

Рис. 11.17  Два горизонтальных размера,
построенных от общей базы с размером 3000 мм

Рис. 11.18  Перемещение размера вниз с помощью маркеров выделения
и отслеживания объектной привязки

Рис. 11.19  Выбор начальной точки второй выносной линии

Создание линейных горизонтальных и вертикальных размеровСоздание линейных горизонтальных и вертикальных размеровСоздание линейных горизонтальных и вертикальных размеровСоздание линейных горизонтальных и вертикальных размеровСоздание линейных горизонтальных и вертикальных размеров



Расстановка размеровРасстановка размеровРасстановка размеровРасстановка размеровРасстановка размеров374 375

ориентации размера с помощью указателя�перекрестия может быть зат�
руднен.

4. Обратите внимание на режимы, отображаемые в командном окне:
Ïðîäîëæåíèå ðàçìåðíîé ëèíèè èëè [Ìòåêñò/Òåêñò/Óãîë/Ãîðè-
çîíòàëüíûé/Âåðòèêàëüíûé/Ïîâåðíóòûé]:
(Specify dimension line location or [Mtext/Text/Angle/Horizontal/
Vertical/Rotated]:)
Эти режимы используются для того, чтобы создавать и изменять линей�
ные размеры в тех случаях, когда размеры, создаваемые AutoCAD автома�
тически, не устраивают пользователя. В частности, в рассматриваемом
примере нам нужно задать вертикальную ориентацию размера. Введите
в командном окне Âåðòèêàëüíûé (VERTICAL) или просто â (V).

5. AutoCAD создаст вертикальный размер, ориентация которого теперь не
будет зависеть от расположения указателя�перекрестия – вам останется
лишь указать место расположения размера (рис. 11.20).

11.3. Создание угловых и других размеров11.3. Создание угловых и других размеров11.3. Создание угловых и других размеров11.3. Создание угловых и других размеров11.3. Создание угловых и других размеров
Понятно, что одних лишь линейных размеров недостаточно для получения
полного представления об изделии. Даже в случае такого простого объекта, как
рабочая зона, необходимо использовать угловые размеры, а также радиусы и
диаметры.

1. Запустите инструмент Угловой (Angular Dimension), щелкнув на кнопке
 Угловой (Angular) панели инструментов Размер (Dimension) или

выбрав из меню команду Размеры ⇒ Угловой (Dimension ⇒ Angular)
либо введя в командном окне команду ðçìóãëîâîé (DIMANGULAR) или
просто ðóã (DAN).

2. В ответ на предложение AutoCAD выбрать объект, для которого нужно
показать угловой размер, щелкните на линии, соединяющей два сопря�
жения в угловой части рабочей зоны (рис. 11.22).

3. AutoCAD предложит выбрать вторую линию. Выберите горизонтальную ли�
нию, представляющую нижнюю границу контура прямолинейной части сто�
лешницы. AutoCAD создаст угловой размер, вид и размерное число которо�
го будет зависеть от расположения указателя�перекрестия (рис. 11.23).
Выберите оптимальное размещение размера и щелкните для его создания.

4. Для создания радиуса следует воспользоваться инструментом Радиус
(Radius Dimension). Щелкните на кнопке  Радиус (Radius) панели ин�
струментов Размер (Dimension) или выберите из меню команду Разме�
ры ⇒ Радиус (Dimension ⇒ Radius) либо введите в командном окне
Ðçìðàäèóñ (DIMRADIUS) или просто ððà (DRA).

Рис. 11.20  Размер,
созданный с использованием режима Âåðòèêàëüíûé (VERTICAL)

Совет. Подобные режимы имеются и у других команд создания размеров, поэтому
в затруднительных ситуациях обращайте внимание на командную строку – в
подавляющем большинстве случаев гораздо проще уточнить, какой именно режим
создания размера вам нужен, чем пытаться «поймать» корректное расположе�
ние размера с помощью мыши.

Попрактикуйтесь в создании линейных размеров, чтобы получить чертеж,
подобный приведенному на рис. 11.21.

Рис. 11.21  Различные вертикальные и горизонтальные линейные размеры
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5. В ответ на приглашение AutoCAD выбрать дугу или окружность щелкни�
те на сопряженном участке угловой части столешницы, как показано на
рис. 11.24.

6. Выберите место расположения радиуса и щелкните для создания соот�
ветствующего размера.

7. Подобным образом создаются и обозначения диаметров. Щелкните на
кнопке  Диаметр (Diameter) панели инструментов Размер (Dimension)

или выберите из меню команду Размеры ⇒ Диаметр (Dimension ⇒ Diame�
ter) либо введите в командном окне команду Ðçìäèàìåòð (DIMDIAMETER)
или просто ðäè (DDI).

8. AutoCAD предложит выбрать дугу или окружность. Щелкните на окруж�
ности, которая представляет на чертеже наружный контур монтажного
кольца основной опоры, а затем задайте оптимальное расположение со�
зданного обозначения диаметра (рис. 11.25).

Совет. Для того чтобы изменить расположение размерного числа, можно исполь�
зовать перетаскивание маркера этого числа, который появляется после щелчка
на размерном объекте.

Таким образом, создание угловых размеров, а также радиусов и диаметров –
задача, в общем�то, несложная. Попрактикуйтесь в выполнении соответствую�
щих операций, руководствуясь рис. 11.26.

Однако в AutoCAD имеется еще один тип размерных объектов, который
можно назвать «свободным». Объекты этого типа (так называемые выносные
надписи, или выноски) создаются с помощью инструмента Быстрая выноска
(Quick Leader). В нашем случае этот инструмент удобно применить для созда�
ния стрелок, обозначающих направление взгляда для линий сечения разрезов,
нанесенных на главном виде.

1. Измените масштаб просмотра по границам чертежа. Разморозьте слой
Штриховка 1495 и назначьте его текущим, а затем измените масштаб
просмотра так, чтобы хорошо видеть правый штрих и букву A, обознача�
ющие на главном виде линию сечения разреза A–A.

2. Щелкните на кнопке  Быстрая выноска (Quick Leader) панели инст�
рументов Размер (Dimension) или выберите из меню команду Размеры ⇒

Рис. 11.22  Выбор первой линии углового размера

Рис. 11.23  Выбор расположения углового размера

Рис. 11.24  Выбор объекта для нанесения размера радиуса
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Выноска (Dimension ⇒ Leader) либо введите в командном окне Áâûíîñ-
êà (QLEADER) или просто áâû (LE).

3. AutoCAD предложит задать начальную точку выноски или нажать Enter
для изменения параметров выносной надписи, используемых по умолча�
нию. Поскольку по умолчанию AutoCAD создает выноски, расположен�
ные под углом к заданной точке, причем с горизонтальной полочкой для

надписи, вам следует нажать Enter, чтобы настроить параметры инстру�
мента Быстрая выноска (Quick Leader).

4. После нажатия Enter на экране появится диалоговое окно Параметры
выноски (Leader Settings). Установите параметры вкладки Пояснение
(Annotations) этого окна в соответствии с рис. 11.27.

Рис. 11.25  На чертеже показан диаметр монтажного кольца основной опоры

Рис. 11.26  Чертеж с нанесенными радиусами, диаметрами и угловыми размерами

Рис. 11.27  Параметры вкладки Пояснение (Annotations)
диалогового окна Параметры выноски (Leader Settings)

5. Перейдите на вкладку Выноска и стрелка (Leader Line & Arrow) и на�
стройте содержащиеся на ней параметры в соответствии с рис. 11.28,
а затем закройте диалоговое окно Параметры выноски (Leader Settings)
щелчком на кнопке OK.

Рис. 11.28  Параметры вкладки Выноска и стрелка (Leader Line & Arrow)
диалогового окна Параметры выноски (Leader Settings)
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6. После закрытия окна AutoCAD продолжит работу команды Áâûíîñêà
(QLEADER), снова предлагая вам выбрать начальную точку выносной
линии или изменить параметры настройки. Включите режим времен�
ной привязки Середина (Midpoint) и выберите середину штриха линии
сечения.

7. AutoCAD предложит задать вторую точку. Включите режим ОРТО
(ORTHO) и, задав вертикальное расположение стрелки (рис. 11.29), вве�
дите 135.

11.4. Изменение размеров, размерных надписей11.4. Изменение размеров, размерных надписей11.4. Изменение размеров, размерных надписей11.4. Изменение размеров, размерных надписей11.4. Изменение размеров, размерных надписей
и размерных стилейи размерных стилейи размерных стилейи размерных стилейи размерных стилей
Некоторые размеры на нашем чертеже лишние – необходимые значения мож�
но рассчитать, используя другие размеры. Однако, с другой стороны, такие раз�
меры нередко применяются на практике, чтобы избавить специалистов, кото�

Рис. 11.29  Создание стрелки с помощью инструмента
Быстрая выноска (Quick Leader)

Создайте стрелки на всех остальных слоях, содержащих обозначение линий
сечения разрезов Б–Б, В–В и т. д. Например, чертеж с разрезом Г–Г теперь
будет иметь вид, представленный на рис. 11.30.

Верните чертеж к исходному виду (разморожены только слои Вид сверху,
Вид спереди, Основная надпись, Размеры и Текст, слой Размеры является
текущим), включите, если нужно, отображение панели инструментов Размер
(Dimension) и измените масштаб просмотра так, чтобы хорошо главный вид
рабочей зоны занимал всю область черчения. Нанесите основные вертикаль�
ные размеры на главном виде рабочей зоны, например, как показано на рис.
11.31, а затем сохраните текущее состояние чертежа в файле Work111.dwg.

 Измените масштаб просмотра по границам чертежа и сохраните чертеж
в таком виде в файле Work112.dwg. В завершении этой главы мы поговорим об
инструментах, предназначенных для редактирования размеров, поскольку
в некоторых случаях элементы размеров, создаваемые AutoCAD автоматиче�
ски, могут не устраивать вас по тем или иным причинам.

Рис. 11.30  Пример разреза, окончательно оформленного с помощью инструмента
Быстрая выноска (Quick Leader) в соответствии с требованиями стандартов

Рис. 11.31  Основные вертикальные размеры на виде спереди
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рые будут работать с чертежом, от необходимости выполнять дополнительные
расчеты. В подобных ситуациях такие избыточные размеры считаются спра�
вочными и должны соответствующим образом обозначаться на чертеже.

1. Измените масштаб просмотра так, чтобы всю область черчения занимал
фрагмент чертежа вида сверху, на котором находятся два размера 352 мм,
образующих замкнутую размерную цепь.

2. Запустите инструмент Редактировать (Edit) (например, введите в ко�
мандном окне ðåä (ED)) и в ответ на приглашение AutoCAD щелкните на
одном из двух размеров.

3. AutoCAD перейдет в режим редактирования многострочного текста за�
мените значение 352 значением 352 *, как показано на рис. 11.32.

ный текст вместо реального значения размера. В некоторых случаях это
бывает необходимо, однако в нашей ситуации нам нужно не заменить
размерное число, а дополнить его. Поэтому в качестве значения пара�
метра Текстовая строка (Text override) введите <> * (рис. 11.33). Текст
размерной надписи редактируемого размера также изменится.

Рис. 11.32  Редактирование размерной надписи
как многострочного текстового объекта

4. Щелкните на кнопке OK панели Формат текста (Text Formatting), а за�
тем нажмите Enter для выхода из режима редактирования текста.

5. Теперь щелкните на втором размере для его выделения, а затем открой�
те палитру Свойства (Properties), выбрав из контекстного меню команду
Свойства (Properties) или щелкнув на кнопке Свойства (Properties) пане�
ли инструментов Standard (можно также ввести îêíîñâ в командном
окне).

6. Найдите в палитре Свойства (Properties) раздел Текст (Text), а в нем –
параметр Текстовая строка (Text override). По умолчанию его значение
равно <>. Эта пара символов представляет собой шаблон, значением ко�
торого является текущее значение размера. Если заменить эту пару сим�
волом произвольным текстом, AutoCAD всегда будет отображать указан�

Рис. 11.33  Редактирование размерной надписи
с помощью палитры Свойства (Properties)

7. Закройте палитру Свойства (Properties), отмените выделение нажатием
Esc и восстановите предыдущий масштаб просмотра, а затем перемести�
те чертеж так, чтобы всю область черчения занимал главный вид.

8. Отредактируйте размерные надписи вертикальных размеров 1276, 344 и
432 мм на главном виде, добавив к размерным числам символ звездочки.
Для редактирования можете использовать любой из описанных выше
методов.

9. Создайте под главным видом текстовый объект * Размеры для справок
(рис. 11.34).

10. Снова запустите команду Äèàëðåä (DDEDIT), выбрав в ответ на предло�
жение AutoCAD вертикальный размер 70 мм, обозначающий расстояние
между нижней поверхностью столешницы и верхней поверхностью под�
ставки под клавиатуру.

11. После того, как AutoCAD перейдет в режим редактирования текста, не
удаляя имеющегося размерного числа, щелкните на кнопке  Символ
(Symbol) панели инструментов Формат текста (Text Formatting).

12. Выберите из открывшегося списка элемент Плюс/Минус (Plus/Minus).
Список закроется, а в строке появится соответствующий символ. Добавь�
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те к нему значение 15 и щелкните на кнопке OK для закрытия панели
Формат текста (Text Formatting) и завершения редактирования.

13. Нажмите Enter для завершения команды Äèàëðåä (DDEDIT). Теперь вы�
сота размещения клавиатуры указана с величиной предельного отклоне�
ния 15 мм (рис. 11.35).

Если вы все еще испытываете затруднения с перемещением размеров, изме�
ните масштаб изображения так, как показано на рис. 11.35 и щелкните на раз�

мере 70 мм. Перемещая маркеры выделения, которые обозначают начальные
точки выносных линий, вы тем самым можете изменить размер, в том случае
он после такого перемещения будет отображать расстояние, отличное от ис�
ходного (рис. 11.36).

Рис. 11.34  Справочные размеры, обозначенные на главном виде

Рис. 11.35  Размер, указанный с предельными отклонениями

Рис. 11.36  Перемещение маркеров выделения,
находящихся в начальных точках выносных линий, приводит к изменению размера

Если же перемещать маркер выделения, который находится возле размер�
ной надписи, это приводит к автоматическому переносу размерной надписи
в другое место чертежа, тогда как сам размер (выносные и размерные линии)
останется неизменным (рис. 11.37). При этом AutoCAD автоматически добав�
ляет или удаляет полочку с выносной линией, связывающую размерную над�
пись с размерной линией, если в этом есть необходимость, а также выбирает
наиболее подходящую ориентацию размера.

 Кроме того, AutoCAD позволяет переопределять (override) размерный стиль
выделенного размерного объекта. Давайте, например, проделаем подобную
операцию для размера 70 мм, включив для него отображение стрелок.

1. Запустите инструмент Размерные стили (Dimension Style), щелкнув на
соответствующей кнопке панели инструментов Размер (Dimension) или
введя в командном окне ðñò (D).

2. В открывшемся окне Диспетчер размерных линий (Dimension Style
Manager) убедитесь в том, что выбран стиль ЕСКД и щелкните на кнопке
Переопределить (Override).

3. На экране появится диалоговое окно Переопределение текущего сти�
ля: ЕСКД (Override Current Style: ЕСКД), которое ничем не отличается
от окна создания нового стиля. Перейдите в этом окне на вкладку Разме�
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щение (Fit) и в группе Опции размещения (Fit options) сбросьте флажок
Подавить стрелки, если они не помещаются между выносными (Sup�
press arrows if they don’t fit inside extension lines) (рис. 11.38).

4. Щелкните на кнопке OK для закрытия диалогового окна Переопределе�
ние текущего стиля: ЕСКД (Override Current Style: ЕСКД).

5. Вернувшись в окно Диспетчер размерных линий (Dimension Style Mana�
ger), вы увидите, что под стилем ЕСКД в списке стилей появился допол�
нительный элемент <переопределения> (<style overrides>) (рис. 11.39).
В области Пояснения (Description) приведено краткое описание стиля
с указанием того, чем перекрытый стиль отличается от исходного.

Рис. 11.37  Перемещение маркера выделения, находящегося возле размерной надписи,
приводит к изменению расположения и ориентации этой надписи

Рис. 11.38  Вкладка Размещение (Fit) диалогового окна Переопределение текущего
стиля (Override Current Style) для стиля ЕСКД с измененным параметром

Рис. 11.39  В списке стилей диалогового окна Диспетчер размерных линий
(Dimension Style Manager) появился перекрытый стиль

6. Щелкните на кнопке Закрыть (Close) для закрытия диалогового окна
Диспетчер размерных линий (Dimension Style Manager). Вид чертежа
не изменился, поскольку изменения перекрытого стиля распространя�
ются только на объекты, которые будут созданы после создания такого
стиля.

7. Щелкните на кнопке  Обновить размер (Dimension Update) панели
инструментов Размер (Dimension) или выберите из меню команду Раз�
меры ⇒ Обновить (Dimension ⇒ Update) либо введите в командном
окне команду �Ðçìñòèëü (–DIMSTYLE) APPLY.

Примечание. Знак «минус», указанный перед командой Ðçìñòèëü (–DIMSTYLE) –
это не ошибка. Многие команды в AutoCAD имеют «двойников», для запуска ко�
торых нужно перед командой указать знак «минус». Примерами таких команд
являются, в частности, команды Ìàññèâ (ARRAY) и �Ìàññèâ (–ARRAY),
Áëîê (BLOCK) и –Áëîê (–BLOCK) и ряд других. Как правило, «минусовая» ко�
манда выполняет те же операции, что и ее обычный вариант, но без использова�
ния диалоговых окон, а путем ввода параметров и задания режимов в командном

Изменение размеров, размерных надписей и размерных стилейИзменение размеров, размерных надписей и размерных стилейИзменение размеров, размерных надписей и размерных стилейИзменение размеров, размерных надписей и размерных стилейИзменение размеров, размерных надписей и размерных стилей



Расстановка размеровРасстановка размеровРасстановка размеровРасстановка размеровРасстановка размеров388 389

окне. В случае с инструментом Обновить размер (Dimension Update) его эквива�
лентом командного окна является режим APPLY, или просто A, «минусового»
варианта команды Ðçìñòèëü (–DIMSTYLE).

8. AutoCAD предложит выбрать объект, стиль которого нужно обновить.
Щелкните на размере 70 мм и нажмите Enter для завершения выбора. На
чертеже появятся стрелки, в соответствии с параметрами перекрытого
стиля ЕСКД (рис. 11.40).

Кроме того, удалить сразу все перекрытые стили можно, воспользовавшись ко�
мандной меню Размеры ⇒ Переопределить (Dimension ⇒ Override) либо коман�
дой в командном окне Ðçìïîäàâèòü (DIMOVERRIDE) или ее псевдонимом ðïî
(DOV) (на панели инструментов Размер (Dimension) соответствующей кнопки
нет). Стоит лишь нажать Enter в ответ на запрос AutoCAD, который появляет�
ся в командном окне после запуска этой команды, и все перекрытые стили будут
удалены.

Стили можно не только перекрывать, но и создавать семейства стилей. Для
этого нужно, выбрав базовый стиль в диалоговом окне Диспетчер размерных
линий (Dimension Style Manager) (в нашем случае – ЕСКД), щелкнуть на кнопке
Новый (New) этого диалогового окна. В открывшемся окне Создание нового
размерного стиля (Create New Dimension Style) следует выбрать из списка Раз�
меры (User for) (см. рис. 11.2) нужный тип элементов стиля. В этом случае стро�
ка Имя нового стиля (New Style Name) окна станет недоступной, поскольку
в ней будет отображаться имя базового стиля и тип выбранного элемента сти�
ля, как, например, показано на рис. 11.41.

Рис. 11.40  Размерный объект обновлен
в соответствии с параметрами перекрытого стиля

9. Снова откройте диалоговое окно Диспетчер размерных линий
(Dimension Style Manager), щелкните на стиле ЕСКД, чтобы выделить
его, а затем щелкните на кнопке Установить (Set Current).

10. В появившемся окне AutoCAD отобразит предупреждение о том, что на�
значение исходного стиля текущим приведет к удалению перекрытых
параметров. Щелкните на кнопке OK для подтверждения удаления пе�
рекрытого стиля, а затем закройте диалоговое окно Диспетчер раз�
мерных линий (Dimension Style Manager) щелчком на кнопке Закрыть
(Close).

Совет. Если вы решили не удалять перекрытый стиль, а наоборот, использовать
его в качестве основного, выделите в окне Диспетчер размерных линий (Dimen�
sion Style Manager) элемент <переопределения> (<style overrides>) и щелкните на
нем правой кнопкой мыши. Выбрав из появившегося контекстного меню команду
Сохранить в текущем стиле (Save to Current Style), вы тем самым замените ис�
ходный стиль перекрытым стилем.

Рис. 11.41  Создание нового стиля для линейных элементов,
который будет входить в семейство стилей ЕСКД

Дальнейшая логика определения и применения нового стиля выбранного
семейства ничем не отличается от логики определения и применения пере�
крытых стилей. Разница состоит лишь в том, что семейства стилей можно со�
здавать по отдельности для разных типов элементов, тогда как перекрытие
стиля может осуществляться сразу по всем параметрам базового стиля.

При назначении базового стиля текущим стили его семейства не удаляются,
как перекрытые стили. Для удаления дочернего стиля, входящего в семейство
базового стиля, нужно выделить подлежащий удалению дочерний стиль, щелк�
нуть на нем правой кнопкой мыши и выбрать из контекстного меню команду
Delete. Однако, в отличие от перекрытых стилей, если дочерний стиль исполь�
зуется в чертеже, удалить его не удастся до тех пор, пока вы не внесете соответ�
ствующие изменения в объекты, основанные на этом стиле.

На этом мы завершаем разговор о размерах. Закройте панель Размер (Di�
mension), масштабируйте изображение по размерам чертежа и сохраните теку�
щее состояние чертежа (рис. 11.42) в файле Work112.dwg.
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Прежде чем приступить к изучению инструментов и методов вывода черте�
жей на печать, которым посвящены две последние главы книги, мы рассмот�
рим в следующей главе еще одно удобное средство AutoCAD, которое уже упо�
миналось в предыдущих главах, – внешние ссылки. Используя внешние ссылки,
можно быстро создавать чертежи сложных объектов, а также организовать
групповую работу над большим проектом.

В предыдущих главах книги вы уже встречались с упоминанием внешних
ссылок (External References или просто X�ref). В чем�то внешние ссылки
подобны блокам, сохраненным в отдельных файлах. Действительно,

внешние ссылки – это обычные dwg�файлы, связанные с другим чертежом
с целью предоставления дополнительной информации пользователям, кото�
рые работают с этим чертежом. Визуально чертеж, представленный в виде
внешней ссылки, воспринимается как часть главного чертежа. Иными слова�
ми, слоями, цветами и типами линий, а также их видимостью можно управлять
точно так же, как и аналогичными свойствами объектов главного чертежа. Од�
нако если пользователь попытается изменить объекты внешней ссылки, ему
это не удастся, поскольку внешняя ссылка, в отличие от экземпляра блока, не
является частью основного чертежа.

Проще говоря, хотя внешние ссылки подобны блокам в том, что они ведут
себя как единые объекты и вставляются в чертеж с использованием подобных
процедур, тем не менее, внешние ссылки не являются частью чертежа, в кото�
рый они вставлены, тогда как экземпляры блоков всегда принадлежат такому
чертежу.

Именно поэтому объекты чертежа, представленные внешними ссылками,
в отличие от объектов, которые являются экземплярами блоков (то есть блоч�
ными ссылками), нельзя разгруппировать. Как вы помните, в конце главы 7 мы
разгруппировали блочную ссылку окна, изменили определение этого блока и
вновь объединили элементы модифицированного объекта в блок. В результате
на чертеже тут же обновились все экземпляры этого блока. Однако, хотя вне�
шние ссылки разгруппировать нельзя, в целом метод внесения изменений
в соответствующие объекты подобен тому, который применяется для блоков.
Для того чтобы освоить нюансы, характерные для внешних ссылок, вам нужно

Рис. 11.42  Чертеж практически готов к печати
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научиться их создавать, управлять их размещением в главном чертеже и об�
новлять их.

12.1. Создание многофайлового чертежа на основе12.1. Создание многофайлового чертежа на основе12.1. Создание многофайлового чертежа на основе12.1. Создание многофайлового чертежа на основе12.1. Создание многофайлового чертежа на основе
внешних ссылоквнешних ссылоквнешних ссылоквнешних ссылоквнешних ссылок
Мы начнем с того, что создадим главный чертеж, в качестве которого будет
применяться чертеж детской, созданный в главе 7. Затем мы вставим чертеж
рабочей зоны в главный чертеж в виде внешней ссылки.

1. Откройте файл Work071.dwg и сохраните его под именем ChRoom121.dwg.
2. Разморозьте и назначьте текущим слой 0, а все остальные слои заморозьте.
3. Выделите все объекты слоя с помощью команды меню Правка ⇒ Вы�

брать все (Edit ⇒ Select All) либо нажатия Ctrl+A или любым другим спо�
собом, а затем удалите все выделенные объекты.

4. Повторите пп. 2 и 3 для слоев Вид сверху, Высота 1495, Высота 1090,
Высота 758, Высота 720, Высота 320, Высота 18, СБлок Н и СБлок П.

5. Назначьте текущим слой Детская, а все слои, перечисленные в п. 4, уда�
лите.

6. Заморозьте слой 0, а все слои Балкон, Окна и Двери разморозьте.
7. Измените масштаб изображения по границам объектов чертежа (рис. 12.1).

наты точки вставки. Кроме того, так же, как и при вставке блоков, в процессе
вставки внешней ссылки можно скорректировать значения масштабных коэф�
фициентов по осям X и Y, равно как и угол поворота (если такая коррекция не
нужна, можно принять значения, установленные по умолчанию).

Все операции над внешними ссылками выполняются с помощью палитры
Внешние ссылки (External References). Для открытия этой панели можно вы�
брать из меню команду Слияние ⇒ Внешние ссылки (Insert ⇒ External Referen�
ces) или щелкнуть на кнопке  Внешние ссылки (External References) панели
инструментов Ссылка (Reference). Можно также ввести в командном окне ко�
манду Ññûëêè (XREF) или просто ññ (XR) либо Âíåøíèåññûëêè (EXTERNAL�
REFERENCES) или просто âí (ER).

Совет. Команда Ññûëêè (XREF) досталась AutoCAD 2007 в наследство от пре�
дыдущих версий, где команды Ññûëêè (XREF) и Âíåøíèåññûëêè (EXTERNAL�
REFERENCES) были разными. Основное отличие этих двух команд состоит
в том, что команда Ññûëêè (XREF) (и ее псевдоним ññ (XR)) имеет «минусо�
вый» эквивалент –Ññûëêè (XREF), а команда Âíåøíèåññûëêè (EXTERNAL�
REFERENCES) – нет. В остальном же эти две команды работают одинаково.

Что касается панели Ссылка (Reference), то автор не советует ее использо�
вать при изучении материала данной главы. Во�первых, потому, что остальные
кнопки этой панели предназначены, в основном, для вставки в чертеж растро�
вых изображений, а в данной книге эта достаточно узкая тема не рассматрива�
ется. Во�вторых, на панели Ссылка (Reference) отсутствуют другие инстру�
менты, предназначенные для работы с внешними ссылками, рассмотренные
в данной главе. Поскольку держать открытой панель из�за одной кнопки не со�
всем разумно, автор рекомендует вам закрыть панель Ссылка (Reference).

1. Создайте в главном чертеже новый слой Рабочая зона с индексом цвета
7 (белый (white)) и назначьте этот слой текущим.

2. Откройте чертеж, который хранится в файле Work111.dwg и сохраните
его под именем Work121.dwg

3. Разморозьте слой 0 файла Work121.dwg и назначьте его текущим, а ос�
тальные слои заморозьте.

4. Удалите все объекты, которые находятся на слое 0 (если нужно, измени�
те масштаб по границам чертежа), после чего разморозьте слой Вид
сверху и назначьте его текущим, а слой 0 заморозьте. Разморозьте также
слои Вид спереди, Основная надпись и Текст, а затем измените масш�
таб по границам чертежа.

5. Сохраните текущее состояние файла Work121.dwg и закройте его.
6. Откройте палитру Внешние ссылки (External References), например,

введя в командном окне ññ (XR) или âí (ER).
7. Щелкните на кнопке  Присоединить DWG (Attach DWG), которая на�

ходится в верхней части палитры Внешние ссылки (External References).
8. С помощью открывшегося окна Выбор файла внешней ссылки (Select

Reference File) найдите на диске файл Work121.dwg и, выбрав его, щелк�
ните на кнопке Открыть (Open).

Рис. 12.1  Главный чертеж, представляющий собой план детской комнаты,
готов для вставки внешней ссылки

Как уже отмечалось выше, в целом процедура вставки в чертеж внешней
ссылки подобна процедуре вставки одного чертежа в другой, которая рассмат�
ривалась в конце главы 7. В ходе такой вставки нужно выбрать чертеж, на кото�
рый в главном чертеже будет создана внешняя ссылка, а затем указать коорди�
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9. В появившемся окне Внешняя ссылка (External Reference), представлен�
ном на рис. 12.2, будет содержаться информация, описывающая встав�
ляемый в качестве внешней ссылки чертеж. В частности, параметры,
которые находятся в нижней части этого окна, вам уже должны быть зна�
комы – с аналогичными параметрами вы сталкивались при вставке в чер�
теж экземпляра блока. Если значения параметров групп Точка вставки
(Insertion рoint), Масштаб (Scale) и Поворот (Rotation) отличаются от
тех, которые приведены на рис. 12.2, исправьте их. Кроме того, выбери�
те в списке Задание пути (Path type) значение Путь не задан (No path),
чтобы не сохранять полный путь к файлу внешней ссылки в файле глав�
ного чертежа.

ChRoom121.dwg, но и слои, которые находились в момент вставки в чер�
теже Work121.dwg. Для того чтобы не возникало конфликтов имен, име�
на слоев внешней ссылки предваряются именем соответствующего фай�
ла чертежа, отделенного от имени слоя вертикальной чертой (рис. 12.4).

Примечание. Объекты, которые находились в файле внешней ссылки на нулевом
слое, после вставки этого файла в главный чертеж нельзя ни заморозить, ни уда�
лить. Именно поэтому мы, прежде чем вставлять файл в главный чертеж в виде
внешней ссылки, сначала очистили нулевой слой этого файла от всех объектов.

2. Заморозьте все слои Work121|имя_слоя, кроме слоя Work121|Вид
сверху.

Совет. Как видно из рис. 12.4, размеры диалогового окна Диспетчер свойств сло�
ев (Layer Properties Manager), равно как и ширину его столбцов, можно менять,
чтобы увидеть как полные названия слоев, так и как можно большую часть пе�
речня слоев.

3. Измените масштаб по границам чертежа. Теперь главный чертеж
с вставленной внешней ссылкой будут выглядеть так, как показано на
рис. 12.5.

4. Поскольку цвет объектов влияет на толщину линий при печати (об этом
мы подробнее поговорим в последних главах книги), давайте назначим
объектам всех незамороженных слоев одинаковый цвет линий, чтобы
при печати все линии чертежа имели одинаковую толщину. Для этого
снова откройте диалоговое окно Диспетчер свойств слоев (Layer Pro�
perties Manager).

Рис. 12.2  Параметры окна Внешняя ссылка (External Reference)
при вставке чертежа Work121.dwg в качестве внешней ссылки

10. Убедившись в том, что параметры окна Внешняя ссылка (External Refe�
rence) соответствуют приведенным на рис. 12.2, щелкните на кнопке OK.

11. Выберите на чертеже точку, в которой нужно разместить вставляемую
внешнюю ссылку (точка вставки совпадает с левым нижним внутренним
углом детской), а затем измените масштаб по границам чертежа. Резуль�
тат должен быть примерно таким, как показано на рис. 12.3.

Понятно, что в таком виде мы не можем использовать главный чертеж –
после вставки внешней ссылки информация, находящаяся на нем, стала избы�
точной. Это объясняется тем, что слои внешней ссылки в полном составе до�
бавляются к слоям главного чертежа. Давайте посмотрим, как отличить одни
слои от других, а также как добиться оптимального вида главного чертежа.

1. Откройте диалоговое окно Диспетчер свойств слоев (Layer Properties
Manager). Теперь в нем отображаются не только слои главного чертежа

Рис. 12.3  Чертеж Work121.dwg вставлен в главный чертеж ChRoom121.dwg
в качестве внешней ссылки
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5. Для начала щелкните на слое Work121|Вид сверху. Затем нажмите Ctrl
и, не отпуская ее, щелкните на остальных незамороженных слоях. Закон�
чив выделение, отпустите Ctrl и измените цвет любого из выделенных
слоев на цвет с индексом 146. Цвет, назначенный остальным выделен�
ным слоям, также изменится. Щелкните на кнопке OK.

Итак, теперь чертеж Work121.dwg вставлен в виде внешней ссылки в файл
ChRoom121.dwg, который в данном случае является главным чертежом. Тот
факт, что файл Work121.dwg является внешней ссылкой, не помешал нам изме�
нить как видимость слоев, так и цвет линий, назначенный слоям внешней ссыл�
ки точно так же, как мы это сделали для цвета линий, назначенного слоям глав�
ного чертежа.

12.2. Редактирование многофайловых чертежей12.2. Редактирование многофайловых чертежей12.2. Редактирование многофайловых чертежей12.2. Редактирование многофайловых чертежей12.2. Редактирование многофайловых чертежей
Файл Work121.dwg можно изменить как непосредственно в главном чертеже,
так и открыв его, как самостоятельный чертеж. Сначала мы воспользуемся пос�
ледним методом и отредактируем файл внешней ссылки Work121.dwg, а затем
посмотрим, как подобные модификации можно выполнять, не покидая главно�
го чертежа. Однако прежде, чем приступить к редактированию внешней ссыл�
ки, мы должны сохранить измененные параметры слоев файла внешней ссыл�
ки вместе с базовым чертежом.

1. Введите в командном окне имя переменной AutoCAD VISRETAIN. Если
значение переменной, которое отобразится в командном окне в угловых
скобках, равно 1, просто нажмите Enter, чтобы оставить его без измене�
ний, а в противном случае введите 1. Эта переменная включает режим
сохранения параметров слоев внешней ссылки в главном чертеже.

2. Сохраните текущее состояние главного чертежа в файле ChRoom122.dwg.

12.2.1. Редактирование файла внешней ссылки12.2.1. Редактирование файла внешней ссылки12.2.1. Редактирование файла внешней ссылки12.2.1. Редактирование файла внешней ссылки12.2.1. Редактирование файла внешней ссылки
Для редактирования файла внешней ссылки выполните следующие действия.

1. Откройте файл Work121.dwg.
2. Создайте новый слой Кресла (индекс цвета – 244) и назначьте его теку�

щим, а затем заморозьте слои Основная надпись, Текст и Вид спереди.
3. Измените масштаб просмотра так, чтобы чертеж был подобен рис. 12.6.
4. Запустите инструмент Прямоугольник (Rectangle). В ответ на пригла�

шение задать координаты первого угла прямоугольника включите режим
временной привязки Смещение (Snap From).

5. AutoCAD предложит выбрать базовую точку. Выберите нижнюю точку
левой вертикальной границы контура парты, как показано на рис. 12.7.

6. В командном окне появится приглашение задать смещение. Включите
режим временной привязки Точка отслеживания (Temporary track
point) и подведите указатель�перекрестие к точке, выбранной в п. 7, не
щелкая мышью.

Рис. 12.4  Слои главного чертежа после вставки внешней ссылки

Рис. 12.5  Вид главного чертежа с внешней ссылкой
после замораживания большинства слоев последней
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7. Как только AutoCAD распознает нижнюю точку вертикальной линии,
сместите указатель�перекрестие вправо. Добившись такого расположе�
ния указателя, когда AutoCAD распознает горизонтальное направление
(рис. 12.8), введите 182.

8. AutoCAD создаст на нижней горизонтальной линии контура парты точку
временной привязки и продолжит выполнение привязки Смещение
(Snap From), предлагая ввести смещение. Используя созданную в п. 9 точ�

ку временной привязки, опустите указатель�перекрестие вниз и, когда
AutoCAD распознает вертикальное направление (рис. 12.9), введите 150.

9. Введите в командном окне @400,-300. AutoCAD создаст прямоугольник,
который будет представлять на чертеже сидение кресла.

Рис. 12.6  Чертеж рабочей зоны с замороженными слоями

Рис. 12.7  Выбор базовой точки для режима Смещение (Snap From)

Рис. 12.8  Задание направления отслеживания привязки в режиме Точка отслеживания
(Temporary track point) для создания временной точки привязки

Рис. 12.9  Задание направление смещения в режиме Смещение (Snap From)
от временной точки привязки, полученной с использованием режима

Точка отслеживания (Temporary track point)
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10. Нажмите Enter для повторного запуска команды Ïðÿìîóãîëüíèê
(RECTANG) и выберите в качестве первой точки нижний левый угол
только что созданного прямоугольника.

11. Для завершения создания второго прямоугольника введите @400,50.
Чертеж должен принять вид, показанный на рис. 12.10.

явится кресло). Поскольку файл Work121.dwg является для главного чер�
тежа ChRoom122.dwg внешней ссылкой, внесенные изменения должны
сразу же отобразиться на главном чертеже. Выберите из меню команду
Окно (Window) ⇒ Путь к файлу\ChRoom122.dwg или просто нажмите
Ctrl+F6 для перехода в окно чертежа ChRoom122.dwg.

18. В области уведомлений появится сообщение о том, что внешняя ссылка,
имеющаяся в открытом чертеже, обновлена (рис. 12.13). Кроме того,

Рис. 12.10  Контур кресла создан

12. Запустите инструмент Сопряжение (Fillet) и введите в командном окне
Ðàäèóñ (RADIUS) или просто ä (R) для изменения радиуса сопряжения.

13. В ответ на запрос AutoCAD задать радиус сопряжения введите 100. AutoCAD
предложит выбрать первый из двух сопрягаемых объектов либо выбрать
другой режимы работы. Введите Ïëèíèÿ (POLYLINE) или просто ï (P)
для перехода к сопряжению полилинии.

14. AutoCAD предложит выбрать двухмерную полилинию. Щелкните на
большом прямоугольнике. Все его углы будут тут же сопряжены с радиу�
сом 100 мм (рис. 12.11).

15. Повторите пп. 14–16 для малого прямоугольника, изменив радиус сопря�
жения со 100 мм на 25 мм.

16. Запустите инструмент Обрезать (Trim) и, используя контур малого пря�
моугольника в качестве секущей, обрежьте те части контура большого
прямоугольника, которые находятся внутри контура малого прямоуголь�
ника. Результат должен быть таким, как показано на рис. 12.12. На этом
изменения чертежа Work121.dwg закончены и мы вернемся к чертежу
ChRoom122.dwg.

17. Сохраните текущее состояние файла Work121.dwg (имя должно остаться
неизменным, поскольку в противном случае на главном чертеже не по�

Рис. 12.12  Завершенный контур кресла

Рис. 12.11  Контур кресла после сопряжения углов большого прямоугольника
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в этом сообщении говорится о том, какой пользователь внес изменения
в файл внешней ссылки и какое имя имеет компьютер этого пользовате�
ля в сети. Подведите указатель мыши к команде Перезагрузить (Reload)
Work121 – имя пользователя, КОМПЬЮТЕР, которая отображается в этом
сообщении. Когда указатель примет вид руки, щелкните на сообщении.
AutoCAD тут же обновит чертеж, а сообщение отключится.

Если вы по каким�то причинам не увидели сообщения или закрыли его, не
обновляя внешней ссылки, а затем решили все же обновить изменившийся
файл, можете прибегнуть для этого к помощи палитры Внешние ссылки
(External References).

1. Откройте палитру Внешние ссылки (External References) (например,
введите для этого в командном окне ññ (XR) или âí (ER)).

2. Выделите в списке внешнюю ссылку Work121, как показано на рис. 12.14,
и щелкните на кнопке  Обновить (Refresh), которая находится в верх�
ней части панели правее кнопки Присоединить DWG (Attach DWG).

3. Информация в столбце Статус (Status) для выделенной внешней ссылки
изменится с Загружена (Loaded) на Выгрузить (Needs reloading). Щелк�
ните правой кнопкой мыши на выделенной в списке внешней ссылке
Work121 и выберите из появившегося контекстного меню команду Пере�
загрузить (Reload).

4. Состояние внешней ссылки в столбце Статус (Status) снова изменится
с Выгрузить (Needs reloading) на Загружена (Loaded). Закройте панель
Внешние ссылки (External References). Вид главного чертежа будет та�
ким же, как и после обновления внешней ссылки с помощью сообщения
(рис. 12.15).

5. Независимо от того, какой метод вы использовали для обновления внеш�
ней ссылки, сохраните текущее состояние чертежа ChRoom122.dwg.

Рис. 12.13  Сообщение об обновлении файла внешней ссылки

Рис. 12.14  Сведения о главном файле чертежа и
о присоединенных к нему файлах внешних ссылок

Рис. 12.15  Главный чертеж после обновления внешней ссылки
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Следует заметить, что параметры слоев одного и того же файла внешней
ссылки могут быть разными в двух разных главных чертежах, ссылающихся на
этот файл. Иными словами, можно создать в нескольких разных чертежах вне�
шние ссылки на один и тот же файл, настроив в каждом из главных чертежей
различные параметры видимости, цвета и типа линий для слоев файла внеш�
ней ссылки.

12.2.2. Редактирование внешней ссылки12.2.2. Редактирование внешней ссылки12.2.2. Редактирование внешней ссылки12.2.2. Редактирование внешней ссылки12.2.2. Редактирование внешней ссылки
из главного файлаиз главного файлаиз главного файлаиз главного файлаиз главного файла
Редактирование внешних ссылок, как уже отмечалось выше, можно выполнять
не только на уровне файла внешней ссылки, но и на уровне главного чертежа,
в котором используется эта внешняя ссылка. Данный метод редактирования
уступает предыдущему в гибкости, поскольку он не позволяет создать новый
слой или новый объект. Однако при этом пользователю все же доступны боль�
шинство инструментов модификации имеющихся объектов.

1. Нажмите Ctrl+F6 для переключения в окно, в котором открыт файл
Work121.dwg, и закройте это окно, нажав Ctrl+F4. После закрытия этого
файла вы автоматически перейдете к окну файла ChRoom122.dwg.

2. Выберите из меню команду Внешняя ссылка или блок для местного
редактирования ⇒ Редактирование вхождений (Tools Xref and Block
In�Place Editing ⇒ Edit Reference In�Place) или щелкните на кнопке  Ре�
дактирование вхождений (Edit Reference In�Place) панели инструмен�
тов РедСсыл (Refedit) либо введите в командном окне команду Ññûëðåä
(REFEDIT).

3. AutoCAD предложит выбрать какой�нибудь объект, принадлежащий
внешней ссылке, которую вы намереваетесь редактировать. Щелкните
на любой линии чертежа рабочей зоны, поскольку все они для главного
объекта являются элементами внешней ссылки.

4. В появившемся окне Редактирование вхождений (Reference Edit)
в списке Имя вхождения (Reference name) на вкладке Информация
о ссылке (Identify Reference) будет выделен файл Work121.dwg, а ниже
будут перечислены все экземпляры блоков, вставленные в этот файл.
В области предварительного просмотра отображается текущий элемент,
выбранный в списке Имя вхождения (Reference name). Выберите эле�
мент списка Work121 (рис. 12.16) и щелкните на кнопке OK.

5. Цвет остальных объектов чертежа, не входящих в выбранную внешнюю
ссылку, изменится (станет блеклым). Это говорит о том, что соответству�
ющие объекты недоступны для редактирования, поскольку AutoCAD пе�
реключился в режим редактирования внешней ссылки. Кроме того,
AutoCAD автоматически включит отображение панели РедСсыл
(Refedit), в раскрывающемся списке которой будет выделена редактируе�
мая внешняя ссылка (рис. 12.17). Охватите рамкой выделения все эле�
менты, которые образуют чертеж кресла, а затем щелкните на любом из

маркеров выделенных объектов для переключения в режим редактиро�
вания с помощью маркеров.

6. Нажмите Пробел, чтобы переключиться из режима Ðàñ÷ëåíèòü
(STRETCH) в режим Ïåðåìåùåíèå (MOVE). Введите Êîïèðîâàòü (COPY)
или просто ê (C) для включения подрежима копирования.

7. Переместите копию выделенных объектов в направлении рабочего мес�
та старшеклассника (рис. 12.18).

8. Выбрав точку расположения чертежа второго кресла, нажмите Enter для
выхода из режима редактирования с помощью маркеров, а затем Esc для
снятия выделения.

9. Если хотите, можете развернуть контур второго кресла с помощью инст�
румента Повернуть (Rotate) (команда Ïîâåðíóòü (ROTATE)) или режи�
ма Ïîâåðíóòü (ROTATE), который включается при переходе в режим ре�
дактирования с помощью маркеров выделения после двукратного
нажатия Пробел.

10. Закончив редактирование, щелкните на кнопке  Сохранить измене�
ния вхождения (Save Reference Edits) панели инструментов РедСсыл
(Refedit). Можно также выбрать из меню команду Сервис ⇒ Внешняя
ссылка или блок для местного редактирования ⇒ Сохранить измене�
ния вхождения (Tools ⇒ Xref and Block In�Place Editing ⇒ Save Reference
Edits) или ввести в командном окне Ññûëçàêð (REFCLOSE).

Рис. 12.16  Диалоговое окно
Редактирование вхождений (Reference Edit)

Рис. 12.17  Панель РедСсыл (Refedit)
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11. В появившемся окне предупреждения о том, что вы намереваетесь сохра�
нить внесенные изменения, щелкните на кнопке OK.

12. AutoCAD обновит файл внешней ссылки, чтобы отобразить внесенные
вами изменения. Сохраните текущее состояние чертежа (рис. 12.19)
в том же файле ChRoom122.dwg.

Примечание. Несмотря на то, что изменения, внесенные при редактировании
внешней ссылки в главном чертеже, были сохранены в файле внешней ссылки
(в этом нетрудно убедиться, открыв файл Work121.dwg), AutoCAD напомнит
вам с помощью сообщения в области уведомления (см. рис. 12.13) о том, что файл
внешней ссылки нужно обновить. Поэтому, строго говоря, в редактировании «на
месте» нет особой необходимости и прибегать к нему нужно только в тех случаях,
когда это действительно нужно. В подавляющем большинстве случаев все же про�
ще (да и удобнее, учитывая недоступность ряда команд при редактировании
внешней ссылки «на месте») применять редактирование файла внешней ссылки
с последующим обновлением главного чертежа.

12.3. Особенности использования внешних ссылок12.3. Особенности использования внешних ссылок12.3. Особенности использования внешних ссылок12.3. Особенности использования внешних ссылок12.3. Особенности использования внешних ссылок
Итак, мы рассмотрели основные методы создания и использования внешних
ссылок. В заключительном разделе этой главы мы рассмотрим некоторые осо�
бенности их использования, которые нужно учитывать при работе с внешними
ссылками.

Как вы помните, при создании внешней ссылки в окне Внешняя ссылка
(External Reference) (см. рис. 2.2) мы в качестве значения параметра Задание
пути (Path type) выбрали из списка значение Путь не задан (No path). В этом
случае в главном чертеже не сохраняется путь к файлу внешней ссылки, а лишь
его имя. Это означает, что AutoCAD будет искать файл внешней ссылки в том
же каталоге, в котором расположен главный чертеж. При выборе этого пара�
метра значением, отображаемым в текстовой области Сохранить путь (Saved
path), является лишь имя файла внешней ссылки, как это показано на рис. 2.2.

Если же оставить для параметра Задание пути (Path type) установленное по
умолчанию значение Полный путь (Full path), AutoCAD будет сохранять в фай�
ле главного чертежа полный путь к файлу внешней ссылки, включая буквенное
обозначение диска, все каталоги и имя самого файла. В этом случае значение
текстовой области Сохранить путь (Saved path), которое сохраняется в файле
главного чертежа, эквивалентно значению текстовой области Найдена в (Found
in) (полный путь к файлу внешней ссылки на диске). Если в качестве значения
параметра Задание пути (Path type) выбрать Относительный путь (Relative
path), значение текстовой области Сохранить путь (Saved path) будет иметь
вид, зависящий от того, какой каталог является текущим на момент открытия
окна Внешняя ссылка (External Reference). Путь к файлу в этом случае записы�
вается с учетом соглашений, принятых в операционной системе для представ�
ления каталогов относительно текущего каталога (рис. 12.20).

Мы так подробно останавливаемся на этой теме потому, что каждый раз при
открытии главного чертежа AutoCAD проверяет все внешние ссылки, подклю�
ченные к главному файлу, и открывает их вместе с главным файлом. Если в ка�
талоге, указанном в главном файле для той или иной внешней ссылки, отсут�
ствует нужный файл (файл был переименован, перемещен в другой каталог,
было изменено имя каталога и т. п.), AutoCAD не сможет найти его и открыть.

Рис. 12.18  Копирование объектов внешней ссылки
в режиме редактирования с помощью маркеров выделения

Рис. 12.19  Обновленный главный чертеж
с измененными объектами файла внешней ссылки
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Внимание. Если AutoCAD не сможет открыть файл внешней ссылки, вы об
этом никак не узнаете – на экране не появится ни окон сообщений, ни других
визуальных средств, извещающих пользователя об отсутствующих файлах
(строго говоря, сообщения есть, но увидеть их неподготовленному пользовате�
лю не так�то просто). Единственное, что изменится на экране – это пиктограм�
ма  Диспетчер внешних ссылок (Manage Xrefs) в области системных уве�
домлений, которая находится в правом нижнем углу окна AutoCAD левее
кнопки раскрытия списка команд, определяющих вид строки состояния. Если
в открытом чертеже отсутствуют внешние ссылки или имеются необновленные
ссылки, на этой пиктограмме появится изображение восклицательного знака.
Щелчок на пиктограмме приведет к открытию палитры Внешние ссылки
(External References), в которой сразу же можно идентифицировать источник
проблемы – внешнюю ссылку, обозначенную в столбце Статус (Status) красным
восклицательным знаком и надписью Не найдена (Not Found) (рис. 12.21).

Кроме того, AutoCAD в точке вставки отсутствующей внешней ссылки поме�
щает однострочную надпись, содержимое которой имеет вид Âí-ññûëêà
(Xref) сохраненный путь к файлу. Однако заметить эту надпись во многих случаях
не так�то легко. Давайте проделаем следующий эксперимент.

1. Закройте файл ChRoom122.dwg.
2. Создайте в папке, в которой находится файл Work121.dwg, вложенную

папку с произвольным именем, например, Ref и переместите файл
Work121.dwg в эту папку.

3. Снова откройте файл ChRoom122.dwg. Как и следовало ожидать, чертеж
рабочей зоны на плане детской будет отсутствовать, поскольку AutoCAD
не найдет файл внешней ссылки в текущем каталоге. Пиктограмма Дис�
петчер внешних ссылок (Manage Xrefs) примет вид, сигнализирующий

о том, что в файле имеются необновленные и (или) отсутствующие вне�
шние ссылки. Однако в данном случае нас интересует едва заметный
объект, появившийся в левом нижнем углу детской. Охватите его окном
масштабирования, стараясь сделать окно как можно меньшего размера
(рис. 12.22).

4. После изменения масштаба вы увидите, что интересующий нас объект
представляет собой надпись Âí-ññûëêà Work121.dwg (Xref Work121.dwg)
(рис. 12.23).

Рис. 12.20  Пример сохранения относительного пути
к файлу внешней ссылки Рис. 12.21  AutoCAD обнаружил, что файл внешней ссылки отсутствует по пути,

сохраненному в файле главного чертежа

Рис. 12.22  Надпись, появившаяся в левом нижнем углу детской,
в масштабе текущего чертежа представляет собой едва различимый объект
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5. Нажмите F2 для открытия текстового окна AutoCAD. Между командой
открытия чертежа и командой изменения масштаба в этом окне будет за�
фиксировано сообщение о том, что файл внешней ссылки Work121.dwg
не найден. Нажмите F2 для закрытия текстового окна.

6. Откройте палитру Внешние ссылки (External References) любым удоб�
ным для вас способом, щелкните на внешней ссылке, которая отсутству�
ет в открытом файле главного чертежа, а затем щелкните на строке Най�
ден в (Found at) в разделе Подробности (Details), расположенном под
списком ссылок текущего чертежа. Справа от строки Найден в (Found
at) появится небольшая кнопка с символами +++ (рис. 12.24).

7. Щелкните на этой кнопке и найдите с помощью открывшегося окна Вы�
бор нового пути (Select new path) в созданном вами каталоге Ref файл
Work121.dwg.

8. Как только вы щелкните в окне Выбор нового пути (Select new path) на
кнопке Открыть (Open), AutoCAD подгрузит внешнюю ссылку, сразу же
разместив ее с использованием той же точки вставки, которая была приме�
нена для отсутствовавшей внешней ссылки. Соответствующие изменения
отобразятся в палитре Внешние ссылки (External References) (рис. 12.25).

Сохраните текущее состояние чертежа в файле ChRoom122.dwg и закройте
файл.

На этом мы закончим знакомство с внешними ссылками. Как вы, наверное,
поняли, внешние ссылки – это очень удобный инструмент для организации
многопользовательской работы над чертежом. Единственное требование, ко�
торое нужно соблюдать при работе с внешними ссылками, заключается в обес�
печении корректного управления файлами внешних ссылок, особенно при пе�
редаче чертежей другим пользователям и (или) в другие организации.

Рис. 12.23  Та же надпись после изменения масштаба Рис. 12.24  Палитра Внешние ссылки (External References)
с разделом Подробности (Details) для отсутствующей внешней ссылки

Рис. 12.25  Палитра Внешние ссылки (External References)
с разделом Подробности (Details) для заново подгруженной внешней ссылки
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В предыдущей главе вы ознакомились с основными принципами созда�
ния многофайловых чертежей. Понять эти принципы, как надеется ав�
тор, несложно – реализованный в AutoCAD механизм внешних ссылок

позволяет просматривать и редактировать одни чертежи из других. Этого,
к сожалению, нельзя сказать об основных принципах, положенных в основу со�
здания компоновок (layout). Начинающие пользователи нередко испытывают
затруднения с созданием компоновок, поскольку пытаются перенести в AutoCAD
методы работы, освоенные ими в других Windows�приложениях. Хотя разра�
ботчики компании Autodesk постарались максимально упростить и унифици�
ровать интерфейс подготовки чертежа к печати, все же нужно признать, что
на освоение концепции компоновок среднему пользователю, как правило, при�
ходится потратить некоторое время.

В действительности в компоновках нет ничего сложного. Если внешние
ссылки позволяют получить из нескольких относительно простых чертежей
единый чертеж с достаточно высоким уровнем сложности, то компоновки не�
редко применяются для решения обратной задачи – для получения на одном
распечатанном листе нескольких разных представлений одного и того же чер�
тежа. Проще говоря, компоновка – это электронный макет печатного листа
чертежа.

Необходимость использования компоновок в AutoCAD продиктовано тем,
что в практике конструирования может использоваться очень широкая номен�
клатура печатающих устройств и форматов. Однако самая важная задача, кото�
рую призваны решать компоновки, – это учет различных масштабов. Без пре�
увеличения можно сказать, что для многих начинающих пользователей камнем
преткновения при выводе чертежа на печать является именно масштабирова�
ние. Суть проблемы состоит в том, что при печати чертежей используется как

бы два масштаба – масштаб, в котором выполнен собственно чертеж (напри�
мер, 1:10), и масштаб, в котором выполнены объекты печатного листа, то есть
компоновки (рамка, основная надпись и т. п.). Как правило, последний всегда
выбирается равным 1:1, то есть на листе компоновки объекты вычерчиваются
в натуральную величину. В таком случае на листе компоновки необходимо со�
вместить сам чертеж, выполненный в необходимом пользователю масштабе,
и объекты компоновки, выполненные в масштабе 1:1. Именно такой подход яв�
ляется наиболее эффективным.

Тем не менее, начинающим пользователям нередко легче поначалу вычер�
чивать объекты чертежа и элементы оформления (рамку, основную надпись,
технические требования, размеры и т. п.) в одном масштабе, совпадающим
с основным масштабом чертежа. Если вы помните, именно так мы и поступили
в главах 10 и 11, когда создавали основную надпись и остальные элементы
оформления.

13.1. Создание простой компоновки13.1. Создание простой компоновки13.1. Создание простой компоновки13.1. Создание простой компоновки13.1. Создание простой компоновки
В ходе работы над главой 10 вами был получен чертеж, представляющий собой
практически готовый к печати лист формата A2, на котором в главе 11 вы на�
несли основные размеры рабочей зоны для печати чертежа в масштабе 1:10.
В следующей главе, посвященной описанию методов вывода чертежей на печать,
вы попробуете распечатать окончательную версию чертежа (Work111.dwg), не
внося в него никаких изменений. В этой же главе мы создадим из этого же чер�
тежа компоновку, которая также будет распечатана в следующей главе, чтобы
вы смогли сравнить оба подхода и разобраться в достоинствах и недостатках
обоих.

13.1.1. Создание набора параметров страницы13.1.1. Создание набора параметров страницы13.1.1. Создание набора параметров страницы13.1.1. Создание набора параметров страницы13.1.1. Создание набора параметров страницы
Итак, сейчас мы займемся созданием простой компоновки для печати чертежа
на листе формата A2 (420 ґ 594 мм).

1. Откройте файл Work111.dwg. Этот чертеж, как вы помните, мы снабдили
рамкой и основной надписью, а также другими элементами оформления,
вычерченными в натуральную величину с учетом масштаба 1:10. В част�
ности, рамка, представляющая границы листа, имеет размер 4200 × 5940 мм.
В данном случае пересчитывать размеры легко, поскольку мы выбрали
масштаб 1:10. А как быть в тех случаях, когда выбран, скажем популяр�
ный у авиамоделистов масштаб 1:72? Нетрудно догадаться, что постоян�
ный пересчет размеров – это не самое интересное для пользователя
AutoCAD занятие. Поэтому, как вы сейчас убедитесь, единственным при�
емлемым решением здесь является применение компоновок, что позво�
лит вычерчивать элементы оформления в натуральную величину.

2. Измените масштабы по размерам чертежа, а затем сохраните текущее
состояние чертежа в файле Work131.dwg.

13ГГГГГлавалавалавалавалава
Подготовка чертежаПодготовка чертежаПодготовка чертежаПодготовка чертежаПодготовка чертежа
к печатик печатик печатик печатик печати
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3. Создайте новый слой Рамка (индекс цвета – 116) и назначьте его текущим.
4. Щелкните на ярлычке Лист1 (Layout1) (рис. 13.1), который находится

между областью черчения и командным окном (справа от ярлычка листа
Модель (Model)).

plotter) выберите из списка Имя (Name) печатающее устройство, кото�
рое поддерживает формат A2 (например, DesignJet 755CM C3198B),
а в группе Формат листа (Paper size) – соответствующий формат. В груп�
пе Ориентация чертежа (Drawing orientation) выберите переключатель
Книжная (Portrait) (рис. 13.3).

8. Щелкните на кнопке OK для возврата в окно Диспетчер параметров
листов (Page Setup Manager). Теперь в списке Набор параметров листа
(Page Setups) этого окна будет отображаться два элемента – созданный по
умолчанию набор *Лист1* и только что определенный вами набор
Work131�A2. Выделив последний в списке, щелкните на кнопке Устано�
вить (Set Current), чтобы назначить его текущим. Имя первого элемента
изменится, чтобы отобразить тот факт, что листу компоновки Лист1наз�
начен набор параметров страницы Work131�A2 (рис. 13.4).

9. Щелкните на кнопке Закрыть (Close). AutoCAD создаст на листе Лист1 но�
вую компоновку и отобразит текущий чертеж в этой компоновке (рис. 13.5).

13.1.2. Работа с компоновками в режимах «ЛИСТ»13.1.2. Работа с компоновками в режимах «ЛИСТ»13.1.2. Работа с компоновками в режимах «ЛИСТ»13.1.2. Работа с компоновками в режимах «ЛИСТ»13.1.2. Работа с компоновками в режимах «ЛИСТ»
(P(P(P(P(PAPER) и «МОДЕЛЬ» (MODEL)APER) и «МОДЕЛЬ» (MODEL)APER) и «МОДЕЛЬ» (MODEL)APER) и «МОДЕЛЬ» (MODEL)APER) и «МОДЕЛЬ» (MODEL)
В настоящий момент на экране в области черчения вы видите макет компонов�
ки печатного листа, который представлен белым прямоугольником на сером
фоне. Собственно чертеж находится в центре макета. Как видно на рис. 13.5,
он ограничен созданным ранее прямоугольником, который должен обозначать
границу печатного листа (пока что эта граница и граница компоновки не совпа�
дают, но вскоре мы исправим этот недостаток). Вокруг этого прямоугольника
имеется еще один прямоугольник, который обозначает границу так называемо�
го видового экрана (viewport). Видовой экран создается AutoCAD автоматически

Рис. 13.1  Для перехода к листу компоновки
нужно щелкнуть на ярлычке с именем вида ЛистN (LayoutN)

Примечание. Если документ был подготовлен в английской версии AutoCAD, то
вероятнее всего, открыв его в русской версии, ярлычки Лист1, Лист2, …, ЛистN
будут называться Layout1, Layout2, …, LayoutN.

5. В открывшемся диалоговом окне Диспетчер параметров листов (Page
Setup Manager) будут перечислены все наборы параметров страниц (page
setup) для компоновок, определенных в текущем чертеже. Поскольку
в нашем случае таких компоновок пока еще нет, этот список будет состо�
ять из одного элемента, как показано на рис. 13.2.

6. Щелкните на кнопке Создать (New) и в строке Имя набора параметров
листа (New page setup name) открывшегося окна Создание набора пара�
метров листа (New Page Setup) введите Work131�A2.

7. Щелкните на кнопке OK, и AutoCAD откроет окно Параметры листа –
Лист1 (Page Setup – Layout1). В группе Принтер/плоттер (Printer/

Рис. 13.2  Список компоновок
по умолчанию содержит только один элемент
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при создании компоновки. На листе компоновки может быть несколько видо�
вых экранов, но всегда имеется как минимум один видовой экран. Можно ска�
зать, что видовой экран – это нечто вроде «окна» на листе компоновки, с помо�
щью которого вы можете видеть «сквозь» этот лист находящийся «снизу»
чертеж или его фрагмент.

Обратите также внимание на ярлычки листов, которые находятся в левой ниж�
ней части области черчения. Сейчас текущим является лист Лист1 (Layout1).
Пощелкайте на ярлычках Модель (Model) и Лист1 (Layout1), чтобы увидеть,
в чем состоят различия между содержимым листа модели и листа компоновки,
а затем снова вернитесь на лист Лист1.

Как вы помните, все элементы оформления чертежа мы разместили непос�
редственно на листе модели. Это, как уже отмечалось выше, не самый удобный
способ оформления чертежей. Поэтому наша задача сейчас состоит в том, что�
бы удалить соответствующие объекты с листа модели и разместить их на листе
компоновки. Понятно, что при этом вам придется постоянно переключаться
с одного листа на другой. Первый способ вы уже знаете – он состоит в том, что�
бы щелкнуть на ярлычке нужного вам листа.

Однако AutoCAD предоставляет пользователю еще один метод внесения из�
менений в модель, не покидая листа компоновки. Обратите внимание на пик�
тограмму в виде треугольника, которая находится в левом нижнем углу области

Рис. 13.3  Диалоговое окно Параметры листа – Лист1 (Page Setup – Layout1)

Рис. 13.4  Диалоговое окно
Диспетчер параметров листов (Page Setup Manager)

с набором параметров страницы Work131?A2, назначенным
используемым по умолчанию для компоновки Лист1

Рис. 13.5  Новая компоновка Лист1 создана
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черчения. Она означает, что вы находитесь в режиме редактирования содер�
жимого листа компоновки, при котором все создаваемые объекты будут разме�
щаться именно на этом листе, а не на листе модели. Этот режим называется
режимом работы в пространстве листа (paper space). О том, что он включен,
можно также узнать, взглянув на кнопки�индикаторы строки состояния. Режим
работы в пространстве листа включается в том случае, когда кнопка�индикатор
ЛИСТ (PAPER) находится в нажатом состоянии.

1. Поперемещайте указатель�перекрестие по области черчения, чтобы убе�
диться в том, что вы можете переместить его в любую точку листа компо�
новки,

2. Щелкните на кнопке�индикаторе ЛИСТ (PAPER). Кнопка останется
в нажатом состоянии, но ее название изменится с ЛИСТ (PAPER) на МО�
ДЕЛЬ (MODEL). Это означает, что вы переключились в режим работы в
пространстве модели (model space). В отличие от перехода непосредствен�
но на лист модели, осуществляемый с помощью щелчка на ярлычке Мо�
дель (Model), при переключении в режим МОДЕЛЬ (MODEL) вы по�
прежнему остаетесь на листе компоновки. Тем не менее, в этом режиме
вы работаете с листом модели, который «виден сквозь» видовой экран
листа компоновки.

3. Снова попробуйте поперемещать указатель по области черчения. Как
легко заметить, теперь указатель принимает форму перекрестия только
в том случае, когда он попадает в область видового экрана, на котором
отображается чертеж (рис. 13.6), а вне этой области указатель принима�
ет форму обычной стрелки. Кроме того, когда указатель принимает фор�

му перекрестия, его линии продолжаются только до границ видового эк�
рана. Иными словами, при редактировании компоновки в режиме МО�
ДЕЛЬ (MODEL) вы можете создавать и модифицировать только те
объекты, которые размещены внутри видового экрана.

Совет. Переключаться на лист модели с помощью ярлычка Модель (Model) при
подготовке чертежа к печати имеет смысл только в том случае, если вы сталки�
ваетесь с необходимостью внесения в чертеж существенных изменений. В этом
случае макет не отображается, что позволяет вам использовать всю область чер�
чения для модификации чертежа. В остальных случаях лучше всего, не покидая
листа компоновки, переключиться в режим МОДЕЛЬ (MODEL), щелкнув для
этого на кнопке�индикаторе ЛИСТ (PAPER) в строке состояния.

13.1.3. Перенос элементов оформления чертежа13.1.3. Перенос элементов оформления чертежа13.1.3. Перенос элементов оформления чертежа13.1.3. Перенос элементов оформления чертежа13.1.3. Перенос элементов оформления чертежа
на лист компоновкина лист компоновкина лист компоновкина лист компоновкина лист компоновки
Теперь все готово для того, чтобы перенести основную надпись и рамку из лис�
та модели на лист компоновки. Для начала перенесем рамку, поскольку она
представляет собой простой прямоугольник.

1. Если включен режим МОДЕЛЬ (MODEL), щелкните на соответствую�
щей кнопке�индикаторе в строке состояния, чтобы перейти к режиму
работы в пространстве листа, то есть режиму редактирования листа ком�
поновки ЛИСТ (PAPER).

2. Запустите инструмент Прямоугольник (Rectangle), например, введя
в командном окне ïðÿìîóã (REC).

3. В ответ на приглашение задать координаты первого угла, введите 0,0.
4. AutoCAD предложит задать координаты второго угла. Введите 408.4,

572.4. На листе компоновки появится прямоугольник (рис. 13.7), разме�
ры которого соответствуют размерам печатаемой области, представлен�
ной штриховыми линиями (сравните рис. 13.7 с рис. 13.5).

Совет. У каждого принтера или графопостроителя печатаемая область имеет
свой размер, который может зависеть от выбранного формата. Для того чтобы
узнать этот размер, щелкните правой кнопкой мыши на ярлычке Лист1
(Layout1), выберите из появившегося контекстного меню команду Диспетчер па�
раметров листов (Page Setup Manager) и щелкните в открывшемся окне Диспет�
чер параметров листов (Page Setup Manager) на кнопке Изменить (Modify) (см.
рис. 13.4). В появившемся окне Параметры листа – Лист1 (Page Setup – Layout1)
(см. рис. 13.3) щелкните на кнопке Свойства (Properties), которая находится
справа от выбранного в списке Имя (Name) устройства печати. На экране по�
явится окно Редактор параметров плоттера (Potter Configuration Editor). Пе�
рейдите в нем на вкладку Устройство и документ (Device and Document Settings),
раскройте группу параметров Нестандартные форматы и калибровка (User�
defined Paper Sizes & Calibration) и выберите в ней параметр Изменение стандар�
тных форматов листа (Modify Standard Paper Sizes (Printable Area)). НайдитеРис. 13.6  Компоновка Лист1 (Layout1) в режиме МОДЕЛЬ (MODEL)
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в списке расположенной в нижней части окна области Изменение стандартных
форматов листа (Modify Standard Paper Sizes) нужный вам формат, и под спис�
ком в текстовой области Изменение стандартных форматов листа (Modify
Standard Paper Sizes (Printable Area)) вы увидите значение размера печатаемой
области для выбранного устройства печати и выбранного формата (рис. 13.8).
Затем закройте все окна, последовательно нажав несколько раз Esc.

5. Нужно сместить линию полученного прямоугольника внутрь на 1 мм,
чтобы линии рамки выводились на печать. Воспользуйтесь для этого ко�
мандой Ïîäîáèå (OFFSET), а затем удалите исходный прямоугольник.

6. Разбейте прямоугольник на отдельные сегменты с помощью команды
Ðàñ÷ëåíèòü (EXPLODE), а затем сместите левую вертикальную линию
внутрь на расстояние, которое обеспечит нужный внутренний размер
области, охваченной рамкой. Этот размер можно рассчитать по форму�
ле Wpa – 2 × 1 – (Wf – (5 + 20), где Wpa – ширина печатаемой области,
а Wf – ширина формата. Подставляя в формулу значения для выбранно�
го формата и графопостроителя, получаем величину смещения, равную
408.4 – 2 × 1 – (420 – (5 + 20)) = 11.4 мм.

7. Удалите исходную вертикальную линию, обрежьте лишние горизонталь�
ные сегменты с помощью команды Îáðåçàòü (TRIM) и объедините но�
вую линию с остальными линиями рамки с помощью режима Çàìêíóòü
(JOIN) команды Ïîëðåä (PEDIT).

8. Снова запустите команду Ïîëðåä (PEDIT), например, введя ïðä (PE) или
просто нажав Enter для ее повтора, и выберите полученный прямоуголь�
ник. Введите Øèðèíà (WIDTH) или просто ø (W) для перехода в режим

определения ширины полилинии, а затем введите 1, чтобы полилиния
приобрела ширину 1 мм.

9. Нажмите Enter для завершения команды Ïîëðåä (PEDIT).
10. Перейдите на лист Модель (Model), щелкнув на ярлычке этого листа.

13.1.4. Вырезание и вставка объектов13.1.4. Вырезание и вставка объектов13.1.4. Вырезание и вставка объектов13.1.4. Вырезание и вставка объектов13.1.4. Вырезание и вставка объектов
с использованием базовой точкис использованием базовой точкис использованием базовой точкис использованием базовой точкис использованием базовой точки
Теперь, когда мы создали рамку на листе компоновки, прямоугольники, пред�
ставляющие рамку и границу печатного листа на листе модели нам уже не нуж�
ны. Однако прежде, чем удалять эти объекты на листе модели, необходимо пе�
ренести на лист компоновки основную надпись. Для этого мы воспользуемся
инструментами копирования и вставки, памятуя при этом, что AutoCAD рас�
сматривает все помещенные в буфер обмена объекты, как единый блок.

1. Выберите из меню команду Правка ⇒ Копировать с базовой точкой
(Edit ⇒ Copy with Base Point) либо введите в командном окне команду
Êîïèðáàç (COPYBASE) или просто нажмите Ctrl+Shift+C.

2. В ответ на приглашение AutoCAD задать базовую точку выберите правый
нижний угол основной надписи (рис. 13.9).

Рис. 13.7  Прямоугольник, совпадающий по размерам с печатаемой областью

Рис. 13.8  Окно Редактор параметров плоттера
(Potter Configuration Editor) позволяет выяснить размер

печатаемой области для выбранного формата и печатающего устройства

Создание простой компоновкиСоздание простой компоновкиСоздание простой компоновкиСоздание простой компоновкиСоздание простой компоновки



Подготовка чертежа к печатиПодготовка чертежа к печатиПодготовка чертежа к печатиПодготовка чертежа к печатиПодготовка чертежа к печати422 423

3. AutoCAD предложит выбрать объекты, подлежащие копированию. С по�
мощью пересекающей рамки выделите основную надпись, не захватывая
рамки чертежа (рис. 13.10).

4. Нажмите Enter для копирования выделенных объектов в буфер обмена и
завершения команды Êîïèðáàç (COPYBASE).

5. Перейдите на лист Лист1 (Layout1) и щелкните на кнопке�индикаторе
ЛИСТ (PAPER) для переключения в режим МОДЕЛЬ (MODEL).

6. Удалите на исходном чертеже, который стал доступным «сквозь» видо�
вой экран, рамку, основную надпись и прямоугольник, который обозна�
чал границу печатного листа. Результат должен быть таким, как показано
на рис. 13.11.

Рис. 13.9  Выбор базовой точки на листе модели
для копирования основной надписи в буфер обмена

Рис. 13.10  Выделение основной надписи с помощью пересекающей рамки

Рис. 13.11  Лист компоновки в режиме МОДЕЛЬ (MODEL)
после удаления элементов оформления из пространства модели

7. Щелкните на кнопке�индикаторе МОДЕЛЬ (MODEL) для возврата в ре�
жим ЛИСТ (PAPER), чтобы вставить находящуюся в буфере обмена ос�
новную надпись на лист компоновки.

8. Выберите из меню команду Правка ⇒ Вставить как блок (Edit ⇒ Paste as
Block) либо введите в командном окне команду Âñòáëîê (PASTEBLOCK)
или просто нажмите Ctrl+Shift+V. В области черчения появится увели�
ченное в 10 раз изображение основной надписи, которое будет переме�
щаться вместе с указателем�перекрестием.

9. Выберите в качестве точки вставки точку, которая находится в правом
нижнем углу рамки листа компоновки (рис. 13.12).

10. Запустите инструмент Масштаб (Scale), выбрав из меню команду Изме�
нить ⇒ Масштаб (Modify ⇒ Scale) или щелкнув на кнопке  Масштаб
(Scale) панели инструментов Изменить (Modify) либо введя в командном
окне команду Ìàñøòàá (SCALE) или просто ìø (SC). В ответ на приглаше�
ние выбрать объект щелкните на любом элементе основной надписи и
нажмите Enter.

11. AutoCAD предложит задать базовую точку. Выберите правый нижний
угол рамки листа компоновки, как и при вставке основной надписи.
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12. В следующем приглашении AutoCAD предложит задать масштаб. Введите
0.1. Выполнение команды Ìàñøòàá (SCALE) автоматически завершит�
ся, а основная надпись приобретет нужный размер (рис. 13.13).

13.1.5. Модификация размеров видового экрана13.1.5. Модификация размеров видового экрана13.1.5. Модификация размеров видового экрана13.1.5. Модификация размеров видового экрана13.1.5. Модификация размеров видового экрана
В заключение нам осталось лишь изменить размеры видового экрана с тем, что�
бы чертеж занимал всю доступную площадь листа компоновки. Кроме того, мы
столкнемся с необходимостью откорректировать масштаб чертежа, поскольку
после автоматического создания компоновки он остается произвольным, а не
1:10, как это указано в основной надписи.

1. Щелкните на прямоугольнике, обозначающем границы видового экрана.
В углах этого прямоугольника появятся маркеры выделения, как и в слу�
чае выделения обычного объекта AutoCAD.

2. Щелкните на кнопке�индикаторе ПРИВЯЗКА (OSNAP) в строке состоя�
ния или просто нажмите F3, чтобы отключить все постоянно действую�
щие режимы объектной привязки.

3. Щелкните на правом верхнем маркере выделения, чтобы выбрать его и
перейти в режим редактирования с помощью маркеров.

4. Переместите указатель�перекрестие вправо и вверх, как можно ближе
к правому верхнему углу рамки. Поскольку текущим режимом редактиро�
вания с помощью маркеров будет режим Ðàñòÿãèâàíèå (STRETCH),
AutoCAD будет сопровождать перемещение указателя�перекрестия «ре�
зиновой линией». Поместив указатель�перекрестие в нужной точке, щелк�
ните для увеличения видового экрана вправо и вверх до заданной точки.

5. Выберите левый нижний маркер выделения, а затем в режиме Ðàñòÿãè-
âàíèå (STRETCH) растяните контур видового экрана влево и вниз, как
показано на рис. 13.14.

Рис. 13.12  Вставка основной надписи на лист компоновки

Рис. 13.13. Основная надпись на листе компоновки после масштабирования
Рис. 13.14  Изменение размера видового экрана в режиме Ðàñòÿãèâàíèå (STRETCH)

редактирования с помощью маркеров выделения
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6. Отмените выделение видового экрана, нажав Esc. Теперь размеры видо�
вого экрана лишь слегка меньше, чем размеры рамки листа компоновки.
Если вы обратили внимание, видовой экран находится на слое Рамка.
Имеет смысл поместить его на отдельный слой, а также сделать более
заметной границу видового экрана, как напоминание о том, что соответ�
ствующий прямоугольник не является частью чертежа и что его не нуж�
но выводить на печать.

7. Создайте новый слой Âèäîâîé ýêðàí с индексом цвета 220. (Цвет может
быть любым, главное, чтобы он хорошо выделялся в области черчения.)
Назначать новый слой текущим не нужно.

8. Щелкните на видовом экране, чтобы выделить его еще раз, после чего
откройте палитру Свойства (Properties), воспользовавшись кнопкой
Свойства (Properties) панели инструментов Standard или выбрав соот�
ветствующую команду из контекстного меню либо любым другим удоб�
ным для вас способом.

9. Убедитесь в том, что в списке, находящемся в верхней части палитры
Свойства (Properties), выбран тип Видовой экран (Viewport). Затем
щелкните на свойстве CkjqLayer и выберите из списка слоев только что
созданный слой Видовой экран (рис. 13.15).

11. Переключитесь из режима Лист (PAPER) в режим МОДЕЛЬ (MODEL)
щелчком на кнопке�индикаторе строки состояния.

Совет. Если вы предпочитаете работать в командном окне, можете для перехо�
да в режим ЛИСТ (PAPER) вводить в командном окне команду Ëèñò (PSPACE)
или просто Ë (PS), а для перехода в режим МОДЕЛЬ (MODEL) – команду ÌÎ-
ÄÅËÜ (MSPACE) или просто Ì (MS).

12. Для точного изменения масштаба, как вы, должно быть, помните из пер�
вых глав книги, лучше всего использовать инструмент Уменьшить (Zoom
In) или Увеличить (Zoom Out) в варианте команды Ïîêàçàòü (ZOOM)
командного окна. Поэтому введите в командном окне ïî (Z), а затем мас�
штабный коэффициент 0.1xp (то есть установите масштаб 1:10). Масш�
таб изображения на листе компоновки изменится.

Примечание. Суффикс õ после значения масштабного коэффициента говорит
о том, что новый масштаб нужно установить относительно текущего масшта�
ба чертежа, а суффикс õð – о том, что новый масштаб нужно установить отно�
сительно единиц измерения, установленных для листа компоновки.

13. Если нужно, подкорректируйте с помощью инструмента Панорамирова�
ние в реальном времени (Pan Realtime) расположение чертежа.

14. Снова вернитесь в режим ЛИСТ (PAPER). Убедитесь в том, что текущим
является слой Рамка, и заморозьте слой Видовой экран. Итак, мы полу�
чили чертеж, который практически не отличается от того, как выглядел
исходный чертеж (см. рис. 13.1), но теперь рамка и основная надпись
выполнены на листе компоновки в масштабе 1:1 (рис. 13.16).

15. Сохраните текущее состояние чертежа в файле Work131.dwg.

Рис. 13.15  Назначение видовому экрану слоя Видовой экран
с помощью палитры Свойства (Properties)

10. Закройте палитру Свойства (Properties) и нажмите Esc, чтобы отменить
выделение. Видовой экран теперь находится на отдельном слое, и нам
осталось лишь откорректировать масштаб чертежа. Рис. 13.16  Создание элементов оформления чертежа на листе компоновки завершено
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13.2. Создание компоновки13.2. Создание компоновки13.2. Создание компоновки13.2. Создание компоновки13.2. Создание компоновки
с несколькими видовыми экранамис несколькими видовыми экранамис несколькими видовыми экранамис несколькими видовыми экранамис несколькими видовыми экранами
В подавляющем большинстве случаев при создании чертежей применяется
именно такая технология, которая была рассмотрена в начале этой главы – со�
здается компоновка с одним видовым экраном для одного файла чертежа. На
этом листе компоновки создается рамка и основная надпись, а все остальные
элементы печатного листа (то есть собственно чертеж, технические требова�
ния и т. п.) размещаются на листе модели. При этом на практике при создании
сложных чертежей нередко прибегают к использованию внешних ссылок,
вставляя в файл главного чертежа содержимое других чертежей. Однако на
листе компоновки это никак не сказывается – пользователь по�прежнему имеет
дело с одним видовым экраном, занимающим практически всю площадь печат�
ного листа.

Тем не менее, в некоторых случаях удобнее создать на листе компоновки
несколько видовых экранов. Например, перед выводом чертежа большого
формата на графопостроитель конструкторы часто распечатывают небольшой
чертеж на лазерном принтере. На таком рабочем оттиске можно, в частности,
распечатать сразу несколько видов или разместить дополнительные изображе�
ния. Такие задачи проще всего решать с использованием нескольких видовых
экранов, поскольку этот подход позволяет создать необходимую компоновку,
не меняя сам чертеж.

13.2.1. Создание новой компоновки13.2.1. Создание новой компоновки13.2.1. Создание новой компоновки13.2.1. Создание новой компоновки13.2.1. Создание новой компоновки
Давайте создадим новую компоновку для печати рабочего оттиска на листе
формата A3 и разместим на листе этой компоновки не только главный вид и
вид сверху, но и чертеж одного из разрезов.

1. Прежде, чем приступить к собственно созданию новой компоновки, да�
вайте переименуем имеющийся лист компоновки Лист1 (Layout1). Щелк�
ните на ярлычке этого листа правой кнопкой мыши и выберите из по�
явившегося меню команду Переименовать (Rename). В строке Имя
(Name) открывшегося окна Переименование листа (Rename Layout)
введите новое имя листа компоновки, например Ôîðìàò À2 (рис. 13.17),
а затем щелкните на кнопке OK.

2. Введите в командном окне команду Ëèñò (LAYOUT) или просто ë (LO),
а затем введите Óäàëèòü (DELETE) или просто ó (D) для выбора режима
удаления имеющейся компоновки. В ответ на предложение ввести имя
удаляемой компоновки или нажать Enter для удаления текущей компо�
новки Формат A2 введите Ëèñò1 (Layout1). Лист компоновки Лист2
(Layout2) тут же исчезнет, а команда Ëèñò (LAYOUT) завершит работу.

3. Переименуйте слой Рамка на Ðàìêà ôîðìàòà À2 и создайте новый слой
Ðàìêà ôîðìàòà À3. Индекс цвета для нового слоя оставьте назначенным
по умолчанию (116) и сделайте новый слой текущим.

4. Перейдите, если нужно, на лист Формат A2 и выберите из меню команду
Слияние ⇒ Располож ⇒ Мастер компоновки листа (Insert ⇒ Layout ⇒
Create Layout Wizard). Кроме того, мастер создания компоновок можно запу�
стить, введя в командной строке команду Ìàñòåðëèñò (LAYOUTWIZARD)
или выбрав из меню команду Сервис ⇒ Мастера ⇒ Компоновки листа
(Tools ⇒ Wizards ⇒ Create Layout).

5. Введите в первом диалоговом окне мастера название нового листа ком�
поновки, например, Ôîðìàò A3 (рис. 13.18), а затем щелкните на кнопке
Далее (Next).

Рис. 13.17  Диалоговое окно Переименование листа (Rename Layout)

Рис. 13.18  Первое диалоговое окно мастера
Создание листа (Create Layout)

6. В следующем окне мастера нужно выбрать печатающее устройство. Вы�
берите из списка принтер, который позволяет выполнять распечатку на
бумаге формата A3 (297 × 420 мм), например HP LaserJet 5Si/5Si MX PS,
как показано на рис. 13.19, и щелкните на кнопке Далее (Next).

7. В следующем окне мастер Создание листа (Create Layout) предложит вам
выбрать размер бумаги. Выберите из списка формат A3 и щелкните на
кнопке Далее (Next).
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8. Удостоверьтесь в том, что в следующем окне мастера выбран переключа�
тель Альбомная (Landscape), и щелкните на кнопке Далее (Next).

9. Следующее окно мастера Создание листа (Create Layout) позволяет вы�
брать одну из основных надписей, входящих в комплект поставки AutoCAD.
Поскольку ни одна из этих надписей не соответствует требованиям оте�
чественных стандартов, выберите в списке Путь (Path) самый верхний
элемент, называющийся Нет (None), и щелкните на кнопке Далее (Next).

Примечание. При желании пользователь может создать собственные варианты
основной надписи и затем использовать их наравне с вариантами, входящими
в комплект поставки AutoCAD. Например, можно создать основную надпись для
формата A3 и сохранить ее в файле с именем, скажем, ÅÑÊÄ îñíîâíàÿ
íàäïèñü À3.dwg. Если этот файл поместить в папку Системный_диск:\
Documents and Settings\имя пользователя\Local Settings\Application Data\Autodesk\
AutoCAD 2007\R17.0\rus\Template (в английской версии папка rus называется
enu), то в списке стандартных основных надписей соответствующего окна мас�
тера Создание листа (Create Layout) появится новый пункт ЕСКД основная
надпись A3.dwg.

10.  В следующем окне мастера нужно определить количество видовых экра�
нов, которые будут использоваться на листе компоновки, а также их рас�
положение. В группе Способ расположения (Viewport Setup) имеется
четыре переключателя, определяющих количество создаваемых видо�
вых экранов. По умолчанию выбран переключатель Один экран (Single)
для создания одного видового экрана. Если выбрать переключатель Нет
(None), компоновка будет создана вообще без видовых экранов. Пере�
ключатель Конструкторский набор (Std. 3D Engineering View) предназ�

начен для получения классической компоновки с тремя видовыми экра�
нами для представления основных видов трехмерной модели в ортого�
нальных проекциях и одним видовым экраном для представления этой
же модели в аксонометрической проекции. Таким образом, в нашем слу�
чае нужно выбрать переключатель Массив (Array), который позволяет
создавать прямоугольный массив из видовых экранов. Как только вы вы�
берите этот переключатель, станут доступными параметры, располо�
женные в нижней части окна. Уменьшите значение параметра Рядов
(Row) до 1, а остальные оставьте без изменений, как показано на рис. 13.20.
Затем щелкните на кнопке Далее (Next) для продолжения.

Рис. 13.19  Выбор принтера во втором окне
мастера Создание листа (Create Layout)

Рис. 13.20  Определение количества видовых экранов
на создаваемом листе компоновки

11. Предпоследнее окно мастера Создание листа (Create Layout) предназна�
чено для выбора точки размещения двух видовых экранов, определен�
ных на предыдущем шаге, на листе компоновки. Щелкните на кнопке
Положение (Select Location). AutoCAD закроет окно мастера, создаст
новый лист компоновки Формат A3 соответствующего формата и ориен�
тации, а затем предложит в командном окне выбрать первый угол прямо�
угольной области, в которой должны быть размещены оба видовых экрана.
Создайте область, занимающую примерно 2/3 верхней части печатного
листа (рис. 13.21).

12. Как только вы щелкните мышью в точке, которая будет соответствовать
правому нижнему углу показанной на рис. 13.21 прямоугольной области,
AutoCAD автоматически вернется к мастеру Создание листа (Create
Layout) и откроет последнее окно этого мастера. Поскольку никаких па�
раметров в этом окне нет, просто щелкните на кнопке Готово (Finish)
для завершения работы мастера. На созданном листе компоновки Фор�
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мат A3 тут же появятся два видовых экрана, на каждом из которых будут
отображаться чертежи рабочей зоны в автоматически выбранном
AutoCAD масштабе (рис. 13.22).

13. Щелкните правой кнопкой мыши на ярлычке листа Формат A3 и выбери�
те из появившегося контекстного меню команду Диспетчер параметров
листов (Page Setup Manager). Можно также воспользоваться командой
меню Файл ⇒⇒⇒⇒⇒ Диспетчер параметров листов (File ⇒ Page Setup Mana�
ger) или щелкнуть на кнопке  Диспетчер параметров листов (Page
Setup Manager) панели инструментов Листы (Layouts) либо ввести в ко�
мандном окне команду Ïàðàìëèñò (PAGESETUP).

14. Выберите в открывшемся окне Диспетчер параметров листов (Page
Setup Manager) элемент *Формат А3* и щелкните на кнопке Создать
(New) для создания нового набора параметров страницы.

15. В строке Имя (Name) окна Создание набора пареметра листа (New Page
Setup) введите Work132-A3 и щелкните на кнопке OK.

16. Удостоверьтесь в том, что все параметры страницы соответствуют ранее
определенным вами значениям, указанным при создании компоновки
с помощью мастера Создание листа (Create Layout) (рис. 13.23) и щелк�
ните на кнопке Свойства (Properties), которая находится справа от спис�
ка Имя (Name) в группе Принтер/плоттер (Printer/plotter).

17. Выясните с помощью открывшегося окна Редактор параметров плотте�
ра (Plotter Configuration Editor) размер печатаемой области для выбран�

Рис. 13.21  Определение границ прямоугольной области
для размещения видовых экранов на листе компоновки Формат A3

Рис. 13.22  Компоновка Формат A3 с двумя видовыми экранами,
созданная с помощью мастера Создание листа (Create Layout) Рис. 13.23  Набор параметров страницы Work132?A3 для компоновки Формат A3
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ного принтера и выбранного формата (см. рис. 13.8). Например, для
принтера HP LaserJest 5Si/5Si MX PS и формата A3 этот размер составля�
ет 285.6 × 408.7 мм. Запишите где�нибудь эти данные, а затем щелкните на
кнопке Отмена (Cancel) для закрытия окна Редактор параметров плот�
тера (Plotter Configuration Editor) без внесения изменений в конфигура�
цию принтера.

18. Щелкните на кнопке OK для закрытия окна Параметры листа – Формат
A3 (Page Setup – Формат A3).

19. Вернувшись в окно Редактор параметров плоттера (Plotter Configura�
tion Editor), выберите в списке набор Work132�A3 и щелкните на кнопке
Установить (Set Current), чтобы назначить его текущим для компоновки
Формат A3 (рис. 13.24), после чего закройте окно, щелкнув на кнопке
Закрыть (Close).

20. Сохраните текущее состояние чертежа в файле Work132.dwg.

вого угла – значения, которые соответствуют размеру печатаемой облас�
ти. Например, автор для выбранного принтера ввела значения 408.7,
285.6 (нужно учесть ориентацию листа). Поверх штриховой линии,
обозначающей границы печатаемой области, должен появится прямо�
угольник, расположенный на слое Рамка формата А3.

2. Сместите прямоугольник внутрь на 1 мм и удалите исходный прямоуголь�
ник. С помощью команды Ðàñ÷ëåíèòü (EXPLODE) разбейте прямо�
угольник на четыре отрезка, затем сместите левый вертикальный отре�
зок внутрь с помощью команды Ïîäîáèå (OFFSET). Величину смещения
можно рассчитать по уже приводившейся выше формуле: Wpa – 2 × 1 –
(Wf – (5 + 20). Для принтера, выбранного автором, эта величина составит
408.7 – 2 × 1 – (420 – (5 + 20)) = 11.7 мм. После смещения удалите исходную
вертикальную линию.

3. Обрежьте лишние сегменты горизонтальных линий с помощью команды
Îáðåçàòü (TRIM), а затем объедините все четыре полученных отрезка,
образующих рамку, в единую полилинию с помощью режима Çàìêíóòü
(JOIN) команды Ïîëðåä (PEDIT). Не завершая команды Ïîëðåä (PEDIT),
установите с помощью режима Øèðèíà (WIDTH) для созданной полили�
нии ширину всех сегментов, равную 1 мм.

4. Перейдите на лист Формат А2 и удостоверьтесь в том, что включен ре�
жим ЛИСТ (PAPER). Если это не так, переключитесь в режим ЛИСТ
(PAPER), щелкнув на кнопке�индикаторе МОДЕЛЬ (MODEL) панели ин�
струментов или введя в командном окне Ì (PS).

5. Выберите из меню команду Правка ⇒ Копировать с базовой точкой
(Edit ⇒ Copy with Base Point) или просто нажмите Ctrl+Shift+C.

6. Включите режим автоматической привязки, щелкнув на кнопке�индика�
торе Привязка (OSNAP) или нажав F3, и задайте в качестве базовой точ�
ку, которая находится в правом нижнем углу рамки.

7. В ответ на приглашение выбрать объекты щелкните на основной надпи�
си (все ее элементы должны были после вставки сохранятся на листе
компоновки в виде единого блока), а затем нажмите Enter.

8. Вернитесь на лист Формат A3 и выберите из меню команду Правка ⇒ Вста�
вить как блок (Edit ⇒ Paste as Block) или просто нажмите Ctrl+Shift+V.

9. Выберите в качестве точки вставки точку, которая находится в правом
нижнем углу рамки листа Формат A3.

10. На этом создание основной надписи завершено (рис. 13.25).
Изучив полученный результат, можно придти к выводу о том, что основную

часть чертежа (в левой половине листа) лучше всего выделить для размещения
главного вида и вида сверху, а в оставшейся части расположить пару основных
разрезов. Кроме того, имеет смысл перенести технические требования также
на лист компоновки, расположив их над основной надписью. Для этого нам
понадобиться, во�первых, настроить имеющиеся видовые экраны, а во�вторых,
создать два дополнительных видовых экрана.

Рис. 13.24  Набор параметров страницы Work132?A3
назначен текущим для компоновки Формат A3

13.2.2. Создание рамки и основной надписи13.2.2. Создание рамки и основной надписи13.2.2. Создание рамки и основной надписи13.2.2. Создание рамки и основной надписи13.2.2. Создание рамки и основной надписи
на листе компоновкина листе компоновкина листе компоновкина листе компоновкина листе компоновки
Прежде, чем переходить к настройке видовых экранов, нужно создать на листе
компоновки Формат A3 рамку и перенести на него основную надпись.

1. Запустите команду Ïðÿìîóãîëüíèê (RECTANG) и введите в качестве ко�
ординат нижнего левого угла 0,0, а в качестве координат верхнего пра�
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13.2.3. Настройка имеющихся видовых экранов13.2.3. Настройка имеющихся видовых экранов13.2.3. Настройка имеющихся видовых экранов13.2.3. Настройка имеющихся видовых экранов13.2.3. Настройка имеющихся видовых экранов
Для решения поставленной задачи нужно выполнить ряд операций как в режи�
ме Модель (MODEL) на листе компоновки, так и непосредственно на листе
МОДЕЛЬ (MODEL).

1. Для начала переключитесь в режим МОДЕЛЬ (MODEL), щелкнув на
кнопке�индикаторе ЛИСТ (PAPER) в строке состояния или просто введя
в командном окне Ì (MS), и попробуйте поперемещать указатель мыши
по видовым экранам. Как легко заметить, активным является тот видо�
вой экран, в котором в режиме МОДЕЛЬ (MODEL) указатель принимает
форму перекрестия.

Примечание. В режиме МОДЕЛЬ (MODEL) на листе компоновки активным яв�
ляется только какой�то один из имеющихся на листе видовых экранов. Узнать,
какой видовой экран активен, можно как по появляющемуся в момент помеще�
ния на него указателя мыши перекрестию, так и по утолщенной линии границы
этого видового экрана. Все операции, которые вы будете выполнять в режиме
МОДЕЛЬ (MODEL), будут применяться только к объектам, которые отобра�
жаются на активном видовом экране. Для того чтобы назначить активным
другой видовой экран, достаточно переместить на него указатель мыши и щелк�
нуть на этом видовом экране.

2. Вернитесь в режим ЛИСТ (PAPER) и, используя редактирование с по�
мощь маркеров выделения, измените размер левого видового экрана так,
чтобы он занимал по вертикали почти всю левую часть компоновки, ох�
ваченную рамкой (рис. 13.26).

3. Снимите выделение с левого видового экрана, затем щелкните для выделе�
ния правого видового экрана и, используя редактирование с помощью мар�
керов выделения, уменьшите его высоту так, чтобы на нем отображался
лишь вид сверху (рис. 13.27), а затем нажмите Esc для отмены выделения.

Рис. 13.25  Рамка и основная надпись листа компоновки Формат A3 Рис. 13.26  Размер левого видового экрана изменен с использованием режима
Ðàñòÿãèâàíèå (STRETCH) редактирования с помощью маркеров выделения

Рис. 13.27  Размер правого видового экрана также изменен
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4. Переключитесь в режим МОДЕЛЬ (MODEL), щелкните, если нужно, на
левом видовом экране, чтобы сделать его активным, а затем введите в ко�
мандном окне ïî (Z) и режим 0.04xp.

Примечание. Масштабный коэффициент 0.04 соответствует масштабу 1:25,
а не 1:10, как это заявлено в текущей основной надписи. Это объясняется тем,
что мы выполняли чертеж для его размещения на листе формата A2, а не форма�
та A3. К исправлению основной надписи мы вернемся несколько позднее.

5. С помощью инструмента Панорамирование в реальном времени (Pan
Realtime) подкорректируйте расположение чертежа.

6. Переключитесь в режим ЛИСТ (PAPER) и измените высоту левого видо�
вого экрана так, чтобы снизу не были видны технические требования
(рис. 13.28).

текущее состояние чертежа Work133.dwg в файле Work134.dwg. Закрой�
те файл Work134.dwg и снова вернитесь к листу Модель (Model) файла
Work132.dwg.

11. Как вы, наверное, догадались, мы только что подготовили два чертежа,
которые будут использоваться в качестве внешних ссылок. Запустите ко�
манду Âíññûëêè (XREF) (например, введя в командном окне âí (XR) или
ññ (ER)) и с помощью открывшейся палитры Внешние ссылки (External
References) вставьте в чертеж Work132.dwg в качестве внешних ссылок
только что созданные чертежи Work133.dwg и Work134.dwg, разместив
их примерно так, как показано на рис. 13.29.

Рис. 13.28  Вид компоновки Формат A3
после настройки левого видового экрана и корректировки масштаба

7. Перейдите на лист Модель (Model), а затем откройте чертеж, хранящий�
ся в файле Work111.dwg.

8. Заморозьте слои файле Work111.dwg, кроме слоя 0, предварительно на�
значив его текущим, после чего удалите все объекты нулевого слоя.

9. Разморозьте слои Высота 720, Штриховка 720, СБлок Н и СБлок П,
а затем назначьте текущим слой Высота 720, заморозьте слой 0 и сохра�
ните текущее состояние чертежа Work111.dwg в файле Work133.dwg.

10. Разморозьте слой Высота 1090 и Штриховка 1090, назначьте текущим
слой Высота 1090, а остальные слои заморозьте, после чего сохраните

Рис. 13.29  Вид листа Модель (Model) после вставки файлов Work133.dwg и Work134.dwg
в виде внешних ссылок

12. Разморозьте слои Штриховка 1495, Штриховка 1090, Текст 758, Штри�
ховка 720, Штриховка 320 и Штриховка 18. Сместите влево и вправо
обозначения линий сечения всех разрезов на главном виде, как показано
на рис. 13.30, чтобы они не пересекались с размерными линиями (ис�
пользуйте режим ОРТО (ORTHO) и редактирование с помощью марке�
ров выделения в режиме Ïåðåíåñòè (MOVE)).

13. Переместите обозначения линий сечения на слой Размеры и снова замо�
розьте все перечисленные в п. 12 слои.

14. Вернитесь на лист компоновки Формат A3, переключитесь в режим
МОДЕЛЬ (MODEL), щелкните на правом видовом экране, чтобы сделать
его активным и откорректируйте изображение на этом видовом экране
с помощью инструмента Панорамирование в реальном времени (Pan
Realtime) так, чтобы на нем отображался разрез Г–Г, а не вид сверху.
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15. Введите в командном окне ïî (Z) и 0.04xp, чтобы привести чертеж раз�
реза Г–Г к масштабу 1:25.

16. Теперь было бы неплохо выровнять чертеж вида сверху и разреза Г–Г по
горизонтали. Для этого нужно использовать команду Ôîðìàòë (MVSETUP).
Введите ее в командном окне, а затем введите опцию Âûðîâíÿòü
(ALIGN) или просто â (A), для перехода в режим выравнивания.

17. В ответ на запрос выбрать тип выравнивания введите Ãîðèçîíòàëüíîå
(HORIZONTAL) или просто ã (H). AutoCAD предложит выбрать базовую
точку. Щелкните на левом видовом экране, чтобы сделать его активным,
и, включив режим привязки Конточка (Endpoint), выберите точку, кото�
рая находится на чертеже вида сверху в левом верхнем углу рабочей зоны
(рис. 13.31).

18. AutoCAD предложит выбрать точку, которая должна быть расположена
по горизонтали на одном уровне с базовой точкой. Щелкните на правом
видовом экране, чтобы снова вернуться в него, и выберите аналогичную
точку на чертеже разреза Г–Г.

19. Чертеж на правом видовом экране будет смещен так, чтобы располагать�
ся на одной высоте с чертежом вида сверху. Нажмите Esc для заверше�
ния команды Ôîðìàòë (MVSETUP) и, переключившись в режим ЛИСТ
(PAPER), подкорректируйте, если нужно, вертикальный размер правого
видового экрана (рис. 13.32).

Рис. 13.30  Вид листа Модель (Model) после перемещения обозначений разрезов
на главном виде и их переноса на слой Размеры

Рис. 13.31  Выбор базовой точки,
по которой должен быть выровнен чертеж на правом видовом экране

Рис. 13.32  Чертеж с отображением на правом видовом экране разреза Г–Г
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13.2.4. Создание дополнительных видовых экранов13.2.4. Создание дополнительных видовых экранов13.2.4. Создание дополнительных видовых экранов13.2.4. Создание дополнительных видовых экранов13.2.4. Создание дополнительных видовых экранов
Для размещения на листе компоновки разреза Б–Б и технических требований
нужно создать два дополнительных видовых экрана.

1. Выберите из меню команду Вид ⇒ Вдовые экраны ⇒ 2 ВЭкрана (View ⇒
Viewports ⇒ 2 Viewports). AutoCAD предложит выбрать размещение но�
вых видовых экранов. Введите Ãîðèçîíòàëüíîå (HORIZONTAL) или
просто ã (H).

2. В ответ на предложение задать размеры области, которую должны зани�
мать оба видовых экрана, выберите сначала точку, которая должна нахо�
диться в левом верхнем углу этой области, а затем – точку, которая долж�
на находиться в ее правом нижнем углу (рис. 13.33).

5. В нижнем видовом экране разместите текст технических требований,
установив для него масштабный коэффициент 0.1xp. После корректи�
ровки видовых экранов лист компоновки должен выглядеть так, как по�
казано на рис. 13.34.

Рис. 13.33  Определение прямоугольной области,
в которой должны быть размещены два новых видовых экрана

3. Как только вы зададите точку, которая находится в правом нижнем углу
прямоугольной области, AutoCAD создаст два новых видовых экрана. От�
корректируйте их вертикальный размер с помощью маркеров выделе�
ния, уменьшив высоту нижнего экрана примерно в два раза и соответ�
ствующим образом увеличьте высоту верхнего экрана.

4. Самостоятельно настройте изображение на верхнем видовом экране
так, чтобы на нем отображался разрез Б–Б. Откорректируйте его масш�
таб и с помощью команды Ôîðìàòë (MVSETUP) выровняйте разрез Б–Б
по вертикали, используя в качестве базовой точки и точки выравнивания
точки, которые находятся в левом верхнем углу каждого из разрезов.

Рис. 13.34  Лист компоновки Формат A3
после создания и настройки всех видовых экранов

6. Выделите все четыре видовых экрана и переместите их на слой Видовой
экран, а затем заморозьте этот слой.

7. Для завершения нужно откорректировать масштаб в основной надписи.
Поскольку мы ее вставили, как блок, необходимо воспользоваться коман�
дой Ññûëðåä (REFEDIT). Введите эту команду в командном окне.

8. AutoCAD предложит выбрать блок, подлежащий редактированию. Щелк�
ните на любом элементе основной надписи.

9. В появившемся окне Редактирование вхождений (Reference Edit) на
вкладке Информация о ссылке (Identify Reference) будет выделен объект
с автоматически созданным AutoCAD именем, как показано на рис. 13.35
(объект, который находится на верхнем уровне иерархии, – это исход�
ный блок, который находится на листе Формат A2).

10. AutoCAD переключится в режим редактирования блока. Щелкните дваж�
ды на тексте 1:10, который находится в графе Масштаб основной надпи�
си, и введите 25, чтобы текст приобрел вид 1:25.

11. Два раза нажмите Enter для завершения редактирования текста, после
чего щелкните на кнопке Сохранить изменения вхождения (Save Refe�
rence Edits) автоматически появившейся на экране панели инструментов
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Печать чертежа – это, как правило, заключительный этап его разработ�
ки. Конечно, после распечатки в чертеж могут вноситься изменения
(порой довольно существенные), но, все же, распечатка чертежа пред�

ставляет собой определенное логическое завершение какой�то стадии работы
над проектируемым изделием. Поэтому даже для начинающего пользователя
AutoCAD очень важно овладеть базовыми навыками вывода чертежей на пе�
чать. В ранних версиях AutoCAD вывод чертежей на печать, особенно на таких
профессиональных устройствах печати, как графопостроители, или плоттеры
(plotter), представлял собой подчас достаточно нетривиальную задачу. Пользо�
ватели сталкивались как с трудностями при подключении таких устройств пе�
чати к ПК, так и с трудностями при настройке параметров AutoCAD для соб�
ственно печати.

В рассматриваемой версии AutoCAD задача печати на любом устройстве
значительно упростилась. Конечно, распечатку чертежа все еще нельзя на�
звать столь же простой, как и печать документа из текстового процессора, но
все же она вполне по плечу начинающему пользователю с начальным уровнем
подготовки.

Если вы разобрались с методами настройки компоновок и в вашем распоря�
жении имеются нужные устройства печати, изучение этой главы не будет пред�
ставлять для вас особых трудностей. Но даже в том случае, если вы пока еще не
освоились с компоновками и (или) ваш ПК не подключен ни к каким устрой�
ствам печати, все равно постарайтесь выполнить приведенные в этой главе
инструкции, насколько это будет возможно – это поможет вам значительно об�
легчить освоение соответствующих приемов в будущем.

В этой главе мы рассмотрим три варианта печати чертежей на примере
трех подготовленных в главах 11 и 13 чертежей.

Рис. 13.35  Диалоговое окно
Редактирование вхождений (Reference Edit)

РедСсыл (Refedit) или введите в командном окне команду Ññûëçàêð
(REFCLOSE).

12. В появившемся окне предупреждения щелкните на кнопке OK. На этом со�
здание чертежа с несколькими видовыми экранами завершено (рис. 13.36).

13. Сохраните текущее состояние чертежа в файле Work132.dwg.
 В следующей главе вы закрепите навыки работы с видовыми экранами, а так�

же изучите методы вывода подготовленных к распечатке чертежей на печать.

Рис. 13.36  Компоновка Формат A3
с настроенными видовыми экранами и отредактированной основной надписью

14ГГГГГлавалавалавалавалава Печать чертежейПечать чертежейПечать чертежейПечать чертежейПечать чертежей
на принтер и в файлна принтер и в файлна принтер и в файлна принтер и в файлна принтер и в файл



Печать чертежей на принтер и в файлПечать чертежей на принтер и в файлПечать чертежей на принтер и в файлПечать чертежей на принтер и в файлПечать чертежей на принтер и в файл446 447

Печать листа Модель (Model) чертежа Work111.dwg без использования
компоновок на имеющемся принтере с подгонкой чертежа к размерам
листа.
Печать листа компоновки Лист1 (Layout1) чертежа Work131.dwg. Лист
компоновки будет распечатан в масштабе 1:1, а сам распечатанный чер�
теж будет иметь масштаб 1:10.
Печать листа компоновки Формат A3 чертежа Work132.dwg. Лист компо�
новки будет распечатан в масштабе 1:1, а сам распечатанный чертеж бу�
дет иметь масштаб 1:25.

Кроме того, в конце главы мы слегка затронем тему вывод чертежей в файл
и создания электронных чертежей в формате PDF. Это позволит вам, даже не
имея в распоряжении принтера, создать электронную версию печатного лис�
та, а затем распечатать ее на другом ПК, к которому подключено соответствую�
щее устройство печати.

В целом процесс печати чертежей в AutoCAD осуществляется в следующей
последовательности.

1. Подготовка листа файла чертежа, который будет выводиться на печать.
2. Выбор печатающего устройства.
3. Определение ширины линий объектов чертежа.
4. Определение части чертежа, которая должна выводиться на печать.
5. Выбор формата бумаги.
6. Выбор масштаба, ориентации и расположения чертежа на листе.
Все эти операции можно объединить, создав набор параметров страницы

и назначив его соответствующему листу. Именно так мы и поступали в преды�
дущей главе. Те операции, которые были пропущены (например, настройка
ширина линий объектов чертежа), можно выполнить позднее, модифициро�
вав уже имеющийся набор параметров страницы. С другой стороны, при ра�
зовой черновой распечатке чертежа, можно не создавать именованный на�
бор параметров страницы, а просто отправить чертеж на печать с нужными
параметрами.

14.1. Печать чертежа из листа «Модель» (Model)14.1. Печать чертежа из листа «Модель» (Model)14.1. Печать чертежа из листа «Модель» (Model)14.1. Печать чертежа из листа «Модель» (Model)14.1. Печать чертежа из листа «Модель» (Model)
Рассммотрим печать чертежа из листа Модель (Model).

14.1.1. Выбор устройства печати14.1.1. Выбор устройства печати14.1.1. Выбор устройства печати14.1.1. Выбор устройства печати14.1.1. Выбор устройства печати
Для начала мы распечатаем чертеж, который был создан в главе 11, без созда�
ния именованного набора параметров страницы. Этот чертеж был подготов�
лен для печати на принтере с форматом листа A2. Однако мы рассмотрим ситу�
ацию, в которой принтер нужного формата отсутствует. Поэтому печать
чертежа будет осуществляться на принтере формата A4, который, как извест�
но, является наиболее распространенным форматом у обычных офисных
принтеров.

1. Откройте файл Work111.dwg, измените масштаб по границам чертежа,
а затем немного уменьшите его с помощью инструмента Зумирование
в реальном времени (Zoom Realtime) и сохраните текущее состояние чер�
тежа в файле Work141.dwg. Как видно из чертежа (рис. 14.1), его элементы
оформления выполнены прямо на листе Модель (Model). Для распечатки
этого чертежа остается лишь настроить параметры страницы.

Рис. 14.1  Чертеж с элементами оформления, выполненными на листе Модель (Model)

2. Щелкните на кнопке  Печать (Plot) панели инструментов Standard
или выберите из меню команду Файл ⇒ Печать (File ⇒ Plot) либо просто
нажмите Ctrl+P. Для запуска инструмента Печать (Plot) из командного
окна можно также ввести команду Ïå÷àòü (PLOT).

3. Многие из отображающихся на экране параметров печати окна Печать �
Модель (Plot � Model) (рис. 14.2) вам уже знакомы, поскольку с подобным
набором параметров вы уже сталкивались в окнах настройки параметров
страницы, открывающихся с помощью команды Диспетчер параметров
листов (Page Setup Manager) контекстного меню ярлыков Модель (Model)
или Лист (List). Щелкните на круглой кнопке Развернуть окно (More
Options), расположенной в правом нижнем углу окна или нажмите Alt и
клавишу символа «>«.

4. В правой части диалогового окна Печать (Plot) появятся дополнитель�
ные параметры печати, многие из которых вам также уже знакомы по
предыдущей главе (рис. 14.3). По умолчанию в строке Имя (Name) разде�
ла Принтер/плоттер (Printer/plotter) находится элемент Нет (None),
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что означает отсутствие выбранного устройства печати. Раскройте этот
список и выберите из него принтер, подключенный к вашему ПК, или,
если такого принтера нет, любой доступный принтер, поддерживающий
формат A4.

Совет. Если к вашему ПК подключено устройство печати, поддерживающее фор�
мат A2, выберите из списка Имя (Name) именно его – в таком случае вы сможете
распечатать чертеж в масштабе 1:10. Однако учтите, что некоторые из приве�
денных ниже инструкций по настройке параметров чертежа вам выполнять не
нужно.

Примечание. В списке Имя (Name), как видно из рис. 14.4, AutoCAD отображает
два типа печатающих устройств: системные принтеры Windows (традицион�
ные офисные устройства печати, доступные во всех приложениях Windows,
с изображением  принтера на значке) и плоттеры AutoCAD (устройства пе�

чати, доступные только из AutoCAD, с изображением  графопостроителя на
значке).

Системные принтеры устанавливаются с помощью окна Принтеры и фак�
сы, которое открывается с помощью меню Пуск ⇒ Принтеры и факсы. Далее

в этом окне следует выбрать команду Файл ⇒ Установить принтер либо щелк�
нуть на элементе Установка принтера, который находится в разделе Задачи
печати панели специальных задач этого окна (рис. 14.5).

Плоттеры AutoCAD устанавливаются с помощью окна папки Plotters, ко�
торое открывается с помощью команды меню AutoCAD Файл ⇒ Диспетчер
плоттеров (File ⇒ Plotter Manager) или команды командного окна Äèñïïå÷
(PLOTTERMANAGER). Открыв окно, следует щелкнуть дважды на ярлыке Мас�
тер установки плоттеров (Add�A�Plotter Wizard) (рис. 14.6), а затем следовать
указаниям мастера установки плоттеров. Кроме того, запустить этот мастер, не
открывая окна папки Plotters, можно с помощью команды меню AutoCAD Сер�
вис ⇒ Мастера ⇒ Установки плоттеров (Tools ⇒ Wizards ⇒ Add Plotter).

14.1.2. Настройка параметров печати14.1.2. Настройка параметров печати14.1.2. Настройка параметров печати14.1.2. Настройка параметров печати14.1.2. Настройка параметров печати
После выбора устройства печати, параметры окна Печать � Модель (Plot �
Model) изменятся, отображая значения, характерные для выбранного устрой�
ства, например, как показано на рис. 14.7.

В списке Формат (Paper size) выберите нужный формат бумаги (в случае ав�
тора это формат A4, в вашем случае это может быть другой формат, например

Рис. 14.2  Основные параметры диалогового окна Печать (Plot) Рис. 14.3  Диалоговое окно Печать (Plot) с дополнительными параметрами
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A2). Щелкнув на кнопке Свойства (Properties), можно открыть уже знакомое
вам окно Редактор параметров плоттера (Plotter Configuration Editor) с пара�
метрами настройки выбранного принтера, из которых, в частности, можно уз�
нать размер печатаемой области (рис. 13.8).

Совет. Размер печатаемой области можно также узнать из всплывающей под�
сказки, которая появляется, если остановить указатель мыши на 1–2 с на облас�
ти представления образа печатного листа, как показано на рис. 14.7.

Рис. 14.4  Список Имя (Name) диалогового окна Печать (Plot)
с перечнем установленных на ПК автора системных принтеров и плоттеров AutoCAD

Рис. 14.5  Стандартная папка Windows Принтеры и факсы
с перечнем установленных на ПК автора системных принтеров

Рис. 14.6  Папка Plotters в рабочем каталоге автора
с перечнем установленных автором плоттеров AutoCAD

Рис. 14.7  Диалоговое окно Печать ? Модель (Plot > Model) с параметрами,
установленными для выбранного принтера
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Обратите внимание на область Подключение (Where) и флажок Печатать
в файл (Plot to file) группы Принтер/плоттер (Printer/plotter). В области
Подключение (Where) отображается порт, к которому подключено печатаю�
щее устройство – Файл (File), LPT, USB или другой. Порты LPT и USB пред�
ставляют собой физические разъемы, к которым чаще всего подключаются со�
временные печатающие устройства. Что касается порта Файл (File), а также
флажка Печатать в файл (Plot to file), то они позволяют выполнять «печать»,
даже если к ПК не подключено печатающее устройство. Подробнее о печати
в файл мы поговорим в конце главы.

Название параметра Число экземпляров (Number of copies) говорит само за
себя – его значение определяет количество копий распечатываемого чертежа.

Теперь обратите внимание на расположенную над группой Принтер/плот�
тер (Printer/plotter) группу Набор параметров листа (Page setup), в которой
находятся раскрывающийся список Имя (Name) и кнопка Добавить (Add).
Раскрыв список Имя (Name), можно выбрать либо именованный набор пара�
метров печати, созданный ранее, либо элемент <Предыдущая печать>
(<Previous plot>), который соответствует неименованному набору параметров
печати, автоматически сохраненных AutoCAD после последней распечатки
чертежа. Кроме того, из списка Имя (Name) можно выбрать элемент Импорт
(Import), чтобы импортировать набор параметров печати из другого файла
(рис. 14.8). Щелкнув на кнопке Добавить (Add), можно присвоить имя текуще�
му набору параметров печати, не открывая окна Диспетчер параметров лис�
тов (Page Setup Manager). Это имя будет сохранено в файле чертежа и появит�
ся в окне Диспетчер параметров листов (Page Setup Manager) в качестве
имени соответствующего набора параметров печати так, словно вы создали
его с помощью окна Диспетчер параметров листов (Page Setup Manager).

Поскольку в нашем случае распечатка будет идти прямо из листа модели,
оставьте пока что выбранным в списке Имя (Name) группы Набор параметров
листа (Page setup) элемент <Нет> (None).

В группе Масштаб печати (Plot scale), расположенной под группой Прин�
тер/плоттер (Printer/plotter), по умолчанию установлен флажок Вписать (Fit
to paper). Как правило, этот флажок лучше всего сбросить и задать масштаб
чертежа вручную, поскольку AutoCAD в режиме Вписать (Fit to paper) выбира�
ет нестандартны значения масштаба, с которыми трудно работать (например,
1:57.91, как показано на рис. 14.7). Поэтому сбросьте этот флажок и выберите
из списка Масштаб (Scale) масштаб 1:10, если вы будете выполнять печать на
принтере формата A2. Если, следуя примеру автора, вы выбрали принтер фор�
мата A4, тогда введите в строке ед.чертежа (units) значение 25. Значение
в списке Масштаб (Scale) в этом случае автоматически изменится на Польз.
(Custom).

Для того, чтобы увидеть, как будет выглядеть печатный лист при выбран�
ных параметрах, можно щелкнуть на кнопке Просмотр (Preview). Однако сна�
чала убедитесь в том, что в группе Ориентация чертежа (Drawing orientation),
которая находится в правом нижнем углу окна Печать � Модель (Plot � Model),

Рис. 14.8  Импорт наборов параметров страниц с помощью диалогового окна
Импорт наборов параметров листов (Import Page Setups)

выбран переключатель Книжная (Portrait), соответствующий ориентации ли�
ста в нашем случае. Кроме того, введите в группе Смещение от начала (начало
в печатаемой области) (Plot offset (origin set to printable area)), параметры ко�
торой находятся в левом нижнем углу окна Печать – Модель (Plot – Model),
в строках X и Y значение 0.0. Параметры печати к текущему моменту должны
выглядеть так, как показано на рис. 14.9 (если вы настраиваете печать для
принтера формата A4).

Щелкнув на кнопке Просмотр (Preview), вы перейдете в режим предваритель�
ного просмотра, результаты которого, скорее всего, вас озадачат (рис. 14.10).

Щелкните на кнопке  Закрыть окно просмотра (Close Preview Window),
которая находится на панели инструментов окна предварительного просмот�
ра, или просто нажмите Esc либо Enter для возврата к диалоговому окну Пе�
чать � Модель (Plot � Model) и обратите внимание на список Что печатать
(What to plot) группы Печатаемая область (Plot area) (рис. 14.11).

Значение, выбранное в этом списке, используется вместе с значениями па�
раметров группы Cмещение от начала (Plot offset) следующим образом. Если
флажок Центрировать (Center the plot) установлен, чертеж всегда центриру�
ется на листе, а значения параметров X и Y определяются автоматически. Если
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же этот флажок сброшен, тогда значения параметров X и Y определяют распо�
ложение чертежа относительно опорной точки печатаемой области, которую
принтер при позиционировании изображения на печатном листе считает точ�
кой с координатами (0,0). При положительных значениях X чертеж смещается
вправо, а при положительных значениях Y – вверх.

Примечание. Если в свойствах принтера выбрана портретная ориентация бу�
маги, опорная точка будет находиться в левом нижнем углу печатного листа,
а если альбомная – то в левом верхнем углу с соответствующим изменением интер�
претации координат X и Y. Это объясняется тем, что перед печатью с использо�
ванием альбомной ориентации чертеж будет развернут на 90є.

Таким образом, чтобы исправить проблему, показанную на рис. 14.10, доста�
точно установить флажок Центрировать (Center the plot) либо ввести в каче�
стве параметров смещения X и Y значения -130 и 20, соответственно.

Однако лучше всего выбрать из списка Что печатать (What to plot) тот ре�
жим интерпретации листа модели, который является оптимальным для сто�
ящей перед вами задачи. По умолчанию выбран режим Экран (Display), кото�
рый интерпретируется AutoCAD как задание напечатать текущее содержимое
области черчения. В этом случае в опорной точке печатного листа размещает�

ся левый нижний угол области черчения. Сравните рис. 14.10 с рис. 14.1 и вы
поймете, почему при печати в режиме Экран (Display) с установленными нуле�
выми значениями смещения по X и Y мы получили результат, показанный на
рис. 14.10.

Если выбрать режим Рамка (Window), AutoCAD временно закроет окно Пе�
чать � Модель (Plot � Model) и предложит задать прямоугольную область, содер�
жимое которой нужно вывести на печать. После задания такой области вы сно�
ва вернетесь к окну Печать – Модель (Plot – Model). Например, если задать

Рис. 14.9  Параметры страницы перед предварительным просмотром печати

Рис. 14.10  Предварительный просмотр дает неожиданный результат

Рис. 14.11  Список Что печатать (What to plot)
группы Печатаемая область (Plot area)
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прямоугольную область, внутри которой находится большая тумба на чертеже
главного вида, то, установив флажок Вписать (Fit to paper) группы Масштаб
печати (Plot scale) и щелкнув на кнопке Просмотр (Preview), можно получить
результат, показанный на рис. 14.12.

Можно улучшить вид печатного листа, поварьировав значениями рассмот�
ренных выше параметров с учетом особенностей имеющегося в вашем распо�
ряжении принтера.

Теперь обратите внимание на раскрывающийся список, который находится
в группе Таблица стилей печати (Plot style table (pen assignment)), расположен�
ной в правом верхнем углу окна Печать � Модель (Plot � Model). Если вы собира�
етесь печатать на черно�белом принтере, тогда лучше всего выбрать из этого
списка таблицу стилей печати monochrome.ctb, поскольку в противном случае
цветные линии могут при черно�белой печати будут представлены в виде от�
тенков серого, что далеко не всегда удобно (некоторые линии могут стать труд�
но различимыми).

Параметры остальных групп оставьте такими, как показано на рис. 14.9 –
эти значения на первых порах вас, скорее всего, будут вполне устраивать.

В завершение щелкните на кнопке Добавить (Add) группы Набор парамет�
ров листа (Page setup) и присвойте в появившемся окне Добавление наборов
параметров листа (Add Page Setup) текущему набору параметров страницы ка�
кое�нибудь имя, например Work141�A4. Щелкните на кнопке OK окна Добавле�
ние наборов параметров листа (Add Page Setup) для создания именованного
набора параметров страницы, а затем на кнопке Применить к листу (Apply to

Рис. 14.12  Предварительный просмотр печатного листа с фрагментом чертежа

Если вы выберите режим Лимиты (Limits) и щелкните на кнопке Просмотр
(Preview), вы убедитесь в том, что в этом режиме в опорной точке размещается
левый нижний угол границ чертежа, которые, как вы помните, можно визуали�
зировать с помощью сетки. На практике этот режим применяется довольно
редко, поскольку вряд ли вы будете по мере усложнения чертежа помнить
о необходимости постоянного слежения за тем, чтобы границы чертежа соот�
ветствовали его реальному состоянию.

Поэтому выберите из списка Печатаемая область (What to plot) режим Гра�
ницы (Extents) и щелкните на кнопке Просмотр (Preview). Если вы перешли в
режим предварительного просмотра, настраивая принтер формата A2 при пе�
чати в масштабе 1:10, вы увидите изображение печатного листа, близкое к иде�
альному. В случае настройки печати на принтере формата A4 с масштабом 1:25
результат несколько хуже, но все же вполне приемлем (рис. 14.13).

Рис. 14.13  Предварительный просмотр печатного листа
с учетом размера всех отображаемых на нем объектов
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Layout) окна Печать � Модель (Plot � Model) для назначения этого набора листу
Модель (Model). После этого нажмите Esc или щелкните на кнопке Отмена
(Cancel) окна Печать � Модель (Plot � Model) для отмены печати.

14.1.3. Настройка ширины линий и печать чертежа14.1.3. Настройка ширины линий и печать чертежа14.1.3. Настройка ширины линий и печать чертежа14.1.3. Настройка ширины линий и печать чертежа14.1.3. Настройка ширины линий и печать чертежа
Мы не стали пока что выводить чертеж на печать, поскольку нам нужно настро�
ить еще ряд параметров чертежа, которые не имеют непосредственного отно�
шения к параметрам собственно печати. Эти параметры представляют собой
различные значения ширины линий для разных элементов чертежа. Как вы
помните, мы назначили ширину лишь для линий рамки и основной надписи.
Для всех же остальных элементов чертежа мы использовали линии той ширины,
которая задается AutoCAD по умолчанию (рис. 14.14). Естественно, это не толь�
ко противоречит требованиям стандартов, но и ухудшает восприятие чертежа.

сплошная тонкая (S1 = 0.15 мм). Линии типа S1 назначим слою Размеры, а ли�
нии типа S – слоям Вид сверху, Вид спереди и Текст.

1. Закрыв на некоторое время окно Печать � Модель (Plot � Model), открой�
те окно Диспетчер свойств слоев (Layer Properties Manager), например,
щелкнув на одноименной кнопке панели инструментов Слои (Layers).

2. Выберите в окне Диспетчер свойств слоев (Layer Properties Manager)
слои Вид сверху, Вид спереди и Текст (для выбора всех трех слоев на�
жмите Ctrl, щелкните поочередно на каждом из слоев, а затем отпустите
Ctrl).

3. Щелкните на слове По умолчанию (Default) в столбце Вес линий
(Lineweight) для любого из трех выделенных слоев.

4. В появившемся окне Вес линий (Lineweight) выберите значение шири�
ны линии 0.3 мм (рис. 4.15), а затем щелкните на кнопке OK. Всем вы�
бранным слоям будет назначена ширина 0.3 мм.

Рис. 14.14  В режиме предварительного просмотра видно,
что почти все линии чертежа имеют одинаковую ширину

Поэтому давайте займемся настройкой ширины линий и назначения их
объектам чертежа.

В учебных целях мы будем использовать для объектов чертежа три основ�
ных типа ширины линий: сплошная широкая основная (текущая, S = 0.3 мм) и

Рис. 14.15  Определение новой ширины линий для выделенных слоев

5. Используя те же операции, назначьте слою Размеры ширину линии 0.15 мм.
6. Закройте диалоговое окно Диспетчер свойств слоев (Layer Properties

Manager) и щелкните на кнопке Печать (Plot) панели инструментов
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Standard или нажмите Ctrl+P для открытия диалогового окна Печать –
Модель (Plot – Model).

7. Щелкните на кнопке Просмотр (Preview) и убедитесь в режиме предва�
рительного просмотра в том, что ширина линий изменилась (рис. 14.16).

1. Сохраните только что распечатанный чертеж в файле Work141.dwg и
закройте его.

2. Откройте файл Work131.dwg, перейдите на лист Лист1 (Layout1) и со�
храните файл под именем Work142.dwg.

3. Щелкните на кнопке Печать (Plot) или нажмите Ctrl+P. В открывшемся
окне установите параметры так, как показано на рис. 14.17, после чего
щелкните на кнопке Применить к листу (Apply to Layout). Обратите
внимание на то, что в списке Что печатать (What to plot) вместо элемен�
та Лимиты (Limits) появился элемент Лист (Layout), который при печа�
ти из листа компоновки всегда является выбранным по умолчанию.

Рис. 14.16  Размерные и основные линии имеют разную толщину

Если полученный результат вас устраивает, а к вашему ПК подключен прин�
тер, можете щелкнуть на кнопке Печать (Plot) окна предварительного про�
смотра или вернуться в окно Печать � Модель (Plot � Model) и отправить чер�
теж на печать, щелкнув на кнопке OK этого окна.

Совет. Если ваш ПК не подключен к принтеру, вы все равно можете выполнить
печать, установив флажок Печатать в файл (Plot to file) группы Принтер/
плоттер (Printer/plotter). На запрос AutoCAD задать имя файла согласитесь
с именем Work141�Model.plt, предложенным по умолчанию. О том, что делать
дальше с полученным файлом, мы поговорим в последнем разделе этой главы.

14.2. Печать чертежа из листа компоновки14.2. Печать чертежа из листа компоновки14.2. Печать чертежа из листа компоновки14.2. Печать чертежа из листа компоновки14.2. Печать чертежа из листа компоновки
Печать чертежа из листа компоновки, в отличие от печати из листа макета,
выполняется гораздо проще (конечно, при условии, что вы заранее настроили
компоновку и назначили ей набор параметров страницы).

Рис. 14.17  Диалоговое окно Печать – Лист1 (Plot – Layout1)
 для печати на графопостроителе формата A2

4. Закройте окно Печать – Лист1 (Plot � Layout1) щелчком на кнопке Отме�
на (Cancel), а затем настройте толщины линий, как вы это делали для
предыдущего чертежа. В этот раз для основной сплошной линии задайте
ширину 0.5 мм, а для основной тонкой – ширину 0.25 мм.

5. Убедитесь в режиме предварительного просмотра в том, что ширина
линий изменилась, а затем распечатайте чертеж на графопостроителе
или, если данной модели в вашем распоряжении нет, в файл Work142�
Layout1.plt, установив для этого флажок Печатать в файл (Plot to file).
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6. Сохраните текущее состояние чертежа в файле Work142.dwg и закрой�
те его, а затем откройте файл Work132.dwg и сохраните его в файле
Work143.dwg.

7. Самостоятельно настройте все параметры печати для листа компоновки
Формат A3 и выполните его печать на принтер формата A3 или в файл
Work143�Формат A3.plt.

8. Сохраните текущее состояние чертежа в файле Work143.dwg.
Если вы имеете возможность действительно распечатывать чертежи на

принтере или графопостроителе, дождитесь завершения печати и изучите по�
лученные распечатки чтобы, в случае необходимости, внести коррективы
в чертежи, компоновки или параметры печати.

В том случае, если вы не имеете в своем распоряжении описанных в этой и
предыдущей главах печатающих устройств, вы можете, как было указано выше,
выполнить печать в файл. В заключение этой главы мы вкратце рассмотрим
основные принципы печати в файл.

14.3. Печать чертежей в файл14.3. Печать чертежей в файл14.3. Печать чертежей в файл14.3. Печать чертежей в файл14.3. Печать чертежей в файл
Как отмечалось в начале этой главы, печатающее устройство может быть под�
ключено к виртуальному порту ФАЙЛ (FILE). В этом случае все чертежи, кото�
рые вы отправляете на это устройство, будут не распечатываться, а выводиться
в файл на диске.

Для направления печати в файл для системного принтера Windows нужно
открыть папку Принтеры и факсы (см. рис. 14.5), найти в ней нужный прин�
тер и, щелкнув на нем правой кнопкой мыши, выбрать из контекстного меню
команду Свойства. Затем в диалоговом окне свойств принтера следует перейти
на вкладку Порты и установить флажок ФАЙЛ (FILE), после чего закрыть
окно свойств щелчком на кнопке OK (рис. 14.18). С этого момента все задания,
которые будут отправляться с вашего ПК на этот принтер, будут представлять�
ся на диске файлами с расширением PRN (AutoCAD по умолчанию использует
расширение PLT).

Для направления печати в файл для плоттера AutoCAD нужно открыть пап�
ку Plotters (см. рис. 14.6), найти в ней нужный плоттер и щелкнуть дважды на
его значке. Затем в открывшемся окне Редактор параметров плоттера (Plotter
Configuration Editor) следует перейти на вкладку Порты (Ports) и выбрать на
ней переключатель Выход в файл (Plot to File) (рис. 14.19).

Совет. Доступ к вкладке Порты (Ports) окна Редактор параметров плоттера
(Plotter Configuration Editor) можно также получить, щелкнув на кнопке Свой�
ства (Properties) окна Печать (Plot) (см. рис. 14.7). Хотя с помощью этой вклад�
ки переназначить печать в файл можно и для системных принтеров Windows,
все же лучше порты последних переназначать с помощью вкладки Порты окна
свойств, а не вкладки Порты (Ports) окна Редактор параметров плоттера
(Plotter Configuration Editor).

Рис. 14.18  Назначение печати в файл
для системного принтера Windows

Рис. 14.19  Назначение печати в файл для плоттера AutoCAD
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Кроме того, как вы уже, наверное, поняли, для разового направления печа�
ти в файл можно установит флажок Выход в файл (Plot to File) диалогового
окна Печать (Plot).

Полученные в результате файлы с расширением PLT можно впоследствии
распечатать на соответствующем печатающем устройстве, воспользовавшись
следующей командой, которую следует ввести в окне командной строки (Пуск ⇒
Все программы ⇒ Стандартные ⇒ Командная строка)

Copy /b èìÿ_ôàéëà.plt > ïîðò
Здесь порт представляет имя порта MS DOS (PRN, LPT1, USB0001 и т. п.).

Однако такое использование файлов печати (то есть файлы с расширением
PLT) сегодня является, скорее, анахронизмом и может иметь практический
интерес лишь в очень редких ситуациях. Гораздо важнее то, что файлы печати
могут иметь разное содержимое. Файлы печати, созданные плоттерами
AutoCAD, представляют собой набор команд для управления перьями графопо�
строителя. С таким файлами сделать ничего нельзя, кроме как направить на
печать из окна командной строки указанным выше способом, если такая воз�
можность была предусмотрена разработчиками графопостроителя.

Рис. 14.20  Чертежи, созданные в этой главе,
напечатаны в файл, преобразованы в PDF>формат с помощью Adobe Distiller

и объединены в один PDF>файл с помощью программы Adobe Acrobat
Рис. 14.21  Чертеж в PDF>формате, созданный непосредственно из AutoCAD

с помощью виртуального плоттера DWG to PDF AutoCAD

Файлы печати, созданные системными принтерами Windows, которые под�
держивают язык PostScript (как правило, в названиях таких принтеров присут�
ствует аббревиатура PS или название PostScript), можно импортировать в другие
приложения, например, в CorelDRAW, а также обработать с помощью популяр�
ного приложения Acrobat Distiller. В последнем случае из PLT�файла Acrobat
Distiller создаст файл в формате PDF, который сегодня является стандартным
форматом для обмена информацией и распространения ее через Интернет.

Затем полученные PDF�файлы можно передавать для просмотра другим
пользователям, публиковать в Интернет, экспортировать в различные растро�
вые форматы и даже объединять в один файл (рис. 14.20).

Совет. Если для вас актуальна проблема создания PDF�файлов из чертежей, ос�
войте методы настройки плоттера AutoCAD DWG to PDF.pc3 (см. рис. 14.4 и
14.6). С помощью этого виртуального плоттера создание PDF�файла из любого
чертежа займет у вас считанные секунды (рис. 14.21).

На этом автор завершает эту книгу, желая вам дальнейших успехов в само�
стоятельном изучении AutoCAD. Автор надеется, что время, потраченное вами
на изучение рассмотренных в книге вопросов, в самом ближайшем будущем
окупится вам сторицей.

Печать чертежей в файлПечать чертежей в файлПечать чертежей в файлПечать чертежей в файлПечать чертежей в файл



467

Рис. А.1  Запуск AutoCAD 2008

А.1. Первый запуск AutoCAD 2008А.1. Первый запуск AutoCAD 2008А.1. Первый запуск AutoCAD 2008А.1. Первый запуск AutoCAD 2008А.1. Первый запуск AutoCAD 2008
При установке приложения AutoCAD в стандартной конфигурации для его за�
пуска достаточно выбрать команду Пуск ⇒  ⇒  ⇒  ⇒  ⇒ Все программы ⇒  ⇒  ⇒  ⇒  ⇒ Autodesk ⇒ ⇒ ⇒ ⇒ ⇒
AutoCAD 2008 – Русский ⇒  ⇒  ⇒  ⇒  ⇒ AutoCAD 2008 (рис. А.1.). Если же при установке на
вашем ПК стандартная конфигурация AutoCAD 2008 была изменена, найдите
значок AutoCAD 2008 самостоятельно, а затем запустите программу, как любое
другое приложение Windows XP.

При первом запуске AutoCAD 2008 появляется окно Семинар по новым воз�
можностям (New Features Workshop) (рис. А.2), с помощью которого можно
ознакомиться с новыми возможностями AutoCAD 2008 по сравнению с преды�
дущими версиями. Выберите в этом окне переключатель Больше не предла�
гать (No, don’t show me this again), чтобы это окно больше не появлялось (если
у вас возникнет такая необходимость, вы всегда сможете ознакомиться с но�
винками, выбрав из меню AutoCAD команду Справка ⇒  ⇒  ⇒  ⇒  ⇒ Новые возможности
(Help ⇒ New Features Workshop)).

Затем AutoCAD выполнит настройку рабочего пространства (по умолчанию
используется рабочее пространство 2D Рисование и аннотации (2D Drafting &
Annotation)), после чего на экране появится окно AutoCAD 2008, которые спе�
циалисты называют также графическим пользовательским интерфейсом (GUI —
graphical user interface).

Как и в AutoCAD 2007, в AutoCAD 2008 используются рабочие пространства
(workspace) — удобный инструмент, который опытные пользователи AutoCAD
применяют для быстрой настройки всех параметров своего экземпляра
AutoCAD, включая файлы чертежей. Однако, в отличие от AutoCAD 2007, в
AutoCAD 2008 имеется не два, а три стандартных рабочих пространства: 2D

АПриложениеПриложениеПриложениеПриложениеПриложение
Основы работы вОсновы работы вОсновы работы вОсновы работы вОсновы работы в
AutoCAD 2008AutoCAD 2008AutoCAD 2008AutoCAD 2008AutoCAD 2008

Рис. А.2  Окно Семинар по новым возможностям (New Features Workshop)

Рисование и аннотации (2D Drafting & Annotation), 3D моделирование (3D
Modeling) и Классический AutoCAD (AutoCAD Classic). Поскольку мы в этой

Первый запуск AutoCAD 2008Первый запуск AutoCAD 2008Первый запуск AutoCAD 2008Первый запуск AutoCAD 2008Первый запуск AutoCAD 2008
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(Format), Сервис (Tools), Рисование (Draw), Размеры (Dimension), Редакти�
ровать (Modify) и Express). Под системой меню в классическом рабочем про�
странстве расположены панели инструментов Стандартная (Standard), Стили
(Styles), Рабочие пространства (Workspaces), Слои (Layers), Свойства
(Properties). Практически все кнопки этих панелей, кроме нескольких кнопок
панели Стандартная (Standard), начинающему пользователю AutoCAD будут
незнакомы. Именно изучению инструментов и команд AutoCAD, представлен�
ных кнопками этих и других панелей инструментов, строго говоря, и посвяще�
на данная книга. Поэтому сейчас мы не будем на них останавливаться, посколь�
ку каждый из основных инструментов черчения AutoCAD описывается в главах
книги по мере изучения материала.

У левой и правой границ экрана AutoCAD отображаются еще три панели
инструментов: слева — Рисование (Draw), а справа Редактировать (Modify) и
Порядок прорисовки (Draw Order) (небольшая панель с четырьмя кнопками,
находящаяся ниже панели Редактировать (Modify)). Это обычные панели ин�
струментов, которые по умолчанию располагаются не по горизонтали, а по
вертикали. А вот крупный объект, закрывающий черную область в центре экра�
на, — это панель палитр инструментов (tool palettes). Палитры инструментов —
это очень удобные средства, но предназначены они, прежде всего, для опыт�
ных пользователей AutoCAD. В нашем же случае эта панель представляет собой
избыточное средство, которое лишь загромождает экран. Поэтому щелкните
на кнопке закрытия панели ПАЛИТРЫ ИНСТРУМЕНТОВ (TOOL
PALETTES) для ее отключения.

Теперь посреди экрана вы видите черную пустую область. Эта область в
AutoCAD называется областью черчения (drawing area). Указатель мыши, попадая
в эту область при перемещении по экрану, принимает форму указателя�перекрес�
тия (crosshair cursor), как показано на рис. А.3. При использовании некоторых
команд AutoCAD указатель может принимать и другие формы, в зависимости
от назначения команды и этапа ее выполнения.

Кроме того, в окне AutoCAD 2008, как и в любом другом окне приложения
Windows, могут отображаться полосы прокрутки. В общем случае использовать
полосы прокрутки в AutoCAD не рекомендуется, поскольку они не только ме�
нее удобны, чем инструменты масштабирования и панорамирования AutoCAD,
но еще и занимают место в области черчения. Поэтому сейчас мы отключим
отображение полос прокрутки, а также заодно изменим цвет области черче�
ния. Эти и другие операции настройки интерфейса AutoCAD выполняются с
помощью диалогового окна Настройка (Options), которое вы будете очень час�
то использовать в работе.

1. Выберите из меню команду Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Настройка (Tools ⇒ Options). От�
кроется диалоговое окно Настройка (Options), показанное на рис. А.4,
которое содержит десять вкладок.

2. Перейдите в окне Настройка (Options) на вкладку Экран (Display), на ко�
торой представлены параметры, управляющие отображением элемен�
тов графического интерфейса AutoCAD (рис. А.5).

книге будем работать с классическими средствами AutoCAD, выберите из спис�
ка панели инструментов Рабочие пространства (Workspaces) рабочее про�
странство Классический AutoCAD (AutoCAD Classic), после чего окно
AutoCAD приобретет вид, показанный на рис. А.3.

А.2. Основные элементы классического интерфейсаА.2. Основные элементы классического интерфейсаА.2. Основные элементы классического интерфейсаА.2. Основные элементы классического интерфейсаА.2. Основные элементы классического интерфейса
AutoCAD и его настройкаAutoCAD и его настройкаAutoCAD и его настройкаAutoCAD и его настройкаAutoCAD и его настройка
Основные элементы окна AutoCAD 2008 (строка заголовка, система меню и панели
инструментов) полностью аналогичны соответствующим элементам любого со�
временного приложения для Windows. Так, в  строке заголовка отображаются
имя активного приложения AutoCAD 2008 и имя текущего файла чертежа
Чертеж1.dwg (Drawing1.dwg). Система меню также должна быть знакома лю�
бому пользователю Windows. В частности, несколько меню (Файл (File), Прав�
ка (Edit), Вид (View), Окно (Window) и Справка (Help)) присутствуют практи�
чески во всех системах меню Windows, хотя указанные меню в AutoCAD
содержат ряд дополнительных команд. Кроме того, в систему меню AutoCAD
входят меню, специфичные только для AutoCAD (Вставка (Insert), Формат

Рис. А.3  Окно AutoCAD 2008 с классическим пользовательским интерфейсом
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строке значение 100 (или просто переместите бегунок право до конца). В
этом случае линии перекрестия будут уходить за границы экрана. Многие
опытные пользователи AutoCAD (в том числе и автор) считают, что так с
указателем�перекрестием работать удобнее, чем при размере, установ�
ленным по умолчанию.

5. Теперь щелкните на кнопке Цвета (Colors), расположенной в нижней
части группы Элементы окна (Window Elements). В открывшемся диало�
говом окне Цветовая гамма окна чертежа (Drawing Window Colors) вы�
берите в списке Контекст (Context) элемент Пространство 2D модели
(2D model space), а в списке Элемент интерфейса (Interface Element) —
элемент Однородный фон (Uniform background). Затем раскройте спи�
сок Цвет (Color) и выберите из него цвет Белый (White). Область про�
смотра Образец (Preview) окна Цветовая гамма окна чертежа (Drawing
Window Colors) примет вид, показанный на рис. А.6.

6. Щелкните на кнопке Принять (Apply & Close) для закрытия окна Цвето�
вая гамма окна чертежа (Drawing Window Colors), а затем на кнопке OK
диалогового окна Настройка (Options).

Теперь цвет области черчения окна AutoCAD изменился на белый, а цвет
указателя�перекрестия — на черный (AutoCAD автоматически подбирает цвет
указателя так, чтобы он был хорошо виден на фоне цвета, выбранного пользо�
вателем для области черчения). Кроме того, если вы установили максимальный
размер для указателя�перекрестия, эти изменения вы также легко заметите.

Теперь давайте рассмотрим другие элементы окна AutoCAD. Во�первых, в
нижнем левом углу окна области черчения отображается пиктограмма с двумя
стрелками. Эта пиктограмма называется ПСК (пользовательская система коор�
динат) и используется для обозначения положительных направлений осей ко�

Рис. А.4  Вкладка Файлы (Files) диалогового окна Настройка (Options)

Рис. А.5  Вкладка Экран (Display) диалогового окна Настройка (Options)

3. Если в группе Элементы окна (Window Elements) установлен флажок
Полосы прокрутки (Display scroll bars in drawing window), как показано
на рис. А.5, щелкните на нем для его сброса и отключения соответствую�
щего режима. Не спешите щелкать на кнопке OK — настройку интерфей�
са мы еще не закончили.

4. Найдите в левом нижнем углу вкладки строку ввода Размер перекрестья
(Crosshair size). Если вы хотите, чтобы экран вашего ПК при изучении
этой книги выглядел точно так же, как и экран автора, введите в этой Рис. А.6  Диалоговое окно Цветовая гамма окна чертежа (Drawing Window Colors)
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пользователям создают дополнительные трудности в освоении базовых при�
емов черчения.

Поэтому давайте их отключим, чтобы вы не испытывали затруднений при
дальнейшей работе с книгой.

1. Если кнопки�индикаторы ДПСК (DUCS) и (или) ДИН (DYN) находятся в
нажатом положении, щелкните на них, чтобы выключить соответствую�
щие режимы.

2. Щелкните на кнопке раскрытия меню строки состояния, которая нахо�
дится в этой строке правее области уведомлений (рис. А.8).

3. Выберите из меню элемент Динамическая ПСК (F6) (Dynamic UCS
(F6)). AutoCAD закроет меню и, отключив отображение кнопки ДПСК
(DUCS), перерисует строку состояния.

4. Снова откройте меню строки состояния и проделайте аналогичную опе�
рацию с элементом Динамический ввод (F12) (Dynamic Input (F12)).

5. Обратите внимание на другие значки и индикаторы, представленные ря�
дом с областью уведомлений и непосредственно в этой области уведомле�
ний. Три из них относятся к работе с аннотированными объектами
(annotations) — нововведением AutoCAD 2008, которое в данной книге
также не используется. Поэтому откройте меню строки состояния, как
показано на рис. А.8, и отключите элементы Масштаб аннотаций
(Annotation Scale), Видимость аннотаций (Annotation Visibility) и Авто�
масштабирование (AutoScale).

6. Снова откройте меню строки состояния, как показано на рис. А.8, и выбе�
рите из него элемент Настройка области уведомлений (Tray Settings). В
открывшемся одноименном диалоговом окне сбросьте флажок Показы�
вать значки служб (Display icons from services) и щелкните на кнопке OK
для закрытия диалогового окна Настройка области уведомлений (Tray
Settings).

7. Нам осталось настроить инструмент  Коммуникационный центр
(Communication Center), который постоянно будет уведомлять вас о не�
возможности установки связи с Интернетом (или, что еще хуже, устанав�
ливать такую связь и проверять наличие обновлений и выполнять про�
чие операции без вашего ведома). Поэтому лучше его также отключить.
Щелкните на значке Коммуникационный центр
(Communication Center) панели инструментов Ин�
фоцентр (InfoCenter), которая находится справа в
строке заголовка окна AutoCAD.

8. В нижней части открывшегося меню Коммуника�
ционный центр (Communication Center) щелкните
на кнопке Параметры (Settings).

Рис. А.8  Меню строки состояния (сравните с рис. А.7). Отображе!
ние кнопки!индикатора ДПСК (DUCS) уже отключено, на очереди —
отключение отображения кнопки!индикатора ДИН (DYN)

ординат X и Y. Для работы с этой книгой пиктограмма ПСК практически не
нужна, поэтому в основном материале книги вы узнаете, как ее отключить.

Во�вторых, под пиктограммой ПСК находятся ярлычки листов модели Мо�
дель (Model) и листов компоновок Лист1 (Layout1) и Лист2 (Layout2). Эти яр�
лычки используются для быстрого переключения между режимами работы в
пространстве модели (model space) и в пространстве листа (paper space). Подроб�
нее о том, что такое компоновки и чем они отличаются от модели, также рас�
сказывается в основном материале книги.

Третий по порядку (но не по важности) элемент окна AutoCAD 2008, — это
командное окно (рис. А.7).

Рис. А.7  Командное окно и строка состояния AutoCAD 2008

Командное окно (command window) — это, без преувеличения, «сердце»
AutoCAD. В этом окне пользователь может вводить команды, а также задавать
их параметры. Кроме того, в командном окне выводится информация о выпол�
няемых AutoCAD операциях. Значимость командного окна очень высока, по�
скольку все команды меню и кнопки панелей инструментов представляют со�
бой, по сути, лишь «надстройку» над командами AutoCAD, которые изначально
предназначались для ввода в командном окне. Кроме того, существуют некото�
рые команды, которые можно ввести только в командном окне. Поэтому автор
советует вам уделить самое пристальное внимание изучению методов работы с
этим элементом интерфейса AutoCAD. Подробнее о настройке командного
окна мы поговорим далее в этом приложении.

Под командным окном расположена строка состояния (status bar). В отличие
от других приложений, в которых строка состояния используется от случая к
случаю, в AutoCAD этот элемент интерфейса применяется очень активно. Во�
первых, в строке состояния отображаются текущие координаты указателя�пере�
крестия. Во�вторых, с помощью находящихся на ней кнопок�индикаторов мож�
но быстро включать и отключать соответствующие режимы работы AutoCAD.
Для начинающего пользователя AutoCAD очень важны такие индикаторы, как
ШАГ (SNAP), СЕТКА (GRID), ОРТО (ORTHO) и ПРИВЯЗКА (OSNAP), по�
скольку с помощью соответствующих режимов можно быстро научиться созда�
вать точные чертежи. Кроме того, вам могут пригодиться такие кнопки�инди�
каторы, как ОТС�ПОЛЯР (POLAR), ОТС�ОБЪЕКТ (OTRACK), ВЕС (LWT) и
МОДЕЛЬ (MODEL), поэтому они также рассматриваются в этой книге. Что
касается кнопок�индикаторов ДПСК (DUCS) и ДИН (DYN), то они нам не по�
надобятся. Индикатор ДПСК (DUCS) предназначен для использования режи�
ма динамической ПСК (DUCS — dynamic user coordinate system), которые исполь�
зуется только при трехмерном моделировании, а индикатор ДИН (DYN) — для
включения режима динамических подсказок, которые многим начинающим
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Рис. А.10  Окно AutoCAD после настройки параметров строки состояния

командного окна. Когда указатель приобретет форму двух параллельных отрез�
ков, сверху и снизу над которыми находятся направленные вверх и вниз верти�
кальные стрелки, нажмите левую кнопку мыши и переместите указатель в нуж�
ном направлении на высоту нескольких строк текста. Добившись
необходимого вам положения границы, отпустите кнопку мыши. После завер�
шения работы AutoCAD состояние командного окна будет сохранено и при сле�
дующем запуске AutoCAD размер командного окна окажется таким, каким он
был установлен во время предыдущего сеанса работы.

Как уже говорилось выше, командное окно — это исключительно важный
элемент интерфейса AutoCAD. Именно в нем пользователь отдает команды
AutoCAD и получает от AutoCAD нужную ему информацию. Например, открыть
упоминавшееся выше диалоговое окно Настройка (Options) можно, не только
выбрав из меню команду Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Настройка (Tools ⇒ Options), но и введя в
командном окне команду Íàñòðîéêà (OPTIONS). Для этого достаточно на�
брать команду с клавиатуры (соблюдать регистр необязательно) и нажать
Enter. AutoCAD автоматически распознает ввод с клавиатуры и отобразит вве�
денную вами команду в командном окне, а затем откроет диалоговое окно На�
стройка (Options). Закрыв окно Настройка (Options) щелчком на кнопке
Cancel или простым нажатием Esc, попробуйте открыть его снова с помощью

9. В разделе Общие (General) открывшегося диалогового окна Параметры
Инфоцентра (InfoCenter Settings) (рис. А.9) выберите в верхнем списке
регион вашего проживания, нижнем — элемент Бессрочная (Never).

10. Перейдите в подраздел Всплывающие уведомления (Balloon
Notification) раздела Коммуникационный центр (Communication
Center) и сбросьте флажок Разрешить уведомления для (Enable balloon
notification for).

11. Перейдите в подраздел RSS�каналы (RSS Feeds) этого же раздела, выде�
лите все установленные по умолчанию RSS�ленты, и щелкните на кнопке
Удалить (Remove). Щелкните на кнопке Да появившегося диалогового
окна подтверждения.

12. Щелкните на кнопке OK диалогового окна Параметры Инфоцентра
(InfoCenter Settings).

Теперь окно AutoCAD должно приобрести вид, показанный на рис. А.10.
В завершение обсуждения основных элементов окна AutoCAD можно упомя�

нуть о кнопке  Очистить экран (Clear Screen), которая находится в строке
состояния (см. рис. А.10) у правой границы окна AutoCAD. Щелкнув на этой
кнопке, вы перейдете в полноэкранный режим работы AutoCAD с автоматичес�
ким сокрытием всех панелей инструментов и строки заголовка. Это позволяет
обеспечить максимальное использование экрана дисплея, что бывает доста�
точно удобным при работе со сложными чертежами. Повторный щелчок на
кнопке Очистить экран (Clear Screen) приводит к возврату в исходный режим
отображения окна AutoCAD.

А.3. Командное окноА.3. Командное окноА.3. Командное окноА.3. Командное окноА.3. Командное окно
Командное окно не зависит от других элементов области черчения, поэтому
его можно перемещать в любое место экрана, а также изменять размер. В част�
ности, для того чтобы увеличить высоту командного окна, следует подвести
указатель мыши к горизонтальной границе, отделяющей область черчения от

Рис. А.9  Диалоговое окно Параметры Инфоцентра (Configurations Settings)

Командное окноКомандное окноКомандное окноКомандное окноКомандное окно
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Остальные меню содержат чаще всего используемые команды AutoCAD. Да�
вайте вкратце рассмотрим назначение команд каждого из меню AutoCAD.
� Меню Вставка (Insert) содержит команды вставки чертежей и рисунков

(в том числе созданных в других программах) или их фрагментов в теку�
щий чертеж.
� Меню Формат (Format) содержит команды настройки общих парамет�

ров чертежа.
� Меню Сервис (Tools) содержит специальные команды, которые не отно�

сятся ни к одной из других категорий, например, для программирования
работы AutoCAD с помощью макросов.
� Меню Рисование (Draw) содержит все основные команды, обеспечиваю�

щие создание новых объектов чертежа (линий, окружностей, много�
угольников и т.д.).
� Меню Размеры (Dimension) содержит команды для нанесения размеров

на текущем чертеже.
� Меню Редактировать (Modify) содержит команды, которые, как и ко�

манды меню Рисование (Draw), используются чаще других команд
AutoCAD, поскольку они предназначены для внесения изменений в
объекты текущего чертежа.
� Меню Express содержит команды вызова пакета Express Tools. (Этот па�

кет является устаревшим и включается в поставку AutoCAD только для
тех пользователей, которые к нему привыкли. При установке с парамет�
рами по умолчанию этого меню и, соответственно, инструментов пакета
Express Tools, в системе меню AutoCAD может и не быть.)

А.5. Панели инструментовА.5. Панели инструментовА.5. Панели инструментовА.5. Панели инструментовА.5. Панели инструментов
Как уже отмечалось выше, по умолчанию в окне AutoCAD отображается не�
сколько панелей инструментов (toolbar). Однако это только вершина айсберга —
всего в AutoCAD 2008 имеется 37 панелей инструментов, на многих из которых
насчитывается не один десяток кнопок. Для того чтобы увидеть список всех
панелей инструментов, достаточно щелкнуть на любой панели инструментов
правой кнопкой мыши. На экране появится контекстное меню, представляю�
щее собой полный список панелей инструментов AutoCAD (рис. А.11).

Те панели инструментов, которые на момент открытия списка отображают�
ся в окне AutoCAD, помечены в списке «галочкой». Если щелкнуть на помечен�
ном элементе списка, контекстное меню закроется, а соответствующая панель
инструментов перестанет отображаться в окне AutoCAD. Для включения ото�
бражения панели нужно снова открыть это контекстное меню, щелкнув правой
кнопкой мыши на любой из оставшихся панелей инструментов, и выбрать из
списка панель, рядом с названием которой нет «галочки».

Кроме того, любая панель инструментов AutoCAD может быть как пристыко�
ванной (docked toolbar), так и плавающей (floating toolbar). Пристыкованными
называются панели инструментов, которые прикреплены к одной из границ

команды меню Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Настройка (Tools ⇒ Options) и понаблюдайте при
этом за командным окном. Если размер окна равен как минимум трем строкам,
вы увидите, что в нем промелькнет команда _options. Это означает, что при
использовании команд меню и панелей инструментов AutoCAD все равно авто�
матически вводит за вас в командном окне соответствующие команды.

Поэтому автор настоятельно рекомендует всем начинающим пользовате�
лям выработать привычку, которая заключается в постоянном наблюдении за
тем, что происходит в командном окне. Это позволит вам избежать множества
недоразумений и досадных ошибок.

Кроме того, из вышесказанного следует сделать вывод о том, что одну и ту
же операцию в AutoCAD  можно выполнить разными способами. Действитель�
но, для запуска большинства команд можно воспользоваться не только клавиа�
турой, но и системой меню либо панелями инструментов. В одних случаях удоб�
нее вводить команды по�старинке, с клавиатуры, а в других — пользоваться
мышью для выбора команд из меню или запуска их с помощью кнопок панелей
инструментов.

О командах, вводимых с клавиатуры, мы будем говорить на протяжении
всей книги, а пока что давайте бегло просмотрим все меню AutoCAD и панели
инструментов, а также кратко поговорим об особенностях их использования в
AutoCAD.

А.4. Система менюА.4. Система менюА.4. Система менюА.4. Система менюА.4. Система меню
Система меню AutoCAD состоит из двенадцати меню. Кроме того, к этой систе�
ме можно отнести и значок меню окна текущего документа AutoCAD, который
находится слева от меню Файл (File). Щелчок на любом из этих элементов при�
водит к открытию соответствующего меню. Значок меню окна документа, а так�
же меню Файл (File), Правка (Edit), Вид (View), Окно (Window) и Справка
(Help) относятся к стандартным меню Microsoft Windows XP, хотя и со специ�
фическими командами AutoCAD. Меню окна документа содержит команды уп�
равления расположением окна активного чертежа AutoCAD. Команды меню
Файл (File) предназначены для открытия и сохранения новых и существующих
чертежей, печати, экспорта файлов в другие форматы, выполнения некото�
рых других общих файловых операций, а также выхода из AutoCAD. Меню
Правка (Edit) содержит команды Отменить (Undo) и Повторить (Redo),
предназначенные для отмены или повтора операций; Вырезать (Cut), Копи�
ровать (Copy) и Вставить (Paste), используемые для работы с буфером обмена
Windows; а также команды организации внешних связей файлов AutoCAD и дру�
гих файлов. Меню Вид (View), помимо команд, предназначенных для управле�
ния отображением чертежа в области черчения, содержит команду Панели
(Toolbars), которая, как и в других программах Windows, позволяет настраи�
вать панели инструментов. Меню Окно (Window) и Справка (Help), в основ�
ном, функционируют так же, как и аналогичные меню программ для Windows.

Панели инструментовПанели инструментовПанели инструментовПанели инструментовПанели инструментов
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Остальные кнопки панели Стандартная (Standard) — это обычные кнопки
приложения Windows (многие из них вам, наверняка покажутся знакомыми).
Кнопки панели Рисование (Draw), которая по умолчанию располагается у ле�
вой границы окна AutoCAD, предназначены для создания объектов чертежа.
Среди них имеется одна выдвижная панель, которая по умолчанию представле�
на кнопкой Вставить блок (Insert Block). Кнопки панели Редактировать
(Modify), расположенной у правой границы окна AutoCAD, предназначены для
внесения изменений в объекты чертежа, созданные с помощью инструментов
панели Рисование (Draw). Выдвижных панелей на этой панели инструментов
нет. Подробнее с инструментами панелей Стандартная (Standard), Рисование
(Draw) и Редактировать (Modify) вы можете ознакомиться в главах основного
материала книги.

А.5.1. Выдвижные панелиА.5.1. Выдвижные панелиА.5.1. Выдвижные панелиА.5.1. Выдвижные панелиА.5.1. Выдвижные панели
Итак, если с использованием обычных кнопок панелей инструментов даже у
начинающих пользователей проблем, как правило, не возникает, то для освое�
ния методов работы с выдвижными панелями требуется некоторая практика.
Самое большое затруднение, которое испытывают начинающие пользователи
при работе с такими панелями, заключается в том, что они не могут найти на
панели инструментов скрытую кнопку выдвижной панели. Поэтому для освое�
ния навыков работы с выдвижными панелями выполните следующие операции.

1. Поместите указатель на кнопку  Зумирование рамкой (Zoom Window)
панели инструментов Стандартная (Standard). (На пиктограмме кноп�
ки, как уже говорилось выше, изображена лупа, под стеклом которой вид�
на прямоугольная рамка.)

2. Подержите указатель на этой кнопке в течение 1�2 с, не щелкая мышью.
Рядом с указателем мыши появится название команды, которой соответ�
ствует эта кнопка (в данном случае — Зумирование рамкой (Zoom
Window)). Это так называемая контекстная подсказка (tooltip), которой
снабжены все инструменты AutoCAD. Именно с помощью контекстной
подсказки можно узнать название нужного вам инструмента. Для этого
достаточно подвести указатель мыши к панели инструментов, а затем
поочередно останавливать его на 1�2 с на каждом инструменте, до тех
пор, пока не увидите контекстную подсказку с нужным вам названием.

3. Теперь поместите указатель на кнопку (вы, наверное, обратили внима�
ние на черный треугольник в правом нижнем углу ее пиктограммы) и,
нажав левую кнопку мыши, удерживайте ее нажатой. Под кнопкой Зуми�
рование рамкой (Zoom Window) появится графическое меню, состоя�
щее из девяти кнопок (верхняя кнопка в этом меню аналогична нажатой
кнопке панели инструментов Стандартная (Standard)). Это графическое
меню из кнопок и называется выдвижной панелью.

4. Продолжая удерживать левую кнопку мыши, медленно ведите указатель
вниз, поочередно останавливая его на 1�2 с на каждой кнопке. Кнопки

Рис. А.11  Список панелей инструментов AutoCAD 2008

окна документа AutoCAD, т.е. панели инструментов в их традиционном смыс�
ле, как, например, на рис. А.11. Плавающие панели инструментов представля�
ют собой небольшие окна, которые можно свободно перемещать по экрану.
Любая плавающая панель, помещенная рядом с границей окна, автоматически
становится пристыкованной и наоборот — любую пристыкованную панель
можно отстыковать и сделать плавающей. Поскольку освоение работы с пане�
лями инструментов — это достаточно важный аспект, он будет рассмотрен под�
робнее в этом приложении. А пока что откройте список панелей инструментов
и отключите все панели, кроме Стандартная (Standard), Рисование (Draw) и
Редактировать (Modify).

Следует отметить, что на многих панелях имеются скрытые кнопки, кото�
рые не всегда отображаются на экране. Такие кнопки нужно выбирать из свое�
образного графического меню, называемого выдвижной панелью (flyout). В част�
ности, на панели Стандартная (Standard) имеется такая выдвижная панель —
если вы внимательно присмотритесь к кнопкам панели Стандартная
(Standard), то увидите в правом нижнем углу одной из кнопок маленький треу�
гольник (по умолчанию эта кнопка называется Зумирование рамкой (Zoom
Window) и на ней изображена лупа). О том, как работать с выдвижными панеля�
ми, мы поговорим подробнее в следующем подразделе.

Панели инструментовПанели инструментовПанели инструментовПанели инструментовПанели инструментов
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при этом будут вам «представляться», показывая свои названия во всплы�
вающих подсказках. «Познакомившись» со всеми кнопками, подведите
указатель мыши к кнопке Показать все (Zoom All). Увидев контекстную
подсказку с названием этой кнопки, как показано на рис. А.12, отпустите
левую кнопку мыши. Выдвижная панель закроется, а AutoCAD выполнит
команду Показать все (Zoom All).

Однако работать с выдвижными панелями все же удобнее, поскольку они по�
зволяют рациональнее использовать область черчения, поэтому они интенсив�
но применять их при изучении дальнейшего материала этой книги.

А.5.2. Размещение панелей в окне AutoCADА.5.2. Размещение панелей в окне AutoCADА.5.2. Размещение панелей в окне AutoCADА.5.2. Размещение панелей в окне AutoCADА.5.2. Размещение панелей в окне AutoCAD
Для того чтобы увидеть, как в AutoCAD можно манипулировать панелями инст�
рументов, мы воспользуемся панелью Редактировать (Modify). Как отмеча�
лось выше, по умолчанию эта панель пристыкована к правой границе окна
AutoCAD. Для того чтобы преобразовать ее в плавающую панель, выполните
следующие операции.

1. Подведите указатель мыши к двойной линии, выглядящей, как рифленая
поверхность (у вертикальных пристыкованных панелей эта двойная ли�
ния находится сверху, а у горизонтальных — слева).

2. Нажав левую кнопку мыши, вы увидите, что вокруг панели появилась
тонкая рамка, охватывающая контур панели. Не отпуская кнопку мыши,
переместите указатель влево. Вместе с указателем будет перемещаться и
рамка, как показано на рис. А.14.

Рис. А.12  Выбор
кнопки Показать
все (Zoom All) из

выдвижной панели
инструментов 3. Продолжайте перемещать указатель мыши влево.

Как только панель Редактировать (Modify) отстыку�
ется, рамка станет, во�первых, широкой, а во�вторых,
горизонтальной, а не вертикальной. Если вы отпус�
тите левую кнопку мыши, на месте широкой горизон�
тальной рамки появится плавающая панель Редакти�
ровать (Modify) с заголовком и кнопкой закрытия,
как у обычного окна Windows.

4. Поместив указатель на строку заголовка плавающей панели Редактиро�
вать (Modify), нажмите и не отпускайте левую кнопку мыши, а затем по�
пробуйте переместить панель в другое место экрана. Обратите внима�
ние, что при перемещении панель остается на месте, а двигается всего
прямоугольная рамка тех же размеров, что и панель (рис. А.15).

5. Подведите указатель мыши к левой границе окна AutoCAD (туда, где на�
ходится пристыкованная панель Рисование (Draw)). Как только указа�
тель мыши (не прямоугольная рамка, а именно указатель) достигнет ле�
вой границы окна, рамка станет снова узкой и вертикальной. Это
означает, что панель готова к пристыковке. Пристыкуйте панель Редак�
тировать (Modify) справа от панели Рисование (Draw).

6. Плавающие панели не оказывают никакого влияния на размеры области
черчения, но они при этом скрывают ее фрагменты, тогда как каждая
пристыкованная панель занимает место, которое могла бы дополнитель�
но занимать область черчения. В AutoCAD 2008, в отличие от более ран�
них версий, в которых отсутствовала уже упоминавшаяся выше кнопка
Очистить экран (Clear Screen), экономия пространства на экране не яв�
ляется принципиальным фактором. Действительно, если, щелкнув на
кнопке Очистить экран (Clear Screen), в любой момент можно переклю
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Рис. А.14  Отсты!
ковка панели Редак%

тировать (Modify)

5. Посмотрите на командное окно в нижней части эк�
рана. Если вы увеличите высоту командного окна
примерно в два раза (так, чтобы в нем отобража�
лось 5�6 строк), то увидите в нем, что при выполне�
нии команды Показать все (Zoom All) в командном
окне автоматически была введена команда Ïîêà-
çàòü âñå (ZOOM ALL). Обратите также внимание
на то, что команда вводится по�английски. (Симво�
лы подчеркивания, указанные перед командой
ZOOM и режимом ее выполнения ALL, говорят о
том, что команда вводится автоматически, а не
пользователем.)

6. Теперь снова посмотрите на панель Стандартная
(Standard), туда, где раньше находилась кнопка Зумирование рамкой
(Zoom Window). Теперь на этом месте находится кнопка Показать все
(Zoom All). Основная особенность выдвижных панелей состоит в том,
что кнопка, выбранная последней, занимает место предыдущей кнопки
на основной панели. Теперь, если вам понадобиться в следующий раз
воспользоваться инструментом Показать все (Zoom All), вы будете ос�
вобождены от необходимости снова открывать выдвижную панель —
вам достаточно будет просто щелкнуть на кнопке Показать все (Zoom
All) панели инструментов Стандартная (Standard), как если бы она
была обычной кнопкой этой панели (рис. А.13). Порядок следования
кнопок на выдвижной панели остается неизменным, поэтому при по�
вторном открытии панели Зумирование (Zoom) кнопка Зумирование
рамкой (Zoom Window) снова окажется на самом ее верху.

Остальные выдвижные панели работают точно так же, как только что рас�
смотренная панель Зумирование (Zoom). Строго говоря, можно не использо�
вать выдвижные панели, поскольку все представленные в них инструменты на�
ходятся на обычных панелях инструментов с соответствующими названиями.
Так, открыв список панелей инструментов AutoCAD, как показано на рис. А.11,
вы увидите в этом списке панель инструментов Зумирование (Zoom). Включив
отображение этой панели, легко убедиться, что она содержит все инструмен�
ты, представленные в виде выдвижной панели Зумирование (Zoom) панели

инструментов Стандартная (Standard), показанной на рис. А.12.

Рис. А.13 . Кнопка Показать все (Zoom All) заняла место кнопки Зумирова%
ние рамкой (Zoom Window)
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Рис. А.15  Перемещение плавающей панели Редактировать (Modify)

читься в режим чистого экрана, то снижение производительности из�за
загромождения области черчения плавающими панелями инструментов,
практически нивелируется.

Однако при обучении основам работы в AutoCAD все же лучше начинать с
минимального набора инструментов, подключая дополнительные панели по
мере необходимости. Поэтому в главах основного материала книги автор будет
считать, что вы оставили на экране лишь панель Стандартная (Standard), при�
стыкованную к верхней границе окна, а также панели Рисование (Draw) и Ре�
дактировать (Modify), пристыкованные к левой границе окна, как показано на
рис. А.16.

Совет. Для включения двухмерного изображения пиктограммы ПСК, как пока�
зано на рис. А.16, выберите из меню команду Вид ⇒  ⇒  ⇒  ⇒  ⇒ Отображение ⇒  ⇒  ⇒  ⇒  ⇒ Знак
ПСК ⇒ ⇒ ⇒ ⇒ ⇒ Свойства (View ⇒ Display ⇒ UCS icon ⇒ Properties). В открывшемся
диалоговом окне Знак ПСК (UCS Icon) выберите переключатель 2D в группе
Стиль знака ПСК (UCS icon style) и щелкните на кнопке OK. Впрочем, стиль
отображения пиктограммы ПСК не влияет на работу AutoCAD, поэтому дан�
ную настройку можно и не выполнять.

Рис. А.16  Окно AutoCAD 2008 настроено для работы с данной книгой

Если вам удалось расположить панели Рисование (Draw) и Редактировать
(Modify), как показано на рис. А.16, а также добиться соответствия расположе�
ния и настройки других элементов окна AutoCAD на вашем ПК расположению
и настройке аналогичных элементов на рис. А.16, можете переходить к изуче�
нию заключительных разделов этого приложения. В противном случае верни�
тесь к его началу и попробуйте разобраться в том, как решить соответствую�
щую проблему, поскольку в основном материале книге такого внимания
вопросам настройки интерфейса уже не уделяется — автор исходит из того, что
вы научились выполнять все операции, описанные в данном приложении.

А.5.3. Настройка панелей инструментовА.5.3. Настройка панелей инструментовА.5.3. Настройка панелей инструментовА.5.3. Настройка панелей инструментовА.5.3. Настройка панелей инструментов
Опытный пользователь AutoCAD может настроить конфигурацию любой пане�
ли инструментов по своему усмотрению — добавить или удалить кнопки, со�
здать новую панель и даже создать новые инструменты, отсутствующие в
AutoCAD. Эти операции выполняются с помощью диалогового окна Настрой�
ка интерфейса пользователя (Customize User Interface) (рис. А.17), открыть
которое можно с помощью команды Вид ⇒  ⇒  ⇒  ⇒  ⇒ Панели (View ⇒ Toolbars) либо с
помощью команды Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Адаптация ⇒  ⇒  ⇒  ⇒  ⇒ Интерфейс (Tools ⇒ Customize ⇒
Interface).
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Рис. А.17  Диалоговое окно Настройка интерфейса
пользователя (Customize User Interface)

Однако одно лишь подробное описание диалогового окна Настройка ин�
терфейса пользователя (Customize User Interface) потребует объема, соответ�
ствующего объему данной книги. Поэтому автор, упомянув о наличии в
AutoCAD 2008 инструментов, позволяющих настроить пользовательский ин�
терфейс, все же рекомендует читателям этой книги отложить изучение мето�
дов настройки на будущее, пока вы не приобретете опыт выполнения обычных
операций.

А.6. Использование клавиатуры и мышиА.6. Использование клавиатуры и мышиА.6. Использование клавиатуры и мышиА.6. Использование клавиатуры и мышиА.6. Использование клавиатуры и мыши
Нетрудно догадаться, что поскольку командное окно является одним из важ�

нейших элементов пользовательского интерфейса AutoCAD, при черчении вы
будете очень часто использовать клавиатуру для ввода команд и необходимых
им данных. Более того — опытные пользователи часто предпочитают вводить
команды именно в командном окне, а не выбирать их из меню или запускать с
помощью панелей инструментов. Это объясняется тем, что в AutoCAD поддер�
живаются так называемые псевдонимы команд (alias keys) — сокращения из одно�
го�двух символов, позволяющие быстро вводить команды и названия их режи�
мов в командном окне. Например, упоминавшуюся команду Íàñòðîéêà

(OPTIONS) можно запустить, просто введя в командном окне псевдоним íà
(OP), команду Ïîêàçàòü ðàìêà (ZOOM WINDOW) — псевдоним ïî p (Z W)
(т.е. последовательно нажав П, О (Z), Enter, P (W), Enter), а команду Ïîêàçàòü
âñå (ZOOM ALL) — псевдоним ïî â (Z A). В главах основного материала соот�
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В этом приложении описаны основные приемы управления элементами
окна AutoCAD 2009, а также принципы настройки AutoCAD 2009 для
работы с данной книгой.

Б.1. Первый запуск AutoCAD 2009Б.1. Первый запуск AutoCAD 2009Б.1. Первый запуск AutoCAD 2009Б.1. Первый запуск AutoCAD 2009Б.1. Первый запуск AutoCAD 2009
При установке приложения AutoCAD в стандартной конфигурации для его за�
пуска достаточно выбрать команду Пуск ⇒  ⇒  ⇒  ⇒  ⇒ Все программы ⇒  ⇒  ⇒  ⇒  ⇒ Autodesk ⇒ ⇒ ⇒ ⇒ ⇒
AutoCAD 2009 ⇒  ⇒  ⇒  ⇒  ⇒ AutoCAD 2009 (рис. Б.1.). Если же при установке на вашем ПК
стандартная конфигурация AutoCAD 2009 была изменена, найдите значок
AutoCAD 2009 самостоятельно, а затем запустите программу, как любое другое
приложение Windows XP.

При первом запуске AutoCAD 2009 появляется окно Семинар по новым воз�
можностям (New Features Workshop) (рис. Б.2), с помощью которого можно
ознакомиться с новыми возможностями AutoCAD 2009 по сравнению с преды�
дущими версиями. Выберите в этом окне переключатель Больше не предла�
гать (No, don’t show me this again), чтобы это окно больше не появлялось (если
у вас возникнет такая необходимость, вы всегда сможете ознакомиться с но�
винками, выбрав из меню AutoCAD команду Справка ⇒  ⇒  ⇒  ⇒  ⇒ Новые возможности
(Help ⇒ New Features Workshop)).

Затем AutoCAD выполнит настройку рабочего пространства (по умолчанию
используется рабочее пространство 2D рисование и аннотации (2D Drafting &
Annotation)), после чего на экране появится окно AutoCAD 2009, которые спе�
циалисты называют также графическим пользовательским интерфейсом (GUI —
graphical user interface).

БПриложениеПриложениеПриложениеПриложениеПриложение
Основы работы вОсновы работы вОсновы работы вОсновы работы вОсновы работы в
AutoCAD 2009AutoCAD 2009AutoCAD 2009AutoCAD 2009AutoCAD 2009

Рис. Б.1  Запуск AutoCAD 2009

Как и в AutoCAD 2007/2008, в AutoCAD 2009 используются рабочие простран�
ства (workspace) — удобный инструмент, который опытные пользователи
AutoCAD применяют для быстрой настройки всех параметров своего экземпля�
ра AutoCAD, включая файлы чертежей. В AutoCAD 2009, как и в AutoCAD 2008,
имеется три стандартных рабочих пространства: 2D рисование и аннотации
(2D Drafting & Annotation), 3D моделирование (3D Modeling) и Классический
AutoCAD (AutoCAD Classic). Поскольку мы в этой книге будем работать с клас�
сическими средствами AutoCAD, щелкните на кнопке строки состояния  Пе�
реключение рабочих пространств (Workspace Switching), как показано на
рис. Б.3, и выберите из открывшегося меню рабочее пространство Классичес�
кий AutoCAD (AutoCAD Classic), после чего окно AutoCAD приобретет вид, по�
казанный на рис. Б.3.

Б.2. Основные элементы классического интерфейсаБ.2. Основные элементы классического интерфейсаБ.2. Основные элементы классического интерфейсаБ.2. Основные элементы классического интерфейсаБ.2. Основные элементы классического интерфейса
AutoCAD и его настройкаAutoCAD и его настройкаAutoCAD и его настройкаAutoCAD и его настройкаAutoCAD и его настройка
Основные элементы окна AutoCAD 2009 с классическим интерфейсом (строка
заголовка, система меню и панели инструментов) полностью аналогичны соответ�
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Рис. Б.2  Окно Семинар по новым возможностям (New Features Workshop)

имя текущего файла чертежа Чертеж1.dwg (Drawing1.dwg). Система меню так�
же должна быть знакома любому пользователю Windows. В частности, несколь�
ко меню (Файл (File), Правка (Edit), Вид (View), Окно (Window) и Справка
(Help)) присутствуют практически во всех системах меню Windows, хотя ука�
занные меню в AutoCAD содержат ряд дополнительных команд. Кроме того, в
систему меню AutoCAD входят меню, специфичные только для AutoCAD
(Вставка (Insert), Формат (Format), Сервис (Tools), Рисование (Draw), Разме�
ры (Dimension), Редактировать (Modify) и Express). Под системой меню в
классическом рабочем пространстве расположены панели инструментов
Стандартная (Standard), Стили (Styles), Рабочие пространства (Workspaces),
Слои (Layers), Свойства (Properties). Практически все кнопки этих панелей,
кроме нескольких кнопок панели Стандартная (Standard), начинающему
пользователю AutoCAD будут незнакомы. Именно изучению инструментов и
команд AutoCAD, представленных кнопками этих и других панелей инструмен�
тов, строго говоря, и посвящена данная книга. Поэтому сейчас мы не будем на
них останавливаться, поскольку каждый из основных инструментов черчения
AutoCAD описывается в главах книги по мере изучения материала.

У левой и правой границ экрана AutoCAD отображаются еще две панели
инструментов: слева — Рисование (Draw), а справа Редактировать (Modify).
Это обычные панели инструментов, которые по умолчанию располагаются не
по горизонтали, а по вертикали.

Кроме того, в AutoCAD 2009 впервые применен так называемый обозреватель
меню (menu browser), подобный кнопке Пуск Windows. Обозреватель меню
представлен большой кнопкой в левом верхнем углу окна AutoCAD 2009 с лого�
типом программы. Щелкнув на этой кнопке, можно получить доступ к коман�
дам меню, к спискам недавно открывавшихся чертежей и выполнявшихся опе�
раций, к списку открытых чертежей, а также к кнопке открытия диалогового
окна Настройка (Options) и команде Выход из AutoCAD (Exit AutoCAD).

Посреди экрана вы видите белую пустую область. Эта область в AutoCAD
называется областью черчения (drawing area). Указатель мыши, попадая в эту об�
ласть при перемещении по экрану, принимает форму указателя�перекрестия
(crosshair cursor). При использовании некоторых команд AutoCAD указатель
может принимать и другие формы, в зависимости от назначения команды и
этапа ее выполнения.

Кроме того, в окне AutoCAD 2009, как и в любом другом окне приложения
Windows, могут отображаться полосы прокрутки. В общем случае использо�
вать полосы прокрутки в AutoCAD не рекомендуется, поскольку они не только
менее удобны, чем инструменты масштабирования и панорамирования
AutoCAD, но еще и занимают место в области черчения. Поэтому сейчас мы
отключим отображение полос прокрутки, а также заодно изменим цвет облас�
ти черчения.

Эти и другие операции настройки интерфейса AutoCAD выполняются с по�
мощью диалогового окна Настройка (Options), которое вы будете очень часто
использовать в работе.

Рис. Б.3  Окно AutoCAD 2009 с классическим пользовательским интерфейсом и открытым
меню кнопки Переключение рабочих пространств (Workspace Switching)

ствующим элементам любого современного приложения для Windows. Так, в
строке заголовка отображаются имя активного приложения AutoCAD 2009 и
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1. Выберите из меню команду Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Настройка (Tools ⇒ Options). От�
кроется диалоговое окно Настройка (Options), показанное на рис. Б.4,
которое содержит десять вкладок.

2. Перейдите в окне Настройка (Options) на вкладку Экран (Display), на
которой представлены параметры, управляющие отображением элемен�
тов графического интерфейса AutoCAD (рис. Б.5).

3. Если в группе Элементы окна (Window Elements) установлен флажок
Полосы прокрутки (Display scroll bars in drawing window), как показано

на рис. Б.5, щелкните на нем для его сброса и отключения соответствую�
щего режима. Не спешите щелкать на кнопке OK — настройку интерфей�
са мы еще не закончили.

4. Найдите в правом нижнем углу вкладки строку ввода Размер перекрес�
тья (Crosshair size). Если вы хотите, чтобы экран вашего ПК при изуче�
нии этой книги выглядел точно так же, как и экран автора, введите в этой
строке значение 100 (или просто переместите бегунок право до конца). В
этом случае линии перекрестия будут уходить за границы экрана. Многие
опытные пользователи AutoCAD (в том числе и автор) считают, что так с
указателем�перекрестием работать удобнее, чем при размере, установ�
ленным по умолчанию.

5. Если вас отвлекает темная цветовая схема AutoCAD 2009, выберите из
списка Цветовая схема (Color scheme) группы Элементы окна (Window
Elements) цветовую схему Светлая (Light), которая ближе к традицион�
ной гамме окон Windows XP (других вариантов цветовых схем разработ�
чики компании Autodesk, к сожалению, не предлагают).

6. Теперь щелкните на кнопке Цвета (Colors), расположенной в нижней
части группы Элементы окна (Window Elements). В открывшемся диало�
говом окне Цветовая гамма окна чертежа (Drawing Window Colors) вы�
берите в списке Контекст (Context) элемент Пространство 2D модели
(2D model space), а в списке Элемент интерфейса (Interface Element) —
элемент Однородный фон (Uniform background). Затем раскройте спи�
сок Цвет (Color) и выберите из него цвет Белый (White). Область про�
смотра Образец (Preview) окна Цветовая гамма окна чертежа (Drawing
Window Colors) примет вид, показанный на рис. Б.6.

7. Щелкните на кнопке Принять (Apply & Close) для закрытия окна Цвето�
вая гамма окна чертежа (Drawing Window Colors), а затем на кнопке OK
диалогового окна Настройка (Options).

Теперь цвет области черчения окна AutoCAD изменился на чистый белый, а
цветовая гамма окна — на более светлую. Кстати, если вы выберите другой цвет
для области черчения, AutoCAD автоматически подберет цвет указателя так,
чтобы он был хорошо виден на фоне выбранного вами цвета. Кроме того, если
вы установили максимальный размер для указателя�перекрестия, эти измене�
ния вы также легко заметите.

Теперь давайте рассмотрим другие элементы окна AutoCAD. Во�первых, в
нижнем левом углу окна области черчения отображается пиктограмма с двумя
стрелками. Эта пиктограмма называется ПСК (пользовательская система коор�
динат) и используется для обозначения положительных направлений осей ко�
ординат X и Y. Для работы с этой книгой пиктограмма ПСК практически не
нужна, поэтому в основном материале книги вы узнаете, как ее отключить.

Во�вторых, под пиктограммой ПСК находятся ярлычки листов модели Мо�
дель (Model) и листов компоновок Лист1 (Layout1) и Лист2 (Layout2). Эти яр�
лычки используются для быстрого переключения между режимами работы в
пространстве модели (model space) и в пространстве листа (paper space). Подроб�

Рис. Б.4  Вкладка Файлы (Files) диалогового окна Настройка (Options)

Рис. Б.5  Вкладка Экран (Display) диалогового окна Настройка (Options)
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Рис. Б.6  Диалоговое окно Цветовая гамма окна чертежа (Drawing Window Colors)

нее о том, что такое компоновки и чем они отличаются от модели, также рас�
сказывается в основном материале книги.

Третий по порядку (но не по важности) элемент окна AutoCAD 2009, — это
командное окно (рис. Б.7).

Командное окно (command window) — это, без преувеличения, «сердце»
AutoCAD. В этом окне пользователь может вводить команды, а также задавать
их параметры. Кроме того, в командном окне выводится информация о выпол�
няемых AutoCAD операциях. Значимость командного окна очень высока, по�
скольку все команды меню и кнопки панелей инструментов представляют со�
бой, по сути, лишь «надстройку» над командами AutoCAD, которые изначально
предназначались для ввода в командном окне. Кроме того, существуют некото�
рые команды, которые можно ввести только в командном окне. Поэтому автор
советует вам уделить самое пристальное внимание изучению методов работы с
этим элементом интерфейса AutoCAD. Подробнее о настройке командного
окна мы поговорим далее в этом приложении.

Под командным окном расположена строка состояния (status bar). В отличие
от других приложений, в которых строка состояния используется от случая к
случаю, в AutoCAD этот элемент интерфейса применяется очень активно. Во�
первых, в строке состояния отображаются текущие координаты указателя�пере�
крестия. Во�вторых, с помощью находящихся на ней кнопок�индикаторов мож�
но быстро включать и отключать соответствующие режимы работы AutoCAD.

В AutoCAD 2009 кнопки�индикаторы могут отображаться в текстовом режиме,
как показано на рис. Б.3, и в режиме значков, как показано на рис. Б.7. Логика
работы кнопок�индикаторов от режима отображения не зависит, поэтому если
в вашем случае в строке состояния AutoCAD вы видите пиктограммы, а не тек�
стовые обозначения, можете не волноваться — вскоре вы узнаете, как переклю�
читься в традиционный режим текстовых обозначений.

Для начинающего пользователя AutoCAD очень важны такие индикаторы,
как ШАГ (SNAP), СЕТКА (GRID), ОРТО (ORTHO) и ПРИВЯЗКА (OSNAP),
поскольку с помощью соответствующих режимов можно быстро научиться со�
здавать точные чертежи. Кроме того, вам могут пригодиться такие кнопки�ин�
дикаторы, как ОТС�ПОЛЯР (POLAR), ОТС�ОБЪЕКТ (OTRACK), ВЕС (LWT)
и МОДЕЛЬ (MODEL), поэтому они также рассматриваются в этой книге. Что
касается кнопок�индикаторов ДПСК (DUCS), ДИН (DYN) и БС (QP), то они
нам не понадобятся. Индикатор ДПСК (DUCS) предназначен для использова�
ния режима динамической ПСК (DUCS — dynamic user coordinate system), кото�
рые используется только при трехмерном моделировании, а индикатор ДИН
(DYN) — для включения режима динамических подсказок, которые многим начи�
нающим пользователям создают дополнительные трудности в освоении базо�
вых приемов черчения. Индикатор БС (QP) предназначен для включения ото�
бражения окна Быстрые свойства (Quick Properties), однако в этой книге
данная функциональность также является избыточной.

Поэтому давайте их отключим, чтобы вы не испытывали затруднений при
дальнейшей работе с книгой.

1. Если кнопки�индикаторы отображаются в режиме значков, щелкните на
любой из них правой кнопкой мыши и выберите из появившегося кон�
текстного меню команду Использовать значки (Use Icons), которая дол�
жна быть помеченной в меню «галочкой».

2. Если кнопки�индикаторы ДПСК (DUCS), ДИН (DYN) и (или) БС (QP)
находятся в нажатом положении (имеют голубой цвет, а не серый), щел�
кните на них, чтобы выключить соответствующие режимы.

3. Щелкните на кнопке раскрытия меню строки состояния, которая нахо�
дится в этой строке правее области уведомлений, и выберите из него
подменю Переключатели режимов (Status Toggles) (рис. Б.8).

4. Выберите из подменю Переключатели режимов (Status Toggles) эле�
мент Динамическая ПСК (F6) (Dynamic UCS (F6)). AutoCAD закроет
меню и, отключив отображение кнопки ДПСК (DUCS), перерисует стро�
ку состояния.

5. Снова откройте меню строки состояния, подменю Переключатели ре�
жимов (Status Toggles) и проделайте аналогичную операцию с элемента�
ми Динамический ввод (F12) (Dynamic Input (F12)) и Быстрые свой�
ства (Quick Properties).

6. Обратите внимание на другие значки и индикаторы, представленные
рядом с областью уведомлений и непосредственно в этой области уве�
домлений. Большинство из них в данной книге не используются, поРис. Б.7  Командное окно и строка состояния AutoCAD 2009
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Рис. Б.8  Меню строки состояния (сравните с
рис. Б.7). Отображение кнопки#индикатора
ДПСК (DUCS) уже отключено, на очереди —
отключение отображения кнопок#индикаторов
ДИН (DYN) и БС (QP)

скольку они не нужны для освоения базо�
вых навыков черчения в AutoCAD. Поэто�
му откройте меню строки состояния, как
показано на рис. Б.8, и отключите элемен�
ты Быстрый просмотр листов (Quick

View Layouts), Быстрый просмотр чертежей (Quick View Drawings), Па�
норамирование (Pan), Зумирование (Zoom), Штурвал (SteeringWheel),
Аниматор движения (ShowMotion), Масштаб аннотаций (Annotation
Scale), Видимость аннотаций (Annotation Visibility), Автомасштабиро�
вание (AutoScale), Рабочие пространства (Workspaces) и Блокировка
отображения (Display Locking).

7. Снова откройте меню строки состояния, как показано на рис. Б.8, и выбе�
рите из него элемент Настройка области уведомлений (Tray Settings). В
открывшемся одноименном диалоговом окне сбросьте флажок Показы�
вать значки служб (Display icons from services) и щелкните на кнопке OK
для закрытия диалогового окна Настройка области уведомлений (Tray
Settings).

8. Нам осталось настроить инструмент Коммуникационный центр
(Communication Center), который постоянно будет уведомлять вас о не�
возможности установки связи с Интернетом (или, что еще хуже, устанав�
ливать такую связь и проверять наличие обновлений и выполнять про�
чие операции без вашего ведома). Поэтому лучше его также отключить.
Щелкните на кнопке  Коммуникационный центр (Communication
Center) панели инструментов Инфоцентр (InfoCenter), которая нахо�
дится справа в строке заголовка окна AutoCAD.

9. В заголовке открывшейся панели меню Коммуникационный центр

(Communication Center) щелкните на кнопке  Параметры Инфоцен�
тра (InfoCenter Settings), которая находится слева от кнопки закрытия
этой панели.

10. В разделе Общие (General) открывшегося диалогового окна Параметры
Инфоцентра (InfoCenter Settings) (рис. Б.9) выберите в верхнем списке
регион вашего проживания, нижнем — элемент Бессрочная (Never).

11. Перейдите в подраздел Всплывающие уведомления (Balloon
Notification) раздела Коммуникационный центр (Communication
Center) и сбросьте флажок Разрешить уведомления для (Enable balloon
notification for).

12. Перейдите в подраздел RSS�каналы (RSS Feeds) этого же раздела, выде�
лите все установленные по умолчанию RSS�ленты, и щелкните на кнопке

Рис. Б.9  Диалоговое окно Параметры Инфоцентра (Configurations Settings)

Удалить (Remove). Щелкните на кнопке Да появившегося диалогового
окна подтверждения.

13. Щелкните на кнопке OK диалогового окна Параметры Инфоцентра
(InfoCenter Settings).

Теперь окно AutoCAD должно приобрести вид, показанный на рис. Б.10.

Рис. Б.10  Окно AutoCAD после настройки параметров строки состояния
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В завершение обсуждения основных элементов окна AutoCAD можно упомя�
нуть о кнопке  Очистить экран (Clear Screen), которая находится в строке
состояния (см. рис. Б.10) у правой границы окна AutoCAD. Щелкнув на этой
кнопке, вы перейдете в полноэкранный режим работы AutoCAD с автоматичес�
ким сокрытием всех панелей инструментов и строки заголовка. Это позволяет
обеспечить максимальное использование экрана дисплея, что бывает доста�
точно удобным при работе со сложными чертежами. Повторный щелчок на
кнопке Очистить экран (Clear Screen) приводит к возврату в исходный режим
отображения окна AutoCAD.

Б.3. Командное окноБ.3. Командное окноБ.3. Командное окноБ.3. Командное окноБ.3. Командное окно
Командное окно не зависит от других элементов области черчения, поэтому
его можно перемещать в любое место экрана, а также изменять размер. В част�
ности, для того чтобы увеличить высоту командного окна, следует подвести
указатель мыши к горизонтальной границе, отделяющей область черчения от
командного окна. Когда указатель приобретет форму двух параллельных отрез�
ков, сверху и снизу над которыми находятся направленные вверх и вниз верти�
кальные стрелки, нажмите левую кнопку мыши и переместите указатель в нуж�
ном направлении на высоту нескольких строк текста. Добившись
необходимого вам положения границы, отпустите кнопку мыши. После завер�
шения работы AutoCAD состояние командного окна будет сохранено и при сле�
дующем запуске AutoCAD размер командного окна окажется таким, каким он
был установлен во время предыдущего сеанса работы.

Как уже говорилось выше, командное окно — это исключительно важный
элемент интерфейса AutoCAD. Именно в нем пользователь отдает команды
AutoCAD и получает от AutoCAD нужную ему информацию. Например, открыть
упоминавшееся выше диалоговое окно Настройка (Options) можно, не только
выбрав из меню команду Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Настройка (Tools ⇒ Options), но и введя в
командном окне команду Íàñòðîéêà (OPTIONS). Для этого достаточно на�
брать команду с клавиатуры (соблюдать регистр необязательно) и нажать
Enter. AutoCAD автоматически распознает ввод с клавиатуры и отобразит вве�
денную вами команду в командном окне, а затем откроет диалоговое окно На�
стройка (Options). Закрыв окно Настройка (Options) щелчком на кнопке
Cancel или простым нажатием Esc, попробуйте открыть его снова с помощью
команды меню Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Настройка (Tools ⇒ Options) и понаблюдайте при
этом за командным окном. Если размер окна равен как минимум трем строкам,
вы увидите, что в нем промелькнет команда _options. Это означает, что при
использовании команд меню и панелей инструментов AutoCAD все равно авто�
матически вводит за вас в командном окне соответствующие команды.

Поэтому автор настоятельно рекомендует всем начинающим пользовате�
лям выработать привычку, которая заключается в постоянном наблюдении за
тем, что происходит в командном окне. Это позволит вам избежать множества
недоразумений и досадных ошибок.

Кроме того, из вышесказанного следует сделать вывод о том, что одну и ту
же операцию в AutoCAD  можно выполнить разными способами. Действитель�
но, для запуска большинства команд можно воспользоваться не только клавиа�
турой, но и системой меню либо панелями инструментов. В одних случаях удоб�
нее вводить команды по�старинке, с клавиатуры, а в других — пользоваться
мышью для выбора команд из меню или запуска их с помощью кнопок панелей
инструментов.

О командах, вводимых с клавиатуры, мы будем говорить на протяжении
всей книги, а пока что давайте бегло просмотрим все меню AutoCAD и панели
инструментов, а также кратко поговорим об особенностях их использования в
AutoCAD.

Б.4. Система менюБ.4. Система менюБ.4. Система менюБ.4. Система менюБ.4. Система меню
Система меню AutoCAD состоит из двенадцати меню. Кроме того, к этой систе�
ме можно отнести и кнопку открытия обозревателя меню AutoCAD, которая
находится слева от меню Файл (File). Щелчок на любом из этих элементов при�
водит к открытию соответствующего меню. Меню Файл (File), Правка (Edit),
Вид (View), Окно (Window) и Справка (Help) относятся к стандартным меню
Microsoft Windows XP, хотя и со специфическими командами AutoCAD. Обозре�
ватель меню позволяет получить доступ к тем же командам меню AutoCAD, но в
иной форме, а также к ранее открывавшимся чертежам, открытым чертежам,
выполнявшимся операциям, кнопке открытия диалогового окна Настройка
(Options) и кнопке Выход из AutoCAD (Exit AutoCAD).

Команды меню Файл (File) предназначены для открытия и сохранения но�
вых и существующих чертежей, печати, экспорта файлов в другие форматы,
выполнения некоторых других общих файловых операций, а также выхода из
AutoCAD. Меню Правка (Edit) содержит команды Отменить (Undo) и Повто�
рить (Redo), предназначенные для отмены или повтора операций; Вырезать
(Cut), Копировать (Copy) и Вставить (Paste), используемые для работы с буфе�
ром обмена Windows; а также команды организации внешних связей файлов
AutoCAD и других файлов. Меню Вид (View), помимо команд, предназначен�
ных для управления отображением чертежа в области черчения, содержит ко�
манду Панели (Toolbars), которая, как и в других программах Windows, позво�
ляет настраивать панели инструментов. Меню Окно (Window) и Справка
(Help), в основном, функционируют так же, как и аналогичные меню программ
для Windows.

Остальные меню содержат чаще всего используемые команды AutoCAD. Да�
вайте вкратце рассмотрим назначение команд каждого из меню AutoCAD.
� Меню Вставка (Insert) содержит команды вставки чертежей и рисунков

(в том числе созданных в других программах) или их фрагментов в теку�
щий чертеж.
� Меню Формат (Format) содержит команды настройки общих парамет�

ров чертежа.

Система менюСистема менюСистема менюСистема менюСистема меню
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� Меню Сервис (Tools) содержит специальные команды, которые не отно�
сятся ни к одной из других категорий, например, для программирования
работы AutoCAD с помощью макросов.
� Меню Рисование (Draw) содержит все основные команды, обеспечиваю�

щие создание новых объектов чертежа (линий, окружностей, много�
угольников и т.д.).
� Меню Размеры (Dimension) содержит команды для нанесения размеров

на текущем чертеже.
� Меню Редактировать (Modify) содержит команды, которые, как и ко�

манды меню Рисование (Draw), используются чаще других команд
AutoCAD, поскольку они предназначены для внесения изменений в
объекты текущего чертежа.
� Меню Express содержит команды вызова пакета Express Tools. (Этот па�

кет является устаревшим и включается в поставку AutoCAD только для
тех пользователей, которые к нему привыкли. При установке с парамет�
рами по умолчанию этого меню и, соответственно, инструментов пакета
Express Tools, в системе меню AutoCAD может и не быть.)

Б.5. Панели инструментовБ.5. Панели инструментовБ.5. Панели инструментовБ.5. Панели инструментовБ.5. Панели инструментов
Как уже отмечалось выше, по умолчанию в окне AutoCAD отображается не�
сколько панелей инструментов (toolbar). Однако это только вершина айсберга —
всего в AutoCAD 2009 имеется 38 панелей инструментов, на многих из которых
насчитывается не один десяток кнопок. Для того чтобы увидеть список всех
панелей инструментов, достаточно щелкнуть на любой панели инструментов
правой кнопкой мыши. На экране появится контекстное меню, представляю�
щее собой полный список панелей инструментов AutoCAD (рис. Б.11).

Те панели инструментов, которые на момент открытия списка отображают�
ся в окне AutoCAD, помечены в списке «галочкой». Если щелкнуть на помечен�
ном элементе списка, контекстное меню закроется, а соответствующая панель
инструментов перестанет отображаться в окне AutoCAD. Для включения ото�
бражения панели нужно снова открыть это контекстное меню, щелкнув правой
кнопкой мыши на любой из оставшихся панелей инструментов, и выбрать из
списка панель, рядом с названием которой нет «галочки».

Кроме того, любая панель инструментов AutoCAD может быть как пристыко�
ванной (docked toolbar), так и плавающей (floating toolbar). Пристыкованными
называются панели инструментов, которые прикреплены к одной из границ
окна документа AutoCAD, т.е. панели инструментов в их традиционном смыс�
ле, как, например, на рис. Б.11. Плавающие панели инструментов представля�
ют собой небольшие окна, которые можно свободно перемещать по экрану.
Любая плавающая панель, помещенная рядом с границей окна, автоматически
становится пристыкованной и наоборот — любую пристыкованную панель
можно отстыковать и сделать плавающей. Поскольку освоение работы с пане�
лями инструментов — это достаточно важный аспект, он будет рассмотрен под�

Рис. Б.11  Список панелей инструментов AutoCAD 2009

робнее в этом приложении. А пока что откройте список панелей инструментов
и отключите все панели, кроме Стандартная (Standard), Рисование (Draw) и
Редактирование (Modify).

Следует отметить, что на многих панелях имеются скрытые кнопки, кото�
рые не всегда отображаются на экране. Такие кнопки нужно выбирать из свое�
образного графического меню, называемого выдвижной панелью (flyout). В част�
ности, на панели Стандартная (Standard) имеется такая выдвижная панель —
если вы внимательно присмотритесь к кнопкам панели Стандартная
(Standard), то увидите в правом нижнем углу одной из кнопок маленький треу�
гольник (по умолчанию эта кнопка называется Показать рамкой (Zoom
Window) и на ней изображена лупа). О том, как работать с выдвижными панеля�
ми, мы поговорим подробнее в следующем подразделе.

Остальные кнопки панели Стандартная (Standard) — это обычные кнопки
приложения Windows (многие из них вам наверняка покажутся знакомыми).
Кнопки панели Рисование (Draw), которая по умолчанию располагается у ле�
вой границы окна AutoCAD, предназначены для создания объектов чертежа.
Среди них имеется одна выдвижная панель, которая по умолчанию представле�
на кнопкой Вставить блок (Insert Block). Кнопки панели Редактирование
(Modify), расположенной у правой границы окна AutoCAD, предназначены для
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внесения изменений в объекты чертежа, созданные с помощью инструментов
панели Рисование (Draw). Выдвижных панелей на этой панели инструментов
нет. Подробнее с инструментами панелей Стандартная (Standard), Рисование
(Draw) и Редактирование (Modify) вы можете ознакомиться в главах основно�
го материала книги.

Б.5.1. Выдвижные панелиБ.5.1. Выдвижные панелиБ.5.1. Выдвижные панелиБ.5.1. Выдвижные панелиБ.5.1. Выдвижные панели
Итак, если с использованием обычных кнопок панелей инструментов даже у
начинающих пользователей проблем, как правило, не возникает, то для осво�
ения методов работы с выдвижными панелями требуется некоторая практи�
ка. Самое большое затруднение, которое испытывают начинающие пользова�
тели при работе с такими панелями, заключается в том, что они не могут
найти на панели инструментов скрытую кнопку выдвижной панели. Поэтому
для освоения навыков работы с выдвижными панелями выполните следую�
щие операции.

1. Поместите указатель на кнопку  Показать рамкой (Zoom Window) па�
нели инструментов Стандартная (Standard). (На пиктограмме кнопки,
как уже говорилось выше, изображена лупа, под стеклом которой видна
прямоугольная рамка.)

2. Подержите указатель на этой кнопке в течение 1�2 с, не щелкая мышью.
Рядом с указателем мыши появится название команды, которой соответ�
ствует эта кнопка (в данном случае — Показать рамкой (Zoom Window)).
Это так называемая контекстная подсказка (tooltip), которой снабжены
все инструменты AutoCAD. Именно с помощью контекстной подсказки
можно узнать название нужного вам инструмента. Для этого достаточно
подвести указатель мыши к панели инструментов, а затем поочередно
останавливать его на 1�2 с на каждом инструменте, до тех пор, пока не
увидите контекстную подсказку с нужным вам названием.

3. Теперь поместите указатель на кнопку (вы, наверное, обратили внима�
ние на черный треугольник в правом нижнем углу ее пиктограммы) и,
нажав левую кнопку мыши, удерживайте ее нажатой. Под кнопкой Пока�
зать рамкой (Zoom Window) появится графическое меню, состоящее из
девяти кнопок (верхняя кнопка в этом меню аналогична нажатой кнопке
панели инструментов Стандартная (Standard)). Это графическое меню
из кнопок и называется выдвижной панелью.

4. Продолжая удерживать левую кнопку мыши, медленно ведите указатель
вниз, поочередно останавливая его на 1�2 с на каждой кнопке. Кнопки
при этом будут вам «представляться», показывая свои названия во всплы�
вающих подсказках. «Познакомившись» со всеми кнопками, подведите
указатель мыши к кнопке Показать все (Zoom All). Увидев контекстную
подсказку с названием этой кнопки, как показано на рис. Б.12, отпустите
левую кнопку мыши. Выдвижная панель закроется, а AutoCAD выполнит
команду Показать все (Zoom All).

Рис. Б.12  Выбор кнопки Показать все (Zoom All) из
выдвижной панели инструментов

5. Посмотрите на командное окно в нижней
части экрана. Если вы увеличите высоту
командного окна примерно в два раза (так,
чтобы в нем отображалось 5�6 строк), то
увидите в нем, что при выполнении коман�
ды Показать все (Zoom All) в командном
окне автоматически была введена команда
Ïîêàçàòü âñå (ZOOM ALL). Обратите
также внимание на то, что команда вводится по�английски. (Символы
подчеркивания, указанные перед командой ZOOM и режимом ее выполне�
ния ALL, говорят о том, что команда вводится автоматически, а не
пользователем.)

6. Теперь снова посмотрите на панель Стандартная (Standard), туда, где
раньше находилась кнопка Показать рамкой (Zoom Window). Теперь на
этом месте находится кнопка Показать все (Zoom All). Основная особен�
ность выдвижных панелей состоит в том, что кнопка, выбранная после�
дней, занимает место предыдущей кнопки на основной панели. Теперь,
если вам понадобиться в следующий раз воспользоваться инструментом
Показать все (Zoom All), вы будете освобождены от необходимости сно�
ва открывать выдвижную панель — вам достаточно будет просто щелк�
нуть на кнопке Показать все (Zoom All) панели инструментов Стандарт�
ная (Standard), как если бы она была обычной кнопкой этой панели
(рис. Б.13). Порядок следования кнопок на выдвижной панели остается
неизменным, поэтому при повторном открытии панели Зумирование
(Zoom) кнопка Показать рамкой (Zoom Window) снова окажется на са�
мом ее верху.

Остальные выдвижные панели работают точно так же, как только что рас�
смотренная панель Зумирование (Zoom). Строго говоря, можно не использо�
вать выдвижные панели, поскольку все представленные в них инструменты на�
ходятся на обычных панелях инструментов с соответствующими названиями.
Так, открыв список панелей инструментов AutoCAD, как показано на рис. Б.11,
вы увидите в этом списке панель инструментов Зумирование (Zoom). Включив
отображение этой панели, легко убедиться, что она содержит все инструмен�
ты, представленные в виде выдвижной панели Зумирование (Zoom) панели
инструментов Стандартная (Standard), показанной на рис. Б.12. Однако рабо�
тать с выдвижными панелями все же удобнее, по�

Рис. Б.13  Кнопка Показать все (Zoom All) заняла место
кнопки Показать рамкой (Zoom Window)
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скольку они позволяют рациональнее использовать область черчения, поэто�
му они интенсивно применять их при изучении дальнейшего материала этой
книги.

Б.5.2. Размещение панелей в окне AutoCADБ.5.2. Размещение панелей в окне AutoCADБ.5.2. Размещение панелей в окне AutoCADБ.5.2. Размещение панелей в окне AutoCADБ.5.2. Размещение панелей в окне AutoCAD
Для того чтобы увидеть, как в AutoCAD можно манипулировать панелями ин�
струментов, мы воспользуемся панелью Редактирование (Modify). Как отмеча�
лось выше, по умолчанию эта панель пристыкована к правой границе окна
AutoCAD. Для того чтобы преобразовать ее в плавающую панель, выполните
следующие операции.

1. Подведите указатель мыши к двойной линии, выглядящей, как рифленая
поверхность (у вертикальных пристыкованных панелей эта двойная ли�
ния находится сверху, а у горизонтальных — слева).

2. Нажав левую кнопку мыши, вы увидите, что вокруг панели появилась
тонкая рамка, охватывающая контур панели. Не отпуская кнопку мыши,
переместите указатель влево. Вместе с указателем будет перемещаться и
рамка, как показано на рис. Б.14.

3. Продолжайте перемещать указатель мыши влево. Как только панель Ре�
дактирование (Modify) отстыкуется, рамка станет горизонтальной, а не
вертикальной. Если вы отпустите левую кнопку мыши, на месте широкой
горизонтальной рамки появится плавающая панель Редактирование
(Modify) с заголовком в левой части и кнопкой закрытия в правой части.

4. Поместив указатель на строку заголовка плавающей панели Редактиро�
вание (Modify), нажмите и не отпускайте левую кнопку мыши, а затем
попробуйте переместить панель в другое место экрана. Обратите внима�
ние, что при перемещении панель остается на месте, а двигается всего
прямоугольная рамка тех же размеров, что и панель (рис. Б.15).

5. Подведите указатель мыши к левой границе окна AutoCAD (туда, где на�
ходится пристыкованная панель Рисование (Draw)). Как только указа�
тель мыши (не прямоугольная рамка, а именно указатель) достигнет ле�
вой границы окна, рамка станет снова узкой и вертикальной. Это
означает, что панель готова к пристыковке. Пристыкуйте панель Редак�
тирование (Modify) справа от панели Рисование (Draw).

Плавающие панели не оказывают никакого влияния на размеры области
черчения, но они при этом скрывают ее фрагменты, тогда как каждая присты�
кованная панель занимает место, которое могла бы дополнительно занимать
область черчения. В AutoCAD 2009, в отличие от более ранних версий, в кото�
рых отсутствовала уже упоминавшаяся выше кнопка Очистить экран (Clear
Screen), экономия пространства на экране не является принципиальным фак�

тором. Действительно, если, щелкнув на кнопке Очистить экран
(Clear Screen), в любой момент можно переключиться в режим чистого

Рис. Б.14  Отстыковка панели Редактирование (Modify)

Рис. Б.15  Перемещение плавающей панели Редактирование (Modify)

экрана, то снижение производительности из�за загромождения области черче�
ния плавающими панелями инструментов, практически нивелируется.

Однако при обучении основам работы в AutoCAD все же лучше начинать с
минимального набора инструментов, подключая дополнительные панели по
мере необходимости. Поэтому в главах основного материала книги автор будет
считать, что вы оставили на экране лишь панель Стандартная (Standard), при�
стыкованную к верхней границе окна, а также панели Рисование (Draw) и Ре�
дактирование (Modify), пристыкованные к левой границе окна, как показано
на рис. Б.16.

Совет. Для включения двухмерного изображения пиктограммы ПСК, как пока�
зано на рис. Б.16, выберите из меню команду Вид ⇒  ⇒  ⇒  ⇒  ⇒ Отображение ⇒  ⇒  ⇒  ⇒  ⇒ Знак
ПСК ⇒ ⇒ ⇒ ⇒ ⇒ Свойства (View ⇒ Display ⇒ UCS icon ⇒ Properties). В открывшемся
диалоговом окне Знак ПСК (UCS Icon) выберите переключатель 2D в группе
Стиль знака ПСК (UCS icon style) и щелкните на кнопке OK. Впрочем, стиль
отображения пиктограммы ПСК не влияет на работу AutoCAD, поэтому дан�
ную настройку можно и не выполнять.

Если вам удалось расположить панели Рисование (Draw) и Редактирова�
ние (Modify), как показано на рис. Б.16, а также добиться соответствия распо�
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Рис. Б.16  Окно AutoCAD 2009 настроено для работы с данной книгой

ложения и настройки других элементов окна AutoCAD на вашем ПК расположе�
нию и настройке аналогичных элементов на рис. Б.16, можете переходить к
изучению заключительных разделов этого приложения. В противном случае
вернитесь к его началу и попробуйте разобраться в том, как решить соответ�
ствующую проблему, поскольку в основном материале книге такого внимания
вопросам настройки интерфейса уже не уделяется — автор исходит из того, что
вы научились выполнять все операции, описанные в данном приложении.

Б.5.3. Настройка панелей инструментовБ.5.3. Настройка панелей инструментовБ.5.3. Настройка панелей инструментовБ.5.3. Настройка панелей инструментовБ.5.3. Настройка панелей инструментов
Опытный пользователь AutoCAD может настроить конфигурацию любой пане�
ли инструментов по своему усмотрению — добавить или удалить кнопки, со�
здать новую панель и даже создать новые инструменты, отсутствующие в
AutoCAD. Эти операции выполняются с помощью диалогового окна Настрой�
ка интерфейса пользователя (Customize User Interface) (рис. Б.17), открыть
которое можно с помощью команды Вид ⇒  ⇒  ⇒  ⇒  ⇒ Панели (View ⇒ Toolbars) либо с
помощью команды Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Адаптация ⇒  ⇒  ⇒  ⇒  ⇒ Интерфейс (Tools ⇒ Customize ⇒
Interface).

Однако одно лишь подробное описание диалогового окна Настройка ин�
терфейса пользователя (Customize User Interface) потребует объема, соответ�

Рис. Б.17  Диалоговое окно Настройка интерфейса
пользователя (Customize User Interface)

ствующего объему данной книги. Поэтому автор, упомянув о наличии в
AutoCAD 2009 инструментов, позволяющих настроить пользовательский ин�
терфейс, все же рекомендует читателям этой книги отложить изучение мето�
дов настройки на будущее, пока вы не приобретете опыт выполнения обычных
операций.

Б.6. Использование клавиатуры и мышиБ.6. Использование клавиатуры и мышиБ.6. Использование клавиатуры и мышиБ.6. Использование клавиатуры и мышиБ.6. Использование клавиатуры и мыши
Нетрудно догадаться, что поскольку командное окно является одним из важ�
нейших элементов пользовательского интерфейса AutoCAD, при черчении вы
будете очень часто использовать клавиатуру для ввода команд и необходимых
им данных. Более того — опытные пользователи часто предпочитают вводить
команды именно в командном окне, а не выбирать их из меню или запускать с
помощью панелей инструментов. Это объясняется тем, что в AutoCAD поддер�
живаются так называемые псевдонимы команд (alias keys) — сокращения из одно�
го�двух символов, позволяющие быстро вводить команды и названия их режи�
мов в командном окне. Например, упоминавшуюся команду Íàñòðîéêà
(OPTIONS) можно запустить, просто введя в командном окне псевдоним íà
(OP), команду Ïîêàçàòü ðàìêà (ZOOM WINDOW) — псевдоним ïî ð (Z W)
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(т.е. последовательно нажав П, О (Z), Enter, Р (W), Enter), а команду Ïîêàçàòü
âñå (ZOOM ALL) — псевдоним ïî â (Z A). В главах основного материала соот�
ветствующие вопросы рассматриваются подробнее, поэтому, возможно, вы
также со временем начнете запускать команды, вводя их псевдонимы.

Кроме псевдонимов команд, AutoCAD поддерживает клавиатурные эквивален�
ты (shortcut keys), которые представляют собой комбинации клавиш, нажатие
которых приводит к запуску той или иной команды либо к включению или от�
ключению того или иного режима. В качестве клавиатурных эквивалентов мо�
гут использоваться комбинации буквенно�цифровых клавиш с Ctrl и Shift (на�
пример, Ctrl+O — команда Файл ⇒  ⇒  ⇒  ⇒  ⇒ Открыть (File ⇒ Open), Ctrl+Shift+C —
команда Правка ⇒  ⇒  ⇒  ⇒  ⇒ Копировать с базовой точкой (Edit  Copy with Base Point) и
т.п.). Функциональные клавиши также могут быть клавиатурными эквивалента�
ми команд (например, F9 — включение или выключение режима объектной
привязки, F7 — включение или выключение режима привязки к сетке и т.п.).
Знание клавиатурных эквивалентов, как и знание псевдонимов команд, позво�
ляет опытным пользователям существенно повысить производительность ра�
боты в AutoCAD.

Наконец, как уже упоминалось ранее в разделе «Система меню», клавиату�
рой можно пользоваться вместо мыши для выбора из меню содержащихся в
них команд. Как вы знаете, в Windows в названии команды меню любого при�
ложения обычно имеется подчеркнутый символ. Это позволяет  нажать кла�
вишу с соответствующим символом вместе с Alt для быстрого открытия этого
меню, а затем клавишу с подчеркнутым символом нужной вам команды. Соот�
ветствующие клавиши называются клавишами ускоренного запуска команд (hot
keys). Например, для быстрого открытия окна Настройка (Options) (команда
Сервис ⇒ ⇒ ⇒ ⇒ ⇒ Настройка (Tools ⇒ Options)) можно нажать Alt+C, Й (Alt+T, N).
Поскольку в AutoCAD, в отличие от многих других приложений Windows, кла�
виатурных эквивалентов не так уж и много, запомнив последовательности
клавиш ускоренного запуска команд, можно также повысить производитель�
ность работы в AutoCAD.

Конечно же, клавиатура, в AutoCAD является далеко не единственным,
хотя и очень важным устройством черчения. Не умаляя важность клавиатуры,
следует признать, что основным инструментом современного конструктора,
работающего в AutoCAD, является устройство указания (pointing device). Таким
устройством может быть специальный планшет, графическое перо или дру�
гое профессиональное устройство. Однако подавляющее большинство как на�
чинающих, так и опытных пользователей применяют для работы шарово�кно�
почный (ШКМ) или оптико�кнопочный (ОКМ) манипулятор, известный как
«компьютерная мышь», или просто мышь (mouse). Автор в последующих гла�
вах будет, во�первых, использовать обиходное название, а во�вторых, исхо�
дить из того, что вы применяете для управления AutoCAD и создания черте�
жей именно мышь, а не какое�то другое устройство. Мыши современных ПК
могут иметь две или три кнопки. Для открытия меню, выбора команд из
меню, а также для перемещения меню, панелей или окон используется основ�

ная кнопка мыши, функции которой, как вы, наверное, догадались, в этой гла�
ве выполняла левая кнопка. Поскольку большинство пользователей ПК явля�
ются правшами, автор, говоря о левой кнопке, в дальнейшем будет понимать
именно основную кнопку мыши, т.е. кнопку, которую пользователь нажимает
указательным пальцем.

Правая (т.е. вспомогательная) кнопка мыши  используется для выполнения
следующих операций.
� Открытие контекстного меню (context menu) — меню, содержимое которо�

го зависит от объекта, на котором вы щелкнули правой кнопкой мыши, и
(или) его состоянии (т.е. от контекста). Пример контекстного меню
представлен на рис. Б.11.
� Открытие специального меню с использованием нажатия Shift (с этим

меню вы будет работать в последующих главах).

В трехкнопочной мыши средняя кнопка обычно по умолчанию запрограм�
мирована на открытие уже упоминавшегося специального меню, тем самым за�
меняя использование правой кнопки вместе с нажатием Shift. Если мышь обо�
рудована колесиком прокрутки, то при щелчке кнопкой, расположенной под
колесиком, запускается команда Панорамирование в реальном времени (Pan
Realtime), а при вращении колесика — команда Показать в реальном времени
(Zoom Realtime). О том, что собой представляют эти очень популярные коман�
ды AutoCAD, вы узнаете в последующих главах книги.

На этом вводная глава по интерфейсу AutoCAD 2009 закончена. Автор наде�
ется, что вы настроили окно AutoCAD 2009 в соответствии с рис. Б.16, а также
разобрались как в методах использования панелей инструментов, меню и ко�
мандного окна, так и в методах использования для этого клавиатуры и мыши.
Если вы собираетесь на этом завершить сеанс работы в AutoCAD, выберите ко�
манду Файл ⇒  ⇒  ⇒  ⇒  ⇒ Выход (File ⇒ Exit) или нажмите Alt+F4 и выйдите из AutoCAD,
не сохраняя текущего документа. Далее переходите к чтению главы 2, в кото�
рой вы изучите команды, позволяющие создать простейший чертеж.
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В этом приложении описаны основные приемы управления элементами
окна AutoCAD 2010, а также принципы настройки AutoCAD 2010 для
работы с данной книгой.

В.1. Первый запуск AutoCAD 2010В.1. Первый запуск AutoCAD 2010В.1. Первый запуск AutoCAD 2010В.1. Первый запуск AutoCAD 2010В.1. Первый запуск AutoCAD 2010
При установке приложения AutoCAD в стандартной конфигурации для его за�
пуска достаточно выбрать команду Пуск ⇒  ⇒  ⇒  ⇒  ⇒ Все программы ⇒  ⇒  ⇒  ⇒  ⇒ Autodesk ⇒ ⇒ ⇒ ⇒ ⇒
AutoCAD 2010 ⇒  ⇒  ⇒  ⇒  ⇒ AutoCAD 2010 (рис. В.1.). Если же при установке на вашем ПК
стандартная конфигурация AutoCAD 2010 была изменена, найдите значок
AutoCAD 2010 самостоятельно, а затем запустите программу, как любое другое
приложение Windows XP.

При первом запуске AutoCAD 2010 появляется окно Начальная настройка
(Initial Setup). Это окно (рис. В.2) представляет собой первое из трех диалого�
вых окон мастера начальной стройки. Опытные пользователи AutoCAD с помо�
щью мастера начальной настройки могут упростить настройку AutoCAD 2010 в
соответствии со своими потребностями. Поскольку данная книга предназначе�
на для начинающих пользователей, необходимость в использовании мастера
начальной настройки у вас вряд ли возникнет. Поэтому щелкните на кнопке
Пропустить (Skip) для продолжения запуска AutoCAD 2010.

Для того чтобы мастер начальной настройки не запускался автоматически
при последующих запусках AutoCAD 2010, следует сбросить флажок Напом�
нить при следующем запуске AutoCAD 2010 (Remind me the next time
AutoCAD 2010 starts), который появится в следующем окне мастера, а затем
щелкнуть на кнопке Запуск AutoCAD 2010 (Start AutoCAD 2010). В случае, если у

ВПриложениеПриложениеПриложениеПриложениеПриложение
Основы работы вОсновы работы вОсновы работы вОсновы работы вОсновы работы в
AutoCAD 2010AutoCAD 2010AutoCAD 2010AutoCAD 2010AutoCAD 2010

Рис. В.1  Запуск AutoCAD 2010

вас все же впоследствии возникнет необходимость запуска этого мастера, вы
всегда сможете запустить его вручную, воспользовавшись кнопкой Начальная
настройка (Initial Setup), которая находится на вкладке Пользовательские
(User Preferences) диалогового окна Настройка (Options).

Затем на экране появляется окно Семинар по новым возможностям (New
Features Workshop) (рис. В.3), с помощью которого можно ознакомиться с но�
выми возможностями AutoCAD 2010 по сравнению с предыдущими версиями.
Выберите в этом окне переключатель Больше не предлагать (No, don’t show
me this again), чтобы это окно больше не появлялось (если у вас возникнет та�
кая необходимость, вы всегда сможете ознакомиться с новинками, выбрав из
меню AutoCAD команду Справка ⇒  ⇒  ⇒  ⇒  ⇒ Новые возможности (Help ⇒ New
Features Workshop)).

Затем AutoCAD выполнит настройку рабочего пространства (если вы не ис�
пользовали мастера начальной настройки, по умолчанию используется рабо�
чее пространство 2D рисование и аннотации (2D Drafting & Annotation)), пос�
ле чего на экране появится окно AutoCAD 2010, которые специалисты
называют также графическим пользовательским интерфейсом (GUI — graphical user
interface).

Первый запуск AutoCAD 2010Первый запуск AutoCAD 2010Первый запуск AutoCAD 2010Первый запуск AutoCAD 2010Первый запуск AutoCAD 2010
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Рис. В.2  Окно Начальная настройка (Initial Setup)

тации (2D Drafting & Annotation), 3D моделирование (3D Modeling) и Класси�
ческий AutoCAD (AutoCAD Classic). Поскольку мы в этой книге будем работать
с классическими средствами AutoCAD, щелкните на кнопке строки состояния
Переключение рабочих пространств (Workspace Switching), как показано на
рис. В.4, и выберите из открывшегося меню рабочее пространство Классичес�
кий AutoCAD (AutoCAD Classic), после чего окно AutoCAD приобретет вид, по�
казанный на рис. В.5.

В.2. Основные элементы классического интерфейсаВ.2. Основные элементы классического интерфейсаВ.2. Основные элементы классического интерфейсаВ.2. Основные элементы классического интерфейсаВ.2. Основные элементы классического интерфейса
AutoCAD и его настройкаAutoCAD и его настройкаAutoCAD и его настройкаAutoCAD и его настройкаAutoCAD и его настройка
Основные элементы окна AutoCAD 2010 с классическим интерфейсом (строка
заголовка, система меню и панели инструментов) полностью аналогичны соответ�
ствующим элементам любого современного приложения для Windows. Так, в
строке заголовка отображаются имя активного приложения AutoCAD 2010 и
имя текущего файла чертежа Чертеж1.dwg (Drawing1.dwg). Система меню так�
же должна быть знакома любому пользователю Windows. В частности, несколь�
ко меню (Файл (File), Правка (Edit), Вид (View), Окно (Window) и Справка

Рис. В.3  Окно Семинар по новым возможностям (New Features Workshop)

Как и в AutoCAD 2007/2008/2009, в AutoCAD 2010 используются рабочие про�
странства (workspace) — удобный инструмент, который опытные пользователи
AutoCAD применяют для быстрой настройки всех параметров своего экземпля�
ра AutoCAD, включая файлы чертежей. В AutoCAD 2010, как и в AutoCAD 2008/
2009, имеется три стандартных рабочих пространства: 2D рисование и анно� Рис. В.4  Меню кнопки Переключение рабочих пространств (Workspace Switching)
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Рис. В.5  Вид AutoCAD 2010 с классическим пользовательским интерфейсом

(Help)) присутствуют практически во всех системах меню Windows, хотя ука�
занные меню в AutoCAD содержат ряд дополнительных команд. Кроме того, в
систему меню AutoCAD 2010 входят меню, специфичные только для AutoCAD
(Вставка (Insert), Формат (Format), Сервис (Tools), Рисование (Draw), Разме�
ры (Dimension), Редактировать (Modify), Параметрические (Parametric) и
Express). Под системой меню в классическом рабочем пространстве располо�
жены панели инструментов Стандартная (Standard), Стили (Styles), Рабочие
пространства (Workspaces), Слои (Layers), Свойства (Properties). Практичес�
ки все кнопки этих панелей, кроме нескольких кнопок панели Стандартная
(Standard), начинающему пользователю AutoCAD будут незнакомы. Именно
изучению инструментов и команд AutoCAD, представленных кнопками этих и
других панелей инструментов, строго говоря, и посвящена данная книга. По�
этому сейчас мы не будем на них останавливаться, поскольку каждый из основ�
ных инструментов черчения AutoCAD описывается в главах книги по мере изу�
чения материала.

У левой и правой границ экрана AutoCAD отображаются еще три панели ин�
струментов: слева — Рисование (Draw), а справа Редактировать (Modify) и По�
рядок прорисовки (Draw Order). Это обычные панели инструментов, которые
по умолчанию располагаются не по горизонтали, а по вертикали. Объект, кото�

рый находится в незанятой области окна AutoCAD, представляет собой еще
одну панель инструментов Сглаживание сети (Smooth Mesh). Эта панель инст�
рументов отображается в режиме плавающей панели. О том, как работать с пла�
вающими панелями инструментом рассказывается далее в этом приложении.

Второй объект, который находится в незанятой области окна AutoCAD, —
это палитра (palette) Палитры инструментов (Tool Palettes). В данной книге
эта палитра не используется, поэтому ее можно закрыть, щелкнув на кнопке
Закрыть (Close), подобной аналогичной кнопке обычного окна Windows.

В AutoCAD 2010, как и в AutoCAD 2009, используется обозреватель меню (menu
browser), подобный кнопке Пуск Windows. Обозреватель меню представлен
большой кнопкой в левом верхнем углу окна AutoCAD 2010 с логотипом про�
граммы. Щелкнув на этой кнопке, можно получить доступ к командам меню, к
спискам недавно открывавшихся чертежей и выполнявшихся операций, к
списку открытых чертежей, а также к кнопке открытия диалогового окна Па�
раметры (Options) и команде Выход из AutoCAD (Exit AutoCAD).

Упоминавшаяся выше белая пустая область, находящаяся посреди экрана, в
AutoCAD имеет специальное название — область черчения (drawing area). Указа�
тель мыши, попадая в эту область при перемещении по экрану, принимает фор�
му указателя�перекрестия (crosshair cursor). При использовании некоторых ко�
манд AutoCAD указатель может принимать и другие формы, в зависимости от
назначения команды и этапа ее выполнения.

Кроме того, в окне AutoCAD 2010, как и в любом другом окне приложения
Windows, могут отображаться полосы прокрутки. В общем случае использовать
полосы прокрутки в AutoCAD не рекомендуется, поскольку они не только ме�
нее удобны, чем инструменты масштабирования и панорамирования AutoCAD,
но еще и занимают место в области черчения. Поэтому сейчас мы отключим
отображение полос прокрутки, а также заодно изменим цвет области черче�
ния. Эти и другие операции настройки интерфейса AutoCAD выполняются с
помощью диалогового окна Настройка (Options), которое вы будете очень час�
то использовать в работе.

1. Если вы еще не закрыли палитру Палитры инструментов (Tool Palettes),
щелкните на кнопке Закрыть (Close) этой палитры, которая находится в
ее правом верхнем углу.

2. Выберите из меню команду Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Настройка (Tools ⇒ Options). От�
кроется диалоговое окно Настройка (Options), показанное на рис. В.6,
которое содержит десять вкладок.

3. Перейдите в окне Настройка (Options) на вкладку Экран (Display), на
которой представлены параметры, управляющие отображением элемен�
тов графического интерфейса AutoCAD (рис. В.7).

4. Если в группе Элементы окна (Window Elements) установлен флажок
Полосы прокрутки (Display scroll bars in drawing window), как показано
на рис. В.7, щелкните на нем для его сброса и отключения соответствую�
щего режима. Не спешите щелкать на кнопке OK — настройку интерфей�
са мы еще не закончили.
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Рис. В.6  Вкладка Файлы (Files) диалогового окна Настройка (Options)

указателем�перекрестием работать удобнее, чем при размере, установ�
ленным по умолчанию.

6. Если вас отвлекает темная цветовая схема AutoCAD 2010, выберите из
списка Цветовая схема (Color scheme) группы Элементы окна (Window
Elements) цветовую схему Светлая (Light), которая ближе к традицион�
ной гамме окон Windows XP (других вариантов цветовых схем разработ�
чики компании Autodesk, к сожалению, не предлагают).

7. Теперь щелкните на кнопке Цвета (Colors), расположенной в нижней
части группы Элементы окна (Window Elements). В открывшемся диало�
говом окне Цветовая гамма окна чертежа (Drawing Window Colors) вы�
берите в списке Контекст (Context) элемент Пространство 2D модели
(2D model space), а в списке Элемент интерфейса (Interface Element) —
элемент Однородный фон (Uniform background). Затем раскройте спи�
сок Цвет (Color) и выберите из него цвет Белый (White). Область про�
смотра Образец (Preview) окна Цветовая гамма окна чертежа (Drawing
Window Colors) примет вид, показанный на рис. В.8.

8. Щелкните на кнопке Принять (Apply & Close) для закрытия окна Цвето�
вая гамма окна чертежа (Drawing Window Colors), а затем на кнопке OK
диалогового окна Настройка (Options).

Теперь цвет области черчения окна AutoCAD изменился на чистый белый, а
цветовая гамма окна — на более светлую. Кстати, если вы выберите другой цвет
для области черчения, AutoCAD автоматически подберет цвет указателя так,
чтобы он был хорошо виден на фоне выбранного вами цвета. Кроме того, если
вы установили максимальный размер для указателя�перекрестия, эти измене�
ния вы также легко заметите.

Рис. В.7  Вкладка Экран (Display) диалогового окна Настройка (Options)

5. Найдите в правом нижнем углу вкладки строку ввода Размер перекрес�
тья (Crosshair size). Если вы хотите, чтобы экран вашего ПК при изуче�
нии этой книги выглядел точно так же, как и экран автора, введите в этой
строке значение 100 (или просто переместите бегунок право до конца). В
этом случае линии перекрестия будут уходить за границы экрана. Многие
опытные пользователи AutoCAD (в том числе и автор) считают, что так с Рис. В.8  Диалоговое окно Цветовая гамма окна чертежа (Drawing Window Colors)
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Теперь давайте рассмотрим другие элементы окна AutoCAD. Во�первых, в
нижнем левом углу окна области черчения отображается пиктограмма с двумя
стрелками. Эта пиктограмма называется ПСК (пользовательская система коор�
динат) и используется для обозначения положительных направлений осей ко�
ординат X и Y. Для работы с этой книгой пиктограмма ПСК практически не
нужна, поэтому в основном материале книги вы узнаете, как ее отключить.

Во�вторых, под пиктограммой ПСК находятся ярлычки листов модели Мо�
дель (Model) и листов компоновок Лист1 (Layout1) и Лист2 (Layout2). Эти яр�
лычки используются для быстрого переключения между режимами работы в
пространстве модели (model space) и в пространстве листа (paper space). Подроб�
нее о том, что такое компоновки и чем они отличаются от модели, также рас�
сказывается в основном материале книги.

Третий по порядку (но не по важности) элемент окна AutoCAD 2010, — это
командное окно (рис. В.9).

Командное окно (command window) — это, без преувеличения, «сердце»
AutoCAD. В этом окне пользователь может вводить команды, а также задавать
их параметры. Кроме того, в командном окне выводится информация о выпол�
няемых AutoCAD операциях. Значимость командного окна очень высока, по�
скольку все команды меню и кнопки панелей инструментов представляют со�
бой, по сути, лишь «надстройку» над командами AutoCAD, которые изначально
предназначались для ввода в командном окне. Кроме того, существуют некото�
рые команды, которые можно ввести только в командном окне. Поэтому автор
советует вам уделить самое пристальное внимание изучению методов работы с
этим элементом интерфейса AutoCAD. Подробнее о настройке командного
окна мы поговорим далее в этом приложении.

Под командным окном расположена строка состояния (status bar). В отличие
от других приложений, в которых строка состояния используется от случая к
случаю, в AutoCAD этот элемент интерфейса применяется очень активно. Во�
первых, в строке состояния отображаются текущие координаты указателя�пере�
крестия. Во�вторых, с помощью находящихся на ней кнопок�индикаторов мож�
но быстро включать и отключать соответствующие режимы работы AutoCAD. В
AutoCAD 2010 кнопки�индикаторы могут отображаться в режиме значков (уста�
новлен по умолчанию), как показано на рис. В.9, и в текстовом режиме, как пока�
зано на рис. В.10. Логика работы кнопок�индикаторов от режима отображения
не зависит, поэтому если в вашем случае в строке состояния AutoCAD вы видите

пиктограммы, а не текстовые обозначения, можете не волноваться — вскоре вы
узнаете, как переключиться в традиционный режим текстовых обозначений.

Для начинающего пользователя AutoCAD очень важны такие индикаторы,
как ШАГ (SNAP), СЕТКА (GRID), ОРТО (ORTHO) и ПРИВЯЗКА (OSNAP),
поскольку с помощью соответствующих режимов можно быстро научиться со�
здавать точные чертежи. Кроме того, вам могут пригодиться такие кнопки�ин�
дикаторы, как ОТС�ПОЛЯР (POLAR), ОТС�ОБЪЕКТ (OTRACK), ВЕС (LWT)
и МОДЕЛЬ (MODEL), поэтому они также рассматриваются в этой книге. Что
касается кнопок�индикаторов ДПСК (DUCS), ДИН (DYN) и БС (QP), то они
нам не понадобятся. Индикатор ДПСК (DUCS) предназначен для использова�
ния режима динамической ПСК (DUCS — dynamic user coordinate system), кото�
рые используется только при трехмерном моделировании, а индикатор ДИН
(DYN) — для включения режима динамических подсказок, которые многим начи�
нающим пользователям создают дополнительные трудности в освоении базо�
вых приемов черчения. Индикатор БС (QP) предназначен для включения ото�
бражения окна Быстрые свойства (Quick Properties), однако в этой книге
данная функциональность также является избыточной.

Поэтому давайте их отключим, чтобы вы не испытывали затруднений при
дальнейшей работе с книгой.

1. Если кнопки�индикаторы отображаются в режиме значков, щелкните на
любой из них правой кнопкой мыши и выберите из появившегося кон�
текстного меню команду Использовать значки (Use Icons), которая дол�
жна быть помеченной в меню «галочкой». Кнопки�индикторы должны
переключиться в текстовый режим, как показано на рис. В.10.

2. Если кнопки�индикаторы ДПСК (DUCS), ДИН (DYN) и (или) БС (QP)
находятся в нажатом положении (имеют голубой цвет, а не серый), щел�
кните на них, чтобы выключить соответствующие режимы.

3. Щелкните на кнопке раскрытия меню строки состояния, которая нахо�
дится в этой строке правее области уведомлений, и выберите из него
подменю Переключатели режимов (Status Toggles) (рис. В.11). Для от�
крытия меню строки состояния можно также щелкнуть правой кнопкой
мыши на любой незанятой кнопками�индикаторами и кнопками инстру�
ментов области строки состояния.

4. Выберите из подменю Переключатели режимов (Status Toggles) эле�
мент Динамическая ПСК (F6) (Dynamic UCS (F6)). AutoCAD закроет
меню и, отключив отображение кнопки ДПСК (DUCS), перерисует стро�
ку состояния.

5. Снова откройте меню строки состояния, подменю Переключатели ре�
жимов (Status Toggles) и проделайте аналогичную операцию с элемента�
ми Динамический ввод (F12) (Dynamic Input (F12)) и Быстрые свой�
ства (Quick Properties).

6. Обратите внимание на другие значки и индикаторы, представленные
рядом с областью уведомлений и непосредственно в этой области уве�
домлений. Большинство из них в данной книге не используются, по�

Рис. В.9  Командное окно (показано в режиме значков) и строка состояния AutoCAD 2010

Рис. В.10  Командное окно с кнопками�индикаторами в текстовом режиме
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Рис. В.11  Меню строки состояния (сравните с рис.
В.10 и В.9).

Отображение кнопки�индикатора ДПСК (DUCS)
уже отключено, на очереди — отключение ото�
бражения кнопок�индикаторов ДИН (DYN) и
БС (QP)
скольку они не нужны для освоения базовых навы�
ков черчения в AutoCAD. Поэтому откройте меню
строки состояния, как показано на рис. В.11, и от�
ключите элементы Быстрый просмотр листов

(Quick View Layouts), Быстрый просмотр чертежей (Quick View
Drawings), Панорамирование (Pan), Зумирование (Zoom), Штурвал
(SteeringWheel), Аниматор движения (ShowMotion), Масштаб аннота�
ций (Annotation Scale), Видимость аннотаций (Annotation Visibility), Ав�
томасштабирование (AutoScale), Рабочие пространства (Workspaces) и
Блокировка отображения (Display Locking).

7. Снова откройте меню строки состояния, как показано на рис. В.11, и вы�
берите из него элемент Настройка области уведомлений (Tray Settings).
В открывшемся одноименном диалоговом окне сбросьте флажок Пока�
зывать значки служб (Display icons from services) и щелкните на кнопке
OK для закрытия диалогового окна Настройка области уведомлений
(Tray Settings).

8. Нам осталось настроить инструмент Коммуникационный центр
(Communication Center), который постоянно будет уведомлять вас о не�
возможности установки связи с Интернетом (или, что еще хуже, устанав�
ливать такую связь и проверять наличие обновлений и выполнять про�
чие операции без вашего ведома). Поэтому лучше его также отключить.
Щелкните на значке  Коммуникационный центр (Communication
Center) панели инструментов Инфоцентр (InfoCenter), которая нахо�
дится справа в строке заголовка окна AutoCAD.

9. В заголовке открывшейся панели меню Коммуникационный (Commu�

nication Center) щелкните на кнопке  Параметры Инфоцентра (In�
foCenter Settings), которая находится слева от кнопки закрытия этой па�
нели.

10. В разделе Общие (General) открывшегося диалогового окна Параметры
Инфоцентра (InfoCenter Settings) (рис. В.12) выберите в верхнем списке
регион вашего проживания, а в нижнем — элемент Бессрочная (Never).

11. Перейдите в подраздел Всплывающие уведомления (Balloon
Notification) раздела Коммуникационный центр (Communication
Center) и сбросьте флажок Разрешить уведомления для (Enable balloon
notification for).

12. Перейдите в подраздел RSS�каналы (RSS Feeds) этого же раздела, выде�
лите все установленные по умолчанию RSS�ленты, и щелкните на кнопке

Рис. В.12  Диалоговое окно Параметры Инфоцентра (Configurations Settings)

Удалить (Remove). Щелкните на кнопке Да появившегося диалогового
окна подтверждения.

13. Щелкните на кнопке OK диалогового окна Параметры Инфоцентра
(InfoCenter Settings).

Теперь окно AutoCAD должно приобрести вид, показанный на рис. В.13.

Рис. В.13  Окно AutoCAD после настройки параметров строки состояния
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В завершение обсуждения основных элементов окна AutoCAD можно упомя�
нуть о кнопке  Очистить экран (Clear Screen), которая находится в строке
состояния (см. рис. В.13) у правой границы окна AutoCAD. Щелкнув на этой
кнопке, вы перейдете в полноэкранный режим работы AutoCAD с автоматичес�
ким сокрытием всех панелей инструментов и строки заголовка. Это позволяет
обеспечить максимальное использование экрана дисплея, что бывает доста�
точно удобным при работе со сложными чертежами. Повторный щелчок на
кнопке Очистить экран (Clear Screen) приводит к возврату в исходный режим
отображения окна AutoCAD.

В.3. Командное окноВ.3. Командное окноВ.3. Командное окноВ.3. Командное окноВ.3. Командное окно
Командное окно не зависит от других элементов области черчения, поэтому
его можно перемещать в любое место экрана, а также изменять размер. В част�
ности, для того чтобы увеличить высоту командного окна, следует подвести
указатель мыши к горизонтальной границе, отделяющей область черчения от
командного окна. Когда указатель приобретет форму двух параллельных отрез�
ков, сверху и снизу над которыми находятся направленные вверх и вниз верти�
кальные стрелки, нажмите левую кнопку мыши и переместите указатель в нуж�
ном направлении на высоту нескольких строк текста. Добившись
необходимого вам положения границы, отпустите кнопку мыши. После завер�
шения работы AutoCAD состояние командного окна будет сохранено и при сле�
дующем запуске AutoCAD размер командного окна окажется таким, каким он
был установлен во время предыдущего сеанса работы.

Как уже говорилось выше, командное окно — это исключительно важный
элемент интерфейса AutoCAD. Именно в нем пользователь отдает команды
AutoCAD и получает от AutoCAD нужную ему информацию. Например, открыть
упоминавшееся выше диалоговое окно Настройка (Options) можно, не только
выбрав из меню команду Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Настройка (Tools ⇒ Options), но и введя в
командном окне команду Íàñòðîéêà (OPTIONS). Для этого достаточно на�
брать команду с клавиатуры (соблюдать регистр необязательно) и нажать
Enter. AutoCAD автоматически распознает ввод с клавиатуры и отобразит вве�
денную вами команду в командном окне, а затем откроет диалоговое окно На�
стройка (Options). Закрыв окно Настройка (Options) щелчком на кнопке
Cancel или простым нажатием Esc, попробуйте открыть его снова с помощью
команды меню Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Настройка (Tools ⇒ Options) и понаблюдайте при
этом за командным окном. Если размер окна равен как минимум трем строкам,
вы увидите, что в нем промелькнет команда _options. Это означает, что при
использовании команд меню и панелей инструментов AutoCAD все равно авто�
матически вводит за вас в командном окне соответствующие команды.

Поэтому автор настоятельно рекомендует всем начинающим пользовате�
лям выработать привычку, которая заключается в постоянном наблюдении за
тем, что происходит в командном окне. Это позволит вам избежать множества
недоразумений и досадных ошибок.

Кроме того, из вышесказанного следует сделать вывод о том, что одну и ту
же операцию в AutoCAD  можно выполнить разными способами. Действитель�
но, для запуска большинства команд можно воспользоваться не только клавиа�
турой, но и системой меню либо панелями инструментов. В одних случаях удоб�
нее вводить команды по�старинке, с клавиатуры, а в других — пользоваться
мышью для выбора команд из меню или запуска их с помощью кнопок панелей
инструментов.

О командах, вводимых с клавиатуры, мы будем говорить на протяжении
всей книги, а пока что давайте бегло просмотрим все меню AutoCAD и панели
инструментов, а также кратко поговорим об особенностях их использования в
AutoCAD.

В.4. Система менюВ.4. Система менюВ.4. Система менюВ.4. Система менюВ.4. Система меню
Система меню AutoCAD 2010 состоит из тринадцати меню. Кроме того, к этой
системе можно отнести и кнопку открытия обозревателя меню AutoCAD, кото�
рая находится слева от меню Файл (File). Щелчок на любом из этих элементов
приводит к открытию соответствующего меню. Меню Файл (File), Правка
(Edit), Вид (View), Окно (Window) и Справка (Help) относятся к стандартным
меню Microsoft Windows XP, хотя и со специфическими командами AutoCAD.
Обозреватель меню позволяет получить доступ к тем же командам меню
AutoCAD, но в иной форме, а также к ранее открывавшимся чертежам, откры�
тым чертежам, кнопке открытия диалогового окна Настройка (Options) и
кнопке Выход из AutoCAD (Exit AutoCAD).

Команды меню Файл (File) предназначены для открытия и сохранения но�
вых и существующих чертежей, печати, экспорта файлов в другие форматы,
выполнения некоторых других общих файловых операций, а также выхода из
AutoCAD. Меню Правка (Edit) содержит команды Отменить (Undo) и Повто�
рить (Redo), предназначенные для отмены или повтора операций; Вырезать
(Cut), Копировать (Copy) и Вставить (Paste), используемые для работы с буфе�
ром обмена Windows; а также команды организации внешних связей файлов
AutoCAD и других файлов. Меню Вид (View), помимо команд, предназначен�
ных для управления отображением чертежа в области черчения, содержит ко�
манду Панели (Toolbars), которая, как и в других программах Windows, позво�
ляет настраивать панели инструментов. Меню Окно (Window) и Справка
(Help), в основном, функционируют так же, как и аналогичные меню программ
для Windows.

Остальные меню содержат чаще всего используемые команды AutoCAD. Да�
вайте вкратце рассмотрим назначение команд каждого из меню AutoCAD.
����� Меню Вставка (Insert) содержит команды вставки чертежей и рисунков

(в том числе созданных в других программах) или их фрагментов в теку�
щий чертеж.
����� Меню Формат (Format) содержит команды настройки общих парамет�

ров чертежа.

Система менюСистема менюСистема менюСистема менюСистема меню
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����� Меню Сервис (Tools) содержит специальные команды, которые не отно�
сятся ни к одной из других категорий, например, для программирования
работы AutoCAD с помощью макросов.
����� Меню Рисование (Draw) содержит все основные команды, обеспечиваю�

щие создание новых объектов чертежа (линий, окружностей, много�
угольников и т.д.).
����� Меню Размеры (Dimension) содержит команды для нанесения размеров

на текущем чертеже.
����� Меню Редактировать (Modify) содержит команды, которые, как и ко�

манды меню Рисование (Draw), используются чаще других команд
AutoCAD, поскольку они предназначены для внесения изменений в
объекты текущего чертежа.
����� Меню Параметрические (Parametric) содержит команды, предназначен�

ные для создания параметрических объектов, то есть объектов, вид кото�
рых определяется автоматически заданием определенного параметра,
например длины или диаметра. Для опытных пользователей AutoCAD
возможность создания параметрических объектов является очень мощ�
ным средством автоматизации черчения, однако в этой книге соответ�
ствующие возможности рассматриваться не будут.
����� Меню Express содержит команды вызова пакета Express Tools. (Этот па�

кет является устаревшим и включается в поставку AutoCAD только для
тех пользователей, которые к нему привыкли. При установке с парамет�
рами по умолчанию этого меню и, соответственно, инструментов пакета
Express Tools, в системе меню AutoCAD может и не быть.)

В.5. Панели инструментовВ.5. Панели инструментовВ.5. Панели инструментовВ.5. Панели инструментовВ.5. Панели инструментов
Как уже отмечалось выше, по умолчанию в окне AutoCAD отображается не�
сколько панелей инструментов (toolbar). Однако это только вершина айсберга —
всего в AutoCAD 2010 имеется 44 панели инструментов, на многих из которых
насчитывается не один десяток кнопок. Для того чтобы увидеть список всех
панелей инструментов, достаточно щелкнуть на любой панели инструментов
правой кнопкой мыши. На экране появится контекстное меню, представляю�
щее собой полный список панелей инструментов AutoCAD (рис. В.14).

Те панели инструментов, которые на момент открытия списка отображают�
ся в окне AutoCAD, помечены в списке «галочкой». Если щелкнуть на помечен�
ном элементе списка, контекстное меню закроется, а соответствующая панель
инструментов перестанет отображаться в окне AutoCAD. Для включения ото�
бражения панели нужно снова открыть это контекстное меню, щелкнув правой
кнопкой мыши на любой из оставшихся панелей инструментов, и выбрать из
списка панель, рядом с названием которой нет «галочки».

Кроме того, любая панель инструментов AutoCAD может быть как пристыко�
ванной (docked toolbar), так и плавающей (floating toolbar). Пристыкованными
называются панели инструментов, которые прикреплены к одной из границ

Рис. В.14  Список панелей инструментов AutoCAD 2010

окна документа AutoCAD, т.е. панели инструментов в их традиционном смыс�
ле, как, например, все панели, показанные на рис. В.14, кроме панели Сглажи�
вание сети (Smooth Mesh). Последняя, как уже отмечалось выше, является пла�
вающей панелью инструментов. Плавающие панели инструментов
представляют собой небольшие окна, которые можно свободно перемещать по
экрану. Любая плавающая панель, помещенная рядом с границей окна, автома�
тически становится пристыкованной и наоборот — любую пристыкованную па�
нель можно отстыковать и сделать плавающей. Поскольку освоение работы с
панелями инструментов — это достаточно важный аспект, он будет рассмотрен
подробнее в этом приложении. А пока что откройте список панелей инстру�
ментов и отключите все панели, кроме Стандартная (Standard), Рисование
(Draw) и Редактирование (Modify).

Следует отметить, что на многих панелях имеются скрытые кнопки, кото�
рые не всегда отображаются на экране. Такие кнопки нужно выбирать из свое�
образного графического меню, называемого выдвижной панелью (flyout). В част�
ности, на панели Стандартная (Standard) имеется такая выдвижная панель —
если вы внимательно присмотритесь к кнопкам панели Стандартная
(Standard), то увидите в правом нижнем углу одной из кнопок маленький треу�
гольник (по умолчанию эта кнопка называется Показать рамкой (Zoom
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Window) и на ней изображена лупа). О том, как работать с выдвижными панеля�
ми, мы поговорим подробнее в следующем подразделе.

Остальные кнопки панели Стандартная (Standard) — это обычные кнопки
приложения Windows (многие из них вам наверняка покажутся знакомыми).
Кнопки панели Рисование (Draw), которая по умолчанию располагается у ле�
вой границы окна AutoCAD, предназначены для создания объектов чертежа.
Среди них имеется одна выдвижная панель, которая по умолчанию представле�
на кнопкой Вставить блок (Insert Block). Кнопки панели Редактирование
(Modify), расположенной у правой границы окна AutoCAD, предназначены для
внесения изменений в объекты чертежа, созданные с помощью инструментов
панели Рисование (Draw). Выдвижных панелей на этой панели инструментов
нет. Подробнее с инструментами панелей Стандартная (Standard), Рисование
(Draw) и Редактирование (Modify) вы можете ознакомиться в главах основно�
го материала книги.

В.5.1. Выдвижные панелиВ.5.1. Выдвижные панелиВ.5.1. Выдвижные панелиВ.5.1. Выдвижные панелиВ.5.1. Выдвижные панели
Итак, если с использованием обычных кнопок панелей инструментов даже у
начинающих пользователей проблем, как правило, не возникает, то для освое�
ния методов работы с выдвижными панелями требуется некоторая практика.
Самое большое затруднение, которое испытывают начинающие пользователи
при работе с такими панелями, заключается в том, что они не могут найти на
панели инструментов скрытую кнопку выдвижной панели. Поэтому для освое�
ния навыков работы с выдвижными панелями выполните следующие операции.

1. Поместите указатель на кнопку  Показать рамкой (Zoom Window) па�
нели инструментов Стандартная (Standard). (На пиктограмме кнопки,
как уже говорилось выше, изображена лупа, под стеклом которой видна
прямоугольная рамка.)

2. Подержите указатель на этой кнопке в течение 1�2 с, не щелкая мышью.
Рядом с указателем мыши появится название команды, которой соответ�
ствует эта кнопка (в данном случае — Показать рамкой (Zoom Window)).
Это так называемая контекстная подсказка (tooltip), которой снабжены
все инструменты AutoCAD. Именно с помощью контекстной подсказки
можно узнать название нужного вам инструмента. Для этого достаточно
подвести указатель мыши к панели инструментов, а затем поочередно
останавливать его на 1�2 с на каждом инструменте, до тех пор, пока не
увидите контекстную подсказку с нужным вам названием.

3. Теперь поместите указатель на кнопку (вы, наверное, обратили внима�
ние на черный треугольник в правом нижнем углу ее пиктограммы) и,
нажав левую кнопку мыши, удерживайте ее нажатой. Под кнопкой Пока�
зать рамкой (Zoom Window) появится графическое меню, состоящее из
девяти кнопок (верхняя кнопка в этом меню аналогична нажатой кнопке
панели инструментов Стандартная (Standard)). Это графическое меню
из кнопок и называется выдвижной панелью.

4. Продолжая удерживать левую кнопку мыши, медленно ведите указатель
вниз, поочередно останавливая его на 1�2 с на каждой кнопке. Кнопки
при этом будут вам «представляться», показывая свои названия во всплы�
вающих подсказках. «Познакомившись» со всеми кнопками, подведите
указатель мыши к кнопке Показать все (Zoom All). Увидев контекстную
подсказку с названием этой кнопки, как показано на рис. В.15, отпустите
левую кнопку мыши. Выдвижная панель закроется, а AutoCAD выполнит
команду Показать все (Zoom All).

5. Посмотрите на командное окно в нижней части экрана. Если вы увеличи�
те высоту командного окна примерно в два раза (так, чтобы в нем отобра�
жалось 5�6 строк), то увидите в нем, что при выполнении команды Пока�
зать все (Zoom All) в командном окне автоматически была введена
команда Ïîêàçàòü âñå (ZOOM ALL). Обратите также внимание на то,
что команда вводится по�английски. (Символы подчеркивания, указан�
ные перед командой ZOOM и режимом ее выполнения ALL, говорят о том,
что команда вводится автоматически, а не пользователем.)

6. Теперь снова посмотрите на панель Стандартная (Standard), туда, где
раньше находилась кнопка Показать рамкой (Zoom Window). Теперь на
этом месте находится кнопка Показать все (Zoom All). Основная особен�
ность выдвижных панелей состоит в том, что кнопка, выбранная после�
дней, занимает место предыдущей кнопки на основной панели. Теперь,
если вам понадобиться в следующий раз воспользоваться инструментом
Показать все (Zoom All), вы будете освобождены от необходимости сно�
ва открывать выдвижную панель — вам достаточно будет просто щелк�
нуть на кнопке Показать все (Zoom All) панели инструментов Стандарт�
ная (Standard), как если бы она была обычной кнопкой этой панели
(рис. В.16). Порядок следования кнопок на выдвижной панели остается

неизменным, поэтому при повтор�
ном открытии панели Зумирование
(Zoom) кнопка Показать рамкой
(Zoom Window) снова окажется на
самом ее верху.

Рис. В.16  Выбор кнопки Показать
все (Zoom All) из выдвижной

панели инструментов

Рис. В.17  Кнопка Показать все (Zoom
All) заняла место кнопки Показать

рамкой (Zoom Window)
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Остальные выдвижные панели работают точно так же, как только что рас�
смотренная панель Зумирование (Zoom). Строго говоря, можно не использо�
вать выдвижные панели, поскольку все представленные в них инструменты на�
ходятся на обычных панелях инструментов с соответствующими названиями.
Так, открыв список панелей инструментов AutoCAD, как показано на рис. В.14,
вы увидите в этом списке панель инструментов Зумирование (Zoom). Включив
отображение этой панели, легко убедиться, что она содержит все инструмен�
ты, представленные в виде выдвижной панели Зумирование (Zoom) панели
инструментов Стандартная (Standard), показанной на рис. В.15. Однако рабо�
тать с выдвижными панелями все же удобнее, поскольку они позволяют рацио�
нальнее использовать область черчения, поэтому мы будем интенсивно приме�
нять их при изучении дальнейшего материала этой книги.

В.5.2. щение панелей в окне AutoCADВ.5.2. щение панелей в окне AutoCADВ.5.2. щение панелей в окне AutoCADВ.5.2. щение панелей в окне AutoCADВ.5.2. щение панелей в окне AutoCAD
Для того чтобы увидеть, как в AutoCAD можно манипулировать панелями инст�
рументов, мы воспользуемся панелью Редактирование (Modify). Как отмеча�
лось выше, по умолчанию эта панель пристыкована к правой границе окна
AutoCAD. Для того чтобы преобразовать ее в плавающую панель, выполните
следующие операции.

1. Подведите указатель мыши к двойной линии, выглядящей, как рифленая
поверхность (у вертикальных пристыкованных панелей эта двойная ли�
ния находится сверху, а у горизонтальных — слева).

2. Нажав левую кнопку мыши, вы увидите, что вокруг панели появилась
тонкая рамка, охватывающая контур панели. Не отпуская кнопку мыши,
переместите указатель влево. Вместе с указателем будет перемещаться и
рамка, как показано на рис. В.17.

3. Продолжайте перемещать указатель мыши влево. Как только панель Ре�
дактирование (Modify) отстыкуется, рамка станет горизонтальной, а не
вертикальной. Если вы отпустите левую кнопку мыши, на месте широкой
горизонтальной рамки появится плавающая панель Редактирование
(Modify) с заголовком в левой части и кнопкой закрытия в правой части.

4. Поместив указатель на строку заголовка плавающей панели Редактиро�
вание (Modify), нажмите и не отпускайте левую кнопку мыши, а затем
попробуйте переместить панель в другое место экрана. Обратите внима�
ние, что при перемещении панель остается на месте, а двигается всего
прямоугольная рамка тех же размеров, что и панель (рис. В.18).

5. Подведите указатель мыши к левой границе окна AutoCAD (туда, где на�
ходится пристыкованная панель Рисование (Draw)). Как только указа�
тель мыши (не прямоугольная рамка, а именно указатель) достигнет ле�
вой границы окна, рамка станет снова узкой и вертикальной. Это

означает, что панель готова к пристыковке. Пристыкуйте панель Ре�
дактирование (Modify) справа от панели Рисование (Draw).

Рис. В.17  Отстыковка панели Редактирование (Modify)

Рис. В.18  Перемещение плавающей панели Редактирование (Modify)

Плавающие панели не оказывают никакого влияния на размеры области
черчения, но они при этом скрывают ее фрагменты, тогда как каждая присты�
кованная панель занимает место, которое могла бы дополнительно занимать
область черчения. В AutoCAD 2010, в отличие от более ранних версий, в кото�
рых отсутствовала уже упоминавшаяся выше кнопка Очистить экран (Clear
Screen), экономия пространства на экране не является принципиальным фак�
тором. Действительно, если, щелкнув на кнопке Очистить экран (Clear
Screen), в любой момент можно переключиться в режим чистого экрана, то
снижение производительности из�за загромождения области черчения плава�
ющими панелями инструментов практически нивелируется.

Однако при обучении основам работы в AutoCAD все же лучше начинать с
минимального набора инструментов, подключая дополнительные панели по
мере необходимости. Поэтому в главах основного материала книги автор будет
считать, что вы оставили на экране лишь панель Стандартная (Standard), при�
стыкованную к верхней границе окна, а также панели Рисование (Draw) и Ре�
дактирование (Modify), пристыкованные к левой границе окна, как показано
на рис. В.19.

Совет. Для включения двухмерного изображения пиктограммы ПСК, как пока�
зано на рис. В.19 , выберите из меню команду Вид ⇒⇒⇒⇒⇒ Отображение ⇒⇒⇒⇒⇒ Знак
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Рис. В.19  Окно AutoCAD 2010 настроено для работы с данной книгой

ПСК ⇒⇒⇒⇒⇒ Свойства (View ⇒ Display ⇒ UCS icon ⇒ Properties). В открывшемся
диалоговом окне Знак ПСК (UCS Icon) выберите переключатель 2D в группе
Стиль знака ПСК (UCS icon style) и щелкните на кнопке OK. Впрочем, стиль
отображения пиктограммы ПСК не влияет на работу AutoCAD, поэтому дан�
ную настройку можно и не выполнять.

Если вам удалось расположить панели Рисование (Draw) и Редактирова�
ние (Modify), как показано на рис. В.19, а также добиться соответствия распо�
ложения и настройки других элементов окна AutoCAD на вашем ПК расположе�
нию и настройке аналогичных элементов на рис. В.19, можете переходить к
изучению заключительных разделов этого приложения. В противном случае
вернитесь к его началу и попробуйте разобраться в том, как решить соответ�
ствующую проблему, поскольку в основном материале книге такого внимания
вопросам настройки интерфейса уже не уделяется — автор исходит из того, что
вы научились выполнять все операции, описанные в данном приложении.

В.5.3. Настройка панелей инструментовВ.5.3. Настройка панелей инструментовВ.5.3. Настройка панелей инструментовВ.5.3. Настройка панелей инструментовВ.5.3. Настройка панелей инструментов
Опытный пользователь AutoCAD может настроить конфигурацию любой пане�
ли инструментов по своему усмотрению — добавить или удалить кнопки, со�

здать новую панель и даже создать новые инструменты, отсутствующие в
AutoCAD. Эти операции выполняются с помощью диалогового окна Настрой�
ка интерфейса пользователя (Customize User Interface) (рис. В.20), открыть
которое можно с помощью команды Вид ⇒  ⇒  ⇒  ⇒  ⇒ Панели (View ⇒ Toolbars) либо с
помощью команды Сервис ⇒  ⇒  ⇒  ⇒  ⇒ Адаптация ⇒  ⇒  ⇒  ⇒  ⇒ Интерфейс (Tools ⇒ Customize ⇒
Interface).

Однако одно лишь подробное описание диалогового окна Настройка ин�
терфейса пользователя (Customize User Interface) потребует объема, соответ�
ствующего объему данной книги. Поэтому автор, упомянув о наличии в
AutoCAD 2010 инструментов, позволяющих настроить пользовательский ин�
терфейс, все же рекомендует читателям этой книги отложить изучение мето�
дов настройки на будущее, пока вы не приобретете опыт выполнения обычных
операций.

В.6. Использование клавиатуры и мышиВ.6. Использование клавиатуры и мышиВ.6. Использование клавиатуры и мышиВ.6. Использование клавиатуры и мышиВ.6. Использование клавиатуры и мыши
Нетрудно догадаться, что поскольку командное окно является одним из важ�
нейших элементов пользовательского интерфейса AutoCAD, при черчении вы
будете очень часто использовать клавиатуру для ввода команд и необходимых

Рис. В.20  Диалоговое окно Настройка интерфейса
пользователя (Customize User Interface)
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им данных. Более того — опытные пользователи часто предпочитают вводить
команды именно в командном окне, а не выбирать их из меню или запускать с
помощью панелей инструментов. Это объясняется тем, что в AutoCAD поддер�
живаются так называемые псевдонимы команд (alias keys) — сокращения из одно�
го�двух символов, позволяющие быстро вводить команды и названия их режи�
мов в командном окне. Например, упоминавшуюся команду Íàñòðîéêà
(OPTIONS) можно запустить, просто введя в командном окне псевдоним íà
(OP), команду Ïîêàçàòü ðàìêà (ZOOM WINDOW) — псевдоним ïî ð (Z W)
(т.е. последовательно нажав П, О (Z), Enter, Р (W), Enter), а команду Ïîêàçàòü
âñå (ZOOM ALL) — псевдоним ïî â (Z A). В главах основного материала соот�
ветствующие вопросы рассматриваются подробнее, поэтому, возможно, вы
также со временем начнете запускать команды, вводя их псевдонимы.

Кроме псевдонимов команд, AutoCAD поддерживает клавиатурные эквивален�
ты (shortcut keys), которые представляют собой комбинации клавиш, нажатие
которых приводит к запуску той или иной команды либо к включению или от�
ключению того или иного режима. В качестве клавиатурных эквивалентов мо�
гут использоваться комбинации буквенно�цифровых клавиш с Ctrl и Shift (на�
пример, Ctrl+O — команда Файл ⇒  ⇒  ⇒  ⇒  ⇒ Открыть (File ⇒ Open), Ctrl+Shift+C —
команда Правка ⇒  ⇒  ⇒  ⇒  ⇒ Копировать с базовой точкой (Edit ⇒ Copy with Base
Point) и т.п.). Функциональные клавиши также могут быть клавиатурными эк�
вивалентами команд (например, F9 — включение или выключение режима
объектной привязки, F7 — включение или выключение режима привязки к сет�
ке и т.п.). Знание клавиатурных эквивалентов, как и знание псевдонимов ко�
манд, позволяет опытным пользователям существенно повысить производи�
тельность работы в AutoCAD.

Наконец, как уже упоминалось ранее в разделе «Система меню», клавиату�
рой можно пользоваться вместо мыши для выбора из меню содержащихся в
них команд. Как вы знаете, в Windows в названии команды меню любого прило�
жения обычно имеется подчеркнутый символ. Это позволяет  нажать клавишу
с соответствующим символом вместе с Alt для быстрого открытия этого меню,
а затем клавишу с подчеркнутым символом нужной вам команды. Соответству�
ющие клавиши называются клавишами ускоренного запуска команд (hot keys). На�
пример, для быстрого открытия окна Настройка (Options) (команда Сер�
вис ⇒ ⇒ ⇒ ⇒ ⇒ Настройка (Tools ⇒ Options)) можно нажать Alt+C, Й (Alt+T, N).
Поскольку в AutoCAD, в отличие от многих других приложений Windows, кла�
виатурных эквивалентов не так уж и много, запомнив последовательности кла�
виш ускоренного запуска команд, можно также повысить производительность
работы в AutoCAD.

Конечно же, клавиатура, в AutoCAD является далеко не единственным,
хотя и очень важным устройством черчения. Не умаляя важность клавиатуры,
следует признать, что основным инструментом современного конструктора,
работающего в AutoCAD, является устройство указания (pointing device). Таким
устройством может быть специальный планшет, графическое перо или другое
профессиональное устройство. Однако подавляющее большинство как начи�

нающих, так и опытных пользователей применяют для работы шарово�кно�
почный (ШКМ) или оптико�кнопочный (ОКМ) манипулятор, известный как
«компьютерная мышь», или просто мышь (mouse). Автор в последующих гла�
вах будет, во�первых, использовать обиходное название, а во�вторых, исхо�
дить из того, что вы применяете для управления AutoCAD и создания черте�
жей именно мышь, а не какое�то другое устройство. Мыши современных ПК
могут иметь две или три кнопки. Для открытия меню, выбора команд из меню,
а также для перемещения меню, панелей или окон используется основная
кнопка мыши, функции которой, как вы, наверное, догадались, в этой главе
выполняла левая кнопка. Поскольку большинство пользователей ПК являются
правшами, автор, говоря о левой кнопке, в дальнейшем будет понимать имен�
но основную кнопку мыши, т.е. кнопку, которую пользователь нажимает указа�
тельным пальцем.

Правая (т.е. вспомогательная) кнопка мыши  используется для выполнения
следующих операций.
����� Открытие контекстного меню (context menu) — меню, содержимое которо�

го зависит от объекта, на котором вы щелкнули правой кнопкой мыши, и
(или) его состоянии (т.е. от контекста). Пример контекстного меню
представлен на рис. В.11.
����� Открытие специального меню с использованием нажатия Shift (с этим

меню вы будет работать в последующих главах).

В трехкнопочной мыши средняя кнопка обычно по умолчанию запрограм�
мирована на открытие уже упоминавшегося специального меню, тем самым за�
меняя использование правой кнопки вместе с нажатием Shift. Если мышь обо�
рудована колесиком прокрутки, то при щелчке кнопкой, расположенной под
колесиком, запускается команда Панорамирование в реальном времени (Pan
Realtime), а при вращении колесика — команда Показать в реальном времени
(Zoom Realtime). О том, что собой представляют эти очень популярные коман�
ды AutoCAD, вы узнаете в последующих главах книги.

На этом вводная глава по интерфейсу AutoCAD 2010 закончена. Автор наде�
ется, что вы настроили окно AutoCAD 2010 в соответствии с рис. В.19, а также
разобрались как в методах использования панелей инструментов, меню и ко�
мандного окна, так и в методах использования для этого клавиатуры и мыши.
Если вы собираетесь на этом завершить сеанс работы в AutoCAD, выберите ко�
манду Файл ⇒  ⇒  ⇒  ⇒  ⇒ Выход (File ⇒ Exit) или нажмите Alt+F4 и выйдите из AutoCAD,
не сохраняя текущего документа. Далее переходите к чтению главы 2, в кото�
рой вы изучите команды, позволяющие создать простейший чертеж.
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Layers II, панель инструментов, 186
Layout, 412
Linetype, 192, 209

MMMMM
Mirror line, 115
Mirroring, 115
Model space, 418
Multiline text, 325

O�PO�PO�PO�PO�P
Override, 385
Paper space, 418
pickbox cursor, 45
Polyline, 343, 345

R�SR�SR�SR�SR�S
Recreate boundary, кнопка, 322
Rendering, 306
Scale factor, 209, 243
Selecting window, 148
Selection fence, 298
Shortcut key, 32
Single line text, 325
Super Hatch, инструмент, 322, 323
SuperHatch, окно, 322

T�V�W�ХT�V�W�ХT�V�W�ХT�V�W�ХT�V�W�Х
Text style, 325
Viewport, 415
VISRETAIN, переменная

AutoCAD, 397
Wipeout, кнопка, 322
X#ref, 221, 391
Xref Attach, кнопка, 322

ZZZZZ
Zoom window, 86
Zooming, 64

ААААА
Альбомная (Landscape),

переключатель, 430
Альбомы цветов (Color Books),

вкладка, 190

Альт. единицы (Alternate Units),
вкладка, 364

Архитектурные (Architectural),
параметр, 62

БББББ
Базовая точка (Base Point),

группа параметров, 253
Базовая точка (Base point),

определение, 112
Базовая точка блока, 240
Базовый (Baseline Dimension),

инструмент, 368
Без имени (Unnamed), флажок, 233
Безразмерный (Unitless),

параметр, 240, 253
Ближайшая (Nearest), режим

привязки, 251, 252
Блок

базовая точка, 240
вставка, 242, 244
запуск инструмента Make

Block, 239
описание, 248
создание, 238
соотношение со слоями, 232
точка вставки, 240

Блок (Block), 231
Блок (Block), переключатель, 265
Блокировать (Lock), параметр, 188
Быстрая выноска (Quick Leader),

инструмент, 377, 380

ВВВВВ
Ввод координат с клавиатуры, 41
Вес линий (Lineweight), группа

параметров, 459
Вес линий (Lineweight), окно, 459
Вес линий (Lineweight),

параметр, 188
Вид (View), инструмент, 300
Видовой экран

модификация размеров, 425
Видовой экран (Viewport), 415
Видовой экран (Viewport), тип, 426

@ (коммерческое at), ввод
относительных координат, 41

< (меньше), ввод относительных
полярных координат, 43

3D моделирование (3D Modeling), 14

ААААА
acadiso.dwt, шаблон, 37
Arc, инструмент, 109
AutoCAD

выход, 59
графическое окно

удаление элементов, 18
запуск, 14
клавиатурные эквиваленты

команд, 32

ВВВВВ
Base point (Базовая точка), 240
Block, 231
Block definition, 237
Block description, 237
Block reference, 237, 241
Block, кнопка, 322
Boundary edge, 53

ССССС
Continuous, тип линии, 190
Coordinate filter, 259
Crossing window, 122
Cutting edge, 56

DDDDD
DOT, тип линии, 192
Drawing limits, 64
Drawing units, диалоговое окно, 61

EEEEE
Edit Hatch, кнопка, 322
Express ⇒ Draw ⇒ Super Hatch, 322
Express Tools, 24
Express Tools, пакет AutoCAD, 322
Express, дополнительное меню, 25
External References, 391

F�G�HF�G�HF�G�HF�G�HF�G�H
Fence, 298
Gradient, 306
Grid, 64
Grip, 248, 271
Group, 231, 234
Hatch, 306

I�JI�JI�JI�JI�J
Image, кнопка, 322
Insert, диалоговое окно, 242
Insertion point, 237, 253
ISO, вкладка, 312
ISO#25, размерный стиль, 359
Justification point, 335

LLLLL
Layer, 184
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Градусы (Grads), параметр, 63
Грани (Boundary), группа

параметров, 301
Границы (Extents), режим, 456
Границы чертежа (drawing

limits), 64, 67
Графическое окно

удаление управляющих
элементов, 18

Группа (Group), 231, 234
Группы объектов (Object Grouping),

окно, 232, 233

ДДДДД
Декарт, Рене, 42
Декартовы координаты,

относительные, 41, 43
Десятичные (Decimal),

параметр, 61
Десятичные градусы (Decimal

Degrees), параметр, 61, 63
Десятичные метрические единицы

измерения, 61, 64
Диаметр (Diameter), кнопка, 376
Диспетчер видов (View Manager),

окно, 301, 302
Диспетчер внешних ссылок (Manage

Xrefs), пиктограмма, 408
Диспетчер параметров листов

(Page Setup Manager),
кнопка, 433

Диспетчер параметров листов (Page
Setup Manager), команда
контекстного меню, 419, 433, 447

Диспетчер параметров листов (Page
Setup Manager), окно, 414, 415,
417, 419, 433, 452

Диспетчер размерных линий
(Dimension Style Manager),
окно, 361, 364, 366, 385, 387,
388, 389

Диспетчер свойств слоев (Layer
Properties Manager),
кнопка, 187

Диспетчер свойств слоев (Layer
Properties Manager), окно, 187,

189, 190, 192–194, 200, 223, 224,
394, 395, 459

Длина (Distance), инструмент, 255,
256, 259

Длина (Distance), команда, 63
Добавить

выбрать объекты (Add Select
objects), кнопка, 309

точки выбора (Add Pick points),
кнопка, 309, 318

Добавить (Add), кнопка, 452, 457
Добавление наборов параметров

листа (Add Page Setup), окно, 457
Дополнительные (custom) узоры

штриховки, 317
Дополнительные параметры

печати, 449
Допуски (Tolerance), вкладка, 364
Доступные типы линий (Available

Linetypes), список, 192
Дробные (Fractional), параметр, 62
Другие стандартные (Other

Predefined), вкладка, 312, 317
Дуга (Arc), инструмент, 109, 142,

180, 239

ЕЕЕЕЕ
ед.чертежа (units), поле, 452
Единицы блока (Block unit),

список, 240, 253
Единицы чертежа (Drawing Units),

окно, 63, 64, 107

ЗЗЗЗЗ
Загружена (Loaded), параметр, 402
Загруженные типы линий (Loaded

linetypes), список, 192
Загрузить (Load), кнопка, 192
Загрузка/перезагрузка типовой

линии (Load or Reload Linetypes),
окно, 192

Задание пути (Path type),
параметр, 407

Задание пути (Path type),
список, 394

Закрыть окно просмотра (Close

Виды (Model Views), группа
параметров, 301

Включая неименованные (Include
Unnamed), флажок, 232, 233

Внешние ссылки, 221
особенности, 407

Внешние ссылки (External References
или X+ref), 391

Внешние ссылки (External
References), инструмент, 393

Внешние ссылки (External
References), палитра, 393, 402,
408, 411, 439

Внешние ссылки (External
References), панель, 403

Внешняя ссылка (External
Reference), окно, 394, 407

Внешняя ссылка или блок
для местного редактирования ⇒
Редактирование вхождений (Tools
Xref and Block In+Place Editing ⇒
Edit Reference In+Place), 404

Вниз влево (Bottom left), режим, 339
Вниз по центру (Bottom center),

параметр, 335, 338
Вниз по центру (Bottom center),

режим, 339
Вн+ссылка (Xref), внешняя

ссылка, 408
Вписать (Fit to paper),

флажок, 452, 456
Все размеры (All dimensions),

параметр, 361
Всплывающие подсказки

автопривязки (Display AutoSnap
tooltip), флажок, 174

Вставить блок (Insert Block),
инструмент, 242, 245, 266, 284, 289

Вставить блок (Insert Block), команда
меню, 242

Вставить блок (Insert),
инструмент, 260, 262

Вставка блока (Insert), окно, 242,
244, 245, 258, 260, 266, 289, 291

Вставка блоков, 243

Вся палитра (TrueColor),
вкладка, 190

Вторая точка (Second point), 112
Вхождение блока (Block Reference),

тип объекта, 249
Выбор,

запрос на выбор, 53
Выбор направления (Direction

Control), окно, 64, 108
Выбор нового пути (Select new path),

окно, 410
Выбор объектов (Select objects),

кнопка, 294, 314
Выбор типа линий (Select Linetype),

окно, 192
Выбор файла внешней ссылки (Select

Reference File), окно, 393
Выбор цвета (Select Color),

окно, 188, 190
Выбор шаблона (Select Template),

окно, 36, 37, 43
Выбрать объекты (Select Objects),

кнопка, 241, 254
Выгрузить (Needs reloading),

параметр, 402
Выделение линии, 45
Выноска и стрелка (Leader Line &

Arrow), вкладка, 379
Выравнивание (Justify),

список, 335, 338
Выравнивание текста (Text

placement, группа
параметров, 364

Высота (Height), поле, 327
Высота текста (Text height),

параметр, 362
Выход в файл (Plot to File),

переключатель, 462
Выход в файл (Plot to File),

флажок, 464

ГГГГГ
Геометрия (Geometry), раздел, 344
Глобальная ширина (Global width),

параметр, 344, 348
Градиент (Gradient), вкладка, 308
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Имя шрифта (Font Name),
список, 327

Инженерные (Engineering),
параметр, 62

Интервал (Spacing),
параметр, 318

Информация о ссылке (Identify
Reference), вкладка, 404, 443

Источник данных (Source), группа
параметров, 265

ККККК
Квадрант (Quadrant), команда

контекстного меню, 151
Квадрант (Quadrant), режим

привязки, 151, 152, 217, 297, 313
Клавиатурные эквиваленты команд

(Shortcut key), 32
Клавиши функциональные, 32
Классический AutoCAD (AutoCAD

Classic), 14
Книжная (Portrait),

переключатель, 415, 453
Команда

Вид
3D виды ⇒ Вид в плане ⇒

Текущая ПСК (View ⇒ 3D
Views ⇒ Plan view ⇒ Current
UCS), 300

Видовые экраны ⇒ 2 ВЭкрана
(View ⇒ Viewports ⇒
2 Viewports), 442

Зумирование
В реальном времени (View

⇒ Zoom ⇒ Realtime), 167
Все (View ⇒ Zoom ⇒ All), 68
Где искать (View ⇒ Zoom ⇒

Out), 65, 78
Границы (View ⇒ Zoom ⇒

Extents), 65, 78
Назад (View ⇒ Zoom ⇒

Previous), 89
Именованные виды (View ⇒

Named Views), 300
Отображение ⇒ Знак ПСК ⇒

Вкл. (View ⇒ Display ⇒ UCS

Icon ⇒ On), 65, 299
Панели инструментов (View ⇒

Toolbars), 30
Панорамирование ⇒ В реаль+

ном времени (View ⇒ Pan ⇒
Realtime), 167

Изменить
Зеркало (Modify ⇒

Mirror), 115
Копирование свойств (Modify

⇒ Copy), 113
Массив (Modify ⇒ Array), 294
Масштаб (Modify ⇒ Scale), 423
Обрезать (Modify ⇒ Trim), 56
Объект

Полилиния (Modify ⇒
Object ⇒ Polyline), 343

Текст ⇒ Редактировать
(Modify ⇒ Object ⇒ Text
⇒ Edit), 339, 357

Штриховка (Modify ⇒
Object ⇒ Hatch), 321

Перенести (Modify ⇒
Move), 146, 148

Повернуть (Modify ⇒
Rotate), 108

Подобие (Modify ⇒
Offset), 46, 78

Расчленить (Modify ⇒
Explode), 235

Свойства (Modify ⇒
Properties), 217, 249

Сопряжение (Modify ⇒
Fillet), 49, 79

Стереть (Modify ⇒
Erase), 45

Удлинить (Modify ⇒
Extend), 54, 80

Сопряжение линий, 51
Файл

Выход (File ⇒ Exit), 59, 74
Диспетчер параметров листов

(File ⇒ Page Setup
Manager), 433

Диспетчер плоттеров (File ⇒
Plotter Manager), 449

Preview Window), кнопка, 455
Заливка (Gradient), 306
Замораживание слоев

общие свойства, 199
Заморозить (Freeze),

параметр, 188, 200
Заморозить слой (Layer Freeze),

инструмент, 200
Заморозить слой (Layer Freeze),

кнопка, 202
Запись блока на диск (Write Block),

окно, 265
Запись блока на диск (Write Block),

список, 266
Запуск инструмента Make Block, 239
Запуск (активизация) инструмента

Arc, 109
Зеркального отображения,

ось, 115
Зеркальное отражение (Mirror),

инструмент, 115, 157, 219,
274, 299

Зумирование (Zoom), команда
контекстного меню, 168

Зумирование (Zoom), панель, 28, 114
Зумирование в границах (Zoom

Extents), инструмент, 235,
236, 265

Зумирование в реальном времени
(Zoom Realtime), инструмент, 166,
168, 169, 172, 176, 254, 270, 342

Зумирование в реальном времени
(Zoom Realtime), кнопка, 114

Зумирование в реальном времени
(Zoom Realtime), команда, 34

Зумировать в границах (Zoom
Extents), инструмент, 67, 78, 86,
173, 257, 303, 343

Зумировать все (Zoom All),
инструмент, 44, 86

Зумировать все (Zoom All),
кнопка, 27

Зумировать предыдущий (Zoom
Previous), инструмент, 86, 89, 93,
107, 112, 113, 114, 124, 142, 147, 153,
155, 166, 171, 180, 182, 208, 280

Зумировать предыдущий (Zoom
Previous), кнопка, 113

ИИИИИ
Из линий (User defined),

параметр, 318
Изменение

границ чертежа, 67
параметров границы сетки, 67, 71
шага сетки и привязки, 68

Изменение размеров
изменение границ чертежа, 68
изменение шага сетки

и привязки, 70
масштабирование по сеткам

и за сетки, 66, 67
просмотр сеток, 67

Изменение стандартных форматов
листа (Modify Standard Paper Sizes
(Printable Area), параметр, 419

Изменение стандартных форматов
листа (Modify Standard Paper
Sizes), область, 420

Изменить (Modify)
инструмент, 83
кнопка, 419
меню, 25
панель, 30, 37, 127, 146, 157,

246, 423
Изменить II (Modify II), панель, 322
Именованные виды (Named Views),

инструмент, 300, 302
Импорт наборов параметров листов

(Import Page Setups), окно, 453
Имя вхождения (Reference name),

список, 404
Имя группы (Group Name), поле, 232
Имя группы (Group Name),

список, 234
Имя набора параметров листа (New

page setup name), поле, 414
Имя нового стиля (New Style Name),

поле, 361, 389
Имя стиля (Style Name), список, 328
Имя файла (File name), поле, 74
Имя шрифта (Font Name), поле, 327
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в (V), 374
в точках (at point), 249
Вертикальный (VERTICAL), 374
Верх (Top), режим, 337
Вид (VIEW), 300, 302
ВЛ (TL), режим, 337
Вложение блока Слой

(BLOCK REFERENCE
Layer), 248

вн (ER), 393, 402
вн (XR), 439
Внешниессылки

(EXTERNALREFERENCES), 393
Внссылки (XREF), 439
ВП (TR), режим, 337
Вписанный (ALIGN), режим, 336
Вправо (RIGHT), 333
Вправо (RIGHT), режим, 337
вр (J), 329
все (_all), 28
все (A), 32
Вставить (INSERT), 242
Встблок (PASTEBLOCK), 423
ВЦ (TC), режим, 337
Выравнивание (JUSTIFY), 329
Выравнивание (JUSTIFY),

режим, 333, 336
Выровнять (ALIGN), 440
Выход (EXIT), 272
г (E), 65
г (H), 440, 442
Горизонтальное

(HORIZONTAL), 440, 442
границы (ZOOM EXTENTS), 65
Группа (GROUP), 232
д, 169
д (C), 300
д (R), 79, 90, 400
Д (YES), 343
Дельта X (Delta X), 256
ди (DI), 255
диализм (DDMODIFY), 217
Диалред (DDEDIT), 339, 340, 357,

383, 384
диалсвой (DDCHPROP), 217
Дисппеч

(PLOTTERMANAGER), 449
дист (DIST), 255
ДИСТ (DIST), 256
дт (DT), 329
Дтекст (DTEXT), 329, 333, 335,

336, 352
дуга (ARC), 111, 127
Дуга (ARC), 109
ед (UN), 61
Единицы (UNITS), 61
з (C), 71, 138, 141
з (J), 344
з (Z), 68
Замкнуть (CLOSE), 44, 45, 71,

138, 141
Замкнуть (JOIN), 344, 420, 435
Зеркало (MIRROR), 116, 157, 244
ЗнакПСК, 65
Зумировать (Zoom), 28
Зумировать все (Zoom All), 28
Зумировать все (ZOOM ALL), 68
Зумировать границы (ZOOM

EXTENTS), 270
Имя (NAME), 206
Имя блока (Block Name), 249
к (C), 144, 156, 405
К (C), 272
Копирбаз (COPYBASE), 421, 422
Копировать (COPY), 112, 114,

158, 160, 352, 405
КОПИРОВАТЬ (COPY), 272
Копиявслои (COPYTOLAYER),

206, 216
кп (CP), 113, 158
круг (CIRCLE), 144
Круг (CIRCLE), 156, 157
кш (BH), 307
Кштрих (BHATCH), 307
л (LO), 429
Л (PS), 427
Лист (LAYOUT), 429
ЛИСТ (PSPACE), 427
лмасштаб (LTSCALE), 209
лмш (LTS), 209
М (MS), 427, 436
М (PS), 435

Закрыть (File ⇒ Close), 36, 43,
59, 61

Закрыть (File ⇒ Exit), 32
Открыть (File ⇒ Open), 32, 77
Печать (File ⇒ Plot), 447
Создать (File ⇒ New), 36, 43, 61
Сохранить (File ⇒

Save), 73, 153, 182
Сохранить как (File ⇒

Save As), 90, 130, 182
Формат

Единицы (Format ⇒
Units), 61

Инструменты слоя
Cменить на текущий слой

(Format ⇒ Layer tools ⇒
Change to Current
Layer), 201

Заморозить слой (Format ⇒
Layer tools ⇒ Layer
Freeze), 202

Копировать объекты
в новый слой (Format ⇒
Layer tools ⇒ Copy
Objects to New
Layer), 206

Сделать слой объекта
текущим (Format ⇒ Layer
tools ⇒ Make Object’s
Layer Current), 198,
200, 204

Лимиты (Format ⇒ Drawing
Limits), 67

Слой (Format ⇒ Layer), 187,
200, 223

Текстовый стиль (Format ⇒
Text Style), 326

Черчение
Дуга

3 точки (Draw ⇒ Arc ⇒
3 Points), 109

Начало, конец, угол (Draw
⇒ Arc ⇒ Start, End,
Angle), 239

Начало, центр, конец (Draw
⇒ Arc ⇒ Start, Center,
Angle), 110

Начало, центр, угол (Draw
⇒ Arc ⇒ Start, Center,
Angle), 127

Дуга (Draw ⇒ Arc),
подменю, 109

Круг ⇒ Центр, радиус
(Draw ⇒ Circle ⇒ Center,
Radius), 144, 156

Круг (Draw ⇒ Circle),
подменю, 143

Полилиния (Draw ⇒
Polyline), 346

Прямоугольник (Draw ⇒
Rectangle), 103

Текст ⇒ Многострочный
(Draw ⇒ Text ⇒ Multiline
Text), 354

Текст ⇒ Однострочный
(Draw ⇒ Text ⇒ Single Line
Text), 329

Штриховка (Draw ⇒
Hatch), 307

Эллипс ⇒ Ось, конец (Draw ⇒
Ellipse ⇒ Axis, End), 178

Эллипс (Draw ⇒ Ellipse),
подменю, 180

Командное окно, 20, 23
.X, координаты точки

вставки, 260
_options, 23
A, режим, 388
APPLY, режим, 388
GRIDDISPLAY, 65
SNAPBASE, 319
ST, 351
VISRETAIN, переменная

AutoCAD, 397
бвы (LE), 378
Бвыноска (QLEADER), 378, 380
Блок (BLOCK), 387
–Блок (–BLOCK), 387
в (A), 68,440
в (I), 242
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Прямоугольник (RECTANG), 103,
105, 119, 122, 144, 340, 400, 434

ПСК (UCS), 300, 301
р (R), 333
Радиус (RADIUS), 138, 169, 400
Растягивание (STRETCH), 425
Растягивание (STRETCH),

режим, 339, 342, 437
Расчленить (EXPLODE), 235, 420,

435
Расчленить (STRETCH), 405
рба (DBA), 369
рди (DDI), 377
ред (ED), 339, 352, 357, 382
Редштрих (HATCHEDIT), 321
Режим = С обрезкой (Mode =

TRIM), 49
режимрис (DSETTINGS), 68, 102
Режимрис (DSETTINGS), 139
Рзмбазовый

(DIMBASELINE), 369, 370
Рзмдиаметр (DIMDIAMETER),

377
Рзмлинейный (DIMLINEAR), 366
Рзмподавить

(DIMOVERRIDE), 389
Рзмпродолж

(DIMCONTINUE), 368
Рзмпродолж

(DIMCONTINUE), 370
Рзмрадиус (DIMRADIUS), 375
Рзмстиль (DIMSTYLE), 360
Рзмстиль (–DIMSTYLE), 388
–Рзмстиль (–DIMSTYLE)

APPLY, 387
Рзмугловой (DIMANGULAR), 375
Рзмцепь (DIMCONTINUE), 368
рли (DLI), 366, 372
рпо (DOV, 389
рра (DRA), 375
рст, 360
руг (DAN), 375
рцп (DCO), 368
рш (HE), 321
свз (PRC), 217
Свойства (PROPERTIES), 217, 249

Середина (MIDDLE),
режим, 337

Cетка (Grid), режим, 68
сл (LA), 187, 200, 223
СЛ (ML), режим, 337
Слои (LAYCUR), 270
Слои (LAYERS), 223, 270
Слоизам (LAYFRZ), 202
Слой (LAYCUR), 198
Слой (LAYER), 187, 200
Слой (LAYER), режим, 46
соп (F), 49
Сопряжение (Fillet), 138
Сопряжение (FILLET), 49, 50, 79,

90, 169, 215, 229
Cохранить (QSAVE), 73, 130
Сохранить (SAVE), 300
Сохранитькак (SAVEAS), 130
сп (LI или LS), 248
сп (LI), 249
СП (MR), режим, 337
Список (LIST), 248, 249
сс (ER), 439
сс (XR), 393, 402
Ссылзакр (REFCLOSE), 405, 444
Ссылки (XREF), 393
–Ссылки (XREF), 393
Ссылред (REFEDIT), 262, 404, 443
ст (ST), 326
Стереть (ERASE), 39, 45
Стиль (STYLE), 326
СЦ (MC), режим, 337
Текст (TEXT), 329, 335
требуется YZ (need YZ), 260
у (EX), 54
Увеличить (ZOOM OUT), 88
угол поворота (rotation angle), 249
Удалить (DELETE), 429
Удалить (ERASE), режим, 46
Удлинить (EXTEND), 54, 56,

80, 127
Форматл (MVSETUP), 440, 442
ц (C), 329
Центр (CENTER), 329
Центр (CENTER), режим, 337
Через (THROUGH), режим, 46

–Массив (–ARRAY), 387
Массив (ARRAY), 294, 387
Мастерлист

(LAYOUTWIZARD), 429
Масштаб (SCALE), 423, 424
Масштаб по оси Y (Y scale

factor), 249
Масштаб по оси Х (X scale

factor), 249
МОДЕЛЬ (MODEL), режим, 435
МОДЕЛЬ (MSPACE), 427
мс (AR), 294
мт (MT), 354
Мтекст (MTEDIT), 357
Мтекст (MTEXT), 354
мш (SC), 423
на, 31
Настройка (DSETTINGS), 174
Настройка (OPTIONS), 31
несколько (MULTIPLY), 169
НЛ (BL), режим, 237
НП (BR), режим, 237
НЦ (BC), режим, 237
о (U), 50, 57, 164
О (U), 277
обр (TR), 56, 83, 127
Обрезать (TRIM), 56, 153, 275,

277, 299, 420, 435
Обрезать (Trim), 83
Окно зумирования (Zoom

Window), 87
окносвзак

(PROPERTIESCLOSE), 217
Окносвзакр (PRCLOSE), 250
от (L), 38, 40, 44
откл (UCSICON OFF), 65
отмена, 47
Отменить (UNDO), 51, 57,

164, 277
ОТРЕЗОК (Command_line), 38
Отрезок (LINE), 38, 40, 41, 44, 45,

71, 118, 132, 133, 138, 171, 214,
251, 252, 253

п (M), 146, 149
п (P), 400
пан (Pan), 114

пан (PAN), 167, 169
Панорамирование, 114
Парамлист (PAGESETUP), 433
пб (W), 265
пблок (WBLOCK), 265
пер (F), 298
Перемещение (MOVE),

режим, 339, 342
Перенести (Move), 147
Перенести (MOVE), 146, 149,

226, 229
Перенести (MOVE), режим, 439
Пересечение (FENCE), 298
Печать (PLOT), 447
пл (PL), 346
План (PLAN), 300, 301
Плиния (PLINE), 346, 347, 349
Плиния (POLYLINE), режим, 400
по (Z), 32, 65, 427, 440
по г (Z E), 173
по п (Z P), 93
по пр (Z P), 89
пов (RO), 108, 152
Повернуть (ROTATE), 108, 109,

152, 405
Повторить (REDO), 164
повторный запуск, 50
под (O), 80
Подобие (Offset), 46
Подобие (OFFSET), 53, 78, 80,

210, 221, 236, 251, 256, 270,
323, 328, 329, 420, 435

показать (ZOOM), 167, 168
Показать (ZOOM), 65, 79, 86,

115, 427
Показать все (ZOOM ALL), 32
Показать предыдущий (ZOOM

PREVIOUS), 89
Полред (PEDIT), 420, 435
поляр (POLAR), режим, 182
Поширине (FIT), режим, 336
прд (PE), 420
Предыдущая (CURRENT),

режим, 300
пря (REC), 342
прямоуг (REC), 103, 419
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МММММ
Магнит (Magnet), флажок, 174
Маркер (Marker), флажок, 174
Маркер выделения

визуализация блоков, 248
Маркеры выделения (Grip), 248, 271
Массив (Array), инструмент, 294, 313
Массив (Array), окно, 294
Массив (Array), переключатель, 431
Мастер компоновки листа (Create

Layout Wizard), 429
Мастер установки плоттеров

(Add+A+Plotter Wizard), ярлык, 449
Масштаб (Scale), группа

параметров, 267, 285
Масштаб (Scale), группы

параметров, 258
Масштаб (Scale),

инструмент, 274
Масштаб (Scale), параметр, 318, 320
Масштаб (Scale), поле, 308
Масштаб (Scale), список, 309, 452
Масштаб печати (Plot scale), группа

параметров, 452, 456
Масштабирование

по сетке и за сетку, 67, 68
Масштабирование (zooming), 64
Масштабирование относительно

сеток, 65, 67
Масштабные коэффициенты

в типах линий, 209
Между рядами (Row offset),

поле, 294
Между рядами (Rows), поле, 294
Между столбцами (Column offset),

поле, 294
Метки центра (Center marks), группа

параметров, 362
Многострочный текст (Multiline

Text), инструмент, 354
Многострочный текстовый объект

(Multiline text), 325
Модель (MODEL),

кнопка+индикатор, 102
МОДЕЛЬ (MODEL),

кнопка+индикатор, 418
МОДЕЛЬ (MODEL), лист, 436
Модель (MODEL), режим, 436
МОДЕЛЬ (MODEL),

режим, 418, 419, 422
Модификация определения

 блока, 262
МСК, 300, 303

ННННН
На основе (Start With), список, 361
Набор параметров листа (Page

setup), группа параметров, 452,
457

Набор параметров листа (Page
Setups), список, 415

Назначение типов линий
слоям, 192

Найден в (Found at), поле, 410
Найдена в (Found in), поле, 407
Направление (Direction),

кнопка, 63, 108
Настройка

для черчения по сетке, привязке
и раскладке координат, 71

линейных и угловых единиц, 64
параметров слоев, 186
подгонка по сетке

изменение границ чертежа, 70
присвоение имен чертежам, 73
размеров штрихов, 209
сохранение чертежей, 73

Настройка (Options), диалоговое
окно, 18

Настройка (Options), окно, 18
Настройка (Settings), команда

контекстного меню, 139, 174, 214
Настройка интерфейса пользователя

(Customize User Interface),
окно, 30

Настройка линейных и угловых
единиц, 60

ш (H), 307, 318
ш (W), 347, 420
Ширина (WIDTH), 420
Ширина (WIDTH),

режим, 347, 435
Штрих (HATCH), 307
э (EL), 179
Эллипс (ELLIPSE), 179

Команды черчения, 35
Коммуникационный центр

(Communication Center),
инструмент, 22

Коммуникационный центр
(Communication Center),
окно, 22

Компоновка (Layout), 412
Компоновка с несколькими

видовыми экранами, 428
Конструкторский набор (Std. 3D

Engineering View),
переключатель, 430

Конточка (Endpoint), режим
привязки, 131, 144, 147, 169, 171,
213, 218, 243, 253, 255, 271, 297,
318, 360, 366, 440

Конточка (Snap to Endpoint),
кнопка, 104, 106, 108

Координатные фильтры (Coordinate
filter), 259

Координатные фильтры (Point
Filters), подменю, 330

Координаты x и y
вычерчивание командами Сетка

(Grid), Шаг (Snap), чтение
на чертеже, 71

коэффициент
масштабирования, 243

Координаты X и Y
относительные декартовы

координаты, 41, 43
относительные полярные

координаты, 42, 45
Копирование объектов, 112
Копировать (Copy), инструмент, 112,

123, 158, 216, 233

Копировать в слой (Copy To Layer),
окно, 206

Копировать объекты в новый слой
(Copy Objects to New Layer),
инструмент, 210, 215

Копировать объекты в новый слой
(Copy Objects to New Layer),
кнопка, 206

Коэффициент
масштабирования, 243

Коэффициент масштабирования
(Scale factor), 209

Крест+накрест (Double), флажок, 318
Круг (Circle), инструмент, 143, 156,

178, 180
Круг (Circle), тип объекта, 165
Круговой массив (Polar Array),

переключатель, 313

ЛЛЛЛЛ
Лимиты (Limits), параметр, 461
Лимиты (Limits), режим, 456
Линейные (Length), группа

параметров, 61, 62
Линейные единицы на чертежах, 60
Линейные размеры (Linear

dimensions), группа
параметров, 364

Линейный (Linear Dimension),
инструмент, 366, 367, 372

Линии
выделение, 45
продление, 53

Линии (Lines), вкладка, 371
Линия (Line), переключатель, 362
Лист (Layout), параметр, 461
ЛИСТ (PAPER),

кнопка+индикатор, 418, 436
ЛИСТ (PAPER), лист

компоновки, 419
ЛИСТ (PAPER), режим, 423, 427, 435,

438, 440
Листы (Layouts), панель, 433
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definition), 237
Опции размещения (Fit options),

группа параметров, 364, 386
Ориентация текста (Text alignment),

группа параметров, 362
Ориентация чертежа (Drawing

orientation), группа
параметров, 452

ОРТО (ORTHO),
кнопка+индикатор, 108, 131,
163, 297

ОРТО (ORTHO),
режим, 131, 133, 138, 346, 380, 439

ОРТО (ORTHO), режим
привязки, 299, 313

Ортогональный режим
общие свойства, 108

Основная надпись на листе
компоновки, 434

Основные единицы (Primary Units),
вкладка, 364

Оставить (Retain), режим, 241
Отключение слоев, 199
Открыть (Open), кнопка, 37
Отменить (Undo), кнопка, 57
Отмечающий указатель (pickbox

cursor), 45
Относительные декартовы

координаты, 41, 43
Относительные полярные

координаты, 42, 45
Относительный путь (Relative path),

параметр, 407
Отслеживание (Polar Tracking),

вкладка, 139, 214
ОТС+ОБЪЕКТ (OTRACK),

кнопка+индикатор, 71, 297
ОТС+ПОЛЯР (POLAR),

кнопка+индикатор, 296
ОТС+ПОЛЯР (POLAR),

режим, 139, 140, 142, 181, 214,
225, 227

Отступ от размерной линии (Offset
from dim line), параметр, 362

Очистить экран (Clear Screen),
кнопка, 23

ППППП
Палитра образцов штриховки (Hatch

Pattern Palette), окно, 308, 317
Панели инструментов, настройка, 30
Панорамирование (Pan), команда, 34
Панорамирование (Pan), команда

контекстного меню, 168
Панорамирование в реальном

времени (Pan Realtime),
инструмент, 166, 169, 172, 176, 18,
254, 296, 340, 427, 438, 439

Папка (Save In), список, 73
Параметры выноски (Leader

Settings), окно, 379
Параметры границ чертежа, 67, 71
Параметры листа – Лист1 (Page

Setup – Layout1), окно, 414, 419
Перезагрузить (Reload),

команда, 402
Перезагрузить (Reload), команда

контекстного меню, 402
Переименование листа (Rename

Layout), окно, 428
Переименовать (Rename), команда

ярлыка листа, 428
Переместить (Move),

инструмент, 146, 147, 148, 218,
228, 272, 274, 280

Перемещение объектов на слои, 197
Перенести (Move), команда, 151
Переопределение (Override)

размерного стиля, 385
Переопределение текущего стиля

(Override Current Style),
окно, 385, 386

Переопределить (Override),
кнопка, 385

Пересекающая линия (Fence), 298
Пересекающая рамка (crossing

window), 122
Пересечение (Intersection), команда

контекстного меню, 330
Пересечение (Intersection), режим

привязки, 151, 154, 156, 352
Пересечение (Snap to Intersection),

инструмент, 335

Настройка параметров
черчения, 60

Научные (Scientific), параметр, 62
Непрерывные линии, 192
Несколько (Multiply), режим, 170, 177
Нестандартные форматы

и калибровка (User+defined Paper
Sizes & Calibration), параметр, 419

Ничего (Snap to None), кнопка, 298
Ничего (Snap to None), режим

привязки, 352
Новый (New), кнопка создания

стиля, 351
Новый размерный стиль (New

Dimension Style), окно, 364, 371
Новый текстовый стиль (New Text

Style), окно, 327, 328, 351
Номер цвета (Index Color),

вкладка, 189
Нормаль (Perpendicular), режим

привязки, 131, 132, 253, 346, 348
Нормаль (Snap to Perpendicular),

инструмент, 279
Нормаль (Snap to Perpendicular),

кнопка, 131, 221, 251
Нормаль (Snap to Perpendicular),

режим привязки, 280, 284

ООООО
Область черчения

общие свойства, 17
Обновить (Refresh), кнопка, 402
Обновить размер (Dimension

Update), инструмент, 388
Обновить размер (Dimension

Update), кнопка, 387
Обозначение материалов

поверхностей, 317
Обозначение цилиндрических

поверхностей, 313
Образец (Pattern), кнопка, 320
Образец (Pattern), параметр, 318
Образец (Pattern), список, 308
Обрезать (Trim), инструмент, 52, 56,

56, 57, 79, 83, 93, 127, 174, 225,

236, 275, 279, 280, 298, 400
Обрезать (Trim), кнопка, 56
Объектная привязка (Object Snap),

вкладка, 102, 175
Объектная привязка (Object Snap),

инструмент, 219
Объектная привязка (Object Snap),

панель, 104, 115, 121, 131, 144,
151, 251, 289, 298

Объектная привязка Вкл (F3)
(Object Snap On (F3), флажок, 174

Объекты
выбор, 53
зеркальное отражение, 115
копирование, 112

Объекты (Objects), группа
параметров, 241, 254

Ограничивающие ребра, 53
Один экран (Single),

переключатель, 430
Однострочный (Single Line Text),

инструмент, 330, 351
Однострочный (Single Line Text),

кнопка, 329
Однострочный текстовый объект

(Single line text), 325
Окна выбора

пересекающий контур, 298
Окно (Window) ⇒ Путь

к файлу\Имя_файла.dwg, 401
Окно зумирования (Zoom Window),

инструмент, 86, 92, 110, 124, 130,
131, 146, 162, 166, 171, 176, 205,
280, 300

Окно зумирования (Zoom Window),
кнопка, 102, 113

Окно зумирования (Zoom Window),
окно, 27, 87

Окно Зумировать предыдущий
(Zoom Previous), кнопка, 164

Описание блока, 248
Описание блока (Block Definition),

окно, 240, 246, 254
Описание блока (Block

description), 237
Определение блока (Block
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Пояснение (Description),
параметр, 188

Пояснения (Description),
область, 387

Правая кнопка мыши, функции, 274
Правка ⇒ Вставить как блок (Edit ⇒

Paste as Block), 423, 435
Правка ⇒ Выбрать все (Edit ⇒ Select

All), 204, 219, 392
Правка ⇒ Копировать с базовой

точкой (Edit ⇒ Copy with Base
Point), 421, 435

Преобразовать в блок (Convert to
Block), переключатель, 246,
247, 289

Преобразовать в блок (Convert to
Block), режим, 241

Привязка (OSNAP),
кнопка+индикатор, 435

ПРИВЯЗКА (OSNAP),
кнопка+индикатор, 71, 174, 175,
297, 307, 425

Применить к листу (Apply to Layout),
кнопка, 457, 461

Пример (Sample Output), 62
Принтер/плоттер (Printer/plotter),

группа параметров, 414, 433,
452, 460

Принтер/плоттер (Printer/plotter),
раздел, 447

Присвоение имен
слоям, 188
чертежам, 73

Присоединить DWG (Attach DWG),
кнопка, 393

Прицел автопривязки (Display
AutoSnap aperture box),
флажок, 174

Продолжить (Continue Dimension),
инструмент, 368

Просмотр сеток, 68
Просмотр (Preview), кнопка, 294,

452, 456, 460
Пространство листа (Paper

space), 418
Пространство модели (Model

space), 418
Прямоугольник (Rectangle),

инструмент, 103, 118, 128, 144,
181, 227, 235, 342, 345, 397, 416

Прямоугольный массив (Rectangular
Array), переключатель, 294

Псевдонимы команд (alias keys), 31
ПСК, 296, 299
ПСК (UCS), список, 301
ПСК (пользовательская система

координат), 20
Путь не задан (No path),

параметр, 394, 407

РРРРР
Рабочие (Workspaces), окно, 14
Радианы (Radians), параметр, 63
Радиус (Radius Dimension),

инструмент, 375
Радиус (Radius), параметр, 165
Развернуть окно (More Options),

кнопка, 447
Размер (Dimension),

инструмент, 360, 365, 366, 376
Размер (Dimension), панель, 360,

368, 369, 375, 377, 380, 387, 389
Размер (Size), параметр, 362
Размер маркера автопривязки

(AutoSnap Marker Size),
параметр, 174

Размер перекрестья (Crosshair size),
поле, 18

Размер стрелки (Arrow size),
параметр, 362

Размерная линия между выносными
(Draw dim line between ext lines),
флажок, 364

Размерные стили (Dimension Style),
инструмент, 385

Размерные стили (Dimension Style),
кнопка, 360

Размерный стиль
переопределение, 385

Размеры ⇒ Базовый (Dimension ⇒
Baseline), 369

Размеры ⇒ Выноска (Dimension ⇒

Пересечение (Snap to Intersection),
кнопка, 121, 151, 289

Печатаемая область (Plot area),
группа параметров, 455

Печатаемая область (What to plot),
список, 456

Печатать в файл (Plot to file),
флажок, 452, 460, 461

Печать – Лист1 (Plot – Layout1),
окно, 461

Печать – Модель (Plot – Model),
окно, 447, 450, 451, 452, 453, 455,
457, 458, 459, 460

Печать (Plot)
инструмент, 447
кнопка, 447, 459, 461
окно, 448, 450, 462, 464
параметр, 188

Пиктограммы
пиктограмма пользовательской

системы координат,
поворот, 299

Плюс/Минус (Plus/Minus),
параметр, 383

По умолчанию (Default),
параметр, 459

Повернуть (Rotate), инструмент, 107,
124, 152, 181, 228, 274, 405

Поворот (Rotation), группа
параметров, 394

Повторить (Redo),
инструмент, 164

Повторить (Repeat), команда
контекстного меню, 210

Повторить ПОДОБИЕ (Repeat
OFFSET), команда контекстного
меню, 210

Повторное выполнение команд, 50
Подавить стрелки, если они

не помещаются между выносными
(Suppress arrows if they don’t fit
inside extension lines),
флажок, 364, 386

Подгонка по сеткам
изменение шага сетки

и привязки, 70

масштабирование относительно
сеток, 66

просмотр сеток, 66
Подгонка по сетке, 64
Подгонка элементов (Fine tuning),

группа параметров, 364
Подключение (Where), область, 452
Подобие (Offset), инструмент, 46, 47,

51, 56, 78, 127, 132, 154, 169, 176,
235, 270, 275

Подробности (Details), раздел, 410
Подтверждать выбор вложенных

объектов (Prompt to select nested
objects), переключатель, 262

Полилиния (Polyline), 343, 345
Полилиния (Polyline),

инструмент, 345
Полный путь (Full path),

параметр, 407
Положение (Select Location),

кнопка, 431
Положения панелей инструментов

и окон разблокированы (Toolbar/
Window Position), инструмент, 22

Полосы прокрутки (Display scroll bars
in drawing window), флажок, 18

Польз. (Custom), параметр, 452
Пользовательская система

координат (ПСК), пиктограмма
поворот, 299
просмотр, 299

Пользовательский (Predefined),
параметр, 308

Полярное отслеживание Вкл (F10)
(Polar Tracking On (F10),
флажок, 214, 297

Полярные координаты,
относительные, 42, 45

Полярные углы (Polar Angle Settings),
группа параметров, 139, 214

Порты (Ports), вкладка, 462
Последний ввод (Recent Input),

команда контекстного меню, 213
Построения (Drafting), вкладка, 175
Пояснение (Annotations),

вкладка, 379
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Сервис ⇒ Внешняя ссылка или блок
для местного редактирования ⇒
Закрыть вхождение (Tools ⇒ Xref
and Block In+place Editing ⇒ Close
Reference), 263

Сервис ⇒ Внешняя ссылка или блок
для местного редактирования ⇒
Редактирование вхождений
(Tools ⇒ Xref and Block In+place
Editing ⇒ Edit Reference
In+place), 262

Сервис ⇒ Внешняя ссылка или блок
для местного редактирования ⇒
Сохранить изменения вхождения
(Tools ⇒ Xref and Block In+Place
Editing ⇒ Save Reference
Edits), 405

Сервис ⇒ Мастера ⇒ Установки
плоттеров (Tools ⇒ Wizards ⇒
Add Plotter), 449

Сервис ⇒ Настройка (Tools ⇒
Drafting Settings), 173

Cервис ⇒ Настройка (Tools ⇒
Options), 33

Сервис ⇒ Режимы рисования (Tools
⇒ Drafting Settings), 68, 102

Сервис ⇒ Сведения ⇒
Расстояние (Tools ⇒ Inquiry ⇒
Distance), 255

Сервис ⇒ Сведения ⇒ Список (Tools
⇒ Inquiry ⇒ List), 248

Сервис (Tools), меню, 25
Сервис ⇒ Адаптация ⇒ Интерфейс

(Tools ⇒ Customize ⇒
Interface), 30

Сервис ⇒ Настройка (Tools ⇒
Options), 23

Середина (Midpoint), режим
временной привязки, 380

Середина (Midpoint), режим
привязки, 146, 147, 157, 158,
218, 251, 253, 255, 280, 284, 285,
297, 319

Середина (Snap to Midpoint),
кнопка, 115

Сетка (grid), 64

Сетка (GRID), кнопка, 65
Сетка (GRID),

кнопка+индикатор, 65, 66, 78
Сетка (Grid), режим, 68
Сетки в областях черчения

изменение границ, 67
изменение шага, 70
масштабирование по сеткам

и за сетки, 65, 67
определение, 64
применение в черчении, 73
просмотр, 65

Символ (Symbol), кнопка, 383
Символ @, ввод относительных

координат, 41
Символ <, ввод относительных

полярных координат, 43
Символы и стрелки (Symbols and

Arrows), вкладка, 362
Слияние ⇒ Внешние ссылки (Insert

⇒ External References), 393
Слияние (Insert), меню, 25
Слои

Layer Properties Manager,
диалоговое окно, создание
слоев и выбор цвета
линий, 190

выбор объектов, 197
общие свойства, 192
перемещение объектов

на слои, 197
Слои (Layers), панель, 186, 195,

200, 223
Слои II (Layers II), панель, 186, 194
Слой (Layer), 184
Слойтек (LAYMCUR), окно, 204
Смещение (Snap From),

инструмент, 133
Смещение (Snap From), панель, 136
Смещение (Snap From),

режим, 134, 138, 162
Смещение (Snap From), режим

временной привязки, 397
Смещение (Snap From), режим

разовой привязки, 346

Leader, 377, 378
Размеры ⇒ Диаметр (Dimension ⇒

Diameter), 377
Размеры ⇒ Линейный (Dimension ⇒

Linear), 366
Размеры ⇒ Обновить (Dimension ⇒

Update), 387
Размеры ⇒ Переопределить

(Dimension ⇒ Override), 389
Размеры ⇒ Продолжить (Dimension

⇒ Continue), 368
Размеры ⇒ Радиус (Dimension ⇒

Radius), 375
Размеры ⇒ Размерные стили

(Dimension ⇒ Dimension
Style), 360

Размеры ⇒ Угловой (Dimension ⇒
Angular), 375

Размеры (Dimension), меню, 25
Размеры (Use for), список, 361
Размещение (Destination), группа

параметров, 266
Размещение (Fit), вкладка, 362, 385
Рамка (Window), режим, 455
Рамка выделения (Selecting

window), 148
Рамка масштабирования (Zoom

window), режим, 86
Рамка на листе компоновки, 434
Раскрывающиеся списки

определение, 62
Растянуть (Stretch),

инструмент, 272, 274
Расчленить (Explode), инструмент,

235, 236, 245, 246, 289, 343, 345
Редактирование вхождений (Edit

Reference In+Place), кнопка, 404
Редактирование вхождений

(Reference Edit), окно, 262, 404,
443, 444

Редактирование размерной
надписи, 382

Редактирование узора
штриховки, 321

Редактирование штриховки (Edit
Hatch), окно, 312, 322

Редактировать (Edit),
инструмент, 352, 382

Редактировать (Edit),
кнопка, 339, 357

Редактировать штриховку (Edit
Hatch), команда контекстного
меню, 321

Редактор параметров плоттера
(Plotter Configuration Editor),
окно, 419, 421, 433, 450, 462

РедСсыл (Refedit),
инструмент, 263, 444

РедСсыл (Refedit), панель, 404, 405
Режим привязки (Snap)

изменение шага сетки, 70
общие свойства, 68
черчение в режиме привязки, 73

Режимы привязки (Osnap Settings),
контекстное меню, 330

Режимы рисования (Drafting
Settings), окно, 68, 101, 139, 174,
214, 297, 330

Рендеринг (Rendering), 306
Рядов (Rows), параметр, 295

ССССС
С линиями (Line), инструмент, 35,

36, 38, 40, 44, 45, 70, 117, 128, 133,
169, 171, 213, 251, 253, 271, 279,
280, 297, 313, 318

Сведения (Inquiry), панель, 248, 255
Свойства (Properties), кнопка, 164,

217, 382, 419, 433, 450, 462
Свойства (Properties), команда

контекстного меню, 335
Свойства (Properties), окно, 338
Свойства (Properties), палитра, 165,

166, 249, 250, 335, 340, 344, 348,
350, 382, 426

Сделать слой объекта текущим
(Make Object’s Layer Current),
кнопка, 204

Секущие ребра, 56
Семейство стилей, 389
Семенар по новым возможностям

(New Features Workshop), окно, 16
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панель, 329, 357
переключатель, 364
раздел, 340

Текстовая строка (Text override),
параметр, 382

Текстовое окно AutoCAD (AutoCAD
Text Window), окно, 248

Текстовые стили (Text style), 325
инструмент, 351, 365
кнопка, 326
окно, 327
список, 362

Текстовый стиль,
определение, 326

Текстура (Texture), 306
Текущий слой, 193
Текущий слой (Current layer), 194
Текущий экран (Current display),

переключатель, 301
Тип (Type), список, 308, 318, 320
Типы линий

выбор размера штрихов, 209
назначение слоям, 192
непрерывные линии, 192
штриховые линии, 192

Типы штриховых линий, 192
Толщина линий

линейные единицы
для вычерчивания, 64

Тонирование (Shading), 306
Топографические единицы

(Surveyor’s Units), параметр, 63
Точка вставки, 253
Точка вставки (Insertion point),

группа параметров, 267, 285, 394
Точка вставки блока, 240
Точка выравнивания (Justification

point), 335
Точка отслеживания (Temporary

track point), режим, 136, 137, 138
Точка отслеживания (Temporary

track point), режим
привязки, 144, 156, 158, 348

Точка отслеживания (Temporary
track point), режим разовой
привязки, 347

Точка отслеживания (Temporary
track point, режим временной
привязки, 397

Точность (Precision),
список, 62, 63, 364

УУУУУ
Увеличить (Zoom Out),

инструмент, 64, 65, 86, 173, 427
Угловой (Angular Dimension),

инструмент, 375
Угловые (Angle), группа

параметров, 61
Угловые единицы на чертежах, 63
Угловые размеры (Angular

dimensions), группа
параметров, 364

Угол (Angle), параметр, 320
Угол и масштаб (Angle and scale),

группа параметров, 308
Угол между элементами (Angle

between items), поле, 314
Угол наклона (Oblique Angle),

параметр, 351
Угол наклона (Oblique Angle,

поле, 327
Угол поворота (Rotation), группа

параметров, 267, 285
Угол поворота (Rotation),

флажок, 258
Удаление

линий, 45
элементов графического окна, 18

Удалить слой (Delete Layer),
кнопка, 193, 224

Удлинения за размерные (Extend
beyond dim lines), параметр, 361

Удлинить (Extend), инструмент, 52,
53, 54, 56, 78, 80, 90, 127, 275,
279, 280

Узор
ANSI31, 311
ANSI32, 311
ANSI35, 311
ANSI37, 308, 311

Cменить на текущий слой
(Change to Current Layer),
инструмент, 197

Смещение объектов, 46
Смещение от начала (начало

в печатаемой области) (Plot offset
(origin set to printable area),
группа параметров, 453

Согласно ISO (ISO standard),
переключатель, 362

Содержимое (Contents),
параметр, 340

Создание
дуг, 142
окружностей, 143
определений блоков, 238
слоев, 186, 192

Создание главного вида, 269
Создание листа (Create Layout),

окно, 429, 431, 433
Создание набора параметров листа

(New Page Setup), окно, 414, 433
Создание нового размерного стиля

(Create New Dimension Style),
окно, 361, 389

Создать блок (Make Block),
инструмент, 238, 246, 253, 289

Создать папку (Create New Folder),
кнопка, 73

Создать слой (New Layer),
кнопка, 193

Создать слой (New), кнопка, 188
Сопряжение (Fillet), инструмент,

49, 50, 53, 55, 78, 127, 138, 169,
176, 343, 400

Сохранение чертежей, 73
Сохранение чертежа (Save Drawing

As), окно, 73
Сохранить (Save), кнопка, 73, 74
Сохранить в текущем стили (Save

to Current Style), команда
контекстного меню, 388

Сохранить изменения вхождения
(Save Reference Edit), кнопка, 263

Сохранить изменения вхождения

(Save Reference Edits),
кнопка, 405, 443

Сохранить путь (Saved path),
область, 407

Сохранить путь (Saved path),
поле, 407

Сохранить с видом снимок слоев
(Save layer snapshot with view),
флажок, 301

Специальные (user+defined) узоры
штриховки, 317

Список (List), инструмент, 248, 249
Способ построения (Method),

список, 313
Способ расположения (Viewport

Setup), группа параметров, 430
Справка ⇒ Новые возможности

(Help ⇒ New Features
Workshop), 16

Ссылка (Reference), панель, 393
Ссылка на блок (Block reference),

237, 241
Ссылки внешние, 221
Стандартный (Predefined),

параметр, 320
Статус (Status), состояние внешней

ссылки, 402
Степень растяжения (Width Factor),

поле, 351
Стереть (Erase), инструмент, 45
Стиль печати (Plot Style),

параметр, 188
Строить выноску (Over dimension

line, with leader),
переключатель, 364

Строка меню, 24
Строка состояния, 21
Структура (Swatch), область, 308

ТТТТТ
Таблица стилей печати (Plot style

table (pen assignment), группа
параметров, 457

Текст (Text)
вкладка, 362
инструмент, 339
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ANSI38, 312
AR+HBONE, 320

Узор штриховки, 311
Указать (Pick Point), кнопка, 240, 253
Указать на экране (Specify On+screen),

флажок, 242, 258, 260, 267
Указать на экране (Specify

On+Screen), флажок, 245, 285
Уменьшить (Zoom In),

инструмент, 64, 67, 79, 86, 427
Установить (Set Current),

кнопка, 194, 302, 365, 415
Устройство и документ (Device and

Document Settings), вкладка, 419

ФФФФФ
ФАЙЛ (FILE), порт, 462
Файлы (Files), вкладка диалогового

окна Настройка, 18
Формат (Format), меню, 25
Формат (Paper size), список, 449
Формат (Type), список, 61
Формат листа (Paper size), группа

параметров, 415
Формат текста (Text Formatting),

окно, 357
Формат текста (Text Formatting),

панель, 382, 383

ЦЦЦЦЦ
Цветовая гамма окна чертежа

(Drawing Window Colors), окно, 19
Центр (Center), режим привязки,

144, 152, 154, 157, 158, 216, 297
Центрировать (Center the plot),

флажок, 453, 454

ЧЧЧЧЧ
Черчение ⇒ Отрезок (Draw ⇒

Line), 38
Черчение (Draw), меню, 25
Черчение (Draw), панель, 30, 37, 103,

239, 307
Число экземпляров (Number

of copies), параметр, 452
Число элементов (Total number

of items), поле, 314
Что печатать (What to plot),

список, 453, 454, 461

ШШШШШ
Шаблон, 37
Шаг (Snap), группа параметров, 68
Шаг (SNAP), кнопка+индикатор, 78
ШАГ (SNAP),

кнопка+индикатор, 66, 68
Шаг (Snap), режим, 68
Шаг в базовых размерах (Baseline

spacing), параметр, 361, 371
Шаг и Сетка (Snap and Grid),

вкладка, 68
Шаг сетки (Grid spacing), группа

параметров, 68
Шаг сетки и привязки, 71
Шаг сетки по Y (Grid Y spacing),

поле, 68
Шаг сетки по Х (Grid X spacing),

поле, 68
Шаг углов (Increment angle),

список, 139, 214
Шрифт (Font), группа параметров, 327
Штриховка (Hatch),

вкладка, 308, 318
Штриховка (Hatch),

инструмент, 307, 311, 318, 320
Штриховка (Hatch), понятие, 306
Штриховка и градиент (Hatch and

Gradient), окно, 307, 309, 312,
318, 322

ЭЭЭЭЭ
Экран (Display), вкладка диалогового

окна Настройка, 18
Экран (Display), режим, 454
Эллипс (Ellipse), инструмент, 178
Эффекты (Effects), группа

параметров, 327
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